Axeda Supervisor™

Wizcon for Windows and Internet 8.2
User Guide
Warranty/Trademarks

"This document is for information only and is subject to change without prior notice. It does not represent a commitment on the part of Axeda Systems. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying or recording, for any purpose, without written permission from Axeda Systems Inc.

If you find any problems in the documentation, please report them in writing. Axeda Systems Inc. does not warrant that this documentation is error-free.

© Copyright 1997-2002 by Axeda Systems

All rights reserved. Axeda, Axeda Systems, Axeda DRM, Axeda Enterprise, Axeda Applications, Axeda Agent, Axeda Supervisor, Wizcon, Automatic eCommerce, Firewall-Friendly, and Access. Insight. In Real Time. are trademarks of Axeda Systems. All other trademarks are either property of Axeda Systems or property of their respective owners."
Table of Contents

Chapter 1, About this Guide ................................................. 1-1
About this Manual ................................................................................................................. 1-2
What You Should Know ......................................................................................................... 1-2
Registering Your Product ...................................................................................................... 1-2
Customer Support .................................................................................................................. 1-3

Chapter 2, Introduction to the Application ................. 2-1
Introduction to the Application ............................................................................................. 2-2
Typical Application SCADA Configuration ........................................................................... 2-3
Main Features ....................................................................................................................... 2-4
Advanced Alarm Management .............................................................................................. 2-4
Alarms .................................................................................................................................. 2-4
Alarm Filters .......................................................................................................................... 2-5
Automatic Network Optimization .......................................................................................... 2-5
Axedas Systems Remote ....................................................................................................... 2-5
Background Processing ......................................................................................................... 2-6
Built-in Report Generator ...................................................................................................... 2-6
Charts and Reports ................................................................................................................ 2-6
Database Connectivity .......................................................................................................... 2-6
Easy Maintenance ................................................................................................................... 2-7
Enterprise Server Connection ............................................................................................... 2-7
Events Summaries .................................................................................................................. 2-8
Events Summary Profiles ...................................................................................................... 2-8
Hot Backup Support ............................................................................................................. 2-8
Image .................................................................................................................................... 2-9
Language ............................................................................................................................... 2-10
Macros .................................................................................................................................. 2-10
Milli-second Time Stamping ................................................................................................. 2-10
Networking ............................................................................................................................. 2-10
Network Application Update ............................................................................................... 2-10
Online Design ......................................................................................................................... 2-11
Open Architecture ............................................................................................................... 2-11
PLCs Sampler ......................................................................................................................... 2-12
Printers ................................................................................................................................. 2-12
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Target</td>
<td>2-12</td>
</tr>
<tr>
<td>Recipes</td>
<td>2-13</td>
</tr>
<tr>
<td>RePlay Module</td>
<td>2-13</td>
</tr>
<tr>
<td>Security</td>
<td>2-13</td>
</tr>
<tr>
<td>Security on the Web</td>
<td>2-13</td>
</tr>
<tr>
<td>Scheduler</td>
<td>2-14</td>
</tr>
<tr>
<td>Tags</td>
<td>2-14</td>
</tr>
<tr>
<td>Tag Filter</td>
<td>2-14</td>
</tr>
<tr>
<td>Tag Mapper</td>
<td>2-15</td>
</tr>
<tr>
<td>Trend Profiles</td>
<td>2-15</td>
</tr>
<tr>
<td>Trend Viewer</td>
<td>2-16</td>
</tr>
<tr>
<td>User Management</td>
<td>2-16</td>
</tr>
<tr>
<td>Zone Navigator</td>
<td>2-16</td>
</tr>
</tbody>
</table>

**Chapter 3, Installation** .................................................. 3-1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements</td>
<td>3-2</td>
</tr>
<tr>
<td>Hardware</td>
<td>3-2</td>
</tr>
<tr>
<td>Software</td>
<td>3-2</td>
</tr>
<tr>
<td>Installation</td>
<td>3-3</td>
</tr>
<tr>
<td>Previous Axeda Supervisor Versions</td>
<td>3-8</td>
</tr>
<tr>
<td>Uninstalling the System</td>
<td>3-8</td>
</tr>
<tr>
<td>Additional Installations</td>
<td>3-10</td>
</tr>
<tr>
<td>Starting the Application</td>
<td>3-10</td>
</tr>
</tbody>
</table>

**Chapter 4, Getting Started** ............................................. 4-1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessing the Application</td>
<td>4-2</td>
</tr>
<tr>
<td>Quick Access Bar</td>
<td>4-3</td>
</tr>
<tr>
<td>User Login</td>
<td>4-5</td>
</tr>
<tr>
<td>Local User Login</td>
<td>4-5</td>
</tr>
<tr>
<td>Remote User Login</td>
<td>4-5</td>
</tr>
<tr>
<td>Login/Logout Quick Access Bar</td>
<td>4-6</td>
</tr>
<tr>
<td>Default User</td>
<td>4-7</td>
</tr>
<tr>
<td>Specifying Remote User Login Parameters</td>
<td>4-7</td>
</tr>
<tr>
<td>Popup</td>
<td>4-8</td>
</tr>
<tr>
<td>Users</td>
<td>4-9</td>
</tr>
<tr>
<td>Customizing the Login/Logout Procedure</td>
<td>4-9</td>
</tr>
<tr>
<td>Designing an Application</td>
<td>4-10</td>
</tr>
</tbody>
</table>
Designing Multiple Applications ................................................................. 4-10
Typical Application Requirements ................................................................. 4-11

Workflow ........................................................................................................... 4-12
Step 1: Building a Project, the Wizard and Station Properties ..................... 4-13
Step 2: Defining Communication Drivers and Blocks ..................................... 4-14
Step 3: Defining User Groups ....................................................................... 4-15
Step 4: Defining Tags and Alarms ................................................................. 4-15
Step 5: Building the Application Image ........................................................ 4-16
Step 6: Defining Application Language ......................................................... 4-17
Step 7: Testing the Application .................................................................... 4-17
Step 8: Defining Charts, Reports and Recipes ............................................. 4-17
Step 9: Fine-Tuning the Application ............................................................. 4-19

Shutting Down ................................................................................................. 4-19
Logout .............................................................................................................. 4-19
Exiting the Application .................................................................................. 4-19

Chapter 5, Getting to Know the Application Studio 5-1

Overview .......................................................................................................... 5-2
All Containers Section .................................................................................... 5-4
The Control Panel .......................................................................................... 5-7

Modules ........................................................................................................... 5-13
Communication Drivers ............................................................................... 5-13
Printers .......................................................................................................... 5-14
Multiple Tags ............................................................................................... 5-14
Single Tags .................................................................................................. 5-15
DDE Blocks ................................................................................................ 5-15
Application Setup ....................................................................................... 5-15
Macros ......................................................................................................... 5-15
Application Network .................................................................................. 5-16
Application Language ................................................................................ 5-17
WizPLC Development and Runtime .......................................................... 5-17
Tag Filters ................................................................................................... 5-17
Alarm Filters ............................................................................................... 5-18
Printer Targets ............................................................................................ 5-19
Zone Navigator ........................................................................................... 5-19
Advanced Alarm Management .................................................................. 5-19
Scheduler ................................................................................................... 5-20
Axeda Remote ............................................................................................ 5-20
Enterprise Server Connection .................................................................... 5-20
RePlay ......................................................................................................... 5-21
Defining Tags .......................................................................................................................... 9-4
   General Tab .......................................................................................................................... 9-5
   Compound Tag Source Parameters ...................................................................................... 9-9
   Record Tab .......................................................................................................................... 9-15
   Dynamic Data Exchange (DDE) Link Tab ........................................................................... 9-16
   Lock Tag .............................................................................................................................. 9-20
   Alarms Tab ........................................................................................................................... 9-22

Single Tag Input ...................................................................................................................... 9-25

MultiAdd Tags ....................................................................................................................... 9-26

System Tags ............................................................................................................................ 9-28

Exporting Tags ....................................................................................................................... 9-29
   Fixed (GLS File) Format .................................................................................................... 9-31
   Exporting Tag Definition Files Using an External Application .......................................... 9-32
   Importing Tags .................................................................................................................. 9-33
   Importing Tag Definition Files Using an External Application .......................................... 9-33

Defining Tag Properties ......................................................................................................... 9-34

Chapter 10, Tag Filter Module ................................................................. 10-1
   Tag Filter Module Overview .............................................................................................. 10-2

   Accessing the Tag Filter .................................................................................................... 10-3
      Tag Filter Properties ...................................................................................................... 10-4

   Tag Filter in the Image Module .......................................................................................... 10-7
      Tag Value Lock ............................................................................................................... 10-9
      Modifying Tag Lock Values ............................................................................................ 10-10
      Running the Tag Lock on the Web .................................................................................. 10-11

Chapter 11, Tag Mapper ............................................................ 11-1
   Tag Mapper - Overview ...................................................................................................... 11-2

   Accessing the Tag Mapper ................................................................................................ 11-3
      Creating a Tag Mapper Table .......................................................................................... 11-5
      Customizing Tag Mapper Dialog Boxes ........................................................................ 11-16
   Tag Mapper Tags in the Image Module ............................................................................. 11-16
Chapter 12, Multiple Tags ........................................... 12-1
Overview ...................................................................................................................... 12-2
Accessing Multiple Tags .............................................................................................. 12-2
Defining a Tag List File and Defining a Tag Filter .................................................... 12-2
  Tags Exerciser Program Window ........................................................................... 12-4
  Find Tag ................................................................................................................. 12-6
  Zoom Tag ............................................................................................................... 12-7
  Saving the Tag List ................................................................................................. 12-8

Chapter 13, Alarms ................................................................. 13-1
Overview ...................................................................................................................... 13-2
Basic Principles ........................................................................................................... 13-2
  Alarms in Events Summaries ............................................................................... 13-2
  Alarm Objects in Images ....................................................................................... 13-3
  Alarm Filters ......................................................................................................... 13-3
Defining Alarms ........................................................................................................... 13-3
  General Tab ......................................................................................................... 13-4
  Assigning Names to Alarm Classes ................................................................... 13-13
  Assigning User Field Names .............................................................................. 13-14
  Action on Alarm ................................................................................................. 13-15
Alarm Levels ............................................................................................................. 13-19
Exporting Alarms ....................................................................................................... 13-21
  .ALS File Format ............................................................................................... 13-24
  Exporting Alarm Definition Files Using an External Application ...................... 13-25
Importing Alarms ..................................................................................................... 13-25
  Importing Alarm Definition Files Using an External Application ..................... 13-26
Alarm Properties ....................................................................................................... 13-27
  Specifying a Login/Logout Message ............................................................... 13-28
  Determining a Time Format .............................................................................. 13-31
  Determining Hotbackup .................................................................................... 13-32
  Determining Network Communications Errors .............................................. 13-32
  Determining VPI Communication Errors ........................................................ 13-33
  Determining User Login Parameters .................................................................. 13-33
  Determining WIL Diskfull .................................................................................. 13-34
  Tag Lock .............................................................................................................. 13-34
Finding Alarms ........................................................................................................... 13-35
Chapter 14, Alarm Filters, Printers & Printer Targets .......................... 14-1

Overview ...................................................................................................................... 14-2
  Alarm Filters .............................................................................................................. 14-2
  Printers ..................................................................................................................... 14-2
  Printer Targets .......................................................................................................... 14-2
  Workflow .................................................................................................................... 14-2
Defining Printers ......................................................................................................... 14-3
  General Tab .............................................................................................................. 14-4
  Alarm Properties Tab .............................................................................................. 14-6
  Colors Tab ............................................................................................................... 14-7
  Line Printing Tab .................................................................................................... 14-9
Defining Alarm Filters ................................................................................................. 14-10
  General Tab ......................................................................................................... 14-12
  Network Tab ........................................................................................................... 14-14
  Counters Tab ......................................................................................................... 14-15
Defining Printer Targets ............................................................................................... 14-16

Chapter 15, Advanced Alarm Management .............................. 15-1

Advanced Alarm Management (AAM) Overview .............................................................. 15-2
Getting Started ........................................................................................................... 15-3
  Requirements ........................................................................................................... 15-3
  Plug Upgrade ......................................................................................................... 15-3
  Workflow for Alphanumeric Messages .................................................................. 15-4
  Workflow for Vocal Messages ............................................................................... 15-5
  Configuring AAM ................................................................................................... 15-6
Channels ...................................................................................................................... 15-7
  Defining Channels ................................................................................................. 15-8
Pager Services ........................................................................................................... 15-18
  Defining Paging Service Setup .............................................................................. 15-18
  Adding Pager Services .......................................................................................... 15-19
  Remove Pager Services ........................................................................................ 15-20
  Defining Call Management .................................................................................. 15-20
  Driver Setup ........................................................................................................... 15-20
  Email Driver Configuration (Direct SMTP connection) ........................................ 15-20
Vocal Server ............................................................................................................... 15-23
  Voice Synthesis Parameters ................................................................................. 15-25
User Message Format ....................................................................................................... 15-34
  Email Message Format .................................................................................................. 15-34
  SMS Message Format ................................................................................................. 15-34
  Pager Message Format ............................................................................................... 15-35
  Fax Message Format .................................................................................................. 15-35
  Printer Message Format .............................................................................................. 15-36
  Voice Message Format ............................................................................................... 15-36
Advanced Alarm Viewer ................................................................................................... 15-37
  Event Log Journal ....................................................................................................... 15-39
  Customizing the Event Log Journal Window ............................................................... 15-41
Message Formatting .......................................................................................................... 15-44

Chapter 16, The Application Network .........................16-1
Overview ...................................................................................................................... 16-2
Basic Concepts ................................................................................................................ ... 16-2
  Application Station ......................................................................................................... 16-2
  Application SCADA Station ........................................................................................... 16-2
  Application Hot Backup Station ..................................................................................... 16-3
  Application VIEW Stations ............................................................................................ 16-3
  Application SERVER Station .......................................................................................... 16-3
  Management View Station ............................................................................................ 16-4
Configuring the Application for Networking .................................................................... 16-5
  Time Setting Considerations ........................................................................................ 16-5
Configuring Application Network Stations ....................................................................... 16-5
  Configuring an Application Server Station .............................................................. 16-6
  Configuring SCADA and VIEW Stations ................................................................. 16-6
  Querying the Status of a Station with Application Language ...................................... 16-7
  Configuring a Hot Backup Station .............................................................................. 16-7
  Updating an exiting Hot Backup application ............................................................ 16-10
  Configuring a Management View Station .................................................................... 16-10
Recording Remote Data ................................................................................................... 16-12
Network Properties .......................................................................................................... 16-15
  General Tab ................................................................................................................ 16-16
Local Station Tab ............................................................................................................. 16-17
  Protocol Tab ............................................................................................................... 16-18
  Internet Tab ............................................................................................................... 16-19
  Backup Tab ............................................................................................................... 16-20

Axeda
# Chapter 19, Image Editor

## Overview

### Basic Principles

- Objects
- Drawing Space
- Image Window
- Fast Actions
- Lock Object
- Zoom Level
- Layers
- Zones
- Goto Zones
- Zone Navigator
- Toolboxes
- Image Files
- ASCII Files
- Bitmap

### File Menu

- New Image Files
- Open Files
- Saving Files
- Deleting Files
- Inserting Files
- Importing Files
- File Attachment
- Printing Images

### Edit Menu

- Undo/Redo
- Copy/Paste to Clipboard
- Copy/Paste Attributes
- Copy/Paste Attributes for Grouped Objects
- Image Parameters
- Bitmap
- Find/Find Next
- Aligning Objects
- Select Options
- Drawing Options
- Drawing Lines and Segmented Shapes
Drawing Arcs ................................................................. 19-26
Drawing Pipes ................................................................. 19-27
Text ................................................................................. 19-27
Font Style Selection ......................................................... 19-27
Modifying Text ................................................................. 19-30
Specifying Line Properties ............................................... 19-31
Colors .............................................................................. 19-31
Setting the Image Background Color ................................. 19-31
Saving and Getting Colors ............................................... 19-32
Pick Color Tool ............................................................... 19-32

View Menu ........................................................................ 19-33
ToolBar .............................................................................. 19-33
Font Bar ............................................................................. 19-34
Status bar ......................................................................... 19-35
Objects Toolbox ............................................................... 19-35
Operations Toolbox ......................................................... 19-36
Patterns Toolbox .............................................................. 19-36
Align Toolbox .................................................................... 19-37
Color Toolbox .................................................................... 19-37
Additional Drawing Tips .................................................. 19-38
Grouped Objects .............................................................. 19-38

Layers Menu ...................................................................... 19-40
Elaborate on ...................................................................... 19-41
Active Layer ...................................................................... 19-41
Definition ........................................................................... 19-41
Override Show/Hide ......................................................... 19-43
Move Object to Active Layer ............................................. 19-44

Cluster Menu ..................................................................... 19-44
Cluster Library ................................................................. 19-45
Defining Clusters ............................................................. 19-46
Linked Tags and Alarms ...................................................... 19-47
Special Tokens .................................................................... 19-48
Open Lib ............................................................................. 19-51
Breaking/Editing Clusters .................................................. 19-53
Deleting a Cluster from the Library ..................................... 19-54
Copying Clusters from One Library to Another ................... 19-55
Rebuild Instances ............................................................. 19-56
Cluster Baskets ................................................................. 19-57
Open Cluster Basket Objects .............................................. 19-59

Options Menu ..................................................................... 19-60
Autowindow ........................................................................ 19-61
Defining Alarm Reports ................................................................. 22-29
History Folder Settings .................................................................. 22-32

Popup Events Summary .................................................................. 22-33
Designing Popup Events Summaries ............................................... 22-35
Popup Events Summary Buzz .......................................................... 22-39

Events Summary Properties ......................................................... 22-43
Defining Events Summary Window Attributes ............................... 22-45

Chapter 23, Events Summary Profiles & Popups ....23-1
Overview .................................................................................. 23-2
Events Summary Profile ............................................................. 23-2
Events Summary Viewer ................................................................ 23-2
Interacting with the Events Summary Viewer ............................... 23-3
History Mode ............................................................................... 23-4

Defining and Modifying Events Summary Profiles ...................... 23-5
Alarm Filters Tab ........................................................................ 23-7
Display Tab ................................................................................. 23-13
Features Tab .............................................................................. 23-15
Colors Tab ................................................................................ 23-16
Configuring Alarm Reports to Display Historical Information .... 23-17

Creating Events Summary Viewers ............................................. 23-19
Default Location of Events Summary Profile Files .................... 23-20

Popup Event Summaries .............................................................. 23-21
Designing Popup Events Summaries ........................................... 23-21
Viewing a Popup Events Summary in a Browser ....................... 23-22
Enabling Popup Events Summary Display in Browsers ............. 23-23

Chapter 24, Charts ................................................................. 24-1
Overview .................................................................................. 24-2
Mouse Operations on the Time Scale ......................................... 24-2
Data Box Window ...................................................................... 24-3
Cursor Shapes .......................................................................... 24-3

Basic Concepts ......................................................................... 24-3
Graphs ..................................................................................... 24-3
Online/History ......................................................................... 24-3
Data Box .................................................................................. 24-3
Viewing Conventions ................................................................................................................................. 24-4

Menu Options ........................................................................................................................................... 24-4
  File Menu ............................................................................................................................................... 24-4
  Setup Menu .......................................................................................................................................... 24-4
  Modes Menu ......................................................................................................................................... 24-5
  Operations Menu ................................................................................................................................. 24-5
  Options Menu ...................................................................................................................................... 24-6

Chart Definition ...................................................................................................................................... 24-6
  Opening a Chart Window ..................................................................................................................... 24-6

Time Definition ........................................................................................................................................... 24-7

Graph Definition ........................................................................................................................................... 24-9
  Tag Value Display ............................................................................................................................... 24-10
  Control Limits .................................................................................................................................... 24-14
  Logarithmic Display ............................................................................................................................. 24-14
  Fill Reference ...................................................................................................................................... 24-14
  Tag Scales ........................................................................................................................................... 24-15
  Setting Control Limits ........................................................................................................................ 24-15
  Specifying a Description for the Chart ............................................................................................... 24-16
  Setting Reference Graph Parameters .................................................................................................. 24-17

X Axis Definition ...................................................................................................................................... 24-22

Modes ..................................................................................................................................................... 24-25
  History Mode ...................................................................................................................................... 24-25
  Online Mode ....................................................................................................................................... 24-26

Scrolling and Zooming ........................................................................................................................... 24-27
  Scrolling ............................................................................................................................................... 24-27
  Zooming .............................................................................................................................................. 24-28

Data Box ......................................................................................................................................................... 24-31
  Data Box Setup .................................................................................................................................. 24-31

Grids ............................................................................................................................................................ 24-33
  Grid Setup .......................................................................................................................................... 24-33
  Grid Activation ................................................................................................................................... 24-34

Chart Properties ......................................................................................................................................... 24-35
  Defining Chart Window Attributes ..................................................................................................... 24-36

Additional Features ................................................................................................................................... 24-37
  Background Color ............................................................................................................................... 24-37
  Smoothing Graphs ............................................................................................................................... 24-38
  Crosshair ............................................................................................................................................ 24-38
Chapter 25, Trends ..................................................25-1
Overview ................................................................. 25-2
  Trend Profile ......................................................... 25-2
  Trend Viewer ......................................................... 25-2
  Interacting with Trend Viewers .............................. 25-4
Creating Trend Profiles ............................................. 25-4
  Adding a Tag to the Trend Profile ............................ 25-5
  Specifying the Date and Time ............................... 25-7
  Specifying the X Axis Time Format ....................... 25-11
  Specifying Trend Profile Display ......................... 25-12
Creating Trend Viewers ............................................ 25-13
Modifying Trend Viewers ......................................... 25-15
  Modifying the Tag List .......................................... 25-15
  Modifying the Start Time of Data Display ................ 25-16
Displaying a Grid .................................................... 25-17
  Specifying the Orientation of the Grid Axes ............ 25-19
Inserting Trend Profiles ........................................... 25-20
  Changing the Default Location of Trend Profile Files 25-20
Web Application Properties ...................................... 25-22

Chapter 26, Generating HTML Pages ......................26-1
Overview ................................................................. 26-2
  Planning Ahead ...................................................... 26-3
Generating HTML Pages with the HTML Assistant .... 26-4
  Generating a Single HTML Page With Two or More Objects 26-4
Html Properties Dialog Box ..................................... 26-7
  Popup .................................................................. 26-7
Chapter 27, Application Language ...................... 27-1

Overview ..................................................................................................................... 27-2

Basic Principles ............................................................. 27-2
  Language Activation ............................................... 27-3

Language Setup .......................................................... 27-3

Language Definitions .................................................. 27-5
  Statement Definition ................................................. 27-7
  If/Then ................................................................. 27-8
  Loading a Statement File to a Printer or a File .......... 27-9
  Finding Text .......................................................... 27-10

Application Language Format ........................................ 27-11
  Variables .............................................................. 27-11
  Expression Operators ............................................. 27-13
  Expressions .......................................................... 27-15
  Commands ............................................................ 27-16

Points to Remember .................................................... 27-36
  Alarms ................................................................. 27-36
  Bit Testing ............................................................ 27-36
  Initialization .......................................................... 27-37
  External Programs .................................................. 27-37
  Tags ........................................................................ 27-37

Chapter 28, Scheduler .................................................. 28-1

Scheduler for Internet - Overview .............................. 28-2
  Secure Access ........................................................ 28-2
  Enhanced Settings ................................................. 28-2
  Task ..................................................................... 28-3
  Template .............................................................. 28-3
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>28-3</td>
</tr>
<tr>
<td>Action</td>
<td>28-3</td>
</tr>
<tr>
<td>Special Day</td>
<td>28-3</td>
</tr>
<tr>
<td>Adding Temporary Date Changes</td>
<td>28-4</td>
</tr>
<tr>
<td>Temporary Daily Programs</td>
<td>28-4</td>
</tr>
<tr>
<td>Architecture</td>
<td>28-4</td>
</tr>
<tr>
<td>Database</td>
<td>28-4</td>
</tr>
<tr>
<td>Server</td>
<td>28-5</td>
</tr>
<tr>
<td>Requirements</td>
<td>28-5</td>
</tr>
<tr>
<td>Installation</td>
<td>28-6</td>
</tr>
<tr>
<td>Enabling the Scheduler</td>
<td>28-6</td>
</tr>
<tr>
<td>Accessing the Scheduler</td>
<td>28-7</td>
</tr>
<tr>
<td>The Scheduler Interface</td>
<td>28-12</td>
</tr>
<tr>
<td>Toolbar</td>
<td>28-13</td>
</tr>
<tr>
<td>Outlook Bar</td>
<td>28-20</td>
</tr>
<tr>
<td>Workflow</td>
<td>28-20</td>
</tr>
<tr>
<td>Creating New States</td>
<td>28-21</td>
</tr>
<tr>
<td>Opening Existing States</td>
<td>28-22</td>
</tr>
<tr>
<td>Creating a New Template</td>
<td>28-23</td>
</tr>
<tr>
<td>Opening Existing Templates</td>
<td>28-24</td>
</tr>
<tr>
<td>Creating Tasks</td>
<td>28-28</td>
</tr>
<tr>
<td>Opening Existing Tasks</td>
<td>28-29</td>
</tr>
<tr>
<td>Week Overview</td>
<td>28-35</td>
</tr>
<tr>
<td>Creating Actions</td>
<td>28-36</td>
</tr>
<tr>
<td>Special Days</td>
<td>28-38</td>
</tr>
<tr>
<td>Opening Existing Special Days</td>
<td>28-38</td>
</tr>
<tr>
<td>Temporary Daily Programs</td>
<td>28-41</td>
</tr>
<tr>
<td>Server</td>
<td>28-43</td>
</tr>
<tr>
<td>Scheduler Tips</td>
<td>28-45</td>
</tr>
<tr>
<td><strong>Chapter 29, Recipes</strong></td>
<td>29-1</td>
</tr>
<tr>
<td>Overview</td>
<td>29-2</td>
</tr>
<tr>
<td>Recipe Files</td>
<td>29-2</td>
</tr>
<tr>
<td>Models</td>
<td>29-2</td>
</tr>
<tr>
<td>Write Blocks</td>
<td>29-2</td>
</tr>
<tr>
<td>Recipe Model Creation and Modification</td>
<td>29-3</td>
</tr>
<tr>
<td>Recipe Creation and Modification</td>
<td>29-5</td>
</tr>
<tr>
<td>Recipe Creation</td>
<td>29-5</td>
</tr>
</tbody>
</table>
Chapter 30, History Viewers .......................... 30-1

History Viewer List Definition ............................................. 30-2
  Generating a History Viewer List ......................................... 30-2
  Filter Definition ....................................................................... 30-3
  Historical Data Directory ......................................................... 30-5
  Loading an Existing History Viewer ........................................ 30-6

Defining History Viewer Window Attributes .......................... 30-7

Chapter 31, Reports ................................. 31-1

Overview .................................................................................. 31-2

Report Definition and Modification ......................................... 31-2
  Accessing the Report Definition Dialog Box ......................... 31-3
  Creating a Frame ...................................................................... 31-4
  Entering Field Codes ............................................................... 31-5
  Inserting Field Definitions ....................................................... 31-7
  Importing HTML Templates ..................................................... 31-8

Field Definition Types ............................................................. 31-10
  Integral .................................................................................. 31-13
  Weighted Average ................................................................. 31-14
  Total Time for Range ............................................................. 31-14
  Current Value ........................................................................ 31-15
  Compound Field Type ............................................................ 31-16
  Multiple Field Types .............................................................. 31-18
  Time Field Type ..................................................................... 31-20
  Date Field Type .................................................................... 31-21
  String Tag Field Type ............................................................ 31-21
Field Summary ................................................................................................................. 31-23
Saving Reports ................................................................................................................ .. 31-25
  Generating a List of Report Fields ................................................................................. 31-26
  Using a List .................................................................................................................. 31-26
  List File Editing Recommendations ........................................................................... 31-27
Generating Reports ........................................................................................................... 31-28
  Command Line Report Generation ............................................................................. 31-28
  Application Language Report Generation ................................................................. 31-29

Chapter 32, Macros ........................................................................................................... 32-1
Overview ...................................................................................................................... 32-2
Basic Concepts ............................................................................................................ 32-3
  Macro File ................................................................................................................... 32-3
Macro Definition .......................................................................................................... 32-4
  Defining Action Macros ............................................................................................. 32-6
  Defining Command Macros ......................................................................................... 32-10
  Defining Sequence Macros ......................................................................................... 32-11
  Defining the DDE Command Macro ......................................................................... 32-12
  Modifying Macros ...................................................................................................... 32-13

Chapter 33, Network Application Update ...................................................................... 33-1
Overview ...................................................................................................................... 33-2
  Remote Update Settings Dialog Box ......................................................................... 33-3
  Adding Stations .......................................................................................................... 33-5

Chapter 34, Enterprise Server Connection .................................................................... 34-1
Enterprise Server Connection - Overview .................................................................... 34-2
  Enterprise Server ....................................................................................................... 34-2
Requirements .............................................................................................................. 34-3
Setup .............................................................................................................................. 34-3
  Connecting between Tags, Alarms & Enterprise Server Connection ......................... 34-4
Chapter 35, Axeda Systems Remote Module  ....... 35-1
Overview .......................................................... 35-2
Architecture .................................................. 35-3
Requirements ................................................ 35-4
   Hardware .................................................. 35-4
   Software .................................................. 35-4
   System Requirements .................................. 35-4
Workflow ..................................................... 35-5
Users Station .................................................. 35-6
   Configuring Properties .............................. 35-6
   Axeda Systems Remote Session ............... 35-8
Viewers Station .............................................. 35-9
   Configuring the Enterprise Viewer Connection 35-9
   Other Viewer Station Options .................. 35-13
Server ......................................................... 35-16

Chapter 36, Application DDE Support .............. 36-1
Overview ..................................................... 36-2
   DDE Address .......................................... 36-2
   DDE Transactions .................................... 36-3
   DDE Overview ....................................... 36-4
Using the Application as a DDE Client ............. 36-4
DDE Client Definition ..................................... 36-5
   Specifying a DDE Address for Tags .......... 36-7
DDE Client Block ......................................... 36-8
   DDE Client Blocks Definition and Modification 36-8
   Connecting Tags to One Item in a DDE Block 36-10
DDE Command ............................................ 36-11
Activating the DDE Client (DDEC) .................. 36-12
   Important DDE Client Notes .................. 36-12
DDE Server (DDES) ....................................... 36-12
   Using the Application as a DDE Server ...... 36-13
   Defining the Application to run as a DDE Server 36-13
   Specifying a DDE Address .................... 36-14
   Activating the DDE Server (DDES) .......... 36-14
Excel to the Application Data Transfer ................................................................. 36-15
An Application Macro From Client ................................................................. 36-16

Chapter 37, Application SQL Support .............................................. 37-1

Overview ..................................................................................................................... 37-2
The Application’s SQL Connection Module ...................................................... 37-2

ODBC SQL Support ........................................................................................................ 37-3
ODBC Configuration ...................................................................................................... 37-3

Activating Application SQL .................................................................................. 37-5
Activating application SQL from the Command Prompt ....................................... 37-6
Activating application SQL from the Application Setup Menu Item .................... 37-6

The Application SQL File ......................................................................................... 37-7
Sample Application SQL Program ........................................................................... 37-8

Application SQL Commands - Overview ................................................................. 37-10
Application SQL Condition ...................................................................................... 37-13
SQL Command ........................................................................................................... 37-14
Connect/Disconnect .................................................................................................. 37-14

Adding, Updating and Deleting Data ................................................................. 37-17

Retrieving Data ....................................................................................................... 37-19

String Expression ..................................................................................................... 37-20

Application Command ................................................................................................. 37-21
Tag Assignment ........................................................................................................... 37-21
Save/Load Recipe ......................................................................................................... 37-24
Block Command ........................................................................................................... 37-24
Program Header .......................................................................................................... 37-25

Program Initialization ................................................................................................. 37-25

Program Termination ................................................................................................. 37-26

Communication Failure Processing ........................................................................... 37-26

Application SQL Messages ......................................................................................... 37-27
Application Messages ................................................................................................... 37-28
Appendix A, Application Files .................................................A-1

Appendix B, Wiztune.dat File .................................................B-1

Overview ...................................................................................................................... B-2
  Accessing the Wiztune.dat File .......................................................................................B-3
  WIZTUNE.DAT ................................................................................................................B-3

Wiztune.dat Parameters ....................................................................................................... B-8
  ALERT_END_USER_ABOVE_ACK ................................................................................B-8
  ALERT_PRT_CONDENSE ..........................................................................................B-9
  ALERT_TIME_FORMAT ............................................................................................B-9
  ALGEN_REGARD_STATE ..........................................................................................B-10
  ANN_AUTO_SCROLL_TO_TOP ................................................................................B-10
  ANN_DOUBLE_CLICK ..............................................................................................B-11
  ANN_FONTSIZE .......................................................................................................B-11
  ASKSAVELAYOUT ....................................................................................................B-12
  ASSIST_HELP_BUTTON ..........................................................................................B-12
  ASSIST_PRINT_BUTTON ......................................................................................B-13
  AUDIT_TRAIL_DSN_NAME .....................................................................................B-13
  AUDIT_TRAIL_ENABLE ............................................................................................B-14
  AUTORESTART .........................................................................................................B-14
  CHART_SCALE_EXTRA_WIDTH .................................................................................B-15
  CHR_MULTIMARKERS ............................................................................................B-15
  CHR_SHOW_COMPRESSION_WARNING ................................................................B-16
  COMMERR_TIMEOUT .............................................................................................B-16
  DEFAULTUSER ........................................................................................................B-17
  DRAW_EXCLUSIVE_RECT ........................................................................................B-17
  DRV_TIMEOUT_FACTOR ........................................................................................B-18
  FULL_SECURE_LOGOFF ...........................................................................................B-18
  HOTBACKUP_UPDATE_ALARMS ...........................................................................B-19
  HOTBACKUP_UPDATE_TAGS ...................................................................................B-19
  IMG_BLINKRATES ..................................................................................................B-20
  IMG_CLUSTER_LEFT_DRAGDROP ...........................................................................B-20
  IMG_CLUSTER_USE_LAYER ....................................................................................B-21
  IMG_EDIT_REFRESH ..............................................................................................B-21
  IMG_FAST_ZONE_THRESHOLD ................................................................................B-22
  IMG_FONT_H ...........................................................................................................B-22
  IMG_FONT_W ...........................................................................................................B-22
  IMG_GRAD_STEP ....................................................................................................B-23
  IMG_HIGHLIGHT_ON_SELECTION .......................................................................B-23
  IMG_MAX_FAST_ZONES ........................................................................................B-24
  IMG_MONO_FONT_H .................................................................................................B-25
IMG_MONO_FONT_W .......................................................... B-25
IMG_MULTI_SELECT_IF_ALL .......................................................... B-26
IMG_PARSEONLOAD .......................................................... B-26
IMG_POOLSIZE .......................................................... B-27
IMG_RESFACTOR .......................................................... B-27
IMG_SMALL_INPUT_BOX .......................................................... B-28
IMG_STOP_UPDATE_ON_TRG .......................................................... B-28
IMG_USE_SEPARATOR .......................................................... B-29
IMGMAXWAIT .......................................................... B-30
IMGMINWAIT .......................................................... B-30
IMGWIZMSGBUF .......................................................... B-31
LGRBUFFSIZE .......................................................... B-31
LGRFLSHTIME .......................................................... B-32
LOGGER_TIMEOUT .......................................................... B-32
LOGIN_TEXT .......................................................... B-33
LOGOUT_TEXT .......................................................... B-33
MLS_RELOAD_OPEN_ALARMS .......................................................... B-34
NET_BROADCASTTIMEOUT .......................................................... B-34
NET_CHECKRETYR .......................................................... B-35
NET_CHECKTIMEOUT .......................................................... B-35
NET_COM_ERR_POPUP .......................................................... B-36
NET_COMMCHECK .......................................................... B-36
NET_HOTBACKUP_ADDR .......................................................... B-37
NET_HOTBACKUP_MAXPAUSETIME .......................................................... B-37
NET_HOTBACKUP_MODE .......................................................... B-38
NET_HOTBACKUP_UPDATE_STATION .......................................................... B-38
NET_LAN_ADPTR_NUM .......................................................... B-39
NET_MAXCHANGESDELAY .......................................................... B-39
NET_MAXTIMEDELAY .......................................................... B-40
NET_NOBROADCAST .......................................................... B-40
NET_PINGCHECK .......................................................... B-41
NET_PINGRETRY .......................................................... B-41
NET_PINGTIMEOUT .......................................................... B-42
NET_PROTOCOL .......................................................... B-42
NET_QUERY_ADD_TIMEOUT_RETRY .......................................................... B-43
NET_QUERY_TIMEOUT .......................................................... B-43
NETWORK .......................................................... B-43
NEW_DBF_DATE .......................................................... B-44
OLD_NET_USER_AUTH .......................................................... B-45
PLUG_START_MESSAGE .......................................................... B-45
PREFIX_SPACE .......................................................... B-46
PRINT_TO_RIGHT .......................................................... B-46
PRINTER_FORMAT ................................................................................................................B-47
PRINTER_LINE ......................................................................................................................B-47
RECIPEPEGATE ....................................................................................................................B-48
SHOWDONEBAR ...................................................................................................................B-48
STARTUP_RECIPE ................................................................................................................B-49
TRG_ACTIVATE ...................................................................................................................B-49
TRG_FEEEDBACK ..................................................................................................................B-50
TRG_TEST_ON_MOVE ..........................................................................................................B-50
TRIGGER_BUTTONS_TIMEOUT ............................................................................................B-51
VFI ........................................................................................................................................B-51
TRG_VISKEY .......................................................................................................................B-52
VFI_DAYS_PER_FILE .............................................................................................................B-52
VF15FST_IDX_SEC ...............................................................................................................B-52
VF15FST_MODE_TIMESTAMP ..............................................................................................B-53
VF15FST_NO_COMM_ERR ....................................................................................................B-53
VF15FST_WRITE_BACK ........................................................................................................B-54
VF15FSTT_IDX_SEC .............................................................................................................B-54
VF15FSTT_MODE_TIMESTAMP ............................................................................................B-55
VF15FSTT_NO_COMM_ERR .................................................................................................B-55
VF15FSTT_WRITE_BACK .......................................................................................................B-56
WIL_DISK_HIGH_LIMIT ......................................................................................................B-56
WIL_DISK_LOW_LIMIT .........................................................................................................B-57
WIZ_DATE_FORMAT .............................................................................................................B-57
WIZ_DATE_SEPARATOR ..........................................................................................................B-58
WIZ_SHOWMMW ...................................................................................................................B-58
WIZDDES_TOPIC_NAME .....................................................................................................B-59
WIZNET_ANN_PROF_DIRECTORY .........................................................................................B-59
WIZNET_HIS_CACHE_DAYS .................................................................................................B-60
WIZNET_IMAGE_DIRECTORY ...............................................................................................B-60
WIZNET_MAXCHANGEDELAY ...............................................................................................B-61
WIZNET_MAXTIMEDELAY .....................................................................................................B-62
WIZNET_MIN_FREE_DISK ......................................................................................................B-62
WIZNET_ROOT_DIRECTORY .................................................................................................B-63
WIZNET_TREND_PROF_DIRECTORY .....................................................................................B-63
WIZPRO_VPI_ROUND ...........................................................................................................B-64
WIZSQL_INTERFACE .............................................................................................................B-64
WIZSQL_ODBC_ATTRIBUTES ...............................................................................................B-65
WIZSQL_ODBC_CODE ..........................................................................................................B-65
WRITE_FORMAT ..................................................................................................................B-65
ALERT_PRT_2_LINES ..........................................................................................................B-66
ALERT_PRINTER_TARGET ................................................................................................. B-66
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Filters</td>
<td>H-2</td>
</tr>
<tr>
<td>API</td>
<td>H-2</td>
</tr>
<tr>
<td>Application Language</td>
<td>H-2</td>
</tr>
<tr>
<td>Application Studio</td>
<td>H-3</td>
</tr>
<tr>
<td>Authorization</td>
<td>H-3</td>
</tr>
<tr>
<td>Axeda Remote</td>
<td>H-4</td>
</tr>
<tr>
<td>Basket</td>
<td>H-4</td>
</tr>
<tr>
<td>Chart</td>
<td>H-4</td>
</tr>
<tr>
<td>Clusters</td>
<td>H-5</td>
</tr>
<tr>
<td>Communication Driver</td>
<td>H-5</td>
</tr>
<tr>
<td>DDE</td>
<td>H-5</td>
</tr>
<tr>
<td>Enterprise Server Connection</td>
<td>H-5</td>
</tr>
<tr>
<td>Events Summary</td>
<td>H-6</td>
</tr>
<tr>
<td>Event Summary Profiles</td>
<td>H-6</td>
</tr>
<tr>
<td>History Viewer</td>
<td>H-6</td>
</tr>
<tr>
<td>Hot Backup Station</td>
<td>H-6</td>
</tr>
<tr>
<td>Html</td>
<td>H-7</td>
</tr>
<tr>
<td>Image</td>
<td>H-7</td>
</tr>
<tr>
<td>Macro</td>
<td>H-8</td>
</tr>
<tr>
<td>Model</td>
<td>H-9</td>
</tr>
<tr>
<td>Momentary Trigger</td>
<td>H-9</td>
</tr>
<tr>
<td>Network</td>
<td>H-9</td>
</tr>
<tr>
<td>PLC</td>
<td>H-9</td>
</tr>
<tr>
<td>Printers</td>
<td>H-10</td>
</tr>
<tr>
<td>Printer Target</td>
<td>H-10</td>
</tr>
<tr>
<td>Recipe</td>
<td>H-10</td>
</tr>
<tr>
<td>Remote Network Application Update</td>
<td>H-10</td>
</tr>
<tr>
<td>RePlay</td>
<td>H-11</td>
</tr>
<tr>
<td>SCADA</td>
<td>H-11</td>
</tr>
<tr>
<td>Scheduler</td>
<td>H-12</td>
</tr>
<tr>
<td>Server</td>
<td>H-12</td>
</tr>
<tr>
<td>Tag</td>
<td>H-12</td>
</tr>
<tr>
<td>Tag Filter</td>
<td>H-14</td>
</tr>
<tr>
<td>Tag Mapper</td>
<td>H-14</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>H-15</td>
</tr>
<tr>
<td>Trends</td>
<td>H-15</td>
</tr>
<tr>
<td>User-Defined Report</td>
<td>H-15</td>
</tr>
<tr>
<td>User Management</td>
<td>H-16</td>
</tr>
<tr>
<td>Users Timetable</td>
<td>H-16</td>
</tr>
<tr>
<td>VFI</td>
<td>H-16</td>
</tr>
<tr>
<td>WizPro</td>
<td>H-16</td>
</tr>
</tbody>
</table>
Index ................................................................. I-1
Chapter 1  About this Guide

About this chapter:

About this Manual on page 1-2, discusses this manual and how to use it.

What You Should Know on page 1-2, discusses what you should know to enable you to work with the application.

Registering Your Product on page 1-2, discusses how to register your application.

Customer Support on page 1-3, discusses how to receive customer support and tells you where to email your enquiries.

Volume 1 on page 1-3, lists the chapters in the first volume of this manual.

Volume II on page 1-4, lists the chapters in the second volume of this manual.
# About this Manual

This User's Guide provides developers and system integrators with the necessary information for building process and control applications with this software product.

If you are using this application for the first time, you may proceed in one of the following ways:

- Read this guide from cover to cover, exactly as it is presented.
- Read Chapters 1 through 6. These chapters provide you with basic information on the installation procedure, guidelines for designing an application, and a description of the Application Studio. Then, read the chapters you need, depending on the tasks you want to perform.
- If you are an experienced user, read Chapter 2 to learn about the available features, and then use the Table of Contents to find the information you need.

*Note: In this manual the names WizSQL, WizLanguage, WizDDE and WizDDES have been named: Application SQL, Application Language, Application DDE and Application DDES. When writing code substitute the word application for Wiz.*

## What You Should Know

Before you start using the application and working through this guide, you should be familiar with the Windows NT and Windows 2000 operating systems. You should also know how to operate an IBM-PC or compatible.

## Registering Your Product

You are important to us, and it's important for us to know who our customers are. Registering your product enables us to provide you with better services and important notifications about the product. Please take a minute to complete the Licensing Agreement included with your product and send it to Axeda Systems Inc.
Customer Support

You can receive technical support from your local distributor. To receive prompt support, make sure that you complete the registration form and send it to Axeda Systems Inc.

The following email addresses can be used to contact our support offices:

- Europe contact: europe.support@axeda.com
- Asia and the Middle East contact: asia.support@axeda.com
- South America and South America international.support@axeda.com
- USA support@axeda.com

In the printed version this manual is divided into two volumes:

Volume 1

Chapter 1, Using this Guide, covers basic information about this manual.
Chapter 2, Introduction to the Application, introduces this application and its features.
Chapter 3, Installation, describes the system requirements and installation procedure.
Chapter 4, Getting Started, provides guidelines for building applications.
Chapter 5, Getting to Know the Application Studio, describes the operational framework of the application.
Chapter 6, Building a Project, describes the application wizard and how to optimize application performance.
Chapter 7, Security and User Management, presents an overview on Authorization and Security and in depth description of User Management.
Chapter 8, Communication Drivers, describes how to define communication drivers and blocks.
Chapter 9, Tags, describes how to define and use tags, which are contact points through which the application receives data from the controller and/or outputs data to it.
Chapter 10, Tag Filter Module, describes how to define and use the Tag Filter module.
Chapter 11, Tag Mapper, describes how to define and use the Tag Mapper module.
Chapter 12, Multiple Tags, describes how to define multiple tags in the application.
Chapter 13, Alarms, describes how to define and use alarms, which are internal system messages that provide the operator with information concerning events generated by the system.

Chapter 14, Alarm Filters, Printers & Printer Targets, gives an indepth description on these modules.

Chapter 15, Advanced Alarm Management, gives an indepth description of the AAM module.

Chapter 16, The Application Network, describes how to design and operate an application Network.

Chapter 17, Users Timetable, gives an indepth description of the User Timetable module.

Chapter 18, Introduction to the Image Module, introduces the user to the Image module.

Chapter 19, Image Editor, describes how to create and view images.

Chapter 20, Image Animation, describes the process of image animation.

Chapter 21, RePlay Module, describes this module and how it works.

Volume II

Chapter 22, Event Summaries, describes different options for alarm display.

Chapter 23, Events Summary Profiles & Popups, describes how to define the way alarms are displayed in a browser.

Chapter 24, Charts, gives an indepth description of the Charts module.

Chapter 25, Trends, describes how to create and modify a Trend Profile, to compare device functionality and correlate actions and responses, and how to create a Trend Viewer that displays these past and current events in a browser.

Chapter 26, Generating HTML Pages, describes how to generate and edit HTML pages.

Chapter 27, Application Language, describes how to create programs that enhance system capabilities.

Chapter 28, Scheduler, describes the Scheduler and discusses how to use this feature in an application.

Chapter 29, Recipes, describes how to create, define and apply recipes and model recipes.
Chapter 30, History Viewers, describes how to generate and use History Viewer lists to provide you with simple and straightforward data concerning tags and tag values over specific periods of time.

Chapter 31, Reports, describes how to define customized reports.

Chapter 32, Macros, describes how to define macros.

Chapter 33, Network Application Update, describes this module and discusses how to use it in an application.

Chapter 34, Enterprise Server Connection, describes this feature and discusses how it is used in an application.

Chapter 35, Axeda Systems Remote Module, describes this feature and discusses how it is used in an application.

Chapter 36, Application DDE Support, describes how to define the application as a DDE client or server.

Chapter 37, Application SQL Support describes how to use application SQL both as a client and server.

Appendix

Appendix A Application Files, describes data and configuration files used by the application.

Appendix B Wiztune.dat File, gives an indepth description of the fine-tuning parameters required for the application.

Appendix C VFI5FST (VFI Fast), describes the VFI5FST tuning parameter.

Appendix D Application ASCII (ILS) File Format, describes the structure and format of the application’s ASCI (ILS) file.

Appendix E Wpack/Wunpack, describes how to pack/unpack an application.

Appendix F Errors Log File, discusses the Errors Log File and its function in the application.

Appendix G System Tags, discusses these tags and their function in the application.

Appendix H Glossary, provides a description of the terms and definitions used in this manual.

Index, provides an index listing of the manual.
Chapter 2  Introduction to the Application

About this chapter:

This chapter describes the application and its features.

Introduction to the Application on page 2-2 discusses this software program and the SCADA concept.

Main Features on page 2-4 discusses the main features of this application.
**Introduction to the Application**

This software program is an advanced Supervisory Control and Data Acquisition (SCADA) system used as an applications development tool that enables system integrators to create sophisticated supervisory and control applications for a variety of industries.

This system is an application generator. This means that all the control and monitoring facilities are already built into the system, and only project definitions need to be provided by the system integrator. Minimal computer or programming skills are required.

The application takes advantage of the powerful, preemptive, multi-tasking capabilities of the Windows 2000 and NT operating systems and a built-in event-driven mechanism to achieve utmost performance and data integrity. It also uses its interface mechanisms to implement clear and efficient visualization of its components.

The software enables you to integrate your application with your Internet/Intranet network, promoting real-time supervisory and control using real-time graphics and event-driven information updates from any computing platform. It combines the benefits of SCADA, Java, HTML and Internet.

The production floor can be safely monitored and controlled through a standard web browser. Both factory data and corporate information can be viewed through a common interface, from any desktop or laptop.

An application communicates with control equipment in the field such as Programmable Logic Controllers (PLCs), measuring instruments, and other devices. As the equipment is monitored and data is recorded, the application responds according to system logic requirements or operator requests.
Typical Application SCADA Configuration
Main Features

This section describes the application's main features and concepts. A Glossary appears at the back of this book in which you can find descriptions of additional terms and concepts.

Advanced Alarm Management

Advanced Alarm Management (AAM) uses a multi-service communications platform providing alarm transmission over various communication channels including Internet, SMS, email, fax and voice.

Alarms can be defined according to hierarchy, be filtered, appear on the user's screen as a pop-up message with/without voice, sent to a single user or when defined sent to groups and teams or to a backup user. Additionally, alarms can be defined as system alarms, be delayed, inhibited, locked or defined according to zones.

Authorized users can add comments or instructions to an alarm for future reference. Alarms can be imported/exported to/from previous versions or other files.

Operators can acknowledge the reception of alarms and automatically receive instructions for handling them. Alarms can also be recorded to a history file for reference purposes. See Chapter 15, Advanced Alarm Management.

Alarms

Alarms are configured application messages used to notify operators of exceptional conditions at the workplace. The application generates automatic system messages that provide operators with information about internal system events, such as communication driver failure, network communication errors and others.

Application alarms can be targeted to and be displayed in the Events Summary, appear in a popup window, or be printed out.

Alarms can be defined in order of hierarchy. New alarms can be added (or existing alarms modified) to different levels of the hierarchy tree. Alarms can be defined according to attributes, inhibited, delayed, have Help messages containing instructions on how to handle the cause of the alarm and have comments attached to them. They can also be recorded to history for report purposes. See Chapter 13, Alarms.
**Alarm Filters**

The **Alarm Filters** module filters alarms and reports before they are printed out or written to the Events Summary. Alarm filters are displayed in the Alarm Filters table and defined or modified in the Filter Properties dialog box. Filter properties can be updated, however the name of a filter cannot be changed.

The Alarm Filter filters the alarms sent when parameters defined in tag variants are not met.

After alarms and reports outside the defined categories have been filtered out by the Alarms Filter, the remaining alarms are sent to the Printers defined in the Printer Targets module. (See Chapter 14, Alarm Filters, Printers & Printer Targets. Defining Alarm Filters on page 14-10).

**Automatic Network Optimization**

When there are very fast tag changes at the workstation and the server is too loaded to send all tag changes, this functionality sends the newest tag values to the web client.

If the web client cannot keep up with tag changes from the application for the Internet station it will process the latest tag thereby insuring that the information displayed is always updated.

**Axeda Systems Remote**

Axeda Systems Remote is unique web-based technology used to access and operate remote workstations. This module is designed for the Internet and supports desktop sharing to anyone connected to the Internet.

When running on a remote computer, a local operator can share the computer’s desktop. Operators use their own keyboard and mouse to operate a shared session.

Operators can also transfer files between two computers.

All data passed between the computers is confidential and made secure with 128-bit data encryption. Encrypted data can be unencrypted and read by the module. See Chapter 35, Axeda Systems Remote Module.
Background Processing

The application enables you to process heavy jobs without temporarily disabling the system. While background processing is in progress other operations can be performed.

Background processing operates when:

- Loading an image file that is larger than 30K
- Printing an image
- Generating Events Summary and History Viewer reports
- Using MultiAdd, List, and Use functions in the Tag Definition dialog box. See Chapter 9, Tags.

Built-in Report Generator

The built-in report generator keeps you continuously informed and up to date on all plant activities.

Designed specifically for supervisory and control systems, the report generator can produce customized daily shift reports, periodical reports, and event-driven reports. For more sophisticated reports use WizReport, available on the Value Pack CD.

Charts and Reports

The system's charts provide graphical views of process behavior and operational trends over a period of time. A single chart can display historical and real-time trends in distinctive colors and styles. Charts can also be defined to display a tag's bit.

An X-Y chart can be configured with up to 16 related process parameters. The user can scroll along the X and Y axis while zooming in and out to view the required details. See Chapter 24, Charts and Chapter 31, Reports.

Database Connectivity

The application’s SQL module allows application designers to build event driven SQL queries to read and write system data from and to database tables. This simplifies the exchange of information with other applications. See Chapter 37, Application SQL Support.

Note: The application's database files are saved in Microsoft Access where they can be opened and modified.
**Easy Maintenance**

The software program reduces operating costs by enabling users to build a single application instead of a network solution of multiple applications. In addition, it eases the administrative burden tremendously, since it is Java based and Java is already an integral part of the web browser installed on most desktops.

The application does not need to be installed locally on each station. Updates can be distributed centrally through web servers.

The application's functionality does not introduce new configuration, resource or compatibility issues; nor does it require extra administrative or maintenance effort for each machine. In addition, the application relies on Java's portability and eliminates the need to support different versions of applications on different platforms. The system can be viewed online with a browser.

**Enterprise Server Connection**

The Enterprise Server Connection is a modular embedded application server that provides data acquisition, local decision-making and a web user interface for devices and systems.

The Enterprise Server Connection includes all functionality and XML processing required for two-way Firewall Friendly communication with the Enterprise Server. Connection data and alarms flow easily to the Server through the Internet without local user or IT administration.

Connection to the device can be made through the system's VPI drivers library, be developed using the OPC Toolkit, or through the Connection's APIs.

When installed on a platform that supports file changes, the Enterprise Server Connection can receive product and application updates remotely from the server. The Enterprise Server Connection is designed to enable upgrade of product files while the system is running thereby minimizing downtime.

This module is currently available for Microsoft Windows NT, Windows NT Embedded and Windows 2000; Microsoft Windows CE for x86, SH3, SH4, ARM and MIPS processors; Linux; and NetSilicon ThreadX 3.0. See Chapter 34, Enterprise Server Connection.
Events Summaries

The Events Summaries interface displays alarms according to the user's specifications. The user can apply filters to display only alarms from a defined zone range, severity range, family prefix, station, class and more. Alarms such can also be sorted in the Events Summary.

The Events Summaries also provides multi filtering and alarm inhibition. The Go to Zone feature enables connecting predefined zones to alarms. This means that an alarm can be attached to an image of a problematic zone enabling the user receiving the alarm to easily identify the alarm's whereabouts. See Chapter 22, Event Summaries.

Events Summary Profiles

Events Summary Profiles determine how active alarms and history are displayed in a browser according to the definitions defined by the System Integrator. See Chapter 23, Events Summary Profiles & Popups.

Events Summaries Viewer

The Events Summary Viewer features real-time monitoring of alarms and history according to the definitions specified in the Events Summary Profile. This enables the user to monitor and acknowledge alarms in real-time, adjust alarm display, resize columns, change alert sorting and view alarm history.

Alarm filters can also be changed to view only specific alarms, for example, from a certain zone or according to priority. Filters can also be added and removed without affecting the server side. Html alarm files can be used and the alarm background and text colors can be set according to alert severity and zone.

Similar to the Events Summary display, this viewer shows the following lists; In History Mode, Load Picture, Inhibit, Ack Selected, Force End, Assist, Columns, Filter List and Add Comments.

Hot Backup Support

The system enables one station to serve as a backup to other stations. If the main SCADA system fails, the backup station immediately takes over and continues to function.
Image

The application uses the most advanced techniques for presenting images. They include:

- Drawing a single large image representing the entire plant and then zooming in on a selected area to obtain detailed views of small and even hidden elements. An image can consist of more than 64 layers, with each layer representing specific information. Operators can then choose and mix layers, accessing only the information they need and are authorized to see.

- Defining dynamics so that as parameters in the field change, so do graphical drawings and textual displays.

- Zone Navigator which can be used to navigate through the various application's image zones.

- Defining any object in the image as a trigger, so that whenever the object is selected, one of several operations, such as activating a macro will be automatically performed.

- Designing an image using the powerful, Image Editor that includes a variety of drawing tools designed specifically for the application's requirements. This unique editing feature enables you to easily modify any object and simultaneously apply the changes to all the applications' diagrams.

- Objects in an image file can be locked (and unlocked) to prevent them from being modified or deleted.

In addition to drawing images within the application framework, graphic files generated using other software programs can be imported to the Image Editor.

- The Clusters Library holds a variety of prebuilt objects, including valves, pumps, and other industry-standard components. The user can define or change the parameters of each object and save the changes in the application's database. When a new library is created it can be saved to the Global Cluster Library and used in other applications.

- The Fast Actions triggers are predefined built-in macros that enable you to easily trigger routine operations. Among the available actions are: load/close window, load/close image, load/close chart, load/close events summary.

- Copy and Paste attributes supporting object (line and fill color) and text (font style, size, color and background).

See Chapter 18, Introduction to the Image Module, Chapter 19, Image Editor and Chapter 20, Image Animation.
**Language**

Application Language is a built-in control language, which can be used to automate plant tasks, augment control capabilities, and enhance system flexibility.

This language enables application engineers with little programming expertise to write useful command programs. Each system function, such as access to control devices, can be expressed in symbolic form in application Language, so that any application engineer can customize the application to meet specific plant design requirements. See Chapter 27, Application Language.

**Macros**

Macros are shortcuts that can be used to execute predefined actions, commands, or programs, whenever designated keys or key combinations are activated. This enhances overall application functionality, and saves you the time and effort of having to execute operations in several stages.

Up to 3072 application macros can be defined. See Chapter 32, Macros.

**Milli-second Time Stamping**

The system samples PLCs at up to a 50 milliseconds resolution and can receive data with a time stamp of up to 1 millisecond resolution. This data is registered in the application's history files according to the time stamp. It allows operators to trace the sequence of plant events exactly as they occur.

**Networking**

The application provides a smooth growth path from a standalone workstation through the plant floor configuration to plant-wide network architecture connecting the plant floor with existing file servers and other management systems.

The system network uses client-server architecture. The application can be connected to other workstations or stations using NetBIOS or TCP/IP protocol that have the software program installed. Thus, tags and alarms defined on any application workstation can be used on the same network as the application. See Chapter 16, The Application Network.
Network Application Update

The Network Application Update module enables an application developer to quickly and easily update far station application files remotely. To the station operator this action is invisible. However a record of the update will appear in the station's error.dat file.

An unlimited number of network stations using the application can be defined in the Remote Update Settings dialog box. This dialog box, by default, holds all the files within the application. See Chapter 33, Network Application Update.

Online Design

Changes can be made during runtime and the user can view the results immediately.

Open Architecture

The system integrates seamlessly with existing databases, spreadsheet s or other customized applications, allowing you to focus on productivity rather than compatibility.

- The application's Virtual File Interfaces (VFIs) enable the designer to select different file formats to be used for application historical data logging and report generation. The system engineer can use a combination of different file systems and databases with the application, for data manipulation convenience and optimum performance.
- A comprehensive Application Programming Interface (API) is included with every application package to enable smooth integration with customized programs and application modules.
- The application supports two-way Dynamic Data Exchange (DDE) links for exchanging data with other DDE-compatible applications.
- The application’s SQL interface enables application designers to build event-driven SQL queries to read and write system data from and to database tables, simplifying the exchange of information with other applications.
- The application is managed by a real-time, event-driven kernel. This module includes an API that can be used to write supplemental application programs in C and Visual Basic language, to meet the specific requirements of any project. For further information, refer to the Read Me file in the Toolkit.
- The application is compatible with a wide variety of PLCs and other control system components. Custom adaptation is supported through a fully documented toolkit.
All definitions of alarms and tags are saved in a Microsoft Access Database (MDB). A database can be opened and modified by the user in MS Access.

A history of tag changes can be saved and viewed/opened in a database that supports ODBC.

OPC capabilities enable system integrators to create a common interface for exchanging data with hardware field devices or other software that can be reused by this client program, and other HMI, SCADA and custom applications.

**PLCs Sampler**

The application samples PLCs at up to a 50 milliseconds resolution and can receive data with a time stamp of up to 1 millisecond resolution. Up to 32 networks of PLCs and other field devices can be sampled.

**Printers**

Alarms and their history, tag history, AHP formatted Help files and reports can be printed both on local and network printers. Printing definitions such as color or different text fonts and backgrounds can be defined.

There are two printing modes:

- Graphical printout, which can appear as a page holding a list of events or alternatively, each event is printed on a separate page.
- Line mode printing where each alarm is printed separately in real-time and is added to the list already printed on the page.

See Chapter 14, Alarm Filters, Printers & Printer Targets page 2.

**Printer Target**

A Printer Target is a collection of predefined filters and printers specifying the conditions under which the targeted printer is activated. The Printer Target dialog box holds a list of all the printer targets that have been defined. Each printer target is identified by a unique name and description. See Chapter 14, Alarm Filters, Printers & Printer Targets page 2.
Recipes
Recipes are lists of tag values that are applied to specific control processes such as groups.

Operators can edit, load and save recipes for convenient handling of production processes and setting control programs. Recipe management and downloading production recipes from management systems is simple and straightforward. See Chapter 29, Recipes.

RePlay Module
The RePlay module is used to display/view previous history tag values in images.

When this module is activated a screen opens displaying an image and its tag values as they appeared at a selected time. The application reads and displays the tag values from the application's history.

Only tags that have Write to History defined during Tag Definition can be used. Chapter 21, RePlay Module.

Security
The system integrator responsible for the application can, using the User Management module, grant access permission to users. Users can have full or partial access to the various modules. Access can be defined according to users, groups and teams.

A user password can hold up to 20 characters that can be changed by the user (if defined so the system integrator). Access to the system can also be through a token or PIN number. See Chapter 7, Security and User Management, Security Overview on page 7-7.

Security on the Web
The application takes full advantage of the security features provided by the web server, enabling user access control according to selected web pages. A Firewall can be used to limit access according to IP addresses.

The program also offers the system integrator the power to limit the operations that the user is able to perform. Only authorized users with specific access permission can login to the application.
**Scheduler**

The Internet based Scheduler enables you to easily create daily or weekly task orientated schedules remotely. Accessed through an Internet browser or by clicking on an icon, the Scheduler is extremely user friendly, efficient and economical.

Being both task and time orientated the Scheduler can be used to create unlimited tasks, actions and states. Tasks can be modified, enabled/disabled and have many states such as On/Off attached to them. An unlimited number of actions, which are basic operations, can be attached to each task. See Chapter 28, Scheduler.

**Tags**

An application tag is used as an internal variable for calculations and display and communication with PLCs to represent data from PLC memory, or to send commands to PLCs.

Tag values can be scanned and recorded to historical files according to several parameters specified by the user. Tags can also be assigned an application DDE link definition and can therefore receive or send data to/from other applications.

Predefined built-in System Tags (see Appendix G, System Tags - Overview on page G-2) that provide information about the system can be created. System tags can be for example, time, date, hour etc parameters. The list of System tags can be viewed in the All Container tree.

A tag can also be locked/unlocked according to pre-defined time. This is useful during maintenance enabling the system integrator to lock tags and prevent irrelevant alarms from being sent. A list of all the tags defined in the Lock Tag can be viewed in run-time.

Tags can be imported/exported to/from other applications or previous versions. See Chapter 9, Tags.

**Tag Filter**

The Tag Filter module holds a list of tag filters that can be selected and used for tag lock visualization. This option is accessed in the Application Studio Control Panel or from the Tag Lock dialog box. Tag filters can be selected or created, saved and loaded.

Tag filters are stored in the application in the file TFM.XML that is created in the Docs or appropriate directory of the application and can be accessed through Java applets. Up to 10 tag filters can be selected simultaneously. See Chapter 10, Tag Filter Module.
Tag Mapper

The Tag Mapper is a data file of tags and tag values that can be used to considerably reduce workload during application creation. Tag values of tags held in a Tag Mapper table are mapped by the Tag Mapper into a list of other tags.

There are two types of Tag Mapper tags:

- **Source:** These are tags whose values are directed to target tags. More than one source tag can be pointed to the same target tag.

- **Target:** This tag type receives the values of the source tag. All target tags must have the WIZTGM_ prefix.

An unlimited number of tags can be mapped. The Tag Mapper is bidirectional. All Tag Mapper dialog boxes are resizeable. See Chapter 11, Tag Mapper.

Trend Profiles

The Trend module provides a real time and historical graphical view of tag values over time.

System architecture provides additional benefits for remote control applications and applications where frequent causal access is required. For these applications historical display of data is critical. The Trend features include:

- **Historical cache mechanism:** Offers improved performance with minimum load on the server.

- **Asynchronous historical data download:** As a result the Trend is always responsive to the user.

- **Performance:** On a local area network, trends can be used over a dial-up connection.

- **Display of multiple tags over time.**

- **Historical and on-line data support.**

- **X and Y axis labeling.**

- **Different line colors and line types.**

- The Trend component takes less than 800kb.
**Trend Viewer**

A Trend Viewer displays online activities and history recorded by the application system according to definitions specified in the Trend Profile.

The Trend Viewer functionality enables modification of the chart's tag setup over the Internet without affecting the server side. The Setup menu enables updates to Tags, Time and the Grid, whereas the Options menu enables Axis Orientation, Print and Show Grid. See Chapter 25, Trends.

**User Management**

The User Management module enables management of all the users of the application both locally and remotely. This software program enables definition of user groups and teams and their access permission to the various application modules. A timetable can be set for each user/group/team and alarms, when necessary can be sent to the appropriate personnel. This management methodology allows for easy scheduling of personnel for various tasks.

Providing full backwards compatibility, User Management enables import/export of groups created in/for previous/new versions. See User Management - Overview on page 7-12.

**Zone Navigator**

The Zone Navigator window enables quick and efficient navigation through the list of zones defined in the application's various image objects. Using the Zone Navigator you can define a number of navigators each of which can contain a number of zones from one or more different image files.

The Zone Navigator can be applied to images through either Button or Action type triggers or by configuring an Action type macro. A digital tag representing the zone's status can be added to each Zone Navigator. Additionally, color indicators can also be defined. The multi-image zone navigator can be activated from the Application Studio control panel, from the Studio Design menu or at runtime from the image using a button or action trigger. This feature has web support. See Chapter 19, Image Editor, Zone Navigator on page 19-64.
Chapter 3  Installation

About this chapter:

This chapter describes system requirements and the installation procedure. 

System Requirements on page 3-2 discusses the requirements of the system. 

Installation on page 3-3 instructs you how to install the application. 

Starting the Application on page 3-10 instructs you how to start the application. 

Additional Installations on page 3-10 lists the additional software components installed during application installation.
System Requirements

Before you install the application verify that you have the following:

Hardware

Computer: Pentium III 450MHz (recommended 1GHz and up).
Memory: 256MB (recommended 512MB).
Hard Disk: 500MB minimum free. This is required for both installing the program and for later developing an application.

Monitor Adapter: 8MB (Recommended 32MB)
Monitor: Resolution 800X600 or higher
Display: VGA, SVGA, or any graphic adaptor that supports the operating system desktop. The display should be set at 256 colors or higher and the screen resolution should be set at 800 x 600 or higher.

Mouse: Any PC compatible mouse.
Parallel Port: Required for the system's security plug.

Software

Operating System: Microsoft's Windows NT version 4.0, Windows 2000 or Windows XP.

- Correctly configured TCP/IP: A fixed IP address is required for a web server.
- Web server: A web server is required for publishing the application, (not for development).
- Browser: Microsoft Internet Explorer 5 (or higher) and virtual machine. If you are installing the Scheduler then the Microsoft Internet Explorer 5.5 SP2 is required.
- HTML Editor: Any HTML editor may be used. (Optional)

The following is required to publish an application on the web.

- Java 1.1 enabled browser
- A web server. For example, the Microsoft Internet Information Server that can be downloaded from the Microsoft web site.
**Installation**

It is strongly recommended that you close and exit all Windows programs before running the installation procedure.

- **To install the application:**

1. Insert the CD-ROM into the CD-ROM drive. The Axeda Supervisor Welcome window is displayed.

2. Click Yes to open the License Agreement window.
3. Click Yes and then Yes again to accept the Agreement. The Setup dialog box opens
enabling you to either accept the Destination Folder location or to Browse and
define a different location where the program will be saved.

4. Click Next to open the Setup Type dialog box.
The Setup Type dialog box has the following options:

**Typical**  
If Typical is selected the Select Example Files dialog box opens where demo applications can be selected and installed.

**Compact**  
If Compact is selected the application and WizPLC minimal installation pack is installed.

**Custom**  
If Custom is selected the Select Components dialog box opens where the user can select only the relevant components required for the installation. This dialog box also enables you to download a copy of this manual.

5. Make your selection and then click Next to open the Select Example Files dialog box.
6. To install example files, check the relevant checkbox and then click Next to open the Language Selection dialog box.

7. Click the arrow and select the relevant language and then click Next to open the Select WizPLC Version dialog box.
8. Select either Soft and Hard Real Time versions or Soft Real Time version and then click Next.

9. The Shortcut Configuration message opens on your screen. To create the Quick Launch Toolbar click Yes or No not to.

10. The Finish Reboot dialog box opens. Select either Yes to restart your computer or No not to and then click the Finish button to exit the setup program.
Previous Axeda Supervisor Versions

If you have a previous version of the system installed a message box opens reminding you to uninstall it.

Uninstalling the System

The Uninstall function can be used to remove the program from your computer. Only the directories, files, folders, icons and registration originally created by the system's installation program will be removed.

To achieve the best results, exit the application and make sure that the system is not running in the background before using the Uninstall program. If it is working, some files and icons may not be removed.

To launch the application uninstall program:

1. Click the Start button on your desktop, point to Settings and then click on Control Panel. The Control Panel folder is displayed.

2. Double-click on the Add/Remove Programs icon. The Add/Remove Program Properties dialog is displayed.
3. Select the application from the list of available programs and click the Add/Remove button. The Modify, Repair or Remove Program dialog box opens.

4. Make your selection and then click Next to actually uninstall the program from your computer. A message opens on your screen reminding you to restart your computer. Click Yes to restart your computer now or No not to.

Note: It is recommended that you restart your computer after uninstalling the program. The Repair option is not supported in this version.

Caution

It is strongly recommended that a personal web server or IIS be installed on the computer prior to installation.

If the above software components are not installed, a dialog box opens informing you that Setup has detected that the version of Internet Information Server or Personal Web Server required have not been installed. Click Yes to exit system setup so that you can install the missing IIS or PWS or No not to.
**Additional Installations**

The following components are installed during the system's installation if they are not already installed.
- MDAC (Microsoft Data Access Component) 2.6 SP1
- JET40 SP3
- MXML3

**Starting the Application**

To start the application, click on the Start button on your desktop, point to Programs, to Axeda Supervisor and then to the application. Click on the application to open the Studio.

Or,

Double-click on the shortcut application icon on your desktop.

► To create a shortcut to your application (without going through the Project Wizard):

1. Right-click on your desktop, and select New/ Folder from the popup menu.
2. Type in the name of the application and select Shortcut from the popup menu.
3. Type the location and name of your application (*.Wpj) or search for the application by clicking on the Browse button.
4. Click Next and select a name for the shortcut.
5. Click Finish to complete the operation.
Chapter 4  Getting Started

About this chapter:

This chapter describes how to access the system and also suggests a workflow for building an application.

Accessing the Application on page 4-2 describes how to open the application and the Application Studio and also describes the Quick Access bar.

User Login on page 4-5 describes how to log in to the application.

Designing an Application on page 4-10 describes what to do before you begin designing an application, as well as typical application requirements.

Workflow on page 4-12 describes a typical workflow for application design.

Shutting Down on page 4-19 describes how to logout of the system and how exit the application.
Accessing the Application

You can access the application and all its working components by either:

- Clicking the application icon.
- Opening the Application Studio that holds all the components you need to design an application.

To open the application, do the following:

1. Click on Start and point to Programs/Axeda Supervisor, and then to the Application and select it from the popup menu. The Getting Started Wizard is displayed. This wizard enables you to open applications from the Application Studio.

The Getting Started window has three tabs:

- New - creates a new application or opens a template application
- Existing - searches and opens an existing application
- Recent - lists recently used applications
2. After you select and open your application the Quick Access Bar appears on your screen. Click the Application Studio icon in the Quick Access bar to access the Application Studio.

*Note:* For further details on the Wizard see Chapter 6, *Building a Project*.

**Quick Access Bar**

The Quick Access Bar holds the following icon options:

- Show Studio
- Load Layout
- Capture Layout
- Load Image
- Load Events Summary
- Load Chart
- Load History Viewer
- Load Recipe
- Save Recipe
Multiple Tags

Single Tag

WizPLC Development

WizPLC Runtime

Advanced Alarm Management

Users Timetable

Users/Groups

Axeda Remote

Enterprise Server Connection

Scheduler Configuration

Login to the Application
User Login

Local User Login

To login to the system locally, click the Login icon in the Quick Access Bar. The User Login dialog box will open on your screen.

If you know your user name and password type them in the relevant fields and click OK.

Note:

A default login name and password can be defined by the System Integrator and used by all users to login to the system.

A user can also be a member of a group or team. In which case the group/team login name and password are used. (See Chapter 7, Security and User Management).

Remote User Login

The system enables remote users to login and access application options in much the same way as local users.
A remote user can access the same group-assigned options available when logged in as a local user. The definitions behind these options are stored on the server, enabling remote users to access their application from any computer.

The login option has the added flexibility of being enabled or disabled. Users can then either:
- Login using their user name and password and access their group assigned options
- Or,
- Login using a default user name and password and access the options specified for default users

**Login/Logout Quick Access Bar**

The Login/Logout Quick Access Bar, which appears when the browser is opened, enables you to quickly login and out of the system.

The application enables you to replace the Login/Logout bar, and design your own login/logout interface using HTML script. Remote user options will still run in the background.

**To login:**

1. Start the system and access your web application. The browser is launched.
2. A typical browser will display the application icon, which you can click to begin login.

3. You can also click Login on the Login/Logout Quick Access bar displayed in the top left corner of the window to open the User Login.
4. If you know your user name and password type them in the relevant fields and click OK.

*Note: A user can also be a member of a group or team. In which case the group/team login name and password are used.*
To logout:
Click the Logout button, or close your browser.

Default User
The application enables you to create a default user. When a Default User is assigned, after a user logs out of the application, the application automatically opens using the name and password of the Default User.

A default user is created in the User Management module (see Chapter 7, Security and User Management, Creating Users on page 7-13) by selecting Users to open the List of Users and then right clicking on a specific user name and selecting the Default User option. The Users icon will appear next to the selected user name.

Note: Only users that are members of the Administrator group can add users to the application.

Specifying Remote User Login Parameters
The Html Properties dialog box is used to change the properties of the Html module (see Chapter 26, Generating HTML Pages).

To access the Html Properties Dialog Box, do the following
In the All Containers section of the Application Studio, right-click HTML and select Properties from the popup menu. The HTML Properties dialog box is displayed.

This dialog box has two tabs:
- Popup - where you can specify whether or not a Popup Event Summary window is displayed in a browser
- Users - where remote user login parameters are defined
Popup

This dialog enables you to define whether or not a Popup Event Summary display is enabled in a browser. It also enables you to assign group authorization so that the Popup Events Summary is displayed only in the browser of authorized users. Do the following:

1. Check the Enable Popup Window in Browser checkbox to enable this option.
2. Click the Groups button to display the standard Groups dialog box in which you can assign group authorization for Popup Events Summary display.
3. Click OK to save these definitions.
Users

This dialog box enables you to define remote user login parameters.

1. Check the Enable Login Quick Access Bar in Browser checkbox to enable this option. The user can then login to the Web application by pressing the Login button.

2. Check the Automatically Login with Default User checkbox to enable any user to login with a default user name and password. This means that any user can access the application and use the options that are assigned to default users. When this option is not checked the user will be forced to login with a user name and password.

3. Click OK to save these definitions.

Customizing the Login/Logout Procedure

Experienced HTML users can customize the login/logout procedure on their computers by creating buttons in HTML and attaching HTML script, as follows:

<table>
<thead>
<tr>
<th>HTML Script</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>scriptLoginUser()</td>
<td>Displays the Login user dialog box used to login to the system</td>
</tr>
<tr>
<td>scriptLogoutUser()</td>
<td>Logout</td>
</tr>
<tr>
<td>scriptGetCurrentUserName()</td>
<td>Displays the currently logged in user</td>
</tr>
</tbody>
</table>
After customizing the login/logout procedure, deselect the remote user login parameters described on the previous page, so that the Login/Logout Quick Access bar is replaced by your own login interface.

Note: Remote system mechanisms will continue to run in the background.

**Designing an Application**

Before you start designing your application, you need to know some basic, but necessary details about the process for which you are creating the application:

- Obtain a list of variables that the application will read and write from and to a PLC (I/O list or Tag list).
- Look at the control drawings to study the design and use of certain equipment.
- Look at the plant drawings to examine the layout of the plant for which you are designing the system.
- Find out the type of reports users and managers wish to receive, in what format and in which fields.
- Find out the type of network you have, if it uses the NetBIOS or TCP/IP protocol, and the name of your network station.
- Determine any authorization definitions.
- Determine PLC definitions, such as blocks and addresses.

Once you have this background information, you can build an application that fully uses the resources of the plant's equipment. Remember that if you are not aware of the limitations of the equipment, you may cause damage.

If you are creating an application for a networking environment, refer to Chapter 16, *The Application Network* before you start designing the application.

**Designing Multiple Applications**

If you are designing multiple applications, you need to decide where to store your history files this could be on the local disk or on the server.

Using system network tags, the same application can run on many stations. The application can be designed on one station and copied to another station. The only difference will be the station name definition (and number).
Note: The tag, alarm and communication driver definitions should not be copied. It is recommended to define the station name and number before you begin to build your application (Images, Charts and so on).

**Typical Application Requirements**

A successful application takes into account the following:

**Consistent Display Design**

Process visualization accurately represents an on-going plant process, enabling a user to clearly understand the process status at any given time.

It is recommended that displays in the visualization remain consistent throughout the application. For example, if a tank's fill status is represented in percentage form, then all fill status should be represented in percentages. See Chapter 18, Introduction to the Image Module, Chapter 19, Image Editor and Chapter 20, Image Animation.

**Alarm Design**

Alarms represent one of the most significant occurrences in a process. It is important to design alarms with different severity levels, zones and characteristics. This way, a user will recognize each alarm and react quickly and correctly. It is important to mark all alarms that are not targeted to an Events Summary with an Auto Ack attribute so that they will not have to be acknowledged by the operator. See Chapter 22, Event Summaries.

**Charts Design**

Charts visually represent the process’s progress. When designing charts, you should take into account user requirements. For example, if a user needs to compare two tags to perform a certain task, it is recommended to include both tags on the same chart. Up to 16 tags may be represented on a single chart. See Chapter 24, Charts.

**Tag Naming Conventions**

Make sure that the name you assign to each tag clearly indicates what the tag represents. For example, all the tags that represent Flow Transmitters may be called FTxxx. This naming method is also convenient when adding a list of tags that are of the same type.
It is also recommended to name the stations in a predetermined manner. For example, according to plant area. See Chapter 9, Tags.

**Logic**

You can use the system's Application Language (see Chapter 27, Application Language) to create an application that can enhance the capabilities of control equipment working with the software program such as PLCs, and establish the connectivity interface between the system and external computer applications.

Compound tags can also be defined in the system. A compound tag is a linear calculation based on values of other tags.

Application scripting language can also be used to implement logic. In addition to providing connectivity to SQL databases, Application SQL (see Chapter 37, Application SQL Support) has powerful language functions and its event driven architecture provides excellent performance.

**Workflow**

This section describes the workflow for building an application.

1. Building a project: The application wizard and Station Properties
2. Defining Communication Drivers and Blocks
3. Defining User Management
4. Defining Tags, Alarms, Event Summaries
5. Building the application Image
6. Defining application logic
7. Testing the application
8. Defining Charts, Reports, Recipes, Printers
9. Fine Tuning

You can merge steps 3 and 4 into one, and complete the step in four stages, define some of the tags, build part of the image, complete the image, define the remaining tags.
Note: If you are building a network application, define a network name and number before you begin the workflow. Remember to restart the application.

**Step 1: Building a Project, the Wizard and Station Properties**

The Getting Started Wizard enables you to create projects either using a template or blank application. The Wizard has three tabs:

- **New** - for building new projects either as a blank application or a template application
- **Existing** - listing all projects created in the application
- **Recent** - listing the most recently used projects

A new project file is saved with the suffix *.Wpj. When the Application Studio opens on your screen the name of the project appears at the route of the All Containers pane.

After the project is saved, Station Properties, which enable you to adjust system parameters to optimize your application working environment can be defined.

▶ **To open the Station Properties dialog box:**

In the All Containers pane right clicking the project name and select Station Properties from the popup menu.
The Station Properties dialog box has the following tabs:

- **General**: Used to customize the application workplace
- **User**: Defines the default user name and password
- **Date Format**: Defines the date style and separator used
- **VFI**: Defines history files format by selecting Virtual File Interface DLL
- **Audit Trail**: Used to log operator actions to a database via an ODBC data source
- **ODBC Connectivity**: Enables application historical data to be saved to various databases through Microsoft ODBC
- **Advanced Alarm Management**: Enables connection to the AAM, a multi service communication platform providing alarm transmission over various channels
- **Scheduler**: Enables connection to the Scheduler where tasks, actions and states can be created and modified over the Internet

*Note: For further details on Station Properties see the Chapter 6, Building a Project.*

**Step 2: Defining Communication Drivers and Blocks**

Blocks are defined logically to maximize the efficiency of the application. This is implemented by defining blocks according to common sampling rates and consecutive addresses in the PLC. After defining communication drivers and blocks restart the application for the changes to take effect. When defining blocks, avoid:

- Leaving gaps of more than 20 addresses within the block.
- Defining blocks with a sampling rate that is different from the individual tag sampling rate.
- Defining the same tags in more than one block.
- Defining large blocks.

*Note: For further details on Communication Blocks see the Chapter 8, Communication Drivers.*
Step 3: Defining User Groups

Defining user groups is important at this stage because each subsequent design level may call for user authorization. Once you define the user groups, you can add individual users at any time to any group.

Defining user groups later on in the design process is possible, but not recommended. For example, in a car production plant, engineers, managers and floor workers have different levels of authorization. If you assign authorization rights early in the design process, you will save valuable time in later stages of the design.

Note: For further details on Creating Groups see page 26 in Chapter 7, Security and User Management.

Step 4: Defining Tags and Alarms

Defining Tags

Tags are I/O points that are mapped from PLCs to the application as well as to internal (dummy) and calculated (compound) variables. You can use tags in images, charts, alarms and all application functions.

When defining tags, make sure that tag and block sample rates do not conflict with each other.

Note: For further details see Chapter 9, Tags.

Defining Alarms

Once you define the tags, continue by defining the alarms. Alarms notify a user of an event in the process. They can:

- Indicate the beginning of a process.
- Warn of a failure in part of the process.
- Give instructions on how to handle the alarm.
- Hold user messages about the alarm.
When defining alarms it is possible to:

- Set different severity levels to control grouping and display of the alarms.
- Target serious alarms to a pop-up window, ensuring that users will not perform any systematic function before clearing the alarm. This is recommended.
- Group alarms in families.
- Assign an alarm to an object in an image. This object will then change its graphical attributes whenever the alarm conditions are met.
- Assign a Help file to each alarm so the user will know what to do when an alarm begins.
- Add user comments.

*Note: For further details see Chapter 13, Alarms.*

**Step 5: Building the Application Image**

The Image is a graphical representation of the application process and represents the feedback that the user receives from the plant. The Image is the main part of the application that a user views. Therefore, it should be informative, yet easy to understand.

When designing images, take advantage of the following features:

- The Image Editor that features many different toolboxes to enable you to build your application.
- Zones, different areas of the image that can be viewed in close up. Each zone can represent a different part of a plant process.
- Layers that can be compared to transparent sheets with the same coordinates, which lay on top of each other. You can enable group access to certain layers and thereby control sensitive information.
- Cluster libraries that use object-oriented technology to simplify and speed up application design and maintenance. A cluster is an object with pre-defined behavior patterns and can be linked to existing tags and alarms, or can be used to automatically create new tags and alarms.
- The Image Editor that features many different toolboxes to enable you to build your application.

*Note: For further details on Images see Chapter 18, Introduction to the Image Module, Chapter 19, Image Editor and Chapter 20, Image Animation.*
Step 6: Defining Application Language

Language commands are used to make logic calculations that the PLC cannot perform. Language is written and implemented according to If and Then conditions. For example:

IF: @FLAG =1
THEN: REPORT "Shift"

Some examples of Application Language commands include:

- Starting and stopping a process.
- Loading a recipe.
- Writing to a tag value based on another tag value.
- Writing to a file or printer.

Note: For further details on Language see Chapter 27, Application Language.

Step 7: Testing the Application

At this stage of the design process, it is recommended that you test your application to check your image, alarm, tag and block definitions.

After completing the test and implementing the necessary changes, you can continue to define your reports, charts, recipes and fine tune the application.

Step 8: Defining Charts, Reports and Recipes

Defining Charts

Charts (see Chapter 24, Charts) provide graphical views of past and current tag values. You can use charts to follow a trend or compare values. You can define up to 16 tags on a single chart.

When defining a chart, it is possible to:

- Define a unique color to each chart that is also used by the scales of the chart.
- Determine that charts show online or historical activities.
Defining Reports
You can define reports (see Chapter 31, Reports) for different users such as: operators, engineers, and managers. Make sure that each report includes the required information for the designated user.

Reports can be:
- Triggered in the application language.
- Written to a file.
- Sent directly to the printer.

When designing reports, it is possible to:
- Place fields in different positions and include any text, such as a header or short explanation at the end of the report. The fields can represent runtime values and a number of calculations performed on the historical tag values, such as averages, integrals, sums and more.
- Choose the range calculation, such as start day, start time, end day and end time.
- Define compound fields that are based on two other fields according to a specific formula. Multiple fields allow you to receive a value based on a group of other fields.

Defining Recipes
Recipes are specified sets of tag values that you can store for future use.

When defining recipes, remember that:
- Each recipe must belong to a model that includes tags for certain processes or production modes. The recipe uses the tags in the model to which it belongs, but can also include tags that are not defined in the model.
- Each model and recipe has a unique name.
- The same tag can belong to more than one recipe.
- You can save the current values of any tags at any time as a recipe. This means that at the end of a process, you can save its values as a recipe and reload the recipe when the process is resumed.

Note: For further details see Chapter 29, Recipes.
Step 9: Fine-Tuning the Application

Once you have completed these steps, it is recommended to check all your definitions. Use the Single Tag Value and:

- Activate system language commands.
- Initiate dynamic behavior in an image.
- Activate reports.
- Check alarms.

Once you are satisfied with the results, fine-tune your entire application, by:

- Adding users to the user groups.
- Saving layouts that can be loaded upon login.
- Setting the menus that will be displayed for the different user groups.

Shutting Down

This section describes how to logout and how to exit the system.

Logout

After initiating logout, you will not have access to the system until you login again.

▶ To logout:

Click the Logout icon button in the Quick Access Bar.

Exiting the Application

You can exit the system from the Quick Access Bar or from the Application Studio.

▶ To exit the application:

Click the Exit button in the Quick Access Bar.

Or,

From the File menu in the Application Studio, select Exit.
Chapter 5  Getting to Know the Application Studio

About this chapter:

This chapter describes the Application Studio, which is the operational framework of the system.

Overview on page 5-2 describes how to open and exit the Application Studio and its components.

Modules on page 5-13 describes the various application container icons.

Defining System Options on page 5-22 discusses system options and how to modify the default application file path.

Multi Language Support on page 5-28 describes how to define multi-language support in an application.

Layouts on page 5-32 describes how to capture and save layouts and how to assign them to users.
Overview

The Application Studio is opened from the Quick Access bar that is displayed when the application is accessed. The Application Studio has an explorer-like interface and offers full control and access to all parts of the system during application development. The interface has two panes:

- **All Containers**
- **Control Panel**

The Application Studio window also contains:
- A menu bar through which you can access application operational menus.
- A toolbar that enables quick access to the Application Studio’s most frequently used functions.
- A status bar showing the number of tags and alarms in the application.

*Note: The status bar will not be displayed in the Events Summary when in the Window Attributes dialog box the Size Border option is unchecked.*

**Toolbar**

- Open application
- Save application
- Add Tag
- Add Alarm Definition
- New HTML file
- New Events Summary Profile
- New Trend Profile
- Capture Layout
- New Image
- New Events Summary
- New Chart
- New History Viewer
- New Recipe
All Containers Section

The All Containers pane displays a hierarchical structure (tree) of the containers from which an application is built. Containers can be thought of as the building blocks of the application. The tree is made up of four main folders of containers with the current application as its root.

- **User Management** lists all the users and groups defined in a project. This module also defines the user's access permission and level. Access can be given per user, group and team. Backup users can also be defined. User Management also enables the System Integrator to create a user timetable and schedule workplans.

- **Web Application** contains the elements that are used to publish an application, such as HTML pages for the Image, Events Summary Profile, and Trend Profiles.

- **Files** contain the elements that are stored as files, such as: Images, Events Summaries, Charts, History Viewer, Model Recipes, Layouts and Reports.

- **Objects** holding the elements that are stored as objects, such as: Tags and Alarms.

Right clicking on a container opens a popup menu that displays related options. For example, right-clicking on Alarms displays a popup menu with the following options: Add Alarm, Add Level, Modify Level, Import Alarms, Export Alarms and Properties.
When a container is selected in the All Containers section on the left, a list of its contents is displayed in the List Zone on the right. For example when Alarms is selected in the All Containers list, a list of all the alarms in the application is displayed in the List of Alarms, as shown below.

All lists, for example the List of Alarms share the following common features:

- Right clicking anywhere in the list displays a popup menu with context sensitive options.
- Clicking on a column header sorts the list within the column. The information for each list is displayed under columns that are relevant to the list.
- A number/character written with an * means filter according to the character and a number of additional characters. For example, 1* will show the following 1, 12, 122, 1A etc.
- A number/character written with an ? means filter according to the character and an additional character. For example, 1? will show the following 1, 12, 13, 1A etc.
- A list can be duplicated in a separate window by right clicking in the list window, pointing to View and selecting Duplicate from the popup menu. A list can be duplicated only once. For example, the List of Alarms.
selecting Settings from the popup menu. A dialog box is displayed in which you can set the order and the type of fields to be displayed in the List Zone. For example, the List of Alarms dialog box.

![List of Alarms dialog box](image)

To specify the columns to be displayed in the List of Alarms, click the checkbox next to a column name to select it. The following columns are available:

- Alarm Expression
- Text
- Family
- Zone
- Severity

You can determine the order by which the columns appear in the Application Studio by selecting a column and activating the Move Up or Move Down buttons.

You can select all the columns by activating the Select All button, and deselect them by activating the Deselect All button. Clicking the Default button selects all the columns.
The Control Panel

The Control Panel, on the right of the Application Studio, is displayed when the root of the tree (the current application) is selected.

- Communication Drivers
- Printers
- Multiple Tags
- Single Tags
- DDE Blocks
- Application Setup
- Macros
- Network
- Application Language
The following menu options are available in the Application Studio:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>New</td>
<td>Open a new file</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Open an existing file</td>
</tr>
<tr>
<td></td>
<td>New Application</td>
<td>Display the New Application Wizard</td>
</tr>
<tr>
<td></td>
<td>Open Application</td>
<td>Open an existing application</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Save the current project</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Save the current project with a specific name</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Exit the application</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Toolbar</td>
<td>Show/hide the toolbar</td>
</tr>
<tr>
<td></td>
<td>Status Bar</td>
<td>Show/hide the status bar</td>
</tr>
<tr>
<td></td>
<td>Disable non-web features</td>
<td>Disable non-web features in the Image</td>
</tr>
<tr>
<td>Menu</td>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Window system</td>
<td>Show/hide the icon in the top left corner of the image window. This overrides the System menu property of the image window attribute</td>
<td></td>
</tr>
<tr>
<td>menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design</td>
<td>Add Object</td>
<td>Add a new tag or new alarm</td>
</tr>
<tr>
<td></td>
<td>Communication Drivers</td>
<td>View the drivers defined for the application, add a new driver, remove a driver and define driver properties</td>
</tr>
<tr>
<td></td>
<td>Macros</td>
<td>Define macros</td>
</tr>
<tr>
<td></td>
<td>DDE Blocks</td>
<td>View the DDE blocks defined for the application, add a new block, delete a block and define block properties</td>
</tr>
<tr>
<td></td>
<td>Application Setup</td>
<td>Setup additional addons and programs to run while starting the application</td>
</tr>
<tr>
<td></td>
<td>Alarm Parameters</td>
<td>This option enables you to define the Class Name and the user given Field Names to an alarm</td>
</tr>
<tr>
<td></td>
<td>Alarm Filter</td>
<td>This option contains a list of all the alarm filters defined in the project</td>
</tr>
<tr>
<td></td>
<td>Printer Targets</td>
<td>A combination of alarm filters and printers. When an alarm is issued it is channeled through the Alarm Filters according to predefined parameters and sent to the printer targeted for it</td>
</tr>
<tr>
<td>Menu</td>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Zone Navigators</td>
<td>The Zone Navigator is a global, multi-image zone navigation window that enables you to quickly and efficiently navigate through a list of zones defined in your application's various image files</td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>This is used to define the settings used in the application language.</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td>This is used to configure options such as; WizPro, Paths and Printers.</td>
<td></td>
</tr>
<tr>
<td>Authorization</td>
<td>This option enables you to configure operator access to the application.</td>
<td></td>
</tr>
<tr>
<td>Advanced Alarm Management (AAM)</td>
<td>There are two sub-menu options:</td>
<td></td>
</tr>
<tr>
<td>Scheduler Configuration</td>
<td>Where the Scheduler can be configured.</td>
<td></td>
</tr>
<tr>
<td>Menu</td>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Network</td>
<td>Local Station and Network</td>
<td>Configure your computer as a SCADA or SCADA View, Hotbackup, or a Management View Station and set your network environment and establish application performance</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Record Remote Data</td>
<td>Record remote tags and alarms</td>
</tr>
<tr>
<td>Tools</td>
<td>Single Tag</td>
<td>Assign an immediate value to a tag. This is useful for testing tag performance.</td>
</tr>
<tr>
<td></td>
<td>Multiple Tags</td>
<td>Define multiple tags to optimize performance.</td>
</tr>
<tr>
<td></td>
<td>Add System Tags</td>
<td>Assign an immediate value to a tag. This is useful for testing tag performance.</td>
</tr>
<tr>
<td></td>
<td>Import</td>
<td>Import a list of tags or a list of alarms.</td>
</tr>
<tr>
<td></td>
<td>Export</td>
<td>Export a list of tags or a list of alarms.</td>
</tr>
<tr>
<td></td>
<td>Find</td>
<td>Search for already existing tags and alarms.</td>
</tr>
<tr>
<td></td>
<td>Multi language Support</td>
<td>Define language support</td>
</tr>
<tr>
<td></td>
<td>WizPLC</td>
<td>This menu option is used to run the WizPLC program while the application is running. There are two modes, Development (for developers using the application) and Runtime</td>
</tr>
</tbody>
</table>
Communication drivers handle communications with external devices, such as PLCs, industrial instruments, remote computers and field buses. These drivers are separate program files, which are installed when installing the application. Communication driver file names have the format VPIWN??..DLL, in which ?? is the two or three-letter code of the driver. Since each communication driver is different, the driver information documentation should be consulted for specific communication driver details.

You can define communication blocks to improve driver performance when working with large quantities of tags. These blocks enable you to transfer large blocks of information instead of individual data items.

### Modules

#### Communication Drivers

Communication drivers handle communications with external devices, such as PLCs, industrial instruments, remote computers and field buses. These drivers are separate program files, which are installed when installing the application. Communication driver file names have the format VPIWN??..DLL, in which ?? is the two or three-letter code of the driver. Since each communication driver is different, the driver information documentation should be consulted for specific communication driver details.

You can define communication blocks to improve driver performance when working with large quantities of tags. These blocks enable you to transfer large blocks of information instead of individual data items.
The first step in designing an application is to define the communication drivers and blocks. You then define the tags, which are control values monitored by the system. They are used as internal variables for:

- Calculations and display.
- Communication with PLC's to represent data from PLC memory or to send commands to PLC's.

Note: In fast Pentium PCs with a 16550 UART (serial interface chip), Windows 2000 default settings may cause communication errors on serial communication drivers. To overcome this problem, lower the buffer sizes on the UART in the following menu: Start/Setting/Control Panel/ System/Device Manager/Port/ Communication Port 1.4/ Port Settings/Advanced.

Use a trial and error method to reach the optimum setting.

For further details read Chapter 8, Communication Drivers.

Printers

The Printers dialog box enables enhanced printing capabilities. Each printer added to a system can be set to print reports, alarms or both. In addition a definition can be made where many alarms are printed on a full page or whether only one alarm is printed on each page. Page orientation and font can also be defined. Alarm properties that are printed can also be set together with different colors, text and background.

For further details read Chapter 14, Alarm Filters, Printers & Printer Targets.

Multiple Tags

The Multiple Tags feature can be used to optimize performance and enhance functionality. This utility enables you to adjust system parameters and establish the correct environment for working with the application.

Multiple Tags display tag lists which enable you to read and write tag values, as well as change several tag attributes. In addition, Multiple Tags provides options to save the tag list as a recipe or a tag list file.

Tag list files are ASCII files that contain lists of tags and their attributes. These files have the extension .GLS and can be used in the application to generate tag lists in the tag definition procedure. For further details read Chapter 12, Multiple Tags.
**Single Tags**

The Single Tag dialog box is used to assign an immediate value to a specific tag.

In the Single Tag dialog box parameters such as the Station Name, Tag Name, Description, Current Value, New Value and Suggested Value slider are used to simulate the tag's value.

For further details refer to Chapter 9, Tags.

**DDE Blocks**

The DDE Client Block enables the system to receive many tag values from the server in one update message. This improves the communication between the application and the DDE server. The DDE Client Block is built from a matrix of rows and columns in which each cell of the matrix contains the value of one data item.

*Note: Not all programs support block messages. Check the documentation of the DDE server application.*

A common use for DDE client blocks is a setup in which a DDE server simultaneously updates a block of items that make up a recipe. The system, the client, receives all the items, and the tag values are changed immediately.

Define DDE client blocks only if data items in the server change simultaneously (within milliseconds). The system receives the whole block of data whenever one of the items in the block changes. Therefore, if items change one at a time, the application will receive a whole block of values, many of which have not changed.

For further details refer to Chapter 36, Application DDE Support.

**Application Setup**

The Application Setup dialog box enables you to set up or modify the additional add-ons and programs you wish to run when starting the application.

**Macros**

Macros are shortcuts that can be used to execute predefined actions, commands, or programs whenever designated keys or key combinations are activated. This enhances overall application functionality and saves you the time and effort of having to execute application operations in several stages.
You can define up to 3072 application macros. Application macros are defined by the following attributes:

- Accelerator keys that invoke the macros (F1 to F12, A to Z, ALT alone, or in combination with Ctrl, Shift, and others)
- A unique name and description
- Authorization groups
- Confirm before Execute option

Application macros include the following types:

- Actions
- Commands
- Sequence
- DDE Command Macros
- Trigger Macros (described in the Triggers on page 19-16 section of Chapter 19, Image Editor).

Macros will only be executed when:
An application window, including the Application Studio, or the Single Tag Input dialog box is the active window. If any other window is active the macro will not be executed. If the application is used locally (for example, if a trigger macros is invoked through a web browser) it will not be executed.

**Application Network**

Application stations operating in a network environment can share objects, such as alarms and tags. Direct access to remote tags and alarms can be implemented through a simple station definition procedure. Once the station is defined to support application network activities, any operation involving tags and alarms on a local station can include remote tags and alarms as well.

The application network system operates in a manner similar to other network systems. The application kernel, handles all network operations and transfers data from/to local and remote stations.

The application supports various network components, including Novell Requester, LAN Server and TCP/IP.
Installation in a TCP/IP environment enables application workstations on one network to communicate with application stations on other networks. Through TCP/IP, the application Network offers a complete enterprise-wide solution.

For further details refer to Chapter 16, The Application Network.

**Application Language**

*Note: This feature is not available on the web.*

Application Language is a simple but powerful tool used to create programs that can enhance the capabilities of control equipment working with the application, such as PLCs, and establish the connectivity interface between this application and external computer applications.

*Note: Application Language runs on your local PC, it is not supported on the Web.*

**WizPLC Development and Runtime**

WizPLC enables you to write control logic programming. There are two modes:

- **Development** which is a programming, monitoring and debugging tool, integrated with the application SCADA system and enables project management
- **Runtime** that runs compiled code on a Windows NT real-time processor. It communicates with I/Os and exchanges data with the application and WizPLC Development.

For further details refer to the WizPLC manual.

**Tag Filters**

The Tag Filter module is used to filter, view and manage a list of tags and their status (locked/unlocked) in the application. This is useful for the development and maintenance of an application.

The Tag Filters List is stored in the application's TFM.XML filter that is created in the \docs directory (or another appropriate directory of the application).
When accessed through Java applets the Tag Filters List can be defined/modified/viewed in the Image module during runtime. Up to 10 tag filters can be selected simultaneously. Tags can be sorted according to:

- **Source**
  - PLC - tags associated with external devices and mapped on the external device variables.
  - Dummy - tags representing internal variables used for a variety of calculations, control and other application related needs.
  - Compound - tags which are linear calculations based on values of other tags.
  - System - tags that are predefined and built to provide system status information.

- **Type**
  - Analog - tags that have numeric values represented in various formats.
  - Digital - discrete logic tags that have a boolean value of True (1) or False (0).
  - String - tags that are defined to receive alphanumerical strings.
  - Locked - which filters only locked tags. A locked tag can be either analog, digital or string.

For further information read Chapter 10, Tag Filter Module.

**Alarm Filters**

The Alarm Filter module filters alarms and reports before they are printed out or written to the Events Summary. Alarm filters are displayed in the Alarm Filters table and defined or modified in the Filter Properties dialog box. Filter properties can be updated, however the name of a filter cannot be changed.

The Alarm Filter, filters the alarms sent when parameters defined in tag variants are not met.

For further details refer to Chapter 14, Alarm Filters, Printers & Printer Targets.
**Printer Targets**

A Printer Target is a combination of alarm filters and printers. When an alarm is issued it is filtered according to predefined parameters and sent to the printer targeted for it.

The Printer Target dialog box holds a list of all the printer targets that have been defined. Each printer target is identified by a unique name and description.

For further details refer to Chapter 14, Alarm Filters, Printers & Printer Targets.

**Zone Navigator**

The Zone Navigator is a global, multi-image zone navigation window that enables you to quickly and efficiently navigate through a list of zones defined in the application's various image files. A number of navigators each of which can contain a number of zones from one or more different image files can be defined in the Zone Navigator module.

For further details refer to Zone Navigator on page 19-64 in Chapter 19, Image Editor.

**Advanced Alarm Management**

**Channels**

Advanced Alarm Management communication lines (TAPI modem or modem connected to COM port) are defined in the Channels dialog box where channels can be added, removed, deactivated or be modified.

The following configurations are available:

- Channels Setup (Tapi modem or modem connected to COM port).
- Pager Services Setup.
- Vocal Server Setup.

During runtime the real time Advanced Alarm Viewer shows statistics and an Events Summary.

For further details refer to Chapter 15, Advanced Alarm Management.
AAM Pager

The AAM Pager Services module enables definition of a list of paging drivers and Call Management parameters. New drivers can be added, existing drivers removed and driver setup can be configured.

For further details refer to Chapter 15, Advanced Alarm Management.

Scheduler

The Internet based Scheduler enables you to easily create daily or weekly task orientated schedules remotely. Accessed through an Internet browser or by clicking on an icon, the Scheduler is extremely user friendly, efficient and economical.

Being both task and time orientated the Scheduler can be used to create unlimited tasks, actions and states. Tasks can be modified, enabled/disabled and have many states such as On/Off attached to them. An unlimited number of actions, which are basic operations, can be attached to each task.

For further information read Chapter 28, Scheduler.

Axeda Remote

The Axeda Remote module, an integral part of the system's package, enables shared access between this application's User (operator) computer and a Viewer (System Integrator, Technical Support) computer. A User's computer that has Axeda Remote is hidden behind a firewall and cannot be addressed directly. Since access to the User's computer is by password and shared Session IDs only, and any information sent over the Internet is encrypted, this module provides a safe solution for remote technical support and other control situations. For further information read Chapter 35, Axeda Systems Remote Module.

Enterprise Server Connection

The Enterprise Server Connection is a modular embedded application server that provides data acquisition, local decision-making and a web user interface for devices and systems. For further information read Chapter 34, Enterprise Server Connection.
**RePlay**

The RePlay module is used to view a graphical display of previous history tag values in images. The application reads and displays the tag values from the application's history.

The RePlay module is activated from the Application Studio Control Panel. An application image cluster controls the RePlay itself.

*Note: Only tags that have Write to History defined during Tag Definition can be used. For further details see Chapter 21, RePlay Module.*

**Tag Mapper**

The Tag Mapper is a data file of tags and tag values that can be used to considerably reduce workload during application creation. Tag values of tags held in a Tag Mapper table are mapped by the Tag Mapper into a list of other tags.

There are two types of Tag Mapper tags:

- **Source:** These are tags whose values are directed to target tags. More than one source tag can be pointed to the same target tag.
- **Target:** This tag type receives the values of the source tag.

A single image can be used to display different source tags values in the same target tags (depending on the index value entered by the user).

To define the source tags that update a specific target tag the user must first create the tables used by the Tag Mapper. Each table has a unique Id (Index) that is later used in the image as the index value.

Each image can use one table only at a specific time. The table that is used is defined by the index value.

An unlimited number of tags can be mapped. The Tag Mapper is bidirectional. For further details see Chapter 11, Tag Mapper.

**Network Application Update**

The Network Application Update module enables an application developer to quickly and easily update far station application files remotely. To the station operator this action is invisible. However a record of the update will appear in the station's error.dat file.
An unlimited number of network stations using the application can be defined in the Remote Update Settings dialog box. This dialog box, by default, holds all the files within the application. For further details see Chapter 33, Network Application Update.

**Defining System Options**

*Note: Changes to application paths and printers options are implemented online.*

**Application Setup**

The Application Setup dialog box enables you to set up or modify the additional add ons and programs you wish to run when starting the application.

► To open the Application Setup dialog box:

In the Control panel of the Application Studio, double-click the Communication Driver icon.

Or,

From the Design menu, select Application Setup. The Application Setup dialog box is displayed.
The following options are available:

**Add** Sets up the additional program you wish to run while starting the system.

**Properties** Displays the properties of the selected program.

**Remove** Removes the selected program from the list of programs.

*Note: When adding a list of programs, write the list in the order that you want them to run. Do not place a program that should run before the application interface following a program that should run after it.*

► **To setup a program you wish to run while starting:**

Click the Add button in the Application Setup dialog box. The Programs Specification dialog box is displayed:

The following options are available:

**Program to Run** Specifies the full path of the program. Click the Browse button to access the DDE server and client settings (Bin/WizDDEs/c.exe).

**Parameters** Specifies the program parameters, if there are any.
To select the setting environment for an application:

Click the Advanced button in the Application Setup dialog box. The Advanced Settings dialog box is displayed:

The following options are available:

- **Run Application Language**: Specifies that the default Language runs.
- **Run WizPLC Runtime**: Specifies that WizPLC runs.
- **Select Application**: Browse to select an application.
**WizPro Options**

WizPro is the application programming interface kernel. It provides mechanisms through which application PLC and external device communication can be implemented, maintains an on-line database, and services all inter-process requests and messages.

- **To set WizPro options:**

From the Design menu, point to Options and select WizPro from the popup menu. The Set WizPro Options dialog box is displayed:

![Set WizPro options dialog box]

The following options are available:

- **Tag Sampling**
  Enables the WizPro tag sampling mechanism. Tags are sampled according to the rate defined for the tag in the Analog Tag Definition dialog box or the Digital Tag Definition dialog box as described in the Defining Tags section in Chapter 9, Tags. Tag sampling will not occur if this option is deselected.

- **Write to HIS File**
  Enables the recording mechanism to record sampled tags in historical files. Historical sampling will not occur if this option is deselected.

- **Alarm Module**
  Enables WizPro to check if alarm conditions are true whenever tag values change.
Collapse Alarms

Enables WizPro to collapse alarms in the Events Summary. This means that repeated identical alarms will be displayed on a single line in the Events Summary. If this option is not selected, each alarm will be displayed on a separate line until the condition defined for the alarm ceases to exist.

Perform Compress on Next Restart

Physically removes all deleted tags and alarms from the system's database and renumbers their ID numbers. When tags or alarms are removed from the application, they are not physically deleted, but only marked as deleted so as not to affect the internal ID numbers of the remaining tags and alarms. Enable this option in applications where it is necessary for tags and alarms to have sequential ID numbers.

Note:

If the ID number of tags or alarms changes, the data in the history files may not be processed. Therefore, it is strongly recommended that you keep a backup of the tag definition files (table tags and alarms in Wizdata MDB) deleting any tags from the database.

If the ID number of tags changes save the application’s Language commands again in the application Language Definitions dialog box, as described in Chapter 27, Application Language. This is necessary so that the commands will correspond to the new, internal tag IDs.

Deleted tags count as defined tags when the application checks that the number of defined tags is less than the amount allowed by the security key.
Changing Default File Paths

Default paths can be defined for each file type to enable the system to keep track of files and their locations.

To define file paths:

From the Design menu, point to Options and select Paths from the popup menu. The Set Default Paths dialog box is displayed:

The dialog box displays the application file types with their current path specifications.

To change the path of a specific file type:

1. Click in the relevant line and either type in the new path or click the Browse button to open the Browse for Folder dialog box where you can search for the correct file path. A path must be specified with a terminating backslash (\).

2. Click Save to confirm the new path locations.

Note: Restart the application for changes to take effect. It is not recommended to change the path of Users, Macros, Classes, Web Applications, Event Summary Profiles, Pictures and Trends.
Multi Language Support

Using Multi-language support, the tag description, alarm text and the text field in an image can be developed in one language and translated to another. During runtime, a user can choose the required language.

Support for different languages is dependent on the operating system and its support for that language. Far Eastern languages, such as Japanese, are supported in the application only in their native operating system. Latin languages are supported in any operating system.

All texts for specific languages are kept in files. The size of this file is proportional to the size of the application. For small applications, this can take as much as 10 kbyte. A larger application can take as much as several mbytes.

Strings

If you have a multi-language application with strings in two or more languages, it is possible that not all the strings will be present in all languages after import. If a string is absent in a selected language the missing string will appear on the screen in the following format:

<??string ID?>

Where the string ID is a number, such as <??0000000005?>.

Defining Multi-language Support

This section describes how to define multi-language support in an application. The following steps need to be repeated for each language used.

1. Export the language strings into a file.
2. Select the language in which the application was written and import the file into the application.
3. Open the file with a text editor, translate the language strings into the required language and save the file with a new name.
4. Select the required language and import the translated file into the application.

After you have defined multi-language support for a language, you can then select it to determine that the application texts will appear in that language.
To export a file:

1. From the Tools menu, point to Multi-language Support and select Export Language from the popup menu. The Export Language dialog box is displayed:

   ![Export Language dialog box]

2. In the Export to file field, enter the name of the text file you wish to create for the language strings.

3. Click OK to save your definitions and close the dialog box. It is recommended to save the file in the same directory as your application.

   *Note: If multi-language support has already been defined in your application, the last language you imported will appear in the Export language field.*

To import the text file:

1. From the Tools menu, point to Multi-language Support and select Import Language from the popup menu. The Import Language dialog box is displayed:

   ![Import Language dialog box]

2. Click in the Import Language field to display a list of available languages. Select the language in which the application was written.

3. In the Import from file field, enter the name of the text file that contains the language string (this is the file you created in the Export to file field in the Export Language dialog box on the previous page), or click Browse to locate the file.

4. Click OK to import the file. The following message appears:
5. Click Yes to establish a link between the language and its file.

   **To translate the file:**
   1. Open the language file using any text editor.
   2. Translate the language strings into the required language and save the file as a new file.
   3. Access the Explorer and remove the extension (.txt) from the file.
   4. Follow step 1 on the previous page to open the Import Language dialog box and enter the required language in the Import language field.
   5. In the Import from file field, enter the name of the file that contains the translated language strings, or click Browse and locate the file.
   6. Click OK to import the file. A message box opens.
   7. Click Yes. The language is now supported.

**Selecting a Language**

After you have defined multi-language support, you can select the language in which you want the application to display the application texts.

   **To set a language:**

   From the Tools menu, point to Multi-Language Support and select Select Language from the popup menu. The Select Language dialog box is displayed:

   ![Select Language dialog box](image)

   1. Click in the Select the language for the application field, and select the required language from the list of supported languages.
2. Click OK to save your definitions and close the dialog box. The language strings are now displayed in the selected language.

Note: The language strings are displayed in another language only after refreshing the required container in the All Containers section. For example, to display the alarms language strings in the selected language, click the + sign to the left of Objects. The objects list collapses and the + changes to a -. Click the - sign to expand the objects list and then click Alarms to display the List of Alarms. The alarm text is displayed in the Text column of the List of Alarms in the selected language.

**Loading System Files Created in Another System Application**

If you try to load (import) an image, or the wizgates.dat and alerts.dat file created in another application, the multi language support module may detect that the file was not created in the current application. The following may occur:

- If a language has not been defined for the application, the application will work with the default language. The multi-language support module will attach the loaded file to the current application.

- If the current application is a multi-language application with two or more defined application languages, the Language database selection dialog box is displayed:

  ![Language database selection dialog box](image)

  Click Browse to specify the path of the language database to be used with this file.

  If the selected database does not match the loaded file, the Language Database Selection dialog box will reappear. You can either click Ignore to attach the loaded file to the current language database, or click Cancel to prevent file loading.
**Layouts**

*Note: This feature is not available on the web.*

A layout is the position of an open window in an application. This section describes how to capture and save layouts and how to assign them to users.

You can assign a layout to a user, so that when the user logs on, the windows included in the layout will automatically be displayed in the position in which they were saved.

You can also close all the open windows in your application, as described below.

Capturing layouts, assigning them to users and user log on is for local use only. Layouts are not used when interacting with the application through a browser.

**Capturing and Saving Layouts**

You can open Image, Events Summaries, History Viewers and Chart windows, position them on your screen and save their position.

**Saving Layouts (by Default)**

You can configure the layout property so that you are prompted to save the layout of any open windows before you exit the application.

► **To save a layout by default:**

1. Right-click Layouts and select Properties from the popup menu. The Layouts Properties dialog box is displayed:
2. Select Prompt to save layout. When you exit the application you are prompted to save the current layout. This change can be implemented online.

► **To save a layout:**

In the All Containers section of the Application Section, right click Layouts and select Capture Layout from the popup menu. A standard Save As dialog box is displayed in which you can save the layout. The layout is displayed in the List of Layouts.

► **To add additional window positions to an existing layout:**

Specify the existing layout file name in the Save As dialog box.

► **To load a layout:**

In the List of Layouts in the Application Studio, right click the required layout and select Load Layout from the popup menu.

► **To delete a layout:**

In the List of Layouts in the Application Studio, right-click the layout you want to delete and select Delete Layout from the popup menu.

**Assigning Layouts to Users**

When you have captured and saved a layout, you can assign it to a user, so that when the user logs in, the layout is automatically displayed on the screen. A layout is assigned to a user in the User Management module. See *Chapter 7, Security and User Management, User Management - Overview* on page 7-12.

► **To assign a layout to a user:**

1. In the User Management container in the All Containers pane click Users. The List of Users opens in the Control Panel.

2. Select a user and then right click and select Modify from the popup menu. The User Properties: User dialog box opens.
3. In the Layout field click the arrow to open a dropdown list and select the relevant layout. The selected layout will be attached to the User and will open on the User's station.

   Note: Users can also be assigned a layout when defining new users and following the instructions above.

**Closing all Open Windows**

You can use the Close All windows feature to close all the windows open in your application.

▶ **To close all windows:**

In the All Containers section, right click Layouts and select Close All windows from the popup menu.
Chapter 6  Building a Project

About this chapter:

This chapter describes how to create an application project using the Getting Started Wizard and how to define Station Properties as follows:

Overview on page 6-2 describes the first steps in creating an application Project.

Optimizing Application Performance on page 6-8 discusses the system's Station Properties, which optimize application performance and enhance functionality.
Overview

After the program is activated the Getting Started Wizard opens on your screen. Through the Wizard you can create new projects, either using a template or blank template, search for existing projects or open the most recently used project.

When a new project is created all files are copied from the NewWizAPP folder to your new application folder. These are the WizUM.mdb file containing a user name and password (default = user.password) and the Wiztune.dat File. This file can be opened by right clicking the project name and selecting the Open Tuning Parameters File option.

A new project file is saved with the suffix *.Wpj. (This may change in future software versions). When the Application Studio opens on your screen, the name of the project appears at the route of the All Containers pane.

After the project is saved, Station Properties, which enables you to adjust system parameters to optimize your application's working environment can be defined. The Station Properties dialog box can be opened by right clicking the project name. The Getting Started Wizard enables you to open existing applications from the Application Studio or to create new applications. There are three tabs: New, Existing and Recent.
New Tab

This tab enables you to open new applications. There are two options:

- Blank Application
- Template Application

To open a blank application:

Click the Blank Application icon to open the Set Application dialog box.

Or,

If you have already accessed an existing project and wish to open a new one. From the File menu select New Application to open the Set Application dialog box.

1. In the Folder Name field, at the end of the folder's location, type in the name of your folder. Click the Create button. The new folder name will be added to the folder location and also appear in the Folders list.

2. In the Application Name field, type in the name of the application. The suffix *.Wpj will be added by default.

3. Click OK to confirm.

4. Before the new application opens the Create System Tags message box will open on your screen.
5. Select either Yes or No accordingly. The Quick Access Bar will open on your screen.

Note: To open the Application Studio, click the Show Studio icon. The new project will appear at the root of the All Containers pane. If you created a folder for the application before opening the program this will appear in the Folders list.

▶ To create a template application:

Click the Template Application icon to open the Choose Template dialog box.

Or

If you have already accessed an existing project and wish to open a new one. From the File menu select New Application to open the Choose Template dialog box.

1. Select the *.Wpj file of the application on which the new application is based, and click Open. The Set Application dialog box is displayed.

2. In the Folder Name field, at the end of the folder's location, type in the name of your folder. Click the Create button. The new folder name will added to the folder location and also appear in the Folders list.

3. In the Application Name field, type in the new name of the application.

4. Specify a new name for the application in the Application Name field.

5. Click OK to confirm. The application closes and then reopens with the default settings of the selected application.

6. Before the new application opens the Create System Tags message box will open on your screen.
7. Select either Yes or No accordingly. The Quick Access Bar will open on your screen.

8. To open the Application Studio, click the application icon. The new project will appear at the root of the All Containers pane.

*Note: A short cut for creating a new application is to right click in the required location and creating a new folder and then right clicking and selecting the application.*

**Default Wiztune.dat File**

When a new application is created all files are copied from the NewWizAPP folder to your new application folder. The WizUM.mdb file contains a user name and password (default = user.password) and the default Wiztune.dat file contains the following parameters:

```
DEFAULTUSER=user-password
NET_PROTOCOL=NPITCP
VFI=VFI5FST,VFI5CB
TRG_FEEDBACK=YES
NET_CHECKTIMEOUT=60
```
**Existing Tab**

This tab holds a list of all existing system applications.

![Existing Tab Image]

- **To open an existing application:**
  
  Click the Existing tab and select the relevant application.

  Or,

  From the File menu select Open Application to open the Open dialog box.

  Select the *.wpj file of the application you want to open and click Open. The system closes and then re-opens displaying the specified application.
**Recent Tab**

This tab holds a list of all existing system applications.

To open a recent application:

Click the Recent tab and select the relevant application.
Optimizing Application Performance

The Station Properties enable you to optimize application performance and enhance functionality. System parameters can be adjusted to establish an optimal working environment for your application.

To define Station Properties:

Right click the application in the root of the container list in the All Containers section (if you have saved your application, the application name will appear in the root), and select Station Properties. The Station properties dialog box opens. This dialog box has the following tabs:

- **General** - where the application workplace can be customized.
- **User** - where a default user that will be logged in when you start the application is defined.
- **Date Format** - where the date format is defined.
- **VFI** - where the format for history files by selecting Virtual File Interface DLLs is defined.
- **Audit Trail** - where an Audit Trail is added or enabled to view operator actions stored in an application system file in the form of tag values.
- **ODBC Connectivity** - to enable the Open Database Connectivity (ODBC) dialog box to save the application's historical data to various databases through Microsoft's ODBC.
- **Advanced Alarm Management** - where the Advanced Alarm Management module is enabled.
- **Scheduler** - where actions, tasks and states can be defined over the Internet.
Setting General Station Parameters

The application workplace can be customized in the General tab of the Station Properties dialog box.

The following options are available:

**Show Quick Access Bar**
Determines whether or not the Quick Access bar appears when the program is loaded.

**Show done bar**
Displays a background processing dialog box when large tasks such as loading a large image are being executed. Changes are made online.

**Auto Restart after an illegal shutdown**
Specifies if the application automatically recovers its last state. For example after power failure. Changes are implemented online.

**Display untitled windows icons in task bar**
When checked the word untitled appears in the task bar for new items that have not been saved.

**Display windows icons in the task bar**
When this option is checked and after reset, no icons are displayed in the task bar.
Selecting a Default User

*Note: This feature is not supported on the web.*

You can specify the name of the user you want automatically logged in whenever you start the application in the Default User tab of the Station Properties dialog box. This is enabled after defining a user name and password.

![Station Properties dialog box]

*Note: You only log on to the system when using the application locally.*

The instructions below apply to both Default User and Logout User fields:

1. In the User field type in the user's name. Enter an asterisk (*) to specify the last user that logged out. Changes are implemented online.
2. In the Password field type in a unique password for the user.
3. Click OK to confirm and reset the application to actually save the changes.

*Note: Remote users login parameters are defined by right clicking Html/properties/users and checking either: Enable login Quick Access Bar in browser, or Automatically login with default user.*
Setting the Date Format

You can set the date style and date separator in the Date Format tab of the Station Properties dialog box.

The following options are available:

**Date style**
- Specifies a date style from a list of predefined date styles.
- Listed below are the Date styles:
  - DDMMYY
  - MMDDYY
  - YYMMDD
  - DDMMYYYY
  - MMDDYYYY
  - YYYYMMDD

**Date separator**
- Specifies a date separator from a predefined list of date separator styles. The date separator files are:
  - / (slash)
  - . (dot)
  - - (dash)
To Set Date Format

1. In the Stations Properties dialog box select the Date Format tab. The Date Format Dialog opens.
2. From the Date Style list select a predefined date style.
3. From the Date Separator list select the way you want the date to be separated.
4. Click OK key to enter your selection.

When loading for the first time, the application sets default values for these parameters using country code, defined in Control Panel/Regional Settings.

The table below lists the default values in the application for different countries.

<table>
<thead>
<tr>
<th>Country</th>
<th>Date Style</th>
<th>Date Separator</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>MMDDYY</td>
<td>/ (slash)</td>
</tr>
<tr>
<td>Japan</td>
<td>YYMMDD</td>
<td>/ (slash)</td>
</tr>
<tr>
<td>Netherlands</td>
<td>DDMMYY</td>
<td>/ (dash)</td>
</tr>
<tr>
<td>Denmark</td>
<td>DDMMYY</td>
<td>/ (dash)</td>
</tr>
<tr>
<td>Germany</td>
<td>DDMMYY</td>
<td>. (dot)</td>
</tr>
<tr>
<td>Austria</td>
<td>DDMMYY</td>
<td>. (dot)</td>
</tr>
<tr>
<td>Russia</td>
<td>DDMMYY</td>
<td>. (dot)</td>
</tr>
<tr>
<td>All others</td>
<td>DDMMYY</td>
<td>/ (slash)</td>
</tr>
</tbody>
</table>

Setting a Format for History Files

The format for history files is set in the VFI tab of the Station Properties dialog box.

VFI enables the designer to select different file formats to be used by the application for historical data logging and report generation. The system engineer can use a combination of different file systems and databases with the application for data manipulation convenience and optimum performance.

VFI uses a unique driver for each database, thereby taking advantage of the database's structure and characteristics. Axeda Systems supplies drivers to support specific databases.
This dialog box Tags and Alarms fields have the following options:

- Proprietary format
- DBF format
- Custom

**Setting a Format for Audit Trail**

Audit Trail is a useful security feature for applications. This tab enables you to log operator actions to a database via an ODBC data source.

Operator actions are stored in an application file in the form of tag values that can be accessed and viewed.

The application logs all manual operations, with exception to those made using Add-on programs, such as script language and application PLC. Additionally, the application does not record Smooth Type trigger actions.

Audit Trail provides data recovery for users connected to a remote ODBC data source in instances of network failure.
Note: It is not recommended to work with a remote database due to possible connection failures.

To enable audit trail:

1. Right-click New Application in the All Containers list of the Application Studio to open the Station Properties dialog box.

2. Using the arrows scroll to open the Audit Trail Enable tab.

3. Check the Enable Audit Control checkbox to activate the Current Data Source field. When the database source is predefined, click the Current Data Source field's drop down list and select the database. If it is not predefined click the Add Data Source button. The standard Windows Create New Data Source wizard window is displayed, in which a database source can be defined. The data source can be any valid predefined ODBC data source.
4. In the Select a Type of Data Source section click User Data Source (applies to this machine only) and then click Next to open the next dialog box.

5. Select the driver for which you want to set up a data source and click next to open the Finish dialog box.

6. Verify that the information in this dialog box is correct. If it is, click Finish, if not click Back to make any corrections. The ODBC Microsoft Access Setup dialog box opens.

7. Complete the Data Source Name and Description fields.
8. In the Database section you have four options:
   - Select - click to open an existing location
   - Create - click to create a new database
   - Repair - click this option targets the specific database for repair
   - Compact - click to save the database and to remove unused space from it

9. In the System Database field click either None or Database and then click OK.

10. The Database Successfully Created notification will appear on your screen. Click Apply and OK to close the dialog box and then restart your computer.

Note: The application does not support the File Data Source (Machine independent) option.

Data Recovery

Audit Trail provides data recovery for users connected to a remote ODBC data source in instances of network failure.

When a network problem is discovered, the application ends the session with the remote database and creates a temporary file in the Temp folder of Windows NT. This file, a text file in CSV format, is called BCK*.tmp.

The application then scans the network connection once a minute, and when connection to the server is re-established, writes the temp file to the audit trail file. If the information is written correctly, the application then deletes the temp file. If the information is not written correctly, the application will notify you of possible data loss.

Note: It is not recommended to work with a remote database due to possible connection failures.

Database Fields

The following fields and variables are added to a database file.

<table>
<thead>
<tr>
<th>Field</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>UserName</td>
<td>SQL_VARCHAR 20</td>
</tr>
<tr>
<td>Specifies which user name performed the action.</td>
<td></td>
</tr>
<tr>
<td>SourceType</td>
<td>SQL_VARCHAR 10</td>
</tr>
<tr>
<td>Specifies the Image or browser.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Variable</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>SourceName</td>
<td>SQLVARCHAR200</td>
</tr>
<tr>
<td>Specifies the Image or picture name.</td>
<td></td>
</tr>
<tr>
<td>SourceID</td>
<td>SQLVARCHAR50</td>
</tr>
<tr>
<td>Specifies the IP address of the browser.</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>SQLVARCHAR10</td>
</tr>
<tr>
<td>Specifies one of the following actions: tag assign, zone, macro.</td>
<td></td>
</tr>
<tr>
<td>TagName</td>
<td>SQLVARCHAR50</td>
</tr>
<tr>
<td>Specifies the name of the tag.</td>
<td></td>
</tr>
<tr>
<td>TagValue</td>
<td>SQLDOUBLE</td>
</tr>
<tr>
<td>Specifies the tag value.</td>
<td></td>
</tr>
<tr>
<td>ZoneName</td>
<td>SQLVARCHAR20</td>
</tr>
<tr>
<td>Specifies the name of the zone.</td>
<td></td>
</tr>
<tr>
<td>MacroName</td>
<td>SQLVARCHAR10</td>
</tr>
<tr>
<td>Specifies the name of the macro.</td>
<td></td>
</tr>
<tr>
<td>TimeAction</td>
<td>SQLVARCHAR20</td>
</tr>
<tr>
<td>Specifies the time and date the action took place. When accessed through a browser, the time and date will be that of the server.</td>
<td></td>
</tr>
</tbody>
</table>
**Formatting ODBC Connectivity**

The ODBC Connectivity dialog box enables you to save application historical data to various databases through Microsoft's ODBC connectivity.

**To enable ODBC Connectivity:**

1. Right-click New Application in the All Containers list of the Application Studio to open the Station Properties dialog box.

2. Using the arrows scroll to open the ODBC Connectivity tab.

3. Check the Enable ODBC checkbox to activate the dialog box options.

4. In the Current Data Source field select the database type to which you want to save application Historical Data. Or click the Add Data Source button to open the Create New Data Source dialog box.

5. In the Cross Reference Table field, type in the name of the table and click the Create Reference Table button to create a cross reference table including tag definition parameters.

6. If you intend to use a protected database (such as Oracle) type the user name and password in the identification field.

7. Under the History Table field type in the name of the historical data table. Check the Enable Tag Name Logging checkbox to write tag names to the historical data table.

8. Click Apply and OK to confirm.
Formatting Advanced Alarm Management

Advanced Alarm Management (AAM) uses a multi-service communication platform to provide alarm transmission over various communication channels including SMS, email, fax and vocal messages.

AAM is comprised of two design mode components:
- AAM channels and AAM pager services
- Advanced Alarm Viewer - a runtime component

To enable Advanced Alarm Management:
If the communication lines used by AAM are already defined then do the following:

1. Right-click New Application in the All Containers list of the Application Studio to open the Station Properties dialog box.
2. Using the arrows scroll to open the Advanced Alarm Management tab.
3. Check the Enable Advanced Alarm Management checkbox and click OK.
4. Restart the application.
Formatting the Scheduler

The Internet based Scheduler enables you to easily create daily or weekly task orientated schedules remotely. Being both task and time orientated, the Scheduler can be used to create unlimited tasks, actions and states. Tasks can be modified, enabled/disabled and have many states attached to them. An unlimited number of actions, which are basic operations, can be attached to each task.

Before the Scheduler is accessed the Scheduler module must first be enabled in the Station Properties dialog box.

► To enable the Scheduler module:

1. In the All Containers side of the Application Studio right click the application's name to open the Station Properties dialog box.

2. Using the arrow, scroll and open the Scheduler tab.

3. Check the Enable Scheduler checkbox and then click OK to actually define this option.

4. Restart the application.
Chapter 7  Security and User Management

About this chapter:

This chapter describes application security, user authorization and also discusses User Management, as follows:

Authorization Overview on page 7-2 discusses application Authorization using the Menu Items and System options.

Security Overview on page 7-7 discusses the Security module with a reference to the Installation for further details.

Application Dialog Boxes on page 7-7 discusses the dialog boxes that replace the standard Windows NT/2000 dialog boxes when the application's system security is installed.

User Management - Overview on page 7-12 discusses definition of users, groups and teams.

Creating Users on page 7-13 discusses how to create new users.

Creating Groups on page 7-26 discusses how to create new groups.

Creating Teams on page 7-31 discusses how to create new teams.
Authorization Overview

Authorization in the application refers to the ability to limit operator access to system facilities. This powerful feature enables the system engineer to control access to the various application components and modules, such as menu items, tags, macros, and graphical objects.

The components to which access can be limited include:

- Menus and menu items
- Writing Tag values
- Macro activation
- Graphic element layers in images

System authorization is assigned according to users, groups and teams. An unlimited number of groups can be defined in the system, each with its own unique name. Each operator can be assigned to one or more groups. For example, once a group is assigned to a tag, any operator that belongs to the group can perform tag value operations on the tag. Operators not assigned to a group matching any of the tag groups will not be able to set new tag values.

Note: User Management defines users and their passwords and also assigns users to groups or teams. The name of the currently logged-in operator is displayed in the Title bar of the Quick Access bar.

To define authorization settings:

Select the Design menu and point to Authorization and then select either Menu Items or System.

- **Menu Items** - Assign an authorized group to each menu item in the application
- **System** - Set system authorization options to security groups and users.

Menu Access Authorization

Each menu item in the system can be assigned authorized users/groups/teams, whereby only their defined operators have access to these items.

For example, if an operator belongs to the groups called MANAGER, SYSTEM, and USERS, and a menu item is assigned the groups TECH, SYSTEM, and ENGIN, this item will be accessible to the operator (since both have a common group).
To assign menu item authorization:

From the Design menu, point to Authorization and select Menu Items. The Menu Authorization dialog box is displayed:

This dialog box contains a list of the application views such as: Image, (See Chapter 18, Introduction to the Image Module) Chart (See Chapter 24, Charts), Events Summary, (See Chapter 22, Event Summaries) History Viewer (See Chapter 30, History Viewers), and the Quick Access bar.

The menus of these items are displayed in a tree arrangement. Menu branches are expanded and contracted by double-clicking on them. An item that holds sub-items is indicated by an arrow (>). When you double-click on such an item, the sub-item list appears. For example, double-clicking on Events Summary displays the following sub-item list:
Double-click on Events Summary to close the sub-item list.

**Set All**
Assigns all the authorization groups to an item

**Reset All**
Resets all the groups assigned to an item to their original settings

**Save**
Saves the new definitions

**Groups**
Opens the Access Permission Manager where the access level of users/groups can be defined. See Groups Tab on page 7-18

---

**To assign specific groups to an item:**

1. Select the item and click the Group button. The Action Permission Manager dialog box is displayed in which you can select groups to be assigned to the menu item. Only operators assigned to the specified groups will have access to the menu item.

2. Click the Set All button to assign all the groups to the item.

3. Click the Reset All button to reset all the groups assigned to the item to their original settings.

4. Click Save to actually save these definitions.
Note: If you assign groups to menus that include sub-menus and sub-items, all the sub-menus and sub-items are affected. However, if you assign groups to a sub-menu or sub-item, the parent menu is not affected. When you select a sub-menu or sub-item that belongs to the menu, you can only reset and set the groups that were defined for the parent menu, unless you return to the parent menu and change the settings.

**Action Permission Manager**

The Action Permission Manager dialog box is used to define authorized users and/or groups.

![Action Permission Manager dialog box](image)

There are four buttons:

- **Add**: Click here to add a user/group to the Access Members list
- **Remove**: Click here to remove a user/group from the Access Members list
To assign access permission:

1. Click the arrow in the dropdown list and select the type of list you want to view. There are three options:
   - **List all Groups Users** - Select this option to display a list of your application's defined groups and users
   - **List all Groups** - Select this option to display a list of your application's defined groups
   - **List all Users** - Select this option to display a list of your application's defined users

2. From the Groups/Users column select a group/user and click the Add button. The selected groups/users are now displayed in the list of Access Members.

3. To actually assign access permission, check the All groups and users have access permission checkbox.

4. Click OK to confirm.

*Note: The option buttons are deactivated when the All groups and users have the access permission checkbox is checked.*
Security Overview

Note: The system's security module must be installed to enable the Security option.

The application provides additional system security by ensuring that users access only those parts of the Windows system to which they have authorization.

When the system's security is installed it replaces the standard Windows system control. The Axeda Supervisor dialog boxes overwrite the Windows NT dialog boxes.

When turned on, computers that have the security module installed will open with the Axeda Supervisor window. After clicking the Start button users will have to enter their user name and passwords in order to gain computer access.

Application Dialog Boxes

This section describes the application’s dialog boxes that replace the standard Windows NT/2000 dialog boxes when the application's system security is installed.

The Axeda Supervisor Welcome dialog box is displayed when Windows is initiated:
The Axeda Supervisor Logon Information dialog box is displayed for user logon:

The Axeda Supervisor Options dialog box is displayed when Ctrl+Alt+Delete is pressed after logon:

The Logoff Axeda Supervisor Station dialog box is displayed when the user logs off:
The Shutdown Axeda Supervisor Station dialog box is displayed when shutdown is initiated:

![Shutdown Axeda Supervisor Station](image)

*Note: The above four options are accessible only to authorized users.*

The Workstation Locked dialog box is displayed when the station is locked:

![Workstation Locked](image)

The Unlock Workstation dialog box is displayed when a user unlocks the station:

![Unlock Workstation](image)
The Change Password dialog box is displayed when a user changes a password:

![Change Password Dialogue Box](image)

**System Definition**

This option defines the level of access the user/group has to the application. The following access levels are available:

- **Full security (disable all)**: Specifies that users will be unable to access other programs.
- **Disable lock station**: Specifies that a user cannot block access to a computer by applying a password.
- **Disable shutdown station**: Specifies that a user will be unable to shut down a station.
- **Disable logoff**: Specifies that a user cannot logout of the system.
- **Disable changing user password**: Specifies that users cannot change their passwords.
- **Disable ALT-ESC**: Specifies that a user cannot access the Start Menu.
- **Disable ALT-TAB**: Specifies that a user cannot navigate between the programs open on the computer using the Alt Tab keys.
To define operator system settings:

1. From the Design menu, point to Authorization and select Systems. The System Authorization dialog box is displayed.

2. To define authorization level, select an option from the System Authorization Options column and then click Add. The name user/group will appear in the Unauthorized Members column.

3. If there are no users defined for an option, double click the option to open the options definition dialog box. Select the name of the user/group/team and click Add and then OK to return to the System Authorization dialog box.

4. Check the Full Security on Logout checkbox to define this option.
User Management - Overview

User Management enables management of an application's users both locally and remotely. Users can be a single user, groups or teams built from users in the same groups.

The application's management methodology, using the Users Timetable module, enables simple and efficient scheduling of users, groups and teams.

By default, User Management has a group called Administrators. Users in this group are authorized to modify user properties (including their password). However, the group name cannot be modified or deleted. Users belonging to this group cannot remove themselves from it. An authorized user can access a user/group and modify its parameters. The User Management feature provides full backwards compatibility. Groups (see page 18) created in previous versions can be imported.

Note: If you have different applications installed on different stations, make sure that each application has its own unique users and groups. Users (see page 29) with the same names defined in different applications will be able to share the same data. The default user can be deleted only after a new default user is defined in Station Properties. Only a user logged in under a different name and with Administrator rights can delete the default user. An Administrator must have at least one user in order to access the application.

The following basic activities can be performed through User Management:

- Definition of users, groups and teams
- Additional user information such as address can be added
- Access permission definition
- Definition of how alarms are transferred and received by users using Advanced Alarm Management
- Back up user definition
Steps for Creating Users, Groups and Teams

This section describes how users, groups and teams are created in the following steps.

- Create new users. See Users Tab on page 7-29.
- Create new groups or add users to existing groups. New users can also be created and added in the Groups dialog box. See Groups Tab on page 7-18.
- Create new groups and add teams to them. See Creating New Teams on page 7-21.

Creating Users

To define a user:

In the All Containers section of the Application Studio click User Management and then click Users. A List of All Users opens in the Control Panel.
Note: If no users are defined in the project then the list will still open with the application's default user displayed.

1. In All Containers right click Users and then click New or right click anywhere in the Control Panel and click New. The New Users dialog box opens.

The New User dialog box has four tabs:

- **General**: Where the user's basic general properties are defined
- **Groups**: Where the group(s) that the user is a member of are defined
- **Messages**: Where the user's communication methods for Advanced Alarm Management services are defined
- **Information**: Containing information such as the user's address, PIN and other comments
**General Tab**

This tab holds fields that define a user's name, description, password and the layout of the user's computer screen. The lower section of the tab enables the system manager to define access permission both locally and on the Web.

1. In the Name field type the name of the user.
2. In the Full Name field type in the user's full name.
3. In the Description field type in a short description about the user. For example, the name of the user's department or job.
4. In the Password field type the user's unique password.
5. In the Confirm field type the user's password again.
6. In the Layout field click the arrow to open the dropdown list and select the relevant layout. The user's computer will always open in this view.
7. To enable a user to change passwords check the Allow Changing Password checkbox.
8. To enable the user to update information check the Allow Changing Information checkbox.
9. To enable the user to access the Web module check the Allow Web Access checkbox.
10. Click OK to actually create the user. The new user's name will be added to the Users List. Or, click Apply and then click the Group tab in this dialog box.
To modify existing users:
1. In All Containers click User Management then click Users to open the List of Users.
2. Right click the specific user to open a popup menu and click modify. Or, double click the specific user. The User Properties dialog box will open.
3. Modify the users properties and then click OK to confirm.

To delete existing users:
1. In All Containers click User Management then click Users to open the List of Users.
2. Right click the specific user to open a popup menu and click delete. The Delete User message will open.
3. Click Yes to delete the user. The User will be deleted from the List of Users.

To set a default user:
1. In All Containers click User Management and then click Users to open the List of Users.
2. In the list right click the relevant user and select Set as Default. The Users icon will appear next to the selected user name.

To change a user's password:
1. In All Containers click User Management then click Users to open the List of Users.
2. Right click the specific user to open a popup menu and click Change Password. The Change Password dialog box will open.
3. Type in the new password in the New Password field.
4. In the Confirm Password field type the new password again.
5. Click OK to confirm.

Note: The User Name field cannot be changed.
To view the List of Users:

This option has three sub-options Duplicate, Settings and Clear Filters described below:

- **Duplicate** - This option opens a duplicate copy of the List of Users. When right clicking and/or selecting a user in the list the same options as for User are available.

- **Settings** - This option defines the List of Users settings. There are three columns; Full Name, Description and User Name. Columns can be deleted and their order changed.
  1. To delete/activate a column click the checkbox next to the specific column name.
  2. To change the order the columns appear in the List of Users, select a column name and click either Move up or Move down.
  3. Clicking Select All activates all columns. These columns will be displayed in the List of Users.
  4. Clicking Deselect All de-activates all columns. No columns will be displayed in the List of Users.
  5. Click Default to return to the application settings.
  6. Click OK to confirm.

- **Clear Filters** - The List of Users table can be filtered alphabetically or numerical as follows:
  1. Type the filter number or letter in the textbox under the List of Users columns. The list will be filtered accordingly.
  2. To clear the filter, right click in the List of Users, select View and then Clear Filters. The complete List of Users will open on your screen.
Groups Tab

Groups can be created for new users by clicking the Groups tab. However, existing users can also be added to groups by opening the List of Users and double clicking the specific user to open the User Properties dialog box.

This tab is divided into two sections, List of Groups and Member Of. The user (see page 29) can be added or removed to a group or added or removed from all the groups listed. Additionally, groups can be created, deleted, viewed or modified. A user's properties can also be viewed and updated.

To add a user to a/all group(s)

1. Select the relevant group/s from the List of All Groups column.
2. Click the Add button. The name of the Group/s will be added to the Member of column.
3. Click OK to confirm. The user's name will be added to the Group/s. This can be viewed when selecting Groups in All Containers to open the Groups List in the Control Panel, double clicking the group name and then checking the Users tab.

**To remove a user from a/all group(s)**
1. Select the relevant group from the List of All Groups column.
2. Click the Remove/Remove All button. The name of the Group will be removed from the Member Of column.
3. Click OK to confirm. The user's name will be removed from the Group/s.

**To modify groups**
1. Select the relevant group from the List of All Groups column.
2. Either right click to open a popup menu and select Modify or click Modify button located under the List all Groups column.
3. Click OK. The Group Properties dialog box will open.
4. Make your modifications and click OK to confirm. For further instructions read To add new groups.

**To delete groups**
1. Select the relevant group from the List of All Groups column.
2. Either right click to open a popup menu and select Delete or, click the delete button located under the List all Groups column.
3. Click OK to confirm.
To add new groups

1. Click the New icon located under the List all Groups column. The New Group dialog box opens. This dialog box has two tabs; General and Users. A third tab opens after the General tab has been filled, Alert Group checked and the Apply button clicked.

2. Follow the instructions on page 26 to complete this dialog box.
Creating New Teams

The Teams tab has two columns List All Teams and Members.

Teams can be created, deleted, renamed and new members can be added to them. To do so either right click the team name to open a dropdown list and select your option or, click the relevant button located under the List all Teams column.
1. To create a new team either right click in the List All Teams column and click New Team, or click the New icon.

2. Type in the team's name and then click Apply.

3. To add members to the team, select the team in the List all Teams column and then either right click to open a popup menu and select Team Members or click the button. The Team Members dialog box will open.

4. From the List all Group Members (page 18) column select the relevant groups that will be added to the team and then click Add. Click OK to confirm. The name of the user appears in the Members column. Click OK to confirm.

**Messenger Tab**

This tab is used to define how alarms are sent to a user/group/team. The Advanced Alarm Management (AAM) messenger service enables the following modes:

- Generic Beep
- Fax
- ellone
- Email
To define an AAM messenger service:

1. Click the Messenger tab to open the Messenger dialog box. This dialog box enables new services to be defined and attached to user/groups/teams.

AAM Services can be created, deleted, modified and moved up and down within the list. To do so either right click in the Assign to AAM Services window or click the relevant button located under the window. In addition back up users can be defined.

1. To define a new AAM service either right click in the Assign to AAM Services window or click the button to open Messenger menu.
2. In the AAM Service Name field click the dropdown list and select the type of service.

3. In the Email/Phone field type in the relevant number/address.

4. If alarms are to be sent in short format check the Short AAM Info checkbox.

5. Click OK to return to the user Messenger tab.

6. In the Backup user field click the arrow to open the dropdown list and select a user.

7. Click OK to confirm.

Note: In this version the only service that can be supported by the Backup User is Vocal.
**Information Tab**

Additional information regarding the defined user can be written in the Information tab. This information includes address, PIN number (for security/accessing the program) and comments.

To add information:

1. Click the Information tab.
2. In the Address field type in the user's address.
3. In the PIN code field type in the user's PIN code.
4. In the Comments field type in any comments that may be required.
5. Click OK. The new user's name and information appears in the List of Users.
Creating Groups

To create a new group:

In the All Containers section of the Application Studio click User Management and then click Groups. A List of Groups opens in the Control Panel.

![Image of New Wizcon Application - Application Studio with groups highlighted]

Note: If no groups are defined in the project then the list will still open with the application’s default Administrator displayed.

1. In All Containers right click Groups and then click New or right click anywhere in the Control Panel and click New. The New Group dialog box opens.

Chapter 7 Security and User Management

Wizcon for Windows & Internet 8.2
When the New Group dialog box opens it has two tabs General and Users however, there is a third tab called Teams which only opens after the General tab has been filled, Alert group clicked and the Apply button clicked.

**General**  
Where the group’s basic general properties are defined. See General Tab on page 7-15.

**Users**  
Where the users that are members of the group are defined. See Users Tab on page 7-29.

**Teams**  
Where the groups that are members of the team are defined. See Creating New Teams on page 7-21.
General Tab

The General tab defines the name of the group and a description of it, for example Bottling, or Hygiene.

1. In the Group Name field type in the name of the Group.
2. In the Description field type in a description of the group.
3. To add this group to a team, check the Alert Group checkbox.
4. Click Apply. The Teams tab is added to the dialog box.
Users Tab

The Users tab defines the users that are members of the group. This tab is divided into two sections, List of Users and Member. Users can be modified, added or removed from groups.

1. To add a user to a group, select a user from the List all Users column and click the Add button. Alternatively, select all the users in the column and click the Add all button. The users will appear in the Members column.

2. To remove a user, select a user from the Members column and click the Remove button. Alternatively, select all the users in the column and click the Remove all button. The users will be removed from the Members column.

3. Click Apply and open the Teams tab.
To add new users

1. Either right click to open a popup menu and then click New or click the button located below the List of Users column. The New User dialog box will open.
2. Follow the instructions above for creating a new user. Click OK to confirm.

To define a group administrator

1. In the Members column check the checkbox next to the relevant user's name.
2. Click OK to confirm.

To modify existing users

1. In the Group Properties Users tab select a specific user from the List all Users column.
2. Either right click to open a popup menu and then click Modify or click the button located below the List of Users column. The User Properties dialog box will open.
3. Modify the relevant properties and click OK to confirm.

To delete existing users

1. Right click the specific user to open a popup menu and click delete. The Delete User message will open.
2. Click Yes to delete the user. The user will be deleted from the List of Groups.
3. Click OK to confirm.
Creating Teams

Creating New Teams

The Teams tab has two columns: List All Teams and Members. Teams can be created, deleted, renamed and new members can be added to them. To do so either right click the team name to open a popup menu and select your option or, click the relevant button located under the List all Teams column.

1. To create a new team either right click in the List All Teams column and click New Team, or click the New icon. A textbox with a team icon will open in the List all Teams column.

2. Type in the team's name and then click Apply.
To add users to teams

1. To add members to the team, select the team in the List all Teams column and then either right click to open a popup menu and select Team Members or click the button. The Team Members dialog box will open.

2. From the List all Group Members column select the relevant groups that will be added to the team and then click Add. Click OK to confirm. The name of the user will appear in the Members column.

To delete teams

1. Right click the specific user to open a dropdown list and click Delete or click the button. The team will be removed from the List of Teams.

2. Click OK to confirm.

To rename teams

1. Right click the specific user to open a popup menu and click Rename or click the button.

2. Type in the new team name.

3. Click OK to confirm.
Chapter 8  Communication Drivers

About this chapter:

This chapter describes how to define communication drivers in the application, as follows:

Overview on page 8-2 is an overview of communication drivers and communication blocks.

Defining Communication Drivers on page 8-2 describes how to add and remove communication drivers to and from your application.

Communication Driver Properties on page 8-8 describes how to define general driver properties, serial port parameters and communication blocks. It also describes how to view general driver information.

Converting Communication Block Definitions on page 8-15 describes the conversion utility used for communication block definitions.

Defining OPC (Application Client) on page 8-17 provides an overview of OPC (OLE for Process Control).

OPC Driver Properties on page 8-18 describes defining OPC driver properties.
Overview

Communication drivers handle communications with external devices, such as PLCs, industrial instruments, remote computers and field buses. These drivers are separate program files, which are installed when installing the application. Communication driver file names have the format VPIWN?? .DLL, in which ?? is the two- or three-letter code of the driver. Since each communication driver is different, the driver's information documentation should be consulted for specific communication driver details.

You can define communication blocks to improve driver performance when working with large quantities of tags. These blocks enable you to transfer large blocks of information instead of individual data items.

The first step in designing an application is to define the communication drivers and blocks. You then define the tags, which are control values monitored by the system. They are used as internal variables for:

- Calculations and display.
- Communication with PLC's in order to represent data from PLC memory or to send commands to PLC's.

Note: In fast Pentium PCs with a 16550 UART (serial interface chip), Windows 2000 default settings may cause communication errors on serial communication drivers. To overcome this problem, lower the buffer sizes on the UART in the following menu: Start/Settings/Control Panel/System/Device Manager/Ports/Communication Port 1.4/Port Settings/Advanced. Use a trial and error method to reach the optimum setting.

Defining Communication Drivers

Communication drivers are defined in the Communication Drivers dialog box, in which you can add and remove drivers and define driver properties.

▶ To add/remove a communication driver:

In the Control Panel of the Application Studio, double-click the icon.
Or,
In the Design menu of the Application Studio, select Communication Drivers. The Communication Drivers dialog box is displayed:

This dialog box has the following fields:

- **Logical Name**: Specifies the communication driver’s unique name.
- **Device**: Specifies the name of the physical device. The standard name is COMn, where n is a number that refers to the serial port of the computer. Drivers that use standard TCP/IP, or proprietary network, do not require this parameter.
- **Name**: Specifies the name of the communicating driver. For example; SIEMENS, SIMATIC S7.
- **Parameters**: Specifies the Device access rights. For example, Read/Write and out of block.
To add a driver

Click the Add button. The Communication Driver Setup Wizard is displayed.

1. To install a driver from the List (installed with the application) double click the name of a communication driver and then click Next.
2. Type in a unique logical name for the driver in the relevant field.
3. Click the up/down arrows to define communication timeout.
4. Click the relevant text box to define the driver's attributes. This can be either Write, Read or Sample tags outside of blocks.
5. To modify the Init File, click the Edit Init File button to open a text editor where the file can be created/edited.
This dialog box enables you to define the driver’s Com port connection and communication parameters.

7. To define the Com port click the field’s arrow to open a dropdown list and make your selection.

8. Fill the Baud Rate, Data Bits, Parity and Stop Bits fields according to the default parameters.

9. Click Next to open the Communication Driver Setup Wizard - Blocks dialog box.
The following options are available:

**Add**  
Click to add a new communication driver

**Delete**  
Delete a communication driver from the list

**Modify**  
Modify an existing communication driver

**Files**  
This option has two sub-options Import and Export

10. Click the Add button. The Block Definition dialog box is displayed.
The following options are available:

**Block Address**  The starting address of the block in the device. For address format specifications, see the relevant communication driver section in the Axeda Systems Driver documentation.

**Length**  Number of items in the block.

**Sample Rate**  Sampling rate of the block in seconds and milliseconds.

*Note: After defining communication drivers restart the application to enable the new definitions.*

**To remove a driver:**

Select the driver you want to remove and click the Remove button. The driver is deleted from the list of drivers.

*Note: After defining communication drivers restart the application to enable the new definitions.*

---

**Communication Driver Properties**

Communication driver properties are defined in the Communication Driver dialog box.

**To define communication driver properties:**

1. In the Design menu of the Application Studio, select Communication Drivers. The Communication Drivers dialog box is displayed.

2. Select a driver and then click the Properties button to display a dialog box in which you can define communication driver properties.

In this dialog box you can define the following:

- General driver properties, in the General Tab.
- Serial port parameters, in the Serial Tab.
- Communication blocks, in the Blocks Tab.
- View information about the driver in the Information Tab.
General Tab

You can define general driver properties in the General tab of the Communication Driver dialog box.

![Communication Driver - ABB EXCOM dialog box]

The following options are available:

- **Logical Name**: Specifies a name for identification purposes.
- **Timeout**: Serial Drivers: Defines the period of time (in one hundredth of a second) during which the system waits for response from a device before indicating a communication failure. Non Serial Drivers: Timeout unit is one millisecond.
- **Attributes**: Read: Check to enable Read Only operations with the device. Write: Check to enable Write Only operation with the device. Sample tags outside of blocks: Check to enable the sampling of tags not included in the communication blocks. If you do not select this option, communications will be limited to tags within the blocks.
Serial Tab

You can define serial port parameters in the Serial tab, of the Communication Driver dialog box.

The following options are available:

**Serial port**  
Enter the appropriate device name. The standard name is `COMn`, where `n` is a number that refers to the serial port of the computer. For example, `COM1` for port 1.

The Baud Rate, Data Bits, Parity and Stop Bits fields are set to the default setting determined by the PLC or manufacturer. (If they have been defined they will automatically be displayed).
Blocks Tab

You can define communication blocks in the Blocks tab, of the Communication Driver dialog box, as described below.

You can define communication blocks to improve driver performance when working with large quantities of tags. These blocks enable you to transfer large blocks of information instead of individual data items.

The rationale for assigning communication blocks is the reduction in transmission overhead. In serial communications (RS-232C), the serial bit rate is relatively slow and 10 to 20 bytes are required just to address the items to be transferred. Thus, while approximately 20 extra bytes are required to transfer one single item, large blocks containing several items can be assigned instead, using the same addressing overhead.

It should be noted, however, that not all devices support block transfers, and those that do may impose restrictions on block size or item types.

For more details, see the relevant application Driver documentation.

The application enables you to define contiguous blocks in the address space of the external device. Each block can then be transferred in a single common transaction.
To define a communication block:

Click the Add button in the Communication Driver dialog box. The following dialog box is displayed.

![Block Definition dialog box]

The following options are available:

- **Block Address**  
  The starting address of the block in the device. For address format specifications, see the relevant communication driver section in the Driver documentation.

- **Length**  
  Number of items in the block.

- **Sample Rate**  
  Sampling rate of the block in seconds and milliseconds.

*Note: The maximum number of blocks that can be defined for each driver is 1024. In certain circumstances blocks may be defined differently. For more information, refer to the Driver documentation.*

- Though blocks are efficient in terms of transfer rate, defining large blocks that cover unnecessary items may degrade system performance.

- It is better to define small blocks with fast sampling rates for items that are monitored frequently, and leave the remaining data in larger blocks with slower sampling rates.

- Although blocks may overlap each other, this situation is undesirable since identical tags that belong to two overlapping blocks will be sampled twice (which is insufficient).

- The relationship between the block and tag sampling rates (specified in the Block Definition and Analog/Digital Tag Definition dialog boxes respectively) is such that the slower of the two rates will always override the other.

For example, if you define a communication block for five tags with a block sample rate of 30 seconds. Three of the tags will be assigned a tag sample rate of 20...
seconds, and the remaining two tags assigned a tag sample rate of 10 seconds. The following illustration will clarify the example:

```
G1 G2 G3 G4 G5
20 sec  10 sec
+---------+
 |        |
30 sec
```

The tags will be sampled only after 30 seconds have elapsed since the last time the block was sampled.

However, if you define a sampling rate for a tag group slower than the block sampling rate, as in the following illustration.

```
G1 G2 G3 G4 G5
40 sec  10 sec
+---------+
 |        |
30 sec
```

The tags in the group (40-second group in the example above) will be sampled whenever the amount of time specified by the slower rate has elapsed.

It is therefore recommended to group tags into blocks according to their sample rate.
**Information Tab**

You can view driver information in the Information tab of the Communication Driver dialog box:

![Communication Driver Dialog Box](image)

The following information is available:

- **File name**: The driver file name.
- **Type**: This field can contain one of two parameters:
  - *Serial* which defines parameter for serial communication (RS-232C protocol).
  - *NULL* which is not serial and can use an external library, or device drivers, supplied by an external provider.
- **Supports**: Describes the function that the driver supports.
- **Description**: The name of the driver.
Converting Communication Block Definitions

The application provides a conversion utility for communication block definitions. You can:

- Export communication block definitions to external sources in fixed or CSV file format.
- Import communication block definitions to the application in fixed or CSV file format.

To import/export communication block definitions:

1. In the Design menu of the Application Studio, select Communication Drivers. The Communication Driver dialog box is displayed.
2. Select a driver from the list of available drivers, click the Properties button and then select the Blocks tab. The communication driver properties are displayed:

3. Click the Files button. This displays a popup menu in which you can select Export or Import.
4. To export:
   - Select Export from the popup menu. The Open block file for export dialog box is displayed. This is similar to the standard Open dialog box.
   - In the Files of type field, select one of two export options: BLS or CSV. Then locate the file enter a filename and click Save. The file is exported.

5. To import:
   - Select Import from the popup menu. The Choose block file dialog box is displayed:
   - In the Files of type field, select the type of file you want to import. You can choose between BLS or CSV. Then locate the file you want to import and click Open. The imported file will replace previous block definitions.

*Note: Restart the application after importing files for changes to take effect.*
Importing and Exporting Definitions Using an External Application

If you are using an external application you can import and export communication block definition files using the command line.

Exporting Communication Block Definition Files

- To convert a communication block definition file to csv format:
  Type the following in the command line:
  `bls2csv [fromfile] [tofile]`

- To convert a communication block definition file to a dat file:
  Type the following in the command line:
  `bls2dat [fromfile] [tofile]`

Importing Communication Block Definition Files

- To convert a csv file to a communication block definition file:
  Type the following in the command line:
  `csv2bls [fromfile] [tofile]`

  Note: The application can run in the background. Restart the application for the changes to take effect.

Defining OPC (Application Client)

OPC (OLE for Process Control) is an industry software standard designed to provide business applications with easy access to industrial plant floor data.

Using OPC technology, a system integrator can create a common interface for exchanging data with hardware field devices or other software that can be reused by this client program, and other HMI, SCADA and custom applications.

This client program uses OPC technology to exchange data with HMI and SCADA software and OPC servers.
**OPC Driver Properties**

Communication drivers are defined in the Communication Drivers dialog box, in which you can add and remove drivers as described on the following page, and define driver properties.

► **To add/remove a communication driver:**

In the Control Panel of the Application Studio, double-click the Communication Drivers icon.

Or,

In the Design menu of the Application Studio, select Communication Drivers.

► **To define communication driver properties:**

1. In the Design menu of the Application Studio, select Communication Drivers. The Communication Drivers dialog box is displayed.

2. Select a driver and then click the Properties button to display The Communication Driver - OPC Client dialog box in which you can define communication driver properties.
In this dialog you can define the following:

**Logical Name**
Specifies the name given to the driver for application identification purposes.

**OPC Server Name**
Name of a specific interface.

OPC Servers are provided by different vendors. The code written by the vendor determines the devices and data to which each server has access, the way in which data items are named and the details about how the server physically accesses that data.

For this reason, we expect that the OPC Server will generally be a local or remote program which includes code that is responsible for data collection from a physical device.

**Node Name**
Specifies the name of your computer.

If your OPC is running from a remote site you must make sure that DCOM™ is configured correctly to provide networking.
Chapter 9  Tags

About this chapter:

Overview on page 9-2 gives a short overview of application tags.
Defining Tags on page 9-4 discusses how to define application tags.
General Tab on page 9-5 discusses the General tab options.
Record Tab on page 9-15 discusses the Record tab options.
Lock Tag on page 9-20 discusses the Lock tab options.
Alarms Tab on page 9-22 discusses the Alarm tab options.
Fixed (GLS File) Format on page 9-31 discusses Fixed Formatted tags
Single Tag Input on page 9-25 describes how to assign an immediate value to a specific tag.
MultiAdd Tags on page 9-26 discusses how to automatically generate a group of tags according to a user-defined pattern format.
System Tags on page 9-28 discusses predefined system tags.
Exporting Tags on page 9-29 discusses how to generate a tag list file (list of tag definitions) in two formats
Importing Tags on page 9-33 discusses how to import a tag list file into the system.
Defining Tag Properties on page 9-34 discusses how to define properties for the tag buffer size and the flush rate.
Overview

The term Tags in the application refers to control values monitored by the system. These values are similar to variables in a programming language such as BASIC, PASCAL, and C. Like their programming counterparts, each value is identified by a unique name and can be one of several data types, such as integer, real, or Boolean.

PLC tags are distinguished from other variables in that they can be associated with external device components, such as registers or I/O points in PLCs, memory locations in remote devices. A tag value represents the value of an external component or device, so that referencing the tag is equivalent to referencing the component or device itself. Updating a tag causes the external component or device to also be updated. Thus, an application PLC tag is actually a link to external devices.

Once tags are defined in the Tag Definition dialog box, they can be used in other modules for displaying, calculating and control functions.

For quick reference, the number of tags within the application is listed Application Studio Status Bar.

Basic Principles

An application tag can be associated with one of the following sources: PLC, Dummy or Compound:

- **PLC**: These tags are associated with external devices and mapped to the external device variables (for example, PLC registers). The application samples these tags periodically through the communication driver so that value changes in the field device variable are automatically transferred to the associated tag. PLC tag value changes in the application are recognized in the external device.

- **Dummy Tags**: These tags represent internal variables and are used for a variety of calculations, control and other application-related needs. Dummy tags are updated by user input or changed by other application modules. These tags are set to 0 upon system initialization.

- **Compound**: Tags that are linear calculations based on values of other tags.

- **System Tags**: Tags that are predefined and built to provide system status information. These tags can be added to an application only once either when the application is activated or anytime afterwards. Once added, System Tags will appear
under the Tags icon in the All Containers pane. When double clicked a list of all the System Tags in the application will open in the Control Panel.

- **RePlay Tags:** The RePlay Tags list is held in the Application Studio, All Containers pane under the Tags container. This list contains seven application dummy WIZRPL tags and the dummy WIZRPL tags that are generated during image RePlay. In the RePlay module the list of WIZRPL Tags appears in the RePlay Image field. Dummy RePlay tags have the same attributes as the original tags used in the original image.

- **Tag Mapper:** The Tag Mapper is a data file of tags and tag values that can be used to considerably reduce workload during application creation. Tag values of tags held in a Tag Mapper table are mapped by the Tag Mapper into a list of other tags. There are two types of Tag Mapper tags:
  - **Source:** These are tags whose values are directed to target tags. More than one source tag can be pointed to the same target tag.
  - **Target:** This tag type receives the values of the source tag. All target tags must have the WIZTGM_ prefix.

According to their data types, tags can be one of the following:

- **Digital Tag Type** (see page 9) Discrete logic tags that have Boolean values of TRUE (1) or FALSE (0).
- **Analog Tag Type** (see page 9) Tags that have numeric values represented in various formats (signed or unsigned integer, floating point, BCD).
- **String Tag Type** (see page 9) Tags which are defined to receive alpha-numeric strings.

**Tag Icons**

The application marks the different tag types with icons. Below are the Analog, Digital and String icons used to mark tags in the Studio Tag List.

- `Analog`
- `Digital`
- `String`
Defining Tags

To define a tag:
Click the Tag icon in the application toolbar to open the Tag Definition dialog box.
Or,
From the All Containers section of the Application Studio, right-click Tags and select Add Tag to open the Tag Definition dialog box.
The Tag Definition dialog box has five tabs:
- General Tab on page 9-5 used to create new tags and modify existing ones
- Record Tab on page 9-15 defines how tag value changes will be recorded to history
- Dynamic Data Exchange (DDE) Link Tab on page 9-16 used to define the online communication method for other applications (such as Excel)
- Lock Tag on page 9-20 enables tag values to be locked for a predefined period of time. The Status Tag (digital) option indicates the locked tag status
- Alarms Tab on page 9-22 where the following tag related alarms can be defined:
  - LoLo
  - Low
  - High
  - HiHi
  - Rate of Change
  - Deviation
General Tab

The General tab defines a tag's general properties. This tab is dynamic and changes when either the Tag Source or Tag Type fields are defined.

The following options are available:

Tag Name Enter a unique tag name with no more than 32 characters.

Description Enter a brief description of the tag with no more than 254 characters.

Groups Click to display the Access Permission Manager dialog box in which you can define authorized users and security groups so that only authorized operators can set tag value.
**Tag Source**

This field is divided into two sections:

Tag source option: Click to display a drop-down list in which you can choose the source to work with. Your choice will determine the available tag source parameters.

Tag source parameters: There are three types of source parameters.

- Dummy: select for internal application-related processing and needs. The Dummy tag has no tag source parameters.
- PLC: select to associate with a PLC driver.
- Compound: select for automatic calculations based on tag values.

**Tag Type**

This field is divided into two sections:

Tag Type and Tag Parameters.

Click to display a drop-down list in which you can choose the tag type to work with. There are three tag types:

- Analog (the default tag type). See Analog Tag Type on page 9-10 for further details.
- Digital see Digital Tag Type on page 9-12 for further details.
- String see String Tag Type on page 9-13 for further details.

Your choice will determine the available tag type parameters.
**PLC Tag Source Parameters**

*Note: If drivers have not been previously defined then do so now. For further information refer to Chapter 8, Communication Drivers.*

▶ **To open the Tag Source parameter fields:**

In the Tag Definitions dialog box click the arrow in the Tag Source field and select PLC. The Tag Source field opens.

![Tag Source Parameter Fields](image)

*Note: The following parameters are available both when creating and modifying a tag.*

The following options are available:

**Driver**

Specifies the name of the driver responsible for communication with the relevant external device. The available communication drivers should be previously defined in the communication driver definition module. For a list of currently defined communication drivers, click on the arrow to the right of the field.
| Address | The address string specifies the location of the tag data source in the PLC or other field device. Generally, the address represents combination of a PLC unit and PLC register number and type. The exact address format is specific for each PLC and depends on the driver used for the communication. |
| Sample | External devices are sampled periodically to update the values of their associated tags. Therefore, a tag value always reflects the state of its associated device. Each tag is assigned its own sampling rate. However, if the device component, with which the tag is associated is included in a communications block, the block will ultimately determine the sampling rate. The following options are available: Never: The external device is never sampled to update its respective tag. In Monitor: The device is sampled to update its respective tag only when the tag's value is requested by one of the application's modules (for example, displayed in an Image). This option is useful for minimizing communications traffic, thereby improving system performance. Select this option for tags that are used for monitoring field activities and do not record into history files. Do not select this option for tags that are used for alarm definition. Always: The device is always sampled to update its respective tag. If you select this option, specify the sample rate in seconds and/or milliseconds. |

*Note: If the tag is included in a communication block, the block will ultimately determine the sampling rate. Tags can be sampled at a rate of up to 40 milliseconds.*
To Define OPC Source Parameters

You can associate the tag you want to define with an OPC driver by clicking in the Tag Source field of the Tag Definition: New Tag dialog box and selecting the driver from the drop-down list. The Tag Source parameters will appear.

*Note: The following parameters are available both when creating and modifying a tag.*

1. From the Driver drop-down list select the OPC driver.
2. In the Address field click on the Browse button. The Add Item dialog box opens.
   *Note: This dialog box opens only if your OPC Server supports browsing. If not you must enter the address manually.*
3. From the Browse Items list, select the name of the item that you want to be linked to and click OK to complete the operation.

Compound Tag Source Parameters

A compound tag is either an analog or digital tag, the value of which is a combination of two other tags.

*Note: The following parameters are available both when creating and modifying a tag.*

**To define compound tags:**

Click in the Tag Source field of the Tag Definitions: NEW Tag dialog box, and select Compound from the drop-down list. The Tag Source parameters will appear:

The compound tag formula is as follows:

\[ \text{Constant}_1 \times \text{Tag}_1 \text{ oper } \text{Constant}_2 \times \text{Tag}_2 \]

Where oper is one of the following operators: +, -, / (division), or * (multiplication). Operators can be selected by clicking on the relevant operator.
Note: *In the tag field click on the arrow to the right of the fields, to obtain a list of available tags.*

Define the compound tag in the Calculate field as either In Monitor or Always. Select Always if you want the compound tag to be calculated always (also when the tag is not In Monitor).

After you define the formula, whenever the individual tags are sampled, the compound tag will be assigned a value according to the evaluated formula.

**Analog Tag Type**

Analog tags have numeric values represented in various formats (signed or unsigned integer, floating point, BDC).

► **To define an analog tag type:**

Click in the Tag Type field of the Tag Definitions, New Tag dialog box and select Analog from the drop-down list. The Tag Type parameters will appear as follows:

<table>
<thead>
<tr>
<th>Tag Type: Analog</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Format:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Limit:</td>
</tr>
<tr>
<td>High Limit:</td>
</tr>
<tr>
<td>Set Default:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measured</td>
</tr>
<tr>
<td>Engineering</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value 2</td>
</tr>
</tbody>
</table>

The following options are available:

**Format**

This field is used to specify the data format of the external device. The options include:

- Unsigned 16: Unsigned 16-bit integer.
- Signed 16: Signed 16-bit integer.
- BCD: 4-digit BCD format.
- Float: 4-byte IEEE single-precision, floating point format.
- Signed 32: Signed 32-bit integer.
- Unsigned 32: Unsigned 32-bit integer.
**Tolerance**

Specifies the minimum amount of change that must occur to a tag value, since the last change, for an event to be recognized. Using this parameter is a convenient way of smoothing sensor fluctuations.

Tolerance applies to analog PLC tags only. The value is in the external device measurement units (raw PLC units) and not engineering units (ref Conversion).

**Tag Scale**

Low/High Limit

These fields specify the upper and lower limits of the tag's value. This option is only relevant when the Set to Default option is not checked.

**Set Default**

When this option is checked the Low/High limits are default according to the format limits.

**Conversion**

External devices normally generate values according to their internal format and in order to obtain the maximum accuracy. For instance, a temperature measured in the field, which is in the range between 0 and 600 degrees, may be presented as a numerical range of between 0 to 65535. To convert the field measured value in engineering units, the application uses the linear conversion.

Value 1 Measured: Measured raw value sample.

Value 1 Engineering: Corresponding engineering value sample.

Value 2 Measured: Another measured raw value sample.
Value 2 Engineering: Another corresponding engineering value sample. For example, if you specify the following:
Value 1 Measured = 0.
Value 1 Engineering = 0.
Value 2 Measured = 1.
Value 2 Engineering = 2.
The converted value would be the raw PLC value multiplied by two.

Note: When converting a float tag value the result will always be a float number even if the tag format is WORD or DWORD.

**Digital Tag Type**

A digital tag type is a discrete logic tag with Boolean values of TRUE (1) or FALSE (0).

► **To define a digital tag type:**

Click in the Tag Type field of the Tag Definitions: New Tag dialog box, and select Digital from the drop-down list. The Tag Type parameters will appear:

![Tag Type Parameters](image)

The following option is available:

- **Filter**
  Used for debouncing, which is filtering out oscillations. This option is only available for PLC tags. See PLC Tag Source Parameters on page 9-7.
**String Tag Type**

A string tag can receive an alphanumeric string as a tag value.

► **To define a string tag type:**

Click in the Tag Type field of the Tag Definitions, New Tag dialog box and select String from the drop-down list. The Tag Type parameters will appear as follows:

```
<table>
<thead>
<tr>
<th>Tag Type:</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width:</td>
<td>10</td>
</tr>
</tbody>
</table>
```

In the Width field, specify the maximum number of characters that you want the string to include. The maximum length of a string tag is 255 characters.

**Authorization Groups**

Security authorization can be added during tag definition. This enables the group/user to sample tag value changes.

This is implemented by assigning authorization groups/users to each tag. Operators who do not belong to any of the assigned groups will not be authorized to change tag values.

*Note: All operators can read tag values, but only authorized operators can change them.*

Operator authorization is discussed in more detail in Chapter 7, Security and User Management.

Once a group is assigned to a tag, any operator who belongs to the group can perform tag value operations on that tag.
To assign groups to a tag:
Click the Groups button to open the Access Permission Manager where authorized users and/or groups can be selected.

1. Click the dropdown list above the Groups/User Name field and select the type of list required. There are three list modes:
   - List all Groups&Users - displaying a list of the application's defined groups and users
   - List all Groups - displaying a list of the application's defined groups.
   - List all Users - displaying a list of the application's defined users.

2. To actually assign access permission select the relevant groups/users and click the Add button, or, click the Add All button to assign all groups/users. The selected groups/users are now displayed in the list of Access Members.

3. To delete users/groups from the Access Members List, select the relevant groups/users and click Remove, or click the Remove All button.
4. Check the All groups and users have access permission checkbox to assign access permission to all your application's groups and users. Click OK to confirm.

**Record Tab**

Click the Record Tab to access the Record tab dialog box to determine how tag value changes are recorded.

The following options are available:

- **Never**
  - Specifies that tag value changes will never be recorded.

- **Changes**
  - Specifies that the tag values will be recorded whenever it is sampled and is found to have changed by more than the tolerance since the previous sample.
Update  
Specifies that the tag value will be recorded whenever a driver is set to update the values (even if no changes were detected.)

Every  
Specifies that the tag value will be recorded each specified time interval.

ODBC Logging  
Specifies that tag value changes will be written in the same format both to the ODBC and to application history. This option is available when either Changes, Update or Every is selected.

**Dynamic Data Exchange (DDE) Link Tab**

Click the DDE Link tab to access the DDE Link dialog box where how the application communicates with other applications (such as Excel) can be defined.
DDE is a common protocol that allows applications to exchange data freely, using either one-time data transfers, or ongoing transfers in which applications send updates to each other whenever new data is available.

The DDE Link tab contains options that enable you to specify that the tag will be linked to another application through the DDE. This will cause the tag value to be updated immediately, whenever a change occurs in the object to which the tag is linked.

There are three options:

In the DDE Type field click the arrow in the dropdown list and select either:

- **None** Specifies that no DDE link is associated with the tag. This is the default option.
- **Single** Specifies the application, topic, item name and type of link.
- **Block** Specifies the block name, row, column and type of link.

**DDE Type - Single**

Select Single from the Tag Definition dialog box for tags that will not be part of a DDE client block.

The following fields define the DDE connection:

- **Application** The application to which you want to link the tag.
- **Topic** The topic in the application that contains the object to which the tag will be linked.
**Item Name**  
The name of the item to which you want to link the tag. The name is taken from the application and topic to which the tag is linked. For example, an Excel cell number.

**Link**  
Enables you to define the DDE Link as: Always linked to the DDE server or In Monitor. When selecting Always, every change will be passed by application DDEC to WizPro, even if the tag is not In Monitor. Application DDEC enables your application to run as a DDE client and receive information from server applications. Refer to Chapter 36, Application DDE Support for more details about application DDEC.

**DDE Type - Block**
Select Block from the Tag Definition dialog box to connect a tag to one item from a DDE block.

<table>
<thead>
<tr>
<th>DDE Type</th>
<th>Block Name</th>
<th>Link</th>
<th>Row</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following options are available:

**Block Name**  
The block to which the tag will belong.

**Row**  
The row number of the item in the block relative to the start position.
The application DDEC block mechanism enables the application to receive many tag values from the server in one update message. This improves the communication between the application and the DDE server.

A common use for DDE client blocks is a setup in which a DDE server immediately updates a block of items building a recipe. Define DDE client blocks only if data items in the server change simultaneously (within milliseconds). For more details, refer to the DDE Support chapter.

PLC tags linked to DDE items will actually cause the DDE application to update the PLC, and the updated value sampled from the PLC will be automatically transferred to the DDE application. However, if any application module reads or writes tag values, it will first access the PLC tags and then update the DDE link.

**Column**

The column number of the item in the block relative to the start position.

**Link**

Enables you to define the DDE Link as:

- Always linked to the DDE server or In Monitor. When selecting Always, every change will be passed by application DDEC to WizPro, even if the tag is not In Monitor.
Lock Tag

Click the Lock tab to access the Lock dialog box. Tag values can be locked for a predefined period of time. This could be for a short time or permanently.

The following options are available:

- **Lock Tag**: This field when checked enables the Lock Tag option.
- **Tag value in locked state**: Specifies the value of the tag in its locked state. The tag remains with this value until the date/time limits expire.
- **Never expire**: When checked defines that the tag will remain permanently locked.
- **Lock until**: Defines the time and date when the defined Lock Tag option expires.
- **Status Tag**: Defines the status of the locked tag (digital only).
To modify a tag:
1. In the All Containers section of the Application Studio, click on Tags to display the List of Tags.
2. In the List of Tags section, right-click the tag you want to modify and select Modify Tag from the popup menu. 
   Or, 
   Double-click on the tag in the List of Tags section. The Tag Definition dialog box is displayed in which you can modify the tag.

To delete a tag:
1. In the All Containers section of the Application Studio, click on Tags to display the List of Tags.
2. In the List of Tags, right click the tag you want to delete and select Delete Tag from the popup menu. A dialog box is displayed in which you can confirm your request or cancel it.

To find a tag:
1. In the List of Tags right-click anywhere and select Find Tag from the popup menu. The Find Tag dialog box opens.
   2. In the Find What field type in the name of the tag, its description or address.
   3. In the Conditions field select either; Tag Name, Description or Address (your selection will depend on the information you typed in the Find What field).
4. Click Find. The tag is highlighted in the List or Tags.

5. To close the dialog box click Exit or anywhere in the Application Studio.

**Alarms Tab**

The Alarms tab is used to define Tag Related Alarms and their properties. The following apply to all Tag Related Alarms:

- **Alarms** are automatically generated with the correct condition and text that is a combination of the tag description and the alarm type.

- If the combination of the tag description and the alarm type is longer than the maximum permitted number of alarm text characters then the alarm text is a combination of the tag name and the alarm type. Other parameters such as Zone, Family etc are set to default.

- The user can edit text and other properties, however the alarm condition cannot be modified.

- An alarm can be deleted from the Tag Definition dialog box only.

- An automatic alarm is marked as such and the link to the tag is saved. The tag contains a link to each alarm definition. If the properties of the above setting change the conditions also change and as a result the alarm definition is updated.

- In the Alarms tab when an alarm in the Alarms Value field is checked the user can modify the definition of this specific alarm by clicking the relevant alarm button.

- Un-checking the relevant checkbox removes the alarm definition.

- If a tag definition is deleted all alarms related to this tag will be removed automatically.

▶ **To access the Tag Definition Alarms Tab**

In the Tag Definition dialog box click the Alarms tab to access the Alarms dialog box.

Or

In the All Containers list right click Tags, select Add Tag and after defining the tag name and other general properties click the Alarms tab.
This dialog box has the following fields:

**Alarms Values**

- There are four alarm values:
  - **LoLo** - critically low process values. The tag value must fall below this limit to generate an alarm.
  - **Low** - low process values. The tag value must fall below this limit to generate an alarm.
  - **High** - high process values. The tag value must exceed this limit to generate an alarm.
  - **HiHi** - critically high process values. The tag value must exceed this limit to generate an alarm.

These values are independent of each other. For example LoLo can be defined as 1000 and HiHi can be defined as 5.
To define Tag Related Alarms do the following:

1. In the Alarm Values field check the alarm type, which could be either LoLo, Low, High or HiHi and then type in the value in the relevant field. If an option is not checked an alarm cannot be defined. Only when a checkbox is selected the can alarm exists.

2. Click the Alarm button opposite the checked Alarm Value to open the Alarm Definition dialog box. Modify the alarm accordingly and then click OK to return to this dialog box.

3. In the Rate Alarm field fill in the Rate of Change and then click the Alarms button to open the Alarm Definition dialog box. Modify the alarm accordingly and then click OK to return to this dialog box.

4. In the Deviation Alarm field do one of the following:
   - To define the Optimal Value check this checkbox and then type in its value. This is the basic value.
   - In the Dead Band % field check either the Percentage or Fixed and then type in the value. Click the Alarms button to open the Alarms dialog box and modify the alarm accordingly. Click OK to return to this dialog box.

**Rate Alarm**
Processes values that change too quickly. When a process value fluctuates by more than the rate of change limit in the given time interval the tag generates an amount per unit of time.

**Deviation Alarm**
Processes values that deviate from the optimum value. Deviation alarms require a definition of a target value and range. If the process exceeds the range, a Deviation Alarm occurs. For example, if the optimum value is 100 and the range (dead band) is +/-5%, the process can vary from 95 to 105 without generating an alarm. The Deviation Dead Band is given as a percentage of the value. Deviation alarms can be according to:
- Type which is according to %.
- Fixed which is fixed according to a set size.
5. Click OK to confirm and save your changes.

**Single Tag Input**

This section describes how to assign an immediate value to a specific tag.

- **To define single tag input:**

In the Control Panel of the Application Studio, double-click the Single Tag icon. Or, From the Tools menu of the Application Studio, select Single Tag. The Single Tag Input dialog box is displayed:

![Single Tag Input dialog box](image)

The following options are available:

- **Station Name**
  - The application network station to which the tag belongs.

- **Tag Name**
  - The tag for which the value is to be modified. Click on the arrow on the right side of the field to display a drop-down list of tags. When a tag is selected, its description is displayed underneath the Tag Name field and its value is displayed in the Current Value field.

- **Current Value**
  - Specifies the current value of the selected tag.

- **New Value**
  - Enter the new tag value, or click on the arrows in the Suggest field slider, to determine a new tag value.
MultiAdd Tags

The MultiAdd operation is used to automatically generate a group of tags according to a user-defined pattern format.

To define tag pattern format:

1. In the All Containers section of the Application Studio, click on Tags to display the List of Tags.

2. In the List of Tags section, right-click the tag you want to add to a group and select MultiAdd from the popup menu. The MultiAdd Tag Definition dialog box is displayed:

   ![MultiAdd Tag Definition dialog box]

3. This dialog box is used to generate a pattern for tags to be added to the existing tag list. Once a pattern is defined for the Name format and Address format fields, you can activate the Generate button to add tags to the list according to the pattern you defined.

Set Specifies a new current value that is written immediately.

Suggest Specifies a new current value that is displayed in the New Value field and written by clicking Apply.
The following options are available:

**Name format**

The contents of this field can be any of the following characters:

*: This character will remain as is in the next tag.

A: This character will be incremented alphabetically.

D: This character will be incremented in decimal numeric order.

H: This character will be incremented in hexadecimal numeric order.

O: This character will be incremented in octal numeric order.

#: This character will cause whatever character appears in that position to be incremented according to its specific character type. If the character is alphabetical, it will be incremented alphabetically; if the character is numerical, it will be incremented numerically. Any other character will remain as is.

Note: The MultiAdd operation increments only the tag name and address.

For example, if the current tag name is WATER39X and the next name format was defined as *****DHA, the MultiAdd operation will cause the tag name WATER39Y to be generated.

Note that if the format length is less than the current name/address length, the format will affect the right part of the name/address. For example, if the name format was defined as **HHH, and the current name is WATER001, the next name will be WATER002.

**Address format**

The contents used for the Name format field can also be used for the Address format field.
After you set the MultiAdd definition, click the Generate button to generate the specified tag pattern. See Chapter 12, Multiple Tags for further information.

**System Tags**

System Tags are predefined, built-in tags providing system status information. These tags can be added to an application only once either when the application is activated or anytime afterwards. Once added, System Tags will appear under the Tags icon in the All Containers pane. When double clicked a list of all the tags in the application will open in the Control Panel.

System Tags also hold information for the application PLC integrated application. For a list of System Tags see Appendix H System Tags.

▶ **To define Systems tags when opening the program:**

If global tags have not been defined in your project then during application start-up the following message box will open on your screen.
4. Click Yes to add system tags or No not to.
5. Check the Never ask again checkbox to define this option. The System Tags icon will appear in the All Containers pane as a sub item of Tags.
6. Double click the System Tags icon to view the List of System Tags.

▶ **To define System Tags using the Tools menu:**
1. From the Tools menu select Add Systems Tags. A Warning message will appear on your screen.
2. Click Yes to add System Tags. The System Tags icon will appear in the All Containers pane as a sub item of Tags.
3. Double click the System Tags icon to view the List of System Tags.

---

**Exporting Tags**

The Export Tags option enables you to generate a tag list file (list of tag definitions) in two formats:

- ASCII - where files can be added. The list files are saved with a GLS extension
- CSV as Excel files - limited to numbers beginning with 0, for example tag addresses. This is a convenient tool for editing.

You can edit the file to add, modify or delete tags. You can then import the file back into the system.

*Note: The Excel program deletes the digit 0 before a number. To overcome this problem use ASCII format.*

▶ **To generate a list of tag definitions:**

In the All Containers pane right click on Tags and select Export Tags from the popup menu. The Tag List dialog box opens:
This dialog box is divided into two fields: Filter and Tags:

**Filter**
- Name - Specifies the tag you want to filter.
- Address - Specifies the address you want to filter.
- Comm. Driver - Specifies the name of the communication driver.

**List Target**
- Specifies the target destination of the generated list:
  - Printer - the generated list will be sent to the defined printer.
  - File (.GLS) - the generated list will be sent to file which can be either:
    - Fixed format
    - CSV

Filter conditions can be set so that only specific tags will appear in the generated tag list.

4. The Filter and Address fields in this dialog box are in From/To format and are used to set the tag list filter. In addition, you can specify the tag list target.

5. If File is selected as the target, the filename, without the path or extension, must be specified and then select Fixed or CSV. The file will be placed in your application directory.
Fixed (GLS File) Format

Tag list files (.GLS) are ASCII files that you edit, or create and add to or replace the existing application tag list.

Note: Long tag names, address strings and additional parameters in tag definitions make length of a line in a GLS file over 256 bytes. In order to work with GLS files, use any Standard Windows Editor and set the Wrap option to OFF. Any line that begins with a semicolon (;) will be ignored.

Tag descriptions appear inside the characters < >. Addresses have the format driver address or empty spaces for dummy tags.

For DDE-Params, the parameters are Link (Y/N), and <Application:Topic:Item>.

For Source-Params, the parameters are:

For PLC:

- **Driver address Smp Smp-Rate**

For Dummy:

- **No parameters**

For Compound:

- **Const1 Tag1 Oper Const2 Tag2**

For Type-Params, the parameters are:

For Analog:

- **Format Tol Conversion Min./Max.**

For Digital:

- **Filter**

For String:

- **Length**

The lines following the title line contain the tags and their corresponding tag information.
The following is an example of a tag list:

```
VERSION 8.2
; No.  Name <Description> Groups Rcd Rcd-Rate DDE-Params ication:Topic:Item> Source  Source-Params  Type  Type-Params  RO  Odbc  Local  Lock  LDef  Lock-Value  Status-Tag  Unlock-time;  Driver  Address  SmpMod  SmplRate  Frmt  Tol/Filter/StrLen  Conversion  Min/Max
1  Dummy1 <> 00000001  N  N  DUMMY  A  U  0  0  1  0
   11/ 0  N  N  N  N  N  0 <> 1001853938000
2  PLC1 <> 00000001  E  4294967294 S  A  <Excel:Book1:R01C01>  PLC  0  0001  A  1000  A  U  0  0  1  0  1/ 0  N  Y  N  Y  Y  0 <>
   18446744073709551615
```

**Exporting Tag Definition Files Using an External Application**

If you are using an external application you can export tag definition files using the command line or, save the option in the dialog box in a CSV file format.

▶ **To convert a tag definition file to CSV format:**

Type the following in the command line:

```
gls2csv [fromfile] [tofile]
```
**Importing Tags**

The Import Tags option enables you to import a tag list file into the system. The imported file can replace the current list of tag definitions.

▶ **To import tag definitions:**

In the All Containers section of the Application Studio, right-click on Tags and select Import Tags from the popup menu. The List to Tags dialog is displayed:

1. In the Files of type field, select the type of file you want to import. You can choose between CSV and GLS. Locate the file you want to import and click Open. The Import Mode dialog is displayed.

![Import Mode Dialog](image)

2. Click Replace to replace the alarms in the alarm list with the imported alarm, Append to add the specified alarm to the alarm list, or Cancel to cancel the import.

**Importing Tag Definition Files Using an External Application**

If you are using an external application you can import tag definition files using the command line.

▶ **To convert a csv file to a tag definition file:**

Type the following in the command line:

```
.csv2gls [fromfile] [tofile]
```
**Defining Tag Properties**

You can define properties for the tag buffer size and the flush rate.

- **To define tag properties:**

In the All Containers section of the Application Studio, right click Tags and select Properties from the popup menu. The Tag Properties dialog is displayed:

The following options are available:

- **Buffer size**: Determines the WizPro logger buffer size for history files, in lines (records). The maximum is 2048 records. Increase the value of this option if you anticipate that a large number of changes will occur at any time during the working session.

- **Flush rate**: Determines a value that will represent the WizPro logger flush to disk rate in seconds (for history files). The maximum is 3600 seconds.

*Note: Restart the application for changes to take place.*
Chapter 10 Tag Filter Module

About this chapter:

This chapter describes the Tag Filter module.

Tag Filter Module Overview on page 10-2 on the following page, discusses the basic Tag Filter options.

Accessing the Tag Filter on page 10-3 discusses how to access this module.

Tag Filter Properties on page 10-4 discusses the Tag Filter General and Network tabs.

Tag Filter in the Image Module on page 10-7 takes you through the necessary steps required to open this list in the Image.

Running the Tag Lock on the Web on page 10-11 takes you through the necessary steps required to run the Tag Lock using the Html module.
Tag Filter Module Overview

The Tag Filter module is used to filter, view and manage a list of tags and their status (locked/unlocked) in the application. This is useful for the development and maintenance of an application.

The Tag Filters List is stored in the application's TFM.XML filter that is created in the \docs directory (or another appropriate directory of the application).

When accessed through Java applets the Tag Filters List can be defined/modified/viewed in the Image module during runtime. Up to 10 tag filters can be selected simultaneously.

In this version upto 1000 tags can be defined.

Tags can be sorted according to:

- **Source**
  - PLC - tags associated with external devices and mapped on the external device variables.
  - Dummy - tags representing internal variables used for a variety of calculations, control and other application related needs.
  - Compound - tags which are linear calculations based on values of other tags.
  - System - tags that are predefined and built to provide system status information

- **Type**
  - Analog - tags that have numeric values represented in various formats.
  - Digital - discrete logic tags that have a boolean value of True (1) or False (0).
  - String - tags that are defined to receive alphanumeric strings.
  - Locked - which filters only locked tags. A locked tag can be either analog, digital or string.

*Note: There is the option to select all sources and all types or only one or more source or type.
Accessing the Tag Filter

To access the Tag Filter:

In the Application Studio Control Panel click the Tag Filters icon to open the Tag Filters dialog box.

Or,

Select Design in the menu bar and then Tag Filters to open the Tag Filters dialog box.

The Tag Filters dialog box has the following columns and fields:

- **Name**: This column holds the logical name of the Tag Filter as defined in the Tag Filter Properties dialog box.
- **Description**: This column holds a description of the type of tag the filter should display as defined in the Tag Filter Properties dialog box.
Note: The Add, Modify and Delete options can also be accessed by right clicking in the Tag Filters dialog box.

Tag Filter Properties

This dialog box has two tabs:
- **General page 5** - where the general criteria of the Tag Filter are defined.
- **Network page 6** - where a list of all the available application stations on the network are held and can be selected and defined for the Tag Filter.

*Note: For a tag to appear in the Tag Filters list it must comply with all the requirements in the Tag Filter Properties dialog box fields.*
Tag Filter Properties - General Tab

This tab when filled defines the general properties of the Tag Filter.

1. In the Name field type in the logical name of the user.
2. In the Description field type in the type of tag that the Tag Filter should display.
3. In the Tag Name field type in the name of the tag as defined in the Tag Definition dialog box.
4. The Tag Address field refers to PLC tags that are filtered according to their address. (This is defined during tag definition in the Tag Definition dialog box see Chapter 9, Tags page 4).
5. The Driver No. From and To fields refer to the driver's serial number which is defined in the communication source type.
6. In the Source field check the relevant source. In this field any number of source types can be selected. See Source on page 10-2.
7. In the Type field check the relevant tag type. In this field any number of tag types can be selected. See Type on page 10-2.

8. Click OK to confirm and save your definitions.

Note:
A* can be written in the Tag Name and Tag Address fields to display tags beginning with A. Other letters of the alphabet can be used in the same way.
A? can be written in the Tag Name Address to display tags whose name begins with an A and one other character for example AB, A1. Other letters of the alphabet can be used in the same way.
A?B can be written to display all tags whose name is made up of three characters beginning with A and ending with B with any character in the middle. Other letters of the alphabet can be used in the same way.

**Tag Filter Properties - Network Tab**

This tab lists all the available application stations on the network.
The Network tab has two columns:

- **List all Stations**: This column lists all the application's network stations.
- **Selected Stations**: This column lists all the selected network stations.

1. To add a Network station to the Selected Stations list, in the List of all Stations select a station and then click the **»** button.
2. To remove a network station from the Selected Stations list, in the Selected Station list select the relevant station and then click the **<<** button.

---

### Tag Filter in the Image Module

The Tag Filters List can be defined/modified/viewed in the Image module during runtime.

- **To access the Tag Filter module from an Image object, do the following**:

  In the All Containers side of the Application Studio click Images (Chapter 18, Introduction to the Image Module) and then select an image from the List of Images on the right side of the Application Studio. An image will open on your computer screen.

  Or,

  In the Quick Access bar click the Load Image icon and select the relevant image from the list in the Open dialog box.

1. When the Image module is open and when in Edit mode draw an object using one of the drawing tools.
2. Select the object and then right click and select Trigger Definition. The Trigger Object Definition dialog box will open.
3. Click the Fast Actions button to open the List of Available Fast Actions dialog box.

4. Scroll down the list and double click on LockTagValues. The Tag Lock Option dialog box opens. There are two options:

   - **From the Current Image** - which when clicked opens the Tag Lock Trigger opens displaying a list of tags and their states from the current image.
- **From the Filter List** - when this option is defined and the Select Filters button clicked the Select Tag Filters dialog box opens.

**Tag Value Lock**

The Tag Value Lock window enables you to modify the application's tag lock definitions in the Image module at runtime. When this trigger next opens it will be in the mode defined during Trigger creation.

- **To access the Tag Value Lock in an Image object, do the following:**

In the All Containers side of the Application Studio click Images and then select an image from the List of Images on the right side of the Application Studio. An image will open on your computer screen.

Or,

In the Quick Access bar click the Load Image icon and select the relevant image from the list in the Open dialog box.

In the Image module during runtime (trigger mode) using the trigger hand click on the object to open the Tag Value Lock dialog box where a list of all locked/unlocked tags are listed.

![Tag Value Lock window](image-url)
The Tag Value Lock trigger has the following options:

**Lock/Unlock**
Where filtered tags can be locked/unlocked without exiting the dialog box. Each unlocked tag receives a continuous current value update.

**Print**
Which prints to reports printer defined in the application.

**From Image/From Filters**
This toggle button moves between the From Image and From Filter List modes.

**Select Filters**
Which when clicked opens the Select Tag Filters dialog box where new Tag Filters can be defined, modified and added to the Selected Filters List.

---

**Modifying Tag Lock Values**

The lock tag definition dialog box enables the filter tags to be both locked/unlocked. This dialog box also enables tag value modification READ/WRITE.

▶ To access the Lock Tag Definition in an Image object, do the following:

1. Double click a tag in the Tag Values Lock list to open the Lock Tag Definitions dialog box.

   ![Lock Tag Definitions dialog box]

2. The Value Definition fields are defined in the Tag Definition dialog box during tag creation.
3. To lock a tag check the Lock checkbox.

4. In the Tag Value in the Locked State field type in the new value of the tag when in locked state. This value will apply only when the tag is locked.

5. If the tag is to always remain locked check the Never Expire checkbox to enable this option. When this option is selected the Tag Value will be Locked Until fields are unavailable.

6. If the tag is to be locked for a specific period in the Tag Value will be Locked Until fields scroll and define the To and From times.

7. To enable this tag for READ or WRITE click the relevant button.

8. To add a new value to a tag, do the following. In the Value Modification Value field, type in the new tag value. To write this value to the tag, click the WRITE button. The current value field will be updated to the new number.

9. To read a current value from a tag, click the READ button. The current tag value will appear in the Current Value field.

Note: For more details see Chapter 9, Tags and Chapter 18, Introduction to the Image Module, Chapter 19, Image Editor and Chapter 20, Image Animation..

**Running the Tag Lock on the Web**

To run the defined trigger Tag Lock on the web follow the instructions on page 9 to access the tag lock from an Image object.

▶ **To access the Lock Tag Definition dialog box in an Image object over the Web, do the following:**

1. In the All Containers side of the Application Studio click Html to open the List of Html Files.

2. Double click the relevant image to open the Tag Locks dialog box over the web.
This dialog box has the following buttons:

**Lock Settings**
The Lock Setting button is activated by double clicking the relevant tag. When clicked this button opens the Lock Tag Definitions dialog box.

**Lock/Unlock**
The Lock button is activated by clicking the relevant tag. When clicked this button will lock the selected tag.

**Lock All**
This button locks all the tags in the Lock Tags window.

**Unlock All**
This button unlocks all the tags in the Lock Tags window.

**From Image/From Filters**
This toggle button moves between the From Image and From Filter List modes.

**Select Filters**
When clicked opens the Select Tag Filters dialog box where new Tag Filters can be defined, modified and added to the Selected Filters List.

*Note:* + indicates that the tag is locked. - indicates that the tag is unlocked.

The Tag Filters List can be modified/viewed on the Web during runtime. However, any Tag Filter changes will not be saved to the application.
Chapter 11 Tag Mapper

About this chapter:

This chapter describes the Tag Mapper module.

Tag Mapper - Overview on page 11-2 discusses the basic options of this module.

Accessing the Tag Mapper on page 11-3 discusses how to access this module and describes the dialog box options.

Creating a Tag Mapper Table on page 11-5 instructs you on how to create a Tag Mapper Table.

Customizing Tag Mapper Dialog Boxes on page 11-16 instructs you how to customize this features dialog boxes.

Tag Mapper Tags in the Image Module on page 11-16 instructs you how to use this module in the Image.
Tag Mapper - Overview

The Tag Mapper is a data file of tags and tag values that can be used to considerably reduce workload during application creation. Tag values of tags held in a Tag Mapper table are mapped by the Tag Mapper into a list of other tags. See Creating a Tag Mapper Table on page 11-5.

There are two types of Tag Mapper tags:

Source: These are tags whose values are directed to target tags. More than one source tag can be pointed to the same target tag.

Target: This tag type receives the values of the source tag. All target tags must have the WIZTGM_ prefix.

To define the source tags that update a specific target tag first create the tables used by the Tag Mapper. Each table has a unique Id (Index) that is later used in the image as the index value. Each image can use one table only at a specific time. The table that is used is defined by the index value. A single image can be used to display different source tags values in the same target tags (depending on the index value entered by the user). An unlimited number of tags can be mapped. The Tag Mapper is bidirectional. All Tag Mapper dialog boxes are resizeable.

Dialog boxes can be accessed by either clicking the relevant button, from the menu bar options, or by right clicking and selecting an option.

Tag Mapper Tables can be imported and exported to/from other applications.

Note: Only one WIZTGM_INDEX tag can be used in an image.
**Accessing the Tag Mapper**

To access the Tag Mapper do the following:

Double click the Tag Mapper icon in the Application Studio Control Panel to open the Tag Mapper dialog box.

This dialog box has the following Menu bar options:

- **Field**
  - **Export**: This option is used to export either:
    - All tables
    - Selected tables
to the open or other applications. This option can also be accessed by right clicking in the dialog box and selecting Export from the dropdown list.

- **Import**: This option is used to import Tag Mapper Tables from the open or other applications. This option can also be accessed by right clicking in the dialog box and selecting Import from the dropdown list.

- **Exit**: This option is used to exit the Tag Mapper.
**Table**

**New Table**: This option is used to open the Set Tag Mapper Table dialog box. This option can also be accessed by right clicking in the dialog box and selecting New Table from the dropdown list.

**Edit**: This option is used to edit a selected Tag Mapper Table. This option can also be accessed by right clicking in the dialog box and selecting Edit from the dropdown list.

**Tags Summary**: This option opens the Tag Mapper Tables Tag Summary dialog box. This dialog box can also be opened by clicking the Tag Summary button.

**Delete**: This option is used to delete a selected Tag Mapper Table. A Tag Mapper Table can also be deleted using the Delete button.

**Clients**: This option opens the Online Clients dialog box where remote users are listed. This dialog box can also be opened by clicking the Online Clients button.

**Help**: This option is used to open the Help project for this module.

This dialog box has the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td>This is the Id of the Tag Mapper table where the tags are held. This number is generated by the system and cannot be modified.</td>
</tr>
<tr>
<td><strong>Table Name</strong></td>
<td>This is the name of the Tag Mapper table.</td>
</tr>
<tr>
<td><strong>Table Description</strong></td>
<td>This is a short description of the Tag Mapper table.</td>
</tr>
<tr>
<td><strong>New Table</strong></td>
<td>This button when clicked opens the Set Tag Mapper Table where a new table can be created. A record of the new table will appear under the last entry in the Tag Mapper.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Select a table record line and then click on this button to open the Set Tag Mapper Table where modifications can be made. This dialog box can also be accessed through the menu bar’s Table Edit option, or by right clicking and selecting Edit.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Select a table record line and then click on this button to remove the table from the Tag Mapper. A Tag Mapper Table can also be deleted through the menu bar’s Table Delete option, or by right clicking and selecting Delete.</td>
</tr>
<tr>
<td><strong>Tags Summary</strong></td>
<td>This button when clicked opens the Tag Mapper Table Tags Summary dialog box. This dialog box can also be opened by selecting Tag Summary from the menu bar’s Table options.</td>
</tr>
<tr>
<td><strong>Online Clients</strong></td>
<td>This button when clicked opens the Online Clients viewer where a list of all the clients that are clients of the Tag Mapper can be seen. This dialog box can also be opened by selecting Online Clients in the menu bar’s Client options.</td>
</tr>
</tbody>
</table>

### Creating a Tag Mapper Table

- **To create a new table do the following:**

  1. In the Tag Mapper dialog box click the New Table button
     
     Or,
     
     Right click and select New Table
     
     Or,
     
     From the menu bar Table option select New Table to open the Set Tag Mapper Table dialog box.
This dialog box has the following fields:

**Table Name**
This is the name of the Tag Mapper table.

**Table Description**
This is a short description of the Tag Mapper table.

**Table Id**
This serial number is automatically generated by the system and cannot be modified.

**Bidirectional Update**
When checked enables automatic bidirectional source and target tag update.

**Id**
This is the number of the table where the tags are held.

**Source Tag**
These are tags whose values are directed to target tags. More than one source tag can be pointed to the same target tag.

**Factor**
This is the number by which the target tag is multiplied. The default is 1.

**Target Tag**
This tag type receives the values of the source tag. More than one source tag can be pointed to the same target tag.

**New Record**
Click this button to open the Tag Mapper Table Record dialog box where a new record line can be created.
2. Type in the Table Name and Table Description.
3. Check the Bidirectional Update checkbox to enable this option.
4. Click the relevant button and complete the dialog box fields.
5. Click OK to confirm.

► To create a table record do the following:
1. In the Set Tag Mapper dialog box click the New Record button
   Or,
   Right click and select New Record to open the Tag Mapper Record Table dialog box.
This dialog box is used to define/select source and target tags and to define the factor by which the target tag is multiplied. It has the following fields:

**Local Station**  
This field is automatically filled by the application when applicable.

**Source Tag**  
Which has the following sub fields:
- **Station** where the station is selected
- **Tag** where the specific source tag is selected

**Target Tag**  
Which has the following sub fields:
- **Station** where the station is selected
- **Tag** where the specific target tag is selected

**Factor**  
This is the number by which the target tag is multiplied. The default is 1.

2. Complete the dialog box fields and then click OK to confirm and to return to the Set Tag Mapper Table dialog box.
To Modify a Tag Mapper Table

In the Tag Mapper dialog box select the relevant table entry and then click the Edit button

Or

Right click and select Edit

Or

From the menu bar Table option select Edit to open the Set Tag Mapper Table.

To Delete a Tag Mapper Table

In the Tag Mapper dialog box select the relevant table entry and then click the Delete button

Or,

Right click and select Delete

Or,

From the menu bar Table option select Delete.

To define multi records

1. In the Set Tag Mapper Table dialog box click the Multi Records button.

This dialog box is used to define/select multiple source and target tags. Each new record added will have a factor of the value created in the table.
In this dialog box the user can select an unlimited number of source tags which are automatically inserted by the application.

This dialog box has the following fields:

- **Source Tags**: This list is automatically inserted by the application. An unlimited number of source tags can be selected.
- **Create Target Tag using XX as prefix**: Check this option and then type in the target tag prefix to which an index will be added starting at the value defined in the Start at Index field.
- **Start at Index**: This is the first consecutive Index number.
- **Create Records as Factor**: When this button is filled the Multi Records table is filled with the source tags definitions.
- **ID**: This is the Id of the selected source tag.
- **Source Tag**: This is a list of the source tags selected from the main source tags list.
- **Factor**: This is the factor by which the target tag is multiplied.
- **Target Tag**: This tag type receives the values of the source tag. More than one source tag can be pointed to the same target tag.

2. In the main Source Tags fields select the relevant tags.
3. Check the Create Target Tags Using checkbox and type in the target tag prefix.
4. In the Starting at Index and As Factor fields type in the relevant numbers.
5. Click the Create Records button. The Multi Records table is filled.
6. Click OK to confirm and to return to the Set Tag Mapper Table dialog box.
To import Tag Mapper Table files from external applications

1. In the Set Tag Mapper Table dialog box click the Import button to open the Import Table dialog box.

![Import Table dialog box]

This dialog box has the following fields:

- **Import from Existing Tables**
  - **ID**: This is the ID of the imported table
  - **Table Name**: This is the name of the table required

- **Import from File**
  - **ID**: This is the ID of the imported file
  - **Table Name**: This is the name of the imported table

- **Import Buttons**
  - When these buttons are clicked the respective table/file is imported.

- **ID**
  - ID of the imported table/file record.

- **Source Tag**
  - This is a list of the source tags
To view the Tag Mapper Tables Tags Summary dialog box

1. In the Tag Mapper Table dialog box click the Tags Summary button or from the menu bar Table option select Tags Summary.

This dialog box displays a list of all the tags that are used by the Tag Mapper. It has the following fields:

- **Filter table**: The displayed information in this dialog box can be filtered according to a specific table or to display all the tables in the Tag Mapper.
- **Tag Name**: This is the name of the tag defined in the Tag Mapper table.
- **Tag type**: This is the type of tag which can be either source or target.
To view the Online Clients list:

In the Tag Mapper dialog box click the Online Clients button

Or,

From the menu bar Clients option select Online Clients.

The Online Clients viewer will open listing all the stations that are clients of the Tag Mapper.

To export all Tag Mapper Tables:

1. In the Tag Mapper dialog box either right click and select Export All

Or,

From the menu bar File options select Export All. The Save As dialog box opens.
2. Select the relevant file and click the Save button.

► **To export selected Tag Mapper Tables:**

1. In the Tag Mapper dialog box select the relevant Tag Mapper Table from the list and then either right click and select Export Selected

   Or,

   From the menu bar File options select Export Selected. The Save As dialog box opens.

2. Select the relevant file and click the Save button.

► **To import Tag Mapper Tables:**

1. In the Tag Mapper dialog box either right click and select Import

   Or,

   From the menu bar File options select Import. The Open dialog box opens.
2. Select the relevant file and click the Open button. The Import Tag Tables From dialog box opens.

![Open dialog box]

This dialog box has the following options:

- Replace all tables
- Replace only existing tables
- Add no existing tables

3. Check the relevant option and click OK to confirm.
Customizing Tag Mapper Dialog Boxes

Both the column width and the order that information is displayed in a column can be modified.

- **Modifying column width:**

1. To modify the column width, place your cursor over the column line. A cross will be displayed.
2. Move the column line to its new position.

- **Modifying table entry hierarchy:**

1. Click the column title bar to display the .
2. Click a table line and the click the arrow to move up.

Tag Mapper Tags in the Image Module

Each image that is used with the Tag Mapper must have the WIZTGM_INDEX tag that is automatically created by the program.

Only values that are greater than 1 can be used when they have a table that matches this index value.

Other tags that can be used are tags with the WIZTGM_ prefix as defined in the Tag Mapper Tables. These tags will display the relevant source tags values.

Changing the WIZTGM_INDEX tag value in an image will cause the image to display the relevant source tags as defined in the Tag Mapper.

All tags holding the WIZTGM_ prefix including the WIZTGM_INDEX tag have different values in different images. This means that even if the tag name is the same the values in each image will differ. The tags will appear in the application's tags list, however, they cannot be used as regular application tags. For example when a tag value is changed in the Single Tag dialog box, the change will not affect an image that has this tag attached. These tags values can only be changed from within the image.

When an image is opened for the first time, the value assigned to the WIZTGM_INDEX for this image is taken from the application. The value 0 is invalid and cannot be used.
Note: Only one WIZTGM_INDEX tag can be used in an image.
For further information see Chapter 18, Introduction to the Image Module, Chapter 19, Image Editor, Chapter 20, Image Animation and Chapter 9, Tags.
Chapter 12 Multiple Tags

About this chapter:

This chapter describes how Multiple Tags are used in the system, as follows:

Overview on page 12-2 is an overview of Multiple Tags.
Accessing Multiple Tags on page 12-2 discusses how to access this module.
Defining a Tag List File and Defining a Tag Filter on page 12-2, describes how to access multiple tags.
Overview

The Multiple Tags module can be used to optimize performance and enhance functionality. This module enables you to adjust system parameters and establish the correct environment for working with the application.

Multiple Tags displays tag lists and enables you to read and write tag values, as well as change several tag attributes. In addition, Multiple Tags provides options to save the tag list as a recipe or a tag list file.

Tag list files are ASCII files that contain lists of tags and their attributes. These files have the extension .GLS and can be used in the application to generate tag lists in the tag definition procedure.

Read Chapter 9, Tags for more information regarding Tags.

Accessing Multiple Tags

The Multiple Tags module is accessed from the Application Studio in two steps:

- Specifying a tag list file to be loaded and defining a tag filter so that only specific tags are loaded from the file.
- Displaying the Tag List in the Tags Exerciser Program Window.

Defining a Tag List File and Defining a Tag Filter

In the Tag Filter dialog box you can:

- Define a tag filter: Only tags that meet the filter requirements specified appear in the generated list.
- Specify a tag list file: Select between a standard application tag file and a .GLS file.
To specify a tag list file and/or define a tag filter:

In the Control Panel of the Application Studio, double-click the Multi Tags icon. Or,

From the Tools menu, select Multiple Tags. The Tag Filter dialog box is displayed on top of the Tags Exerciser Program window.

The following options are available:

Tag Filter

Specifies filter parameters so that only the tags that meet the filter requirements appear in the generated tag list. The following tag options are available:

- Name
- Driver No.
- Address
- Source (PLC, Dummy, Compound, System)
- Type (Analog, Tag Value, String).

Source File

Specifies a tag list file. The following options are available:

- File (.GLS): A GLS file. Enter the file in the field (without specifying the extension). Click in the field to display a list of existing .GLS files from which you can select a file.
Click OK to save your options. The Tag Filter dialog box closes and the Tags Exerciser Program window is displayed with a list of the tags that meet the filter requirements specified.

**Tags Exerciser Program Window**

The Tags Exerciser Program window displays a list of the tags that meet the filter requirements specified in the Tag Filter dialog box. The following is an example of a tag list in the Tags Exerciser Program window:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZW200_INDEX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_DELAY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_Relay</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_STEP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_PYLONENTRY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_PYLONTIME</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_WRITE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_WRITEOPENFILE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_ALARMDIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_COLLAPSE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_COMPRESS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_COMPRESSFILE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_COLLAPSEFILE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_COLLAPSE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZW200_COLLAPSEFILE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The data in the window is displayed under the following columns.

- **Name**: Tag name
- **Driver**: Driver number associated with the tag
- **Address**: The address of the tag in the PLC
- **Value**: The last read value of the tag
- **Rate**: Tag sampling rate in seconds (specified during tag definition)
The dialog box contains a menu bar with the following menus and options:

**File**
- **New**: Clear the tag list from the Tags Exerciser Program window.
- **Open**: Open the Tag Filter dialog box to define a tag filter and specify a tag list file.
- **Save as Recipe**: Save the list as a recipe.
- **Save as GLS**: Save the list as a tag list file.

**Options**
- **Sample Selected**: Sample the currently selected tag in the list.
- **Sample All**: Change the Never sample attribute of all the tags in the list to Request. Tags are then sampled only when clients are registered for them.
- **Sample Disable**: Select this item to change the sample attribute of all the tags to Never. This will disable the sampling of all the tags.
- **Find Tag**: Search for a tag.
- **Zoom Tag**: Modify the tag options.
Note: If a communication error occurs, a line of asterisks appears for any tag represented in the tag list that is associated with the VPI to which the error occurred. The line of asterisks is on-going and appears until the error is corrected. When the error is corrected, the tag value appears in the tag list.

Find Tag

After a list is generated, you can search for a specific tag.

To find a specific tag:

From the Options menu in the Tags Exerciser Program window select Find Tag. The Find Tag By Name dialog box is displayed:

Specify the name of the tag you want to search for and click the Find button. The tag will appear highlighted in the list of tags.

Note: The name you specified is used as a prefix in the name matching process. The search is modeless, meaning that you will not have to close the dialog box to perform any other operation in the window.
Zoom Tag

The Zoom Tag option is used to modify the attributes of a tag in the Tags list. The attributes that can be modified and operations that can be performed include:

- Reading the tag value.
- Writing a value to the tag.
- Changing the sample attribute.

To modify the attributes of a tag:

Double-click the tag in the list.

Or,

Click a tag in the list to select it, and select Zoom Tag from the Options menu. The Tags Exerciser Program Window is displayed:

The following options are available:

- **Tag Name**: The name of the tag.
- **Driver**: The Driver address to which the tag belongs.
- **Address**: Specifies the current tag address. Enter the new address and activate the Change button to confirm the change.
Value Displays the specified tag value. Click the Read button to display the current value. Enter the new value and activate the Write button.

Sample The following options are available:

- **Always**: The tag will be sampled always.
- **In Monitor**: The tag will be sampled only when its value is requested by an application module (displayed in an image window).
  
  This mode minimizes communications traffic and improves system performance.
- **Never**: Tag sampling is disabled.

*Note: This dialog box is modeless, meaning that you can switch to a different tag without closing it by simply double-clicking on the required tag in the list.*

### Saving the Tag List

The tag list can be saved in one of two file types:

- Recipe file.
- Tag list (.GLS) file

**To save the current tag list in a recipe file:**

1. From the File menu, select Save as Recipe. The Recipe File Name dialog box is displayed:

   ![Recipe File Name](image)

2. Enter a recipe model to which you want the recipe to belong in the Recipe Model field. Click inside the field to display a list of existing recipe models.
3. Specify the name of the recipe file in the Recipe Name field.
4. Click OK to save your definitions and close the dialog box.
Note: For more details about recipe models and recipes, refer to Chapter 29, Recipes.

To save the current tag list in a tag list file:

1. From the File menu, select the Save as GLS option. The New Tag List File dialog box is displayed:

   ![New Tag List File dialog box](image)

2. Enter the name of the file in which the list is to be saved without the GLS extension.
3. Click OK to save your definition and to close the dialog box.
About this chapter:

This chapter describes how to define and use alarms in the system, as follows:

Overview on page 13-2 is an overview of application alarms.
Basic Principles on page 13-2 describes the basic principles of alarm definition.
Defining Alarms on page 13-3 describes how to define alarms, how to define a single action for an alarm and how to assign a name to alarm classes.
Alarm Filters on page 13-3 describes how to define filters and apply tag counters to alarms.
Alarm Help Files on page 13-15 describes how to create alarm help files.
Alarm Properties on page 13-27 describes how to define a login and logout message, the time format that appears in the Events Summary and the alarm printout, and how to overwrite default print sequences.
Exporting Alarms on page 13-21 describes how to generate a list of alarms in ASCII format, and describes the ALS file format.
Importing Alarms on page 13-25 describes how to import alarm definitions from an ASCII file.
Finding Alarms on page 13-35 describes how to locate an alarm in the List of Alarms in the Application Studio.
Overview

Alarms are configured application messages used to notify operators of exceptional conditions at the workplace. The application generates automatic system messages that provide operators with information about internal system events, such as communication driver failure, network communication errors and others.

Application alarms can be targeted to and be displayed in the Event Summaries, appear in a popup window, or be printed out.

Alarms can be defined in order of hierarchy. New alarms can be added (or existing alarms modified) to different levels of the hierarchy tree. Alarms can be defined according to attributes, inhibited, delayed, have Help messages containing instructions on how to handle the cause of the alarm and have comments attached to them. They can also be recorded to history for report purposes.

Note: For quick reference, the number of alarms within the application is listed in the Application Studio Status Bar.

Basic Principles

Only users with the appropriate authorization can define alarm conditions. Application alarms are generated whenever predefined conditions exist.

Up to 65,535 alarms can be defined in the application. Each alarm can be assigned different characteristics and properties during the alarm definition procedure. Alarms can be sent to different targets and be checked by different attributes.

Alarms in Events Summaries

Alarms are written to the Event Summaries. If previously defined the operator can see a graphical display of the cause of the alarm, check Help for instructions in handling the alarm, acknowledge and end the alarm, add comments or inhibit (on the Internet) the alarm. The Start, End and Acknowledgement time and date of the alarm can also be listed in the Summary Events.
Alarm Objects in Images

The application enables you to visualize alarm conditions graphically by associating image objects with alarms. Alarm objects in images react to the conditions of the alarms in the alarm family with which they are associated. For example, if the alarm condition is true in the alarm family, the object may begin to blink or change colors.

Alarm Filters

The application enables you to define filters and apply tag counters to alarms. The tag counters collect the specified alarm information that can be used in Images. The alarm filter is automatically activated when the application is loaded.

Defining Alarms

Alarms are defined in the Application Studio. After defining an alarm, you can assign a name to alarm classes, as described below.

To define an alarm:

Click the Alarms icon in the Application Studio toolbar
Or,

In the All Containers pane of the Application Studio, right click Alarms and then select Add Alarm from the popup menu. The Alarm Definition dialog box opens.

This dialog box has two tabs:

- **General Tab** - where general alarm properties such as Alarm Condition, Alarm Text, Zone, Family, Target, Attributes and Delay are defined.

- **Action on Alarm** - where actions such as, Go to Zone, Execute Macro on Alarm and AAM Configuration are defined.
**General Tab**

This tab is used to define general alarm properties.

![Alarm Definition dialog box](image)

---

**Alarm Condition**

This field defines the alarm conditions.

**Alarm Text**

This field when completed shows a description of the alarm. An alarm message can include tokens and contain up to 255 characters.

**Family**

Specifies the name of the group to which the alarm belongs. The name can consist of up to 64 characters and is the link to alarm objects. It is also used for classification and filtering.
Help File  Specifies the name of the Help file that contains information for the operator. For more details about creating alarm help files, refer to the section on Alarm Help Files on page 13-15.

Zone  You can enter a zone area from 0 to 50,000. This value is used to classify and filter alarms in the Events Summary and application popup windows.

Severity  Specifies the priority order of each alarm. For example, a low priority could be 0 and a high priority, 50,000. It is also used for classification and filtering.

User Fields  These are customized fields that are defined by the user according to their specific requirements. User fields enable additional alarm filtering. There are five User Fields. See Assigning User Field Names on page 13-14.

Groups  This option is used to assign authorized users and groups of users to the alarm. Alarm recipients can handle the alarm according to user authorization.

Inhibition by Tag  Inhibit if a specific tag receives a specific value.

Inhibit Immediate  This checkbox when checked means inhibit this alarm immediately.

Targets  Specifies the alarm destination. The following options are available:

**Default Printer:** The alarm message is sent to the printer defined as the alarms printer.

**Events Summary:** The alarm is displayed in the Events Summary.

**Popup:** The alarm is displayed in a Popup window.

**Popup buzz:** The alarm is displayed in a Popup Events Summary that will buzz when the alarm is displayed. If you do not select this option, the Popup Events Summary will not buzz when the alarm is displayed even if it was defined to do so in the PopUp Buzz dialog box.
**Targets**

**User Class:** Enables you to identify an alarm and to classify it online and in historical Events Summaries. Select this option and click on the arrow on the right of the field to select an alarm user class from a drop-down list of predefined classes. Each alarm can be assigned only one class.

**Attributes**

The alarm operational attributes include the following:

**System Wide:** Alarms can be limited to a single station or distributed among several application stations using application network support facilities.

If this option is selected, the alarm will be distributed to other stations in the network. It can be acknowledged from any station across the network. By default, alarms appear only on the station used by the operator.

**Auto Acknowledge:** The system automatically acknowledges alarms (as they occur) as if already acknowledged by the operator.

**Auto END:** The system automatically ends alarms (after they occur) as if the condition that caused the alarm to be generated has already terminated.

**Class at Acknowledge:** Enables you to re-assign a User Class property to the alarm when the alarm is acknowledged. This means that you can change the routing of an alarm upon its acknowledgment.

**Record to File:** Records the alarm in the alarm's history file.

**Discard:** Discards active alarms when the application is terminated.

**Exclude from Printing:** If this option is selected the alarm will not be printed.
**Auto Print AHP File:** Help files with the AHP suffix can also be printed. A help file in HTML format is printed manually according to user demand. An alarm line and its AHP file are printed as a set where the AHP file appears directly under the alarm. When working in a network configuration and an alarm with an AHP file attached is sent to another station this alarm will be printed in the far station only when the AHP file is located in the far station.

*Note: If an alarm is defined with both the Auto Acknowledged and Auto End options, it will be considered inactive and will not be displayed in the Event Summaries.*

**Delay**

Delay intervals can be defined during which time alarms will not be generated. There are three options defining when the alarm will be reset:

- **Condition is false:** Alarms will not be generated when the alarm condition is false (within the time delay).
- **Delay time ends:** If the alarm condition is True, at the end of the defined time delay alarms will be generated. This is without taking into consideration changes in alarm status during the delay period.
- **Never:** The delay feature will not be imposed.

*Note: The default is Never.*
**Alarm Conditions**

Expressions are displayed in the Alarm Condition field in different colors and according to their expression type.

- Red for errors
- Black for operations
- Blue for correct tag names
- Olive green for functions

Alarm Condition options consist of a list of tags, operators and functions from which you can build an expression.

- **Tags** - when selected a field box with an arrow is added to the Alarm Condition field.

![Alarm Definition](image)

The Alarm Condition field is divided into two when the Tag (right click on the field) option is selected from the popup menu. The upper field enables selection of the Station Name whereas the lower field enables selection of a tag from this station's tag list.

Clicking the arrow to the right of the field displays a dropdown list of available tags from which you can select the required tag. Only one tag can be added at a time to the Alarm Condition field. Clicking anywhere in the Alarm Condition field removes the tag field box and enters the tag into the expression. Tags can be written manually by first entering a @ and then the required tag name.

- **Numeric Operator** - when selected displays the following options:
  
  + Plus
  - Minus
  = Equal
  / Backslash
  % percentage
- **Relational Operators** - when selected displays the following options:
  - `==` Equal
  - `!=` Not Equal
  - `<=` Less than Equal
  - `>=` More than Equal
  - `<` Less than
  - `>` Greater than

- Logical Operator when selected displays the following options
  - **AND** Combines two conditions logically
  - **OR** Combines two conditions logically
  - **NOT** Negates the condition that follows it

- **Function** - when selected displays the following options:

<table>
<thead>
<tr>
<th>Function</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log</td>
<td>LOG(expression) where expression &gt; 0</td>
<td>Calculates base 10 logarithm.</td>
</tr>
<tr>
<td>Ln</td>
<td>LN(expression) where expression &gt; 0</td>
<td>Calculates natural logarithm.</td>
</tr>
<tr>
<td>Root</td>
<td>ROOT(expression) where expression &gt;= 0</td>
<td>Calculates square root.</td>
</tr>
<tr>
<td>Min</td>
<td>MIN(x,y) where both x and y are expressions.</td>
<td>Returns the minimum out of the two parameters.</td>
</tr>
<tr>
<td>Max</td>
<td>MAX(x,y) where both x and y are expressions.</td>
<td>Returns the maximum out of the two parameters.</td>
</tr>
<tr>
<td>Power</td>
<td>POWER(x, y) where both x and y are expressions.</td>
<td>Returns the value of xy.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Notes</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>Sign</td>
<td><code>SIGN(expression)</code>&lt;br&gt;Calculates the sign.</td>
<td>Returns -1 if expression &lt; 0 and 1 if expression ≥ 0.</td>
</tr>
<tr>
<td>Floor</td>
<td><code>FLOOR(expression)</code>&lt;br&gt;Calculates the floor.</td>
<td>Returns a floating-point value representing the largest integer that is less than or equal to expression.</td>
</tr>
<tr>
<td>Bit</td>
<td><code>BIT(B, @tagname)</code>&lt;br&gt;B is bit number and @tagname is a tag value</td>
<td>Alarm is on when BIT is true value = &quot;1&quot;</td>
</tr>
<tr>
<td>Abs</td>
<td><code>Abs (expression)</code>&lt;br&gt;Calculates absolute value.</td>
<td>Returns the absolute value of expression.</td>
</tr>
<tr>
<td>Sin</td>
<td><code>SIN(expression)</code>&lt;br&gt;expression angle is in radians.</td>
<td>Calculates sine.</td>
</tr>
<tr>
<td>Cos</td>
<td><code>COS(expression)</code>&lt;br&gt;expression angle is in radians</td>
<td>Calculates cosine.</td>
</tr>
<tr>
<td>Tan</td>
<td><code>TAN(expression)</code>&lt;br&gt;expression angle is in radians.</td>
<td>Calculates tangent.</td>
</tr>
<tr>
<td>ROC</td>
<td></td>
<td>Processes values that change too quickly. If a process value fluctuates by more than the rate of change limit in the given time interval, the tag generates the alarm. The rate is given in percentage per unit of time.</td>
</tr>
<tr>
<td>Deviation (%)</td>
<td>Processes values that change from the optimum value. Deviation alarms require a definition of a target value and range. If the process value exceeds the range, a deviation alarm occurs. For example, if the optimum value is 100 and the range (deadband) is +/-5 the process can vary from 95 to 105 without generating an alarm. The deadband is given by percentage of the value.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>Deviation F (Fixed)</td>
<td>Process values that change from the optimum value. Deviation alarms require a definition of a target value and range. If the process value exceeds the range, a deviation alarm occurs. For example, if the optimum value is 100 and the range (deadband) is +/-5 the process can vary from 95 to 105 without generating an alarm. The deadband is given by a constant value of the value.</td>
<td></td>
</tr>
</tbody>
</table>
Bit Operator - when selected displays the following options:

- **OR** Combines two conditions logically
- **AND** Combines two conditions logically
- **XOR** Exclusive OR
- **NOT** Negates the condition that follows

**Alarm Text**

The alarm text can include the following tokens:

- **@tagname** Replaces @tagname with the current tag value when the alarm is started.
- **@!tagname** Replaces @!tagname with the value of the tag that is force read from the PLC when the alarm is started.
- **@#tagname** Replaces @#tagname with the value retrieved from the block to which the tag belongs, if the block is fresh. If the tag does not belong to a block, the @# control will function the same as @!

*Note: The above three tagname tokens must be typed in lower case letters. Otherwise the system will not recognize them.*

- **$TIME** The current time in Hours.Minutes.Seconds format. The value range is from 00.00.00 to 23.59.59.
- **$DATE** The current date in Day.Month.Year format. The value range is from 01.01.00 to 31.12.99.
- **$HOUR** The current hour. The value range is from 0 to 23.
- **$MINUTE** The current minute. The value range is from 0 to 59.
- **$SECOND** The current second. The value range is from 0 to 59.
- **$DAY** The current day. The value range is from 1 to 31.
- **$MONTH** The current month. The value range is from 1 to 12.
- **$YEAR** The current year. The value range is from 00 to 99.
Assigning Names to Alarm Classes

This option is used to assign user-defined names to alarm classes. Alarm classes can be used to categorize alarms to identify them more easily, and to filter them in the system Events Summary. See General Tab on page 13-4.

To assign class names:

From the Design menu, select Alarm Parameters and then Class Names. The Alarm User Class Names dialog box is displayed:
The dialog box displays 16 default class names. Double-click on the default name to select it, and enter the new name.

**Assigning User Field Names**

These are customized fields that are defined by the user according to their specific requirements. User fields enable additional alarm filtering. There are five User Fields.

▶ **To define User Fields:**

From the Design menu, select Alarm Parameters and then Field Names to open the Alarm User Fields dialog box.

1. Type in the unique User Name opposite the relevant number.
2. Click OK to confirm.
**Alarm Help Files**

Alarm Help files are user-created ASCII files. Each Help File contains handling instructions for an associated alarm. The operator receiving an alarm can open the alarm's Help File in the Event Summaries by clicking the assist icon or by right clicking on the alarm and selecting Assist.

Help files can also be saved in HTML format and be sent to the operator via the Internet. Help Files can be created using any text editor. However the Help File folder must be saved in the same location as the application.

- System Help Files are saved as XXX.AHP
- HTML Help Files are saved in a folder called DOCS as XXX.HTML

After a Help File for an alarm has been created and saved in the application folder it can be attached to an alarm in the Alarm Definition General Tab.

▶ **To define a Help File:**

1. In the Help File field click the Browse icon. The Open dialog box opens displaying Help Files folders.
2. Select the relevant Help File and click Open to return to the General tab.
3. Click Apply or OK.

**Action on Alarm**

You can define a single action for an alarm when it reaches one of three states: when it starts, when it is acknowledged and when it ends. When the alarm reaches the selected state, it will trigger a macro.

▶ **To define an action on alarm:**

In the Alarm Definition dialog box click the Action on Alarm tab. The Action on Alarm dialog box will open.
The following options are available

**Go to Zone** When selected an image of the zone specific to the alarm opens on the user's screen when the alarm is generated.

**Image** Defines the image file that will be opened when the alarm is generated.

**Zone** Defines the specific zone in the image file that will be displayed when an alarm is generated.
**Execute Macro on Alarm**

**Started:** Enables defining an action when the alarm starts.

**Acknowledged:** Enables you to define an action when the alarm is acknowledged.

**Ended:** Enables you to define an action when the alarm ends.

**Create Macro:** Macros can be attached to all three alarm states. Defined actions will be activated automatically by application at run-time. This feature makes building applications easier. The user does not need to use either Application Language or an add-on to perform an action when an alarm changes its status.

**AAM**

Enables configuration of alarm transmission to users and groups via printer, fax, e-mail, SMS, voice messages and other services. Before configuring advanced alarm transmission verify that the appropriate drivers providing this service in Advanced Alarm Management are defined.

**Select Recipients:** Click Groups to define Advanced Alarm Management recipients.

**File Association:** Add text file for the email message.

**Synthized Alarm Text:** If this checkbox is checked this text file is sent as a voice message. When this checkbox is not checked the For Voice WAV file will be defined. The default is checked.
To define AAM transmission:

In the Alarm Definition dialog box click the Action on Alarm tab.

1. In the Select Recipients field click the Groups button to open the Alarm Recipients dialog box. Select the relevant recipients and click Add and then OK.

2. In the File Association field select a text file that will be attached to your e-mail, or will be sent by fax or to the printer.

3. To send a vocal message, click the browse button and select a sound file (file of type *.wav).

4. Check the Synthesized Text checkbox to send the text file as a voice message. When this checkbox is not checked the For Voice WAV file will be defined.

Note: Before configuring advanced alarm transmission, verify that the appropriate drivers providing this service in AAM are defined.
**Alarm Levels**

Alarms can be defined according to hierarchy. Each alarm can be defined at a different level in the hierarchical tree. Levels can be modified, added or deleted. Level definition contains most of the parameters used by alarm definition so that when one is defined and then modified its sub-levels also receive the same modifications. Alarm hierarchy is defined and viewed in the All Containers tree.

Note: If at the Alarm Level there is an inhibited tag, an alarm will not be issued even if the specific alarm has no tag.
To add a level:

In the All Containers pane right click Alarms. From the dropdown menu select Add Level. The Definition dialog box opens.

1. Type in the Level Name in the Level Name field of up to 253 characters.
2. The other fields appearing in this dialog box are described in detail in General Tab on page 13-4 with exception to the Modify field.
3. The Modify field has the following sub-fields: Include Alarms, Change and Override. Make your selection accordingly.

4. Click OK to confirm.

▶ **To modify a level:**

In the All Containers pane right click Alarms and select Modify Level from the dropdown menu. The Definition dialog box will open on your screen.

Or,

In the All Containers pane double click the Alarms icon. A List of Alarms opens in the Control Panel. Select an alarm and either right click and select Modify Level or double click. The Alarm Definitions dialog box will open on your screen.

Further instructions appear in **To add a level: on page 13-20** and in the **General Tab on page 13-4**.

▶ **To delete a level:**

1. In the All Containers pane right click Alarms and select Delete Level from the dropdown menu. A message box opens on your screen.

2. Click Yes to delete the level. The level will be removed from the list.

---

**Exporting Alarms**

The Export Alarms option enables you to generate a list of alarms in ASCII or CSV format and send the list to the printer or a file. The generated list can also be filtered to include only specific alarms.

Alarm lists can be generated and then edited using a text editor. Once generated, the list can be printed for project documentation. This is useful in large projects, where thousands of alarms must be defined. In this case, working with a text editor is faster than defining each alarm separately.
To generate a list of alarms:

In the All Containers section of the Application Studio, right click Alarms and select Export Alarms from the popup menu. The Alarm List dialog appears:

The dialog box contains filter options that you can select to determine which alarms will appear in the list that you want to generate. Each filter field is optional (except for the filename in the List Target field, which must be specified if you select the File option).

The following options are available:

- **No.** Specifies the range of numbers of the alarms that you want to appear in the generated list.
- **Tag Name** Specifies the name, or name prefix range of the tags associated with the alarms that you want to appear in the generated list.
- **Family** Specifies the name or prefix of the family to which the alarm belongs that you want to appear in the generated list.
- **Severity** The severity range of the alarms that you want to appear in the generated list.
After you complete the dialog box and activate the OK button, an alarm list will be generated according to the filter you specified.

**Zone**

The zone range of the alarms that you want to appear in the generated list.

**Targets**

The target specifications of the alarms that you want to appear in the generated list (any, none, or all can be selected).

**User Class**

Activate this button to select classes to filter the alarms that will appear in the generated list. After you activate this button, the Set User Class dialog box appears. See [To assign class names: on page 13-13](#).

You can select one or more classes, so that only the alarms that belong to the classes will appear in the generated list. Activate the Set All button to select all the classes. Activate the Reset All button to deselect all the classes.

**Attributes**

The attribute specifications of the alarms that you want to appear in the generated list. You may select any attribute, all of the attributes, or none at all.

**List Target**

Specifies the target destination of the list to be generated: Printer or File (.ALS). You can select Printer to send the list to the printer, or File (.ALS) to save the list in a file with the extension .ALS. For File (.ALS), specify the name of the file without the extension. This file will be located in the application's directory in the Set Default Paths dialog box.

**Fixed**

The file is printed in .ALS format.

**CSV**

The file is printed to an Excel file.

After you complete the dialog box and activate the OK button, an alarm list will be generated according to the filter you specified.
.ALS File Format

This section describes the field definitions of an .ALS file. An .ALS file can be opened with any text editor.

The format of the file is as follows:

The first line contains the alarm attribute fields. This line begins with a semicolon.

Each remaining line contains one alarm definition.

The fields in the alarm definition lines are as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>Specifies the alarm original number.</td>
</tr>
<tr>
<td>Tag</td>
<td>Specifies the name of the tag associated with the alarm.</td>
</tr>
<tr>
<td>Cond</td>
<td>Specifies the conditional operator of the alarm condition.</td>
</tr>
<tr>
<td>Value</td>
<td>Any numerical value for the alarm condition.</td>
</tr>
<tr>
<td>Text</td>
<td>The text that will appear when the alarm condition is true. The text appears in brackets &lt; &gt;.</td>
</tr>
<tr>
<td>Prt,Ann,Pop,</td>
<td>These fields represent the target specification of the alarm. The value can be Y for Yes or N for No.</td>
</tr>
<tr>
<td>Sys,AAc,AEn,</td>
<td>These fields represent the alarm attributes. The value can be Y for Yes or N for No.</td>
</tr>
<tr>
<td>Sev</td>
<td>Specifies the alarm severity from 0 (lowest level) to 50,000 (highest level).</td>
</tr>
<tr>
<td>Zone</td>
<td>Specifies the alarm zone number from 0 to 50,000.</td>
</tr>
<tr>
<td>Name</td>
<td>Specifies the alarm name (assigned in the alarm definition). The name appears in brackets &lt; &gt;.</td>
</tr>
<tr>
<td>Help</td>
<td>Specifies the name of the help file associated with the alarm (specified in the alarm definition). The name of the help file appears in brackets &lt; &gt;.</td>
</tr>
</tbody>
</table>
Exporting Alarm Definition Files Using an External Application

If you are using an external application you can export alarm definition files using the command line.

*Note: WizPro must not be running during this operation.*

- **To convert an alarm definition file to CSV format:**
  
  Type the following in the command line:
  
  `als2csv [fromfile] [tofile]`

**Importing Alarms**

The Import Alarms option enables you to import alarm definitions from an ASCII file. You can use the imported ASCII file to replace the current list with the generated one, or append it to the current list of alarms.

- **To import alarm definitions:**

  In the All Containers section of the Application Studio, right-click Alarms and select Import Alarms from the popup menu. The Open Alarm file for Import dialog box opens on your screen.
1. In the Files of type field, select the type of file you want to import. You can choose between CSV and ALS. Locate the file you want to import and click Open. The Import Mode dialog box is displayed.

2. Click Replace to replace the alarms in the alarm list with the imported alarm, Append to add the specified alarm to the alarm list, or Cancel to cancel the import.

**Importing Alarm Definition Files Using an External Application**

If you are using an external application you can import alarm definition files using the command line.

*Note: WizPro must not be running during this operation.*
To convert a CSV file to an alarm definition file:

Type the following in the command line:

csv2als [fromfile] [tofile]

**Alarm Properties**

This section describes how to define alarm properties also for predefined alarms.

To define alarm properties:

In the All Containers section of the Application Studio, right click Alarms and select then Properties. The Alarms Properties dialog box opens.

This dialog box has the following tabs:

- **General** - where the message that appears when a user logs in and out is defined. This message can by default be acknowledged and ended and be viewed in the Events Summary and History. Alarms can also be ended by the user by using the User Defined status feature.

- **Time Format** - where the time and date format of the message is defined.

- **Hotbackup** - used when an application that has master backup is run.

- **Network Communication Error** - used during network communications failure.

- **VPI Communication Error** - used during communication failure between the application and communication drivers.
- **User Login** - defines how and where an alarm issued during user login/logout is written to.
- **Wil Diskfull** - defines when and how an alarm is sent when the computer disk is full.
- **Tag Lock** - defines that a tag is locked when an alarm is issued.

### Specifying a Login/Logout Message

You can specify a message that will appear when a user logs in and logs out in the General tab of the Alarms Properties dialog box.

The following options are available:

- **Avoid generating alarms using tag set values on system startup**
  When this is checked no alarms using tag set values are generated during system startup.

- **Avoid generating new alarms**
  Specifies that logins and logouts are not logged. Restart the application for changes to take effect.

- **Login Alarm Text**
  Specifies the text you want to appear when a user logs in. This change can be implemented online.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Logout Alarm Text</strong></td>
<td>Specifies the text you want to appear when a user logs out. This change can be implemented online.</td>
</tr>
<tr>
<td><strong>Allow user defined status</strong></td>
<td>This feature is optional. Names are limited to hold up to 20 characters. Check this option to enable the user to define alarm states.</td>
</tr>
<tr>
<td><strong>Status names</strong></td>
<td>This feature is optional. Alarm states are given in the States.dat file in the application's directory. When the application is loaded this file is read and information in it is used where applicable. Status names are local and therefore are not transferred to other stations. Alarm messages, however are transferred to other stations where they can be handled. You can move an alarm to another user-defined status only if it has not already been acknowledged. However, if the alarm has been moved to another status it cannot be moved back to its previous status. If the user has already been authorized to acknowledge an alarm further authorization is not required where alarm status appear.</td>
</tr>
</tbody>
</table>

*Note: If no names are defined then the default names AlarmStatus0 and AlarmStatus1 are given. If in the Alarm Properties dialog box Allow User Defined Status is not checked then none of these column options are available. The default status names are language dependant.*
To define alarm status names:

1. In the Alarm Properties General Tab click the Status Names button to open the Alarm Status Names dialog box.

2. Type in the name of the alarm states in the 0 and 1 fields.

3. Click OK to save these definitions.

The new alarm status names appear in the Event Summary Columns dialog box where they can be selected and added as new columns to the Event Summaries. The status timestamp and user's name are also logged into the history file when an alarm is logged. Alarms can be assigned to a status by the user either in the Events Summary or Image (see Chapter 18, Introduction to the Image Module) modules.

Note: When status names are not defined the default names Alarm Status0 user AlarmStatus0 time and AlarmStatus1 user AlarmStatus1 time are used by default.
Determining a Time Format

You can choose between four different alarm time formats to determine the time format that will appear in the Events Summary and the Alarm printout, in the Time Format tab of the Alarm Properties dialog box.

The following options are available:

- **Day + Time** Displays a time format of month, time.
- **Day + Time + MilliSeconds** Displays a time format of month, time plus milliseconds.
- **Date + Time** Displays the full date and time.
- **Date + Time + MilliSeconds** Displays the full date and time plus milliseconds.

*Note: Restart the application for changes to take effect.*
Determining Hotbackup

This is a system filter used when an application that has master backup is run.

Note: Restart the application for changes to take effect.

Determining Network Communications Errors

This is a system filter that defines backup during network communications failure.
**Determining VPI Communication Errors**

This is a system filter used to communicate with other drivers.

**Determining User Login Parameters**

This is a system filter used to define how and where an alarm issued during user login/logout is written to.
**Determining WIL Diskfull**

This is a system filter that defines when and how an alarm is sent when the computer disk is xxx full.

![Alarms Properties](image)

**Tag Lock**

This dialog box is used to define that a tag is locked when an alarm is issued.

The default values (2) for Zone and Severity are assigned. A default family name (Taglock) is assigned.

![Alarms Properties](image)

The parameters of the alarm are tuneable however the following parameters are default:

- System Wide
- Auto Acknowledge
Alarm text always holds the specific locked tag’s name. After the tag is unlocked the alarm ends.

Finding Alarms

The application enables you to locate alarms in the List of Alarms in the Application Studio. This is especially useful if you have an application with many alarms.

To locate an alarm:

1. Click anywhere in the List of Alarms and select Find from the Tools menu. The Find Alarm dialog box is displayed:

2. Enter the alarm text in the Alarm Text field.
3. Enter the alarm family in the Family field.
4. Select the condition(s) by which you want to conduct the search in the Conditions area. You can choose between Alarm Text, Family name or Both.
5. Click Find. The alarm is located in the List of Alarms.
6. Click Exit or anywhere in the Application Studio outside the List of Alarms to close the dialog box.

Note: The Alarms List can also be opened using the filter option in the Application Studio.
Chapter 14 Alarm Filters, Printers & Printer Targets

About this chapter:

This chapter describes Alarm filters, Printers and Printer Targets and how to configure them as follows:

Overview on page 14-2 describes Alarm filters, Printers and Printer Targets and their functionality in the system program.

Defining Printers on page 14-3 describes how to define printers and their various functions.

Defining Alarm Filters on page 14-10 describes alarm filters and their functionality in the program and how to define their different parameters.

Defining Printer Targets on page 14-16 describes printer targets and their functions in the program.
Overview

Alarm Filters

The Alarm Filter filters alarms and reports before they are printed out or written to the Event Summaries. Alarm filters are displayed in the Alarm Filters table and defined or modified in the Filter Properties dialog box. Filter properties can be updated, however the name of a filter cannot be changed.

The Alarm Filter filters the alarms sent when parameters defined in tag variants are not met.

After alarms and reports outside the defined categories have been filtered out by the Alarms Filter, the remaining alarms are sent to the Printers defined in the Printer Targets module. See Defining Alarm Filters on page 14-10.

Printers

The Printers dialog box enables enhanced printing capabilities. Each printer added to a system can be set to print reports, alarms or both. In addition a definition can be made where many alarms are printed on a full page or whether only one alarm is printed on each page. Page orientation and font can also be defined. Alarm properties that are printed can also be set together with different colors, text and background. See Defining Printers on page 14-3.

Printer Targets

A Printer Target is a collection of predefined filters and printers specifying the conditions under which the targeted printer is activated.

The Printer Target dialog box holds a list of all the printer targets that have been defined. Each printer target is identified by a unique name and description. See Defining Printer Targets on page 14-16.
**Workflow**

This section describes the order of the steps required for defining Printers, Alarm Filters and Printers Targets.

- **Define tags**
  Tags definition.

- **Define alarm**
  Alarm definition.

- **Define Printer**
  The Printer module has three tabs; General, Alarm Properties and Color.

- **Define Alarm Filter**
  Alarm filters are attached to alarms. The Alarm Filter filters alarms according to family, severity, zone and classes.

- **Define Printer Target**
  The Printer Target dialog box connects between the defined filters and printers.

---

**Defining Printers**

The Printers dialog box enables enhanced printing capabilities. Each printer added to a system can be set to print reports, alarms or both. Printers can also be Network printers that are shared by multiple users. In addition, you can define whether many alarms will be printed on a full page or whether only one alarm will be printed on each page. Page orientation, font and printed alarm properties can also be defined and printed in different colors, text and background.

➤ **To specify printers:**

In the Control panel of the Application Studio, double-click the Printer icon.

Or,

From the Design menu, point to Options and select Printers from the popup menu. The Printers dialog box is displayed.
The Printers option has four tabs:

- **General Tab**
- **Alarm Properties Tab**
- **Colors Tab**
- **Line Printing Tab**

### General Tab

1. To define a printer either, click the name of a printer from the Printers List or click the arrow in the Select Printer field's dropdown list and select a printer.

2. Printers can be added or deleted from the Printers List. To add printers to the Printers List click either Local Printer or Network Printer. Double click the name of a printer in the List and OK to confirm. To delete a printer select a printer and click Delete Printer. The printer will be deleted from the list.
3. Report, Alarms or both can be printed. In the Use Printer For field check the relevant checkbox(es) to define this option.

**Alarms:** This option has backwards compatibility. This means that alarms from previous versions that have the Default Printer option selected will print to the defined printer.

**Reports:** This option has backwards compatibility (see Alarms above) and also prints reports.

**Default Printers:** This option can be selected by itself or together with Alarms or Reports or both.

4. The Alarm Print Options has three options, Full page, One alarm per page or Line printing, click the relevant option.

5. In the Orientation field click either Portrait or Landscape.

6. To change font style or color, click the Choose Font button and select a font or color.

7. Click OK to confirm.

*Note: When the Network Printers button is clicked the Network Browser opens. Browse to open the Network Place directory where a list of the computers that have shared printers is located. Select the relevant computer name from this list and then select a printer.*

*Only one Alarm and one Reports printer can be defined per application. This means that the remaining printers will all be Default. If one printer has both Reports and Alarms selected then all other printers in the application will be Default.*

*The Line Printing tab only opens when this option is clicked in the Alarm Print Options and is for Dot Matrix printers only.*
1. To define a printer either, click on the name of a printer from the Printers List or click the Select Printer field's dropdown list and select a printer.

2. Printers can be added or deleted from the Printers List. To add printers to the Printers List click either Local Printer or Network Printer. Double click the name of a printer in the List and OK to confirm. To delete a printer select a printer and click Delete Printer. The printer will be deleted from the list.

3. The Columns Order field lists the column fields and the order in which they will appear in the printout. Check the relevant column in the list to define this option.

4. The order in which columns appear in the printout can be defined using the following buttons:
   - Move Up - Moves a column up one space.
   - Move Down - Moves a column down one space.
Select All - Selects all the columns in the options list.
Deselect All - Removes all the columns in the options list.
Default - Resets to the default options list.

5. Click OK to confirm these changes.

Note: When Network Printers is selected the Network Browser opens. Browse to open the Network Place directory where a list of the computers that have shared printers is located. Select the relevant computer name from this list and then select a printer.

Colors Tab

Note: Alarms should first be defined in the Alarm Definition dialog box tabs and in the Printers/General Tab.

1. To define a printer either, click on the name of a printer from the Printers List or click the Select Printer field's dropdown list and select a printer.

2. Printers can be added or deleted from the Printers List. To add printers to the Printers List click either Local Printer or Network Printer. Double click the name of
a printer in the List and OK to confirm. To delete a printer select a printer and click Delete Printer. The printer is deleted from the list.

3. Select either Zone or Severity. Additional zones can be entered by typing the zone number in the sequential textbox. The highest zone number indicates the report/alarm urgency.

4. Colors can be added to text. Each alarm/report type can be defined a different color. To add/change a color click the (empty) color box to open the color chart, select a color and click OK. The color will be added to the list.

5. In the Background field select either Zone or Severity. Additional zones can be added by typing the zone number in the sequential textbox. The highest zone number indicates the alarm's urgency.

6. To add/change a background color, click the (empty) color box to open the color chart, select a color and click OK. The color will be added to the list and appear as background color on the printout.

Note: Color can be defined for Windows mode printing.
Line Printing Tab

Note: This tab only appears after Line Printing is defined in the Alarm Print Options of the General Tab.

1. To define a printer either, click on the name of a printer from the Printers List or click the Select Printer field's dropdown list and select a printer.

2. Printers can be added or deleted from the Printers List. To add printers to the Printers List click either Local Printer or Network Printer. Double click the name of a printer in the List and OK to confirm. To delete a printer select a printer and click Delete Printer.

3. An escape sequence is a set of characters giving additional commands to the printer regarding printing format. Each printer has its own escape sequence, which is usually written in the printer's manual.

4. The number of characters in each line can be defined. To do so either type in the number or use the arrows to scroll up/down.
5. The number of lines on each page can be defined. To do so either type in the number or use the arrows to scroll up/down. The digit 0 indicates continuous printing.

**Defining Alarm Filters**

When the value of a tag deviates from the values set in the Single or Multiple Tag dialog box an alarm is sent to the relevant station. The Alarm Filters module filters alarms according to family, severity, zone and classes.

In the Control panel of the Application Studio, double-click the Alarm Filters icon. Or, From the Design menu select Alarm Filters. The Alarm Filters dialog box is displayed:
The Alarm Filters dialog box has four columns:

<table>
<thead>
<tr>
<th>Alarm Filters</th>
<th>Displays an Alarms Filters list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag for</td>
<td>Number of active alarms</td>
</tr>
<tr>
<td>Started&amp;Unacked</td>
<td></td>
</tr>
<tr>
<td>Tag for</td>
<td>Number of acknowledged alarms</td>
</tr>
<tr>
<td>Started&amp;Acked</td>
<td></td>
</tr>
<tr>
<td>Tag for</td>
<td>Number of alarms that were activated and not acknowledged</td>
</tr>
<tr>
<td>Ended&amp;Unacked</td>
<td></td>
</tr>
</tbody>
</table>

Alarm filters can be added, updated and deleted.

- **To add Alarm Filters:**

To define an Alarm Filter click the Add button located under the Alarm Filter list. The Filter Properties dialog box opens.

There are three tabs:

- General Tab
- Network Tab
- Counters Tab
This tab holds general information about the alarm filter.

1. In the Name field type a unique name for the alarm filter.

2. In the Description field type a short description of the alarm filter.

3. Click the Family field's arrow to open the dropdown list and select a family. Only alarms from this family will be displayed.

4. In the Severity field specify the Minseverity and Maxseverity fields. Alarms out of these fields will not be displayed.

5. In the Zone field specify the Minzone and Maxzone fields. Alarms out of these zones will not be displayed.

6. Click the Select Class button to open the Set Class Filter dialog box. Filter classes can be used to categorize alarms to identify them more easily and to filter them in the Event Summaries. Classes can be added and removed individually or as a group by clicking the Set All and Reset All buttons. Click OK to return to the General tab.
7. Click the Select Fields button to open the User Fields Filters dialog box. This dialog box holds customized fields that are defined by the user in the Alarms Parameters Field Names dialog box. Type in your filtering criteria in the relevant User Field and click OK to confirm. The Alarm Filter will filter the User Fields accordingly. For example in User Field 1 only Alarms that are High will be filtered.

8. Click OK to actually save the Alarm Filter definitions.

Note: The Family name list is defined in the Tags dialog box in the Tag Name field.
**Network Tab**

This tab is used to define the Filter Alarm's network station. The stations appearing in the List All Stations list are active in the Network menu.

1. In the List All Stations column select the relevant station.
2. Either double click the station name or, click the Forward button. The station name will be transferred to the Selected Station column.
3. To remove a station from the Selected Station list click the Backwards button.
4. The All Stations checkbox enables filtering alarms on all the stations in the network including local stations. Click this checkbox to enable this option. When this checkbox is selected the button options are not enabled.
5. Click OK to confirm.
Counters Tab

This tab displays the status of the number of alarms in the system.

1. To enable the fields in this dialog box check the Enable Count Alarms checkbox.
2. In each field click the arrow to open the dropdown list and select the tag that will be counted. Do not select system tags.
3. Click OK to confirm. The defined fields will appear in the Alarm Filter dialog box.
To change Alarm Filters specifications:

1. To change an Alarm Filter either double click the alarm filter in the list or select the Alarm Filter and click the Change button located under the Alarm Filter list. The Filter Properties dialog box will open.

2. Change relevant parameters using the instruction for To add Alarm Filters: on page 14-11 Click OK to confirm. The changes will appear in the Alarm Filters list.

To delete an Alarm Filter:

1. To delete an Alarm Filter select the alarm filter and click the Delete button located under the Alarm Filter list. A message box will open asking if you are sure that you want to delete this alarm filter.

2. Click Yes to delete the Alarm Filter.

3. Click OK to confirm.

Defining Printer Targets

A Printer Target is a collection of predefined filters and printers specifying the conditions under which the targeted printer is activated.

The Printer Target dialog box holds a list of all the printer targets that have been defined. Each printer target is identified by a unique name and description.

To specify Printer Targets:

In the Control panel of the Application Studio, double-click the Printer Target icon.

Or,

From the Design menu select Printer Target. The Set Printers dialog box is displayed:
1. To add a printer target click the Add button. The Target Definition dialog box opens.

2. To modify a printer target select the printer target in the Name column and click the Modify button.

3. Printer targets can be deleted. To do so select the printer target in the Name column and click the delete button.

4. To load a printer target, select the printer target in the Name column and click the Load button. A tick will appear in the checkbox next to the selected printer target.

5. To unload a printer target select the printer target in the Name column and click the unload button. Or uncheck the checkbox of the selected printer target.

*Note: When a printer target is loaded and an alarm that meets the filter criterion is generated, the alarm will be sent automatically to the printer defined for printing alarms.*
To specify Target Definition:

A Target Definition is comprised of a user defined name and description and a selection of printers and filters. This dialog box opens when either the Add or Modify button is clicked in the Printer Target dialog box.

1. Type the name of the target in the Name field.
2. Type a description for the target in the Description field.
3. In the List all Selected Filters field select the relevant filter. To add filters to this list click the Select Filter button to open the Select Filter dialog box. Select a filter, click Add and OK to confirm.
4. In the List all Selected Printers field select the relevant printer. To add printers to this list click the Select Printers button to open the Select Printers dialog box. Select a printer, click Add and OK to confirm.

5. To automatically load the printer target during application start up click the Load at Application Startup button and click OK. The printer target now appears in the Printer Targets list.

*Note: The Name must be unique.*
Chapter 15 Advanced Alarm Management

About this chapter:

This chapter describes Advanced Alarm Management (AAM), as follows:

- **Advanced Alarm Management (AAM) Overview on page 15-2** is an overview of the application network environment.
- **Getting Started on page 15-3** describes the basic requirements for AAM.
- **Channels on page 15-7** describes working with AAM Channels.
- **Pager Services on page 15-18** describes working with AAM Pager Services.
- **Vocal Server on page 15-23** describes this server’s setup.
- **Message Formatting on page 15-44** lists different types of user message formats.
Advanced Alarm Management (AAM) Overview

The Advanced Alarm Management (AAM) module provides additional alarm services. This is useful when critical alarms requiring urgent attention need to be sent, read and the cause of the alarm handled.

The AAM module sends either alphanumeric or voice messages. An alarm can be sent by SMS, pager, email, fax, printer, or as voice to single or multiple users. An alarm sent by voice mail can be acknowledged and any messages sent with the alarm can be read.

AAM messages can be sent to groups (defined in Chapter 7, Security and User Management, User Management - Overview on page 7-12) and according to schedules set in the Users Timetable (Chapter 17, Users Timetable, Users Timetable Overview on page 17-2).

The AAM module supports multilanguage. User messages can be translated into French, English or German.

Note: All WAV files played by the AAM must be in mono format and not stereo.

Advanced Alarm Management can be used in two modes:

- Demo mode: Used for trial purposes, runs for two hours after which the user (developer) must restart the computer. The voice option is not available.
- Plug with AAM option: Authorized unlimited fulltime mode.

The following AAM configuration module defines how and where an alarm is sent:

- Channels - defining the modems (TAPI modem or modem connected to COM port).
- Pager Services - defines the types of services used to send alarms (SMS, Email, Pager, Fax, Printer, Voice).
- Advanced Alarm Viewer - a real time log where outgoing alarms can be viewed.
- User Timetable - where users within teams and groups work schedules can be defined. Alarms will be sent to users in realtime and according to work shift. See Chapter 17, Users Timetable.
Getting Started

This section discusses basic work principles and requirements for using AAM.

Requirements

- Network communications - LAN or regular modem.
- Plug authorization.
- Multi media hardware - soundblaster (for voice functionality only).

Plug Upgrade

Contact your supplier for details regarding ordering a new plug or upgrading existing software through the Remote Upgrade Service (RUS). Or visit our website at www.axeda.com to find your nearest supplier.
Workflow for Alphanumeric Messages

Step 1: Activate AAM module in the Station Properties dialog box

Step 2: Define COM modem

Step 3: Define email driver

Step 4: Define message recipients (User Management, Groups tab)

Step 5: Define alarm conditions (User Management, Messenger tab)

Step 6: Generate an alarm using the Single Tag tool

Step 7: Verify message status
Workflow for Vocal Messages

Step 1: Activate AAM module in the Station Properties dialog box

Step 2: Define COM modem

Step 3: Define Vocal Driver

Step 4: Define synthesis engine

Step 5: Define message recipients (User Management, Groups tab)

Step 6: Define alarm conditions (User Management, Messages tab)

Step 7: Generate an alarm using the Single Tag tool

Step 8: Verify message status
Configuring AAM

Advanced Alarm Management is configured in the Station Properties dialog box Advanced Alarm Management tab.

To define Advanced Alarm Management:

In the route of the All Containers pane right click on the project name. The Station Properties dialog box opens.

1. Using the arrows scroll and select the Advanced Alarm Management tab.
2. Check the Enable Advanced Alarm Management checkbox.
3. Click OK to confirm and restart the application.
**Channels**

Advanced Alarm Management communication lines (TAPI modem or modem connected to COM port) are defined in the Channels dialog box where channels can be added, removed, deactivated or be modified.

**Quick Access Bar Icon**

The Advanced Alarm Management dialog box can be accessed by clicking the AAM icon on the Quick Access Bar.

The following configuration options can be accessed through this dialog box:

- **Channels** (modems) channels setup - Tapi modem or modem connected to COM port
- **Pager Services** (messages)
- **Vocal Server**
- **Advanced Alarm Viewer**
- **Message Formatting**

During runtime the real time Advanced Alarm Viewer shows statistics and an Event Summaries.
**Defining Channels**

- **To specify AAM Channels:**

  In the Quick Access bar click the AAM icon and then click the Number of modems, message services and vocal server Setup button.

  Or,

  From the Design menu, point to Advanced Alarm Management and select Channels from the popup menu. The Channels dialog box is displayed.

  ![Channels dialog box](image)

  The Channels dialog box has four buttons:

  **Add**  This button, when clicked opens the Channel dialog box where TAPI modems and COM ports can be selected and added.

  **Properties**  This button when clicked opens the Line Properties dialog box where communication line parameters can be configured.
TAPI Modem/COM Port setup Dialog Box

In this dialog box you can view and select TAPI modems and/or physical COM ports.

Select a modem, port or both and click the OK button. The Line Properties dialog box opens on your screen.

Notes: By default all modems and physical ports defined in the system are listed in this dialog box. To view TAPI modems or COM ports, check the Display only Modems and Display only Available COM ports checkboxes.

We highly recommend you to use a modem connected to a COM port rather than a TAPI modem to enable maximum parameters control.
TAPI Modem Properties Dialog Box

Click the Setup button to open the standard Microsoft dialog box where setup modem parameters can be defined.

**Voice functionality:** The AAM module supports voice functionality with the TAPI modem if the modem driver also supports voice functionality.

**With Windows NT4:** Generally, modem drivers do not support voice function and AAM cannot be used with the TAPI modem. Therefore, the COM port is connected to the modem.

**With Windows 2000:** Most TAPI modem drivers support voice functionality and the AAM module can use TAPI modem for voice call management. Not all driver modems support voice functionality.

▶ **To check that a driver can manage voice functionality:**

In the AAM dialog box, click Setup. Add a TAPI modem, and click Properties to open a standard Microsoft dialog box. If in the Assigned Service on Incoming Call field the Vocal Server option is defined this means that your TAPI modem driver can handle voice calls and can be used by AAM.
COM Port Properties Dialog Box

This dialog box is used to configure the parameters of the communication line.

Line Properties has the following fields:

Port: The port number is the name of the port defined in the Channels or Channel Modem and Port dialog box.

Keep Open: When this option is selected AAM defines that this port remains open permanently solely for the application. If this checkbox is not checked then this modem/port will be opened on demand and when available and will be automatically closed when communication terminates.

Type: There are two port types:

Hayes Modem - where communication is established through the telephone network
Direct Communication - for example, a printer connected to the port
<table>
<thead>
<tr>
<th><strong>Bauds, Bits, Parity</strong></th>
<th>Where port/modem communication bandwidth is defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Flow Control</strong></td>
<td>Where communication error control parameters are defined:</td>
</tr>
<tr>
<td></td>
<td>None - no flow control</td>
</tr>
<tr>
<td></td>
<td>Hardware - communication errors will be checked at the hardware level</td>
</tr>
<tr>
<td></td>
<td>Xon/Xoff - communication errors will be checked at the software level. Xoff code (13h) request for data emission suspension sent to the transmitter who then returns Xon (11h) code to resume transmission.</td>
</tr>
<tr>
<td><strong>Assigned service</strong></td>
<td>This field assigns services to incoming calls:</td>
</tr>
<tr>
<td></td>
<td>Direct line - assigned service that will manage port communication</td>
</tr>
<tr>
<td></td>
<td>Modem - assigned service that will manage incoming call</td>
</tr>
<tr>
<td><strong>Prefix to dial</strong></td>
<td>The number dialed to receive an outside communication line.</td>
</tr>
<tr>
<td><strong>Voice Modem</strong></td>
<td>Modem used to carry voice messages. Voice modem parameters can be defined by clicking the button to open the Modem Parameters in the Vocal Code dialog box.</td>
</tr>
<tr>
<td><strong>Fax Modem</strong></td>
<td>Modem used to carry fax messages.</td>
</tr>
<tr>
<td><strong>Modem CSM/PCS</strong></td>
<td>Where the parameters for this modem can be defined. Click the Browse button to open the GSM/PCS modem parameters dialog box.</td>
</tr>
<tr>
<td><strong>Reserved for</strong></td>
<td>Defines that this modem/port is reserved for incoming calls only.</td>
</tr>
<tr>
<td><strong>Automatic Setting</strong></td>
<td>Port/modem settings according to definitions.</td>
</tr>
</tbody>
</table>
1. Check the Keep open checkbox to enable port sharing between several applications.

2. In the Type field select either Hayes Modem or Direct.

3. Port baud rate should be defined as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud rate</td>
<td>300-11520</td>
</tr>
<tr>
<td>Bits</td>
<td>7,8</td>
</tr>
<tr>
<td>Parity</td>
<td>Even, Odd, None</td>
</tr>
<tr>
<td>Stop bits</td>
<td>1,2</td>
</tr>
</tbody>
</table>

These parameters can be modified by the services using the port for outgoing calls according to the communication type established.

4. In the Flow Control field select either None, Hardware or Xon/Xoff.

5. In the Assign Service on Incoming Call field click the dropdown list and select the relevant service.

6. In the Prefix to Dial field type the prefix used to access the outside communication line if relevant.

7. Select the relevant format type:

   - If a Hayes Modem has been selected then click the Modem parameters button to open the Hayes Modem Parameters dialog box.
   - If Direct has been selected in the Type field then select either Automatic connection, Connect detect or both.

8. Click OK to confirm.
Modem Parameters in Vocal Mode

This dialog box defines the parameters of the modem that transmits voice messages.

To specify modem parameters in vocal mode:

In the Line Properties dialog box click the voice modem button to open the Modem Parameters dialog box.

1. In the Modem field click the arrow to open the dropdown list and select a modem type.
2. In the Sampling field click the arrow in the Rate field to select how often the transmission line is sampled and then select the number of bits per sample.
3. In the Silence Detection Voice Receive field type in the silence detection period number (x100ms) and then in the Silence Sensitivity Tuner field select either; Low, Medium or High.
4. DTMF tone detection can be either on Transmission, Reception or Command, select a mode.
5. In the Other Parameters field type in the relevant parameters.
6. In the Reinitialization in Vocal Mode field define baud level.
7. In the Flow Control field select either None, Hardware or Xon/Xoff.
8. In the Begin and End Voice Communication fields type in the relevant number.
9. Click OK to confirm.
Notes: To avoid noise problems on the phone line, select the hardware flow control option. The parameter Ringback Goes Away Timer (100 ms) enables synchronization of messages that are played during user download. By default this is defined at 50. The value must be modified according the modem you use (with Olitec Speed Com 2000 the value could be 100).

**GSM/PCS Modem Parameters**

This dialog box defines the parameters of the GSM/PCS modem and the format of SMS messages.

- **To specify GSM/PCS modem parameters:**

  In the Line Properties dialog box click the Browse button to open the GSM/PCS modem parameters dialog box.

1. In the PIN number field type in the unique PIN number.
2. In the SMS format field select either; Auto, PDU or Text.
3. Click OK to confirm.
**Hayes Modem Parameters**

This dialog box is used to define the Hayes Modem communication line parameters.

► **To specify Hayes modem parameters:**

In the Line Properties dialog box click the Modem Parameter button to open the Hayes modem parameters dialog box.

![Hayes modem parameters dialog box]

1. In the Init String field type the command string that will be transmitted to the modem at interface initialization and at the end of each communication session.

2. Specify the Dial field parameters:
   - Prefix - type the string to be transmitted before the dial number
   - Suffix - type the attention string to signal a modem command during data communication

3. Specify the Hang-up field parameters:
   - Prefix - type the attention string to signal a modem command during data communication
   - Suffix - type the disconnection command
4. In the Originate Connection field type the command that will be sent to the modem to connect it after an incoming call received when the modem is setup for manual use.

5. In the Answer Connection field type the connection command that will be sent to the modem when an incoming call is received and the modem is set up for manual use.

6. Check the Hang-up by DTR checkbox to enable the DTR line to function as a command to disconnect the modem from the line.

7. Type the number of rings the system waits before answering an incoming call. The type of answer depends on the service selected for incoming calls in the Line Properties dialog box.

8. Select the Caller ID to enable a protocol generation for identification of the call dial number during incoming calls. There are three protocol types:
   - Formatted ID - analog voice modem with caller identification
   - Unformatted ID - analog voice modem with caller identification
   - Register S190 - ISDN modem, caller ID installed in the S190 modem register.

Note: To avoid problems during phone line connection add W to the ATDT for commands, for example; ATDTW. This will cause the modem to generate an error when the phone line is not connected.

► To modify Channel Line Properties:
In the Channels dialog box select the specific port or modem and click the Properties button. The Line Properties dialog box will open. See COM Port Properties Dialog Box on page 15-11.

► To remove Channel Line Properties:
In the Channels dialog box select the port or modem and click the Remove button.

► To deactivate Channel Line Properties:
In the Channels dialog box select the port or modem and click the Deactive button.
**Pager Services**

The AAM Pager Services module enables definition of a list of paging drivers and Call Management parameters. New drivers can be added, existing drivers removed and driver setup can be configured.

**Defining Paging Service Setup**

- To define paging service setup:

  In the Quick Access bar click the AAM icon and then click the Number messages configured Setup button.

  Or,

  In the Control panel of the Application Studio, double-click the AAM Pager Services icon.

  Or,

  From the Design menu, point to Advanced Alarm Management and select Pager Services from the popup menu. The Paging Service Setup dialog box is displayed.
The Paging Service Setup dialog box has the following options:

**Installed Drivers**  
A list of all drivers installed in the system.

**Setup**  
This option opens the setup dialog box for the selected service.

**Add**  
This opens the Add Paging Drivers dialog box where drivers can be selected and added.

**Remove**  
This button when clicked removes a selected driver from the list.

**Call Management**  
This option defines the number of times transmission connection is attempted before a failure message is sent. It also defines the time interval between each attempt.

**Adding Pager Services**

This button when clicked opens the Add Paging Drivers dialog box. The list of drivers can be configured according to country and with/without the GSM modem.

1. In the Paging Service Setup dialog box click the Add button to open the Add Paging Drivers dialog box.
2. In the Country field click the arrow to open the dropdown list and select a country. The Drivers list will show only the drivers available for the specific country.

3. To enable the GSM modem, click the With GSM Modem checkbox.

4. Select a driver from the Drivers list.

5. Click OK. The driver will appear in the Paging Service Setup Installed Drivers list.

**Remove Pager Services**

This option removes a driver from the Installed Drivers list.

Select the driver from the Installed Drivers list and click the Remove button. The driver is removed from the list.

**Defining Call Management**

This field defines both the number of times connection is attempted before a failure message is sent and the timeout before each call attempt.

1. In the Tries Number if Call Fails field type in the number of times a transmission is sent.

2. In the Timeout before New Try field type in the number of seconds between each connection attempt.

3. Click OK to confirm.

**Driver Setup**

This option defines the selected driver's setup. In general different dialog boxes open for different drivers.

**Email Driver Configuration (Direct SMTP connection)**

An SMTP server can be used to send email (directly) by defining the full address of the SMTP server given by the Internet provider.
Email Driver Configuration (With Internet modem connection)

Email can be sent through a modem and an Internet connection:

1. Setup the Internet connection independently of the application. In the Email Driver Setup dialog box enter the name of the Internet connection.
2. Define the login and password of the connection.
3. Click OK to confirm.

SMS Driver Configuration

Each country already has an SMS driver profile configured and therefore generally these do not need to be configured. However, in most countries SMS messages are sent via TAPI or ERMES servers. Therefore, if the SMS driver profile is not in the list contact Axeda Systems for an updated configuration file.

Pager Driver Configuration

Each country already has a page profile configured and therefore generally these do not need to be configured. However, in most countries message pagers are sent via TAPI or ERMES servers. Therefore if the SMS driver profile is not in the list contact Axeda Systems for an updated configuration file.
Fax Driver Configuration

Note: To avoid flow communication problems select the hardware flow control option by clicking the More button.

Voice Driver Configuration

Note: No specific parameters are needed in the configuration of the voice driver.
**Vocal Server**

The Vocal Server dialog box configures the sound of the voice message defined in the Alarms dialog box Action on Alarm tab AAM field. The voice can be defined as male, female, according to age, volume, pitch, rate, country of origin and more.

*Note: All WAV files played by the AAM must be in mono format and not stereo. The following format must be used 44kHz 16bit mono.*

**To open the Vocal Server Setup**

In the Quick Access bar click the AAM icon. The Advanced Alarm Management dialog box opens. Click Vocal Server Setup to open the Vocal Server Setup dialog box.
This dialog box has the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>This button when clicked opens the Vocal Server license agreement.</td>
</tr>
<tr>
<td>Engine</td>
<td>The Engine field defines the type of synthesizer.</td>
</tr>
<tr>
<td>Test Message</td>
<td>Type in the message of the alarm text</td>
</tr>
<tr>
<td>Voice Synthesis Parameters:</td>
<td>Voice - this field defines the type of voice speaking the message</td>
</tr>
<tr>
<td></td>
<td>Rate - this field defines how fast the message is spoken</td>
</tr>
<tr>
<td></td>
<td>Pitch - this field defines the pitch the message is spoken</td>
</tr>
<tr>
<td></td>
<td>Volume - this field defines the volume at which this message is spoken</td>
</tr>
</tbody>
</table>

1. In the Engine field click the arrow in the dropdown list and select ViaVoice Outloud 4.0.
2. In the Text Message field type in the text of the voice message.
3. In the Voice field click the arrow to open the dropdown list and select the voice type.
4. In the Rate, Pitch and Volume fields slide the button to change parameters.
5. Click the Advanced button to open the Voice Synthesis Parameters dialog box to make further changes to the voice.
6. Click OK.
WAV Messages

The following messages are held in the product Bin. To activate the message the following format must be defined in the Frequency Formatting dialog box: PCM48KHz.8bit.mono. File names cannot be modified.

- **ACKFILE.WAV** This message is used to inform the user that the alarm message has been acknowledged.
- **ENDALARM.WAV** This message is used to inform the user that the alarm has ended.
- **ENDMSG.WAV** This message is used to inform the user that the message has ended.
- **STARTALARM.WAV** This message is used to inform the user that the alarm is starting.
- **WAITACTFILEACKEND.WAV** This message is used to inform the user that their message has been received and that they can either press * to confirm it or press # to exit the message.
- **WAITACTFILEEND.WAV** This message informs the user that their message was received and that to end the message press #.

Voice Synthesis Parameters

The Voice Synthesis Parameters edits the voice of the voice message.

This dialog box has four tabs:
- **Voice** - defines the voice label, gender, and other parameters.
- **Features** - defines voice language, dialect, style and more
- **Dictionaries** - holds lists of words, roots, abbreviations common to the module.
- **Identifiers** - lists the identifier codes recognized by the Id field.

- **To open the Voice Synthesis Parameters**

In the Vocal Server Setup dialog box click the Advanced button to open the Voice Synthesis Parameters dialog box.
Voice Tab

This tab has the following fields:

Voice Characteristics
This field defines the voice sound in the following options: Label, vocal tract, pitch, speed, volume, head size, pitch fluctuation, roughness and breathiness.

Describe As
This option defines voice gender and age.

Store
This option displays the Edit Stored Voices list

Edited Stored Voice
This option is used to edit the Stored Voices list

Show/Hide Test Panel
This option shows/hides the test panel where the defined voice can be tested, compared to another voice in the list and saved.
1. In the Speaker field click the arrow to open the dropdown list and select the speaker type. The values in the Voice Characteristics tab change accordingly.

2. Change the sound of the voice using the Voice Characteristic fields.

3. Click Test to hear the voice.

4. To change the voice gender click the Describe As button to open the Describe Voice As dialog box, where you can change the gender characteristics.

5. Click the Show Test Panel button to compare the voice to another voice in the list.

6. The Save Speaker button saves the voice to file.

7. Click the Delete Speaker button to erase this voice.

8. Click OK to confirm.

**Features Tab**
This tab has the following fields:

**Speaker**
This option when opened displays the Speakers list

**Native Language & Dialect**
This option defines language and dialect

**Style**
This option defines type of speech

**Tag Processing**
This option defines how the selected tab will be processed:
- Interpret - causes all tags to be recognized and interpreted
- Treat as Unknown - causes all tags to be treated as unknown and processed according to the application's definitions
- Speak - causes all unknown tags to be spoken as individual characters and numbers
- Ignore - causes all unknown tags to be ignored

**Audio**
This option defines the Audio sampling rate used.
- PC optimizes the sampling rate for the computer while Phone optimizes sampling rate for the telephone

**Show/Hide Test**
This option shows/hides the test panel where the defined voice can be tested, compared to another voice in the list and saved

1. In the Speaker field click the arrow to open the dropdown list and select a speaker type.
2. In the Native Language and Dialect field click the arrow to open the dropdown list and make your selection.
3. In the Style field click the arrow to open the dropdown list and make your selection.
4. In the Tag Processing field select the relevant processing method.
5. In the Audio field select either PC (11.025kHz) or Phone (8kHz).
6. Click the Show Test Panel button to compare the voice to another voice in the list.
7. Click OK to confirm.
Dictionaries Tab

This tab is used to add or edit dictionaries and to define special word types.

This dialog box has the following fields:

Dictionary Type

There are three dictionary types:
- Special Words - contains entries which may include digits or other non-alphabetic symbols or entries that require translations with annotations, SPRs or other non-alphabetic symbols
- Roots - contains the root of the word only
- Abbreviations - contains entries that include periods

Edit

When this button is clicked it opens the Edit Dictionary dialog box where you can add, edit, delete, add speakers, keys and translation

Show/Hide Test

This option shows/hides the test panel where the defined voice can be tested, compared to another voice in the list and saved
1. In the Dictionary Type field click the arrow to open the dropdown list and select a dictionary term.

2. To edit a dictionary term click the Edit button to open the Edit Dictionary dialog box.

3. Click OK to confirm.

**Edit Dictionary**

![Edit Dictionary dialog box](image)

This dialog box has the following fields:

- **Add**
  - This option when clicked opens the Dictionary Entry dialog box

- **Edit**
  - This option when clicked opens the Dictionary Entry dialog box

- **Delete**
  - When selected deletes the dictionary entry

- **Key**
  - The string of characters that the dictionary searches for. Click this option to hear the pronunciation of the key

- **Trans**
  - Click this option to hear the translation of the key.
1. To add a new dictionary entry, click the Add button. The Dictionary Entry dialog box will open. Complete the fields as described in Dictionary Entry on page 15-31 and click OK to return to this dialog box.

2. To edit a dictionary entry, select the entry and click the Edit button. The Dictionary Entry dialog box will open. Complete the fields as described in Dictionary Entry on page 15-31 and click OK to return to this dialog box.

3. To delete a dictionary entry, select the entry and click the Delete button. The entry will be removed from the list.

4. Click the Key button to listen to the pronunciation of the key for the selected dictionary term.

5. Click the Trans button to listen to the pronunciation of the translation that was provided by the user for the selected dictionary term.

6. Click OK to confirm.

**Dictionary Entry**

This dialog box opens when the Edit Dictionary Add or Edit buttons are selected.
This dialog box has the following fields:

**Key**  
The string of characters that the dictionary searches for.

**Translation**  
The translation of the key that the dictionary searches for.

**SPR from Key**  
Phonetic alphabet the dictionary searches for

**SPR from Translation**  
The phonetic alphabet that the dictionary searches for.

1. In the Key field type in the new directory term.
2. In the Translation field type in the way that the word should be pronounced.
3. If the translation sounds correct click OK, if not continue modifying the spelling of the translation.
4. For phonetic alphabet pronunciation click the SPR from Translation field.
5. Click OK to confirm.
Identifiers Tab

The Identifier tab dialog box holds a list of identifier codes recognized by the vocal server.

This dialog box has the following fields:

- **Speaker**: This field when opened displays the Speakers list
- **Description**: This field shows the description of the selected speaker
- **Guide**: This field shows the Description field’s code
- **Show/Hide Test**: This option shows/hides the test panel where the defined voice can be tested, compared to another voice in the list and saved

1. In the Speaker field click the arrow to open the dropdown list and select a speaker type.
2. Click the Show Test Panel button to compare the voice to another voice in the list.
3. The Save Speaker button saves the voice to file.
4. Click the Delete Speaker button to erase this voice.
5. Click OK to confirm.

**User Message Format**

This section shows message formats for different kinds of pager services.

**Email Message Format**

<table>
<thead>
<tr>
<th>Station Name: Station1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Status: Alarm Started</td>
</tr>
<tr>
<td>Alarm Date/Time: Thursday August 30 2001, 10 Hours, 22 Minutes, 21 Seconds</td>
</tr>
<tr>
<td>Alarm Text: The test variable is equal to 46</td>
</tr>
<tr>
<td>Alarm Severity: 2</td>
</tr>
<tr>
<td>Alarm Zone: 15</td>
</tr>
<tr>
<td>Alarm Family: Electrical</td>
</tr>
</tbody>
</table>

*Note: The contents of the Alarm Text field will appear also in the Object of the email.*

**SMS Message Format**

<table>
<thead>
<tr>
<th>St:Station1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Started: Thursday August 30 2001, 10 Hours, 57 Minutes, 46 Seconds, &lt;The test variable is equal to 46&gt;</td>
</tr>
<tr>
<td>Svr:2</td>
</tr>
<tr>
<td>Zn:15</td>
</tr>
<tr>
<td>Fam:Electrical.</td>
</tr>
</tbody>
</table>
Pager Message Format

Station Name: Station1
Alarm Date/Time: Thursday August 30, 2001
Alarm Text: The test variable is equal to 46
Severity:
Alarm Family: Electrical

Fax Message Format

<Logo>
<Fax Message Header>
Station Name: Station1
Alarm Status: Alarm Started.
Alarm Date/Time: Thursday August 30, 2001, 10 Hours, 22 Minutes, 21 Seconds
Alarm Text: The test variable is equal to 46
Alarm Severity: 2
Alarm Zone: 15
Alarm Family: Electrical
### Printer Message Format

- **Station Name:** Station1
- **Alarm Status:** Alarm Started
- **Alarm Date/Time:** Thursday August 30 2001, 10 Hours, 22 Minutes, 21 Seconds
- **Alarm Text:** The test variable is equal to 46
- **Alarm Severity:** 2
- **Alarm Zone:** 15
- **Alarm Family:** Electrical

### Voice Message Format

- **Station name is:** Stations1
- **Alarm started at:**
- Date is: Thursday August 30 2001, 11 Hours, 12 Minutes, 28 Seconds
- Severity is equal to
- Family is: Electrical.

**Note:** An introduction message will be played before the alarm message. An alarm message can be acknowledged by pressing the * character after which a confirmation message will be played.
**Advanced Alarm Viewer**

The AAM viewer displays detailed information on all AAM alarms in the application.

► **To open the Advanced Alarm Viewer**

In the Quick Access bar click the AAM icon. The Advanced Alarm Management dialog box opens. Click the Advanced Alarm Viewer to open the Advanced Alarm Viewer dialog box.

Or,

In the menu bar select Tools and then Advanced Alarm Viewer. The Advanced Alarm Viewer opens.
### Description of available statistics:

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarms in process</td>
<td>Displays the number of alarms that are being processed</td>
</tr>
<tr>
<td>Alarms processed</td>
<td>Displays the number of alarms that have been processed</td>
</tr>
<tr>
<td>Alarms well processed</td>
<td>Displays the number of alarms that have successfully reached their destination</td>
</tr>
<tr>
<td>Alarms processed with errors</td>
<td>Displays the number of erroneous alarms generated</td>
</tr>
<tr>
<td>Joined users</td>
<td>Displays the number of users that have been reached</td>
</tr>
<tr>
<td>Unreachable users</td>
<td>Displays the number of users that cannot be reached</td>
</tr>
<tr>
<td>Alphanumeric messages sent correctly</td>
<td>Displays the number of alphanumeric message sent correctly</td>
</tr>
<tr>
<td>Displays the number of alphanumeric message sent correctly</td>
<td>Alphanumeric messages sent with error Displays the number of erroneous alphanumeric messages</td>
</tr>
<tr>
<td>Vocal messages sent correctly</td>
<td>Displays the number of vocal message sent correctly.</td>
</tr>
<tr>
<td>Vocal messages sent with error</td>
<td>Displays the number of erroneous vocal messages</td>
</tr>
<tr>
<td>Alarms acknowledged</td>
<td>Displays the number of alarms that have been acknowledged by user</td>
</tr>
<tr>
<td>Alarms unacknowledged</td>
<td>Displays the number of alarms that have not been acknowledged</td>
</tr>
</tbody>
</table>
Description of fields available in the Events Summary:

**AAM ID**  
Displays the alarm identifier provided by the AAM module

**Status**  
Displays an icon according to the management status of the alarm

**Date**  
Displays the date the alarm was raised

**Time**  
Displays the time that the alarm was raised

**User**  
Displays the name of the user receiving the alarm

**Driver Name**  
Displays the driver used to reach the user

**Destination**  
Displays the destination address of the sent message

**Backup User**  
Displays Yes if the user is the backup user, otherwise it displays No.

**Detailed Status**  
Additional informations on the AAM status

**More Details**  
This button when clicked opens the Event Log Journal

*Note: In this version the only service that can be supported by the Backup User is Vocal.*

**Event Log Journal**

The Event Log Journal is a table that holds the historical record of all events detected by the Advanced Alarm Management module. A new Event Log Journal file is opened every day where each event is written in order of occurrence. The file is saved in the Trace folder located under the application bin folder in the following format:

```
tYYMMDD.LOG
YY=year, MM=month DD=date
```
To open the Event Log Journal

Click the Details button in the Advanced Alarm Viewer dialog box.

The Event Log Journal has the following fields columns and options:

- **Date:** The date of this Event Log Journal file
- **Service:** The AAM service where the event occurred, this could be Pager, Vocal Server or both
- **Events:** The Events button when clicked opens a list of all event types
- **Print:** The Print button when clicked prints a copy of this page
- **Time:** The event time stamp
- **Service:** The AAM service where the event occurred, this could be Pager, Vocal Server or both
- **Event:** Label of the event including the event code number and name
- **Identifier:** The user whose station generated the event
- **Information:** Additional information regarding the event
To select the Event Log Journal date:
1. In the Date field click the arrow to open the dropdown list.
2. Select the relevant date. The Log will show only the events that occurred on the selected date.

To select a service:
1. In the Service field click the arrow to open the dropdown list.
2. Select the relevant Service. This could be Pager, Vocal Server or both. The Log will show only the events that occurred in the selected service.

To select an event type:
Click the Events button to open the Events Type list.

1. Check the relevant event types.
2. Click the All button to select all event types and None for no event types.
3. Click Close to close the list. The selected event types will be recorded.

Customizing the Event Log Journal Window
Each column in the Event Log Journal can be customized according to requirements.

To customize the Event Log Journal:
Right click in the column you wish to customize to open the dropdown list options.
► To define the column title:
1. Select Column Title from the dropdown list to open the Column Title dialog box.
2. Type in the new name of the column and click OK.

► To define the column width:
1. Select Column Width from the dropdown list to open the Column Width dialog box.
2. In the Column Width field type in the new measurement and click OK.

► To define the column position:
1. Select Column Position from the dropdown list to open the Column Position dialog box.
2. In the Column Position field type in the new position (range 1-5) and click OK. The position of the column within the table will change accordingly.

► To define column alignment:
1. Select Column Alignment from the dropdown list to open the Column Alignment dialog box.
2. In the Title Alignment field select either; Left, Center or Right.
3. In the Column Alignment field select either; Left, Center or Right and click OK. The column will be aligned accordingly.

► To sort a column:
Select Sort on Column from the dropdown list. The column in the Event Log List will be sorted accordingly.

► To mask a column:
Select Mask from the dropdown list. The column will be hidden.

► To display a column:
This option is used to retrieve masked columns.
1. Select Display from the dropdown list to open the Column Display list.
2. Select the columns you wish to display in the Event Log Journal table and click OK. The selected columns will open in the table.
To print a column:
Select Printing from the dropdown list to open the Printing Format list
1. Select the columns you wish to print.
2. Select printing orientation, which is either Default, Portrait or Landscape. Click OK to print the column.

To export a column:

1. Select Export from the dropdown list to open the Export dialog box.
2. Select the columns you wish to export.
3. Check the Include first line header checkbox to display the columns title in the exported file.
4. Select the columns separator in the exported data (tab, semi colon or comma).
5. Define where to export your table data: to the clipboard or a file. If you selected to export the data to a file, click the browse button to select the file to which you want to export the table data.
6. Click OK when done.
**Message Formatting**

The Message Formatting dialog box is used to define the format of the alarm message that is sent to the user.

► **To open the Advanced Alarm Viewer**

1. In the Quick Access bar click the AAM icon. The Advanced Alarm Management dialog box opens.

2. Click the Message Format button to open the Message Formatting dialog box.

![Message Formatting Dialog Box](image)
This dialog box has the following options and buttons:

**Format**
This field defines the type of alarm format sent to the user:

- **Long** which when checked indicates that the user will receive an alarm message holding all the alarm fields available. The defaults for this field are Start time and Text.
- **Short** which when checked indicates that the user will receive an alarm holding limited fields only. The default for this field is Text.

*Note: Check the End Time Message checkbox to enable the user to receive notification that an AAM has ended.*

**Columns List**
This list holds all the columns that can be selected and which will appear in the AAM message sent to the user.

**Move Up**
Moves a selected column from the Columns List one space up.

**Move Down**
Moves a selected column from the Columns List one space back.

**Select All**
Selects all the columns appearing in the Columns Lists and adds them to the AAM message format.

**Desselect All**
Unchecks all the selected messages from the Columns List.

**Default**
Returns this dialog box's options to the application's default.

*Note: A message will not be sent to a vocal client in the following circumstances:*

- If the alarm is acknowledged by pressing these buttons "*" on a cellular phone.
- If the program's AutoAck option is selected.
Chapter 16 The Application Network

About this chapter:

This chapter describes how to design and operate an application network, as follows:

Overview on page 16-2 is an overview of the application network environment.

Basic Concepts on page 16-2 describes the application network configurations.

Configuring Application Network Stations on page 16-5 describes how to configure the application for networking.

Recording Remote Data on page 16-12 describes how to record remote tags and alarms. It also describes how to simulate the connection between a remote station that is not running.

Network Properties on page 16-15 describes how to set your network environment to establish maximum application performance.

Application TCP/IP Support on page 16-21 describes how to configure your application network for TCP/IP.

Application Backup - Principles of Operation on page 16-23 describes the backup principles of the backup station and the master station

Failure Detection and Reaction on page 16-24 describes what to do when an error message is received in switch backup mode.
Overview

Application stations operating in a network environment can share objects, such as alarms and tags. Direct access to remote tags and alarms can be implemented through a simple station definition procedure. Once the station is defined to support the application's network activities, any operation involving tags and alarms on a local station can include remote tags and alarms as well.

The application network system operates in a manner similar to other network systems. The application kernel, handles all network operations and transfers data from/to local and remote application stations.

The application supports various network components, including LAN Server and TCP/IP.

Installation in a TCP/IP environment enables application stations on one network to communicate with other application stations on other networks. Through TCP/IP, the application network offers a complete enterprise-wide solution.

Basic Concepts

This section describes the application's network configurations.

Application Station

A general term describing a station that is configured to operate on the application network (can be SCADA, BACKUP, VIEW or SERVER).

Application SCADA Station

An operations station that can communicate with up to 1000 network stations and 32 PLCs simultaneously. This station performs functions such as:

- Sampling PLCs
- Generating alarms
- Collecting historical data
- Performing control operations
The operator can view the process through the application user-interface and interact with on-going activities. The application's SCADA station can receive and send data to other network stations.

**Application Hot Backup Station**

For applications that require the highest degree of reliability, the application provides the hot backup redundant configuration. This configuration consists of two identical application SCADA stations. Both stations are connected to the same PLCs, but one station runs in the Master mode and samples data in the field, while the second station (Backup station) remains in a Stand-By mode. When the Master station goes down, the Backup station switches to the Master mode, starts to sample PLCs and distributes real-time data to other stations across the network.

In addition to real-time redundancy, the Hot Backup feature ensures the integrity of historical databases. After the Master station recovers, the backup station updates the Master station with the missing historical data. This mechanism ensures that the historical database on the Master stations remains complete.

**Application VIEW Stations**

A fully operational station that allows operators to view and control the process. This station automatically receives all the online and historical data from the SCADA stations, as required. The operator can transparently interact with the process using application images, charts and other standard modules. The application VIEW station serves as a mirror of the real-time and historical data from one or more SCADA stations. The network VIEW station is not connected to a PLC, but to SCADA stations via a network.

**Application SERVER Station**

*Note: Not enabled for the web.*

Buffers and redirects data exchange transactions between the Management View stations to the plant in order to isolate and avoid overloading SCADA stations that control the real-time data floor.

The application server collects requests from the Management View stations and transfers them to the appropriate SCADA stations. In response to these requests, the
server continuously receives updated messages about tags and alarms and dispatches them to the Management View stations.

In addition to routing real-time data, the application server can collect data from the SCADA stations and record selected data in historical databases. These databases can reside on the server local disk or on the network file server and are shared among all stations across the network. Since the application stores the data in a common format, users can access this data from both application stations and other applications without having to deal with format conversion.

This configuration allows users to efficiently distribute computer power among different computers and PLCs, optimizes network resource consumption, and ensures that time-critical missions will be completed without interference.

**Management View Station**

*Note: Not enabled for the web.*

Stations that bring real-time and historical data from the plant floor to any desktop in the organization. Management View stations can display data collected by one or more SCADA stations. In addition to displaying the data in forms of images, graphs and reports, Management View stations provide the necessary functions for interacting with on-going activities. Each command for changing process parameters or downloading a recipe is immediately transferred to the appropriate application SCADA stations. Since the server handles the communication, this process does not affect time-critical operations on the plant-floor. A Management View Station cannot operate without a Server station.
Configuring the Application for Networking

Before defining stations for your network first configure the O/S for networking.

Time Setting Considerations

The application timestamp is based on local time according to daylight saving time therefore synchronize the clocks on your network settings.

Make sure that:
- The windows settings are identical in all application stations across the network. This includes Time Zone as well as Daylight Saving Time.
- All network PC clocks are synchronized at all times. It is recommended to use a network utility to periodically synchronize the PC clocks.
- If the application and OS/2 are on the same network, make sure that the Windows time settings in all application stations are as follows: Time Zone - Eastern Time (USA and Canada) - (GMT - 5.00). Automatically adjust the clock to daylight saving time changes by selecting the automatically adjust clock for daylight saving changes option in the Time Zone tab. These time settings ensure that the Windows and OS/2 events are synchronized.

Configuring Application Network Stations

You can configure your computer as an application network station, as described below. You can also query the status of a station with Application Language.

▶ To configure network stations:
Select the Network menu in the Application Studio. The following options are available:
- Local Station Tab and Network Properties This dialog box enables you to configure your computer as either a SCADA or View station. It has the following tabs:
  - General Tab where the network can be activated and other general parameters defined.
  - Local Station Tab where the station's name and ID are defined and where the network is defined as a Management View or Backup station.
- **Protocol Tab** where the type of protocol used is defined.
- **Internet Tab** where the maximum time a message is delayed and number of messages that can be delayed are defined.
- **Backup Tab** where the backup mode and properties are defined.
- **Recording Remote Data** This dialog box records remote tags and alarms.

### Configuring an Application Server Station

A station is defined as an application server automatically according to the plug, however the station name and station ID must be defined in the same way as for the SCADA station, as described below.

### Configuring SCADA and VIEW Stations

When configuring a SCADA station, specify a unique name and a unique ID number for your station. It is recommended to keep a 10 number gap between different station IDs. For instance, if one ID is 80, the next ID should be 90, and so on. The range for ID numbers is 1 through 999.

Before configuring a SCADA station verify the station's name so that you can give your SCADA station a unique name.

*Note: SCADA and VIEW stations require a security plug.*

- **To define your computer as a SCADA/VIEW station:**
  1. In the Network dialog box scroll to open the Local Station tab.
2. In the Station Name field, specify a unique name for the station.
3. In the Station ID field, specify a unique ID number for the station.
4. Leave the Management View and Backup station fields empty.
5. Click OK to save your definitions and to close the dialog box.
6. Restart the application to implement the changes.

**Querying the Status of a Station with Application Language**

The status of a station can be queried through the $BACKUP Application Language variable. The $BACKUP variable represents the status of the backup station:

- When this variable is set to 1 - the station is in Backup or passive mode.
- When the variable is set to 0, the station is in Master or active mode.

*Note: Do not assign $BACKUP to a tag through the application language. Since application language runs on both the Master and Backup stations - the assignment statement of WIL5 $BACKUP is executed twice. Once by the Master WIL5, and the other by the Backup station's WIL5, thus not giving a true picture of the situation. For more details refer to Chapter 27, Application Language.*

**Configuring a Hot Backup Station**

*Note: Not enabled for the web.*

The Hot Backup configuration is based on a pair of SCADA stations: One operates as a master and the other serves as a standby or backup. If the Master station fails, the Backup station takes over.

A Backup station can also operate as a VIEW station, serving as an additional station for displaying and controlling the process on the Master station.

When configuring stations, no application station may have the same name as a Backup station with the '2' appended. For instance, if a Backup station is named Silo, no other application station on the network can be named Silo2.
To define a station as a Hot Backup station:

1. In the Network Properties dialog box Backup Tab Hot Backup Mode field select either:
   - Auto - which is the default switch option.
   - Manual - which enables activating the backup station regardless of the state of the Master station.
   - Disabled - which disables the switching option.
2. If TCP/IP protocol is used add the backup station's IP address to the master station in the Network Properties Backup tab TCP/IP Address field.
3. Exit the application on the Master station and copy all the Master station application files to the Backup station.
4. Run the application.
5. From the Network menu of the Application Studio, select Local Station Configuration. The Local station configuration dialog box opens.
6. Return to the Local Station dialog box and check the Backup Station checkbox. The Backup Parameters field opens.
The following options are available:

**Checkup rate**
Specifies the times per seconds (1/sec.) at which the Backup station will check if the Master station is still functioning.

**Share history files**
Specifies that the Backup and Master station both share the same history files (LRM, HIS). Both stations have the same tag history path and use a file server or peer-to-peer connection. This option is recommended when historical data is critical.

**Update history of Primary**
Updates the Master or main station with the data logged in the Backup station.

7. (Optional) If you are configuring the backup station as a VIEW station, leave the above options blank, and click OK.

8. In the Network Properties dialog box Backup Tab Hot Backup Mode field select either:
   - Auto - which is the default switch option.
   - Manual - which enables activating the backup station regardless of the state of the master station.
   - Disabled - which disables the switching option.

9. If TCP/IP protocol is used add the Master station's IP address to the backup station in the Network Properties Backup tab TCP/IP Address field.

10. Enter your specifications. Click OK to save them and close the dialog box.

**Notes:** Only tag historical data can be transferred to the Master and not alarm history. A Master station is automatically updated with the online data (tag values and live alarms) when it becomes active. Alarm history, recorded by the Backup station during the Master station fail-time, will not be transferred to the Master station after the master restarts. If neither of the procedure options is selected, each station, when active, will record historical data independently, and no historical data will be transferred between the two stations. The Backup station can only be manually activated using the WizSetBackup ModeAPI in an add-on. Restart the application for changes to take place.
Updating an exiting Hot Backup application

Both master and backup stations must be identical. The procedure below ensures that the tags file in the master and the backup station will always be identical. This is a must for master/backup applications.

Procedure to add/change tags to an existing Hot Backup application:

1. Exit from the application in the backup station.
2. Add or change the new tags in the master station.
3. Copy the files to the wizdata.mdb file to the backup station.
4. Run the application in the backup station.

Configuring a Management View Station

Note: Not enabled for the web.

Configuring a management view station is similar to defining a SCADA station

To configure your station as a Management View station:

1. Load the application without a plug.
2. From the Network menu of the Application Studio, select Local Station Configuration. The Local station configuration dialog box appears:
1. In the Station Name field, specify a unique name for the station.

2. In the Station ID field, specify a unique ID number for the station. Keep a 10 number gap between different station IDs. For instance, if one ID is 80, the next ID should be 90. Range for ID numbers is 1-999.

3. Select the Management View checkbox. The Management View Parameters are displayed in the dialog box.

4. In the Server station field, click on the arrow to the right and select a server station to indicate that requests for data from the local station will be directed to the application server.

5. Click OK to save your definitions and close the dialog box.
Recording Remote Data

In addition to application server stations, both SCADA and VIEW stations are also able to record remote tags and alarms.

You can simulate the connection to a remote station that is not running. This enables you to work with remote tags, alarms and images to help you when developing the local station application.

To specify remote tags and alarms for recording in your local database:

1. From the Network menu select the Record Remote Data option. The Define remote data to record dialog box opens:

2. Select the remote station for which you want the tag and alarm data to be recorded, and activate the OK button to save your settings and close the dialog box.

3. Restart the application for your changes to take affect.
To change the recording specifications of a remote station:

Select a station in the list box and activate the Change button. The Define Data To Record From Station dialog box opens:
The following options are available:

**Record Tags**

Specifies the tags that are to be recorded in the local database. Select to configure the tag recording parameters as follows:

**Tag name:** Specifies the tag that you want to record. Click on the arrow to the right of the field and select a tag or enter a name prefix so that all the tags beginning with the prefix are recorded.

After you specify a tag, activate the Add button to add the name to the list.

To delete a tag from the list, select the name you want to delete in the listbox and activate the Delete button.

**Record Alarms**

Specifies the alarms that the application should record in your local database. Select to configure the alarm recording parameters, as follows:

Specify values in the following filter fields, so that only the alarms that meet these specifications will be recorded in your local database. These values will appear under the Filter column in the Define Data To Record From Station dialog box, shown on the previous page.

**Minimal Severity**

**Maximal Severity**

**Family Prefix**

**First Zone**

**Last Zone**

These filter fields together with the Class button are similar to the specifications defined for the Events Summary. Refer to Display, in the Chapter 22, Event Summaries.
Network Simulation Option

The Network Simulation option allows you to simulate the connection to a remote station that is not running. This enables you to work with remote tags, alarms and images to aid in developing the local station application.

► To implement network simulation:

1. Copy the application files of the remote station to a directory on a server drive, or your local hard disk.

2. Create a text file called NETSIM.DAT, as follows:

   STATION_NAME  ID  PATH
   Where:

   STATION_NAME is the name of the remote station with which the connection will be simulated.
   ID is the station ID.
   PATH is the path specifying the location of the remote station's application files. This file must be located in the local application directory.
   For example:  SCADA01 110 S:\APPLICATION\REMOTE

Network Properties

The Network Properties menu enables you to set your network environment and establish maximum application performance, and to enable or disable specific functions.

► To define network properties:

Double-click the Network icon in the Control Panel.

Or,

From the Network menu of the Application Studio, select Network Properties. The Network dialog box opens in which you can:

- Determine if the application network module is loaded, enabling you to access application stations on the network, in the General Tab,
- Determine a network protocol to be used by the application, in the Protocol tab.
- Optimize network use in the Internet tab.
- Determine the Hot Backup switching mode in the Backup tab.
General Tab

You can determine if the application network module will be loaded in the General tab of the Network dialog box.

The following options are available:

**Activate Network**

Specifies that the network is activated. Select to activate.

**Message control**

The following options are available:

- **Maximum Network Answer Time Delay**: Defines the amount of time that a query waits for an answer from a remote station.

- **Maximum Network Time Delay**: Determines the maximum time interval that a station will delay before updating the other stations with tag and alarm changes. The default time is 1000ms.

- **Maximum Network Changes Delay**: Determines the maximum number of messages that a source station accumulates before it sends the data buffer to a target station. The default is 48 messages.

*Note: Restart the application for changes to take effect. As soon as either of the two settings reaches the defined value, the data buffer will be sent.*
**Local Station Tab**

The Local Tab is used to define the station name and ID number and whether it is a Management or Backup station. In the Network dialog box scroll to open the Local Station tab.

1. In the Station Name field, specify a unique name for the station.
2. In the Station ID field, specify a unique ID number for the station. Keep a 10 number gap between different station IDs. For instance, if one ID is 80, the next ID should be 90. Range for ID numbers is 1-999.
3. Either select the Management View checkbox to open the Management View Parameters field and then do the following:
   - In the Server station field, click on the arrow to the right and select a server station to indicate that requests for data from the local station will be directed to the application server.
   - In the Station Name field, specify a unique name for the station.
   Or,
   - Check the Backup Station checkbox to open the Backup Parameters field which has the following options:
     - Checkup rate Specifies the times per seconds (1/sec.) at which the Backup station will check if the Master station is still functioning.
Share history files Specifies that the Backup and Master station both share the same history files (LRM, HIS). Both stations have the same tag history path and use a file server or peer-to-peer connection. This option is recommended when historical data is critical.

Update history of Primary Updates the Master or main station with the data logged in the Backup station.

4. Click OK to save your definitions and close the dialog box.

**Protocol Tab**

You can select either the NetBIOS or TCP/IP network protocols in the Protocol tab of the Network dialog box.

1. Click on the network protocol to be used by the application. The default network protocol is: TCP/IP.
2. If relevant, click the Show Popup Window on Communication Errors checkbox to define that a popup window opens for a communication error in another station.
3. To enable an application station to communicate with application stations on other LANs, specify the addresses of the remote stations in a text file called OTHERNET.DAT.

Sample OTHERNET.DAT file
Below is a sample OTHERNET.DAT file.

193.32.3.65
193.32.3.66
194.49.5.132

The above station IP address lines enable a network station using one of these addresses to communicate with other stations using the same addresses.

Note: Restart the application for changes to take effect.

**Internet Tab**

You can optimize Internet access in the Internet tab of the Network dialog box.

Determine lower values for the settings in this dialog box so that the application will send smaller packets of data more frequently, updating application Java applets faster.
The following options are available:

**Maximum time a message could be delayed**
Specifies the maximum time interval that a server will delay, before updating the Wizlets with tag and alarm changes. The default value is 100ms.

**Maximum number of messages delayed**
Specifies the maximum number of messages that a server accumulates before it sends the data buffer to the Wizlets. The default value is 48.

*Note: The data buffer will be sent once either of the two settings reaches the defined value. Restart the application for changes to take effect.*

### Backup Tab

For details regarding Hot Backup and the Backup Tab see page 23

1. In the Backup Tab Hot Backup Mode field select either:
   - **Auto** - which is the default switch option.
   - **Manual** - which enables activating the backup station regardless of the state of the Master station.
   - **Disabled** - which disables the switching option.

2. If TCP/IP protocol is used add the backup station's IP address to the master station in the Network Properties Backup tab TCP/IP Address field.
3. Exit the application on the Master station and copy all the Master station application files to the Backup station

4. Run the application

**Application TCP/IP Support**

Present connectivity needs cause organizations to combine desktop workstations, servers, and hosts into Local Area Networks (LANs), and enable even remote locations to access these networks. These LANs connect with other LANs and Wide Area Networks (WANs), and enable any pair of systems to communicate when they need to, regardless of their location in the network.

Transmission Control Protocol/Internet Protocol (TCP/IP) is a communications protocol that provides effective and reliable communications between computers in a network, and also between different networks.

Industrial uses of TCP/IP include transferring data between two networks in an organization. A large plant complex may have a network at one site whose stations communicate with stations on a network in a different part of the complex.

This section describes the following:

- TCP/IP Software describes the software you need to install on your system.
- Application configuration describes how to configure your application network for TCP/IP.

**TCP/IP Software**

The TCP/IP software you need to install on your system is the Windows network protocol you are using.

To locate it, click the Start button, pointing to Settings and select Control Panel and then double-click on the Network to open the Network dialog box.

For further information, refer to the Windows Readme file. In TCP/IP configurations, the IP addresses of the stations on the network are made up of 4 digits identifying the LAN and specific station on the network. During TCP/IP configuration, the IP Addresses and Broadcast Addresses should be defined according to the needs of your system. No special TCP/IP address configuration is necessary for your application.
For application stations to be able to communicate on TCP/IP networks, the IP addresses must be defined with the first 3 numbers identifying the LAN and the last number identifying the specific station.

*Note: The application will not support different configurations.*

**Application Configuration**

The application network is configured for your TCP/IP, as follows:

1. **To configure the application network for your TCP/IP:**
   1. Install Windows NT or Windows 2000 TCP/IP on all stations. To test the communication, use the Ping utility from the TCP/IP folder.
   2. In the Tuning Parameters utility, set the NET_PROTOCOL parameter to NPITCP. To return to NetBios support, set the NET_PROTOCOL parameter to NPINTBS, or delete the line NET_PROTOCOL=NPITCP from the wiztune.dat file.
   3. Specify the Broadcast Address of the remote stations in a text file called OTHERNET.DAT, as shown on the following page, so that an application station can communicate with other application stations on other LANs,
   4. Set the NET_HOTBACKUP_ADDR parameter to the IP address of Backup, so that a link is established between a Master station and its Backup station. For example:
   ```
   NET_HOTBACKUP_ADDR= 193.32.3.65
   ```
   5. Access the Tuning Parameters utility of the Backup station and set the NET_HOTBACKUP_ADDR parameter to the IP address of the Master.

*Note: Tuning Parameters are described in more detail in the Tuning Parameters appendix.*
Application Backup - Principles of Operation

The Backup station and the Master station always have the same status of tags and alarms. This is executed in the following way:

**Tags**
- When a tag is changed at the active station, a message is sent to the passive station notifying of a tag change, with the ID of the tag and its new value. The passive station receives the message and performs WizPutGateVal in memory only mode.
- When a tag is changed from the passive station, the request is routed to the active station where it is written to the PLC or to memory (depending on the type of the tag). The active station then informs the passive station that a tag was changed (as in case 1).
- When a passive station is first loaded, it requests an update of all tag values.

**Alarms**
- When an alarm is generated in the active station, the active station informs the passive station that an alarm was started. The forwarded information includes all that is needed to start the same alarm on the Backup station. The passive station receiving notification from the active station starts the alarm using an internal API similar to WizStartAlarm. Further changes to the alarm generated in the active station are passed to the Backup station using the alarm ID and the event that occurred. (Ack/End/Class/Text changed).
- When a request to Start/Ack/End an alarm on the passive station is made, the passive station routes the request to the active station. The passive station will show the result of the request after it receives the notification from the active station.
- When the passive station starts, it requests the status of all active alarms at the Master station, builds an Alarm id on active station to Alarm id on passive station translation table, and brings the passive station to the same status.
**Failure Detection and Reaction**

In automatic switch Backup mode, the backup station periodically checks the connection with the master station. The frequency of the check is user defined. For more details about fine-tuning, refer to the Tuning Parameters appendix.

During communication test failure with the Master station, or if the Backup station was switched to active mode (in manual switch backup mode), the Backup station broadcasts a Backup is Active message to the network.

When the remote stations receive the message they:

- Update their internal stations database with the information that the Master station is now replaced by the Backup station.
- Disconnect the session with the Master station.
- Reconnect to the Backup station.
- If the local station was a client with alarms and tags on the Master station, it re-registers as a client for the alarms and tags at the Backup station.
Chapter 17 Users Timetable

About this chapter:

- Users Timetable Overview on page 17-2 discusses the basic User Timetable options.
- Customizing the Users Timetable on page 17-4 discusses how to create a personalized teams schedule.
- Selecting the Schedule Time Frame on page 17-6 discusses how to create time frames.
- Scheduling Teams on page 17-9 discusses how to create a team schedule.
**Users Timetable Overview**

The Users Timetable module enables efficient management of the application's workforce teams. Using this module, teams can be selected and scheduled in a calendar environment, which can be either: daily, weekly or yearly. For further timetable management efficiency each team can be allocated a specific color.

Commands and options in the Users Timetable module are performed through the module's menu bar, toolbar or by right clicking in the timetable.

Timetable intervals can be locked or unlocked. This could be to reserve time period cells for scheduled teams or for defining public holidays and so on.

▶ **To access the Users Timetable:**

In the Quick Access Bar click the icon. The Set Users Timetable dialog box opens.
**Menu bar**

The Users Timetable menu bar has the following options and commands:

**File**
- Save
- Print
- Exit

**Edit**
- Select all
  - Clear - which has the following sub options:
    - Clear all
    - Clear selected
    - Clear row
    - Clear column

**View**
- Fit to view all
  - Gridlines - which has the following sub options:
    - Both
    - Vertical
    - Horizontal
    - None

**Options**
- Team Name
- Week Separator
- Set time intervals
- Stop marking
- Headers font
- Colors
### Toolbar

The Users Timetable toolbar icons have the following options and commands:

- ![Icon](image)
  - Save current group timetable
- ![Icon](image)
  - Print current group timetable
- ![Icon](image)
  - Clear group timetable
- ![Icon](image)
  - Insert row to the timetable
- ![Icon](image)
  - Remove the row from the timetable
- ![Icon](image)
  - Set timetable interval
- ![Icon](image)
  - Lock selected cells in the timetable
- ![Icon](image)
  - Unlock selected cells in the timetable
- ![Icon](image)
  - Toggle stop/start marking in the timetable

### Customizing the Users Timetable

The Users Timetable fonts and colors can be customized to meet your personal requirements. Additionally rows and columns can also be added or removed.

**To customize the timetable font:**

1. In the Options menu select Headers Font. The Font dialog box opens.
2. Select and define the font type, style and size.
3. Click OK to confirm.
To customize timetable colors:

1. In the Options menu select Colors. The Colors dialog box opens.

2. Click the dropdown menu in each field to display a color palette. Select the relevant color.

3. Click OK to confirm.

   Note: When a group with teams is selected for the first time the teams are assigned random colors.

To customize timetable gridlines:

1. In the View menu select Gridlines. The Gridlines sub menu opens.

2. There are four options:
   - Both - displays both horizontal and vertical gridlines
   - Vertical - displays vertical gridlines only
   - Horizontal - displays horizontal gridlines only
   - None - displays no gridlines
► **To insert time rows:**

1. Click the **Insert** icon or right click in the table area to open the popup menu and select Insert time row. The Insert New Time dialog box opens.

2. Using the arrows scroll up or down to define the new time.

3. Click OK to confirm. A new row with the new time will be added to the table.

► **To remove time rows:**

Select the specific row and then click the **Remove** icon or right click in the table area to open the popup menu and select Remove time row. The time row is removed.

### Selecting the Schedule Time Frame

The Users Timetable has three time frames each of which changes the appearance of the table. The frames are:

- Daily - displays a 24 hours work schedule
- Weekly - displays a weekly work schedule
- Yearly - displays a monthly schedule with upto 31 days per month

*Note: The start day can only be set in a weekly time frame whereas start and end times can be set in all time frames. The Daily/weekly/Yearly Schedule field is activated only after a group with teams is selected.*
To customize a time frame:

1. In the Options menu select Set Time Intervals or click the Set Time icon. The Set Time Intervals dialog box opens.

2. In the Time Interval field define the period of time that each time cell represents. The default is 60 minutes.

3. In the Day Start At and Day Ends At fields use the arrows to scroll and define the new time. The default is 00:00.

4. Select the day of the week that the timetable begins.

   Note: The Yearly Schedule field at the bottom of the dialog box is for reference purposes only.
Yearly Schedule

The Yearly Schedule displays a month by month view of the yearly calendar. In turn, each month can be split into weeks.

To customize a yearly time frame:
1. In the Select Group field click the dropdown arrow to open the groups/teams list.
2. Select the relevant groups and then in the field above select Yearly schedule.
3. To select a month either click the month fields arrow to open a dropdown list or scroll backwards/forwards using the Forwards/Backward arrow buttons.
4. To select a year click the Year field's arrow and scroll down to select the relevant year.
5. Click the This Month button to display the current month's calendar.
6. If you have made changes to the User Timetable and wish to return to the timetable that is currently saved in the database click the Default Schedule button.

To customize a weekly calendar in a yearly time frame:
1. In the View menu select Week Separator. The timetable is marked with weekly gridlines.
To lock/unlock time intervals:

1. Select the specific time cell and then click the Locked icon. The selected time cell will be locked.

2. To unlock a time cell select the relevant cell and click the Unlocked icon.

Note: This option is only available in the Daily and Weekly options. Time cells can only be locked when the Stop Marking option is on. Locked Time cells remain locked even when the group changes.

Scheduling Teams

Teams are groups of users defined in Alert Groups. When an alarm is generated and targeted to a specific group of users, the team that is scheduled in the Users Timetable at that specific time will receive the alarm.

Note: Users/Groups/Teams are created in the User Management module. See Chapter 7, Security and User Management.

To schedule a team:

1. Click the Select Group dropdown list to display all the application's Alert Groups. A + sign to the left of the group's name indicates that the group has teams.

2. Click the relevant team. The team will now appear in the List of Teams.
3. To change the team color code, right click on the specific team to open the Change Teams Color dialog box, and select a color. The team's color identifier will change to the selected color both in the List of Teams and in the Users Timetable.

4. To schedule a team, select a team and in the Users Timetable click the relevant table cells. The cells will be painted the team's color identifier and the name of the team will appear in the cell.

► **To print a user timetable:**

1. To print a timetable either click the Printer icon or select Print from the File menu. The Print option dialog box will open.

2. Check that the Printer parameters are correct and Click OK.

► **To save a user timetable:**

To save a timetable either click the Save icon or select Save from the File menu.

**Mark/Stop Marking Options**

Time cells can be automatically marked according to row, column or specific cell. The Stop Marking option prevents time cells that are not included in a team's time scheduling from being marked.

► **To activate/deactivate the marking option:**

1. In the Option menu check that the Stop Marking option is not activated. Or, click the !Toggle icon.

2. Select the team for which the time cells are allocated.

3. Select the first time cell and then right click to open a popup menu.

4. Select either Mark Entire Column or Mark Entire Row accordingly.

5. To deactivate the Marking option either; click the icon or from the Options menu select Stop Marking or right click in the Users Timetable to open the dropdown list and select Stop Marking.

*Note: Stop Marking is deactivated when a new team is selected.*
Chapter 18 Introduction to the Image Module

About this chapter:

This chapter is an introduction to the Image Module as follows:

Images Overview on page 18-2 discusses the basic Image options.
Getting Started on page 18-2 discusses the basic parameters required for creating an image in the Image module.
Image Properties on page 18-3 discusses how to predefine the Image Window parameters.
The Image Window on page 18-12 discusses the Image interface, its toolbar, menu bar and various operational toolboxes.
Basic Image Module Concepts on page 18-16 discusses the various Image module concepts.
Images Overview

Images are dynamic graphic representations of industrial processes. Tags in an industrial process can be represented by an image object and each object can represent specific process values. Together they can display a dynamic picture of the work process.

Images can be saved into HTML pages and be viewed from remote stations over the Internet. Using the Goto Zone function, operators can receive alarms showing a graphical image of the cause of the alarm.

Images can be imported, inserted or attached to a project from other projects or locations. Graphics can also be saved in Cluster Libraries and be used to create multiple projects.

The Layers functionality enables users to zoom in and out of an image for a more detailed view. Different operators can view different layers, a feature which is useful for work efficiency and security.

Getting Started

This section discusses basic work principles for creating an image.

There are two work modes available, where each mode when selected, opens showing different functions on the computer screen. These modes are:

- **Edit** - this mode is used for designing and editing images. This mode opens displaying the Drawings, Colors, Objects and Operations toolboxes. The Navigate toolbars can be activated in this mode enabling the user to move within the image and/or zoom in and out of it.

- **Trigger on** - when the Trigger mode is set to ON, objects defined as trigger objects can be used for tag input. When this mode is OFF, no objects (even those defined as Trigger objects) can be used for tag input. The Navigate toolbars can be activated in this mode enabling the user to move within the image and/or zoom in and out of it.
**Image Properties**

Image Properties are used to define the properties of the image.

▶ **To access the Properties dialog box:**

In the All Containers section right-click Images and select Properties from the popup menu. The Image Properties dialog box opens. This dialog box has the following tabs:

- **View** - where image window view properties are defined.
- **Loading** - where the amount of memory available for Image objects is defined
- **Trigger** - where the parameters for trigger objects are defined.
- **Rates** - where image update performance in milliseconds and the size of the internal message buffer that images use to collapse tag/alarm notification message is defined.
- **Fast Zone** - where the period of time (in ms) for "slow" zones is defined.
- **Dynamic** - where the blinking rate values for dynamic objects are defined.

**View**

This tab is used to define the properties of the Image window, repaint and resolution level.
The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image position remains when adding/removing toolbars and menus</strong></td>
<td>When checked, this defines that the position of the image object does not change when adding/removing toolbars and menu bars.</td>
</tr>
<tr>
<td><strong>Repaint images after editing operations</strong></td>
<td>When checked this field defines that an image will be repainted automatically after actions that may alter the image (such as, moving, copying) are performed. This option is useful in small and medium zones.</td>
</tr>
<tr>
<td><strong>Resolution factor</strong></td>
<td>Sets global stretching or shrinking factors applicable to all images. This is required to solve display differences caused by replacing an operating system, monitor or other H/W or to move between resolutions.</td>
</tr>
<tr>
<td><strong>Number of gradient color steps</strong></td>
<td>This field determines the number of steps used when drawing objects filled with gradient color. The default is 16. Drawing large gradient surfaces in many steps may be slow therefore, develop using few steps and then increase for run-time.</td>
</tr>
<tr>
<td><strong>Advanced button</strong></td>
<td>Displays the Image Window Attributes dialog box where window attributes are defined.</td>
</tr>
</tbody>
</table>

*Note: When changing the Resolution Factor the window remains the same size in pixels. However a centimeter in one image will not be a centimeter in another. The image remains unchanged when the value is 1. Values greater than 1 expand the image.*

**To set correct application values:**

1. Load the image in a PC and measure an object's length in the image (a line will do).
2. Load the same image in another PC and measure the same object's length.
3. Divide the first length by the second length and the result is the xx.xx value.
4. Enter the IMG_RESFACTOR with the value you found and reload the application.
   The range is 0.1<=IMG_RESFACTOR<=10.
   The default value: 1
5. Restart the application for changes to take effect. The range of the factor is $0.1 < \text{IMG\_RESOLUTION\_FACTOR} \leq 10$.

**Setting Image Window Attributes**

Click the Advanced button in the View tab of the Properties dialog box.

*Note: Image Windows Attributes is not applicable on the Web.*

![Image Window Attributes dialog box]

Each listed attribute can be set to On or Off. When confirmed, the selected attributes will apply to all future windows of the type specified. The following options are available:

- **Title bar**
  The line in the window holding the title. This is relevant only if the Title bar is active.

- **Name in title**
  Title bar text.

- **System menu**
  The menu that opens when clicking on the top left corner of a menu. The menu options are: Move, Size, Close.

- **Min/Max button**
  This option defines whether the min/max buttons will appear in the Image window.

- **Size Border**
  Specifies that window border size can be changed by clicking and dragging.

- **Menu Bar**
  Specifies that the menu bar will open in the Images window.

- **Always on Top**
  When selected the image is displayed on top of other applications.
Pos  Specifies X and Y coordinate in pixels.
Size  Specifies window size in pixels.
Title Bar Text  Specifies the name appearing in the title bar.

Note: The system menu is title bar dependent. Its corresponding checkbox is unchecked and disabled. If the menu bar is not selected but the system menu is, the menus and items included in the Menu bar will appear in the system menu.

Loading
This tab determines the amount of memory available for image objects. It also enables/disables tag name parsing when loading images and determines the mode in which the image will open.

Note: Setting the amount of memory available for image objects is not applicable on the Web. Always restart the program after updating this tab.
The following options are available:

**Images memory pool size**
Enables large images with many objects to be created, but allows only 10 (+-) Image windows to be open at one time. The lower the value, the more Image windows that can be opened simultaneously (they must be smaller in size). The value for the parameter can be set from 60 to 200.

**Parse each image when loading**
Enables or disables tag name parsing when loading in the Images module. Disable this option to shorten image load time for images that contain network tags. When this option is disabled network tags validity is not checked. Therefore, use this option after all tag definitions in the network station are complete.

**Open new image in Navigation mode**
This checkbox defines that the new image will be opened in Navigation mode.

**Trigger**
This tab defines trigger objects and onmouseover properties.
This tab holds the following fields:

**Trigger object**
Determines whether trigger objects are highlighted when selected. If this option is checked, trigger objects will be outlined (with dashed lines) when they are selected. The default option is not selected.

**Mouse pointer on triggers**
Determines whether the mouse pointer will be highlighted when it is moved on top of a trigger object in an image. The default option is not selected.

**Trigger small input box**
When checked, the input box when defining data entry for triggers, will be small and will only have a field for entering the value.

**State**
Determines which trigger object is activated when overlapping triggers are clicked. This could be either; Top (default) or Bottom.

*Note: Always restart the program after updating this tab.*

**Rates**

*Note: The Image Rates Properties is not applicable on the Web.*

This tab determines the image update performance in milliseconds. It also defines the size of an internal message buffer that images use to collapse tag/alarm notification messages received by WizPro.

![Image Properties Tab](image.png)
This tab has the following fields:

**Image update rate**  
Specifies the image update performance in milliseconds. Specify maximum and minimum rates. The default values are: Maximum = 2000 Minimum = 10.

**Message buffer size**  
Determines the size of the internal message buffer that images use to collapse tag/alarm notification messages received by WizPro. When tag values change, an image receives messages in a buffer from WizPro and updates graphical objects accordingly. The range is 5 to 500 messages. A high value for this parameter improves the performance of images with rapidly changing dynamic objects, so that images will not have to make graphical updates for each value message. The default is 20 messages.

*Note: Always restart the program after updating this tab.*
**Fast Zone**

*Note: Image FastZone Properties is not applicable on the Web.*

This tab determines the period of time (in ms) for "slow zones". A zone is slow if it has a background that takes more than a given period of time to draw. This parameter improves the drawing time for Goto Zone operations by using a cache of memory bitmaps for drawing the background of slow zones.

![Image Properties](image)

This tab has the following fields:

- **Fast zone threshold (msec)**: Specifies the fast zone threshold. If this parameter is set to be 2500 and the background takes 2500ms or more to draw, the zone is considered to be slow. The range is 0 to 1 hour (in ms). The default is 2500ms.

- **Maximum fast zones**: Determines the limit of the number of fast zone bitmaps that can be kept in a single window's memory cache. When a window reaches this limit, the least recently used fast zone bitmap is removed from the cache to make room for the new bitmap. The available range is 0-50. The default is 0 (FastZone disabled).

*Note: This only affects the background of the image. Dynamic elements are drawn as before. Operate only when NOT is Edit mode. Always restart the program after updating this tab.*
**Dynamic**

*Note: Image Dynamic Properties is not applicable on the Web.*

This tab determines blinking rates for dynamic objects. The blink rate is the period of time that the object will appear on the screen, disappear, and then reappear, and so on.

The format of this parameter is from left to right. It is recommended to increase the values for this option if it is anticipated that a large number of dynamic objects on the screen will be updated at once.

This tab has the following field:

**The blinking rate values for dynamic objects (msec)**

<table>
<thead>
<tr>
<th>Fast</th>
<th>Medium</th>
<th>Slow</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>1000</td>
<td>2000</td>
</tr>
</tbody>
</table>

Specifies the fast zone threshold. The values specified for fast, medium and slow are in milliseconds and can be from 50 (1/20 second) to 30,000 (30 seconds). If a value that exceeds these limits is specified then the application will automatically apply the maximum and minimum values instead. The default values are 200, 500 and 1000 ms.

*Note: High blink rates decrease the system's performance. When using the Wiztune.dat file to enter the values, use commas (,) to separate the values. Restart the application for changes to take effect.*
The Image Window

Images are created, edited and viewed in windows that can be moved, sized and closed. The Image window can be operated using standard window techniques, according to the windows specific configuration defined during application setup.

To open an Image window:

Click the New Image icon in the toolbar.

Or,

In the All Containers section, right-click Images, and select New Image from the pop-up menu. The Images interface will open on your screen.

The following screen shot shows an Images window in Edit mode when the Navigate option has been selected.
Title Bar
Displays the title of the image.

Image Region
The work area where the image is designed.

Scroll Bars
The bottom and right edge sliders are used for scrolling horizontally and vertically. The slider position and size relative to the scroll bar, represent the position and size of the window relative to the workspace.

Status Bar
Specifies information of x y coordinates, scale and layers.

Zoom Bar
The left edge slider is used for zooming: Moving up - zooms out Moving down - zooms in

Action Buttons
Buttons located above and below the Zoom Bar, used for viewing operations. These operations include automatic positioning of the Image (a), window selection (w), and Image Redraw (r).

Toolbar
Holds icons which activate the most common functions.

Menu Bar
The Image menu bar contains the following menus and options:

File
Save, Save as, Insert, Import, Attach to, Print, Exit

Edit
Undo/Redo, Copy/Paste to clipboard, Find/Find next, Align, Select, Operator, Options, Drawings, Line type, Set background color, Get/Save background colors

View
Toolbar, Font bar, Status bar, Objects, Operations, Drawings, Patterns, Align, Colors

Layers
Elaborate on, Active layer, Definition, Override show/hide, move objects to active layer

Clusters
Define, Break, Open lib, Rebuild instances, Basket maintenance, Open basket
### Toolbar

The Image toolbar contains the following icons and commands icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Paste</td>
</tr>
<tr>
<td><img src="image" alt="Undo/Redo" /></td>
<td>Undo/Redo</td>
</tr>
<tr>
<td><img src="image" alt="Goto" /></td>
<td>Goto</td>
</tr>
<tr>
<td><img src="image" alt="Goto Zone" /></td>
<td>Goto Zone</td>
</tr>
<tr>
<td><img src="image" alt="Define Zone" /></td>
<td>Define Zone</td>
</tr>
<tr>
<td><img src="image" alt="Edit Zone" /></td>
<td>Edit Zone</td>
</tr>
<tr>
<td><img src="image" alt="Navigate Zone" /></td>
<td>Navigate Zone</td>
</tr>
</tbody>
</table>

**Options**
- Auto window, Goto, Goto Zone, Zones Definition, Repaint window, Simulate, Force dyn show, Mark triggers, Styles definition

**Modes**
- Edit, Navigate, Trigger on, Copy on, Grid setup, Snap to grid, Grid show

**Help**
- Image module Help files.
Additional toolboxes can be activated/deactivated in the View menu. The following options are available.

- **Objects** - enables definition of image objects such as Alarm, Trigger, Dynamic, Cluster Definition, Group, Slider, Media Player and Scheduler.

- **Operations** - includes Rotate, Pick Color, Active Layer, Toggle Fill, Cluster Library, Send to Back, Bring to Front, Delete, Grid, Snap to Grid and Copy Paste Attributes.

- **Drawings** - contains simple drawing objects such as Line, Pipe, Box, Text, and Circle. Both filled and unfilled objects can be selected. The selection and text tool are also included in this toolbox. The Widget option holds the Slider, Media Player and Scheduler options.

- **Patterns** - contains 16 different fill patterns, including solid and transparent. The Image drawing patterns also support 32 gradient styles. The first color used for the gradient is the foreground color, while the last color used is the background color.

- **Align** - enables alignment of two or more selected objects. The objects can also be centered or resized horizontally, vertically or both. The objects can also be arranged so they are equal distances from each other, either vertically or horizontally.

- **Colors** - includes 32 colors for background and foreground (text). A left mouse click selects the line color while a right mouse click selects the fill color.
Opening Existing Files

Image files are opened from the Application Studio.

To open an existing Image file:

From the File menu of the Application Studio, select Open. In the dialog box that is displayed, select the file to be opened. Image files have the extension *.VIM.

Or,

Select the relevant file from the List of Images in the Application Studio. When a file has been selected and confirmed, the image will be opened.

If an image with an undefined tag is loaded, an error message will appear with a reference to a file called imgname.mis, where imgname will be the name of the Image that was loaded. The .mis file can be opened for further information using any text editor. The file includes the name of the undefined tag and its type (dynamic or trigger).

Basic Image Module Concepts

Active Layer

An image is made up of layers and is built one layer at a time. A layer being worked on is referred to as the active layer. The layer that always exists by default is called the base layer.

The active layer name is displayed in the window title together with the Image name and the current scale.

Mouse Buttons

Generally, the left button is used to draw objects. Click the left button on specific points in the image to start and end objects. The right button is generally used to cancel operations or complete them.

Cursor

When a drawing operation is selected, the cursor will take on the appearance of the icon representing the operation that was selected.
**Filling**

Any figure can be filled with a pattern. A pattern is structured as a foreground (text) color over a background color. A transparent attribute can also be selected. Open figures will be filled up to the line connecting the endpoints of the figure.

**Orientation**

Some figures are drawn in an orthogonal orientation (only in the horizontal, vertical, or 45-degree directions). Once such a figure is drawn, it can be rotated to any angle.

**Attributes**

Each figure (circle, square, polygon, and so on.) is assigned a set of attributes, including colors, filling and patterns.

An important drawing feature is that once a figure with specific attributes is drawn, each time that the operation is selected again the figure will be drawn with the same attributes.

**Continuous Design**

After an object is drawn, a new object with the same attributes can be drawn immediately without selecting the operation again.

**Multiple Windows**

Several Image windows may appear on the screen simultaneously. One toolbox of each type will appear for each different Image. For example, if you opened three windows for the same image called DEMO, one toolbox of each type will serve all three windows.
**File Management**

Normally an Image window and image are the same. The file name for both are identical except for the extension. The Image module will automatically open/save both files as required.

When saving an image for the first time the Save As dialog box opens where files can be saved in the following formats:

- Image*.VIM
- Bitmaps *.BMP
- ASCII*.ILS

**Image Limitations**

The following lists the technical specifications of the Image module:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Coordinate space</strong></td>
<td>2,000,000 x 2,000,000 pixels</td>
</tr>
<tr>
<td><strong>Number of static elements</strong></td>
<td>100,000</td>
</tr>
<tr>
<td><strong>Number of dynamic elements</strong></td>
<td>10,000</td>
</tr>
<tr>
<td><strong>Number of zoom scales</strong></td>
<td>2,048</td>
</tr>
<tr>
<td><strong>Number of zones</strong></td>
<td>500</td>
</tr>
<tr>
<td><strong>Number of layers</strong></td>
<td>64</td>
</tr>
</tbody>
</table>
Chapter 19 Image Editor

About this chapter:

This chapter describes the Image Editor, as follows:

Overview on page 19-2, provides an overview of the Image Editor.

Basic Principles on page 19-2 describes some of the basic concepts used for Image design.

File Menu on page 19-6 describes the options in this menu.

Edit Menu on page 19-10 describes the options in this menu.

View Menu on page 19-33 describes the options in this menu.

Layers Menu on page 19-40 describes the options in this menu.

Cluster Menu on page 19-44 describes the options in this menu.

Options Menu on page 19-60 describes the options in this menu.

Modes Menu on page 19-72, describes the options in this menu.
Overview

The Image Editor is the graphic tool of the application. It is used to create and view the images that enable the operator to visualize part or all of a control process.

The Image Editor operating in an Image window defined during application setup includes a wide variety of drawing tools that make image design quick and easy. Any drawing in this window can be zoomed and scrolled.

Objects created using the Editor can be linked to tags, so that as the values of a tag change, the objects linked to the tag will change accordingly. In addition, objects can be defined as triggers for tag value input.

Image Editor operations can be performed only by operators that have the appropriate authorization level permission. While some operators may be authorized to design and view images, others may only be able to view them. In addition, each object in an image has its own authorization level.

The following basic activities can be performed using the Image Editor:

- **Image Editing** - Image design.
- **Image Animation** - Associating Image objects and dynamic properties with tags and modifying their values.
- **Image Navigation** - Navigating within an image.

Basic Principles

This section describes some of the basic concepts used for image design that should be understood before using the Image Editor.

Objects

Objects are geometric figures or text that together make up an image. Objects that are geometric figures can be either open or closed, and can be filled with specified patterns and displayed in unlimited colors.
In addition to the standard object design features, the following features are also available:

- Objects can be defined as Groups, Dynamic, and Triggers.
- The Cluster Library contains defined objects that can be used in any image. Library clusters can be defined to include one or more existing image object.
- An image can include widgets (slider scale objects and Media Player) to enable fast and simple tag value changes. Widgets are custom designed and can be placed anywhere within the image.
- Image objects can be associated with alarms.

**Drawing Space**

An image is drawn in a drawing space measured in drawing units. This measurement can be useful when moving throughout the drawing space and determining object sizes.

The drawing space is from -1,000,000 to +1,000,000 drawing units.

**Image Window**

An image is held in an image window. The part of the image that is displayed in the window depends on the window size, image size, and zoom level.

**Fast Actions**

Fast Actions are predefined macros that can be attached to triggers to enable you to perform routine operations. These include:

- **CloseActiveImage** - used to close the currently opened Image file.
- **CloseChart** - used to close a specified Chart file.
- **CloseEventSummary** - used to close a specified Events Summary file.
- **CloseImage** - used to close a specified Image file.
- **GotoUrl** - after this trigger option is defined for an Image object when the object is clicked it will jump to the defined URL.
- **LoadAnnFile** - used to open a specified Events Summary Profile file, or an Event Summary file.
- **LoadHtmlPage** - used to load a specified HTML page.
- **LoadImage** - used to open a specified Image file, window and zone.
- **LoadPictureFile** - used to open a specified image window.
- **LoadRecipe** - used to load the recipe to apply its tag values to the image
- **LoadTrendFile** - used to open a specified trend file.
- **LockTagsValues** - used to open the Tag Value Lock window where you can lock/unlock tags and change the locked tags definitions.
- **OpenScheduler** - used to jump from the Image to the Internet Scheduler
- **SaveRecipe** - used to save the recipe tag values to the image

*Note: In this version a recipe description that has been defined in this trigger cannot be modified.*

**Lock Object**

This option defines that a selected image object when locked cannot be moved from its location. When a locked object is copied onto the clipboard the copied object is unlocked while the original object remains locked.

**Zoom Level**

The zoom level determines how the image will be viewed. The smaller the zoom level the closer and larger the image.

Any zoom level can be assigned from 1 to 2048. At a zoom level of 64, each drawing unit is 0.01 mm on a standard monitor.

**Layers**

An image is structured in layers. Each layer contains a part of the overall image. When the drawing is completed the layers can be merged. Each individual image layer can be made visible or hidden. Layers can be added or changed, but not removed.

**Zones**

Zones are predefined positions in the image window.
Goto Zones

The operator with the relevant authorization can, using the Goto Zone option, jump to any defined zone from anywhere in an image. The Goto Zone dialog box is used to enter the coordinates of the location to which to jump in the image. Any position in the image can be jumped to whether or not that position is defined as a zone.

Zone Navigator

The Zone Navigator is a global, multi-image zone navigation window that enables you to quickly and efficiently navigate through a list of zones defined in the application's various image files. A number of navigators each of which can contain a number of zones from one or more different image files can be defined in the module.

Toolboxes

The following toolboxes can be activated in the View mode. When the Image window definition is to open with Navigate Mode On, the Drawing, Operations, Options and Color toolboxes will also open.

Image Files

There are three file extension types:

- Image *.VIM
- Bitmaps *.BMP
- ASCII *.ILS

By default image files are saved as *.VIM.

ASCII Files

By default images are saved in .VIM files. You can, however, also save images as ASCII files, which can then be edited and loaded in the Image window.

Image ASCII files can be useful for the following purposes:

- Viewing: Saving images in ASCII format enables you to obtain documented records of the images so that they can be viewed by opening the file with any text editor.
This option provides the illustration designer and plant engineer with a powerful image-debugging tool.

The ASCII format enables images to be converted easily from/to other formats and be used as drawing objects.

This option also enables you to draw Images by editing text files. This can be useful when you are working outside the application environment, or want to create an image without physically drawing it.

Images in ASCII format can be used for numerous purposes, to enhance Image creation and modification capabilities.

Images saved as ASCII (.x.ILS) files can be loaded in the same as any other image.

**Bitmap**

A bitmap is a graphic format informing the application to consider the graphic element (text or drawing) and its background as a solid unit.

**File Menu**

The Image File menu has the following options:

**Save**
Select this option to save the current image file with its original name.

**Save as**
Select this option to save the current image file with a new name.

**Insert**
This option allows you to insert an existing image file into an existing Image window.

**Import**
An image file that has been saved as an ASCII file can be imported into the image. This file can then be viewed and edited.

**Attach to**
The File Attach to menu allows you to attach an image (*.VIM) to an existing window. This replaces the image in the window. The VIM file is modified to reflect this change.
New Image Files

New Image files are opened from the Application Studio.

To open a new Image file:
From the File menu in the Application Studio, point to New and select Image.
Or,
Press Ctrl + N.
Or,
In the Container List of the Application Studio Containers right-click Images and select New Image from the popup menu. A new Image is displayed with the default Image properties.

Open Files

Image files are opened from the Application Studio.

To open an existing Image file:
From the File menu of the Application Studio, select Open. In the dialog that is displayed, select the file to be opened. Image files have the extension *.VIM.
Or,
Select the relevant file from the List of Images in the Application Studio. When a file has been selected and confirmed, the Image will be opened.
If an image with an undefined tag is loaded, an error message will appear with a reference to a file called imgname.mis, where imgname will be the name of the image that was loaded.
The .mis file can be opened for further information using any text editor. The file includes the name of the undefined tag and its type (dynamic or trigger).
Saving Files
When saving the image for the first time, the Save As dialog box with the extension of *.VIM opens in the default directory for the image.

► To save an Image as an Image file:
1. Select Save as to open the Save as dialog box.
2. Select Image from the Save as type list. The file is saved with the *VIM extension.

► To save an Image as a Bitmap:
1. Select Save as to open the Save as dialog box.
2. Select Bitmap from the Save as type list. The file is saved with the .BMP extension.

► To save an Image as an ASCII file:
1. Select Save as to open the Save as dialog box.
2. Select ASCII from the Save as type list. The file is saved with the .ILS extension.

Deleting Files
Images are deleted from the Application Studio.

► To delete an Image file:
Select the image name from the List of Images in the Application Studio. Right-click on the file you wish to delete and select Delete from the popup menu.

Inserting Files

► To insert an image:
1. Select Insert from the File menu. The Open dialog box opens.
2. Double click the relevant file from the list. The file contents will be merged into the currently opened image file.

Note: Imported objects will be placed in the layer to which they belonged in the source image (according to the ordinal number of the layer and not the layer name), or in the current layer if the layer to which they belonged does not exist in the target image. The same applies for text in different fonts.
Importing Files

The Import option enables you to import or load an image file that has been saved as an ASCII file (*.ILS) into the Image window. This file can then be viewed and edited.

▶ To import an Image as an ASCII file:

1. Select Import from the File menu. The Open dialog box opens.
2. Double click the relevant file from the list. The file contents will be imported into the currently opened image file.

Note:
Imported objects will be placed in the layer to which they belonged in the source Image (according to the ordinal number of the layer and not the layer name), or in the current layer if the layer to which they belonged does not exist in the target Image. The same applies for text in different fonts.
Images that were saved as ASCII (x.ILS) files can be loaded in the same way as any other image.
For more information see Appendix G, ASCII (ILS) File Format for the structure and format of an ILS file.

File Attachment

The Attach to option enables you to attach an Image (*.VIM) to an existing window. This replaces the image inside the window. The VIM file is modified to reflect this change.

▶ To attach an image file:

1. Select Attach to from the File menu. The Open dialog box opens.
2. Double click the relevant file from the list. The file contents will be imported into the currently opened image file.
**Printing Images**

Images are printed from the Image file menu.

➢ **To print an Image file:**

Select Print from the File menu. The Print dialog box is displayed:

1. To send the Image to a file in the bitmap format
2. Select the Bitmap option and specify the filename.

**Edit Menu**

The Image Edit menu is the graphic tool of the application and is used to create and view the images enabling you to visualize part or all of a control process. The following options are available:

- **Undo/Redo**
  - Undo/redo the last action.
- **Copy/Paste to Clipboard**
  - Copy/paste data between applications.
- **Copy/Paste Attributes**
  - Copies/pastes attributes from one object to another.
- **Edit Properties**
  - Edit drawing objects and clusters. Attributes such as line and fill color, existing dynamic definitions and trigger definitions can be modified.
- **Find**
  - Find and go to an object that matches the search text.
- **Find Next**
  - Search for the next occurrence of the last search string.
- **Align**
  - Align two or more objects at right top or bottom. Center or resize horizontally, vertically or both.
- **Select**
  - Select objects in the image.
- **Operations**
  - This option when selected enables editing and animation operations in an Image.
**Drawings**
This option when selected enables you to draw and add text by using the polyline, box, circle, pipe, text, and pick color tools or assign trigger objects with the button tool. The media player or slider properties can also be defined.

**Set Background Color**
This option when selected sets the image background color.

**Get Colors**
This option when selected retrieves customized colors.

**Save Colors**
This option when selected saves customized colors.

**Undo/Redo**
The Undo and Redo operations are available for Image drawing operations. This applies to actions such as delete, scale, rotate and change attributes (color) of an object. The Undo command reverses or deletes the last entry.

Immediately after you undo an action, the Undo command changes to Redo, enabling you to restore what you reversed. Up to 50 levels of Undo/Redo operations are available.

**Copy/Paste to Clipboard**
The Clipboard is a convenient way to transfer graphic objects from the application to external applications, vice versa, and from one image to another. This option is only available when the Edit mode is activated.

**Copy/Paste Attributes**
This feature supports the following:
- **Object** - line and fill color
- **Text** - font style, size, color and background color
To copy/paste an attribute do the following:

1. In an image select an object/text. In the operations toolbox click the Copy/Paste Attributes button.

2. Click on another object/text in the image. Each time you click an object/text the attributes of the copied item will be pasted in to it.

3. Right click anywhere in the image to end this process.

Note: An object's attributes can be applied by clicking each object individually. Copied attributes can only be pasted into the same object/text type. This means that attributes copied from text cannot be copied into objects. The Copy Attributes button is only enabled when an object/text is selected. Text attributes cannot be pasted into object attributes and vica versa.

Copy/Paste Attributes for Grouped Objects

This option is available for a group of objects.

Each individual object in the group may have different attributes, (which will remain the individual object's attribute after being grouped). However the attribute of the group will be the same. For example the object color and fill of the group is green while each individual object within the group has a different color and fill.

Using the copy/paste button, the object group can be selected and its attributes pasted into an object out of the group.

Note: The attribute of a group/selected list that has both text and objects cannot be copied and pasted into another object.

Image Parameters

This format is used by to create image objects. Each object in an image includes several parameters (such as dynamic, trigger, etc.). These parameters inform the application how the object behaves.

If this format is used, when transferring an object from/to the clipboard the object will include other Imaging parameters information.
**Bitmap**

A bitmap graphic is captured by pixels. In a Copy to Clipboard operation, the application copy's the selected object(s) in all of the formats. During a Paste from Clipboard operation, the application will paste the clipboard object first in the image parameter format. If the object is not in this format it will be pasted in bitmap format and if this fails the object will not be pasted.

*Note: If you paste an object from the clipboard, the imported object will be placed in the current active layer.*

When a text object is pasted from the clipboard and the original font of the object you pasted does not exist in your system, the object will appear in the current active font.

The following editing operations can be applied to objects pasted from the Clipboard to a image:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Bitmap</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move</td>
<td>Yes</td>
</tr>
<tr>
<td>Size</td>
<td>Yes</td>
</tr>
<tr>
<td>Rotate</td>
<td>No</td>
</tr>
<tr>
<td>Fill</td>
<td>No</td>
</tr>
<tr>
<td>Color</td>
<td>No</td>
</tr>
<tr>
<td>Dynamic</td>
<td>Yes</td>
</tr>
<tr>
<td>Trigger</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Bitmap Transparency Dialog Box**

This dialog box is used to change color transparency of an Image bitmap.

► **To access the Transparency dialog box do the following:**

1. From the Drawing Tool bar click the Picture icon and then click in the Image drawing area. The Select Picture window opens.
2. Double click on a bitmap image. The image will open on your screen.
3. Right click anywhere in the image and then select and double click the imported bitmap. The Transparency dialog box opens.
4. Check the Use Transparency field to activate the Selected Color fields.
5. In the color fields define the required transparency.
6. Click OK to save.

► To copy an object from an image to the Clipboard:
Select an object(s), and then select Copy to Clipboard from the Edit menu, or click the <Ctrl-Insert> key combination.
Or,
Select an object and then right click to open a pop up menu and select Copy to Clipboard.

► To paste an object from the clipboard to an image:
1. Select Paste from Clipboard in the Edit menu, or press the <Shift-Insert> key combination or select an object and then right click to open a pop up menu and select Paste to Clipboard.
2. To paste the object do either:
   - Double-click on the point in the image where you want the object to appear. The object will automatically be pasted at the location you selected in its original size.
   - Click once to set the size and location of the object. You can then define the area that the graphic object will fill, using an outline box. After the initial click, simply move the outline box, by moving the mouse, to the end point of the object, and click again.
Note: If you start by clicking on a high point, and move down and click on a lower point, the graphic object will appear upside-down (unless that object is in the bitmap format).

**Edit Properties**

The Edit Properties dialog box is used to modify selected objects.

► **To open the Edit Properties dialog box:**

Select Edit Properties in the Edit menu, or select an object and then right click to open a pop up menu and select Edit Properties.

This dialog box has the following options:

- **Objects List**
  
  This section displays a tree of the object according to hierarchy.

- **Object Properties**
  
  This section shows the object selected from the Objects List.

- **Definition**
  
  This button when clicked is used to modify dynamic tag parameters and is only available for objects such as button, alarm or text. It is not available that are defined as basic objects.
Triggers

Trigger objects are objects that you can click on to cause pre-defined tag values to be set automatically or manually, cause the image to go to a pre-defined zone, or cause pre-defined macros to be activated. Any object can be defined as a trigger object. However, only one tag value input method can be assigned per object.

The tag value input method that you select in the dialog box will be marked by an arrow. The Data Entry, Bit, Smooth, and Test the last position of the dialog box will be saved (unless you activated the Cancel button before completing the operation). This means that you can drag the dialog box to any position on the screen, and thereafter, whenever the dialog box will be invoked, it will appear in its last position. However, the dialog box position is relative to the window position. If the window is moved and then the dialog box is invoked, it will appear in the position it was last saved, relative to the new location of the window.

For Text Table objects, the String button will appear in the Input Method field instead of Data Entry.

For Time objects, the Time button will appear in the Input Method field instead of Data Entry.

For Date objects, the Date button will appear in the Input Method field instead of Data Entry.

To define a trigger

Select the object you want to define as trigger, and then Right click the selected object. Select Trigger Definition from the popup menu.

Or,

From the Edit menu select Operations, then click on the Trigger option.

Or,
From the Objects toolbar select the Trigger tool. The Trigger Object Definition dialog box opens:

1. Select the station to which the tag associated with the trigger object is attached.
2. Select the tag associated with the trigger object, or click the browse button to open the Tag Definition dialog box where you can define a new tag.
3. Select the trigger object Input Method. Several tag input methods can be used for trigger objects. To test an input method, tag value variations can be simulated.

The tag value input methods include the following:

**Action**

When the operator clicks on an object, a present value is applied to the tag, or a pre-defined macro is activated. This method is valid for all tags and objects.

**Buttons**

When the operator clicks on an object, a set of buttons with present values appears. Activating a button causes a value to be applied to the tag, or a pre-defined macro to be activated. This method is valid for all analog and digital tags.

**Bit**

When the operator clicks on an object, On, Off, and Toggle buttons appear. This method is valid for all tags and objects (except string tags).

**Data Entry**

When the operator clicks on an object, a dialog box appears to specify a numerical tag value. This method is valid for all tags and objects besides Text Table objects.
4. Click the Set Macro button to define macros for trigger objects (note that Set Macro is not supported on the Web).

5. Click the Test button to test the input method and adjust its appearance. In addition you can move the numeric keypad to any location on your screen. When you re-open the application and operate the keypad, it will be opened at the same location as you selected.
**Fast Actions**

Fast Actions are pre-defined macros that can be attached to a trigger, enabling you to easily execute routine operations.

*Note: Fast actions are Web enabled.*

► **To define Fast Action triggers:**

1. Click the Fast Action button on the Trigger Object Definition dialog box. The List of available Fast Actions dialog box is displayed.

   ![List of available Fast Actions](image)

   Select the Fast Action you want to attach to the trigger:

   - **CloseActiveImage** - used to close the opened Image file.
   - **CloseChart** - used to close a specified Chart file.
   - **CloseEventSummary** - used to close a specified Events Summary.
   - **CloseImage** - used to close a specified Image file.
   - **GotoUrl** - after this trigger option is defined for an Image object when the object is clicked it will jump to the defined URL.*
   - **LoadAnnFile** - used to open a specified Events Summary Profile file or an Event Summary file. *
   - **LoadHtmlPage** - used to load a specified HTML page. *
   - **LoadImage** - used to open a specified Image file, window and zone.
   - **LoadPictureFile** - used to open a specified image window. *
- **LoadTrendFile** - used to open a specified trend file. *
- **LockTagsValues** - used to open the Tag Value Lock window where you can lock / unlock tags and change the locked tags definitions.
- **Open Scheduler** - used to jump from the Image to the Internet Scheduler
- **SaveRecipe** - used to save the recipe tag values to the image

2. Click OK to define the selected Fast Action Parameters.

*Note: * indicates that when Load in the same window (Web only) is checked a new page in the Explorer is not opened, however the current page is changed to the selected one.

### Find\Find Next

The Find option is used to search and jump to an object that matches the search text. This feature is available in Edit mode only. The Find command opens the Find dialog box while Find Next searches for the next occurrence of the last search string.

A search string can be of upto and including 256 characters. Search options are common for all Image windows

*To open the Find/Find next dialog boxes:*

Select Find/Find next from the Image Edit menu or press the following keys:

- **Ctrl F** = Find
- **F3** = Find next

Clicking the Advanced button in the Find dialog box opens the lower section of the dialog box showing the advanced search options. If a search fails, a notification message is displayed with the searched string.
The Find in Image dialog box has the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple text</td>
<td>Check this checkbox if the Find field is in simple text.</td>
</tr>
<tr>
<td>Tag name</td>
<td>This includes tag names in Dynamic object, Tag value, Trigger, Text table and Widgets.</td>
</tr>
<tr>
<td>Alarm family</td>
<td>As defined in alarm object.</td>
</tr>
<tr>
<td>Match case</td>
<td>The search is made for full matching letter cases; otherwise, strings are compared ignoring the case.</td>
</tr>
<tr>
<td>Match whole word</td>
<td>The search is made to find the exact full text, all characters are accounted for. Otherwise, the search is made to find the occurrence of the search string inside any text.</td>
</tr>
<tr>
<td>Only in visible view</td>
<td>If this option is checked, the search is limited to the visible part of the Image inside the Image window.</td>
</tr>
<tr>
<td>Trigger macro name</td>
<td>The name of the macro that a trigger activates.</td>
</tr>
<tr>
<td>Trigger zone name</td>
<td>The name of the zone that a trigger jumps to.</td>
</tr>
<tr>
<td>Trigger button</td>
<td>Any name in a trigger button including title and legend on each button.</td>
</tr>
<tr>
<td>Cluster instance</td>
<td>The instance name of a cluster.</td>
</tr>
<tr>
<td><strong>Cluster library</strong></td>
<td>The library name of cluster instance.</td>
</tr>
<tr>
<td><strong>Cluster object</strong></td>
<td>The cluster object name as appearing in the library.</td>
</tr>
<tr>
<td><strong>Text table value</strong></td>
<td>The current string value matches the search string.</td>
</tr>
<tr>
<td><strong>String tag value</strong></td>
<td>The current string tag value matches the search string.</td>
</tr>
<tr>
<td><strong>Goto object</strong></td>
<td>Checks that the application will automatically navigate to the found object and bring it into the middle of the current window; scale will not be changed.</td>
</tr>
<tr>
<td><strong>Always Goto object</strong></td>
<td>The application will jump to the found object, even if it already appears in the visible part of the Window.</td>
</tr>
<tr>
<td><strong>Smart order</strong></td>
<td>Performs a geometric search. The image is searched from 'left to right' in strips of the same size of the current open view. In many cases, such a search is more intuitive, especially if the image is divided into zones with a corresponding layout. If this option is not checked, the search is simple, meaning that the search is by the order of objects in the image, from the first object created to the last one.</td>
</tr>
</tbody>
</table>

*Note: For Text table and String tag the Simple text option must be also checked. If searching for trigger zone or macro the search is also made in trigger buttons for a match. Options can be set independently.*
Aligning Objects

The Align option is used to align objects with other objects or to resize objects.

▶ To align objects:

Select Align in the Image Edit menu or activate the Align toolbox by checking Align in the View menu. This menu has the following options:

- Align objects by their left edges.
- Align objects by their right edges.
- Align objects by their centers (vertically).
- Align objects by their middles (horizontally).
- Align objects both horizontally and vertically.
- Align objects by their tops.
- Align objects by their bottoms.
- One or more objects can be resized to the same width.
- One or more objects can be resized to the same height.
- One or more objects can be resized to both same height and width.
- Objects can be arranged (distributed) so they are equal distances from each other horizontally.
- Objects can be arranged (distributed) so they are equal distances from each other vertically.

Note: The Align feature does not support the Undo option.
Select Options

There are three Select Options:

- Select
- Deselect Last
- Deselect All

1. To select several objects simultaneously using the left mouse draw a rectangle around the relevant objects.
2. To add a new object to already selected objects press the <Shift> key and click a new object.
3. Deselect objects by clicking on an empty part of the image area or select Select/Deselect Last/All.
4. Deselect the last selected object by pointing to Select in the Edit menu and selecting Deselect Last.

Note: Right-clicking sets the object automatically to select mode and cancels the move operation.

Drawing Options

The Drawings toolbox options are used to design image objects. Line, Pipe, Box, Text and Circle.

Both filled and unfilled objects can be selected. The selection and text tool are also included in this toolbox.

- Filled/empty rectangle or square
- Filled/empty circle
- Filled/empty ellipse
- Filled/empty arc
- Filled/empty orthonogal polygon
Filled/empty polygon
Filled/empty orthogonal pipe
Pipe
Orthogonal polyline
Text
Polyline
Picture
Button

**Drawing Lines and Segmented Shapes**

This section describes how to draw with the following group of tools:

► **To draw:**

1. In the Drawings toolbox, click the appropriate shape.
2. Click the left button on the start point.
3. Click the left button on successive end points.
4. Click the right button and the last point will automatically be connected to the start point, closing the polygon.
5. Right-click in the Image to deselect the tool.

If you click the right button before starting to draw, the Select tool will be activated.
To create an arc:
Click on a line end while holding down the <Shift> key. The line between the last two points will be marked by the system as an arc, which can then be adjusted to the required radius and set by clicking the left button.

Drawing Rectangles and Ellipses

To draw:
1. In the Drawings toolbox, click the appropriate shape.
2. Position the mouse pointer where you want to start drawing.
3. Drag diagonally.
4. Release the mouse button.
5. Right-click in the Image to deselect the tool.
If you click the right button before starting to draw the select tool will be activated.

Drawing Arcs

Note: The angle of an arc or closed arc may be affected is the arc is scaled.

To draw an arc:
1. In the Drawings toolbox, click on the appropriate tool.
2. Position the mouse pointer where you want to start drawing, drag to the end point and then release the mouse button.
3. Move the mouse to the desired radius point and left-click the mouse button.
4. Right-click in the Image to deselect the tool.
**Drawing Pipes**

*Note: The width of the pipe can be controlled using the plus (+) and minus (-) keys at any stage during the drawing process.*

- **To draw a pipe:**
  1. From the Drawings toolbox, click on the appropriate pipe tool.
  2. Click the left mouse button on the start point.
  3. Click the left mouse button on successive end points.
  4. Right-click when the shape is complete.
  5. Right-click in the Image to deselect the tool.

**Text**

This section describes how to insert text into an image:

- **To use the text tool:**
  1. From the Drawings toolbox, click on the text tool.
  2. Enter text in the Text dialog box. Click OK. The text will appear at the specified location on the screen.

The other Text Types field is used for the dynamic display of tag values. When the text is entered and confirmed, it will appear at the specified location on the screen.

**Font Style Selection**

In the application any text object, simple, tag value or text table, can have its own font style. The Font bar reflects the font style that is going to be used for the next text object.
It also reflects the font style of the current selected, single, text object. Changing the font style while a single text object is selected will change that object's style. Predefined text styles can be used for easy uniform texts as labels, titles and so on.

It is possible to set a style to text and then change only part of the style properties. If a style is changed, all texts with that style are changed in any property that was not modified for that text. The text object colors are selected and set as any other object.

**To define font styles:**

1. From the Options menu, select Styles Definition. The Styles Definition dialog box is displayed:

   ![Styles Definition Dialog Box](image)

   2. Click the Add button to open the Style Properties dialog box.

   ![Style Properties Dialog Box](image)
3. Specify the required font style from the following options and click OK to save your definitions and close the dialog box.

**Style name**  
Selected from list. Reflects the font style that is going to be used for Text objects. Predefined text styles can be used for easy uniform texts as labels, titles and so on.

**Font Face Name**  
Can be bitmap or TrueType - selected for available fonts (system dependent). List of available system fonts.

**Font size**  
For bitmap fonts you can select from sizes available for that face name. If another value is entered, the Image will use the best fit. In TrueType fonts size 14 is translated as 1,000 word units on scale of 64.

**Effects**  
Select from the following options: Bold: (font dependable), Italic, Underline and Strikethrough.  
*Note that Underline and Strikethrough are not applicable on the Web.*

**Sample Text**  
Type any text to obtain an example of the way the text will appear in the Image. The text example that you type appears in the example box below this field.
You can activate the Properties button in the Font Styles Definition dialog box to reopen the Font Properties dialog box where you can change your font definitions.

It is important to note that when using bitmap fonts, since these fonts cannot be scaled or rotated, changing the zoom does not change the size of the font. It is recommended to place bitmap text in layers using only one scale level.

**Modifying Text**

Text in an image can be edited by selecting the relevant text and then activating the Text tool in the Drawing toolbox.

▶ **To modify text:**

1. Select text and click the Text button. The Modify Text dialog box is displayed:

   ![Modify Text dialog box](image)

2. The text you selected to edit will appear in the Text field.

3. Change the text and activate the OK button to cause the new text to replace the old text.

For tag value, text table, or date/time text, the appropriate dialog is displayed in which you can change the text attributes.
Specifying Line Properties

An image can be drawn using different types of lines. The following line widths are supported: 1, 2, 4, 6, 8 and 10 pixels.

► To specify the line width/type:
1. Select the line you want to modify.
2. Select the Line type button in the Image toolbar, or select Line Type from the Edit menu to open the Lines dropdown list.
3. Select a line type the original line will change to the selected line.

Colors

This application has full color support that is limited only by your computer's operating system and hardware.

Double-clicking on any color in the Color toolbox opens a common color dialog box where colors can be selected to customize your toolbox.

Setting the Image Background Color

The Set Image Background feature enables you to set the image background color.

► To set the background color:
1. From the Edit menu select Set Background Color. The Color dialog box opens.
2. Select a color and click OK. The background of your image will display the selected color.
**Saving and Getting Colors**

The *.pal file contains the 16 toolbox colors as well as the additional 16 custom colors from the Color dialog box. Once you define or customize your colors, you can save them in a *.pal file.

*To get saved colors:*

From the Edit menu select Get/Save Color. The Color dialog box opens. The Color dialog box is displayed where you can select the colors from a *.pal file.

If the Image file name and *.pal file name are the same, the *.pal file is loaded automatically. You can then continue to work with the customized palette every time you open an Image.

**Pick Color Tool**

Select the Pick Color tool in the Operations toolbox for filling or drawing objects with the exact color used in a different object.

The Pick Color tool enables you to take a color sample from an area of an image to designate a new line color or fill color.

*To select the line or fill color using the Pick Color tool:*

1. Select the drawing tool of your choice.
2. Select the Pick Color tool, and then place the dropper icon on any point in the image over the desired color.
3. Draw your new object and the object fills with the selected color.
4. To select a new line color, in the Color toolbox, click the required color. The toolbox resets to the last drawing tool that was used, and the color becomes the default color for that drawing tool.
5. To select a new fill color, in the Color toolbox, right click the required color. The toolbox resets to the last drawing tool that was used, and the color becomes the default color for that drawing tool.
**View Menu**

The View menu activates/deactivates the Image module's toolbar, status bar and unique toolboxes. To activate/deactivate an option click the specific menu item in the View menu.

**Toolbar**
- **Toolbar**
  Defines that the toolbar is activate in the Image window.
- **Font bar**
  Defines that the font bar is activate in the Image window.
- **Status bar**
  Defines that the status bar is activate in the Image window.
- **Objects**
  Defines that the Objects toolbox is activate in the Image window.
- **Operations**
  Defines that the Operations toolbox is activate in the Image window.
- **Drawing**
  Defines that the Drawing toolbox is activate in the Image window. The drawing tools enable the user to draw and edit images. Also included is the Widget option and a trigger button.
- **Patterns**
  Defines that the Patterns toolbar is activate in the Image window.
- **Align**
  Defines that the Align toolbox is activate in the Image window.
- **Colors**
  Defines that the Colors toolbox is activate in the Image window.

**Toolbar**
The Image toolbar contains the following icons and commands icons:

- ![Save](Image)
- ![Print](Image)
- ![Copy/paste](Image)
Font Bar

The Font bar enables you to set the text font style for any text object, simple, digital or text table. This toolbar includes the font name, size, direction and different text effects. The text can be bold, italic, underscored or strikethrough.
**Status bar**

The Image module Status bar displays the coordination scale and layer of the image object.

**Objects Toolbox**

- Alarm Definition
- Trigger Definition
- Dynamic Definition
- Cluster Definition
- Group
- Slider
- Media Player
- Scheduler
Operations Toolbox

- Rotate
- Pick color
- Active layer
- Toggle fill
- Cluster library
- Send to back
- Bring to front
- Delete
- Grid
- Snap to grid
- Copy attributes

Patterns Toolbox

The Patterns toolbox contains 16 different fill patterns, including solid and transparent. The Image drawing patterns also support 32 gradient styles. The first color used for the gradient is the foreground color, while the last color used is the background color.
Gradient fills are supported for the following objects: Text, Filled box/circle, Polygon.

Note: Pipes do not support Gradient fills.

**Align Toolbox**

The Align toolbox enables you to align two or more selected objects. They can be aligned to the left, right, top, or bottom. Objects can also be centered or resized horizontally, vertically or both. The objects can also be arranged so they are equal distances from each other, either vertically or horizontally. See Aligning Objects on page 19-23.

**Color Toolbox**

The Color toolbox includes 32 colors for background and foreground (text). A left mouse click selects the line color while a right mouse click selects the fill color. Double-clicking either mouse button opens the Color dialog box, enabling you to customize any color.
Additional Drawing Tips

Moving and Scaling Objects
When an object is selected, eight handles will appear around the object to indicate that it is selected.

► To move an object or group of objects in the Image:
1. Select the object(s) you want to move.
2. Click inside the object (or bounded rectangle for a group of objects) hold the mouse button down and drag the object(s) to the desired location.

► To scale an object or group of objects in the Image:
1. Select the object(s) you want to scale.
2. Click on one of the eight handles of the object (or bounded rectangle, for a group of objects) hold the mouse button down and drag the handle to resize the object(s).

► To resize the object(s) proportionally:
Click and drag any corner handle in a diagonal direction, as in the following illustration:

Note: To terminate a move or scale operation, press the <Esc> key.

Grouped Objects
Grouping objects combines two or more objects into a single object. You can flip, rotate, and resize or scale all the objects in a group as a single unit. You can also change the attributes of all objects in a group at one time. Grouped objects can be edited the same way as any other object, but cannot be nested (a group cannot include another group). A grouped object can also be ungrouped to separate its original elements.

Note: Any object in a segment which is defined as a trigger object, will function in the Trigger mode in the same way as when it is not included in a segment.
Grouping and Ungrouping Objects

- **To group objects:**
  1. Click the select tool and then drag to select the drawing objects you want to group.
  2. Click the button on the Group tool in the Objects Toolbox or, point to Operations in the Edit menu and select Group.

- **To ungroup objects:**
  Select the grouped objects. Click the right mouse button on the grouped objects and select Ungroup from the popup menu or, point to the Operations in the Edit menu and select Ungroup.

Lock Objects

Image objects can be locked and unlocked. A locked object cannot be moved or modified.

- **To lock an image object:**
  1. Select an image object.
  2. Right click to open a popup menu. Select Lock.

Bring to Front/Send to Back

The Bring to Front option enables you to place objects in the front of your Image.

- **To bring objects to the front:**
  Select the drawing object you want to bring to the front and click the Bring to Front tool in the Operations toolbox.

- **To send objects to back:**
  Select the drawing object you want to send to the back and click the Send to Back tool in the Operations toolbox or, from the Operations menu click Send to Back. The selected drawing object is placed in behind other overlapping objects.
## Layers Menu

An image is structured in layers. Each layer contains a part of the overall image. When the drawing is completed the layers can be merged. Each individual image layer can be shown/hidden. Layers can be added or changed, but not removed. The layer that always exists by default is called the base layer.

Each image can consist of one layer (the Base layer) or several layers.

The Layer menu options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elaborate on</td>
<td>If the Elaborating Zoom is On, each layer will be viewed in the scale range assigned when the layer is defined. If the Elaborating Zoom is off, each layer will always appear (even if scaling ranges were not specified for them).</td>
</tr>
<tr>
<td>Active Layer</td>
<td>The active layer definitions sets the parameters for which all subsequent editing operations will be performed.</td>
</tr>
<tr>
<td>Definition</td>
<td>This option opens the Layers Definition dialog box where the parameters for the layer are defined.</td>
</tr>
<tr>
<td>Override Show/Hide</td>
<td>This option when set to hide indicates that a layer will always be hidden, despite the Elaborating Zoom mode setting. Any layer set as hidden is marked with a special arrowhead character. Note that if both Hide and Show attributes are assigned to a layer, the layer will be hidden.</td>
</tr>
<tr>
<td>Move Object to Active Layer</td>
<td>This option is used to move a selected object to the layer defined as active.</td>
</tr>
</tbody>
</table>

---

**Chapter 19 Image Editor**  
**Wizcon for Windows & Internet 8.2**
Elaborate on

Layers can be viewed in the Elaborating Zoom On or Elaborating Zoom Off mode. If the Elaborating Zoom is on, each layer will be viewed in the scale range you assign when you define the layer. If the Elaborating Zoom is off, each layer will always appear (even if scaling ranges were not specified for them).

► To toggle the Elaborating Zoom mode on and off
Select Elaborate On from the Layers menu.

Active Layer

The layer that is worked on is referred to as the active layer. The active layer name is displayed in the window Title bar together with the Image name and the current scale.

► To select an active layer
Select Active Layer from the Layers menu.

Definition

This option when selected opens the Layers Definition dialog box where layers can be defined or modified.

► To define a layer
In the Layers menu select Definition. The Layers Definition dialog box opens.
1. In the Name field type the name of layer.

2. In the From Scale field, specify the lower limit of the zoom level range for elaborating zoom.

3. In the To Scale field, specify the upper limit of zoom level range for elaborating zoom.

4. Click the Group button to open the Access Permission Manager dialog box opens, where you can assign authorized users and groups for this layer.

5. Click the Add button to add your definition to the list of layers.

▸ **To modify a layer:**

1. Select the relevant layer.

2. Modify the layer using the instructions above.

3. Click the Change button for the changes to take effect.

▸ **To remove a layer**

Select the relevant layer and click the Delete button.
Override Show/Hide

You can override the current visibility mode and make a layer visible or hidden. The Layer Override Hide or Layer Override Show dialog boxes are basically identical and enable you to select a layer from the list and make it visible or hidden.

When Override Hide is selected the layer will always be hidden, despite the Elaborating Zoom mode setting. A layer set to show/hide is marked with an forward pointing arrowhead.

Note: If both the Hide and Show attributes are assigned to a layer, the layer will be hidden.

► To open the Layer Override Show dialog box:
From the Layers menu select Override Show/Hide. The Layer Override Show/Hide dialog box opens.

1. Select the layer that you wish to show/hide and then click the Show/Hide button. This layer will always be visible/hidden.

2. Click the Clear button if you want all layers to revert to default visibility.
**Move Object to Active Layer**

This option is used to move a selected object from a layer to the layer defined as active.

- **To move an object to the active layer:**

  Select an object in one layer and then from the Layers menu select Move Objects to Active Layer. The object will appear in the Active Layer.

  *Note: You can select an object and then click the right mouse button on the active layer.*

**Cluster Menu**

A Cluster is an object-class. Clusters can easily placed in an application and be reused as required. Clusters can be small or large. They can be simple, such as circles or pumps, or complex, such as a complete sub-application that includes tanks, pumps and valves.

Once clusters are instantiated in an Image, they can be moved, scaled, rotated, and deleted in the same as any other Image object. To cancel a Cluster definition select a cluster object in the Image and then select Break from the Clusters menu in the Image.

Instances cannot be defined as dynamic, as trigger, or as another cluster (no nesting of clusters), unless they are broken apart.

The Clusters menu has the following options:

- **Define**
  - This option defines clusters and adds them to the Cluster Library

- **Break**
  - This option cancels a selected cluster object in the image

- **Open Lib**
  - This option is used to open a library.

- **Rebuild Instances**
  - This option enables instances to be built automatically after updating the original cluster in the library
The Cluster Library uses object-oriented technology to simplify and speed up application design and maintenance. A Cluster Library holds a number of clusters.

There are two steps for working with clusters:

- Defining clusters and adding them to libraries. This step requires knowledge of all the application components and is usually performed by application designers.
- Using existing clusters and placing them in the application. This requires minimum knowledge of the application and no programming skills.

Once a cluster is placed in an application an instance can be created. One cluster can have many different instances, each with the specific characteristics defined according to the application's needs. The action of creating a separate instance of the object or function is called instantiation. A unique editing feature allows you to modify any object and simultaneously apply the changes to all application diagrams. For example, to modify runtime supervision in a certain pump type, you can redefine the pump cluster in the library and then rebuild all instances of the pump to incorporate the changes made to the cluster definition.

The application includes a set of ready-to-use cluster libraries.

It is recommended to use clusters whenever possible. Working with clusters is much easier than working with graphics, tags, and alarms separately. Besides saving time, you can use an object that has been already approved for work.
**Defining Clusters**

- **To define a cluster and add it to a library:**

Select the graphic object in the image that you want to include in the cluster and then either:

- From the Clusters menu select Define.
- Or,
- Click the Cluster Definition tool from the Objects toolbox.
- Or,
- Right-click and select Cluster Definition from the popup menu.

If no tags or alarms are associated with the graphic objects that are selected in the image (the object was not defined as a dynamic, trigger, or alarm object), the Define Cluster Object dialog box is displayed:

The following options are available:

- **Name** Specifies the name of the cluster (up to 15 characters).
- **Lib** Specifies the name of the library in which the cluster will be placed. To select from existing libraries, click on the arrow to the right of the field.
- **Description** Specifies a brief description of the cluster (up to 40 characters).
- **Add new library to the Cluster folder** Check this checkbox, to add the newly created library to the global Cluster folder (this will enable other applications to use the new library you create).
Note: These fields and buttons appear in the dialog box only if the object is defined as a dynamic, trigger, or alarm object.

**Linked Tags and Alarms**

If the object you selected in the image is associated with tags or alarms (the object was defined as a dynamic or trigger object), the Define Cluster Object dialog box is displayed:

This listbox contains a list of tags and alarms associated with the object you selected, and the type of the object with which the tags and alarms are associated.

The object types, enclosed in brackets (<>), include:

- D for dynamic
- G for trigger
- A for alarm (Not applicable on the Web)
- W for widgets (tag value sliders)
- T for text table
- N for digital, date/time, and string displays
- t for dynamic text tables
To define tags and alarms do the following:

In the Define Cluster dialog box, click the Tags or Alarms button. A new tag/alarm with the modified original tag/alarm definition will be generated during cluster instantiation in the image. The Tag Definition dialog box is displayed. Only tags/alarms that are associated with the cluster objects will appear in the tags/alarms list and only the Change button is enabled.

1. Click the Change button to open the Tag/Alarm Specification dialog box.
2. Complete the fields in this dialog box according to instructions in the Tags and Alarms chapters.

Note: You can also access this dialog by double-clicking on a line in the list.

Special Tokens

In the Tag/Alarms Definition dialog box, you can use special tokens to enable customized tag creation and identification during object instantiation. These tokens can be used in the Tag Name, Address and Description fields to enable customized tag attribute generation.
'[...]' brackets specify an optional parameter.

The following tokens can be used:

$ID(from-to)

The from-to variable represents characters from the data supplied by the operator during instantiation. The following methods can be used for the From-To parameter:

#-# All the characters within the number range specified will be displayed. For example, if the string is ABCDE and 2-4 for From-To is specified, the letters BCD will be displayed.

# The character located at the number you specify will be displayed. For example, if the string is ABCDE, and you specify 3 for From-To, the letter C will be displayed.

#- All the characters from the number you specify and forward will be displayed. For example, if the string is ABCDE, and you specify 3- for From-To, the letters CDE will be displayed.

-# All the characters up to the number you specify will be displayed. For example, if the string is ABCDE and you specify -3 for From-To, the letters ABC will be displayed.

For example, if you specify the tag name ANASID(2-3) in the Tag Definition dialog box and if the operator instantiates the object for which this tag was defined and enters the instance name I02, a tag called ANA02 will be created for that object (the count for 2-3 in I02, is 1=1, 0=2, and 2=3).

For tag address, if, for example, you want the address constant to be 0000, in the Address field of the Tag Definition dialog box, you can choose 0000$ID(2-3). Then if, for example, the operator enters A10 in the instance name, the address of the tag generated upon instantiation of the object would be 000010.

The same applies for Description. For example, if you want the constant valve to appear in the description followed by the valve number, if you use Valve$ID() (where the empty parentheses indicates that all the characters in the operator-supplied name should be used). If the operator enters 12 for the instance name while instantiating the object, the description of the generated tag will be Valve12.

Different combinations of the $ID variable can be used to customize generated tag attributes upon object instantiation.
$ASK("text", [from-to])

For text, specify the text that will appear in the prompt upon instantiation. The from-to parameter is optional and can be used in the same way as described in $ID token.

For example, if you entered $ASK("TAG NAME") in the Tag/Alarm Name field of the Tag/Alarms Specifications dialog box and $ASK("Enter Description") in the Description field, when you instantiate the object in the image, the Instance Parameters dialog box appears:

![Instance Parameters dialog box](image)

If you enter $ASK("Tag Name",1-4) in the Tag/Alarm Name field of the Tag/Alarms Specifications dialog box and $ASK("Enter Description",1-5) in the Description field, when you instantiate the object in the image, the Instance Parameters dialog box reappears. However, only the first four characters of the tag/alarm name and the first five characters of the tag/alarm description specified by the operator are extracted and used.

► **To find an existing tag/alarm:**

1. Click the find button to open the Find dialog box.

![Find dialog box](image)

2. Specify the name prefix of the tag or alarm family that you want to search, and click the Find button.

3. Select Define each Object when Instantiating to define alarms during cluster instantiation in the Image.
Open Lib

This menu option is used to insert an image from an existing Cluster Library into an image.

► **To instantiate a cluster from a library to the application:**

Select Open Lib from the Clusters menu in the Image window.

![Image window](image.png)

*Note:* This window is modeless (meaning that you can perform other application or operating system functions while this window appears on the screen). In addition, the library window can be resized to adjust its height.

1. Specify the library from which you want to instantiate a cluster. To open a list of existing libraries, click on the arrow to the right of the Library field. Double click on a specific cluster to open an information box where the library to which the cluster belongs and further information regarding the cluster is listed.

2. Select the cluster and instantiate it in the image by right clicking on the object and dragging it to the required location in the image.

3. After placing a cluster from a library into an image, the application enables you to determine parameters that are used to generate the instance characteristics. If the cluster is not defined with the Define each Object when Instantiating option, the Instance Parameters dialog box opens. Click the Browse button to locate the tag you want to associate with the instance parameters.
Note: If the cluster contains $ASK variables, this dialog includes the $ASK Parameter field in which you can specify additional user data.

To determine parameters:

1. Enter a unique instance name in the Instance name field.
2. Enter a tag name in the TAG NAME field or click the Browse button. The Tags Identifier dialog box opens:

3. In the Station field, enter a station name, or click the arrow to the right of the field and select the required station from a list of available stations. To associate more than one station to the instance parameters, select another station and click Add. The station is added to the field. To replace stations in the Station field, select a station from the list of stations and click Change. The specified station is added to the Station field, replacing all other stations.

4. In the Tag field, enter a tag name, or click the arrow to the right of the field and select a tag from a list of tags. To associate more than one tag to the instance parameters, select another tag and click Add. The tag is added to the field. To replace the tags in the Tag field, select a tag from the list of tags and click Change. The specified tag is added to the Tag field, replacing all other tags.

If the cluster is defined with the Define each Object when Instantiating option, the Define Instance Links dialog box opens:
The following options are available:

- **Instance Name**: The unique name of the instance in the image.

- **Linked Tags and Alarms**: This listbox contains a list of all the tags and alarms associated with the object(s) in the cluster, and the operation defined for each.

- **Tags/Alarms**: Activate these buttons to change the original definitions of the tags and alarms associated with the objects in the cluster. The tag and alarm definitions that you specify will be used to generate new tags and alarms for the cluster in the Image.

- **Find**: Activate this button to search for a tag or alarm in the Linked Tags and Alarms listbox. In the entry field, you can specify the full name of the tag or alarm, or a name prefix.

### Breaking/Editing Clusters

Clusters can be modified without breaking the cluster. This includes changing tag names and range parameters in dynamic operation. You can also change the fill and line color of the objects. Trigger operations can also be edited.

*Note: Editing allows modifying, but not adding new properties to the cluster.*

- **To Edit Clusters:**
  1. Select the cluster you want to edit.
  2. Right-click the object and select Edit Properties from the popup menu.
From the Edit menu click Edit Properties. The Edit Properties dialog opens.

The Edit Properties dialog displays the structure of the cluster. The dialog box is divided into two frames:

- **Object List** on the left. The Object tree contains the structural makeup of the cluster. For example, the displayed truck consists of dynamic objects, groups, and polylines. Each object can be modified.

- **Object Properties** on the right. When clicking on an object in the Object list, it is shown on the right. The Definitions and Attributes buttons allow you to modify the object. You can also modify triggers with the Trigger button.

*Note: For further information read See Edit Properties on page 19-15.*

**Deleting a Cluster from the Library**

Clusters can be deleted from their library.

1. **To delete a cluster from the library:**
   1. Select the Cluster and the Open Lib menu.
2. In the Library field select the library from which you want to delete the object. Then, select the cluster from the clusters list in the dialog box and press the Delete button on the keyboard.

*Note: Since a library must contain at least one cluster, the last cluster in the library cannot be deleted.*

**Copying Clusters from One Library to Another**

Clusters can be copied from one library to another.

*To copy a cluster from one library to another:*

1. Select the Cluster and the Open Lib menu.

2. In the Library field select the library from which you want to copy cluster. Then select this menu item again.

3. In the new dialog box select the library to which you want to copy the cluster.

4. Then simply drag the cluster from the source library dialog to the target library dialog, and the cluster will be copied.

*Note: Clusters that reside in the same library must have different names. Therefore, if the cluster you want to copy already exists in the target library, you will not be able to copy it.*
Rebuild Instances

One of the big advantages of using clusters is the ability to rebuild all instances automatically after updating the original cluster in the library.

▲ To rebuild the instances in the application:

1. Select Rebuild Instances from the Clusters menu to open the Rebuild Cluster Instances dialog box:

   ![Rebuild Cluster Instances](image)

   In the list, you can see all the instances that were placed in the current Image. Each line contains the library name, the cluster name, and how many instances of that object were placed.

2. Select those items you want to update (note that the list box has multiple selections, and therefore, you can select more than one line in the list), and press the Rebuild button.

Note: The tags and alarms that were associated with each instance will remain unchanged. The Rebuild operation will fail if there is no compatibility between the cluster in the library, and the instances in the Image. Compatibility means that the tags, alarms and triggers must have the same links. For example, you cannot redefine an object that was linked to one tag to be connected to two tags. You can select all items in the list by pressing <CTRL> keys.
Cluster Baskets

The basket is a tool supplying a high level of engineering and application design. It is used to make a prototype of the application before starting to actually implement it, and also to trace the progress of the application development.

When you place an object from the basket to your application, there is one less object that you can take from the basket. If you delete an instance that is a basket item from the application, it will be added to the basket again (as if not taken from there). All the basket operations are also logged in a file called BASKET.LOG, which describes who takes or adds items from and to the application basket, and when.

There is only one basket in the system, which is kept in a simple ASCII text file called BASKET.DAT. This file can be edited using any text editor to ensure simple and fast image design for the application engineers. The format of the BASKET.DAT file is similar to the one that appears in the listbox of the Basket Maintenance dialog box.

To define an application basket:

Select Basket Maintenance from the Clusters menu to open the Basket Maintenance dialog box.
The following fields are available:

- **Name**: Specifies the name of the item as you want it to appear in the basket library.

- **Library**: Specifies the library from which you want to extract the cluster. To select from a list of existing libraries, click on the arrow to the right of the field.

- **Object**: Specifies the name of the cluster as it appears in the library you specify. To select from a list of existing objects, click on the arrow to the right of the field.

- **AmountsFor Required**: Specify the amount of times the cluster object will be available in the basket library. For Used, the value is usually 0 (if you do not fill this field, the default value is also 0). This indicates that the first cluster object in the basket library will be number 0.

- **Cluster Listbox**: A list of existing clusters defined in the basket library.

- **Add**: Activate this button to add the current cluster definition to the basket library.

- **Change**: Activate this button to change the definition of a cluster in the basket library to the current definition.

- **Delete**: Activate this button to delete the cluster from the basket library.
Open Cluster Basket Objects

This option is used to open a cluster basket and import an object into an image.

- **To instantiate an existing cluster:**

Select Open Basket from the Clusters menu. The Drag &Drop to Img dialog box is displayed:

![Drag & Drop to Img Dialog Box](image)

- **To instantiate an object from the library window:**

Click the right mouse button on the object you want to instantiate, and drag the object to the desired location in the image.

Note: In addition to each object in the library, the numbers indicate the amount of required objects that you specify in the Basket Maintenance dialog box and the amount of objects you already instantiated in the Image.
Options Menu

This menu defines image properties and zones that will appear on the operator's workstation.

The Goto, Goto Zone and Zone Definition options are used to define and jump to zones.

- **Autowindow**: This option when selected automatically sets the image window position and zoom level.
- **Goto**: This option opens the Goto dialog box where the coordinates of the location to which you want to jump in the image are defined.
- **Goto Zone**: Using the Goto Zone function, operators can receive alarms showing a graphical image of the cause of the alarm.
- **Zone Definition**: This option when selected opens the Zones Definition dialog box where zone parameters are defined. These zones will appear in the Goto Zone list.
- **Repaint**: Select this item to redraw the current image. This is useful to view the results of editing operations, if they do not immediately appear on the screen.
- **Window**: A window zoom is defined by marking a window in an image. This zoom enables the operator to define a window's contents.
- **Simulate**: Select this option to simulate variations of tag values and observe how the image is affected by each value.
- **Force Zone Dyn Show**: This option when selected causes a dynamic object in an image to appear.
- **Mark Trigger**: This option when selected causes all trigger objects in the window to be marked (or unmarked) on the screen. A red hand will appear in all the trigger objects in the image.
- **Styles Definition**: Select this option to define a font for image text objects.
**Autowindow**

This option automatically sets the Image window position and zoom level, so that all image objects in the window will be arranged.

This function can also be performed by clicking the button on the left side of the Image window.

**Goto**

This dialog box is used to enter the coordinates of the location to which you want to jump in the image. You can jump to any position in the image, whether or not that position is defined as a zone.

▶ **To open the Goto dialog box:**

1. Select Goto from the Options menu or click the Goto icon. The Goto dialog box opens.

2. Enter a scale level between 1 and 2048.

3. Enter the X and Y coordinates, in drawing units.

4. Click OK to confirm.

*Note: In the Image module scale represents the image zoom level. The smaller the scale, the closer the image is. At a scale of 64 each drawing unit is 0.01 on a standard workstation monitor.*
**Goto Zone**

The Goto Zone dialog box enables you to easily jump to any of the zones defined in the Zones Definition dialog box.

- **To jump to a specified zone in an image:**
  
  From the Options menu select Goto Zone
  
  Or,
  
  Click the Go to Zone icon. The Goto Zone dialog box opens.

1. Select a zone and click OK, or double click a zone.

2. The image window will immediately be centered on the zone's central point and the zoom level will be adjusted to the level defined for that zone.

*Note: A pre-defined zone called Previous Zone is included in the zone list. You can goto this zone the same way as any other zone. However, if there is no zone to return to the previous zone item will be disabled.*
Zone Definition

A Zone is a pre-defined position and zoom level in the image that can be jumped to by selecting the Goto Zone item in the Options menu.

▶ To open the Zone Definition dialog box

From the Options menu select Zones Definition

Or,

Click the Navigation mode icon. The Zone Definition dialog box opens:

1. In the Name field type in a unique zone name.
2. In the Central Point field enter the X and Y coordinates, in drawing units, to define the zone center in the image window.
3. In the Scale field type in a level between 1 and 2048.
4. Select the Control tag checkbox if you want to use a digital tag to indicate the zone status. At run-time, if the digital tag value is 1, the zone status will be BAD; if set to 0, the zone status will be GOOD.
5. In the Station field select the station from which you want to select a tag.
6. In the Tag field select the tag you want to use from the drop-down menu, or click the browse button to open the Tag Definition dialog box.
7. Click the Add button to add the zone. The new zone is displayed in the list.
8. Click Save to save the zone definition and exit the dialog box.
To modify a defined Zone parameters:
1. Select the zone you wish to modify.
2. Using the instructions for Zone Definition, modify the selected zone parameters.
3. Click the Change button. The zone properties displayed in the list of zones are modified.

To remove a zone:
1. Select the relevant zone.
2. Click the Delete button.

Zone Navigator
The Zone Navigator is a global, multi-image zone navigation window that enables efficient navigation through a list of zones defined in the application's various image files.

Using the Zone Navigator window a number of navigators each of which can contain a number of zones from one or more different image files can be defined.

The Zone Navigator can be applied on images through button and action type triggers or by configuring an action macro using the Zone Navigation Action macro.

A digital tag representing the zone status of each Zone Navigator can be attached. If the tag value is set to 1 Zone Navigator status will be BAD and if set to 0 Zone Navigator status will be GOOD. Additionally, colors can be defined in which zones with a control tag of BAD status will be displayed in the run-time Zone Navigator window. This option is Web enabled.

To open the Zone Navigators window:
Double click the Zone Navigator icon on the Studio Control panel.

Or,
Select Zone Navigators from the Studio Design menu.

Or,
In the Edit mode right click an object to open a popup menu and select Trigger Definition, Action and then Zone Navigator. The Zone Navigator dialog box opens.
The Zone Navigator has the following fields:

**List of Zone Navigators:** This list displays all the Zone Navigators defined. Each navigator is identified by a unique name and general description.

**New:** Click this button to add a new Zone Navigator.

**Modify:** Click this button to modify the selected Zone Navigator. This will open the New Zone Navigator dialog box where the Name field will appear in gray.

**Delete:** Click this button to delete the selected Zone Navigator.

**Select Color:** Click this button to open the Color dialog box where color indicating zones status can be defined. The default color is red.
To open a new Zone Navigator:

In the Zone Navigator dialog box click New to open the New Zone Navigator dialog box.

The New Zone Navigator dialog box has the following fields:

- **Name:** Unique Zone Navigator name. This can be up to 60 characters including spaces.
- **Description:** Unique description of the Zone navigator. This can be up to 256 characters, including spaces.
- **Enable Tag Control:** This checkbox when checked enables definition of an analog tag that will indicate Zone Navigator status.
- **Station:** Indicating the station from which the Tag is selected.
- **Tag:** Indicating the Zone Navigator Tag.
<table>
<thead>
<tr>
<th><strong>List all Selected Zones:</strong></th>
<th>Displays a list of all selected zones. This list has three columns: Zone Name, Image Name and Control Tag.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add:</strong></td>
<td>This button when clicked opens the Add Zones dialog box which displays a list of defined zones which can be added/removed to the List all Selected Zones.</td>
</tr>
<tr>
<td><strong>Delete:</strong></td>
<td>This option when clicked deletes a selected zone from the List all Selected Zones.</td>
</tr>
<tr>
<td><strong>Move Up</strong></td>
<td>This button when clicked moves a selected line in the List of All Selected Zones up a row.</td>
</tr>
<tr>
<td><strong>Move Down</strong></td>
<td>This button when clicked moves a selected line in the List of All Selected Zones down a row.</td>
</tr>
<tr>
<td><strong>Window Properties:</strong></td>
<td>The following fields define the zone's behavior on the operator's workstation:</td>
</tr>
<tr>
<td><strong>Automatically close window after (Sec):</strong></td>
<td>This option defines that the window will automatically close after the indicated number of seconds.</td>
</tr>
<tr>
<td><strong>Always Select before Opening:</strong></td>
<td>This checkbox when checked defines that this window will be displayed on top of other opened windows.</td>
</tr>
<tr>
<td><strong>Always select before opening:</strong></td>
<td>This checkbox when checked indicates that the user will jump to the zone only after selecting to view it when the alarm is received.</td>
</tr>
<tr>
<td><strong>Open in existing window:</strong></td>
<td>This checkbox when checked indicates that zones will be opened in the same image window, even when they belong to a different image window than the currently opened one. When unchecked, each zone will be opened in the image file in which it was defined.</td>
</tr>
</tbody>
</table>
To Add zones to the Zone Navigator:

Click the Add button to open the Add Zones dialog box:

![Add Zones dialog box]

This dialog box has the following fields:

- **List of All Zones**: This displays a list of all defined zones in the application.
- **Selected Zones**: This displays a list of the zones selected from the List of All Zones.
- **Add/Add All**: Click these buttons to either add a selected zone to the Selected Zones list or click Add All to add all the zones to the list.
- **Remove/Remove All**: Click these buttons to either remove a selected zone from either lists or click Remove All to remove all the zones from the list.
**Repaint**

This option when select redraws the current image. This is useful to view the results of editing operations, if they do not immediately appear on the screen, or to remove undesirable residues that may remain on the screen after editing.

- **To repaint an object:**
  Select the Repaint option from the Options menu.

  Or,

  Click the button on the Image scroll bar.

**Window**

A window zoom is defined by marking a window in an image. This is later used as the window. This zoom enables the operator to define what is to be included in the window.

- **To zoom in to a specific part of the image:**
  1. Click on any location in the image to define the start and end points of the image section you want to zoom in on.
  2. Click in the outlined box, or, click the button on the Image scroll bar.
  3. To move an outlined box, position your cursor on a box border (a multiple arrow cursor appears), click, and drag the box to the new position.

**Simulate**

This option opens the Simulate Tags dialog box, which is used to specify tag values and simulate them for test purposes. After dynamic objects are defined, the operator can test an object's response to different tag values using an application mechanism that simulates tag values without affecting the tag itself.
To simulate tag values:

1. Select Simulate from the Options menu. The Simulate Tag Values dialog box opens.

2. In the Station field click the arrow to open the dropdown list and select the tag station.

3. In the Tag field click the arrow to open the dropdown list or click the Browse button to select the relevant tag.

4. In the New Suggested Value field type in a value.

5. To set the value is click the Apply button, or, use the horizontal scroll bar to immediately set and simulate the specified value.

6. Click the Range button to specify the upper and lower range limits of the tag value to be simulated.

7. Click the Exit button to quit the dialog box and leave the last set value.

Force Zone Dyn Show

This option when selected causes a dynamic object in an image to appear even if the object is hidden.

To define Force Dynamic show

Select an object from the view and then select Force Dyn. Show from the Options menu, right click an object to open a popup menu and then select Dynamic Definition or, click the Force Dynamic Show icon from the Image Main Menu.
**Mark Trigger**

Note: Mark Triggers is not supported on the Web.

Triggers can be marked in Edit mode during image design. When this option is selected all trigger objects in the window are marked (or unmarked) on the screen. After selecting the Mark Triggers option, a red hand will appear in all the trigger objects in the image. The Mark Triggers function will apply to any trigger object.

Note: If an object is marked (with a red hand) to indicate that it is a trigger object, but is dynamically or manually transformed (moved, rotated, scaled, etc.), the trigger mark may disappear or will not appear in its proper location. If this occurs, you can refresh the screen by pressing <Alt-R>.

**Styles Definition**

This option is used to define the image text style.

1. To define text font style:
   1. Select Styles Definition from the Options menu. The Styles Definition dialog box opens.

   ![Styles Definition Dialog Box]

   2. Click the Add button to open the Style Properties dialog box where you can define the new style properties.
3. To change the definition of an existing style select a style from the list click the Properties button to open the Style Properties dialog box. Change the style attributes: size and effect and click the OK button.

4. To Remove a style, select a style from the list and click the Remove button.

**Modes Menu**

This menu sets the operating mode of the window. Several image windows can appear on the screen simultaneously enabling the operator to view and edit separate parts of the same or different images on the same screen. The different modes can be activated/deactivated by selecting/deselecting the relevant mode option.

- **Edit**
  The Edit is used for designing and editing an image. In this mode, an image can be viewed and edited.

- **Navigate**
  This option is used to move through an image workspace without editing the image. In this mode, the displayed image can only be viewed and not navigated or edited, though tag input can be performed if the operator is authorized to do so and the Trigger on mode has been activated.

- **Trigger On**
  When the Trigger mode is set to On, objects defined as Trigger objects can be used for tag input. When this mode is Off, no objects, even one defined as a Trigger object, can be used for tag input.

- **Copy On**
  When this option is selected transformations do not affect the original objects. For example, if an object is moved, both the original and the moved objects will remain on the screen (the object will be copied). If this mode is Off, when an object is moved, only the newly positioned object is moved.

- **Grid Setup**
  This option when selected opens the Grid Setup dialog box where you can select the grid unit types and coordinates, reference point to which all other points are relative and preview the defined grid.
**Edit**

The Edit mode is used for designing and editing an image. In this mode, an image can be viewed and edited.

A check mark beside the Edit option indicates that it is active. Selecting the option again causes the system to revert the Monitor Mode.

In the Edit mode, all the image Window functions are present, including the Tools windows which contains the drawing and editing tools used to create and modify images. When the Edit Mode is activated, all the Tools available in the window will appear. The Tools window contains the object, the operation, the drawing and the color tools. In addition, the current coordinates of the location of the cursor in the image will appear in the title bar of the window (or in the caption of the icon, if it was minimized).

*Note: If the Edit mode is activated without the Navigate mode, you will be able to edit the image, but not scroll, pan, or zoom in it.*

**To access the Edit Mode:**

Select Edit from the Modes menu.

**Navigate**

The Navigate Mode is used to move through an image workspace without editing the image.

In this mode, the displayed image can only be viewed and not navigated or edited, though tag input can be performed if the operator is authorized to do so and the Trigger on mode has been activated. The Tools window initially appears outside the Image Window, but can be moved to the new location.

If this mode is selected without the Edit mode, you will be able to scroll, pan, and zoom in the image, but not edit it.
In addition, if the Edit mode is not activated together with this mode, the Tools window will not appear.

- **To enable the Navigation mode**

  Click the Navigate mode icon in the Image main menu.

  Or,

  Select Navigate from the Modes menu.

**Trigger On**

When the Trigger mode is set to ON, objects defined as Trigger objects can be used for tag input. When this mode is OFF, no objects, even those defined as a Trigger object, can be used for tag input.

When this mode is active, you can move from one trigger object to another by pressing the Tab key. To move in the reverse order, press the Shift and tab keys together. Note that you move from one object to another according to the order in which the objects were designed. To change the order, use the Z order tool. After you select this item, the cursor will appear as a white hand. When the hand is placed on a trigger object, it will turn red.

In this mode, image objects designed for tag input (trigger objects) can be activated.

- **To access the Trigger on mode:**

  Click the Trigger on icon on the Image Main Menu.

**Copy On**

The Copy On mode enables duplication of objects in Transform operations.

When the Copy On mode is activated, a transform operation will preserve the original object. When the Copy on mode is not activated, a transform operation will discard the original object (only the transformed object will remain).

- **To toggle the Copy On mode:**

  Select Copy On from the Modes menu. A check beside the item indicates that it is active.

In addition to the Copy mode, the following methods can also be used to copy objects:
**Grid Setup**

A grid is an array of points superimposed on an image. It is used to accurately position objects in an Image.

A grid consists of the following elements:

- **Origin**: The origin is the reference point that all other points are made relative to. The origin can be any point in an Image.

- **Step**: The distance between adjacent grid points. Different values can be assigned for horizontal and vertical steps.

- **Snapping**: The cursor can be made to move only in grid point steps. When the mouse is moved, the cursor will jump to the next grid point.

The following types of grids can be used:

- **World**: The grid step is set to the Drawing Space: When the zoom level is changed, the visible distance between grid points also changes accordingly together with the other geometrical objects in the Image.

- **Pixels**: The grid step is set to the screen pixels: Whatever the zoom level, the distance between the grid points remains the same, even though object sizes visibly change.

Grids can be made visible or hidden. The following sections describe the operations that are performed to create grids and set their attributes.
To configure a grid:
Select Grid Setup from the Modes menu, or the Grid Setup button from the toolbar. The Grid Setup dialog is displayed:

The following options are available:

- **Step Units**: Specifies the grid type, as follows:
  - Pixels: Image grid type units.
  - World: Geometric grid type units.

- **Step**: The grid step (in the respective units):
  - X: Horizontal step.
  - Y: Vertical step.

- **Origin**: Used to enter the origin point X-Y coordinates.

- **Select Point**: When this button is activated, the dialog will temporarily be suspended, and the operator can then indicate the origin point by clicking the left button in the window.

- **Show**: When this button is activated, the grid is displayed on the Image to verify the setting. If the operator changes the setting and activates the button again, the old grid will be deleted and the new one will be displayed.
**Snap to Grid**

► To toggle the Grid Snapping mode on and off:

Click the Snap to Grid tool in the Operations toolbox, or select Grid Snap from the Modes menu.

**Grid Show**

► To make a grid show or hidden:

Click on the Grid tool from the Operations toolbox, or select Grid Show from the Modes menu. A grid is displayed over the Image.
Chapter 20 Image Animation

About this chapter:

This chapter describes how to use Image animation in the application, as follows:

Overview on page 20-2 provides an overview of Image animation.
Dynamic Objects on page 20-2 provides a description of dynamic objects and describes how to define them.
Alarm Objects on page 20-23 describes how to define objects as alarm objects.
Trigger Objects on page 20-28 describes how to define trigger objects.
Modifying Object Properties on page 20-31, describes how to modify the properties of objects in Images.
Input Method Preparations on page 20-38 describes what to do before you can use an input method.
Trigger Macros on page 20-50 describes how to define trigger macros.
Tag Value Sliders on page 20-52 describe how to design sliders.
Media Player on page 20-54 describes how to define media players.
Scheduler on page 20-55 describes how to access this feature.
Tag Value Simulation on page 20-57 describes how to simulate tag values in Images.
Overview

Image Animation is the process of linking Image objects created by using the Image Editor to a control process via tags. Refer to Chapter 9, Tags for more information about tags and their relation to on-going processes.

There are two main ways to implement Image Animation:

- **Dynamic Objects** - Objects in Images are associated with tags. Any change in tag values causes the object to change graphically.
- **Trigger Objects** - Objects in Images are designated as triggers. When these objects are activated, operations, such as tag value changes, are executed immediately, thereby affecting the graphic presentation of the Image.

Each of these methods is described in the following sections.

**Dynamic Objects**

Dynamic objects are elements that change according to tag values. When a tag value changes, the properties of the object, such as position, size, color, and orientation change accordingly (there are 12 different object properties). Thus, a dynamic graphical illustration of plant activity can be achieved.

Any object in an Image can be dynamically animated, including process messages. In addition, process messages themselves can be made to change (textually) according to tag values. Values can be presented numerically, or predefined messages can be displayed for each specific tag value.

In order to implement object animation, tag value ranges are denoted by start and end values. The current state of an object corresponds to the start value, and the final state of an object, after changes, corresponds to the end value. Thereafter, for any tag value, the object will be changed proportionally (by linear interpolation or extrapolation).

Tag values can be further divided into sub-values that control different display attributes, such as colors and fill patterns. For further details see Chapter 9, Tags.
**Dynamic Object Definition**

This operation is performed to make existing Image objects dynamic.

- **To create a dynamic object:**

  Select the graphic object in the Image that you wish to include in the cluster, and do one of the following:

  - Click the Dynamic Definition button in the Object toolbox.
  - Right click an object and select the Dynamic Definition option from the popup menu.
  - From the Edit menu, point to Operation and select Dynamic. The Dynamic Parameters dialog box is displayed.
The following options are available:

**Ranged Parameters**

Includes the following fields:

- **Station**: Specifies the station running the application to which the tag belongs. To select a station from the list of stations defined in the application network, click on the arrow to the right.

- **Tag**: Specifies the tag associated with the selected object. To select an existing tag, click on the arrow to the right.

- **From**: Specifies the minimum tag value for which the animation will occur.

- **To**: Specifies the maximum tag value for which the animation will occur.

**Animation**

Specifies the dynamic operation to be performed on the selected object for the specified tag value range. The operations include the following:

- **Move 1**: Positional variation 1. See Move on page 20-6.
- **Move 2**: Positional variation 2.
- **Scale**: Scale variation. See Scale on page 20-8.
- **Fill**: Command to fill an object. See Fill Region on page 20-9.
- **Show**: Specifies that an object will be visible when the value is within the specified value range, and hidden when the value is outside that range.
- **Empty**: Specifies that an object will be empty when the value is within the specified value range.

**Multi-Range Parameters**

The following options are available:

- **Station**: Specifies the station running the application to which the tag belongs. To select a station from the list of stations defined in the application network, click on the arrow to the right.

- **Tag**: Specifies the tag associated with the selected object. To select an existing tag, click on the small arrow to the right.
**Animation**

Specifies the dynamic operation to be performed on the selected object for the specified tag value range. The operations include the following:

**Blink**: Specifies that an object will blink when the value is within the specified value range.

**Line Color**: Sets the line color of an object when the value is within one of several specified value ranges.

**Fill Color**: Sets the fill color of an object when the value is within one of several specified value ranges.

**Fill Type**: Sets the internal fill pattern of an object when the value is within one of several specified value ranges. Not applicable on the Web.

**Drum**: Sets a bit pattern so that when a tag value matches this bit mask, the corresponding object will be visible; otherwise it will be hidden.

**Object**

The selected object to which the dynamic definition will be applied.

**Options**

Transformation options.

**Notes:**

In the Dynamic Parameters dialog box an arrowhead will appear beside any button that has been selected.

When the Dynamic Parameters dialog box appears on the screen, no dynamic object animation will occur in the Image, although tag values will be updated. As soon as the dialog box is closed (when the OK or Cancel button is activated), all dynamic objects in the Image will be graphically updated.

Several transformation and range parameters can be set for one object, each dependent on its associated tag value. The final appearance of an object will be the result of all the relevant transformations. However, if any one transformation is applied more than once, only the last application will be effective.

Dynamic objects cannot be nested or grouped.

When defining dynamic object attributes in the Dynamic Parameters dialog box, you can right-click to cancel the current operation.
Optimizing Dynamic Object Performance

Dynamic updating in the Image is one of the most important operations in the Image. When a dynamic object changes its state, such as in tag changes or blink times, the Image redraws the object. This process is complex and uses a large amount of computer resources that should be optimized to run as fast as possible.

To optimize your dynamic object performance use the following guidelines when designing your Image:

- Avoid putting too many fast changing dynamic elements in one zone.
- Minimize the size of fast changing dynamic objects.
- Avoid spreading fast changing dynamic elements out over the zone.
- Avoid putting other dynamic objects in the immediate surroundings of fast changing dynamics.
- Keep fast changing dynamic objects as simple as possible. Do not make a fast blink over a complex cluster or group.

Each of the dynamic object attributes is described in the following sections.

Move

When the Move 1 button is activated, the Dynamic Parameters dialog box is temporarily disabled and the Editor enters the Move mode. When an object is moved to the location corresponding to the End Value parameter, the dialog box reappears for further setting.

If the Hand mode is active, instead of moving the object, the operator enters the movement coordinates in the Move 1 dialog box. (See Transformation Options on page 20-14).
The following options are available:

**X Factor**  
X Specifies a horizontal change in drawing units (with a scale of 64, each unit being 1/100 mm), per unit change in the tag value.

**Y Factor**  
Y Specifies a vertical change in drawing units (with a scale of 64, each unit being 1/100 mm), per unit change in the tag value.

An animation feature enables the movement to reflect the combined value of two tags. To implement this feature, specify a new tag name or use the current tag name in the Dynamic Parameters dialog box, activate the Move 2 button, and specify the coordinates for the second tag in the Move 2 dialog that appears.

The final position of an object is derived from the sum of the coordinates of each individual position. For example, diagonal movement can be obtained through the combination of one tag with a horizontal position parameter, and another tag with a vertical position parameter.

**Rotate**

When the Rotate button is activated, the Dynamic Parameters dialog box is temporarily disabled and the Editor enters the Rotate mode (see Chapter 18, Introduction to the Image Module and Chapter 19, Image Editor). When the object is rotated to the orientation corresponding to the End Value parameter, the dialog box reappears for further setting.

*Note: If the start point is identical to the end point, clicking on a rotation point will rotate the object 360 degrees.*

If the Hand mode is active, instead of rotating the object, the operator enters the rotation parameters in the Rotate dialog box:

![Rotate Dialog Box](image)
The following options are available:

**Angle**
Specifies the rotation angle in degrees, per unit change in the tag value.

**Reference Point**
Specifies the X and Y coordinates of the rotation axis. The default coordinates are those of the lower left corner of the bounded segment rectangle.

The rotation axis can be made to relate to the Image or the object itself, by specifying the required parameter in the Options dialog box (which is accessed by clicking the Options button in the Dynamic Parameters dialog box).

*Note: Rotation from the Start orientation to the End orientation will be in the counter-clockwise direction, unless otherwise specified in the Options dialog box.*

**Scale**

When the Scale button is activated, the Dynamic Parameters dialog box is temporarily disabled and the Editor enters the Scale mode. When an object is scaled to the size corresponding to the End Value parameter, the dialog box reappears for further setting.

If the Hand mode is active, instead of sizing the object, the operator enters the scaling parameters in the Scale dialog box.

![Scale dialog box]

The following options are available:

**X Factor**
Specifies the horizontal scaling in drawing units, per unit change in the tag value.
The scaling reference point can be made to relate to the Image or the object itself, by specifying the required parameter in the Options dialog which is activated by clicking the Options button in the Dynamic Parameters dialog box.

**Fill Region**

Like other object elements, the fill region of an object can vary according to the tag value, and is set according to the Start and End values.

When the Fill button is activated, the Dynamic Parameters dialog box will be moved temporarily to the background and a half-filled box icon will be attached to the cursor. Click the left button and drag the mouse to the Start Value area. Click the left button again to fill the End Value area. Click the right button to abort the operation. When the Fill operation is complete, the Dynamic Parameters dialog box will return to the foreground for further specifications.

The filling reference point can be made to relate to the Image or the object itself by specifying the required parameter in the Options dialog box.

**Show/Empty**

The Show and Empty attributes can be applied globally for an entire tag range, as follows:

- **Empty Object**
  When the Empty button is clicked, the object will be empty for the given value range, and filled when outside that range (if the object is defined as a filled object).

- **Show Object**
  When the Show button is activated, the object will be visible for the given value range, and hidden when outside that range.

For each global setting, if you use a range in which the first value is greater than the second, the opposite effect will occur (the object will be hidden) for the range specified. For example, if you use the range 10-4.9 for each of the settings, the following will occur:
The object will be filled for any value from 5 to 10.
The object will be hidden for any value from 5 to 10.

You can select Force Dynamic Show from the Options menu in the Image window to cause a dynamic object in an Image to always appear, even if that object is currently hidden in accordance with a Show Object specification.

Or, you can click on the Force Dynamic Show icon in the Image toolbar.

In addition, note that the lower value must be a value within the range of show values, for the hidden option to operate (such as 10-4.9 described above).

**Fill Colors and Types**

Some attributes that can be applied to dynamic objects are divided into several tag value ranges. These attributes include Blink, Line Color, Fill Color, Fill Type and Drum. Each of these attributes is described in the following paragraphs.

Dynamic colors and patterns can be applied to objects by activating the Line Color, Fill Color or Fill Type button.

**Colors**

Click the Line or Fill Color button to display the following dialog box:

![Fill Color Dialog Box](image)

In the Low Value and High Value entry boxes, specify the value range for which the color you select will be active. Then, select a color for the range you specified, by
clicking on the arrow to the right of the color field. You can move from field to field by pressing the <Tab> key.

Note: Each range should be specified in ascending order. No overlapping is allowed.

For values that are not included in the ranges you specified, the object will maintain its original attributes.

**Types**

Note: This feature is not supported on the web.

The Fill Type button when clicked opens the following dialog box:

Follow the instructions for Colors on page 20-10 to complete this dialog box.
Dynamic Object Blinking

To define a dynamic object to blink:

Click the Blink button in the Dynamic Parameters dialog box. The following dialog is displayed:

The following fields are available:

- **Low Value**: Specifies the minimum tag value for which the dynamic object will blink.
- **High Value**: Specifies the maximum tag value for which the dynamic object will blink.
- **Rate**: Specifies the amount of time that the dynamic object will appear on the screen, then disappear, then reappear, and so on. The value for Rate can be Fast, Medium or Slow. To select a rate, click on the arrow to the right of the field, or move to the field and use the up and down arrow keys to select an option.
In the Tuning Parameters and in the WIZTUNE.DAT file (see Appendix B, Wiztune.dat File), the IMG_BLINKRATES parameter defines the blinking rate values for dynamic objects. The format of this parameter is:

IMG_BLINKRATES=fast medium slow

The values you specify for fast, medium, and slow are in milliseconds, and can be from 100 (1/10 second) to 30,000 (30 seconds). If you specify a value that exceeds these limits, the application will automatically apply the maximum or minimum values instead.

The default is IMG_BLINKRATES=500 1000 2000.

*Note: You can also use commas (,) to separate the values.*

**Drum Pattern**

An object can be made visible when its associated tag value matches a specified bit pattern. The bit pattern can include Don't Care bits, which are bits that will be considered matches no matter what their actual values may be.

▶ **To assign a Drum Pattern:**

Click the Drum button to open the Drum Tag Definition:

A bit pattern is entered as a sequence of zeroes, ones, or asterisks (*) that represent Don't Care bits.

For example, using the pattern in the dialog box above,
the value 0101101000110100110111011010 matches the pattern,
while the value 0101101000110100110111011010 does not.

If a tag value matches the specified bit pattern, the object will be made visible; otherwise it will be hidden.
If several objects are associated with the same tag, each object requires its own pattern, so that each pattern will control the visibility of a different object.

This tool can be used to capture several discrete states within a single analog tag. For example, a device can at any time be in the On, Off, Idle or Fail state, whereby each state is represented by a different bit in an analog tag. A bit pattern can be defined for each object that represents a state, and as the device changes states, its current state will be reflected in the Image by the respective object.

If a tag value matches several patterns (due to the Don't Care bits), any object associated with those patterns will be made visible.

Note: You can select Force Dynamic Show from the Options menu in the Image window to cause a dynamic object in an Image to appear always, even if that object is currently hidden according to a Drum Pattern specification.

Transformation Options

To perform dynamic object transformation operations:

Click the Options button to open the Options dialog box.

The following options are available:

- **Hand Mode**: When this option is selected, the operator will be able to enter numerical values for the Move, Scale, default, they are defined graphically in the Image.

- **Fixed Fill Area**: When this option is selected, fill area borders will be fixed to their position in the Image. By default, the borders are bound to the object. Not applicable on the Web.
If multiple transformations are to be performed on the same object, they will be performed in the following order: Move, Scale and Rotate. This order affects the location of fill area borders, rotation axes, and scaling reference points when they are not fixed to a position in the Image.

**Sample when out of Window**

In the application, dynamic objects that do not visually appear in the Image window are not sampled. However, if an object was transformed using the dynamic move, resize, or rotate options, and after the transformation that object receives tag values that cause it to move outside the Image window, you can use the Sample when out of Window option to cause the object to be sampled.

If this option is not selected, transformed objects that no longer appear in the Image window will not be sampled.

**Dynamic Text**

In an Image tag values can be displayed as one of the following dynamic text object types:

- Tag value
- Text Table display (each value causes a pre-defined string to be displayed)
- Date/Time display
Tag string display (exact field device values)

To define a dynamic text display:

Click on the button in the Drawings toolbox to open the Text dialog box:

![Text dialog box]

To enter regular text, click the left button in the Text field. Regular text is described in more detail in Chapter 18, Introduction to the Image Module and Chapter 19, Image Editor. The following description refers to dynamic text only.

The fields that relate to dynamic text in the dialog box are as follows:

- **Text**: This field is used only for regular (non-dynamic) text in the Image.
- **Tag Value**: For numerical display.
- **Text Table**: For the display of text, according to predefined tag values.
- **Date/Time**: For date or time display.
- **String**: For actual field device value display.
Tag value

To define numerical display for tag values:

Click the Tag value button. The Tag Value dialog box is displayed:

The tag and its value to be displayed are both defined together with the display attributes.

The fields in this box are:

- **Station**  
  Specifies the workstation to which the tag belongs.

- **Tag**  
  Specifies the tag associated with the tag value.

- **Display Mode**  
  Select Dec for Decimal, Hex for Hexadecimal, or Eng for Engineering (powers of ten). For example, for the number fifteen: Dec = 15, Hex = F, and Eng = 1.5e1.
Note: The tag value can also be defined as a dynamic object. Thus, both the display contents and appearance can be made to change in accordance with tag value changes.

The Digits before "." and Digits after "." fields may cause actual tag values to appear incorrectly. For example, if you specified 2 for the Digits before "." field, and the actual tag value is 115, only 15 will be displayed.

To prevent confusion with decimal numbers, the application automatically precedes hexadecimal numbers with 0x. Therefore, take into account that you need space for two extra characters before the displayed value. For example: 65,355 in decimal = FFFF in hexadecimal. To indicate that FFFF is in hexadecimal, you must define six characters, 0xFFFF.

**Text Table**

Text Tables are used to associate tag values with predefined strings. When a Text Table is defined and activated, a text string will be associated with the tag values defined in the Table. When a value changes, the corresponding string will be displayed. Each string table is stored in a separate file.
To assign text tables or create new ones:
Click the Text Table button in the Text dialog box.
If no text table exists, the New Text Table File dialog box opens where you can specify the name of the text table.

If a text table file already exists, the Open Text table file dialog box appears:

Select a file from the list (or click the New button to open the New Text Table dialog box). The Text Table dialog box is displayed where you can specify the string-value relationship:
The following options are available:

- **Station**: Specifies the network station to which the tag belongs.
- **Tag**: Specifies the name of the tag.
- **Value**: Specifies the string display value.
- **Text**: Specifies the string for the value.
- **List**: Specifies the list of values and the strings defined for them.
- **Add**: Adds the value-string pair to the list.
- **Change**: Replaces the selected pair with the one specified in the entry boxes.
- **Delete**: Deletes the selected pair from the list.

Specify a tag name, the tag values, and their corresponding strings in the entry boxes, and add them to the list by clicking the Add button. A value-string pair can be selected from the existing pairs list, placed in the entry boxes, and revised, by activating the Change button. When the Delete button is clicked, the selected pair is removed from the list.
Special Cases:
- If a tag value does not exist in the text table, the text field will be filled with Xs (xxxxx).
- If no text table file exists, number signs (#####) will appear in the field.
- If a communication error occurred, asterisks (***** ) will appear in the field.

If spaces are to be used in the string, enclose the string in quotation marks, for example, "The text ".

Text table string files can be created or modified using your system editor. The format of this file is as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>&quot;Cycle Starting ...&quot;</td>
</tr>
<tr>
<td>20</td>
<td>&quot;Cycle Completed !&quot;</td>
</tr>
</tbody>
</table>

*Note: Text Tables can also be used for Trigger objects (see Trigger Object Definition on page 20-29) when the String input method is active.*

**Date/Time**

Date/Time display is used to present the value of a tag as a dynamic date or time display.

► **To define Date or Time display for tag values:**

Click the Date/Time button in the Text dialog box. The Text Format: Date/Time dialog box is displayed:
The following options are available:

**Station**
Specifies the network station to which the tag belongs.

**Tag**
Specifies the tag with which the Date/Time display will be associated.

**Date**
The tag value will determine the display of the number of days from 1/1/1980. The limitation date is up to the value of 21203 (18-Jan-2038) (18-01-38 on the Image).

**Time**
The tag value will determine the display of the number of minutes since midnight.

**Time with Seconds**
The tag value will determine the display of the number of minutes and seconds from midnight.

---

**Tag Value String**

Tag value string displays can be used to represent tags defined as string tags as Image objects. Tag string objects in the Image will display exact field device numeric, alphabetic, or alphanumeric values.

➤ **To define a tag string display:**

Click the String button in the Text dialog box. The String Tag dialog box is displayed:

![String Tag dialog box](image)

Specify the network station to which the string tag belongs, and then the name of the string tag you want to be represented in the Image. To select a station or tag from a list of existing stations and tags, click on the arrow to the right of the field.

String tag objects in the Image can also be defined as triggers. When the object is selected in the Trigger mode, you will be able to enter textual values using different input methods. (See Trigger Object Definition on page 20-29).

*Note: String Tags are not supported in the RePlay module.*
**Alarm Objects**

An Image object can be associated with an alarm, so that the alarm will affect the way the object behaves. Such objects are called alarm objects. (See Chapter 13, Alarms for further information)

An alarm object can be defined to blink, show, hide, or change colors when the alarm is active, provide textual assistance when selected, and enable alarm acknowledgment.

► **To define an object as an alarm object:**

Select an object in the Image and activate the Alarms Definition button in the toolbox (or right click on the object and select Alarm Definition). The Alarm Object Definition dialog box is displayed:
The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Station</strong></td>
<td>The network station to which the alarm belongs. For a list of defined stations click on the arrow to the right of the field.</td>
</tr>
<tr>
<td><strong>Alarm Family</strong></td>
<td>The family of alarms to be associated with the object. The name you specify must be the name of a family of alarms that was, or will be, defined in the system. (You can specify the name of an alarm family that was not yet defined in the Alarm Definition module. Although, at some point, it must be defined.) For a list of defined alarm families click the arrow to the right of the field. You can also use a ? and a * wildcard to enable you to quickly define family filters. The maximum number of names that you can specify is 600.</td>
</tr>
<tr>
<td><strong>Show Object</strong></td>
<td>Select Always to cause the object to appear in the Image constantly. If you select this option, you must also select an Animation. Select Alarm Family Active to cause the object to appear in the Image only when the alarm condition is true. Select Alarm Family not Active to cause the object to appear in the Image only when the alarm condition is false. If you select this option, both the Animation and Trigger Function fields will be disabled.</td>
</tr>
</tbody>
</table>
Animation

The following options are available:

**Blink**: Click to define the blink parameters for the object. The Image Alarm - Blink dialog box is displayed.

**Fill Color**: Activate to define the color display of the object. The Image Alarm - Color dialog box is displayed:

Select the alarm status option you want and the color to be associated with that status.

Active alarms can be either; Started (unacked, unended), Acked (and unended), or Ended (but unacked). For example, you can define the object to be red when the alarm is started, green when it is acked, and its default color when it is ended.
Line Color: Activate to define the color of the borderlines of the object. The Image Alarm - Color dialog box is displayed. (This dialog box is similar to the Fill Color dialog box).

Notes:
This note applies to all the Animation dialog boxes: These dialog boxes have the following states: Started, Acked, Ended. If User Defined States are defined (and enabled in the Alarm/Tag properties dialog box) then they will also appear here. Any state name can be defined for User Defined States. However if no state name is defined then the default State 1 and State 2 are used. More than one animation option can be applied for each alarm object.

If the No Alarm option is selected in the Show Object When field, the Animation field will be disabled.

A selected Animation option is indicated by a small arrow that appears beside the button label.
If more than one alarm is active in an alarm family, the status of the alarm in order of severity will be as follows: Started, Ended, Acked. In the Trigger mode, if the Acknowledge option is selected in the Trigger Function field, and you click on the object to acknowledge the alarm, all the alarm instances will be acknowledged.
Trigger Function

Select **Acknowledge** to cause the alarm associated with the object to be acknowledged whenever the object is selected in the Trigger mode.

Select **Acknowledge with confirm** to prompt the operator before acknowledging the alarm.

Select **Assist** to cause the help file of the alarm associated with the object to appear whenever you select the object in the Image.

Select **Assist + Ack** button to cause the help file of the alarm to appear with an additional acknowledge button. For more information about alarm help files, see the Event Summaries chapter.

Select **None** for no trigger function.

If the No Alarm option is selected in the Show Object When field, the Trigger Function field will be disabled.

Notes:

*If an object was already defined as an alarm object, and you access the Alarm Object dialog box for that object, the dialog box will appear with the options you selected. If you change the definition (select different options) and then activate the OK button, the new definition will replace the previous definition.*

*Several objects can be selected together in the Image for alarm object definition. If an object within the group you selected was already defined as an alarm object, the group definition will replace the single object's definition.*
**Trigger Objects**

Trigger objects are objects that you can click on to cause predefined tag values to be set automatically or manually, cause the Image to go to a predefined zone, or cause predefined macros to be activated.

Any trigger object included in a segment will function the same as when it is not included in a segment. For more information about segments, see Chapter 19, Image Editor. Several tag input methods can be used for trigger objects. To test an input method, tag value variations can be simulated.

The tag value input methods include the following:

- **Action**: When the operator clicks on an object, a preset value is applied to the tag, or a predefined macro is activated. This method is valid for all tags and objects.

- **Buttons**: When the operator clicks on an object, a set of buttons with preset values appears. Clicking a button causes a value to be applied to the tag, or a predefined macro to be activated. This method is valid for all analog and digital tags (not for string tags).

- **Bit**: When the operator clicks on an object, ON, OFF, and Toggle buttons appear. This method is valid for all tags and objects (except string tags. For analog tags, the Toggle buttons will not appear.

- **Data Entry**: When the operator clicks on an object, a dialog box appears to specify a numerical tag value. This method is valid for all tags and objects, except Text Table objects.

- **String**: When the operator clicks on an object, a Text Table that was made active for the tag associated with that object, will be applied. The Text Table contains a list of strings corresponding to different tag values.

- **Date**: When the operator clicks on an object defined as a Date/Time object, a dialog box appears with the current date value to be modified.
**Trigger Object Definition**

**To define trigger objects:**

Select the required object and do one of the following to display the Trigger Object Definition dialog box:

- Click the Trigger Definition tool in the Objects toolbox.
- Or
- Right click and select Trigger from the popup menu.
- Or
- Select Trigger from the Edit Operations menu.

For **Text Table** objects, the String button will appear in the Input Method field instead of Data Entry. For Time objects, the Time button will appear in the Input Method field instead of Data Entry. For Date objects, the Date button will appear in the Input Method field instead of Data Entry.
The following fields are available:

- **Station**: Specifies the station to which the tag belongs.
- **Tag**: Specifies the tag associated with the object.
- **Input Method**: The value input methods described above: Data Entry Value, Action, Smooth Variation, Buttons, Bit, Momentary.
- **Set Macro**: Activate to define macros for trigger objects. (Not applicable on the Web).
- **Test**: Activate to test the input method and adjust its appearance.

Any object (static, dynamic, segment) can be defined as a trigger object. However, only one tag value input method can be assigned per object.

**To cancel a trigger definition:**

Select the trigger object, right click, and select Remove Trigger from the pop-up menu. Or, select the trigger object, point to Operations in the Edit menu, and select Remove Trigger.

An arrow will mark the tag value input method that you select in the dialog box.

*Note*: For the Data Entry, Smooth, Bit, and Test dialog boxes the last position of the dialog box will be saved (unless you clicked the Cancel button before completing the operation). This means that you can drag the dialog box to any position on the screen. Thereafter, when the dialog box is opened, it will appear in its last position. However, the dialog box position is relative to the window position. If the window is moved and then the dialog box is invoked, it will appear in the position it was last saved, relative to the new location of the window.
Modifying Object Properties

You can quickly access any object, group of objects or a cluster object and modify the object properties.

This option is especially useful when editing cluster objects. You can select a cluster object and edit any of its objects without ungrouping the whole cluster.

This option enables you to:

- Modify trigger definitions and text.
- Modify dynamic tag definitions.
- Modify basic object attributes such as the line color, the fill color and the active layer.

This option does not enable you to add or remove objects from an Image, or modify the shape of the object, for example, its size or type.

To modify object properties:

Click on a single object to select it or click on each required object while holding down the shift key, then right click and select Edit Properties from the popup menu.

A dialog box similar to the following is displayed. In this dialog box, a cluster object is selected:
The Object List on the left displays a hierarchical structure, or tree, of the objects, which comprise the cluster. The tree displays object types as folders under which objects of that type are contained. For example, dynamic objects are displayed in the Dynamic folder. The Object List can be configured to display different objects types.

The application enables you to locate items according to specified strings and to replace simple text or tag names.

Each object selected in the Object List is viewed in the Object Properties area on the right of the dialog box.

The following options are available in the Edit Properties dialog box:

- **Definition**: Enables you to modify dynamic tag parameters. This option is available for objects with a definition such as a button, or an alarm. It is also available for text. It is not available for objects that are only defined with basic object attributes such as color or line type.

- **Attributes**: Enables you to modify the line color, the fill color and the active layer.

- **Trigger**: Displays the standard Trigger Object Definition dialog box in which you can modify trigger definitions. This option is available for objects with a trigger definition.
Modifying Dynamic Tag Parameters

The application enables you to access the tag parameters specified for dynamic properties and modify them. This option does not enable you to re-define options such as Animation, for example, change Blink to Line Color.

To modify dynamic tag parameters:

Select the Definition button in the Edit Properties dialog box to display the Dynamic Object dialog box. This dialog box is similar in functionality to Dynamic Parameters.

[Image of Dynamic Object dialog box]

To Modify the Range Parameters:

1. Click the arrow to the right of the Range Parameters area and select the required operation from the popup list. A dynamic type that is not defined will appear in parenthesis. If you select an undefined type, the Tag Properties, and From and To options are disabled.

2. Enter to and from values in the To and From fields to modify the maximum and minimum tag values.

3. Click Apply to save your changes.

4. Click the arrow to the right of the Station field and select the required station.

5. Click the arrow to the right of the Tag field and select the required tag.
► **To Modify the Animation options:**

1. Click the Animation button in the Multi-Range Parameters area to display a dialog in which you can modify the action defined in the Multi Range Parameters field. For example, Blink.
2. Click the arrow to the right of the Station field and select the required station.
3. Click the arrow to the right of the Tag field and select the required tag.
4. Click OK to save your changes and close the dialog box.

**Modifying Basic Object Attributes**

The application provides quick access, through one dialog box to three options that are usually defined separately during Image object definition.

Using the new Object Attributes dialog box, you can modify line and fill color and change the active layer of an object. The application does not support modifications to line types and fonts, nor enable access to transparent colors.

► **To modify basic object attributes:**

1. Select the Attributes button in the Edit Properties dialog box to display the Object Attributes dialog box:

![Object Attributes dialog box](Image)

2. Click the Line color button to display the standard Color dialog box in which you can modify the line color.
3. Click the Fill Color button to display the standard Color dialog box in which you can modify the fill color.
4. Click the Active Layer button to open the Select Active Layer dialog box in which you can change the layer from a list of available layers.
5. Click the Move to Active button to Move to the active image layer.
6. Check the Lock checkbox to lock this object. A locked image and its definitions cannot be moved or modified.
7. Click OK to close the dialog box and save changes.

Filtering the Edit Properties

The Edit Properties dialog box, in addition to providing access to the object edit options, displays a flexible Object List that provides a number of features that enable you to:

- Specify the object folders that appear in the Object List. Object folders are used to display the object types that comprise the specified cluster.
- Locate items in the Object List by specifying a string and running a match. This is useful when the Object List contains many objects and you want to quickly locate the ones you require.
- Find and replace simple text or tag names in the Object List.

To filter folder types:
1. From the Edit menu, choose Select. The Select Objects dialog box is displayed:

![Select Objects dialog box]

2. Select the object type you want to display in the Object List. You can choose from the following:
   - Dynamic Object
   - Alarm Object
3. Click OK to close the dialog box and save changes.

4. (Optional) You can display all the available folder types by choosing Select All from the Edit menu of the Edit Properties dialog. This overwrites your previously defined options. (It also reselects all the options in the Select Objects dialog box.)

▶ To locate items in the object list:

1. From the Edit menu, select Find. The Find dialog box is displayed:

2. In the Find what field, enter the object you want to locate, for example, circle.

3. Enter one of the following to define the string by which the object is located:
   - Simple text
   - Tag name
   - Alarm family
   - Trigger button
   - Trigger macro
   - Trigger zone

4. Select Match case or Match whole word to define your search criteria.
5. The application searches the Object List for a match and selects the object when found. A message is displayed if the object is not found.

6. (Optional) Select Find Next from the Edit menu or press F3 to continue searching the tree for the next match.

► **To find and replace text:**

1. From the Edit menu, select Replace. The Replace dialog box is displayed:

   ![Replace dialog box]

2. Select Simple text in the Option to Replace area.

3. Enter the text you want to search for in the Find What field, or click the arrow to the right of the field to select text from a list of available text objects.

4. Enter the replacement text in the Replace With field, or click the arrow to the right of the field to select replacement text from a list of available text objects.

5. Click Find Next to locate the text. Click Replace to continue the find and replace operation, or click the Replace All button to automatically find and replace all matching objects. You can also click Find Next again to simply find the next text object without replacing the currently selected text.

6. Click Cancel to stop the find and replace and close the dialog box.

► **To find and replace tags:**

1. From the Edit menu, select Replace. The Replace dialog box is displayed.

2. Select Tag name in the Option to Replace area.

3. Enter the tag you want to search for in the Find What field, or click the arrow to the right of the field to select a tag from a list of available tags.
4. Enter the name of the replacement tag and the station, in which it is found, in the Replace With field, or click the arrows to the right of the fields and select replacement tags and their stations from lists of available tags and stations.

5. Click Find Next. The tag is located. Click Replace to continue the find and replace operation, or click the Replace All button to automatically find and replace all matching tags. You can also click Find Next again to simply find the next tag without replacing the currently selected tag.

6. Click Cancel to stop the find and replace and close the dialog box.

**Input Method Preparations**

The following sections describe the steps you need to take before you can use an input method.

**Action Buttons**

Before using use the Buttons input method first define the action buttons.

- **To define action buttons:**

  Click the Buttons button in the Trigger Object Definition dialog box. The Preset Buttons Definition dialog box is displayed:
The following options are available:

**Title**
- The button group title (optional).

**Legend**
- A description of the buttons. In this field, any button letter can be highlighted for keyboard entry, by prefixing it with the ampersand (&) character.

**Value**
- The button value. If the object was defined as a string tag the value can be any numeric, alphabetic, or alphanumeric value.

**Zone**
- The zone to jump to when the button is activated. This field is optional. After checking this option click the Zone field and select the relevant zone.

**Zone Navigator**
- The Zone Navigator is a global multi image zone navigation window that enables you to quickly and efficiently navigate through image files. After checking this option click the Browse button to open the Zone Navigators dialog box and select the relevant Zone Navigator.
A new button can be defined and added to the list by clicking the Add button. A button can be selected from the list, its characteristics modified, and the revised definition saved, by activating the Change button. A button is deleted from the list by clicking the Delete button.

If an ampersand (&) character precedes any part of the text specified in the Legend field, the operator will be able to activate that button by pressing the <Alt> key together with character that follows the ampersand (the character that will be underlined). For example, if a button legend is specified as O&FF, the actual text will appear as OFF, and the operator will be able to activate that button by pressing the <Alt> key together with the <F> key.
In the **Macros** field a macro that you want to be activated can be specified by typing the name of the macro, or by clicking on the arrow to the right. When you click on the arrow, a list of predefined macros will appear for you to select from.

*Note: If more than one operation is assigned in this dialog box, the operations will be performed in the following order: goto zone, tag assignment, run macro. If one of the operations fails, the next operation will not be executed.*

**To save a button definition:**

Click the Save button and type a name. Once action buttons are saved for a specific object, they will appear each time the operator clicks on that object. Then, clicking on any button will apply that value to the tag.

1. (Optional) If you selected Execute a window containing the button panel you defined is displayed.

2. Click **Execute** to confirm and execute the action. You can also click **Cancel** to cancel the action and return to the Preset Buttons Definition dialog box.

*Note: The dialog box will disappear after a predetermined amount of time if you do not select any of the available options. The time parameter for the display of this dialog box is specified in the wiztune.dat file, as follows:*

```
TRIGGER_BUTTONS = TIMEOUT
```

*Note: The default value is 20 seconds. The maximum value is 100 seconds.*
Action

To use the Action input method first define an Action formula.

- **To define an action formula:**

Click the Action button in the Trigger Object Definition dialog box. The Action Definition dialog box is displayed:

![Action Definition Dialog Box]

1. In the Formula field you can use any of the following formats:
   
   ```
   @ tag op val
   val op @ tag
   val
   @ tag
   ```

   Where `@` alone is the current tag, `tag` is the name of any tag, `op` is any valid operator including operators `+`, `-`, `/`, `*`, `%` (percent denotes modulus, as in C programming language), `&`, `|`, or `^` (bitwise AND, inclusive OR and exclusive OR). `Val` is any numerical value.

2. Either a Zone or Zone Navigator (see Zone Navigator on page 19-64 of Chapter 19, Image Editor) can be added. Do either:

   Check the Zone checkbox and then in the Zone field click the arrow and select the relevant zone or, type in the relevant zone.

   Or,
Check the Zone Navigator checkbox and then in the Zone Navigator field click the Browse button. The Zone Navigator dialog box opens. Select the relevant Zone Navigator and click OK to save and return to the Action Definition dialog box.

3. To add a macro, click the Macro field and select the relevant macro.

4. Click OK to confirm your definitions and to exit this dialog box.

**String Tags**

If the tag associated with the object was defined as a string tag you can enter any character string in the Formula field, including a blank string (no characters). The Formula edit field can have up to 55 characters only.

If the formula begins with the character (@) the Image interprets the rest of the string as a tag. If you want to see the character (@) typed, place a space before it. The tag in the formula can also be of a numerical type. In this case, the value is converted to a string and written to a string tag.

In addition, you can enter a zone to jump to, or a macro to activate, whenever that object is selected.

In the Macro field, you can specify a macro that you want to be activated by typing the name of the macro, or by clicking on the arrow to the right. When you click on the arrow, a list of predefined macros will appear for you to select from.

*Note: If more than one operation is assigned in this dialog box, the operations will be performed in the following order: goto zone, tag assignment, run macro. If one of the operations fails, the next operation will not be executed.*
Smooth Variation Range

To use the Smooth input method to specify tag values to be applied online you must first define the variation range.

To define the smooth variation range:

Click the Smooth button in the Trigger Object Definition dialog box. The Tag Input - Smooth Range dialog box appears:

Enter values for the upper and lower range limits. These values will be used as the range within which values can be selected to apply to the tag.

Momentary Trigger

A Momentary Trigger is an object that is used to change a tag value in a single action. Usually such operations are required for a digital Tags that controls a field operation which is activated by a high value (one 1) for a short period of time, followed by a low value (zero 0).

The neutral way to implement such an operation is by using the button down button up pair of user actions. This operation is actually a button click that is regarded as one operation. The Momentary trigger operation will regard a button click as two operations.

All tags can be used for the Momentary, trigger, including string tags. The following is a description of the way Momentary Trigger operates:

- All tags can be used for the Momentary, including string tags.
- A formula, identical to the one used in the Action trigger, can be assigned for button down button up operations.
- Any Dynamic object in an Image, that should reflect the tag value change will be updated, while the button is still pressed.
Only when the user releases the mouse left button (button up) the Up formula is calculated and the result value will be written to WizPro, in the same way as the Down value.

If the user releases the button in a place not above the trigger object, the Up value will not be written.

To set and reset a bit in an Analog tag, the OR and AND operations can be used. For example, for 8 bit analog tag to set the 3rd bit use the formula '@ | 4'. To reset the same bit, use formula '@ & 251'. The same principal can be applied to any bit and for 16 or 32 bits analog tags.

**To define a Momentary Trigger**

1. Select the object you wish to define as a Momentary Trigger.
2. Click the Trigger Definition tool in the Objects Toolbox or right click and select Trigger Definitions. The Trigger Object Definition dialog box appears.
3. Click the Momentary button and the Tag Input - Momentary Values dialog box is displayed.
4. Enter the Value that the application will write to the tag when you click the left mouse in the Button Down Formula field.
5. In the field Button Up Formula enter the value that the application will write as soon as you release the mouse button. For new definitions, the default values are 1 and 0 for Down and Up respectively.
6. Press OK to complete the operation.

**Input Method Testing**

After you select an input method and make the necessary definitions, you can test the action that will occur whenever you click on the trigger object. The test that you perform will access the particular input method dialog box.
To test an input method:
Click the Test button in the Trigger Object Definition dialog box. A dialog box opens for the Input method (excluding the Action method). The dialog box is placed in a default location on the screen, but can be moved by placing the cursor on the Title bar, clicking, and dragging the box to any location. The new location will be recorded and the dialog box will thereafter appear in the new location, relative to the Image window lower-left corner.

The following sections describe each of the tag value input method operations in more detail.

Data Entry Value
When the Data Entry Value method is used and the operator clicks on a trigger object, the Modify Tag Value dialog box appears:

Enter a value and click the OK button to apply it immediately to the tag.

*Note: If the object is a string tag object enter a textual value in the New Tag Value field.*

Touch Screen Support
This trigger can be used to enable the application to support touch screens. In the Wiztune.dat file (see the Wiztune.dat File Appendix), manually set the tuning parameter:

```
IMG_TRG_KEYPAD = YES
```

Default is NO

Restart the application for it to take effect.

The Key Pad is available for Data Entry triggers of numeric type. The Enter Value dialog box opens.
Note: This keypad is not supported in browser.

The keypad operates as any other numeric keypad. Click the Back button to delete one number back. Click Clear to erase all numbers in the field.

You can set the location of your keypad anywhere on the screen by clicking the Test button and moving the keypad to any location. When you reopen the application and operate the keypad, it will be opened at the same location as you selected.

**Smooth Variation**

When the Smooth Variation method is used and the operator clicks on a trigger object the Single Tag Input dialog box is displayed:
The following options are available:

**New**  
New tag value (numerical).

**Suggest**  
Slider for suggested values.

**Set**  
Slider for tag values.

**Apply**  
Applies the value to the tag.

**Bit**  
When the Bit method is used and the operator clicks on a trigger object, the Tag Input: Bit Operation dialog box appears:

![Tag Input: Bit Operation](image)

The Toggle button is only displayed for digital tags.

The action button functions are:

**On**  
Sets the tag value to 1.

**Off**  
Sets the tag value to 0.

**Toggle**  
Toggles between 1 and 0 for digital tags only.

*Note: If the object was defined as a string this trigger type will be disabled.*
**Buttons**

If the Buttons method is used when the operator clicks on a trigger object, a dialog box will open the predefined buttons. Each button represents a different value. When a button is activated, its corresponding value is immediately applied to the tag.

The following is an example of a Button dialog box:

![Button example](image)

See [Action Buttons](#) on page 20-38 for further details.

**String**

When the String method is used (a Text Table was defined for a trigger object) and the operator clicks on the object the Modify Tag by String dialog box is displayed:

*Note: To use the String input method, a string must first be defined by activating the Text table button in the Text dialog box. In the Modify Tag dialog box select a predefined string from the list. The values corresponding to the string you selected will immediately be applied to the tag.*

**Date**

When the Date method is being used and the operator clicks on the object, the Set Date dialog box is displayed. After the new date is entered, the date display object will immediately be updated.

**Time**

When the Time method is being used (the object was defined for time display and the operator clicks on the object, the Set Time dialog box is displayed.

*Note: If the time display was not defined as Time with Seconds, the seconds box will not appear in this dialog box.*

After the new time is entered, the time display object will immediately be updated.
Trigger Macros

Note: This feature is not supported on the web.

Once you have defined Trigger objects, you can define special macros (keys or key combinations) to apply Trigger object operations. For more information about Macros see Chapter 32, Macros.

To define Trigger macros:

Click the Set Macro button in the Trigger Object Definition dialog box. The Trigger Macro Definition dialog box is displayed:

The following options are available:

- **Name**
  Specifies the name of the macro.

- **Description**
  Specifies a brief description of the macro.

- **Accelerator Keys**
  Alt, Ctrl, Shift, and Function keys that can be used in combinations to invoke the macro.

- **Confirm Before Execute**
  Causes the application to prompt you to confirm the execution of a macro before it is executed.

- **Execute when out of VP**
  Causes a macro to be executed even when the trigger object does not appear visually in the Image window.

- **Group**
  Used to assign groups to operators for macro authorization.
Note: Trigger macros will only be executed if the Trigger mode is activated (by selecting Trigger On from the Modes menu, in the Image).

**Marking Trigger Objects**

- **To mark trigger objects on the screen:**
  
  Select Mark Triggers from the Options menu in the Image.

  Or,

  Select the mark trigger toggle from the Image toolbar. After you select this item, a red-colored hand will appear in all the trigger objects in the Image.

- **To unmark the objects:**
  
  Reselect Mark Triggers. If the Trigger On mode is active, the hand cursor that appears will turn red when you click and hold the button down, and move the cursor within the borders of the object. When you leave the object borders (while still holding the button down), the hand will turn white.

  *Note: The <Spacebar> can be used to simulate the mouse button.*

  The Mark Triggers function will apply to any object. However, if an object is marked (with a red hand) to indicate that it is a trigger object, but that object is dynamically or manually transformed (moved, rotated, scaled, etc.), the trigger mark may disappear, or will not appear in its correct location. If this happens, you can press <ALT+R>, or click on the <r> button in the Image window, to redraw the Image. The hand will then appear in its proper location.

  Specify YES for the Trigger tab in the Image Properties dialog box to highlight trigger objects (outlined with dashed lines) when you click on the object and hold the mouse button down. The default for this parameter is NO.
Tag Value Sliders

Note: This feature is not supported on the web.

Tag value sliders (widgets) can be designed and used in an Image to change and read tag values in a simple visual manner. The sliders can be positioned anywhere in the Image and will automatically reflect any change in the tag value that occurs in the field.

The following is an example of a slider:

The following points should be noted when working with tag value sliders:

- Tag value sliders are system windows that operate using system controls.
- Tag value sliders are automatically generated as trigger objects, and therefore can only operate in the Trigger mode.

To design a slider:

From the Edit menu, point to Drawings and then to Widgets.

Or,

Select Slider from the popup menu.
Or,

Click the Slider button in the Objects Toolbox. The Slider properties dialog box is displayed:

The following fields are available:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station</td>
<td>Specifies the network station to which the tag belongs. For a list of stations from which you can select, click on the arrow to the right of the field.</td>
</tr>
<tr>
<td>Tag</td>
<td>Specifies the tag to be associated with the slider. For a list of tags from which you can select, click on the arrow to the right of the field.</td>
</tr>
</tbody>
</table>
To define a new media object:

1. Select the Media button from the Objects Toolbox.
2. Draw a rectangle in the initial size you wish.
3. The Media Player Properties dialog box opens where you can select the Media device (file) you wish to play.

Note: This feature is not supported on the web.
4. You can set the Media window to include a title bar with your own text.

The Media device will be displayed Stretched to the object size. A small control bar is displayed at the bottom on the object with the options to Play, Stop, Pause, Fast Forward and Rewind.

You can select and edit the object size and the location can be manipulated as any other object. To change the object properties, double-click on it.

*Note:* A Media Player cannot be grouped with other image objects.

**Scheduler**

The Internet based Scheduler enables you to easily create daily or weekly task orientated schedules remotely.

Before the Scheduler is accessed the Scheduler module must first be enabled in the Station Properties dialog box.

Access to the Scheduler is through password only. The user authorization rights defined in the application's User Management module are also relevant for this module.

Once accessed the user can schedule or modify operations for any workstation. For more information see Chapter 28, Scheduler.

*Note:* The user name and password are case sensitive.
To access the Scheduler through the Image module:
Access through the Image module can only be made if tasks have previously been defined in the Scheduler.

1. In the Image module when in Edit mode click the Scheduler icon in the Options toolbox. The clock icon with an arrow attached to it will replace your mouse arrow.

2. Draw an object. The Scheduler Task Configuration dialog box opens.

3. Click the arrow in the Task Name field and select a task from the list.

4. If relevant, click the Groups button and define access permission to the selected task and then click OK. A clock object will appear in the Image window.

5. Move to Trigger On mode and then click the clock object with the Trigger hand. The Scheduler Login page opens.

6. Type in your User Name and Password and then click the Login button. The selected task page opens in the Scheduler site.
**Tag Value Simulation**

After dynamic objects are defined, the operator can test an object's response to different tag values using an application mechanism that simulates tag values without affecting the tag itself. See Chapter 9, Tags for more information on tags.

► **To simulate tag values:**

Select Simulate from the Options menu. The Simulate Tag Values dialog box appears:

The following options are available:

- **Station**
  Specifies the application network station to which the tag belongs.

- **Tag**
  Specifies the tag to be simulated.

- **Current Simulated Value**
  Specifies the value being used for simulation.

- **New Suggested Value**
  Suggested simulation value. Enter a value or move the slider below. Extreme left is the lower range limit, extreme right is the upper range limit.

- **Exit**
  Exits the simulation.

- **Apply**
  Applies the suggested value.

- **Range**
  Range of simulation values for the slider.

After the required value is specified simulate in the New Suggested Value field and activate the Apply button, the value you specified will be simulated, and any dynamic or trigger object associated with that tag will be affected accordingly.
To set the simulation range:

1. Activate the Range button in the Simulate Tag Value dialog box. The following Simulating Tag Values: Range dialog box is displayed:

![Simulating Tag Values dialog box]

2. Enter the range limits. The scroll bar in the Simulate Tag Values dialog box will immediately be adjusted to the new range.
Chapter 21 RePlay Module

About this chapter:

This chapter describes the RePlay module.
RePlay Module - Overview on page 21-2 discusses the basic RePlay options.
RePlay Tags on page 21-4 discusses WIZRPL tags and their features.
RePlay Cluster on page 21-6 discusses the basic RePlay Cluster options.
**RePlay Module - Overview**

The RePlay module is used to view a graphical display of previous history tag values in images. The application reads and displays the tag values from the application's history. The RePlay module is activated from the Application Studio Control Panel. An application image cluster controls the RePlay itself.

*Note: Only tags that have Write to History defined during Tag Definition can be used. String Tags and Remote Tags are not displayed in this version.*

**Accessing the RePlay Module**

The RePlay module can be accessed by double clicking the RePlay icon in the Application Studio Control Panel.
This dialog box has the following fields:

**Image**  Where the image to be reviewed can be selected.

**Image Tags**  Where all the tags that are attached to the selected image are listed. This list only opens after an image has been selected.

**RePlay Images**  This field lists all the Images that have already been configured/replayed.

**RePlay Tags**  This field displays a list of all the image tags that you wish to replay as follows:

- **All** selects all the tags in the Image Tags list and moves them into the RePlay Tags list.
- **Selected** moves only selected tags from the Image Tags list to the RePlay Tags list.
- **Remove All** when selected removes all tags from the RePlay Tags list.
- **Remove Selected** when selected removes only selected tags from the RePlay Tags list.

**Create**  This button when clicked creates a cloned image and the dummy tags used in the RePlay.

**Progress**  This field shows the progress of the Create option.

1. In the Image field click the arrow to open a dropdown list and select the relevant image. The original image will open on your computer with a new name and all the tags that are attached to this image will appear in the Image Tags list.

2. From the Image Tags List, select the tags that will appear in the RePlayed image. Click the All button to select all the tags in the list, or select specific tags and then click the Selected button. The selected tags will be moved to the RePlay Tags list.

3. To remove tags from the RePlay Tags list either click the Remove All list or select specific tags and click the Remove Selected button.

4. Click the Create button to create dummy tags for the image. A cloned image will open displaying the selected tags.

*Note: Do not close the original image. When the Create button is clicked and if not all the Image Tags are selected as RePlay Tags, a message will open stating that the cloned image has missing tags.*
RePlay Tags

The RePlay Tags list is held in the Application Studio, All Containers pane under the Tags container. This list contains seven application dummy WIZRPL control tags and the dummy WIZRPL tags that are generated during image RePlay.

In the RePlay module the list of WIZRPL Tags appears in the RePlay Image field.

Dummy RePlay tags have the same attributes as the original tags used in the original image.

<table>
<thead>
<tr>
<th>All Containers</th>
<th>List of RePlay Tags</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_PLAYBACKDATE</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_STARTTIME</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_PLAYBACKTIME</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_STOP</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_STARTDATE</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_CONTROL</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00001</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00009</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00008</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00007</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00006</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00005</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00004</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00003</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00002</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00001</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00009</td>
</tr>
<tr>
<td></td>
<td>WIZRPL_TEST00008</td>
</tr>
</tbody>
</table>

Dummy WIZRPL Control Tags

There are seven dummy tags that are automatically created by the application. These tags are responsible for RePlay control and setup.

WIZRPL_CONTROL

This tag controls RePlay playback and can have the following seven values:

- 0 = Stop
- 1 = Play
- 2 = Pause
- 3 = Step Forwards
■ 4 = Step Backwards
■ 5 = Forward
■ 6 = Backward

**WIZRPL_STARTDATE**
This tag specifies the start date of RePlay history retrieval. The value of this tag is 8074, which is the number of days from 31.12.1979 to 7.2.2002.

**WIZRPL_STARTTIME**
This tag specifies the start time of RePlay history retrieval. The value of this tag is the number of seconds from midnight 00.00.00. For example, if the required time is 12.33.57 set the value to 45237.

*Note: There are 86400 seconds in a 24 hour day.*

**WIZRPL_DELAY**
This tag specifies RePlay playback delay. This indicates that after a specific time and date of history retrieval the RePlay module with pause for a specified time. The value is in milliseconds where 1000ms=1second.

**WIZRPL_STEP**
This tag species the RePlay playback history retrieval jump. History values will be read in stepped sections according to the defined size. For example, if the value is set to 1, RePlay will read history in 1 second resolution.

**WIZRPL_PLAYBACKTIME and WIZRPL_PLAYBACKDATE**
These tags show the current playback time and are not set by the user.

*Note: If a step has a 0 value RePlay will set it to a default of 1 second.
If the delay has a 0 value RePlay will set to a default of 1000ms.
If the Start date has a 0 value RePlay will set it to a default of today.
Settings can be modified only when the RePlay mode is at Stop.
Immediate RPL tag values can be assigned in the Single Tag Input dialog box. To do so, in the List of Replay Tags select a RPL tag and then right click and select Single Tag Input. For further details read Chapter 9, Tags.*
RePlay Cluster

The RePlay Cluster, controls historical data playback actions in RePlay images.

To access the RePlay Cluster Controls:

1. In the Image module when in an image, open the Cluster menu and select Open Lib.
2. In the Library List scroll down and select VCR and then drag it into the image. The Instance Parameters dialog box opens.
3. In the Instance Name field type in the relevant name and then click OK to open the RePlay Clusters Controls. (See Open Lib on page 19-51 in Chapter 19, Image Editor for further details).

This controls box has the following fields and buttons:

- **Step (seconds)**: This specifies the number of seconds that the RePlay history is read.
- **Delay (milliseconds)**: This specifies the number of seconds that the RePlay history can be delayed.
- **Start Time**: This specifies the time from which the RePlay begins.
- **Start Date**: This specifies the date from which the RePlay begins.
- **Playback Time**: The time that RePlay playback begins.
- **Playback Date**: The date that RePlay playback begins.

*Note: The definitions for Step, Delay, Start Time and Start Date can be defined in the Single Tag Input dialog box. See Chapter 9, Tags Single Tag Input on page 9-25 for further details. The Cluster Library has three types of VCR options, each of which has the same functions.*
This controls box has the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Stepped backwards</td>
</tr>
<tr>
<td></td>
<td>Fast back</td>
</tr>
<tr>
<td></td>
<td>Fast forward</td>
</tr>
<tr>
<td></td>
<td>Stepped forward</td>
</tr>
<tr>
<td></td>
<td>Play</td>
</tr>
<tr>
<td></td>
<td>Pause</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
</tr>
</tbody>
</table>

1. To select an action either; click the icon, or select Modes, Trigger on and then press the required action. A blue light on a selected action.

2. Press the Play button to start the RePlay. The data will be read starting at the date and time specified in the Start Time and Start Date fields. When the Play button is pressed the RePlay playback limit time is set to the current system time.

3. Press Stop to end the RePlay session.
4. Press Pause to pause the RePlay session.
5. Press Forward to fast forward the RePlay playback. The FastForward actions behaves differently according to the RePlay mode.
   - In Play mode and FF is pressed the data will be RePlayed and viewed at a faster pace.
When in Stop mode the data will not be read and therefore cannot be viewed. However the Date and Time fields will be updated. When the Play button is pressed again, RePlay will resume from the updated date and time.


7. Press Step Forward to jump forward in the Step value (WIZRPL_STEP tag). This is true only when the RePlay is in Pause mode.

8. Press Step Backwards to jump back in the Step value. This is true on when the RePlay is in Pause mode.

*Note: Step forward and Step backwards are only available in Pause mode.*
Chapter 22 Event Summaries

About this chapter:

This chapter describes the Events Summary module, as follows:

Overview on page 22-2 is an overview of the Events Summary features.

Creating and Modifying Events Summaries on page 22-3 describes how to define an Events Summary, how to close an Events Summary window, and how alarms are displayed in the Events Summary.

Operations on page 22-5 describes how alarm messages are handled in the Events Summary module.

Settings on page 22-14 describes how the layout of the Events Summary is defined and filtered. It also discusses the Online and History modes.

Reports on page 22-28 describes how reports are made and their options. It also discusses the Alarm History Folder.

Popup Events Summary on page 22-33 describes an Popup Events Summary, how to design it and to define its parameters, and how to make a Popup Events Summary buzz to indicate a severe warning.

Events Summary Properties on page 22-43 describes how to define Events Summary tuning parameters and Events Summary window attributes.
Overview

Note: This module is not enabled on the web.

The Events Summary is a window in which alarms are displayed. Several Events Summaries can be created each with different types of alarm categories. This enables the operator to identify the type of alarm. Alarms in the Events Summary can be classified according to several groups, and insignificant events and information can be inhibited for operator convenience.

Events Summaries operate in one of two modes, Online or History.

- In the Online mode, only active alarms are listed (according to the specified filters).
- In the History mode, a historical list of alarms is shown in the Events Summary (according to the specified alarm filter) and can be directed to the Internet, Intranet, operator's screen, file, or a printer.

The Events Summary can display alarms generated on any application station on the network. This way, an operator can see alarms of the same logical functional group from different parts of the controlled area.

Alarms are displayed in default colors, specified during Application Setup. Different colors for background and foreground (text) can be defined for each severity range and zone, but event time (Start Time, Ack Time and End Time) colors are assigned by the system and cannot be changed.

The event time colors are:

- Start Time - Red
- Ack Time - Black
- End Time - Green

Note: By default the background color for Start Time, Ack Time, End Time is white.
Creating and Modifying Events Summaries

This section describes how to create a new Events Summary and how to modify an existing one.

► To create an Events Summary:

Click the 📊 Events Summary icon in the Application Studio toolbar.

Or,

In the All Containers section of the Application Studio, right click Events Summaries and select New Events Summary from the popup menu. The Events Summary window appears as follows:

<table>
<thead>
<tr>
<th>Start Time</th>
<th>Zone</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>14:13:00.00</td>
<td>0</td>
<td>Station: Disk C 88% full ...</td>
</tr>
<tr>
<td>11:17:00.00</td>
<td>0</td>
<td>Station: Disk C 88% full ...</td>
</tr>
<tr>
<td>11:15:00.00</td>
<td>0</td>
<td>Station: Disk C 88% full ...</td>
</tr>
<tr>
<td>11:10:00.00</td>
<td>0</td>
<td>Station: Disk C 88% full ...</td>
</tr>
<tr>
<td>10:17:00.00</td>
<td>0</td>
<td>Station: Disk C 88% full ...</td>
</tr>
<tr>
<td>10:11:28.25</td>
<td>0</td>
<td>High</td>
</tr>
<tr>
<td>10:10:50.02</td>
<td>0</td>
<td>High</td>
</tr>
<tr>
<td>09:18:00.00</td>
<td>0</td>
<td>Station: Disk C 87% full ...</td>
</tr>
<tr>
<td>09:16:00.00</td>
<td>0</td>
<td>Station: Disk C 87% full ...</td>
</tr>
<tr>
<td>09:15:00.00</td>
<td>0</td>
<td>Station: Disk C 87% full ...</td>
</tr>
<tr>
<td>09:16:00.00</td>
<td>0</td>
<td>Station: Disk C 86% full ...</td>
</tr>
<tr>
<td>08:15:00.00</td>
<td>0</td>
<td>Station: Disk C 86% full ...</td>
</tr>
<tr>
<td>07:16:00.00</td>
<td>0</td>
<td>Station: Disk C 80% full ...</td>
</tr>
</tbody>
</table>
**Toolbar**

- **Save Event Summary**
- **Print Event Summary**

**Go to Zone**: Displays a graphical view of location where the alarm occurred

**Assist**: Opens either Html or system Help holding instructions for handling the alarm

**Ack All**: Acknowledges all alarms in the Events Summary. Once acknowledged these alarms will be deleted from the list.

**Ack Selected**: Acknowledges only selected alarms in the Events Summary. Once acknowledged these alarms will be deleted from the list.

**Force End**: This option is used to manually end an alarm.

**Messages**: These are general messages about the system.

**User Comments**: Which can only be written in Online mode. These comments are saved to the application's history together with the alarm.

**Online**: Toggles between the Online and the History mode.

**Inhibit**: Locks alarms for a specific period of time.
Operations

The options in the Operations menu can be applied to each individual event in the Events Summary or, as in the Ack All command to all the events.

To perform any operation on alarms in an Events Summary (except for Ack All), the alarm must first be selected. Selecting an alarm again will cancel the initial selection. Alarms that were modified, added, or deleted, will be sorted immediately into their correct locations.

- **Go to Zone**: Jumps to the graphical display of the cause of the alarm
- **Assist**: Opens either a system or Html Help file where instructions for handling the event are displayed
- **Ack All**: Acknowledges all the alarms in the Events Summary list
- **Ack Selected**: Acknowledges only the selected alarms in the Events Summary list
- **Force End**: This option enables the user to manually end an alarm.
- **Messages**: These are general messages about the system.
- **User Comments**: Add Comments - which can only be written in Online mode. These comments are saved to the application's history together with the alarm.
- **Inhibit**: Alarms that have been frozen for a predefined period of time

*Note: Events Summary operations can be performed only by authorized operators. Authorization is defined during Application Setup. These options can also be accessed by right clicking an alarm to open a popup menu. A selected alarm can be deselected by selecting a new alarm.*

Go to Zone

This option when selected, jumps to a graphical display of the cause of the alarm. The zone is defined in the Images module and attached to an alarm in the Alarms module - Alarms Definition dialog box - Actions on Alarms tab. See Chapter 19, Image Editor and Action on Alarm on page 13-15.
To activate the Go to Zone option:
Select the alarm in the Events Summary and then select Go to Zone from the Operations menu.
Or,
Select the alarm and then right click to open a popup menu. Click Goto Zone
Or,
Select an alarm and then click the Goto Zone icon.

Assist
This option, when selected, opens either a system or Html Help file where instructions for handling the event are displayed.

To activate the Assist option:
Select an alarm in the Events Summary, and then select Assist in the Operations menu.
Or,
Select an alarm in the Events Summary, and then right click to open a popup menu.
Select Assist.
Or,
Select an alarm and then click the Assist icon. The Assist message box opens.
Assist information is taken from alarm Help files.

Note: Alarm help can also be obtained by double-clicking on any alarm (for which a Help file exists) in the Events Summary.

**Ack All**

The Ack All option acknowledges all the alarms in the Events Summary.

▲ **To acknowledge all the alarms in the Events Summary:**

Select an alarm in the Events Summary, and then select Ack all in the Operations menu.

Or,

Select an alarm in the Events Summary, and then right click to open a popup menu. Select Ack All.

Or,

Select an alarm and then click the Ack All icon.

Alarms defined with the Class-at-Ack option are displayed individually, showing the Set User Class dialog box in which you can assign a class to each alarm.

If Acknowledge Time (Ack) appears in the Events Summary, the current time will be displayed in white.

The Events Summary can hold between 0-4000 alarms and can acknowledge between 2-1000.

You can display the name of the station from which the alarm was generated. The station name can also be used as a sort parameter.

**Ack Selected**

This option when selected acknowledges only the selected alarms in the Events Summaries list. If the Acknowledge Time (Ack) appears, the current time will be displayed in white. If the Ack column is sorted, the order of the alarms will change accordingly.

If the ACK value was specified for the ANN_DOUBLECLICK parameter in the WIZTUNE.DAT file, an alarm can also be acknowledged by double-clicking the alarm.

*Note: Alarms that are Acknowledged and Ended will not appear in the Events Summary.*
To acknowledge selected alarms in the Events Summary:
Select an alarm in the Events Summary, and then select Ack selected in the Operations menu.
Or,
Select an alarm in the Events Summary, and then right click to open a popup menu. Select Ack selected.
Or,
Select an alarm and then click the Ack Selected icon.

Force End
This operation is used to force alarms to end. This is useful to remove alarms that cannot be ended due to communication or equipment modifications, or other causes. An alarm that was force ended will be removed from the Events Summary.

To force alarms to end:
Select an alarm in the Events Summary, and then select Force end in the Operations menu.
Or,
Select an alarm in the Events Summary, and then right click to open a popup menu. Select Force end.
Or,
Select an alarm and then click the Force End icon.
If End appears in the Events Summary, the current time will be displayed in green.

Messages
This operation is used by the operator to spontaneously record alarm messages in the system. This enables the operator to immediately record special activities or outstanding events.

The operator can also overwrite an existing operator message (entered manually or automatically), and also view the edited message. This option can be used, for example,
to record only part of an on-going process for display, or to modify a message to meet a particular requirement.

All messages, whether entered manually or automatically, are recorded and can be retrieved.

► To record a new alarm message:
Select an alarm in the Events Summary, and then select Message in the Operations menu.

Or,
Select an alarm in the Events Summary, and then right click to open a popup menu. Select Message.

Or,
Select an alarm and then click the Messages icon.

![Message dialog box](image)

Alarms that are entered manually are assigned the default severity level 0, and the name MSGn, where n stands for the number of the alarm in the order of manually entered alarms (MSG1, MSG2, etc.). Manually entered alarms are always acknowledged. You can also edit a message and view the edited text, as described on the following page.

► To edit an existing message:
Select a message from the alarms list in the Events Summary, then select Message from the Operations menu and change the text.

► To view the changes made to the message:
Select the message in the Events Summary and then select Assist from the Operations menu.

Note: Using the above options, you cannot change the text of system alarms (alarms defined by selecting Alarms from the Design menu in the Studio Application, or by right-clicking Alarms in the All Containers section of the Application Studio).
An assistance file (.AHP) is generated for each operator message. This file contains all the operator message text except for the latest message entry.

User Comments

Comments regarding an alarm can be added to each alarm in the Event Summary. This feature is used by operators to keep track of significant events occurring in the plant.

- Comments can only be added if the Record to File attribute has been added to the alarm.
- Comments can be created in Online mode only but can be viewed in both Online and History modes.
- If in the History mode there are already comments then new comments can be added.

To add comments to an alarm:

Select the alarm in the Events Summary and then select User Comments from the Operations menu.

Or,

Select the alarm and then right click to open a popup menu. Click User Comments.

Or,

Select an alarm and then click the Add Comments icon.

The User Alarm Comments dialog box opens.
1. Type in your comments in the New Comments textbox and then click the Add button. Your comment will be entered in the Previous Comments textbox.

2. To clear a message from the textbox, select the message and click the Clear button.

3. Click OK to confirm.
**Inhibit**

The Inhibit option is used to periodically freeze an alarm for a predefined period of time. This feature is useful during maintenance when alarms can be deactivated and then reactivated when necessary. At runtime alarms can be inhibited from the Events Summary.

Selecting the Inhibit option from the Events Summary window opens the Internet Explorer where selected s can be inhibited.

► **To inhibit an alarm:**

Select the alarm in the Events Summary and then select Inhibit from the Operations menu.

Or,

Select the alarm and then right click to open a popup menu. Click Inhibit

Or,

Select an alarm and then click the Inhibit icon.

1. Select the level that you wish to inhibit and then check the Inhibit checkbox.

2. Click the Modify buttons to activate the changes.

3. To reactivate an inhibited alarm, select the alarm and uncheck the checkbox.

4. Click the Modify buttons to activate the changes.

**User Defined Status**

Alarm states are given in the States.dat file in the application's directory. When the application is loaded this file is read and information in it is used where applicable. This feature is optional. After they are defined, the new Alarm Status names appear in the Event Summary Columns dialog box, where they can be selected and added as new columns to the Events Summary (also on the Web). The status timestamp and user's name are also logged into the history file when an alarm is logged. Alarms can be assigned to a status by the user either in the Events Summary or Image modules.

User Defined Status names are local and are not transferred to other stations. Alarm messages, however are transferred to other stations where they can be handled. You can move an alarm to another user-defined status only if it has not already been
acknowledged. However, if the alarm has been moved to another status it cannot be moved back to its previous status.

If the user has already been authorized to acknowledge an alarm further authorization is not required where alarm status appear. Names are limited to hold up to 20 characters. (See Chapter 13, Alarms).

**Note:** If no names are defined then the default names AlarmStatus0 and AlarmStatus1 are given.

If in the Alarm Properties dialog box Allow User Defined Status is not checked then none of these column options are available. The default status names are language dependant.

**To define alarm status names:**

1. In the Alarm Properties General tab click the Status Names button to open the Alarm Status Names dialog box.

2. Type in the name of the alarm states in the 0 and 1 fields.

3. Click OK to save these definitions.

**Note:** When status names are not defined the default names Alarm Status0 user AlarmStatus0 time and AlarmStatus1 user AlarmStatus1 time are used by default.

**User Fields**

These are customized fields that are defined by the user in the Alarms Definition dialog box according to their specific requirements. User fields enable additional alarm filtering. There are five User Fields available. User Field names can also be modified in the application and in the alarm report definition dialog box. (See Chapter 13, Alarms).
To define User Fields do the following:

1. In the Application Studio toolbar select Design/Alarm Parameters/Field Names to open the Alarm User Field Names dialog box.

2. Upto 32 User Fields can be defined. In the relevant User Field make the relevant modifications.

3. Click OK to save these changes. The updated User Field names will appear in the Alarm Definitions and Event Summary Columns and in the History Filter dialog boxes.

**Settings**

Alarms can belong to several classifications. The Settings menu in the Events Summary window is used to determine which alarms will be displayed in the Events Summary and their order, alarms text and background colors. It is also used to view a list of alarm filters and alarms in historical and online mode. The following display options are available:

- **Display**: Specifies which alarm fields will be displayed in the Events Summary.
- **Filter**: Assigns values to alarm classifications so that the Events Summary will display only the alarms that meet these specifications.
- **Online**: Choose between Online mode for a list of alarms as they occur in the system, or History mode, for a list of historical alarms.
**Display**

The Display option is used to specify which alarm components will be displayed in the Events Summary.

► **To specify alarm components:**

Select Display from the Settings menu. The Display dialog box opens. This dialog box has four tabs:

- General: Where the Events Summary parameters for alarm Help text and for the alarm list are defined. See General Settings on page 22-16
- Columns: Where the alarms content fields displayed in the Events Summary and Popup Event Summary windows are defined. See Columns Tab on page 22-19
- Colors: Where text and background colors of the alarms displayed in the Events Summary and in the Popup Events Summary windows are defined. Colors are determined by the alarm Severity or Zone. See Alarm Colors Tab on page 22-20
- Events Summary Profile Settings: Where parameters used to monitor alarms on a Web browser are defined. See Events Summary Profile Settings Tab on page 22-21
General Settings

The General Settings dialog box defines Event Summary parameters for alarm Help text and for the Alarms List.

This dialog box has the following fields:

**Number of Alarms in Events Summary**
- This field defines the maximum number of alarms in the Events Summary. The default is 3200

**Max Number of Alarms for Ack All Operation**
- This field defines the maximum number of alarms that can be acknowledged in an Ack All operation. The default number is 500
Alarm Help Text Status
This field defines the status of alarm help: Assist - instructions for handling the alarm appear in Help files either system or HtmlAck - acknowledges the alarm Assist and Ack - both acknowledges the alarm and has Help file instructions

Choose Font
When clicked opens the Font dialog box where font type, size, style and color can be defined

Advanced
This button when clicked opens the Events Summary Window Attributes dialog box

Note: Setting Window Attributes is not applicable on the Web.

Events Summary Window Attributes
In this dialog box, you can assign default attributes to all windows of the type you selected (Image, Charts, Events Summary, or History Viewer).

environments[222, 109, 465, 422]

Axeda

Settings 22-17
This dialog box has the following fields:

**Title Bar**
The line in the window containing the title name. This is relevant only if the Title Bar is On.

**Name in Title**
The text appearing in the Title Bar.

**System Menu**
The menu that appears when you click on the small box at the top left corner of a window. This menu contains items that can be used to manipulate windows (move, size, close, etc.).

**Min/Max Button**
The buttons that appear in the upper right corner of a window. These buttons can be used to shrink or enlarge the window to predetermined sizes.

**Size Border**
Window borders that when clicked can be dragged to change the window size.

**Menu Bar**
The line in which the window menus appear.

**Always on Top**
Select to display the window viewport on top of other open applications.

**Pos**
The window X and Y position coordinates in pixels.

**Size**
The window size in pixels.
**Columns Tab**

This tab defines the column fields that will appear in the Events Summary.

The following options are available:

- **Columns**: This field defines the columns that will be displayed in the Events Summary.
- **Move up**: Moves the column one space up in the Events Summary window.
- **Move down**: Moves the column one space down in the Events Summary window.
- **Select All**: Selects all the column
- **Deselect All**: Deselects all the column
- **Default**: Returns this dialog box to the default options
**Alarm Colors Tab**

The Colors tab is used to assign alarm text and background colors according to their severity level or zone to alarms displayed in the Events Summary and Popup Events Summary. Up to 10 different colors can be defined for the text and background (10 for each).

1. Under Text/Background select either Zone or Severity to define whether the text/background colors pertain to the alarm severity or zone.
2. The values entered in each column represent ranges for which the sample colors will apply. The values should be entered in ascending order.
3. Each value has a color box that displays the selected color. To change this click the color box to display a standard colors dialog box, where you can select a color or define a custom color.
4. Click OK to confirm.
Events Summary Profile Settings Tab

This dialog box defines alarm monitoring on a Web browser.

To modify an Events Summary:

In the Studio List of Events Summaries right click on the Events Summary to open a popup menu. If the Events Summary is open then the properties option is enabled. Click Properties, the Events Summary dialog box is displayed.

1. Modify the existing Events Summary following the instructions for creating an Events Summary.
2. Click OK to confirm.
To exit the Events Summary:
Select Exit from the File menu, or double-click on the icon in the upper left corner of the Events Summary window.

Filter
The Filter option is used to assign values to each of the alarm classifications so that the Events Summary will display only the alarms that meet these specifications. Alarms are filtered according to family, severity, zone and classes. New filters can be added, existing filters can be modified or deleted.

Note: When a filter with a target file is defined and neither the Override or Auto Increment options are selected the Override option is automatically selected.

Defining Filters
To add filters:
In the Design menu select Popup and then Popup Filters. The Filters dialog box opens.
1. To add a filter, select a filter from the All Defined Filters list and then click the Add button. The filter will be added to the Selected Filters list.

2. Click OK to confirm.

► To delete a filter from the All Defined Filters list:
1. Select the relevant filter from the list
2. Click the Delete button. A message box will open asking if you are sure that you want to delete the filter.
3. Click Yes or No accordingly. The filter will be removed from the list.

► To remove a filter from the Selected Filters list:
1. Select the relevant filter from the list
2. Click the Remove button. The filter will be removed from the list.

► To create a new filter:
To create a filter, click the New button. The Filter Properties dialog box opens. There are three tabs; General Tab, Network Tab and Counters Tab.
**General Tab**

This tab holds general information about the filter.

1. In the Name field type a unique name for the filter.
2. In the Description field type a short description of the alarm filter.
3. Click the Family field's arrow to open the dropdown list and select a family. Only alarms from this family will be displayed.
4. In the Severity field specify the Minseverity and Maxseverity fields. Alarms out of these fields will not be displayed.
5. In the Zone field specify the Minzone and Maxzone fields. Alarms out of these zones will not be displayed.
6. Click the Select Class button to open the Set Class Filter dialog box.
Filter classes can be used to categorize alarms to identify them more easily and to filter them in the Events Summary. Classes can be added and removed individually or as a group by clicking the Set All and Reset All buttons. Click OK to return to the General tab.

7. Click OK to actually save the Alarm Filter definitions.

Note: *The Family name list is defined in the Tags dialog box in the Tag Name field.*
Network Tab

This tab is used to define the Filter Alarm's network station. The stations appearing in the List All Stations list are defined in the Network menu.

1. In the List All Stations column select the relevant station.
2. Either double click the station name or, click the forward arrow button. The station name will be transferred to the Selected Station column.
3. To remove a station from the Selected Station list click the backward arrow button.
4. Click OK to confirm.
Counts Tab
This tab defines the Alarm Filter dialog box columns.

1. To enable the fields in this dialog box check the Enable Count Alarms checkbox.
2. In each field click the arrow to open the dropdown list and make your selection.
3. Click OK to confirm. The defined fields will appear in the Filter dialog box.

To modify an existing filter:
1. To modify a filter select the relevant filter and click the Modify button. The Filter Properties dialog box opens.
2. Follow the instructions for creating a New filter.
Online

This option is used to select the Online mode for a list of alarms as they occur in the system, or the Reports mode, for a list of historical alarms. To toggle the Events Summary mode, select Online from the Settings menu. When the Online mode is not active (no check appears beside the item), the Reports mode is active.

Note: Alarms must be defined as Record to File in the Alarms module in order to be enabled in the History mode. The Online Mode window is automatically minimized after it is maximized.

Reports

The Report menu is enabled only when the Online mode is off. To turn the Online mode off, uncheck Online from the Settings menu.

The Reports menu enables you to:

- Define the Alarm Report see Defining Alarm Reports on page 22-29.
- Define the History folder see History Folder Settings on page 22-32.
**Defining Alarm Reports**

Alarm reports can have filters added to them.

► **To configure alarm reports:**

Select Options from the Report menu. The Alarm Report Definition dialog box is displayed.

The following options are available:

*Note: Where two sets of columns appear in a field, the first set is used for From values and the second for To values.*
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start time</strong></td>
<td>Specifies the range of date and time for the alarm start time that will appear in the report.</td>
</tr>
<tr>
<td><strong>Indicator</strong></td>
<td>Indicates whether the date and time is absolute or relative. Click inside the field to display the following options:</td>
</tr>
<tr>
<td>Absolute</td>
<td>The exact time specified. For example, if you specify the date 08-05-96, and the time 15:00:00, alarms will be listed from 3 PM on August 5, 1997.</td>
</tr>
<tr>
<td>Relative</td>
<td>The time and date that you specify will be relative to the current time and date. For example, for time 10:00:00 and date 3, alarms will be listed from 3 days and 10 hours ago.</td>
</tr>
<tr>
<td>Relative Date</td>
<td>Only the date that you specify will be relative to the current date (the time will remain absolute). For example, for time 10:00:00 and date 3, alarms will be listed from 3 days ago, at 10 AM.</td>
</tr>
<tr>
<td><strong>End Time</strong></td>
<td>Specifies the range of date and time for the alarm end time. Only alarms that ended in this date and time range will appear in the report. The options you can select for Indicator are the same as those for the <strong>Start time</strong> field described above.</td>
</tr>
<tr>
<td><strong>Ack Time</strong></td>
<td>Specifies the range of date and time for the alarm acknowledge-time. Only alarms that were acknowledged in this date and time range will appear in the report. The options you can select for Indicator are the same as those for the <strong>Start time</strong> field described above.</td>
</tr>
<tr>
<td><strong>Severity Range</strong></td>
<td>Specifies the range of severity levels of the alarms that you want to appear in the report.</td>
</tr>
</tbody>
</table>
**User Status**  
This feature is optional. User Defined Status names are local and are not transferred to other stations. Alarm messages, however are transferred to other stations where they can be handled. You can move an alarm to another user-defined status only if it has not already been acknowledged. However, if the alarm has been moved to another status it cannot be moved back to its previous status. If the user has already been authorized to acknowledge an alarm further authorization is not required where alarm status appear. Names are limited to hold up to 20 characters.

Alarm states are given in the States.dat file in the application's directory. When the application is loaded this file is read and information in it is used where applicable. If no names are defined then the default names AlarmStatus0 and AlarmStatus1 are given.

**Zone Range**  
Specifies the range of zones of the alarms that you want to appear in the report.

**Family Range**  
Specifies the range of family prefixes of the alarms that you want to appear in the report.

**User Field Range**  
These are customized fields that are defined by the user in the Alarms Definition dialog box according to their specific requirements. User fields enable additional alarm filtering. There are five User Fields available. User Field names can also be modified in the Application and in the alarm report definition dialog box.
History Folder Settings

This option is used to define the directory from which the application will extract historical alarm data files.

To specify a directory:

Select Alarms History Folder from the Reports menu. The History Directory dialog box is displayed, in which you can either specify the path of the directory in which the historical data file is located, or select the Use default history directory option.

---

**Selected Class**

Activate this button to select alarm classes so that only the alarms that belong to one of those classes will appear in the report. The Set Class Filter dialog box is displayed. Select the alarm classes you want, and click OK. To select all the classes in the box, activate the Set All button. To de-select all the classes in the box, activate the Reset All button.

**Alarm Path**

Additional field that filters alarms located in this level.

**Target**

In this field, specify the target of the alarm report to be generated. If you select File, specify the name of the file that you want the report to be written to.

File type in or click the browse button to locate the name of file that you want the report to be written to and then check either:
* Override the existing file
* Auto increment the file name to automatically add a consequencial number to the next file
The default directory is specified in the Set Default Paths dialog box for the Alarm History field.

Note: A history's path cannot have non-alphabetical or non-digital characters apart from spaces.

**Popup Events Summary**

The Popup Events Summary is an Events Summary that appears on the screen whenever a severe alarm occurs. As you define each alarm you can specify whether the alarm will appear in a Popup Events Summary or in an Events Summary. In addition, the operator can filter the alarms that will appear in the Popup Events Summary.

This section describes how to use a Popup Events Summary. The following is an example of a Popup Events Summary:
The following alarm information is displayed:

- **Alarms**: The number of alarms that appear in the Popup.
- **Date**: The Popup activation date.
- **Time**: The Popup activation time.
- **Alarm List**: A list of the active alarms in the Popup.

The following options are available:

- **Clear**: Clears the selected alarm from the Popup.
- **Clear All**: Clears all the alarms from the Popup. When this button is activated, the Popup Events Summary will automatically disappear from the screen.
- **Relax**: Clears the Popup Events Summary from the screen for a predefined period of time.
- **Quiet**: A list of the active alarms in the Popup.
Notes:

1. When the Clear button is activated and the alarm is removed from the Popup, the alarm's End or Ack status will not be affected.

2. When a Popup is activated (when an alarm becomes active) and appears on the screen, you will not be able to perform any system function until the Popup disappears. This is meant to draw the operator's attention to serious alarms. The Popup will disappear only when all the alarms in the list are cleared (either one at a time or all together). However, the operator can cause the Popup to disappear temporarily by activating the Relax button.

3. In the Popup an eight-star marker appears to the left of the alarm line. This marker indicates the alarm that is causing the current buzz.

Designing Popup Events Summaries

Popup Events Summaries are designed in the Application Studio Design menu where either Popup Filter, Popup Settings or Popup Buzz can be selected.

To design a Popup Events Summary:

Select Popup Settings from the Design menu in the Application Studio. The Popup Settings dialog box opens:

This dialog box has the following tabs:

- **Columns**: Where alarm fields displayed in the Events Summary and in the Popup Event Summary windows are defined.

- **Colors**: Where the text color and the background color of the alarms displayed in the Events Summary and in the Popup Events Summary windows are defined.

- **Popup Specification**: Defines the Popup Events Summary window attributes.
**Columns Tab**

This tab defines the column fields that will appear in the Popup Events Summary.

The following options are available:

- **Columns**
  This field defines the columns that will be displayed in the Popup Events Summary.

- **Move up**
  Moves the column one space up in the Popup Events Summary window.

- **Move down**
  Moves the column one space down in the Popup Events Summary window.

- **Select All**
  Selects all the column options

- **Deselect All**
  Deselects all the column options

- **Default**
  Returns this dialog box to the default options
**Colors Tab**

The Colors tab is used to assign alarm text and background colors according to their severity level or zone to alarms displayed in the Events Summary and Popup Events Summary. Up to 10 different colors can be defined for the text and background (10 for each).

1. Under Text/Background select either Zone or Severity to define whether the text/background colors pertain to the alarm severity or zone.

2. The values entered in each column represent ranges for which the sample colors will apply. The values should be entered in ascending order.

3. Each entry has a color box displaying the selected color. To change this, click the color box to display a standard colors dialog box, where you can select a color or define a custom color.

4. Click OK to confirm.
Popup Specifications

This tab defines the appearance of the Popup Events Summary window.

1. In the List Length field type in the length of the list that is displayed in the Popup window.
2. In the Relax Time field type in the amount of time that the Popup window waits before reopening on the operator's screen when the Relax or Quiet buttons are clicked in the Popup window.
3. In the Position field, specify the X,Y coordinates.
4. In the Size field specify the width and length.
5. Check the Title Bar field to display the title bar in the popup window.
6. Check the Show Old Alarms field to activate this checkbox. When this option is checked all alarms both present and past will be displayed. If this is not checked only new alarms will appear in the popup window.
7. To view these configurations click the Test button.
8. Click OK to confirm.
Popup Events Summary Buzz

The Popup Events Summary can be defined to buzz. This feature can be used to call the operator's attention to the screen and indicate a severe warning.

The buzz will be determined according to the alarm's severity. Different buzzes can be defined for different severity ranges. The Popup will buzz according to the parameters of the alarm with the highest severity.

*Note: Only alarms that belong to a class called Popup Buzz will be able to activate the Popup to buzz option.*

▶ To define buzz parameters:

From the Design menu select Popup and then Popup Buzz. The Popup dialog box opens.

The Sound of Buzz field is used to define the *.wav file and its tone.

- The Sound field when selected opens a browser where a *.wav field can be located and selected.
- The Tone field opens the Off time and Tone columns where these parameters are defined.

The following options are available for the Tone option:

- **Tone**
  
  Specifies the buzz tone for a severity range. The value is in Hertz, and can be from 37 to 32,767 (system limitation).

- **Sound**
  
  Specifies the buzz sound
Buzz Parameters
The following parameters are available:

**Severity Range**: Specifies the severity range for which the other parameters in this line will be relevant. The severity range will include all the severity levels greater than the one defined in the previous line, up to and including this severity.

**On Time**: Specifies the amount of time in 1/10 seconds that the Popup will buzz for a specific severity range. If you specify 0, no buzzing will occur for that severity range. This may be useful if you want to de-activate the buzzing for all alarms within a specific severity range.

*Note: It is recommended to specify short On-Time, up to 20 seconds, since this action uses large computer resources and slows the system.*

**Off Time**: Specifies the amount of time in 1/10 seconds that the Popup will be silent between buzzes.

Status Parameters
The following options are available:

**Buzz Acked Alarms**: Select this option if you want the buzz to operate on alarms that were defined to buzz, even if they were acknowledged.

**Buzz Ended Alarms**: Enables the buzz to operate on alarms that were defined to buzz, even if they were ended.

Test Severity Buzz
The following options are available:

**Severity**: Specifies a severity number to test how the Popup will buzz for the severity.

**Start Test**: Starts the buzz test. A buzz will sound according to the parameters you defined in the dialog box. When the buzz is operating, the Start Test button will change to the Stop Test button. You can activate this button to terminate the test.

*Note: In the Popup, the alarms causing the current buzzing will be marked by a small eight-star marker in the left margin of the line that contains the alarm.*
For Tone do the following:

1. Under Severity Range specify the range, for which the other parameters in this line will be relevant. The severity range will include all the severity levels greater than the one defined in the previous line, up to and including this severity.

2. Under On time specify the amount of time in 1/10 seconds that the pop-up will buzz for a specific severity range. If you specify 0, no buzzing will occur for that severity range. This may be useful if you want to de-activate the buzzing for all alarms within a specific severity range.

3. Under Off time specify the amount of time in 1/10 seconds that the pop-up will be silent between two buzz sessions.

4. Under Tone specify the tone frequency in Hertz units.
For Sound do the following:

1. Under Severity Range specify the severity range, for which the other parameters in this line will be relevant. The severity range will include all the severity levels greater than the one defined in the previous line, up to and including this severity.

2. Under Sound File, type the name of a sound file you want to play, or click the browse button to select a *.wav file.

3. Under Status Parameters select Buzz asked alarms if you want the buzz to operate on alarms that were defined to buzz, even if they were acknowledged.

4. Select Buzz ended alarms if you want the buzz to operate on alarms that were defined to buzz, even if they were ended.
5. Under Test severity buzz, enter a severity number for which you want to test how the popup will buzz for that severity level and click the Start test button to start testing (when clicked, this button turns into a Stop test button, click it to end testing session).

6. Click Apply for the changes to take effect.

**Events Summary Properties**

This section describes how to define Events Summary tuning parameters.

► **To define Events Summary properties:**

From the All Containers section of the Application Studio, right click on Events Summaries and select Properties from the Popup menu. The Events Summaries Properties dialog box is displayed:
The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alarm help text status</strong></td>
<td>The following options are available:&lt;br&gt;&lt;br&gt;<strong>Assist</strong>: Enables the user to obtain alarm help text from alarm Help files.&lt;br&gt;<strong>Ack</strong>: Acknowledges alarms.&lt;br&gt;<strong>Assist and Ack</strong>: Enables both the Assist and Ack options. This change can be implemented online.</td>
</tr>
<tr>
<td><strong>Scroll alarm list</strong></td>
<td>Enables the Events Summary to scroll and display alarms at the top of the list. If this option is checked, this parameter determines that when a new alarm arrives the Events Summary automatically scrolls to show the top alarms in the list. This ensures that if the new alarm is important, it will not be missed if the operator scrolled the list too far. Restart the application for changes to take effect.</td>
</tr>
<tr>
<td><strong>Show Force End</strong></td>
<td>User implements the Force End field, which helps the user to know whether the name that appears in the User field is the name of the person who ended or acknowledged the Alarm.</td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td>Defines Events Summary window attributes.</td>
</tr>
</tbody>
</table>
Defining Events Summary Window Attributes

Click the Advanced button in the Events Summaries Properties dialog box, to define default Events Summary window attributes.

The following options are available:

**Title Bar**
- Defines that a title will appear at the top of the window.

**Name in Title**
- Specifies that the name of the window will appear in the title bar.

**System Menu**
- Specifies that a menu appears when you click on the icon in the top left corner of the window. This menu contains items that can be used to manipulate windows, such as move, size, close and so on.

**Min/Max Button**
- Specifies that a Minimize and Maximize button appear in the top right corner of the window. These buttons can be used to minimize or maximize the window to predetermined sizes.

**Size Border**
- Enables window borders that can be dragged to change the window size.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Bar</strong></td>
<td>Specifies that a menu bar appears in the window.</td>
</tr>
<tr>
<td><strong>Always on Top</strong></td>
<td>Select to display the Events Summary window on top of other open applications.</td>
</tr>
<tr>
<td><strong>Pos</strong></td>
<td>Specifies the window X and Y position coordinates in pixels.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Specifies the window size in pixels.</td>
</tr>
<tr>
<td><strong>Title Bar Text</strong></td>
<td>Specifies the text that will appear in the Title bar.</td>
</tr>
</tbody>
</table>
Chapter 23 Events
Summary Profiles & Popups

About this chapter:

This chapter describes the Events Summary Profile that contains the definitions that determine the way alarms are displayed in a browser. It also describes how to create an Events Summary Viewer, an HTML page that features real-time monitoring of alarms. This chapter also includes a description of Events Summary popups, as follows:

Overview on page 23-2 is an overview of the Events Summary Profile and Events Summary Viewer features.

Defining and Modifying Events Summary Profiles on page 23-5 describes how to define which alarms will be displayed in the Events Summary, their order, how to assign alarms text and background colors.

Creating Events Summary Viewers on page 23-19 describes how to create an Events Summary Viewer by generating an HTML page from the Events Summary.

Default Location of Events Summary Profile Files on page 23-20 describes how to change the location of Events Summary Profile files.

Popup Event Summaries on page 23-21 describes how to use popup events Summaries to enable real-time monitoring of alarms.
Overview

This application enables real-time monitoring of alarms.

Events Summary Profile

The Events Summary Profile module holds the definitions that determine the way alarms are displayed on the Internet browser. The Events Summary Profiles dialog box has the following tabs:

- Alarm Filters: Which defines the alarm filtering criteria by which alarms are sorted and then displayed in the Events Summary.
- Display: Which defines the display parameters of the Events Summary window.
- Features: Which defines the features that will be enabled or disabled for the operator.
- Colors: Which defines the default colors.

Events Summary Profile files can be identified by their WNA file name extension.

Events Summary Viewer

The Events Summary Viewer features real-time alarms monitoring (online mode) according to the definitions specified in the Events Summary Profile. In addition to the Online mode, the application also provides a History mode that displays a report of historical alarms. This shows a list of alarm activities for a specified period of time. For example, alarm information one week before the current date.

The application enables you to define filters for the Events Summary Viewer to specify the type of alarm information that is displayed.

For example a filter can be defined that displays only alarms from a specific family such as; families beginning with the letter A. Filters can also be applied online to display a historical report.
The screen shot below shows an example of an Events Summary Viewer in Online mode.

<table>
<thead>
<tr>
<th>Start time</th>
<th>End time</th>
<th>Ack time</th>
<th>Severity</th>
<th>Text</th>
</tr>
</thead>
</table>

### Interacting with the Events Summary Viewer

Alarms are displayed according to the parameters specified in the Events Summary Profile. In the example above, alarm information is displayed in the following columns: Start time, Ack time, End time, Severity and Text. An operator can click a column heading to sort the information displayed in the column according to ascending or descending order.

The Events Summary contains the following options:

- **History**: Displays the Events Summary Viewer in history mode. (This option toggles with the Online mode, that displays the Events Summary Viewer in real-time.)

- **Load Picture**: Each alarm can have an image zone picture attached. When this option is selected and if an alarm is issued the selected image zone will open on the user's computer screen. To use this option the Image WNP files must first be saved.

- **Ack Selected**: Acknowledges selected alarms. If the alarm is ended the alarm will be removed from the list.

- **Force End**: Force ends displayed alarms. The time the alarm is ended is then displayed in the End time column. If the alarm is acknowledged it will be removed from the list.

- **Assist**: Online Help that can be used to handle the cause of the alarm.

- **Inhibit**: The Inhibit option opens a window displaying the alarm levels. Each level can be inhibited or not. All the alarms in an inhibited level will in turn be inhibited.
When a column heading is clicked, a down pointing arrow appears in the heading, which sorts the column information in descending order. Click the column again to display the information in ascending order. The arrow changes to an up pointing arrow. The width and the height of the columns are determined when generating the HTML page. However these can be changed manually by moving the columns lines Online.

**History Mode**

The following Events Summary Viewer is displayed in history mode.

<table>
<thead>
<tr>
<th>Start time</th>
<th>Ack time</th>
<th>End time</th>
<th>Severity</th>
<th>Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>10:11:14:01</td>
<td>10:11:15:12</td>
<td>10:11:15:16</td>
<td>0</td>
<td>run off</td>
</tr>
</tbody>
</table>
The following options are always available. The other options displayed here are described in the Events Summary Viewer on page 23-2.

**Online**
Displays the Events Summary Viewer in online mode.

**Columns**
Specifies the columns that will be displayed in the Events Summary Viewer. See page 5.

**Report**
Configures historical alarm reports. See Configuring Alarm Reports to Display Historical Information on page 23-17 for further details.

**Inhibit**
The Inhibit option opens a window displaying the s. See page 3.

**Add Comments**
Enables the operator to add comments regarding the alarm. See page 5.

*Note: Any changes you make to the Events Summary Viewer are available until you refresh. The next time you login, the default Events Summary Viewer parameters are displayed.*

**Defining and Modifying Events Summary Profiles**

This section describes how to define an Events Summary Profile and how to modify an existing Events Summary Profile.

► **To define an Events Summary Profile:**

Click the New Events Summary Profile icon in the Application Studio toolbar.

Or,

In the All Containers section of the Application Studio, right click Events Summary Profiles and select New Profile from the popup menu. The Events Summary Profile dialog box opens.
This dialog box has the four tabs:

- **Alarm Filters Tab**: Which defines the alarm filtering criteria by which alarms are sorted and then displayed in the Events Summary.
- **Display Tab**: Which defines the display parameters of the Events Summary window.
- **Features Tab**: Which defines the features that will be enabled or disabled for the operator.
- **Colors Tab**: Which defines the default colors.

To modify an Events Summary:

1. In the All Containers section, click Events Summary Profiles. The existing Events Summary Profiles are displayed in the List of Events Summary Profiles.

2. Double-click the Events Summary Profile you want to modify. The Events Summary Profile dialog box is displayed.
To insert an Events Summary Profile:

In the All Containers section, right-click Events Summary Profile and select Insert Profile from the popup menu. The Import File dialog box is displayed in which you can select a predefined Events Summary Profile and add it to the current application.

**Alarm Filters Tab**

The Alarm Filters tab enables you to set filter conditions for alarms. Only the alarms that meet these conditions are displayed in the Events Summary Viewer.

The List of Selected Filters lists all filters that have been selected in the application.

To select new filters:

Click the Select Filters button to open the Select Filters dialog box.

This dialog box has the following fields:

- **All defined filters**: Lists all defined filters in the application.
- **Selected filters**: Lists selected filters only.
To open the Filter Properties dialog box:

Click the New button or select a filter in the Select Filters dialog box and click Modify. The Filter Properties dialog box opens.

There are three tabs:

- General Tab
- Network Tab
- Counters Tab
General Tab

This tab holds general information about the alarm filters.

1. In the Name field type a unique name for the alarm filters.
2. In the Description field type a short description of the alarm filters.
3. Click the Family field's arrow to open the dropdown list and select a family. Only alarms from this family will be displayed.
4. In the Severity field specify the Minseverity and Maxseverity fields. Alarms out of these fields will not be displayed.
5. In the Zone field specify the Minzone and Maxzone fields. Alarms out of these zones will not be displayed.
6. Click the Select Class button to open the Set Class Filter dialog box.
   Filter classes can be used to categorize alarms to identify them more easily and to filter them in the Events Summary. Classes can be added and removed individually or as a group by clicking the Set All and Reset All buttons. Click OK to return to the General tab.
7. Click the Select Fields button to open the User Fields Filter dialog box. If User Fields have already been defined then the customized name will show for each field. If not, the default AlarmUserField0-5 name will appear. When a User Field is not filled then all filters from this type will be displayed. To display specific filters for this user field type in the filter type in the relevant text box. For Example; to see the AlarmUserField0 list beginning with A type the letter A*.

8. Click OK to actually save the Alarm filters definitions.
Network Tab

This tab is used to define the Alarm Filters network station. The stations appearing in the List All Stations list are active in the Network menu.

1. In the List All Stations column select the relevant station.
2. Either double click the station name or, click the Forward Arrow button. The station name will be transferred to the Selected Station column.
3. To remove a station from the Selected Station list click the Back Arrow button.
4. Click OK to confirm.
**Counters Tab**

This tab displays the status of the number of alarms in the system.

1. To enable the fields in this dialog box check the Enable Count Alarms checkbox.
2. In each field click the arrow to open the dropdown list and select the tag that will be counted.
3. Click OK to confirm. The defined fields will appear in the Alarm Filters dialog box.
**Display Tab**

The Display tab enables you to determine which of the parameters selected during alarm definition is actually displayed in the Events Summary Viewer. You can also determine the width of each column. The operator can then adjust the default display, resize columns and change alarm sorting at run time.

*Note: If an alarm is defined with both the Auto Acknowledged and Auto End options, it will be considered inactive and will not be displayed in an Events Summary Profile.*

The Display tab contains four columns in which display options are determined.

The following options are available:

**Column**
Displays the available alarm parameters such as Start time and End time. A parameter is selected/deselected for display by double-clicking inside the View column.
| **View** | Specifies which alarm parameters are displayed in the Events Summary Profile. Double-click inside the column next to the required parameters to select or deselect the parameters. A plus sign (+) indicates that the parameter is selected. |
| **Order** | Specifies the order of the alarms in ascending or descending order. Double-clicking in the column along side the required parameters toggles it between ascending and descending. |
| **Weight** | Specifies the amount of space designated to a column in relation to the entire Events Summary. Double-clicking in the column next to the required parameters displays the Update Weight Value dialog. You can then enter a new value in the Value field. |
| **Move Up / Down** | Specifies the position of the parameters in the Events Summary. To move a parameter, click on a parameter to select it and click the Move Up or Move Down button. The selected parameter will move up or down one place in the list. |
| **Sorted By** | Specifies the default sort order of the alarms. Click in the field and select a sort order from the drop-down list. For example, End Time. |
| **Time Format** | Specifies the alarm time format. Click in the field and select a time format option from the drop-down list. |
Features Tab

The Features tab enables you to determine operator options.

The following options are available:

- Allow Alarm Acknowledge
- Allow Force End Alarm
- Allow to Modify Sorting
- Allow to Change Filter Definition
- Allow Field Sizing
- Allow Column Selection
- Allow Alarm Assistance

1. Click the checkbox to left of an option to deselect an option. The checkmark is removed.
2. Click the check box again to enable the option.
3. Click the Select ALL button to select all options.
4. Click the Reset ALL button to disable all options.

**Colors Tab**

Different colors can be assigned for alarm text and background in the Colors tab. Specifying different colors for different types of alarms enables each alarm to be easily distinguished and categorized.

Different colors for background and foreground (text) can be defined for each Severity range and Zone.

*Note: Event time (Start Time, Ack Time and End Time) colors are assigned by the system and cannot be changed.*

![Colors Tab Interface]

- To assign text/background color to an alarm according to its severity or zone:
  1. In the text/background column select the Severity or Zone option from the By field.
  2. Enter the maximal value for the severity or zone in the numerical entry field.
3. Click the color box to the right of the entry field to display a color box in which you can select a color for this maximal value.

4. Click OK to activate and to close the dialog box.

Note: Alarms with severity or zone (according to the selection) below or equal to the entered maximum value will be displayed using the selected color. If the Ack Time or End Time option is not being used, the event time colors are applied to the Start Time option, if used.

Configuring Alarm Reports to Display Historical Information

The application provides the following filters that can be configured online to display a historical report.

- The range of date and time an alarm was activated.
- The range of date and time an alarm was acknowledged.
- The range of date and time an alarm ended.

▶ To configure an alarm report:

1. Select History in the Events Summary Viewer. The Events Summary Viewer is displayed in History mode.

2. Select Report. The Alarm Report dialog box is displayed:
This dialog box is similar to the standard Alarm Report Definition dialog box. For more information about specifying the filters in this dialog box, refer to the section on Reports on page 22-28 in Chapter 22, Event Summaries.

Click OK. The Alarm Report dialog box closes and a Progress dialog box is displayed while the application connects to the server.

A system file with an adb extension is created in the Docs/History folder of your application.

3. (Optional) You can stop the application from transferring the history information to this file at any time by pressing Cancel. The application then displays a message in the Events Summary Viewer, notifying that the history reading has been cancelled. When the query is complete, the application reads the history file prior to displaying the alarm report. A progress dialog box opens.

4. (Optional) You can click Cancel at any time to stop the application from reading the history prior to displaying the report in your browser. This is useful if the report is larger than you expected.

5. When the history reading is complete, the report is displayed in your browser.
Creating Events Summary Viewers

An Events Summary Viewer displays alarms generated in the system according to definitions specified in an Events Summary Profile.

Events Summary Viewers are created by generating an HTML page from the Events Summary Profile, in the system, and publishing the resulting page on the Web.

This section describes how to generate a single HTML page that contains the Trend Viewer. For details on generating a single HTML page that contains two or more objects or about publishing, refer to Generating HTML Pages with the HTML Assistant on page 26-4 in the HTML chapter.

To create an Events Summary Viewer:

Click the New HTML File icon in the toolbar.

Or,

From the All Containers section of the Application Studio, right-click HTML and select New HTML File from the pop-up menu. The Generate new HTML file dialog box is displayed:
The dialog box has three sections:

- Picture
- Events Summary Profile
- Trend Viewer.

1. Click the Include Events Summary Viewer box to enable the fields in this section.

2. Click the Profile box and select an Events Summary Profile file from the list of available Profiles.

3. (Optional). You can change the default width and height of the viewer in the Width and Height fields. It is recommended to generate the page first and view it in your browser, before changing the default options.

4. Click Generate. The New File dialog box is displayed fill in the file name and click Save. The page is generated and is saved in the list of Html files in the Application Studio.

5. Double click on the page in the List of HTML files to display it in your browser.

**Default Location of Events Summary Profile Files**

The location of the Events Summary Profiles folder (AnnPrf) is located by default in the Docs directory of the application. This can be viewed in the Set Default Paths dialog box.

*Note: Although the Events Summary Profiles path can be changed it is not recommended to do so.*
To view the Set Default Paths dialog box.

In the Design menu select Options and then Paths. The Set Default Paths dialog box opens.

![Set Default Paths dialog box]

**Popup Event Summaries**

The system supports Popup Events Summaries to enable realtime monitoring of alarms.

**Designing Popup Events Summaries**

Designing a Popup Events Summary that is displayed in a browser is identical to designing a standard Popup Events Summary.

See [Popup Events Summary on page 22-33](#) in the Event Summaries chapter.

The application supports all popup display options, excluding Buzz. These options are defined by selecting Popup Settings from the Design menu of the Application Studio, and are described in more detail in Chapter 22, Event Summaries.
**Viewing a Popup Events Summary in a Browser**

The following is an example of a Popup Events Summary that appears in a browser:

![Popup Events Summary Window](image)

The Popup Events Summary displays the following alarm information at the top of its window:

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alarms</strong></td>
<td>Specifies the number of alarms that appear in the Popup Events Summary.</td>
<td></td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>Specifies the date that appears in the server at the time the Popup Events Summary is activated.</td>
<td></td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>Specifies the time that appears in the server when the Popup Events Summary is activated.</td>
<td></td>
</tr>
</tbody>
</table>

Alarms are displayed in the Popup Events Summary according to the filter conditions specified when the Popup Events Summary is defined. The example on the previous page displays the following filters:

- **Start time** Displays the time the alarm was triggered.
- **Zone** Displays the zone defined for the alarm.
- **Text** Displays the text defined for the alarm.
The following options are available at the bottom of the Popup Event Summary:

- **Clear**  
  Clears the selected alarm from the Popup Events Summary.

- **Clear All**  
  Clears all the alarms from the Popup Events Summary.

- **Relax**  
  Clears the Popup Events Summary from the screen for a predefined amount of time.

---

**Enabling Popup Events Summary Display in Browsers**

You can specify whether or not Popup Event Summary display is enabled in a browser. Group authorization can be defined to determine that the Popup Events Summary is displayed only in the browser of authorized users.

▶ **To enable display in browsers:**

1. In the All Containers section of the Application Studio, right click HTML and select Properties from the popup menu. The HTML Properties dialog is displayed.

2. Select the Popup tab to display the following:

![HTML Properties](image)

3. Check that Enable Popup window in browser is selected so that the Popup Events Summary is displayed in the browser.

4. Click the Groups button to display the standard Groups dialog box in which you can assign group authorization for Popup Events Summary display.
Chapter 24 Charts

About this chapter:

This chapter describes how to define, edit and view Charts in the system, as follows:

Overview on page 24-2 is an overview of application Charts.

Basic Concepts on page 24-3 describes basic concepts common to Charts, including definition of graphs, Online/History mode, data boxes, and viewing conventions.

Menu Options on page 24-4 describes the Chart window menu options.

Chart Definition on page 24-6 describes how to define Charts.

Time Definition on page 24-7 describes how to determine the period for which tag values can be traced.

Graph Definition on page 24-9 describes how to define graphs in Charts.

X Axis Definition on page 24-22 describes how to create three types of graphs using the X axis.

Modes on page 24-25 describes the Chart's operational modes: History and Online modes.

Scrolling and Zooming on page 24-27 describes the scrolling and zooming operations.

Data Box on page 24-31 describes the data box which displays the graph tags, values and descriptions.

Grids on page 24-33 describes grids, which are sets of equidistant points covering the entire graph area.

Chart Properties on page 24-35 describes how to define the line style of a Chart and its window attributes.

Additional Features on page 24-37 describes additional features such as, setting a background color, smoothing graphs, the crosshair cursor, communication errors and authorization.

Keyboard/Mouse Action Summary on page 24-44 summarizes the Chart keyboard and mouse actions.

Functional Ranges on page 24-46 describes Chart functional ranges.
Overview

Note: This feature is not supported on the web. For Web, use Trend Profiles. See the Creating Trend Viewer chapter.

Charts provide graphical views of past and current activities recorded by the system. They can be used to reveal operational trends, compare device functionality and correlate actions and responses.

A Chart can be defined, edited and viewed. It is displayed in a window where up to 16 activities can be displayed simultaneously, each with its own color and style.

Chart operations are performed according to the operator's authorization level. For example, some operators may be able to define, edit, and view Charts; others may only be able to view Charts.

In addition to the standard window structure, the Chart window includes the following elements:

- **Graph Area**: The center area used to display graphs.
- **Tag (Value) Scale**: The vertical bar located to the left of the graph area (by default). This bar can be moved by dragging and dropping it at the right or left side of the window.
- **Time Scale**: The horizontal bar located at the bottom of the window, above the scroll bar.
- **Scroll Bar**: The bar at the bottom of the window used to scroll the Chart.

**Mouse Operations on the Time Scale**

Double-click on the time scale (horizontal axis) to open the Chart Time Definition dialog box, in which you change the specified range values.

In addition, several zooming and scrolling operations can also be performed on the time scale.
**Data Box Window**

A Data Box window can also be invoked to provide additional information. This window can contain a description of each graph and the position of the pointer with respect to the graphs, so that accurate readings can be made.

**Cursor Shapes**

You can change the regular cursor shape that appears in the graph area of the Chart to a crosshair.

**Basic Concepts**

The following basic concepts are common to all Charts:

**Graphs**

Each Chart can be composed of one or up to 16 graphs. Each graph represents the values of a specific tag and has its own attributes, such as style, pattern, color and scale.

All graphs are drawn according to a common time scale that you define at the beginning of the Chart definition procedure.

**Online/History**

Charts can display either Online data or Historical data.

- **Online Mode**: Graphs are constantly updated according to actual changes in field values.
- **History Mode**: The Chart can be configured to display tag values that occurred over a specified time period.

**Data Box**

A Data Box is an optional window that can be invoked to provide the graph tag names, descriptions and values.
Viewing Conventions

Specific views in a Chart are made fast and simple by manipulating the mouse in different ways. The mouse operations include double-clicking, marking a box, dragging and dropping. For example, any tag scale can be dragged and dropped to the right or left side of the Chart window.

Menu Options

The following menu options are available in the Chart window.

- **File Menu** in which you can specify Chart filing operations.
- **Setup Menu** in which you can define Chart components.
- **Modes Menu** in which you can set the Chart operational mode.
- **Operations Menu** in which you can perform various Chart and graph operations.
- **Options Menu** in which you can choose additional Chart options.
- **Help**, in which you can display Chart Help topics.

File Menu

The File menu contains the following options:

- **Save** Save the Chart.
- **Save As** Save the Chart under a different name.
- **Delete** Remove a Chart from the application.
- **Print** Print the currently active Chart.
- **Exit** Exit the Chart.

Setup Menu

The Setup menu contains the following options:

- **Graph Definition** Define graph characteristics
- **X Axis Definition** Create an X Axis in your graph
**Modes Menu**

The Modes menu contains the following options:

- **Online**
  - Graphically view tag value changes as they occur in the field.

- **History**
  - Graphically view historical tag values according to the specified time period.

- **Average**
  - Smooth a graph by averaging all the values that correspond to a particular time scale point.

- **Grid**
  - Create a grid graph.

**Operations Menu**

The Operations menu contains the following options:

- **Zoom Back**
  - Revert back to the last interactively defined state of the graph or scale.

- **Default**
  - Revert back to the initial zoom state of the graph or scale.

- **Zoom**

- **Goto**
  - Search for a particular section of the graph and display that section in the Chart window.
Options Menu

The Options menu contains options that are toggled on and off, as follows:

- **Online scroll step**: Optimize automatic scrolling.
- **Cross hair**: Change the regular mouse pointer in the graph to a cross hair shape.
- **Data box**: Present graph tag and time values according to the current pointer location, or current tag values.
- **Hide Vertical Scales**: Remove the vertical scales from the Chart.
- **Hide Horizontal Scale**: Remove the Horizontal scales from the Chart.
- **Hide Scroll bar**: Remove the Scroll bar from the Chart.

Chart Definition

Chart Definition involves the following steps:

- Opening a Chart window. See Opening a Chart Window on page 24-6
- Defining Chart time. See Time Definition on page 24-7
- Defining graphs. See Graph Definition on page 24-9

Opening a Chart Window

The first step in Chart definition is opening a Chart window.

To open a Chart window:

- Double-click the Chart button in the Application toolbar.
- Or,

In the All Containers section of the Application Studio, right click Charts and select New Chart from the popup menu. An empty Chart window is displayed:
**Time Definition**

The Chart time determines the period for which tag values can be traced. There are three components in the Chart time definition:

- Chart start time.
- Chart time period.
- Window time period.

*Note: In the History mode, the Chart time is fixed. In the Online mode, the Chart time will continuously change according to the current time.*

- **To define the Chart time periods:**
  
  On the Chart that is displayed, double-click on the time scale.
  
  Or,

  From the Setup menu, select Time definition. The Chart Time Definition dialog box is displayed:
The following options are available:

**Chart start time**

Specifies the date and time from which the data will begin to be monitored. Click in the Indicator field to select one of the following options:

**Absolute:** Specifies an exact time and date. For example, if you specified the date 08-05-96, and the time 15:10:00, the data will monitored from 3:00 PM on August 5, 1997.

**Relative:** Specifies the amount of time until the data begins to be monitored. For example, for time 10:00:00 and date 3, the data will begin to be monitored in three days (72 hours) and 10 hours after runtime.

**Relative Date:** Specifies the number of days until the data begins to be monitored. The time remains absolute. For example, for time of 10:00:00 and date of 3, the data will begin to be monitored on the third day after runtime, at 10:00:00 AM.
Once the Chart time periods are defined, you can then define the graph, and other Chart components.

**Graph Definition**

Graph definition is the next step after the Chart time definition. Graphs are defined by specifying the following items:

- A tag to be represented by the graph.
- The tag value limits.
- Graph display attributes.
- Control limits.
- Graph description.

Each Chart can be composed of one or many graphs. Each graph represents the values of a specific tag and has its own attributes, such as style, pattern, color and scale.

All graphs are drawn according to a common time scale that you define at the beginning of the Chart definition procedure.

<table>
<thead>
<tr>
<th>Chart time period</th>
<th>Specifies the time limits of the Chart. You can define up to 365 days.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window time period</td>
<td>Specifies the length of time that is viewed in a single Chart window. For example, even though you define your Chart to include a thirteen-day span, you may only want to view the values for three days in the Chart window at any given moment. The window time period cannot be longer than the Chart time period.</td>
</tr>
</tbody>
</table>
Tag Value Display

The Chart window can include up to 16 graphs. Each graph represents one tag. Several parameters control the graph display. A graph can appear in one of the following forms:

- Bar
- Line
- Line with Markers
- Markers only

Note: If you have defined different graphs in different colors in the same Chart, you can use the multi-marker option to automatically assign different shaped markers to each graph.

Remember that for each type of graph, you can also select a fill pattern. An example of a fill pattern defined for a graph is shown in the following Chart:
To define a graph:

From the Setup menu, select Graphs definition.

Or,

Double-click in the graph area of the Chart window. The Graphs Definition dialog box is displayed:
The following options are available:

**Display parameters**
Enables you to select a graph type. The following options are available:

Type: Click in the field to display the following options.

- **Line**: This option displays a curved line connection.
- **Line with markers**: This option displays a line that indicates where tag value changes occurred.
- **Markers only**: This option is without connecting lines.
- **Bar (histogram)**: This option represents points.

**Logarithmic Display**: Determines that the tag scale of the graph displays logarithmic values.

**Graph color**: Specifies the color of the graph. Click on the arrow to the right of this field and select a color.

**Graph pattern**: Specifies the fill pattern. Click on the arrow to the right of the field and select a fill pattern.

**Fill reference**
Determines how a selected pattern will fill the graph, as follows:

- **Low Limit**: Causes the pattern to fill the graph line down to the lower limit value of the graph (the value specified in the Low option of the Tag Scale Limits field).

- **Value**: Causes the pattern to fill the graph line in between the highest and lowest limits defined in the Tag Scale Limits field.
### Tag parameters

The following options are available:

**Station:** Specifies the station to which the tag belongs.

**Tag:** Specifies the tag represented in this Chart.

**Display bit number:** Display a chart on a tag's bit. To activate this option check the checkbox and then scroll to select a bit number (0 to 15). This option can be used only with signed/unsigned 16 and signed/unsigned 32 tags.

**Label:** Specifies a description of up to four characters that represent the type of units in the graph. For example, lbs can be used for weight.

### Tag scale limits

Specifies the limits of the scale.

- **Low:** Specifies the lowest value that will be presented in the graph.
- **High:** Specifies the highest value that will be presented in the graph.

These values appear as the vertical axis limits for the graph.

**Default tag limits:** Determines that the specified limits are the default limits for any other tag you add to the graph.

### Extended parameters

The following options are available:

**Control limits:** Specifies the lowest and highest tag values for which graph lines will be drawn.

**Description:** Specifies a description for the graph.

**Reference Graph:** Sets the parameters for the graph.
1. To add the tag to the tag list click the Add button.
2. To change the attributes of a specific tag in the list select the tag, change the attributes, and click the Change button.
3. To delete a tag from the list select the tag and click the Delete button.

**Control Limits**

Control limits enable an operator to immediately detect events considered as extreme situations. For example, if the temperature of an engine exceeds a certain limit. The limits appear in the Chart as two horizontal lines, one for the upper limit and one for the lower limit.

You can select an option to invert the color of values in the graph that exceed the control limits. The control lines and inverted color make it easy to notice any value that exceeds the limits, so that appropriate action can be taken.

**Logarithmic Display**

The logarithmic display is defined in the Graphs Definition dialog box. It obtains logarithmic tag scale values. See Graph Definition on page 24-9.

**Fill Reference**

The Fill reference option is defined in the Graphs Definition dialog box. It determines how a selected pattern will fill the graph. It consists of two options: Low Limit and Value.

**Low Limit**

Selecting the Low Limit option causes the pattern to fill the graph line down to the lower limit value of the graph (the value specified in the Low option of the Tag Scale Limits field).

**Value**

Selecting Value: Causes the pattern to fill the graph line in between the highest and lowest limits defined in the Tag Scale Limits field.
Tag Scales

The tag scale consists of a predefined value range defined in the Graphs Definition dialog box along the vertical axis. Up to 16 tag scales can appear simultaneously in a single Chart window.

By default, all the tag scales are located in a pile to the left of the graph area. You can move a tag scale by right clicking on the scale, dragging it to the left or right side of the graph area, and dropping it at the new location.

Any scale located in the pile of scales on the left side of the window, can be moved to the top of the pile simply by clicking on the right or left arrow button below the menu bar.

Note: Since scale units may sometimes be too large to appear on the scale, the units have a maximum of four digits. At the bottom of the tag scale, the units appear in powers of ten to indicate the actual unit values.

If a graph description was defined to appear in the Chart during the graph definition procedure, the description appears to the left of the tag scale.

Setting Control Limits

You can specify the low and high limit values that will be marked by horizontal lines across the Chart. You do not have to specify both limit values.

▶ To set control limits:

Click the Control Limits button in the Graphs Definition dialog box. The Control limits dialog box is displayed. Fill in the fields as required, and click OK.
The following options are available:

- **Draw low limit**: Specifies the low limit value. Enter a value in the Low limit field.
- **Draw high limit**: Specifies the high limit value. Enter a value in the High limit field.
- **Invert color out of limits**: Causes the graph values that exceed the control limits to appear in inverted color. If you select this option, the Draw options are enabled.

*Note: If you do not select a Draw option or the Invert Color option, the low and high value fields are disabled.*

**Specifying a Description for the Chart**

The Chart description can either be the text specified for the tag during the tag definition, or any other text that you specify.

Select the Write description on scale option if you want the description you specified to appear beside the tag scale in the Chart.

► **To enter a description:**

Click the Description button in the Graphs Definition dialog box. The Graph Description dialog box is displayed. Fill in the fields as required, and click OK.
The following options are available:

- **Use tag description**: Uses the description specified for the tag during tag definition.
- **Enter description**: Uses the text that you enter in the field below as a tag description.
- **Write description on scale**: Specifies that the description appears beside the tag scale.

*Note: You cannot define two graphs for an identical tag.*

**Setting Reference Graph Parameters**

A reference graph is a graph with a predefined set of values chosen by the engineer. The values are either supplied manually or taken from the history of a specific tag in a specific time period.

A reference graph is attached to a standard graph and is used to graphically represent the desired behavior of that standard graph. It enables the operator to graphically compare the actual behavior of a tag with the required one.

You can define a reference graph for each standard graph. You can also define one reference graph for all the standard graphs in a Chart window. For example, a Chart showing the heat of two ovens in identical manufacturing lines. One reference graph can be created for each of these lines.

The definitions of a reference graph are saved in the Chart window file and its points in a separate file. The engineer is able to select the file to receive the points of a new reference graph. If there is a reference graph that is the same in two Chart windows, the engineer does not have to define it twice.

A reference graph shares the following attributes with its standard graph.

- Type: Bar, Line, Line with marker, Marker only
- Logarithmic display
- Fill reference
- View limits
- Control limits
A reference graph has the following display parameters:

- **Color:** The default is the standard graph color.
- **Pattern:** The default is the standard graph pattern.
- **Line Width:** The reference graph has thicker lines than the standard graph.

**To set reference graph parameters:**

After defining a graph and adding it to the tag list in the Graphs Definition dialog box, click the Reference button. The Reference Graph Definition dialog box is displayed.
The following options are available:

**Reference Name**
Specifies a name for the reference graph.

**Display parameters**
The following options are available:

- **Graph color**: Specifies the graph color. The default color is the standard graph color.
- **Graph pattern**: Specifies a pattern for the graph. The default pattern is the standard graph pattern.
- **Line Width**: Determines a reference graph with the standard graph color but with thicker lines. The default is a thicker line than the line in the standard graph.

**Source of Data**
The following options are available:

- **History**: A reference graph whose points are taken from the history of a specific tag from a specific time period.
- **Manual**: A reference graph whose points are entered manually by the engineer, as described below.
- **Existing**: A reference graph that was used for another standard graph.

**Source Parameters**
Source parameters exist for:

- **Manual**: Source parameters are displayed by default and its fields are: described below.
- **Existing**: A reference graph that was used for another standard graph.
- **Station**: Specifies the station to which the tag belongs. The default is the station defined in the standard graph.
- **Tag**: Specifies the tag represented in this Chart. The default is the tag defined in the standard graph.
- **Data Time Period**: Specifies the time period from which to take the history of the tag. Includes the Chart start time and its time length.
Enter the parameters to define the required reference graph and select a source of data. The source parameters of the data source are described in the following sections.

**Manual Source Parameters**

When Manual is selected as the data source in the Reference Graph Definition dialog box, a reference graph can be defined in which its points are entered manually by the engineer.

- To display the manual source parameters:

Select Manual in the Source of Data field. The following source parameters are displayed in the Reference Graph Definition dialog box and the Draw Reference Graph Point window is displayed underneath the Reference Graph Definition dialog in which an engineer can manually map values.

The point values with their stamp are displayed. The time stamp will begin with 00:00:00.

There are two possible ways for the engineers to enter points:

1. Moving the cursor over the graph: The values are reflected in the Time and Mili and Value fields of the source parameters. Each time the engineer clicks the mouse, the value appears in the source parameters list of values. Clicking OK will save the definitions and close the dialog box.

2. Entering a list of values into the Values field of the source parameters. Clicking OK will save the definitions and close the dialog box.
**Existing (File) Reference Graph**

When Existing is selected as the data source in the Reference Graph Definition dialog box, a reference graph can be defined that has been used for another standard graph.

► **To display the Existing source parameters:**

1. Select Existing in the Source of Data field. The following source parameters are displayed in the Reference Graph Definition dialog box.

2. Select one of the list of existing reference graphs.

3. Click OK to close the dialog box.

**Runtime Behavior of a Reference Graph**

The following describes the runtime behavior of a reference graph.

- A reference graph is displayed in both History and Online mode in the background of the standard graph to which it belongs.
- Data for history reference graphs is read from the directory defined in the Chart history directory definition.
- A reference graph field can be added to the data box, called reference value. In this field the data box will put the value of the reference graph under the mouse pointer.
This field will be empty when the data box is showing current values, because reference graphs have no current value.

- Since the reference graph is used only for comparison it will not have a scale.
- Zoom and scroll operations will apply to reference graphs as for standard graphs.
- Average mode will apply to reference graphs as for standard graphs.
- XY Chart: behavior: Same as for time graph.

**Single Graph Definition**

You can change the attributes of a graph in the Chart by double-clicking on the tag scale of that graph (in the Chart). The Graph Definition dialog box is displayed in short form, without the graph list, for you to modify.

**X Axis Definition**

Three types of graphs can be presented in a Chart, as shown in the diagram below.

- Two types of XY graphs, in which the X axis represents tag values as illustrated below.
- Time graphs, in which the X axis represents time.

---

**XY Graph**

![XY Graph](image)

**Time Graph**

![Time Graph](image)
To select the graph type:

From the Setup menu, select X axis definition. The X axis definition dialog box is displayed:

The following options are available:

**Time**
- **Time** Displays the time values of the X axis.
- **Time and Date**: Displays the Chart time and date in the scale.
- **Time only**: Displays only the Chart time in the scale.
- **Date only**: Displays only the Chart date in the scale.

**Tag**
- **Tag**: Displays the tag values of the X axis.

If you select this option, specify the tag with which you want the X axis to be associated. For a list of tags defined for the current Chart, click on the arrow to the right of the field.
Graphs Sort Reference

In the graph sort reference of the X axis definition dialog box, you can determine the order in which the graph points are connected and indicate which points will appear on the graph. For more details see below:

**Time**: Causes the graph points to be connected in the order of the time the values changed. In this case, all points will appear on the graph.

**X Tag Values**: Causes the graph points to be connected in the order of X values. In this case, for each X there will be only one point on the graph. This point will be of the last Y value in the requested time range.

**Graphs Sort Reference**

For example, suppose the following set of tag values was obtained:

<table>
<thead>
<tr>
<th></th>
<th>Time 1</th>
<th>Time 2</th>
<th>Time 3</th>
<th>Time 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X</strong></td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>0</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

If you select Time, the graph is displayed on the following points:

(0,0), (0,2), (4,2), and (2,2). In this case, there are two points (0,0) and (0,2) with the same X value but two different Y values.

If you select X Tag Values, the graph appears on the following points: (0,0), (2,2), and (4,2). In this case, only the last point for the 0 X value is displayed. Note that the order of the points is by their X value order.
Charts can run in one of two operational modes: History Mode or Online Mode.

**History Mode**

Historical Charts provide graphical information for recorded values. This operational mode can be used as an analytical tool to help discover patterns and trends in the plant.

To activate historical Charts:

From the Modes menu, select the History option. A check mark appears beside it to indicate that it is active.

The History mode is indicated in the Chart by an icon that appears in the time scale.

In the History mode, the Chart includes a horizontal scroll bar that can be used to scroll the Chart. The scroll bar has the following characteristics:

- The left side of the bar represents the Chart start time.
- The right side of the bar represents the end of the Chart period.
- The location of the slider in the scroll bar represents the relation between the window and Chart start times.
- The size of the slider represents the relationship between the window and Chart time periods.

**History Directory**

Historical data is stored in a default system location specified in the Design menu of the Application Studio. The directory from which the historical data is taken can be changed.

To retrieve data from a different location, a new path name must be specified. Refer to Chapter 4, Getting Started and Chapter 5, Getting to Know the Application Studio for more details about defining path names.

*Note: A history’s path cannot have non-alphabetical or non-digital characters apart from spaces.*
To assign a historical data path name:

From the Setup menu, select the History directory option. The History Directory dialog box is displayed in which you can specify the directory path from which you want your historical files to be extracted.

Online Mode

Online Charts can be used to graphically show a process in progress, by demonstrating operational trends and correlation between parameters.

Online Charts are continuously scrolled along the time (X) axis, so that full window updates are continuously shown.

*Note: If the X axis was defined as sorted by Time, each time a tag value on the X or Y axis changes a line will be drawn from the last point on the graph to the new point.*

If the X axis was defined as X Tag Values, each time an X value changes, the Chart module will check each Y scale. If a Y axis value exists for the X value, the current Y value will replace the X value. If no Y value exists for the X value, the new point will be added to the graph (X, current Y). Each time a Y value changes, and a valid X value exists for that Y value, the new Y value will replace the old Y value.

To activate Online Charts:

From the Modes menu, select the Online option. A check mark appears beside it to indicate that it is active.

*Note: When the operational mode is changed from Historical to Online, the Chart automatically jumps to the current time.*
The Online mode is indicated in the Chart by the icon that appears in the time scale as follows:

![Online Scroll Icon]

**Online Scroll**

Automatic scrolling occurs in the Chart whenever the graph reaches the extreme right side of the window. This is determined by the window period configured for the Chart. You can regulate automatic scrolling.

**To regulate automatic scrolling:**

From the Options menu, select Online scroll step. A popup menu displays the following options:

- **No step** - The default scroll (one small bar at a time appears on the time scale).
- **Full window** - A scroll of one full window.
- **1/2 window** - A scroll of one-half of the current window size.
- **1/3 window** - A scroll of one-third of the current window size.
- **1/4 window** - A scroll of one-fourth of the current window size.

---

**Scrolling and Zooming**

Several Chart scrolling and zooming operations can be performed to view the graphs in the chart in different ways. This enables you to obtain specific tag value information quickly and easily.

The different scrolling and zooming operations are described in the following pages.

**Scrolling**

Scrolling in the chart is the same as navigating through time in the chart. As you scroll the chart back and forth, the appropriate historical values appear.

Besides the automatic scrolling feature mentioned in the section called Online Mode, you can also scroll a graph in the following ways:
By manually by clicking on the right or left arrow of the scroll bar.
By clicking inside the scroll bar area.
By dragging the scroll bar slider.

**Zooming**

Zooming can be performed on three different components of the Chart window:

- The graph area.
- The tag scale.
- The time scale.

Several zooming operations are common to all chart components. These operations include the following:

**Zoom In**

This operation is used to view a specific part of a graph. To zoom into a specific area in a graph, an area must first be designated by drawing a box (clicking and dragging the mouse) to cover the desired part of the graph, time scale, or tag scale. Then, clicking the mouse in the box you drew causes that part of the graph to fill the entire window.

Note: If the zoom in operation was performed in the graph area, the scales change accordingly. Similarly, if the zoom in operation was performed on one of the scales, the graph area also changes accordingly.

In addition, you can also perform the following zoom in operations, using the right mouse button:

- Right-click once on the time scale to zoom in the graph window periods by a factor of 1.5.
- Right-click once on a tag scale to zoom in the graph.
Zoom Out
This operation is used to obtain a broader view of a specific part of a graph.
The following zoom out operations can be performed using the left mouse button:
- Left-click once on the time scale to zoom out the graph window periods by a factor of 1.5.
- Left-click once on a tag scale to zoom out the graph.

Zoom Back
This operation is used to undo the last zoom operation, and can undo a maximum of ten previous operations.

➤ To Zoom Back:
From the Operations menu, select the Zoom Back option.
Or,
Press the ESC key.

Default Zoom
This operation is used to revert back to the initial zoom state of all the graphs (to how the chart first appeared when it was defined), according to the original window time definition.

➤ To activate the Default Zoom option:
From the Operations menu, select Default Zoom.
Or,
Press the HOME key.
In the Online mode, the chart reverts to how it appeared when the Online mode was first activated, except for the time scale, which displays the current time.

Zooming In - Online Mode
A zoom in operation can also be performed in the Online mode. When you zoom into a specific area of the graph in the Online mode, automatic chart scrolling ceases, and the area you zoomed in to fills the entire graph area.
Note: To reactivate online scrolling and return to the original online state of the graph, from the Operations menu, select Default Zoom.

A zoom operation in the Online mode is indicated by an icon that appears in the time scale, as follows:

![Time Scale with Zoom Icon](image)

**Goto**

In addition to the zoom operations described above, you can also perform a Goto operation. This operation is used to search for a particular section of a graph, then to display it in the window. The search is based on time, and it is modeless. This means that you will be able to go to a specific graph section, perform any operation in that section, go back to the previous location in the graph, and so on.

► **To perform a Goto operation:**

From the Operations menu, select Goto. The Goto dialog box is displayed:

![Goto Dialog Box](image)

The following options are available:

- **Window start time**
  
  Specifies the date and time to search for.

- **Window time period**
  
  Specifies the time period for which the window of the graph appears.

- **Go**
  
  Activates the search.

- **Go back**
  
  Jumps back to the last location before the Goto operation was performed.
**Data Box**

A Chart data box is a separate window that can be invoked at any time to view the graph tags, values, and descriptions.

A data box presents graph tag and time values according to the current pointer location, or current tag values.

You can determine its setup, as described on the following page.

**To display the Chart Data Box:**

From the Options menu, select Data box. A check appears beside the item to indicate that the box is active and the data box is displayed. The following is an example of the data box of an existing Chart.

<table>
<thead>
<tr>
<th>Value</th>
<th>Reference Value</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Data Box includes a Value Table field that contains a list of tag names, descriptions, and values according to the current pointer location in the graph, or current tag value. Each tag line appears in the color of the graph it represents. The data can be scrolled using the scroll bar.

The time field in the Data Box shows the time according to the pointer position in time graph and the start time and period of the data shown in the window in XY graphs.

By default, the Data Box appears below the Chart, but can be positioned anywhere on the screen. The Data Box will never be covered by the Chart. The Data box can be resized.

**Data Box Setup**

This section describes how to configure data box parameters.

**To display the Data Box Setup:**

From the Setup menu, select Data box setup.

Or,
If the data box is open, double-click in the tag list table. The Data Box Setup dialog box is displayed.

The following options are available:

- **Enable data box sizing**: Enables and disables data box sizing.
- **Data box title bar**: Enables a title bar in the data box.
- **Show time field**: Displays the time field at the top of the data box.
- **Show header**: Displays the names of the field above the value table.
- **Show tag names**: Displays the names of the tags in the table.
- **Show descriptions**: Displays graph description in the table.
- **Show current values**: Displays the current values of the tag, or the values represented by the current pointer location.
- **Activate current box**: Activates the data box.

*Note: The Value field in the data box will always appear and cannot be disabled.*
1. Select the options you want and activate the OK button.
2. To view the data box with the options you selected click the Test button. The Test button is disabled if the Activate data box option is not selected.
3. To save your options and exit the dialog box click OK.

**Grids**

A grid is a set of horizontal lines intersected at 90° angles by vertical lines, covering the entire graph area. The lines can be displayed in subunits or whole units. When activated, the grid appears on the screen enabling you to coordinate the measurement of steps along the X and Y axis.

**Grid Setup**

Before you activate the grid, it should be configured by setting several options.

▸ **To configure the grid:**

From the Setup menu, select the Grid Setup option. The Grid Setup dialog box is displayed:

![Grid Setup Dialog Box](image)
The following options are available:

**X Axis**
You can define the following options:
- **Each tick:** Displays the vertical lines on the grid in subunits.
- **Each label:** Displays the vertical lines on the grid in whole units.

**Y Axis**
You can define the following options:
- **Tag:** Specifies a tag represented by a Y axis in the Chart, to which the grid is applied.
- **Each tick:** Displays the horizontal lines on the grid in subunits.
- **Each label:** Displays the horizontal lines on the grid in whole units.

**Show grid**
Activates the grid.

After you define the grid, you can change the grid definition as many times as you want, and activate the Test button each time to view the grid, without exiting the dialog box. However, the Test button is enabled only if you select the Show grid option.

Click the OK button to save the definition and exit the dialog box.

**Grid Activation**
You can activate a grid for a graph in one of two ways:

▶ **To activate a grid:**
From the Modes menu, select Grid. The grid, with the attributes you specified in the Grid Setup procedure covers the entire graph area.

Or,

Select the Show grid option in the Grid Setup dialog box.

▶ **To deactivate the grid:**
Deselect the Grid item in the Modes menu.

*Note: A check beside the item indicates that the Grid mode is active.*
**Chart Properties**

You can define the line style of a chart and its window attributes.

► **To define Chart properties:**

In the All Containers section of the Application Studio, right click on Charts and select Properties from the popup menu. The Chart Properties dialog box is displayed:

![Chart Properties dialog box](image)

The following options are available:

- **Use chart multi markers**
  Determines the style of the markers in the Line with marker and Marker only graphs. If there are two graphs on your chart, each with a different color, a different marker shape will automatically be defined for each graph. The application uses 10 different marker shapes.

- **Advanced**
  Activate to define the Chart window attributes, as described on the following page.

Restart the application for changes to take effect.
**Defining Chart Window Attributes**

Chart window attributes are similar to Alarm window attributes.

**To define Chart window attributes:**

Click the Advanced button in the Chart Properties dialog box. The Chart Window Attributes dialog box is displayed:

The following options are available:

- **Title Bar**
  Specifies that a title bar appears at the top of the window.

- **Name in Title**
  Specifies that the name of the window will appear in the title bar.

- **System Menu**
  Specifies that a menu appears when you click on the icon in the top left corner of the window. This menu contains items that can be used to manipulate windows, such as move, size, close and so on.

- **Min/Max Button**
  Specifies that a Minimize and Maximize button appear in the top right corner of the window. These buttons can be used to minimize or maximize the window to predetermined sizes.

- **Size Border**
  Enables window borders that can be dragged to change the window size.
You can also define chart window attributes for a specific chart by right-clicking the Chart in the List of Charts in the Application Studio to display the Chart Window Attributes dialog box.

**Additional Features**

In addition to all the Chart features mentioned, the following sections describe some additional useful features.

**Background Color**

The background color of a chart can be defined at any time. Once a color is specified and the chart file is saved, the color always appears in the background of the graph area.

► **To set the background color:**

1. From the Setup menu, select the Background option. The Chart Background dialog box is displayed:

![Chart Background Dialog Box](image)

Menu Bar
- Specifies that a menu bar appears in the window.

Always on Top
- Select to display the Chart on top of other open applications.

Pos
- Specifies the window X and Y position coordinates in pixels.

Size
- Specifies the window size in pixels.

Title Bar Text
- Specifies the text that will appear in the Title bar.
2. Select the background color by clicking on the arrow to the right of the color field and select a color from the color palate.

3. Select Apply the color to the scales if you want the background color to be used as the scales background color. The default background color of the scales is pale gray.

4. Activate the Test button to see how the Chart is displayed.

5. Click OK to save the color selection and exit the dialog box.

**Smoothing Graphs**

In some cases, the window period and window size are set so that several values are displayed near the same point in the time scale, resulting in a graph which is plotted as a sequence of vertical lines. These vertical lines represent the range of values for the respective time scale point.

It is possible to obtain smooth graphs by averaging all the values that correspond to a particular time scale point.

► **To smooth a graph:**

From the Modes menu, select Average. The Average mode is activated.

► **To restore original graph values:**

From the Modes menu, deselect Average.

*Note: A check beside the item indicates that the Average mode is active.*

**Crosshair**

You can cause the cursor to appear as a crosshair in the graph area.

► **To change the cursor to a crosshair:**

From the Options menu, select the Crosshair option. The cursor appears on the Chart.
To change the pointer back to its original form:

From the Options menu, deselect the Crosshair option.

Note: A check beside the item indicates that the crosshair form is active.

Communication Errors

If a communication error occurs, a line of asterisks appears for any tag represented in the Chart associated with the VPI to which the error occurred. The line of asterisks is ongoing in the Online mode, and static in the History mode, and appears until the error is corrected.

Note: The line of asterisks appears at the last point (value) in the graph before the error occurred. For example, if a communication error occurred when the graph was at the value 50, a line of asterisks begins to appear at the 50 mark.

Authorization

If any item of any menu is disabled, meaning that the item was not authorized for that particular operator, the mouse and key operations that perform the same function as that menu item are also disabled.

Note: You can prevent an unauthorized operator from performing any Chart zooming operation simply by disabling the Operations menu.

Chart Files

Any active chart, together with its parameter settings can be saved for later use, by selecting Save from the Chart window File menu. The Chart is saved in an ASCII file called *.chr. These files can be edited using any text editor.

Note: All colors are RGB colors and not indexed.
The following is an example of a chart file:

```
VERSION = 5.11  1024 768 WIN
425, 408, 299, 319, 1, 1, 1, 1, 1, 1, 3
; Chart type, Number of graphs
  XY_T 2 0
; Graphs:
; Tag parameters : Name, Label, Limits(Default(Y/N)
Low High)),
Scale(Side,X-order,Z-order)
; Display parameters : Line-type, Log. Display(Y/N),
Color, Pattern,
  Fill
ref.(Fill down(Y/N), Value)
; Control-Limits((Show,Invert,Val.)Low,High),
Description(Use
Default(Y/N), Write on scale(Y/N), Description)
  PHASE1 'Volt' N -240 240 B 0 0
  O N 16711680 15 Y 0
  N N 0 N N 0 Y N 'Phase 1'
  PHASE2 'Volt' N -240 240 L 0 0
  M N 255 15 Y 0
  N N 0 N N 0 Y N 'Phase 2'
; Chart Start time(Type, Date/Days, Time)
  D 0 00:00:00 DT
; Chart time length, Window time length
  01-00-00 00-01-00-00
```
The first line specifies the application version number and should not be changed.

The second line contains the Chart window attribute values. The first two values represent the window coordinates (x,y), and the next two values represent the window width and height, respectively. The values after the window height (1 for selected, 0 for not selected) represent the min/max button, title bar, name in title, system menu, size border, and menu bar options (in that order). The last value in the line (3) represents the window type (chart) and should not be changed.

The third line contains the title bar text of the Chart window, specified (originally) in the Set Chart Window Attributes dialog box.

Under Chart type, Number of graphs, for Chart type, the following parameters can appear:

T represents a Time Chart.
The Chart Type, is followed by the number of graphs in the chart:

- **Graphs**, all the graphs in the chart are specified according to the explanation lines above the values. For line type, the value can be B for bar, L for line, or M for line with markers.

- **Chart Start time**, the time type is specified as follows: R for relative, D for relative date, or A for absolute. For absolute, the date is then specified, followed by the time. For relative or relative date, the number of days is specified, and then the time.

- **Chart time length**, Window time length, the time periods are specified, respectively. The Chart time length is in the format days-hours-minutes. The window time length is in the format days-hours-minutes-seconds.

- **Background color**, the number that appears represents the sequential number of the selected color in the Chart Background dialog. The first color in the first row is 1, the next is 2, and so on. The second parameter determines whether to use the background color as the scales background color.

- **History directory**, if the default history directory is specified (Y), no history directory appears in the single quotes that follow. If N is specified (the default directory is not being used), the directory name appears in the single quotes.

- **Data box setup**, all of the options are specified by Y (yes) or N (no) values, followed by the data box coordinates (x,y) on the screen, and then the data box width (cx) and height (cy).

- **Grid setup**, the grid attributes are specified according to the explanation line.

- **Chart modes**, the different Chart modes are specified according to the explanation line.

- **Chart options**, Chart option values are specified. For scroll step the x can be 0 for no scroll step (which is the default of one small bar at a time), 1 for a full window, 2 for half a window, 3 for one third of a window, or 4 for one fourth of a window.

---

**XY_X** represents an XY Chart with the X Tag Values option for Graphs Sort Reference.

**XY_T** represents an XY Chart with the Time option for Graphs Sort Reference.
Saving Charts as Trends

When you save an application chart, automatically a trend file is also created (*.wnt). When you update the trend, and then you return to your chart and save it, a message appears asking you if you want to save the chart and overwrite the trend. Yes, will overwrite the trend file and No will only save the chart.

Note:
Trends do not support graphs with x-axis defined as a tag. Therefore, if the user created a chart with this kind of graph the new trend will be a regular graph.
In the Time definition dialog box of the chart, the user can choose Relative and write the time back in the format hours:minutes:seconds (for example: 03:40:50) but in the Trend definition the user can write only relative hour, therefore, in the example above the new trend will be 4 hours relative (the time will be rounded up).
In the chart the user can choose for the line type - Line, Line with markers, Markers only and Bar. In the trend there is only Line and Line with markers, therefore Markers only in chart will become Line with markers in trend and Bar in chart will become Line in the trend.
It is not enough to write the title of the chart in the properties of the chart VP in order for it to be added to the trend, the user should press save on this chart after the title was added.
There is no foreground color in the chart definition so in the trend it will always be black (as the default for it in the trend definition).
23 is the highest number that can be defined as relative time in the trend so if the user defined the time in the chart as 'relative' more then 23 hours back he could see only 23 hours back in the trend.
## Keyboard/Mouse Action Summary

The following table summarizes the Chart keyboard and mouse actions:

<table>
<thead>
<tr>
<th>Key / Mouse</th>
<th>Description</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC</td>
<td>Pressing the ESC key.</td>
<td>Causes a zoom back to the previous state of the graphs.</td>
</tr>
<tr>
<td>HOME</td>
<td>Pressing the HOME key.</td>
<td>Causes a zoom back to the first (original) state of the graphs.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Clicking the left mouse button twice rapidly.</td>
<td>In the graph area, causes the Graphs Definition dialog box to appear. On the time scale, causes the Chart Time Definition dialog box to appear with the current specifications. On the tag scale, causes the single Graph Definition dialog box to appear with the specifications of that tag. In the data box tag list, causes the Data Box Setup dialog box to appear.</td>
</tr>
<tr>
<td>Key / Mouse</td>
<td>Description</td>
<td>Operation</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Click</td>
<td>Clicking the mouse button once.</td>
<td>After a box is drawn around a specific area in a graph or scale, a single click in the box zooms in to that portion of the graph or scale. Clicking the left mouse button on a tag scale zooms out of that scale and its associated graph. Clicking the right mouse button on a tag scale zooms in to that scale and its associated graph. Clicking the left mouse button on the time scale zooms out by a factor of 1.5. Clicking the right mouse button on the time scale zooms in by a factor of 1.5.</td>
</tr>
<tr>
<td>Drag and Drop</td>
<td>Holding the left mouse button dragging the cursor to the required position and releasing the button</td>
<td>This mouse operation can be performed to draw a box around a graph or scale area, whereby clicking the left button in that box afterwards zooms in to that portion of the graph or scale. You can click the right button on a tag scale, and drag that scale to any side of the Chart.</td>
</tr>
</tbody>
</table>
### Functional Ranges

The following table summarizes the Chart functional ranges:

<table>
<thead>
<tr>
<th>Item</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of graphs for time Chart</td>
<td>16</td>
</tr>
<tr>
<td>Maximum number of graphs for XY Chart</td>
<td>15</td>
</tr>
<tr>
<td>Maximum Chart time period</td>
<td>365 days</td>
</tr>
<tr>
<td>Minimum Chart time period</td>
<td>seconds</td>
</tr>
</tbody>
</table>
Chapter 25 Trends

About this chapter:

This chapter describes how to create and modify a Trend Profile to compare device functionality and correlate actions and responses. It also describes how to create a Trend Viewer that displays these past and current events over an Internet browser according to the definitions specified in the Trend Profile.

Overview on page 25-2 describes an overview of Trend Profiles and describes how to interact with a Trend Viewer on the web.

Creating Trend Profiles on page 25-4 describes how to create a Trend Profile.

Creating Trend Viewers on page 25-13 describes how to create a Trend Viewer by generating an HTML page from the Trend Profile.

Modifying Trend Viewers on page 25-15 describes how to modify a Trend Viewer online.

Displaying a Grid on page 25-17 describes how to display a grid in a Trend Viewer to enable you to read Trend activities accurately.

Inserting Trend Profiles on page 25-20 describes how to import a Trend Profile from another system application.

Changing the Default Location of Trend Profile Files on page 25-20 describes how to change the default location of Trend Profile files.
Overview

Trends are used to compare device functionality and correlate actions and responses. Their data can be displayed in one of two modes:

- Online mode in which the Trends are constantly updated according to changes in field values.
- History mode in which the Trends can be configured to display tag values that occurred over a specified time period.

Trend Profile

A Trend Profile contains the definitions that determine the way graphical views of past and current activities recorded by the application are displayed over an Internet browser.

Trend Viewer

A Trend Viewer displays online past and current activities recorded by the system according to definitions specified in the Trend Profile. Trend Viewers can be modified online. Trend Viewers are created by generating an HTML page from a Trend Profile and then opening the resulting page on the Web.
The X-axis displays the window time period, meaning how many minutes of data are displayed in the window at any given time.

The window time period display can be specified to show the date, the time or the date and time together.

The scroll bar is positioned just under the monitored data. It automatically moves with the data in a Trend displaying online data. If the trend displays historical data, the scroll bar is positioned on the far left of the Trend Viewer and is clicked to view the accumulated data.

There are two Y-axis displaying tag values. Each axis represents a line in the graph. The axis is displayed in the same color as the line it represents. The Y-axis on the left belongs to the line representing the first tag added to the Trend. The Y-axis on the right belongs to the line representing the second tag added to the Trend. If a third tag were added to the Trend, the Y-axis of the line would be displayed to the right of the second tag added, and so on.
Interacting with Trend Viewers

You can interact with a Trend Viewer, as follows:

- Click on the scroll bar to scroll the window and display additional data.
- Click on a peak to view the tag values of the line and the time the data was monitored, as shown in the picture below. The time is displayed in the format specified in the X-Axis time format tab.

Creating Trend Profiles

Trend Profile definition involves the following four steps:

- Adding a Tag to the Trend Profile, in which you associate Tags to the Trend Profile.
- Specifying the Date and Time in which you determine a time range for data monitoring, in the Time tab.
Specifying the X Axis Time Format, in which you specify a time format for the X axis, in the X Axis time format tab.

Specifying Trend Profile Display, in which you add a title to the Trend Profile, specify background and foreground color, and scroll steps in the Display tab.

Adding a Tag to the Trend Profile

The first step to creating a trend profile is to specify the tags that will be included in the profile. You can add up to 32 tags to a single Trend Profile. Each tag is represented in the Trend by a line.

When you add a tag to a Trend Profile, you must also determine the type of line that will appear in the Trend Viewer.

You can choose between:

- Line with markers
- Curved line
- Bar line

The system automatically allocates a color for the line. If you add more than one tag to a Trend Profile, the system allocates a different color for each line.

To add a tag:

Click the New Trend Profile icon in the toolbar.

Or,

In the All Containers section of the Application Studio, right-click Trends Profiles and select New Profile from the pop-up menu. The Trend Profile dialog box is displayed:
1. Click the Add button. The Add Tag dialog box is displayed:
2. (If the network is configured). Click the Station name box and select a station from the list of available stations.

3. Click the Tag name box and select a tag from the list of available tags. Note that the low and high limits of the tag that were specified during tag definition appear in the Low and High fields at the bottom of the dialog box.

4. Check the Display bit number checkbox to activate this field and then scroll to define the bit number. A bit number between 0-15 can be defined, 16 to 32 signed/unsigned bit tags are available.

5. Click the Line type box and select a line type. You can choose from Line, to display a curved line, Line with Markers to display a line upon which tag value changes are indicated with markers or Bar to display a bar-type line.

6. (Optional) Click the Line color box to change the color of the line. The standard Color dialog box is displayed in which you can determine a different color. If you are adding more than one tag to the Trend Profile, the system automatically allocates a different color for each line.

7. (Optional) Select Override default tag defined limits to set new limits for the tag. This will determine the high and low point of the line on the Y bar of the Trend Profile.

8. Click OK. The Add new tag dialog is closed and the options you specified are displayed in the Trend Profile dialog box.

To add additional tags to the Trend Profile, repeat steps 2 to 8. You can add up to 32 tags to a single Trend Profile.

**Specifying the Date and Time**

The starting date and time for the monitoring and display of data is specified in the Time tab. While specifying the date and time, you can also determine whether the Trend will display online or historical data.

Specifying the starting date and time is common to both online or historical data display and is determined in one of two ways:

- **Absolute**, meaning the current time and date. For example, if you specify the date 08-05-02, and the time 15:10:00, the data is monitored from 3:10 PM on August 5, 2002.
**Relative**, meaning relative to the time and date the Trend was opened. For example, if you specify a starting time of 3 days and 2 hours back, the data displayed is the data monitored 3 days and 2 hours before the Trend was opened.

**To specify the date and time:**

Select the Time tag in the Trend Profile dialog box. The Trend Profile Trend tag is displayed:
The following options are available:

**Start Date**
Specifies the date from which the data will begin to be monitored. You can choose from:

**Start**: Specifies a relative start date: For example, if you specify 4, the data is monitored four days before the Trend is opened during runtime.

**Start on**: Specifies an absolute start date: For example, if you select 1 August 2002, the data is monitored from this date.

**Start Time**
Specifies the time from which the data will begin to be monitored.

You can choose from:

**Start**: Specifies a relative start time. For example, if you specify 2, the data displayed is the data monitored 2 hours before the current time.

**Start on**: Specifies an absolute start time. For example, if you specify 15:00:00, the data is monitored from 15:00:00 on the current day. If the Trend is opened during runtime at 16:00 you will view one hour of monitored data. If the Trend is opened during runtime at 14:00, you can begin to view data after one hour.

**Historical Period**
Specifies the time span for data monitored in historical mode only.
Specifying Online Trends

When specifying a Trend that will display online data:

- Select a starting time/date for data monitoring, in the Start Time or Start Date fields.
- Specify a time span for the data displayed in a window at any given moment, in the Window time period field.

Specifying Historical Trends

When specifying a Trend that will display historical mode data:

- Select a starting time/date for data monitoring in the Start Time or Start Date fields.
- Specify the time span, or amount, of monitored data, in the Historical Period field. For example, if you specify 2 days and 2 hours, the amount of data that is displayed is the data accumulated in 2 days and 2 hours, starting from the specified start time.
- Specify a time span for the data displayed in a window at any given moment, in the Window time period field.

Note: When specifying a start time, take into account the historical time span. For example, if you specify a start date of two days back from runtime and a historical time span of three days, only the first two days of data will be displayed. To display all three days of the historical time span, specify a start time of at least three days.
Specifying the X Axis Time Format

The time format displayed on the X axis of the Trend is configured in the X Axis tab. You can display:

- The time.
- The date.
- The time and the date together.

To specify the X axis time format:

Select the X Axis time format tab in the Trend Profile dialog box. The Trend Profile X Axis Time Format tab is displayed:

The following options are available:

- **Time and date** Select to display the time and date.
- **Time only** Select to display the time.
- **Date only** Select to display the date.
Specifying Trend Profile Display

A title that will appear at the top of the Trend Viewer can be defined. You can also determine the background color of the Trend Profile and the color of its time display, labels and title using the foreground color.

To specify Trend Profile display:

1. Select the Display tab in the Trend Profile dialog box. The following page is displayed:

   ![Trend Profile Dialog Box]

   - **Title**: Type in a title for the Trend Profile in the Title field.
   - **Background color**: Click the Background color box to display the standard Color dialog box in which you can determine a color for the background of the Trend Profile.
   - **Foreground color**: Click the Foreground color box to display the standard Color dialog box in which you can determine a single color for the time display, labels and title of the Trend Profile.
   - **Scroll step**: Click on the Online scroll step to regulate automatic scrolling. Default - ½ window.

2. Type in a title for the Trend Profile in the Title field.
3. Click the Background color box to display the standard Color dialog box in which you can determine a color for the background of the Trend Profile.
4. Click the Foreground color box to display the standard Color dialog box in which you can determine a single color for the time display, labels and title of the Trend Profile.
5. Click on the Online scroll step to regulate automatic scrolling. Default - ½ window.
To modify a Trend Profile:

1. In the All Containers section of the Application Studio, click Trends Profiles and double-click the Trend Profile you want to modify from the List of Trend files. The Trend Profile dialog box opens.

2. Select the relevant Trend Profile and then click the Edit button to open the Edit Tags dialog box.

3. Modify the Trend Profile following the instructions above.

Creating Trend Viewers

A Trend Viewer displays online past and current activities recorded by the application according to definitions specified in the Trend Profile.

Trend Viewers are created by generating an HTML page from the Trend Profile, which can then be opened on the Web. Trend Viewers can be modified online.

This section describes how to generate a single HTML page that contains the Trend Viewer.

To create a Trend Viewer:

1. Click the New HTML File icon in the toolbar.

Or,

From the All Containers section of the Application Studio, right-click HTML and select New HTML File from the pop-up menu. The Generate new HTML file dialog box is displayed:
This dialog box has three sections: Picture, Events Summary Profile and Trend Viewer.

2. Click the Include Trend Viewer box to enable the fields in this section.

3. Click the Profile box and select a Trend Profile file from the list of available profiles.

4. (Optional). You can change the default width and height of the viewer in the Width and Height fields. It is recommended to generate the page first and view it in your browser, before changing the default options.

5. Click Generate. The New File dialog box is displayed.

6. Enter a name for the HTML page and click Save. The page is generated. It is saved in the List of HTML files in the Application Studio.

7. Click on the page in the List of HTML files to display it in your browser.
Modifying Trend Viewers

The application enables you to modify Trend Viewers online, as follows:

- Modify the tags that are specified in the Trend
- Modify the start time of data display
- Print the information displayed in the Trend Viewer

Modifying the Tag List

The application enables you to add tags, modify current tag specifications and remove the tags that are displayed in the Trend Viewer. These changes are made online and are in effect until you refresh the browser. The Trend Viewer is then displayed according to its default settings.

To add a tag:

1. In the Trend Viewer open the Setup menu and select Tags Setup. The Tag definition dialog box is displayed:

   ![Tag definition dialog box]

2. Click Add. The Tag definition dialog is displayed in which you can add a tag. This tag is similar to the standard Add the new tag dialog box used during Trend Viewer definition.

3. Click OK to close the dialog box and save your changes.
To modify current tag specifications:
1. Select Tags Setup from the Setup menu. The Tag definition dialog box is displayed.
2. Select the tag you want to modify and click Edit. The Tag definition dialog box is displayed in which you can change the current tag specifications.
3. Click OK to save your changes and close the dialog box.

To remove a tag:
1. Select Tags Setup from the Setup menu. The Tag definition dialog box is displayed.
2. Select the tag you want to remove and click Remove. The tag is removed from the Tag list.

Modifying the Start Time of Data Display
The application enables you to modify the start time of the data displayed in the Trend Viewer.

Your changes are in effect until you refresh the browser. The Trend Viewer is then displayed according to its default settings.

To modify the time and date:
Select Time Setup from the Setup menu. The Time set definition dialog box is displayed in which you can modify the time and date. See Specifying the Date and Time on page 25-7 for further details.

The fields in this dialog box contain date and time information that can be accessed by using the up and down arrows. You can also use the left and right arrows in the Start on field to navigate between the day, month and year options within the field.
Displaying a Grid

The application enables you to display a grid in a Trend Viewer. This is useful for reading the Trend activities quickly and accurately.

The Trend Viewer contains its own default grid properties which you can modify. These changes are made online and are in effect until:

- The browser is refreshed. The trend is then reloaded with its default parameters.
- The start time of the data display, or the tag parameters are modified, or a tag is changed, while the grid is displayed. The grid display is then turned off and the grid setup properties revert to default. You can redisplay the grid by selecting Show Grid from the Options menu.

To display the grid:

Select Show Grid from the Options menu. A grid is displayed in the Trend Viewer.

This is a toggle option. If you do not wish to display the grid in the Trend Viewer, select Show Grid again.
**Modifying a Grid**

You can determine how the grid lines appear in the grid by specifying:

- The distance between adjacent grid lines. The grid lines then appear with specified intervals between them.
- That the grid lines are displayed in line with the annotations on the axis.

You can also define the color in which the grid is displayed.

**To modify a grid:**

1. Select Grid Setup from the Setup menu. The Grid Setup dialog box is displayed:

   ![Grid Setup Dialog Box](image)

2. In the Snap to tag field, select a tag from a list of available tags. The selected tag is referred to when determining the line spacing.

3. In the Value Axis area select either:
   - Each annotation to display the grid according to the annotations on the Value axis
   - Enter a value in the Spacing value field to determine the distance between the adjacent grid lines.
The Trend mechanism will check the values you enter for their validity. You can enter a ? in the Spacing value field to view the high and low values that are valid for the current Trend viewer settings.

4. In the Time axis area select either:
   - Each annotation to display the grid according to the annotations on the Time axis.
   - Enter a value in the Spacing value field to determine the distance between the adjacent grid points.

5. Click in the Grid color field to display a color pallet in which you can select the grid color.

6. Click OK to close the dialog box and save your settings. The application will display an error message if you have entered any invalid parameters.

**Specifying the Orientation of the Grid Axes**

In the default positioning of the grid axes, the Y axis displays tag values and the X axis displays time. The application enables you to change the orientation of the Value and Time axes so that the Y axis displays time and the X axis displays tag values.

Orientation of the axis can be modified so that the tag values are displayed on the X axis and the time on the Y axis.

Axes orientation changes are in effect until you refresh the browser. Changes are made online and do not affect current grid setup and display parameters.

- **To change the default orientation of the grid axis:**

  From the Options menu, select Axis Orientation. The grid lines are adjusted so that the tag values are displayed on the X axis and the time on the Y axis, as shown above.

  *Note: When Inverse Orientation is selected, the Tag Setup and Time Setup options are disabled.*
To revert to the default orientation settings of the grid axis:
From the Options menu, select Axis Orientation. The grid lines are adjusted so that the tag values are displayed on the Y axis and the time on the X axis, as shown on the previous page.

To print:
Select Print from the Options menu of the Trend Viewer.

**Inserting Trend Profiles**

You can insert a Trend Profile from another system application into a current application.

To insert a Trend Profile:

1. In the All Containers section of the Application Studio, right-click Trends Profiles, and select Insert Profile from the popup menu. The Import File dialog box is displayed.

2. Specify the name and location of the Trend Profile and click Open. The Trend Profile is imported into the current application and added to the List of Trend files in the Application Studio.

**Changing the Default Location of Trend Profile Files**

Trend profiles are saved by default in the TrendPrf folder. The location of the folder can be viewed in the Set Default Paths dialog box.
To view the Set Default Paths dialog box.

In the Design menu select Options and then Paths. The Set Default Paths dialog box opens.

<table>
<thead>
<tr>
<th>Path</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>C:\Users[User]\ApplicationX</td>
</tr>
<tr>
<td>Alarm History</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Alarm Help(.ahp)</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Tag History</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Images(.img)</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Text Tables(.txt)</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Custom (.obj)</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Recipe</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Recipe Model (.rnc)</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Windows definitions (.vni, .chn, .xml)</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Users</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Macros</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Classes</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Web application root directory</td>
<td>C:\Documents and Settings\X</td>
</tr>
<tr>
<td>Event Summary Profiles (.xml)</td>
<td>AvePit</td>
</tr>
<tr>
<td>Pictures (.png)</td>
<td>Pictures</td>
</tr>
<tr>
<td>Trend Profiles (.xml)</td>
<td>TrendPit</td>
</tr>
</tbody>
</table>

Note: Although the Trends Profiles path can be changed it is not recommended to do so.
Web Application Properties

The Web Application Properties dialog box enables you to change the Cache settings for historical data.

Cached information enables quick access to recently acquired data. The system caches up to ten days of data by default and ensures that while doing so, at least 20 Mb of disk space remains free.

The following options are available:

**Cache the last x days**

Specifies the number of runtime days the system will store acquired data.

**Keep at least x Mb free on disk**

Specifies how many Mb the system keeps free while caching data. If the system detects that there is not enough space to cache the specified number of days, it will cache as many days as there is available space.
Chapter 26 Generating HTML Pages

About this chapter:

This chapter describes how to generate and edit HTML pages in the system.

Overview on page 26-2 gives basic information about what you need to know before generating HTML pages in the system.

Generating HTML Pages with the HTML Assistant on page 26-4 describes how to generate HTML pages using the HTML assistant, how to edit, import and delete an HTML file.

Building HTML Pages Manually on page 26-9 describes how to manually create HTML files using standard HTML editors. It also describes how to change the default location of HTML files.

Web Application Properties on page 26-13 describes how to specify Web application, Picture and Events Summary Profile and Trend profile file locations. It also describes how to specify historical cache settings.
Overview

The system's applications are viewed online using application Java Applets known as Wizlets that are embedded in HTML pages displayed by the Web browser. The page also includes a parameter that specifies the input file. For example, a page containing an Events Summary Profile wizlet also contains the file name for the Events Summary Profile.

The system includes an HTML assistant to help you generate HTML pages. You can also build the pages manually. The HTML pages are then published on a web server so that an operator can view and interact with an application in a web browser.

HTML pages can be generated from the following:

- A Picture, as described in Chapter 18, Introduction to the Image Module. The resulting page displays a Picture Viewer, an interactive graphical representation of the application process.
- An Events Summary Profile, as described in Chapter 23, Events Summary Profiles & Popups. The resulting page displays an Events Summary Viewer in which you can view and interact with online alarms.
- A Trend Profile, as described in Chapter 25, Trends. The resulting page displays a Trend Viewer in which you can view past and current events that occurred in the system.

You can generate a single HTML page that will contain two or more objects, or an HTML page that will contain a single object.

Note: When an Events Summary/Chart is created an additional file will be created automatically for the Events Summary Profile/Trend Profile.

In an Event Summary that is displayed on the Web only one alarm can be selected. The displayed order of columns of the Event Summary and Event Summary Profiles over the web differs to the order of the same windows not displayed over the web.
Planning Ahead

It is recommended to decide how you want your application to be displayed before you begin to generate HTML pages.

If you choose to generate two or more HTML pages you will need to decide how to jump from one page to another. You can:

- Design a Home Page that is displayed when the application is launched containing links to the other pages. For example, a link to the graphical representation and a link to the online alarms view.
- Determine which HTML page is displayed when the application is launched, for example, the page containing the online alarm view, and add a link to the page containing the picture view as shown below.

![Table and Diagram]

Go to Plant Floor View
Generating HTML Pages with the HTML Assistant

This section describes how to generate an HTML page with two or more application objects. Generating HTML pages with a single application object is described as follows:

- The Picture Viewer, that displays a graphical representation of a process, see Chapter 18, Introduction to the Image Module.
- The Events Summary Viewer, that displays online alarms see Chapter 23, Events Summary Profiles & Popups.
- The Trend Profile Viewer, that displays Trends, see Chapter 25, Trends.

Generating a Single HTML Page With Two or More Objects

HTML pages can be generated within the application using the application's HTML Assistant.

To generate a HTML page with two or more objects:

From the All Containers section of the Application Studio, right click HTML and select New HTML File from the pop up menu.

Or,

Click the New HTML file icon in the toolbar. The Generate new HTML file dialog box is displayed.
The following options are available:

**Include Picture Viewer**

Check to display the dynamic graphic options, as follows:

- **Picture**: Specifies the Picture that represents graphic display. Click to display list of Picture files and select the required file.
- **Disable control operations**: Select to disable user control operations.
1. Specify parameters for the Viewers you want to display in the page, as described on the following page.

2. Click Generate. The New File dialog box is displayed.

3. Enter a name for the HTML page and click Save. The page is generated. It is saved in the List of HTML files in the Application Studio.

4. Double click on the page in the List of HTML files to display it in your browser.

---

**Include Events Summary Viewer**

Check to display the active alarms options, as follows:

**Profile:** Specifies the Events Summary Profile that determines alarm display. Click to display a list of Events Summary Profile files and select the required file.

**Width:** Specifies the width of the alarm summary wizlet in the page. **Height:** Specifies the height of the alarm summary wizlet in the page.

**Include Trend Viewer**

Check to display the Trend options, as follows:

**Profile:** Specifies the Trend Profile that determines data monitoring. Click to display a list of Trend Profile files and select the required file.

**Width:** Specifies the width of the Viewer wizlet in the page. **Height:** Specifies the height of the Viewer wizlet in the page.
**Html Properties Dialog Box**

The Html Properties dialog box is used to change the properties of the Html module.

- **To access the Html Properties Dialog Box, do the following**

In the All Containers section of the Application Studio, right-click HTML and select Properties from the popup menu. The HTML Properties dialog box is displayed.

This dialog box has two tabs:
- **Popup** - where you can specify whether or not a Popup Event Summary window is displayed in a browser
- **Users** - where remote user login parameters are defined

### Popup

This dialog box enables you to define whether or not a Popup Event Summary display is enabled in a browser. It also enables you to assign group authorization so that the Popup Events Summary is displayed only in the browser of authorized users. Do the following:

1. Check the Enable Popup Window in Browser checkbox to enable this option.
2. Click the Groups button to display the standard Groups dialog box in which you can assign group authorization for Popup Events Summary display.
3. Click OK to save these definitions.

**Users**

This dialog box enables you to define remote user login parameters.

1. Check the Enable Login Quick Access Bar in Browser checkbox to enable this option. The user can then login to the Web application by pressing the Login button.

2. Check the Automatically Login with Default User checkbox to enable any user to login with a default user name and password. This means that any user can access the application and use the options that are assigned to default users. When this option is not checked the user will be forced to login with a user name and password.

3. Click OK to save these definitions.
Building HTML Pages Manually

You can manually create HTML files using standard HTML editors such as FrontPage Express that is included with Microsoft Internet Explorer.

The following is an example of HTML code for adding a Picture Viewer Wizlet.

```
<APPLET archive="w4ivsl200.jar,w4ireq200.jar"
    CODE="wizcon/visualizer/Visualizer.class"
    WIDTH=600 HEIGHT=250>
    <PARAM NAME = file VALUE = "car.wnp">
    <PARAM NAME = filebase VALUE = "pictures">
    <PARAM NAME="InetStudioBase" VALUE="InetStudio">
    <PARAM NAME="ALPopupBase" VALUE="AnnPrf">
    <PARAM NAME = cabbase VALUE = "w4ivsl.cab,w4ireq.cab">
</APPLET>
```

Note: Make sure you include the "cabbase" parameter to enable support when running within Microsoft Internet Express.

The archive="w4ivsl200.jar" specifies the name of an archive file that contains specific classes for the Picture Viewer by using the archive file and other browsers speed up the downloading time of applets. The other way is to load application Java classes one by one which is more time consuming.

The Internet Explorer 5.0 (with limitation) can load Java applets archived as JAR files - JAR files are compressed as in ZIP files and therefore faster to download.

The JAR format is Java 1.1 standard for packing Java applications and should be supported by all Java 1.1 compliant browsers.

Microsoft Internet Explorer can also load Java applets from CAB files.

An optional CODEBASE tag specifies the directory relative to the HTML page, where application classes are found (*.jar or application.cab). For example, if application classes are placed in the classes sub-directory under the directory on the HTML page.

In the default case where the classes are in the web application root directory, the CODEBASE tag is not required and should be removed.
Note: The CODEBASE tag is available only when accessed through a web server. This tag is not for local access.

The file parameter (VALUE="car.wnp") specifies the name of the Picture file to be displayed by the Picture Viewer wizlet.

The filebase parameter (VALUE="pictures") specifies the directory where the Picture files are. It is relative to the Web application root directory (the HTML directory).

WIDTH and HEIGHT specify the size in pixels the Picture Viewer Wizlet will get in the HTML page.

This is an example of HTML code for adding an Events Summary Wizlet:

```html
<APPLET archive="w4iann200.jar,w4ireq200.jar"
    CODE="wizcon/annunciator/Annunciator.class"
    WIDTH=600 HEIGHT=250>
    <PARAM NAME = file VALUE = "AnnFirst.wnp">
    <PARAM NAME = filebase VALUE = "AnnPrf">
    <PARAM NAME="InetStudioBase" VALUE="InetStudio">
    <PARAM NAME="ALPopupBase" VALUE="AnnPrf">
    <PARAM NAME = cabbase VALUE = "w4iann.cab,w4ireq.cab">
</APPLET>
```

The parameters are similar to the Visualizer Wizlet, with different values.

**Editing HTML Pages**

HTML pages can be edited as follows:

- To edit an HTML page:
  1. In the All Containers section, click HTML. A list of HTML files is displayed in the List of HTML Files.
  2. Right-click the required HTML file and select Edit HTML file from the popup menu. The file is opened in your default HTML editor.
Importing HTML Files

You can import an HTML file into your current application.

To import an HTML File:
In the All Containers section, right-click HTML and select Insert HTML file from the popup menu. The Import File dialog is displayed in which you can select an HTML file and click Open to import it into the current application.

Deleting HTML Files

HTML files can be removed from the current application.

To delete an HTML page:
1. In the All Containers section, click HTML. A list of HTML files is displayed in the List of HTML Files.
2. Right-click the required HTML file and select Delete HTML file from the popup menu. The file is removed from the application.
Web Application Files Default Location

Web application files are part of the web application are saved in the Docs folder.

To view a list of the application module’s default paths:

In the Application Studio select Design from the Menu Bar, select Options and then Paths. The Set Default Paths list opens.

Note: It is recommended not to change the default location of the Web Application files directory.
Web Application Properties

The Web Application Properties dialog box enables you to change the Cache settings for historical data.

Cached information enables quick access to recently acquired data. The system caches up to ten days of data by default and ensures that while doing so, at least 20 Mb of disk space remains free.

The following options are available:

- **Cache the last x days**  
  Specifies the number of runtime days the system will store acquired data.

- **Keep at least x Mb free on disk**  
  Specifies how many Mb the system keeps free while caching data. If the system detects that there is not enough space to cache the specified number of days, it will cache as many days as there is available space.
Chapter 27 Application Language

About this chapter:

This chapter describes how to define and set-up Application Language for use in the system, as follows:

Overview on page 27-2 is an overview of the Application Language.

Basic Principles on page 27-2 describes the basic principles of Application Language programs and the two stages of language activation.

Language Setup on page 27-3 describes the Application Language setup procedure.

Language Definitions on page 27-5 describes how to define the Application Language.

Application Language Format on page 27-11 describes the basic elements of Application Language statements.

Points to Remember on page 27-36 describes things to remember about the Application language as it relates to alarms, bit-testing, initialization, external programs and tags.
**Overview**

Application Language is a powerful tool used to create programs to enhance the capabilities of control equipment working with the system, and establish the connectivity interface between this application and external computer applications.

*Note: In the manual the name WizLanguage has been substituted by application Language. When writing code type the name of the application and then Language. Application Language runs on your local PC, it is not supported on the Web.*

**Basic Principles**

Application Language programs are written as a sequence of statements. These statements consist of two elements:

- **Condition**: A condition based on arithmetic and Boolean expressions using tag values or system variables.
- **Operations**: A set of operations defined by the language, including assigning tag values, issuing alarms, loading images, loading recipes, and generating reports.

Language statements are scanned periodically by the system, as defined during the Application Language setup procedure. If a statement condition is true, the relevant operation or operations are executed.

The following are example statements:

```plaintext
IF
  @TEMP >= 100
THEN
  @POWER = 0; PRINT$A "Boiling Water at " @TEMP
  Degrees, Power Shut off"
IF
  @LEVEL <= @MINLEVEL AND @RESERVE <> 0 AND $HOUR = 12
THEN
  @FEEDRATE = 10; @FEED = 1; PRINT$A "Filling tank at rate" @FEEDRATE
```
Note: Since operations are executed as long as the respective conditions are met, the same set of operations can theoretically be executed perpetually. To prevent this from happening, or to cause this to happen, the operator can assign the following parameters:

<table>
<thead>
<tr>
<th>Disregard</th>
<th>Operations are executed as long as a specified condition is true.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute on Change</td>
<td>Operations are executed only once when a condition becomes true.</td>
</tr>
</tbody>
</table>

Each Language statement can include a brief description.

**Language Activation**

Application Language activation is performed in two stages.

- Statements are defined (the programming stage).
- Language statement scanning and execution parameters are determined.

The remainder of this chapter deals with the statement definition stage only.

**Language Setup**

Application Language is a language program that can be accessed from within this application. The language can be used to execute a variety of commands, and will run periodically in the background of the application. Application Language commands can include predefined messages that are issued as the program is executed.

The following is an example of a simple Application Language program that will check if a tag called PRES equals or exceeds a specific pressure level, and if so, will reset a tag called AIR, which will then cause a tag called SPRAY to begin the spraying cycle:

```plaintext
IF @PRES >= @PRESLVL
THEN RESET @AIR; {SET @SPRAY;}
PRINT$E "Starting to Spray"
```

The Application Language setup procedure enables you to define how the language will operate when it is accessed.
To configure Application Language for operation:

From the Design menu of the Application Studio, point to Application Language and select Settings from the pop-up menu.

The Application Language Setup dialog box appears:

The following options are available:

**Scan rate**

Specifies the rate at which the Application Language program is executed. Each time the specified period (in seconds) elapses, the program is executed once (if the previous pass was completed). A value of zero indicates that the Application Language program will not be executed at all.

**Redirection**

Redirects messages to specific destinations. The following PRINT$ commands are available:

- **PRINT$A and PRINT$E**: Redirect messages to Popup for the Popup Event Summary, or to Printer for the alarm printer.
- **PRINT$B, PRINT$C and PRINT$D**: Redirect messages to the file specified.

*Note: To verify the rate of the Application Language, a print$ command with the current time can be placed in the program. For example:*

```
PRINT$E "Start scan at " $TIME
```
The following section describes how to create Application Language definitions that will be used by the system. This involves two steps:

- Opening the Application Language dialog box in which statements are defined
- Defining statements

**To open the Application Language dialog box:**

In the Control Panel of the Application Studio, double-click the Application Language icon.

Or,

From the Design menu of the Application Studio, point to Application Language and select Definition from the pop-up menu. The Application Language dialog box opens.
The following options are available:

**Command No.** Specifies sequential statement numbering. The statements are numbered automatically as they are defined and modified.

**Description** Specifies a description of the statement. Statements are only identified by their description.

**Previous status** The following options are available:

- **Disregard:** indicates that the commands will be executed as long as the condition persists.
- **Execute on Change:** indicates that the commands will be executed only once when the condition changes from false to true.

**If** Specifies a condition expression.

**Then** Specifies operations, each separated by a semicolon.

**Append** Adds the statement to the statement list in the dialog box.

**Change** Edits a statement definition. Select the statement and make the required changes before activating.

**Insert** Inserts a statement into the statement list after the currently selected statement.

**Delete** Deletes the selected statement.

**Clear** Removes the definitions of the selected statement.

**Use** Loads a selected file from a list.

**List** Loads a specific file from the statement list to the printer, or to a file.

**Find** Finds specific text in If/Then statements and description sections of a program.
**Statement Definition**

You can define statements in the definition fields, the Description, Previous status, If and Then fields of the Application Language dialog box as described below and select the statement execution method.

Once a statement is defined, it can be appended to the end of the program by activating the Append button. The statement numbers are automatically adjusted.

- **To select a statement in the program:**
  Click on the statement. The statement is highlighted. Its definition appears in the Definition Fields for editing.

- **To define a new statement:**
  Click on a blank statement. The Definition Fields is cleared, enabling a new statement to be defined.

  When a statement is selected, its position in the program will be marked so that new statements can be inserted in its place.

- **To edit a statement in a program:**
  Select the statement, make the desired changes in the Definition Fields, and activate the Change button. The edited version of the statement is entered in place of the original version.

  To clear any statement, activate the Clear button.

- **To insert a pre-defined statement at any location:**
  Select the statement before which the pre-defined statement is to be inserted and activate the Insert button.

- **To delete any statement in a program:**
  Select the statement and activate the Delete button.
**If/Then**

If/Then statements consist of two elements, Conditions and Operations.

- **Conditions** contain expressions that yield the value True (non-zero) or False (zero).
- **Operations** can contain several commands, each separated by a semicolon. No line breaks are necessary between commands.

If an expression in a Condition yields a True value, the commands in the relevant Operation are executed.
If the expression is False, the commands are ignored and the program proceeds to the next statement.

*Note: The Conditions element may be empty, causing the Operations to be executed in any case.*

**Examples**

```plaintext
IF ($HOUR = 18) AND @DONE
THEN RLOAD "NIGHT.1"
IF @LEVEL >= @SETP
THEN RESET @PUMP;
SET @MIXER;
PRINT$E "mixer start"
```

Comments can be inserted in statements, but will be ignored upon program execution. Comments are typed in curly brackets {}.

**Example:**

```plaintext
IF @LEVEL >= @SETP
THEN RESET @PUMP; { SET @MIXER; }
PRINT$E "Starting Mixing"
```
Loading a File from the Statement List

Click the Use button in the Application Language dialog box to load a selected file from the list. The Use List File dialog box is displayed:

The following options are available:

- **Append**: Appends the selected list commands to the end of the command list located in the If/Then fields of the Application Language dialog box.
- **Replace**: Replaces the existing commands with the list of commands available in the defined WLS file.
- **Cancel**: Exits the dialog box.

Loading a Statement File to a Printer or a File

Activate the List button in the Application Language dialog box to load a specific file from the statement list to a printer or to a file. The Commands List dialog box is displayed:
The following options are available:

- **From**: Specifies the number of the statement from which the printing is to begin.
- **To**: Specifies the number of the last statement to be printed.
- **List Target**: Sends the program to the printer or a file:
  - **Printer**: Sends the program to the printer.
  - **File (.WLS)**: Sends the statements to a file. Specify the name of the file to which you want the statements sent.

### Finding Text

Click the Find button in the Application Language dialog box to find specific text in If/Then statements and description sections of a program. The Find text dialog box is displayed:

![Find text dialog box](image)
Enter a text string and click OK. The search will begin from the statement you select and proceed down to the end of the program. When the string is found, the screen is scrolled to the statement that contains the string.

**Application Language Format**

Application Language is a simple procedural language in which statements are written sequentially. Application Language statements consist of the following basic elements:

- **Variables** Tag or system values, as described below.
- **Operators**: Arithmetic or Boolean symbols that together with variables and constants, constitute expressions.
- **Expressions** Combinations of variables, constant, and operators that yield values.
- **Commands** Symbols that represent operations.
- **Constants**: Any positive numerical value.

**Variables**

There are two kinds of variables:

- **Tags**: A tag is represented by its name, preceded by a commercial-at sign (@). For example, @POWER, or @INFLOW.
  
To indicate the application network station a tag belongs to, after the commercial-at sign, simply type the station name followed by a colon (:), and then the name of the tag. For example: @STATION1:ANA01 refers to a tag called ANA01 in the station called STATION1.

- **System Variable**: A variable controlled by the system. This type of variable is represented by a name preceded with a dollar sign ($), such as $TIME, or $DATE. System variables are read-only, and cannot be modified.
System Variables

The table below describes system variables:

<table>
<thead>
<tr>
<th>Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ALARMS</td>
<td>-</td>
<td>Represents the number of unacknowledged alarms in the system.</td>
</tr>
<tr>
<td>$TIME</td>
<td>00.00 - 23.59</td>
<td>Specifies the current time in Hours.Minutes format. When printed, the time will appear in the format Hours.Minutes.Seconds.</td>
</tr>
<tr>
<td>$DATE</td>
<td>01.01 - 31.12</td>
<td>Specifies the current date in Day.Month format. When printed, the date appears in the format Day.Month.Year.</td>
</tr>
<tr>
<td>$HOUR</td>
<td>0 - 23</td>
<td>Specifies the current hour.</td>
</tr>
<tr>
<td>$MINUTE</td>
<td>0 - 59</td>
<td>Specifies the current minute.</td>
</tr>
<tr>
<td>$SECOND</td>
<td>0 - 59</td>
<td>Specifies the current second.</td>
</tr>
<tr>
<td>$DAY</td>
<td>1 - 31</td>
<td>Specifies the current day.</td>
</tr>
<tr>
<td>$MONTH</td>
<td>1 - 12</td>
<td>Specifies the current month.</td>
</tr>
<tr>
<td>$YEAR</td>
<td>0 - 99</td>
<td>Specifies the current year.</td>
</tr>
<tr>
<td>$WEEKDAY</td>
<td>0 - 6</td>
<td>Specifies the current day, where 0 is Sunday and 6 is Saturday.</td>
</tr>
<tr>
<td>$NEWMIN</td>
<td>0 - 1</td>
<td>This variable is set to 1 each time the program is executed after one minute. Afterwards it reverts to 0.</td>
</tr>
<tr>
<td>$NEWHOUR</td>
<td>0 - 1</td>
<td>This variable is set to 1 each time the program is executed after one hour. Afterwards, it reverts to 0.</td>
</tr>
<tr>
<td>$NEWDAY</td>
<td>0 - 1</td>
<td>This variable is set to 1 each time the program is executed after 24 hours. Afterwards, it reverts to 0.</td>
</tr>
<tr>
<td>$OPERATOR</td>
<td>String</td>
<td>Specifies the current operator name.</td>
</tr>
</tbody>
</table>
Expression Operators

Several types of operators can be used on variables and constants to form expressions. The operators that can be used include arithmetic, trigonometric, Boolean, and others listed on the following page. Each operator is assigned a priority value to enable the system to determine which operator should be calculated first when an expression includes several operators.

The operators, their priority levels, and brief descriptions of each are provided in the following table.

Note: Although the use of parentheses in expressions is optional, it is recommended to use them whenever the priority of calculation execution is in doubt. If an expression does
not include parentheses, mathematical and logical calculations will be executed according to the order shown in the chart above.

<table>
<thead>
<tr>
<th>Priority Level</th>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>(, )</td>
<td>Open and close parentheses.</td>
</tr>
<tr>
<td>2</td>
<td>SIN, COS</td>
<td>Sine and Cosine, in radians.</td>
</tr>
<tr>
<td></td>
<td>FLOOR</td>
<td>&quot;Rounds off&quot; downward. Thus, FLOOR 8.75 = 8.</td>
</tr>
<tr>
<td></td>
<td>SIGN</td>
<td>Value's sign (returns 1, -1, or 0).</td>
</tr>
<tr>
<td></td>
<td>ABS</td>
<td>Absolute value.</td>
</tr>
<tr>
<td></td>
<td>LOG</td>
<td>Logarithm, base 10.</td>
</tr>
<tr>
<td></td>
<td>LN</td>
<td>Natural logarithm.</td>
</tr>
<tr>
<td></td>
<td>DAYOF</td>
<td>Extracts day from date value.</td>
</tr>
<tr>
<td></td>
<td>MONTHOF</td>
<td>Extracts month from date value.</td>
</tr>
<tr>
<td></td>
<td>YEAROF</td>
<td>Extracts year from date value.</td>
</tr>
<tr>
<td>3</td>
<td>~ BIT</td>
<td>Bitwise NOT.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Extracts the value of a given bit in an analog tag.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>@TAG BIT 1 would return the value of the first bit on the right for a tag called TAG.</td>
</tr>
<tr>
<td>4</td>
<td>^</td>
<td>Power (e.g., @TAG ^ 2).</td>
</tr>
<tr>
<td>5</td>
<td>*, /</td>
<td>Multiplication and division.</td>
</tr>
<tr>
<td></td>
<td>%</td>
<td>Remainder (e.g., 5%2 = 1).</td>
</tr>
<tr>
<td>6</td>
<td>+, -</td>
<td>Addition and subtraction</td>
</tr>
<tr>
<td></td>
<td>MIN, MAX</td>
<td>Compare two values, return the larger and the smaller, respectively (e.g., 1 MIN 3 returns 1).</td>
</tr>
<tr>
<td>7</td>
<td>&lt;&lt;, &gt;&gt;</td>
<td>Bitwise Shift Left and Shift Right. The value of each bit is moved to the left or right, by number of places specified (e.g., @TAG &gt;&gt; 3 moves each bit value 3 places right). The bits at the end are dropped, and the new bits receive the value 0.</td>
</tr>
</tbody>
</table>
Application Language Format  27-15

String Tags

For tags defined in the Tag Definition module as string tags, only the following expression operators can be used:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;</td>
<td>Bitwise AND</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>BXOR</td>
<td>Bitwise XOR (e.g., 3 BXOR 5 returns 6)</td>
</tr>
<tr>
<td>=</td>
<td>Equality</td>
</tr>
<tr>
<td>&lt;=&gt;</td>
<td>Inequality</td>
</tr>
<tr>
<td>&gt;, &lt;</td>
<td>Greater and lesser than</td>
</tr>
<tr>
<td>&gt;=, &lt;=</td>
<td>Greater/lesser or equal</td>
</tr>
<tr>
<td>NOT</td>
<td>Boolean NOT</td>
</tr>
<tr>
<td>AND</td>
<td>Boolean AND</td>
</tr>
<tr>
<td>OR</td>
<td>Boolean OR</td>
</tr>
</tbody>
</table>

Expressions

Expressions are formed by combining constants, variables and operators. However, any single variable or constant can also be considered an expression.

In expressions, any operator in parentheses will be calculated first.

For Boolean operators, the value 0 is considered False and the value 1 (or any non-zero value) is considered True.
Negative values can be included in expressions by subtracting from zero. However, only positive constants are allowed.

**Examples**

<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSGN</td>
<td>@KILOS * 1000 + @GRAMS</td>
<td>Returns total in grams</td>
</tr>
<tr>
<td></td>
<td>(@TEMP1 + @TEMP2) / 2</td>
<td>Returns tag average</td>
</tr>
<tr>
<td></td>
<td>@FLAG OR NOT @FLAG</td>
<td>Returns 1 (True)</td>
</tr>
<tr>
<td></td>
<td>$WEEKDAY &gt; 7</td>
<td>Returns 0 (False)</td>
</tr>
<tr>
<td></td>
<td>(60 MAX $MINUTE) + 1 = 61</td>
<td>Returns 1 (True)</td>
</tr>
<tr>
<td></td>
<td>0 - 100</td>
<td>Returns -100</td>
</tr>
<tr>
<td></td>
<td>0 - @VOLTAGE</td>
<td>Returns inverted value of VOLTAGE.</td>
</tr>
</tbody>
</table>

**Remember**

- Division by zero returns a value of 0.
- Bit operations, such as shifts and Boolean bit operators, take unsigned integers. If any other value is encountered, it is converted to a positive integer, which may cause unpredictable results.
- Only the following operators can be used for string tags: (, ), =, ><, <->, NOT, AND, and OR.

**Commands**

Commands are symbols that represent operations. Some commands may require arguments. Application Language commands, examples of each command, and brief descriptions of each, are provided in the following table.

<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSGN</td>
<td>@tag1=130@</td>
<td>Assigns a value to a tag.</td>
</tr>
<tr>
<td></td>
<td>tag1=2*@tag2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>@tag1=(@tag2=2)</td>
<td></td>
</tr>
<tr>
<td>INC</td>
<td>INC @tag1</td>
<td>Adds 1 to tag value.</td>
</tr>
<tr>
<td>DEC</td>
<td>DEC @tag1</td>
<td>Subtracts 1 from tag value.</td>
</tr>
<tr>
<td>Command</td>
<td>Example</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>SET</td>
<td>SET @tag1</td>
<td>Assigns a tag value of 1.</td>
</tr>
<tr>
<td>RESET</td>
<td>RESET @tag1</td>
<td>Assigns a tag value of 0.</td>
</tr>
<tr>
<td>SETBIT</td>
<td>SETBIT @ANA01 3</td>
<td>Sets a specific bit in a tag.</td>
</tr>
<tr>
<td>RESETBIT</td>
<td>RESETBIT @ANA01 2</td>
<td>Resets a specific bit in a tag.</td>
</tr>
<tr>
<td>RSAVE</td>
<td>RSAVE &quot;recipe.001&quot; RSAVE &quot;recipe.&quot; @tag</td>
<td>Saves a recipe.</td>
</tr>
<tr>
<td>RLOAD</td>
<td>RLOAD &quot;recipe.001&quot; RLOAD &quot;recipe.&quot; @tag</td>
<td>Loads a recipe.</td>
</tr>
<tr>
<td>PRINT$A</td>
<td>PRINT$A &quot;Danger! Temp=&quot;: @temp</td>
<td>Writes alarm message to pop-up, Event Summary and file.</td>
</tr>
<tr>
<td>PRINT$G</td>
<td>PRINT$G &quot;Final Temp was: &quot;: @temp</td>
<td>Writes alarm message to Event Summary and file.</td>
</tr>
<tr>
<td>PRINT$F</td>
<td>PRINT$F &quot;Sensor A is ON&quot;</td>
<td>&quot;Writes alarm message that does not have to be acknowledged.</td>
</tr>
<tr>
<td>PRINT$B,C,D</td>
<td>PRINT$B &quot;Total weight was: &quot;: @kgs</td>
<td>Outputs a message to file you specified in the Application Language setup.</td>
</tr>
<tr>
<td>PRINT$E</td>
<td>PRINT$E &quot;Have a nice day!&quot;</td>
<td>Displays a pop-up message.</td>
</tr>
<tr>
<td>SHELL</td>
<td>SHELL &quot;command&quot; @tag</td>
<td>Executes a command from the operating system environment. A tag name can be used for transfer of values to external programs.</td>
</tr>
<tr>
<td>CHART</td>
<td>CHART &quot;TREND3&quot;</td>
<td>&quot;Loads a chart with several optional parameters.</td>
</tr>
</tbody>
</table>
Strings

Many commands accept string arguments. The string argument is a list of characters placed between double-quotes. For example, "This is a string."

Consecutive strings are concatenated to form a single string, such as "This is" "one long string."

Variables can be placed between strings. In such cases, the resultant string will include the value of the variable.

For example, "Production on" $DATE "was" @PROD "tons." This string would yield the following statement:

Production on 11.12.90 was 7.24 tons (depending, of course, on what the value of @PROD is).

<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPORT</td>
<td>REPORT &quot;rep1&quot;</td>
<td>Generates a report according to a format defined in the Report module.</td>
</tr>
<tr>
<td>EXIST</td>
<td>IF EXIST &quot;recipe.001&quot; THEN RLOAD &quot;recipe.001&quot;</td>
<td>Checks if a file exists.</td>
</tr>
<tr>
<td>UNITERR</td>
<td>UNITERR 1.002</td>
<td>Checks if a communication driver and device are operational.</td>
</tr>
<tr>
<td>MACRO</td>
<td>MACRO &quot;MyMacro&quot;</td>
<td>Activates a pre-defined macro.</td>
</tr>
<tr>
<td>ZONE</td>
<td>ZONE &quot;MAIN.3&quot;</td>
<td>Loads an image window and goes to a specified zone.</td>
</tr>
<tr>
<td>@ltagname</td>
<td>@ltag1</td>
<td>Forces an immediate tag read.</td>
</tr>
</tbody>
</table>

**REPORT**

REPORT "rep1"

Generates a report according to a format defined in the Report module.

**EXIST**

IF EXIST "recipe.001" THEN RLOAD "recipe.001"

Checks if a file exists.

**UNITERR**

UNITERR 1.002

Checks if a communication driver and device are operational.

**MACRO**

MACRO "MyMacro"

Activates a pre-defined macro.

**ZONE**

ZONE "MAIN.3"

Loads an image window and goes to a specified zone.

**@ltagname**

@ltag1

Forces an immediate tag read.
String Tags

Only the following commands can be used for tags that were defined as string tags in the application tag definition module:

- ASSIGN
- RSAVE
- RLOAD
- PRINT$A,B,C,D,E,F,G
- SHELL
- REPORT
- EXIST
- MACRO
- ZONE
- CHART
- @ !TAGNAME

Each Application Language command is described in the following paragraphs.

Assign Commands

Assign commands force new values on tag variables (only if those variables can be changed).

The basic assign command is the equals (=) sign. The tag is placed to the left of the sign; the assigned expression is placed to the right.
Examples

@TAG1 = @TAG2   TAG1 is assigned to the value of TAG2.

@SUM = FLOOR (@SUM + 0.5)   SUM is assigned the rounded value of its current value.

@STOP = (@TEMP = @MAX)   STOP is assigned the value True (1) if TEMP is equal to Max and False (0) otherwise. Note that the same = symbol is used for both a command and a logical operator.

@LEVEL = 0 - 10   LEVEL is assigned the value -10.

@SPEED = 0 - @SPEED   SPEED is assigned the opposite of its current value.

Some control assignment operations have special commands. These operations include:

INC     Increment a tag. Example: INC @TAG, which is equivalent to @TAG = @TAG + 1

DEC     Decrement a tag. Example: DEC @TAG, which is equivalent to @TAG = @TAG - 1

SET     Sets a tag to 1. Example: SET @TAG, which is equivalent to @TAG = 1

RESET   Sets a tag to 0. Example: RESET @TAG, which is equivalent to @TAG = 0

SETBIT  Sets a bit in a tag to 1. Example: SET @TAG 3, which sets bit 3 in TAG

RESETBIT  Resets a bit in a tag to 0. Example: RESETBIT @TAG 3, which resets bit 3 in TAG
**Message Commands**

Messages can be sent to various destinations using the PRINT command.

The basic PRINT syntax is

```
PRINTdest string
```

where `dest` is a destination indicator and `string` is a string argument with several changes (explained below).

The destination indicator is a letter preceded by the dollar sign ($), which indicates the destination of the string.

A string can be sent to any of the following destinations:

- **$A**: The string is recorded and sent as an alarm to the pop-up, Event Summary, the printer, or both, depending on how it was defined in the Application Language Setup.

- **$F**: The string is recorded and sent as an Acknowledged alarm to the pop-up Event Summary, the printer, or both, depending on how it was defined for the $A indicator in the Application Language setup.

- **$E**: The string is sent to the pop-up Event Summary, the printer, or both, depending on how it was defined in the Application Language Setup dialog box. However, it will not be recorded as an alarm. This is useful when immediate notification is required, but the information does not have to be recorded and processed.

- **$G**: The string is recorded as an alarm, but not sent to the pop-up, Event Summary or printer.

- **$B**: The string is sent to a file specified in the Application Language setup.

- **$C**: Same as $B (but can be a different file for saving).

- **$D**: Same as $B (but can be a different file for saving).

The pop-up Event Summary is described in more detail in Chapter 22, Event Summaries.

Several destination indicators can be specified for one PRINT command, so that the string will be sent to all the indicator destinations.
Examples

This message will be issued as an alarm.

```plaintext
PRINT$A "Oven is too hot!" @TEMP "Degrees"
```

This message will be sent to a file.

```plaintext
PRINT$C "Balance for batch" @BATCH "at" @WEIGHT "Kilos"
```

This message will be issued as an alarm and sent to a file.

Using the file destinations ($B, $C, $D), on-line information can be saved and used later by other applications, such as spreadsheets, databases, and report generators.

Line Feed Control

The special control code |NN placed at the beginning of a string, suppresses the Carriage Return or Line Feed code at the end of the message. Thus, consecutive PRINT commands will form single lines.

Note: This code applies only to the PRINT$B, PRINT$C, and PRINT$D commands.

Example

This message will be written as:

```plaintext
Temperature is dangerously high!. Alarm operators!
```

Recipe Commands

A Recipe is a list of tags and their respective values. Recipes are described in more detail in the Recipes chapter.

The Application Language includes commands that can be used to capture and apply recipes. These commands are useful when the operator wants the system to
automatically apply set values to large groups of tags, or automatically record current settings for later use.

Models are groups of recipes, and each recipe is stored in a file called model.rec, where model stands for the model name and rec stands for the recipe name. Thus, the recipe OUT belonging to the model MOTION is stored in the file called MOTION.OUT.

The recipe command syntax is:

**RLOAD recipe** To apply a recipe

**RSAVE recipe** To capture a recipe

Where recipe is a string specifying the recipe filename. If only the filename is specified without a pathname, the recipe will be placed in the default pathname for recipes, as explained in the Changing Default File Paths section the Getting to Know the Application Studio chapter. If a full pathname is specified for the recipe, the default will be overridden.

**Examples**

```
RLOAD "MOTION.OUT"
```

Apply recipe OUT of model MOTION from the default recipe directory.

```
RLOAD "D:\DYES\COLOR.RED"
```

Apply Recipe RED of model COLOR from the \DYES directory in drive D.

```
RSAVE "TUNE.008"
```

Capture the current process setting into recipe 008, according to model TUNE.

```
RLOAD "DAILY." $DAY
```

Apply a recipe according to the current day (DAILY.0 for Sunday, DAILY.1 for Monday, etc.).
Capture the current process setting into a recipe identified by the value of MODE,

```plaintext
RSAVE "MIXER." @MODE
```

according to the model MIXER. For instance, if MODE is 12, then recipe 12 will be

generated and stored as file MIXER.12.

```plaintext
RLOAD @RCP1
```

Apply the recipe represented by the string tag called RCP1. Note that RCP1 must be a

string tag and its value must be a valid recipe for the operation to be executed.

When a recipe is applied or captured, an alarm will automatically be issued. The

destination of the alarm is determined by the PRINT$A command (as explained above),

and its status is Acknowledged and Ended.

**SHELL Command**

While Application Language commands and statements are being executed, operating

system batch programs can also be called and executed.

The command syntax is:

```plaintext
SHELL "command"
```

Where command is a string containing any operating system command.

**Examples**

```plaintext
SHELL "COPY RECIPE.001 RECIPE.002"
```

This command will copy file RECIPE.001 to RECIPE.002.

```plaintext
SHELL "COPY DATA." @COUNT " DATA.NEW"
```

If the tag called COUNT is 15, file DATA.15 will be copied to DATA.NEW.

```plaintext
SHELL "START MYPROG"
```

This command will execute a program called MYPROG.

*Note: Application functions can be expanded by writing add-on program, using the
application kernel.*
**Chart Command**

The CHART command can be used to load a chart, with several optional parameters. The following CHART command formats can be used:

**Default Chart**

The format of the default chart command is:

```plaintext
CHART "VpName"
```

This command loads the specified chart window as is. The time definition will not be changed.

**Absolute Time**

The format of the absolute time chart command is:

```plaintext
CHART "VpName  ABS  I_Date  I_Time  [D_Len] [T_Len]"
```

This command loads the specified chart window and changes its time parameters in the absolute mode, where:

- **I_Date** The number of days from 01/01/80.
- **I_Time** The number of minutes since midnight.
- **D_Len** Chart and window period, in days. This parameter is optional (see notes on next page).
- **T_Len** Chart and window period, in minutes. This parameter is optional (see notes below).

In the absolute mode, you can specify date and time parameters to change tag values, via image time and digital date displays.
**Relative Time**

The format of the relative time chart command is:

```
CHART "VpName REL D_Date D_TIME [D_Len]
[T_Len]"
```

This command loads the specified chart window and changes its time parameters in the relative mode, where:

- **D_Date**: The number of days back from the current day.
- **D_Time**: The number of minutes back from the current minute.
- **D_Len**: Chart and window period, in days. This parameter is optional (see notes on next page).
- **T_Len**: Chart and window period, in minutes. This parameter is optional (see notes).

In the relative mode, you can define the numbers of days ago as a simple digital display, and the number of minutes ago as a digital time display.

**Relative Date**

The format of the relative date chart command is:

```
CHART "VpName RELDATE D_Date [I_TIME] [D_Len]
[T_Len]"
```

This command loads the specified chart window and changes its time parameters in the relative date mode, where:

- **D_Date**: The number of days back from the current day.
- **I_Time**: The number of minutes since midnight. This parameter is optional. If not specified, the default definition will be used.
- **D_Len**: Chart and window period, in days. This parameter is optional (see notes).
- **T_Len**: Chart and window period, in minutes. This parameter is optional (see notes).
Note: In the relative date mode, you can define the numbers of days ago as a simple digital display, and the time when the chart will begin.
For all modes, if the window is not loaded, the CHART command will first load the window and then change the definitions. If the window is already loaded, the command will only change its definitions.
The CHART command can change time parameters only for historical charts.

Examples

CHART "PROCESS ABS " @IDATE " " @ITIME

This command loads the PROCESS chart window in the absolute mode and sets time and date parameters according to IDATE and ITIME tags. The values for these tags can be assigned using WIL2 instructions or Date/Time triggers in an image.

CHART "TEMP RELDATE 1 " @ITIME

This command loads the TEMP chart in RELDATE mode, and sets the date for yesterday and the time according to the @ITIME tag.

Report Command

This command enables the automatic generation of a report according to a format that has been created previously in the Report module.

Note: The REPORT command cannot be used to edit any report that was not created using the application Report module.

The short format of the command is:

REPORT "xxxxx"

Where xxxxx is a report name of up to 5 characters.

Note: The REPORT command must be the last command in the Execute section, and therefore cannot appear together with an RLOAD or SHELL command.

Tag names can be included in the REPORT command as variables. This can be useful to generate a series of reports with a single command.
For example, if you want to generate ten reports, REP0 to REP9, you would define a dummy tag called repno, and write the following command sequence:

```
IF@repno > 0
    THEN@repno = @repno - 1;
REPORT "REP" @repno
```

One way the series could be activated is by pressing a function key defined with the value of 20.

For example,

```
IF@TAG1 = 20
    THEN@repno = 0
```

The full format of the REPORT command, with optional report variables, is:

```
REPORT "xxxxx rd rt st et of sd ed dir tag"
```

Where:

**RD** sets the reference date. 0 is the current day, 7 is the previous week.

**RT** is the reference time, used by Time type fields. This is the number of minutes that elapsed since midnight, between 0 and 1,439. Thus, 8 AM would be 480.

**ST** and **ET** are Start Time and End Time, and are only for the time in Tag type fields for which you selected the Given at Run Time option. Specify the number of minutes that elapsed since midnight.

**OF** is for Output File. Specify the filename or device to which the report will be sent.

**SD** and **ED** stand for Start Date and End Date respectively, and are used with Tag type fields for which you selected the Given at Run Time option. These parameters are optional.

**DIR** (Directory) specifies the directory in which your history files are located.

**TAG** specifies the exact name of a tag (for example, ANA01 and not @ANA01). The tag will be reset (tag=0) when the report begins, and set (tag=1) when the report ends. Thus, you will be notified when the report is completed.
Examples

The following is a list of examples of how you would use the Report command.

```
REPORT "REP4 2 360 0 360 LPT2"
```

This command would create a report in a format defined as REP4, with a reference date of 2 days before, a reference time of 6 AM, midnight as the default start time for tag fields, 6 AM as the default end time, and the report would be output to printer 2.

If you want to leave optional variables empty, type an x at their location in the REPORT command. The application will use the default value 0 for all the variables except OF (Output File), for which the default is LPT1. If you want the report to be sent to the printer, do not type anything (typing x would cause the report to be sent to a file called x).

For example, the command

```
REPORT "REP1 x x x x REP1.LST"
```

would generate a report in the format defined as REP1, and output that report to a file called REP1.LST.

You can use the REPORT command to generate a report about the duration of a specific batch program. The program start time is stored in a PLC register, which may, for example, be represented in the application as the tag called Start. When the batch is terminated, the value 1 will be assigned to a bit in the PLC. This bit may, for example, be a digital tag in the application called Batchend.

The command would be written as follows:

```
IF@BATCHEND = 1 THENREPORT "BATCH x x " @start
```

Tag names can be included for variable values. Note that parameters must be separated by spaces.

The variables SD and ED are useful to help process weekly and monthly reports, and in calculating an accumulative average.

For example:

```
IF$TIME = 17.00 THEN@S_DATE = $DAY - 1; $E_DATE = 0; REPORT "REP1 X X X X LPT1 " @S_DATE " " @E_DATE
```
**File Check Command**

The `exist` command can be used to check if a file exists. If the file you specify exists, the command will return 1. If the file does not exist, the command will return 0.

For example:

```
IF EXIST "MAIN.IMG"
    THEN SHELL "COPY MAIN.IMG DETAIL.IMG"
```

*Note: You can also use string tags to represent the file you want to search for.*

For example:

```
IF EXIST @IMG
    THEN SHELL "START MYPROG"
```

In this example, `@IMG` can be a string tag that contains the value of a valid filename.

**Communication Error Verification Command**

The `uniterr` command can be used to check if a specified communication driver and device are operational. The format of this command is:

```
UNITERR n.nnn
```

Where `n` is the communication driver number, and `nnn` is the device number.

For example:

```
UNITERR 1.002
```

This command will check if communication driver number 1 and device number 2 are operational (not in communication error).

In case a communication error is detected, the return value will be 1 (0 if communication exists).

*Note: Three digits must be specified for the unit number.*
**Macro Command**

The Macro command can be used to activate a macro (pre-defined in the application Macro Definition module). The format of this command is:

```
MACRO "MacroName"
    or
MACRO StringTag
```

Where StringTag is the name of a string tag that contains the value of a valid macro name.

**Examples**

```
MACRO "MyMacro"

This command will activate a macro called MyMacro.
```

```
MACRO @MAC

This command will activate the macro represented by the value of the tag called MAC.
```

**Zone Command**

The Zone command can be used to load an image window and go to a specified zone. If the specified image is already loaded, only the Go To Zone operation will be performed. The format of this command is:

```
ZONE "VpName.ZoneName"
    or
ZONE StringTag
```

Where StringTag is the name of a string tag that contains the value of a valid zone name.

**Examples**

```
ZONE "MAIN.PUMP4"

This command will cause a move to the zone called PUMP4 in the image called MAIN.
```
This command will cause a move to the zone represented by the value of the tag called ZON.

**Tag Sampling Command**

Tags are sampled periodically. However, sometimes it may be necessary to spontaneously sample and record the current values of external elements. For example, in some batch programs, tags must be sampled and recorded in synchronization with events, such as when a value has stabilized.

In the Application Language, the sample symbol is an exclamation mark (!) which is attached to the name of the tag to be sampled.

**Examples**

<table>
<thead>
<tr>
<th>Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>@TOTAL = @TOTAL + @!WEIGHT</td>
</tr>
<tr>
<td>PRINT$A &quot;Mixture is ready with volume&quot; @!VOLUME</td>
</tr>
</tbody>
</table>

**Statements**

Statements consist of two elements, Conditions and Operations.

Conditions contain expressions that yield the value True (non-zero) or False (zero).

Operations can contain several commands, each separated by a semicolon. No line breaks are necessary between commands.

If an expression in a Condition yields a True value, the commands in the relevant Operation are executed. If the expression is false, the commands are ignored and the program proceeds to the next statement.

*Note*: The Conditions element may be empty, causing the Operations to be executed in any case.
Examples

```
IF($HOUR = 18) AND @DONE
THEN RLOAD "NIGHT.1"

IF @LEVEL >= @SETP
THEN RESET @PUMP; SET @MIXER; PRINT$E "Starting Mixing"
```

Comments

Comments can be inserted in statements, but will be ignored upon program execution. Comments are typed in curly brackets {}.

Example

```
IF @LEVEL >= @SETP
THEN RESET @PUMP; { SET @MIXER; }
PRINT$E "Starting Mixing"
```

Statement Groups

Several statements can be grouped together in a single condition. When the condition is True, the statements will be executed. If the statement is False, the entire group will be ignored, including all its conditions and commands.

Groups are placed between BEGIN and END directives, which serve as grouping elements only.

The BEGIN directive must be the first element in a group of statements and the END directive must be the last element.
Example

```
IF$NEWHOUR
THENBEGIN;
SET @STORE; SET @MOVE
IF
THENRSAVE "PROD."$HOUR
SHELL "FILETRAN PROD."$HOUR
IF@COUNT < @CMIN
THENPRINTSA "Count too small: ":@COUNT
IF@COUNT > @CMAX
THENPRINTSA "Count too large: ":@COUNT;
END
```

In the example above, the statements will be executed only at the beginning of each hour.

*Note: The second statement has an empty Condition and is executed only when the entire statement group is executed.*

Statement groups can be nested. This means that a group can be included as part of another group.
Example

```
IF $NEWHOUR
THEN BEGIN;
    SET @$STORE; SET @$MOVE;
    @$TOTAL = @$TOTAL + @$COUNT
IF
THEN RSAVE "PROD."$HOUR
    SHELL "SENDFILE PROD."$HOUR
IF @$CHANGE
THEN BEGIN;
    SHELL "GETFILE ORDER.NEW"
IF
THEN RLOAD "ORDER.NEW"
IF @$PASS
THEN RESET @$WAIT;
SET @$GO;
END
IF @$COUNT < @$CMIN
THEN PRINT$A "Count too small: @$COUNT"
IF @$COUNT > @$CMAX
THEN PRINT$A "Count too large: @$COUNT;"
END
```
**Points to Remember**

The following are points to remember about Application language as it relates to alarms, bit-testing, initialization, external programs and tags.

**Alarms**

Commands can be written in the Application Language to issue alarms. However, if alarms that announce flag status or setpoint violations are required, it is recommended to define these alarms according to the instructions provided in the Alarms chapter.

Alarms issued as a result of Application Language commands are specified as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>WIZWIL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity</td>
<td>10</td>
</tr>
<tr>
<td>Class</td>
<td>None</td>
</tr>
<tr>
<td>Zone</td>
<td>0</td>
</tr>
</tbody>
</table>

**Bit Testing**

To reduce the number of tags under application control, and reduce communications and processing loads, several discrete flags (bits) can be grouped into a single analog tag (if the external device supports this grouping).

Several bit-wise operators, such as >>, &, |, BXOR, and BIT can be used to isolate and test analog tag bits.

For example,

```
IF ((@STATUS1 | @STATUS2) BIT 3) AND @POWER BIT 5
THENPRINT$A "Conveyor motor stuck"
```

Such bit-oriented analog tags can be displayed as Drum tags, as explained in the Image Editor chapter.
Initialization

Sometimes, an application may need to perform several operations upon startup. In order for the system to be able to identify a startup operation, specified by a Application Language program, Dummy tags are automatically initialized to 0.

For example:

```plaintext
IF @RUN = 0
 THEN @RUN = 1;
 RLOAD "INIT.1";
 RLOAD "INIT.2";
 SET @GO
```

Where RUN is a Dummy tag.

External Programs

An application can exchange information with other programs using recipe files, and can invoke operating system programs and batch files using the Shell command. The Shell command can be used for file maintenance operations, file transfers, complex calculations, and report generation.

Using the Print command with $B, $C, or $D, the application can generate files that can be exported to other programs, such as spreadsheets, databases, and report generators.

Tags

- String tags can receive string values with a maximum of 81 characters. Any character after the 81st will be ignored.
- A maximum of three string tags can be concatenated in the same statement. For example, in the statement

```plaintext
@STRING_SUM = @STR1 @STR2 @STR3 @STR4
```

the last string tag (@STR4) will be ignored.

In addition, as mentioned above, the @STRING_SUM tag in the example should receive a maximum of 81 characters.
Chapter 28 Scheduler

About this chapter:

This chapter describes the Scheduler module.

Scheduler for Internet - Overview on page 28-2 discusses the basic Scheduler features.

Enabling the Scheduler on page 28-6 guides you through how to enable the Scheduler module.

Accessing the Scheduler on page 28-7 guides you through how to access the Scheduler module.

The Scheduler Interface on page 28-12 discusses the various sections of this module's interface and how to implement them to create tasks, actions, states etc.

Server on page 28-43 discusses Scheduler server options.

Scheduler Tips on page 28-45 gives you a few tips on how to improve the Scheduler's performance.
Scheduler for Internet - Overview

The new generation Internet based Scheduler enables you to easily create daily or weekly task orientated schedules remotely. Accessed through an Internet browser or by clicking on an icon, the Scheduler is extremely user friendly, efficient and economical.

Being both task and time orientated the Scheduler can be used to create unlimited tasks, actions and states. Task can be modified, enabled/disabled and have many states such as On/Off attached to them. An unlimited number of actions, which are basic operations, can be attached to each task.

Timetable templates can be created in advance and be attached to a task. Additionally, multiple schedules using the same template can be defined, where changes made to one template will automatically appear in all the other schedules using the same template.

The Scheduler enables temporary changes to be defined for both tasks and dates.

An additional feature is the ability to create an unlimited number of Special Days, such as public holidays and incorporate them into the task schedule. Different tasks can be defined for these days or the task schedule for a specific day can be altered.

Another feature used to make changes is the Temporary Daily Program. The definitions made in a Temporary Daily Program override regular task and Special Day definitions.

The internet based Scheduler is designed to be used on the application but in the future can also be used on OPC and @aGlance servers, enabling access to real-time databases and allowing you to program actions on different sources.

Note: For optimal view set your computer screen resolution to: 1024 X 768.

Secure Access

Access to the Scheduler is through password only. The user authorization rights defined in the control application are also relevant for this module.

Once accessed the user can schedule or modify operations for any workstation.

Note: If enabled by the application's plug type.

Enhanced Settings

The Scheduler Settings page has three sections; General, Start Up and Working Days & Hours. These sections can be used to define the time and day of the week that the...
schedule starts and ends, how the schedule acts during start up, how messages are logged and for debugging diagnostics. When necessary, these definitions can be used to retrieve schedules that have been lost during communication failure or, when the database is unavailable. The Settings page is also used to define the language of the Scheduler.

**Task**

A task is any operation that the user defines that is automatically activated through the Scheduler. The task is also the basic programmable unit of the Scheduler. See Building a New Task on page 28-32.

**Template**

A template is a timetable that can be attached to many tasks. Multiple task schedules using the same template can be defined, where changes made to one template will automatically appear in the other task schedules using the same type of template. See Creating a New Template on page 28-23.

**State**

A State is the connection between what has to be done (action) and when (timetable). There are two types of states:

- Task related depending on the task type, such as On/Off, High/Low
- Timetable related connecting between the task and the time the task should be performed


**Action**

An action is a basic task operation such as, writing a value to a tag, or executing a macro. See Creating Actions on page 28-36.

**Special Day**

Special Days are occasions that occur out of the task schedule's defined time boundaries.
The application engineer can schedule Special Days by clicking on the current timetable or by rescheduling an existing one. See Special Days on page 28-38.

**Adding Temporary Date Changes**

This option enables you to select a task on a specific date and time and then add new states and actions to it. See Adding a Temporary Daily Program on page 28-34.

**Temporary Daily Programs**

The definitions made in a Temporary Daily Program override regular task and Special Day definitions. See Temporary Daily Programs on page 28-41.

**Architecture**

The Internet based Scheduler is an excellent solution for both Gateway and Portal architecture.

When Gateway architecture is used whereby several stations are linked to one Scheduler, the user can view all station databases and build tasks accordingly. However in Portal architecture, that offers higher security and global access, each station has its own Scheduler. The user can view a list of stations and then select the database of a specific station and build task timetables.

**Database**

The database (Microsoft Access) built from a set of tables linked to each other is the heart of the Scheduler module and acts as a middle layer between the client and server sides. A database holds all the information regarding the tasks, states, actions, timetables etc. defined in the Scheduler.

On the web side the database is responsible for defining the tasks, states, actions etc. Whilst the server on the other side reads the information appearing in the database and then builds the daily program that is to be implemented.
Note: If an Access database is not available then an SQL database with conversions can be used. For further details regarding the Microsoft Access program read its Help files.

Server

The server (WebSchSrv.dll) is implemented as a COM component. The main responsibility of the server is to read the information saved in the database and to create a daily program for implementation. At the end of each working day, the server creates a new daily program for the next day. However, if after changes have been defined and when in the Inform Server page the "Yes" option is selected the server will build a new daily program for the same day that will include the updated information.

The server works independently within the SCADA system (or other control application). Each SCADA interfacing with the server must be a COM client and control the server through the supplied interface.

After the server builds a daily program it is fired to the server clients according to the task action time defined in the timetable. Since each task action is sorted according to time, the server after firing one task action waits for the next task action's time and then again fires a task action.

The server is also responsible for handling time adjustment of the computer's clock both manually by the operator or automatically for day light saving (DST). During start up the server can perform all actions that were defined in a timetable and that were not performed when the server was shut down. (According to the definitions in the application's Settings tab). The server supports hotbackup of control applications. See Server on page 28-43.

Requirements

This module as other web-based modules has two sides where each side requires the following:

- Web Side
  - Internet Browser IE5.5 SP 2, or higher
  - Application's URL
Installation

The Scheduler is installed together with the application. If you wish to update an existing application and add the Scheduler plug, contact your application supplier. See Chapter 3, Installation.

Enabling the Scheduler

Before the Scheduler is accessed the Scheduler module must first be enabled in the Station Properties dialog box.

► To enable the Scheduler module:

1. In the All Containers side of the Application Studio right click the application's name to open the Station Properties dialog box.
2. Using the arrow, scroll and open the Scheduler tab.

3. Check the Enable Scheduler checkbox and then click OK to actually define this option.

4. Restart the application.

**Accessing the Scheduler**

Access to the Scheduler is through password only. The user authorization rights defined in the application's User Management module are also relevant for this module.

Once accessed the user can schedule or modify operations for any workstation.

*Note: The user name and password are case sensitive.*

➤ **To access the Scheduler through the Image module:**

Access through the Image module can only be made if tasks have previously been defined in the Scheduler.

1. In the Image module when in Edit mode click the icon. The clock icon with an arrow attached to it will replace your mouse arrow.

2. Draw an object. The Scheduler Task Configuration dialog box opens.
3. Click the arrow in the Task Name field and select a task from the list.

4. If relevant, click the Groups button and define access permission to the selected task and then click OK. A clock will appear in the Image window.

5. Move to Trigger On mode and then click the clock object with the Trigger hand. The Scheduler Login page opens.

6. Type in your User Name and Password and then click the Login button. The selected task page opens in the Scheduler site.
To access the Scheduler through the Scheduler Icon:

If Enable Scheduler is defined in the Station Properties dialog box the Scheduler icon will appear in the Application Studio Control Panel.

1. Click the icon in the Application Studio Control Panel. The Scheduler dialog box opens.
This dialog box has the following fields:

**Server Control**  This field has the following buttons:
- Start
- Disable/Enable
- Backup - which creates a backup of the Scheduler database
- Compact DB - which when clicked updates the Scheduler database

**Scheduler Web Site**  This button when clicked connects the user to the Scheduler web login

**Auto Run**  This defines that when the application is open and the Scheduler icon is clicked, the Scheduler will automatically open
### Server Status
This field indicates the status of the Scheduler server, which can be:
- **Running**
- **Not Running**
- **Disabled**

### Last Error
This field displays the last error that occurred in the Scheduler.

### Actions
This table shows the task action that is currently being performed.

2. Click the Scheduler Web Site button to access the Scheduler Login page.
3. Type in your User Name and Password and then click the Login button. The selected task page opens in the Scheduler site.

**To access the Scheduler through a Web Browser:**

1. In the Internet browser, type in the application's URL and click the Search button. If there are no communication problems the Scheduler Login page should open.
2. Type in your User Name and Password and then click the Login button. The main page opens.

*Note: The user name and password are case sensitive.*
The Scheduler Interface

The Scheduler interface is divided into three panes:

- Toolbar
- Outlook Bar
- Work Area
**Toolbar**

The toolbar holds the following tab options:

- ![Icon](image1.png) Click this button to exit the Scheduler interface
- ![Icon](image2.png) Click this button to open the Scheduler home page
- ![Icon](image3.png) Click here to access the Temporary Daily Program page
- ![Icon](image4.png) Click here to access the Scheduler Settings page
- ![Icon](image5.png) Click this button to access the Scheduler System Info page
- ![Icon](image6.png) Click this button to logout of the Scheduler
- ![Icon](image7.png) Click this button to open the Scheduler calculator
- ![Icon](image8.png) Click this button to open the Scheduler Help
- ![Icon](image9.png) Click this button to change the direction of the user interface.
- ![Icon](image10.png) Click this button to enable tip of the day. This button is not in the Toolbar but appears in the Scheduler’s interface.
**Settings**

The Settings page is used to define the general settings of a timetable schedule.

The Scheduler Settings page has three sections:

- **General**
  - The General Settings page has the following sub fields:
  - **Time Range** - this is the adjustment time. If the time is adjusted out of the 60 minutes boundary (manually in the server’s internal clock), the server will shut down. Maximum is 120 minutes. Default is 60 minutes.
**Number of retries on action failure** - the default is three.

**Trace log messages** - defines how and when log messages will be defined for debugging diagnostics.

**Time interval** - the time intervals in the Time/Days columns can be defined to either every 30 or 60 minutes.

---

**Start Up**

This field defines server behavior during start up (in relation to the server’s previous status):

**Update status from:**

- **None** - do nothing during start up.
- **Last time stop** - continue from last time stop (for the same day only)
- **Start of current day** - start actions from midnight until the present time.
- **Start of working week** - runs all actions from beginning of working week.

**Last status failure from** (this occurs only when there is a failure in the updated server during start up):

- **None** - do nothing during start up.
- **Start of current day** - start actions from midnight until the present time.
- **Start of working week** - runs all actions from the beginning of the working week.
Execute only tag actions

When checked performs tag assignments. If this is not checked then macros can also be run and commands can be executed.

Working Days & Hours

This is for view purposes only.

**Week starts on** - defines the day of the week that the timetable commences.

**Week ends on** - defines the day of the week that the timetable ends.

**Day starts at** - draws green colored cells in the timetable for this time period.

**Day ends at** - defines the hour that the timetable ends. The default is that the timetable ends at 23:00.

**Language** - defines the language of the Scheduler.

This could be for example, English, French or German.

*Note: Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button.*
System Info

This page holds general information regarding the system and browser and can be used for diagnostic purposes. The recommended resolution for the web is 1024 x 768.

<table>
<thead>
<tr>
<th>System Information</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser code name</td>
<td>Mozilla</td>
</tr>
<tr>
<td>Browser name</td>
<td>Microsoft Internet Explorer</td>
</tr>
<tr>
<td>Browser version</td>
<td>4.0 (compatible, MSIE 6.0, Windows NT 5.0)</td>
</tr>
<tr>
<td>Java Enabled</td>
<td>true</td>
</tr>
<tr>
<td>Browser Platform</td>
<td>Win32 (x86)</td>
</tr>
<tr>
<td>System Language</td>
<td>en-us</td>
</tr>
<tr>
<td>User language</td>
<td>en-us</td>
</tr>
<tr>
<td>User agent</td>
<td>Mozilla/4.0 (compatible, MSIE 6.0, Windows NT 5.0)</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>max (1024x768), available (1024x768)</td>
</tr>
<tr>
<td>Screen Colors and Fonts</td>
<td>colors (16, 65536), font smoothing false</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Diagnostic information</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>App Server Component</td>
<td>Installed</td>
</tr>
<tr>
<td>WizScheduler Client</td>
<td>Installed, 1.00 Build 0025</td>
</tr>
<tr>
<td>Wizcom</td>
<td>Running</td>
</tr>
<tr>
<td>Database path</td>
<td>C:\Documents and Settings\asai\Desktop\Application1\WebScheduler.mdb</td>
</tr>
<tr>
<td>Database connection</td>
<td>Connected, 1.51</td>
</tr>
<tr>
<td>Start Session</td>
<td>OK</td>
</tr>
<tr>
<td>Login user</td>
<td>user</td>
</tr>
<tr>
<td>IP Address</td>
<td>127.0.0.1</td>
</tr>
<tr>
<td>Active clients</td>
<td>1</td>
</tr>
<tr>
<td>Wizcom Station</td>
<td>Local station</td>
</tr>
<tr>
<td>Scheduler version</td>
<td>Demo</td>
</tr>
<tr>
<td>Network tags</td>
<td>Disabled</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
</tr>
</tbody>
</table>

Axeda™
Diagnostic Information

AspServer Component
This field has three options:
- Installed
- Not installed
- Unable to determine

Scheduler Client
This field has three options:
- Installed
- Not installed
- Unable to determine

If not installed appears in this line this indicates a problem with the installation of this component.

Wizcon
If this is not running the Scheduler cannot be run since it takes its database from the application.

DB path
The full path of the database should be written here. If this line is empty this indicates a problem with the control application. It could be that the application is not running.

DB connection
This field indicates the database status and version. This field will be Not connected if the DB path field is also empty. If the path is not correct this could indicate that the database is not legal, or that it is located elsewhere, or that it is read only, or that the user is not authorized to access the Scheduler database.

Start session
If this is not OK this indicates a problem with the web server which could IIS, PWS or, that the virtual directory does not point to the correct location of the web server. When this occurs some fields will not be correct.

User Login
This field lists the user's login name.

Active Clients
This field lists the number of clients that are at present active.

Application Station
Each station has a unique name. This field lists the specific station's unique name.
Note: Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button.

Calculator

The Scheduler calculator is multi purpose and can be used for a number of tasks on the Scheduler.

To access the Scheduler click the icon.

Change User Interface Direction

This option is used to change the layout direction of the user interface. This is useful for languages such as Hebrew or Arabic that read from right to left. To access this option click the icon.
**Outlook Bar**

The Outlook Bar has the following button options. When the Tasks, Templates, States, Special Days and the Server buttons are clicked additional button options open.

- **Tasks**

- **Templates**

- **States**

- **Special Days**
  When clicked opens two sub menu buttons. New and Explore. See Adding Special Days on page 28-33.

- **Server**

**Workflow**

In general Tasks, Templates, States and Actions can be defined in any order. However, if this is the first time you are using the Scheduler module this workflow may be of help to you.

Before beginning work in the Scheduler decide if your configuration is for many tasks using the same template or, if each task has its own template, tasks, actions and states. Then follow this order:

- Create a State
- Define a Template
- Define a Task
- Create an Action
Creating New States

A State is the connection between what has to be done (action) and when (timetable). There are two types of states:

- Task related depending on the task type, such as On/Off, High/Low
- Timetable related connecting between the task and the time the task should be performed

To create a state, do the following:

1. In the Outlook Bar click the States button and then click New to open the States Definition page.

This page has the following fields:

- **Name**: This field holds the name of the state, which can be of one word only and is mandatory.

- **Description**: This field holds a short description of the state, which is useful when many states are used. This field is not mandatory.

2. Click OK to confirm these parameters and to save the state in the States List.
Note: Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button

Opening Existing States

After a state is defined and then added to a task or template the States page can be accessed to view the States List and to locate where each state is used. To view the States List, do the following:

1. In the Outlook Bar click the States button and then click the Explore button. The States page opens.

2. Click the relevant state. The name of the State is displayed in the Layout Listing and a list of where the State is used appears in the Tasks and Templates columns.

3. To view a specific task or template click the relevant task/template name in the relevant column.

Note: States can be added and deleted by clicking the relevant button or by right clicking and selecting either New or Delete.
Creating a New Template

A template is a timetable that can be attached to many tasks. Multiple Task schedules using the same template can be defined, where changes made to one template will automatically appear in the other task schedules using the same type of template.

1. In the Outlook Bar click the Templates button. The New and Explore buttons are displayed.

2. Click the New button to open the Template Definition page.

   ![Template Definition Page]

   This page has the following fields:

   **Name**
   - This field holds the name of the template, which can be of one word only and is mandatory.

   **Description**
   - This field holds a short description of the template, which is useful when many templates are used. This field is not mandatory.

3. More than one template can be created in the same Template Definitions page. Click the Apply button to save your definitions and then continue to create another template.

4. Click OK to save the template/s and to exit the page.

*Note: Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button.*
Opening Existing Templates

After templates have been defined and saved they are added to the Templates List. To open this list, do the following:

1. Click the Templates button and then click the Explore button. The Scheduler opens displaying the Templates List.
2. Select and click a template from the list. The selected template will open in the Scheduler.

This page has the following buttons and right click options:

**New**
Right click in the Templates List and select New to open a new template.

**Delete**
Select a template from the Templates List and then right click and select Delete to remove a template from the list.

**Save**
Click this button to save your template definitions.

**New State**
Click this button or right click in the States List to open the State Definition page. See Creating New States on page 28-21

**Delete State**
Click this button to delete a selected State.

**Special Days**
Click this button to view the Special Days page. See Opening Existing Special Days on page 28-38
The Template page has the following arrows:

- Scroll to the top of the page
- Scroll up
- Scroll down
- Scroll to the bottom of the page

**Add Time**
Click this button or right click to add a time to the Scheduler. 
*See Add Time on page 28-26*

**Toggle Unused**
Click this button or right click to view only the hours that have states defined.

**Search**
Click this button or right click to search for a state/action in the template. *See Search on page 28-27*

**Toggle Days**
Right click to select this option. This feature toggles between the weekday and special day views.

**Unmark Selected**
Right click to select this option. This feature is used to remove the highlighting on a selected state.
Add Time

This feature is used to add time to the Scheduler’s hourly calendar. To add time do the following:

1. Click the Add Time button or, right click and select Add Time to open the Add Time page.

2. The left side field is used to define the relevant hour whilst the right side field defines minutes. Scroll down both fields, select the appropriate parameters and then click the Add button. The new time is added to the template.

Note: If a new time is created but no state appears on the timetable for it, then the next time the task is opened it will not be displayed.
Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button.
**Search**

The Search feature can be used to locate a state/action in an open template. This is useful when the template holds many states/actions. To find a state/action do the following:

1. Click the Search button, or right click and select Search. The Scheduler Search page opens.

2. In the Search for field type in the name of the State/Action that you require and then click the OK button. The state (or an action with the same name) will be highlighted in the Scheduler.

3. Right click and select Unmark Selected to remove the highlighting from the state/s.

*Note: The Search for field is case sensitive. Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button.*
Creating Tasks

A task is any operation that is defined and that is automatically activated through the Scheduler. To create a task, do the following:

1. In the Outlook Bar click the Task button. The New Task, Explore and Week Overview buttons are displayed.

2. Click the New button to open the Task Definition page.

This page has the following fields:

- **Name**: This field holds the name of the task, which can be of one word only and is mandatory.
- **Description**: This field holds a short description of the task, which is useful when many tasks are used. This field is not mandatory.
- **Source**: This field displays the SCADA application source.
- **Type**: This field defines the number of actions each state can hold and perform. There are two types; single and multiple.
Opening Existing Tasks

After tasks have been defined and saved they are added to the Tasks List. To open this list, do the following:

1. Click the Tasks button and then click the Explore button. The Scheduler opens displaying the Tasks Tree.
2. Select and click a task from the Tree. The selected task will open in the Scheduler.
Selected Task Interface

The Selected Task Interface has the following features:

**Toolbar**
This toolbar is unique to the Selected Task Interface.

**States List**
Right click this button to add a New state, or Attach, Remove, Copy or Paste an existing state.

**Timetable**
The timetable is empty until a template is attached or, states are added.

**Type**
This refers to the type of action. Right click to Add, Delete, Move Up, Move Down or Delete All types.

**Actions**
An Action is the activity that the task actually performs. Right click to Add, Delete, Move Up, Move Down or Delete All actions.

The Selected Tag Interface has the following arrows:

- **Scroll to the top of the page**
- **Scroll up**
Scroll down

Scroll to the bottom of the page

**Selected Task Interface - Toolbar**

- Save All - always click before you exit the Selected Task Interface
- New State - click here to create a new state
- Remove State - click here to remove a state from the State List
- Attach State - click here to open the Public States List and then select a state.
- Attach Action - click here to open the Actions fields
- Search Action/State - click here to open the Search for page
- Task Properties - click here to open the Task Definitions page
- Add Time - click here to open the Add Time page
- Attach Template - click here to open the Templates List page
- Toggle Unused - click here to delete empty hours from timetable view
- Special Days - click here to open the Special Days timetable
- Temporary Date Changes - click here to define a task state and action for a specific day
- Daily Program - click here to open the Task Daily Program Report
- Inform - click here to update the Server

*Note: Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button. If changes are not saved they will not be recorded in the database.*
Building a New Task

This section explains how to attach a Template, add States and Actions and if required Special Days or a Daily Program to a task. The following is a suggested order for building new tasks:

- Attach a Template
- Add/attach States
- Add Actions
- Define Special Days
- Save and update Server

1. Click the Attach Template icon or right click in the empty timetable to open the Templates List page.

2. Select a template and then click OK. The template will be attached to the task.

*Note: To create a new template See Creating a New Template on page 28-23.*

Attaching an existing State to a Task

1. Click the Attach State icon or right click on States and select Attach or Multi Attach to open the Public States List page.

2. Select a state or select Multi Attach and then click OK. The state will be attached to the States List in the task.

3. Select a state from the States List and then click the timetable on the relevant hour.

4. Click Save to save these definitions.

*Note: For a Task to be performed the attached states must have actions attached to them. For further details on States See Attaching an existing State to a Task on page 28-32. For further details on Actions See Attaching an Action to a Task on page 28-32.*

Attaching an Action to a Task

1. Select a state from the States List. If this has no action attached, click the Attach Action icon. The Type and Action Table columns open.

2. From the Type column select the type of action that is to be attached to the task action.
3. In the Action column select the action that is attached to the task state.
4. Click the Save All icon in the toolbar.

**Adding Special Days**

Special Days override the task definitions of a specific day and can be created before building a new task. To add a Special Day to a task, do the following:

1. Click the Special Days icon to open the Special Days List.
2. Select a state from the States List and then click on a time in the timetable.
3. Click Save to change your changes.

For further details See Adding a Special Day Entry to the Calendar on page 28-39.

**Adding Temporary Date Changes**

This option enables you to select a task that is performed on a specific date and time and add new states and actions to it. To add a temporary date change, do the following:

1. Click the icon to open the Temporary Date Changes dialog box.
2. Right click in the work area to open the drop down list. There are five options:

**New**  
This option opens the Scheduler calendar where you can scroll and select specific days. You can select as many days as required. Each day will be displayed next to the nearest calendar date.

**Toggle Unused**  
Select this option to view only the tasks that have Temporary Date Changes defined.

**Add Time**  
This option opens the Add Time dialog box where new times can be added to the Temporary Date Changes list. See Add Time on page 28-26

**Search**  
This option is used to search for a state/action in the Temporary Date Changes list. See Search on page 28-27

**Unmark Selected**  
This feature is used to remove the highlighting on a selected state.

*Note: Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button.*

**Adding a Temporary Daily Program**

The definitions made in a Temporary Daily Programs override regular task and Special Days definitions. To view a Temporary Daily Program report, do the following:

Week Overview

The Week Overview displays a timetable of the activity that a task performs over a week. To open the Week Overview, do the following:

1. Click the Week Overview button in the Outlook pane.
**Weekly Overview Toolbar**

- Click here or right click to open the Task Definition page and create a new task.
- Click here or right click to open the task and to modify its schedule.
- Save Task Schedule - always click before you exit the Selected Task Interface.
- Select a task and then click here or right click to delete it.
- Click here or right click to display task properties.
- Click here or right click to display Daily Task Programs.
- Inform - click here to update the Server

**Enable/Disable Tasks**

Tasks can be enabled/disabled by checking the left checkbox on the specific Task.

<table>
<thead>
<tr>
<th>Task Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>23</td>
</tr>
<tr>
<td>24</td>
</tr>
</tbody>
</table>

A task that is disabled will be removed from the Tasks List and will not be performed.

*Note:* When a check appears in the Week Overview's timetable pane this indicates that the task is enabled for the specific day.

If the task has a green highlight this indicates that the task has actions attached to it. Changes should always be saved to the server. In the Outlook Bar click Server and then click the Inform button.

**Creating Actions**

An Action is always attached to a State and is the actual activity that the task performs. To add an Action to a State, do the following:

1. In the Outlook Bar click the Task button and then click the Explore button.
2. Select a task from the Tasks List. The task will open in the Work Area.

3. Select a state from the States List and then either click the Attach Actions icon or right click and select Attach. The Action table Type and Actions columns open.

4. The Types field indicates the type of activity that the action performs and has the following options:

   - **Tag assignment by constants**: Take an application tag and assign a value to it.
   - **Tag assignment by tag**: Take a tag and assign another tag's value to it.
   - **Execute macro**: Execute an application macro.
   - **Execute system command**: Run an Operating System command.

5. In the Actions field click the Browse button to open the Select Tag/Macro page.
6. Select a tag/macro and then close the page. The tag/macro opens in the Action field.
7. Complete the tag/macro definitions and then click Save.

---

**Note:** Use the Scheduler Calculator for any mathematical calculations. Click the Calculator button to access it.
**Special Days**

Special Days definitions override the task definitions of a specific day/hour and can be created before building a new task. To create a new Special Day, do the following:

1. In the Outlook Bar click Special Days and then click New to open the Special Day Definitions page.

2. Complete the fields and then click Apply to define more Special Days or OK to save.

   - **Name**
     This field holds the name of the Special Day, which can be of one word only and is mandatory.

   - **Description**
     This field holds a short description of the Special Day, which is useful when many Special Days are used. This field is not mandatory.

**Opening Existing Special Days**

After Special Days have been defined and saved they are added to the Special Days List. Click the Special Days button and then click the Explore button. The Scheduler opens displaying the Special Days List.
Special Days Interface

The Special Days Interface has the following features:

- **Special Days List**: List of all Special Days defined in the Special Days Definitions page.
- **Save**: Click here to save Special Day definitions.
- **New Day**: Click here or right click to open the Special Day page, where new Special Days can be created.
- **Delete Day**: Click here or right click to delete the Special Day defined.
- **Schedule**: Right click and select Schedule to view the Special Day definition.
- **Go to Day Scrolling**: This feature enables you to scroll and define the year, month and date of the Special Day.

Adding a Special Day Entry to the Calendar

1. Select a Special Day from the Special Days list.
2. Click on a calendar date. The Special Day will be added to the calendar.
**Viewing a Special Day Entry**

1. To view the updated calendar, right click in the calendar and select Scheduler to open the Day Scheduler window.
**Temporary Daily Programs**

The definitions made in a Temporary Daily Program override regular task and Special Day definitions. To define a Temporary Daily Program, do the following:

1. Click the Temporary Daily Programs icon in the Toolbar to open the Temporary Daily Programs interface.

The Temporary Daily Programs has the following features:

- **Days List**  
  This list displays all the Temporary Daily Programs defined.

- **Date**  
  This field displays the date of the Temporary Daily Program, which can be changed by clicking the Calendar icon or by typing it in.

- **Calendar**  
  Click this icon to open the Temporary Daily Programs where a new date can be selected.

- **Go to**  
  Click this icon to open a report of the Temporary Daily Program.

- **New**  
  Click here or right click and select New to open the Daily Program Item Definition page where a new daily program can be defined.
Creating a New Calendar Date

1. Click the Calendar icon to open the monthly calendar.

2. The Calendar has the following arrows which can be used to define a new Temporary Daily Program date:

   - Click this arrow to jump back a year
   - Click this arrow to jump forward a year
   - Click this arrow to jump back a month
   - Click this arrow to jump forward a month

Save
Click here to save new Temporary Daily Program definitions.

Print
Click here or right click and select Print to print the new Temporary Daily Program.

Default
Click here to return to the Temporary Daily Program default definitions.

Modify
Select a row and then right click and select Modify to open the Daily Temporary Program Definitions page.

Delete
Select a row and then right click and select Delete to remove a Temporary Daily Program.
Creating a New Temporary Daily Program

1. Click the New button or right click and select New to open the Daily Program Item Definition page.

2. In the Time field type in the time of the task/state, which should be performed.

3. In the Task field either type in the name of the task or, click the Browse button to open the Tasks List and select the relevant task.

4. In the State field either type in the name of the state, or, click the Browse button to open the States List and select the name of the state that is attached to the task.

5. Click the Apply button and then create another Temporary Daily Program or, click OK to save these definitions.

**Server**

The explanation given below describes the Server button in the Outlook Bar and its sub options.

To access the server options click the Server button in the Outlook Bar. The following sub option buttons are displayed:

- **Start**
  - Runs the server and builds the daily program.

- **Stop**
  - When selected actions are not fired to the client.
Inform   This button when clicked, triggers the server to build a new daily program. After changes are made in the Scheduler this button should be clicked to inform the server about the updated database. When this is not clicked the updated data will only be applicable on the following day.

Status   Shows the server status mode:

Running

Error and its Time

Error and its Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last task execute time</td>
<td>01/09/2001 00:00:00</td>
</tr>
<tr>
<td>Last action execute time</td>
<td>01/09/2001 00:00:00</td>
</tr>
<tr>
<td>Last task ID</td>
<td>0</td>
</tr>
<tr>
<td>Last server status</td>
<td>0</td>
</tr>
<tr>
<td>Last server status description</td>
<td><strong>Not Loaded</strong></td>
</tr>
<tr>
<td>Last server status time</td>
<td>01/09/2001 00:00:00</td>
</tr>
<tr>
<td>Last error</td>
<td>None</td>
</tr>
<tr>
<td>Last error time</td>
<td>01/09/2001 00:00:00</td>
</tr>
</tbody>
</table>

Update server status

Note: For the Start, Stop and Inform button to apply the server must be loaded.
Scheduler Tips

1. Double click on the Outlook Bar right pane to resize it to create a larger view area.

2. In a task schedule if you place the mouse over a cell with a state defined a window will open displaying all the actions attached to the state.

3. You can set a temporary schedule for each day to override any predefined schedule. Click the Temporary Daily Program icon in the main toolbar to do so.

4. You can attach a predefined scheduling template to a task schedule by clicking the Attach Template icon in the task toolbar.

5. In the Task or Template scheduler click the Special Days icon in the task/template toolbar to switch between the week view and the Special Days view.

6. To show/hide empty hours in a template schedule click the Toggle Unused icon in the task/template toolbar.

7. To search for a state/action in a task/template schedule click the Search icon in the toolbar.
Chapter 29 Recipes

About this chapter:

This chapter describes how to create, define and apply recipes in the system, as follows:
Overview on page 29-2 describes the basic principle of recipes, including a discussion of recipe files, models and write blocks.
Recipe Model Creation and Modification on page 29-3 describes how to create and modify recipe models.
Applying Recipes on page 29-8 describes how to set the tag values of an ongoing process to a specified recipe.
Loading Recipes on page 29-7 describes how to load recipes in the application.
Recipe Properties on page 29-8 describes how to determine the tag value and the recipe that will be loaded on startup.
Additional Information on page 29-9 provides additional information concerning files and communications.
Overview

This chapter describes Recipes, which are lists of tag values that are applied to specific control processes. Value groups are applied to a control process to cause the process to enter a desired working state.

In the application, when a recipe is applied, the tags listed in the recipe are set to the corresponding values that specified. Tags in a recipe can be assigned a set value or associated with the value of another tag. If a tag is associated with another tag, its value will be the current value of the tag with which it is associated at the time the recipe is applied.

Creating recipes involves two steps:
- Creating a recipe model
- Creating a recipe, based on a model

Recipe Files

Recipes are stored as simple text files. Therefore, they can be used to exchange information between the application and other programs.

Models

Recipes are defined and grouped using models. A Model is a prototype list of tags from which recipes are derived. In the application, models must be defined before recipes. However, while each recipe must belong to a model, recipes do not necessarily have to include tags from the model to which they belong.

Each model and recipe has a unique name. Two different recipes with the same name can belong to different models.

Models, like recipes, are stored as text files, and can be exported to external applications.

Write Blocks

Write blocks are groups of tags to which values are written in a single data transfer operation whenever the recipe is applied.
Recipe Model Creation and Modification

The following section describes how to create and modify recipe models.

When defining recipe models, you create a prototype list of tags from which recipes are derived. This involves the following:

- Entering a description of the recipe model.
- Selecting the tag(s) and stations upon which you want to base the model recipe.
- (Optional) Specifying a write block.

Model recipes are created in the Model Editing dialog box. This dialog box is invoked from the Application Studio.

- To create a new recipe model, follow the instructions listed on the following page to invoke the Model Editing dialog box.
- To modify a recipe model, double-click the recipe model in the List of Recipe Models.

To create a recipe model:

Click the New Recipe Model icon in the Application Studio toolbar.

Or,

In the All Containers section of the Application Studio, right click Model Recipes and select New Recipe Model File from the popup menu. The New Recipe Model File dialog box is displayed:

Enter the new model name and click OK. The Model Editing dialog box is displayed.
If you are modifying a model recipe, the dialog box will display the model recipe definitions.

The following options are available:

- **Description**
  Specifies a brief description of the tag.

- **Station Name**
  Specifies the station to which the tag belongs.

- **Tag Name**
  Specifies the name of a tag. To view and select from a list of existing tags, click the arrow to the right of the field. Your entry will mark the beginning of the write block.

- **Block Size**
  Specifies the number of tags to be included in the write block.

- **To add a tag to the model:**
Enter the required options as described above and activate the Add button. The tag is displayed in the tag list box.

- **To change a tag:**
Select the tag in the tag list box, then select a different tag in the Tag Name field and activate the Change button.

- **To delete a tag from the list:**
Select the tag in the tag list box, and activate the Delete button.
Recipe Creation and Modification

This section describes how to create and modify a recipe.

Recipe Creation

A recipe is defined and grouped according to a model; therefore its respective model must be specified before creating the recipe.

When defining recipes, you define a list of tag values that are applied to a specific control process.

Recipes are created in the Recipe Editing dialog box. This dialog box is invoked from the Application Studio.

- To create a new recipe, follow the instructions listed on the following page to invoke the Recipe Editing dialog box.
- To modify a recipe, double-click the recipe in the List of Recipes.

▶ To create a recipe:

From the All Containers section of the Application Studio, double-click Model Recipes. If recipes have been defined a list of the recipes opens underneath the Model Recipe module.

1. Right-click the model upon which you want to base the recipe and select New Recipe from the popup menu. Notice how the List of Recipes is displayed in the Application Studio. The New Recipe File dialog box is displayed.

2. Enter the recipe name and click OK. The Recipe Editing dialog box is displayed:
If you are modifying a recipe, the dialog box will display the recipe definitions.

The options available in this dialog box are similar to those in the Model Editing dialog box, with the addition of the Value/Tag field, as described:

- **Value/Tag**
  Specifies the value for the selected tag. Note that you can specify several values, separated by commas, in which case each value will be written to the next memory location in the PLC. This option can be used only if your PLC supports recipe write blocks.

- **To add a tag to the recipe:**
  Enter the required options as described above and activate the Add button. The tag is displayed in the tag list box.

- **To change a tag:**
  Select the tag in the tag list box, then select a different tag in the Tag Name field and activate the Change button.

- **To delete a tag from the list:**
  1. Select the tag in the tag list box, and activate the Delete button.
  2. Click the Save button to save your definitions and close the dialog. The recipe appears in the List of Recipes in the Application Studio.
**Loading Recipes**

After defining model recipes and recipes you can load the recipe to apply its tag values to the system.

► **To load a recipe:**

1. In the All Containers section of the Application Studio, double-click on Model Recipes to display the list of defined models.

2. Click the model upon which the recipe you want to apply is based. The recipe is displayed in the List of Recipes.

3. Right-click the recipe and select Transmit Recipe from the popup menu. The Load Recipe File dialog box is displayed:

4. Select a recipe and activate the OK button. A dialog box appears notifying you that the recipe was successfully loaded.

*Note: If an error occurs when a recipe is loaded, a message is displayed. An explanation of the error is written to a file called errors.rcp, which can be viewed using any text editor.*
Applying Recipes

Applying a recipe means setting the tag values of an on-going process to a specified recipe.

To apply a recipe:

From the All Containers section of the Application Studio, double-click on Model Recipes to display the list of defined models.

1. Click the model upon which the recipe you want to set is based. The recipe is displayed in the List of Recipes.

2. Right-click the recipe and select Receive Recipe from the popup menu. A dialog box appears notifying you that the recipe was successfully saved. The tag values of the selected recipe are modified to the tag values of the on-going process.

Recipe Properties

This section describes how to determine the tag value and the recipe that will be loaded on startup.

To define recipe properties:

From the All Containers section in the Application Studio, right click Model Recipes and select Properties from the popup menu. The Recipes Properties dialog box is displayed:
The following options are available:

**Startup Recipe:** Determines the name of a recipe that will be loaded during system startup.

**Process each value according to its tag:** Enables the processing of values according to the tag associated with the appropriate address in the recipe block.

**Enable sampling during recipe operations** Enables the application to sample during recipe operations.

*Note: Restart the application for changes to take effect. The application logger and alarm generator are activated only after the specified recipe is loaded. If the load fails, see the file called error.rcp for a description of the failure.*

---

**Additional Information**

The following sections provide additional recipe information concerning files and communications.

**Files**

Recipes and models are stored as text files. These files can be used by external programs, such as; spreadsheets, databases, report generators, production management programs, or computation programs. To facilitate this data exchange, the recipe file format must be defined, so that external programs will be able to read them.
Model Files

Model files are named file.RC@, where file is the model name that can include any alphanumeric character. Model files have the following format:

```
Description ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
 gggggggg = 0 ;
```

The first line is a brief description of the model. gggggggg stands for the tag name. Each tag value appears after the tag name, although for model files these values are insignificant.

For example,

Booster Startup and Operation ;

```
SPEED0 = 0 ;
SPEED1 = 0 ;
VOLT0 = 0 ;
VOLT1 = 0 ;
FLOW = 0 ;
VOLUME = 0 ;
```
Recipe Files

Recipe files are named file.recip, where file is the name of the model and recip stands for the recipe name that can include any alphanumeric character. Recipe files have the following format:

<table>
<thead>
<tr>
<th>Description ;</th>
</tr>
</thead>
<tbody>
<tr>
<td>gggggggg = vvvvvv ;</td>
</tr>
<tr>
<td>gggggggg = vvvvvv ;</td>
</tr>
<tr>
<td>gggggggg = vvvvvv ;</td>
</tr>
<tr>
<td>gggggggg = vvvvvv ;</td>
</tr>
<tr>
<td>gggggggg = vvvvvv ;</td>
</tr>
<tr>
<td>gggggggg = vvvvvv ;</td>
</tr>
<tr>
<td>gggggggg = vvvvvv ;</td>
</tr>
</tbody>
</table>

The first line is a brief description of the recipe. gggggggg stands for the tag name and vvvvvv stands for a value (or the name of another tag from which the value is taken). For example,

<table>
<thead>
<tr>
<th>Fine Grain Size ;</th>
</tr>
</thead>
<tbody>
<tr>
<td>MESH1 = 5 ;</td>
</tr>
<tr>
<td>MESH2 = 7 ;</td>
</tr>
<tr>
<td>MESH3 = 11 ;</td>
</tr>
<tr>
<td>SPEED = 390 ;</td>
</tr>
<tr>
<td>FLOW = 1200 ;</td>
</tr>
<tr>
<td>VOLUME = @VOLMIX ;</td>
</tr>
</tbody>
</table>

Note: @ is used as a text string that begins from the @ sign. The @ sign alone signifies a tag name. The tag list is taken from the relevant model. The tag values constitute the recipe.

Model and recipe files have the same format:

- In a model file, the tag list constitutes the model
In a recipe file, the tag values constitute the recipe

Since a model file is distinguished from a recipe file only by its extension (.RC@), a recipe can be converted into a model by assigning it the proper extension.

Note: Modifying models (changing the order of tags or tags themselves) may cause conflicts between recipes created before the model was modified and recipes created after the model was modified. Since models provide the recipe names and tag lists, an error will occur when a model tag list was changed, but its name was not. In such a case, recipes will be created that belong to the same model, but with different tag arrangements. Therefore, when models are modified, their names and tag lists must be modified accordingly.

Write/Save Blocks

Write/save blocks that were defined in the Model Editing dialog box are saved in the recipe file. The following is an example of a write block defined for the tag ANA01 in a recipe file:

```
Compressor Machine 2 ;
ANA01   = 3,26,17,0,5 ;
ANA06   = 390         ;
AIRPRES = 1200        ;
```

RECIPEPERTAG Mode for Recipe Blocks

In previous application versions, all the values in a recipe block were processed according to the first tag. For example, the conversion of all the values in the block were performed according to the first tag.

The RECIPEPERTAG mode for recipe blocks enables the processing of values according to the tag associated with the appropriate address in the block. This mode is activated by specifying yes for the new RECIPEPERTAG variable in the WIZTUNE.DAT file (RECIPEPERTAG=YES).
RECIPEPERTAG introduces the following functions:

- Each value in the block will be converted according to a tag associated with the value's address, when the recipe is saved or loaded.
- During recipe editing, the value's limits will be checked according to the associated tag.
- If a value has no associated tag, that value will not be converted, and no limit checking will be performed. For example, assume the following configuration:

**Tag Definition**

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAG001</td>
<td>A001</td>
</tr>
<tr>
<td>TAG002</td>
<td>A002</td>
</tr>
<tr>
<td>TAG003</td>
<td>A004</td>
</tr>
<tr>
<td>TAG004</td>
<td>A005</td>
</tr>
</tbody>
</table>

Recipe File: Test.001:

@TAG001 = 10,20,30,40,50

Thus, when TEST.001 is loaded, the following procedure will be performed:

- The first value (10) will be converted according to the TAG001 tag.
- The second value (20) will be converted according to TAG002.
- The value 30 will not be converted since no tag is associated with its address.
- Values 40 and 50 will be converted according to TAG004 and TAG005, respectively.
- The converted values will be packed in the message, and downloaded to the PLC.

*Note:* A recipe block can start only with an analog tag. If more than one tag has the same address in a recipe block, the value will be processed arbitrarily according to the parameters of one of those tags. Load and Save blocks are allowed only for communication drivers that support Read and Write block operations.
Communications

When a recipe is captured or applied, the tags associated with the control process from which the recipe is extracted, are either read from or written to. Since the recipe operation involves the immediate updating of current tag values, Forced Read and Write commands are issued by the system during a control process. These commands activate the relevant communication devices.
Chapter 30 History Viewers

About this chapter:

This chapter describes how to generate and use History Viewer lists in the system, as follows:

History Viewer List Definition on page 30-2 describes how to generate a History Viewer list, define a filter, and specify the directory from which the application will extract the historical tag data.

Defining History Viewer Window Attributes on page 30-7 describes how to define attributes for the History Viewer.
History Viewer List Definition

A History Viewer list provides you with simple and straightforward data concerning tags and tag values over specific periods of time. This section describes the following:

- Generating a History Viewer list
- Filtering lists to include only specific tags
- Specifying the directory from which the application will extract the historical tag data
- Loading an existing History Viewer list

Generating a History Viewer List

The application can generate lists of historical Tags values for History Viewer purposes.

To generate History Viewer tag lists:

Click the History Viewer button in the Application Studio toolbar.

Or,

In the All Containers section of the Application Studio, right click History Viewer and select New History Viewer from the popup menu.

The following dialog box is displayed:
History Viewer information is displayed according to the following parameters: Date, Time, Tag, Value and Type.

**Filter Definition**

You can specify the lower and upper range limits of the tags to be included in the History Viewer list.

**To define a filter for the list:**

From the Options menu in the History Viewer window, select the Filter option. The Logger Report Definition dialog box is displayed:

![Logger Report Definition dialog box]

The following options are available:

**Start Time**

Specifies the date and time of the first tag to be included in the History Viewer list. Clicking in the Indicator field displays the following further options:

**Absolute:**

The exact time that you specify. For example, if you specified the date 10-05-02, and the time 15:00:00, tag values will be listed from 3 PM on October 5, 2002.
Relative: The time and date that you specify is relative to the current time and date. For example, for time 10:00:00 and date 3, tag values will be listed from 3 days and 10 hours ago.

Relative Date: The date that you specify is relative to the current date (the time will remain absolute). For example, for 10:00:00 and date 3, tag values will be listed from 3 days ago, at 10 AM.

End Time Specifies the range of date and time of the last tag to be included in the History Viewer list. The options you can select for Indicator are the same as those for the Start Time field described above.

Tag Range Specifies the range of tag prefixes that you want to include in the History Viewer list.

Value Range Specifies the range of tag values that you want to include in the History Viewer list.

Include Set Values Includes set values in the list. Set values are tag values recorded by WizPro upon system initialization.

Target Directs the list to one of the following:

Screen: Sends the list to the screen.

Printer: Prints the list to the printer specified in the Set Printers dialog box, described in the Printers chapter.

File: Sends the list to a file. You must enter a file name into the box below the field.

After you set the filter and activate the OK button, the History Viewer list is generated. The list filter specifications are preserved until a new window is accessed or the system re-started. The History Viewer list is displayed in the dialog box as follows:
**Historical Data Directory**

You can specify the directory from which the application will extract the historical tag data.

- **To specify the directory:**

  From the Options menu in the History Viewer window, select the History Directory option. The History Directory dialog box is displayed:
The following options are available:

**Use default history directory**
Determines that the default directory is used to save the data. The directory is that specified for the History field, in the Set Default Paths dialog box. For more details, refer to File Paths section in the Getting to Know the Application Studio chapter.

**Enter history directory**
Specifies the path of the directory in which the historical data file is located.

*Note: A history’s path cannot have non-alphabetical or non-digital characters apart from spaces.*

▶ **To save the existing History Viewer:**
From the File menu in the History Viewer window, select Save. A standard Save As dialog box is displayed in which you can name the file. Click OK to save the file and exit the dialog box. The History Viewer list is saved with the data definitions.

**Loading an Existing History Viewer**
You can load an existing History Viewer from the Quick Access bar.

▶ **To load a History Viewer:**
1. Click on the Load History Viewer button in the Quick Access bar. A standard Open dialog box is displayed where you can select the History Viewer you want to open.
2. Click OK to close the dialog and open the History Viewer.
Defining History Viewer Window Attributes

You can define parameters for the History Viewer by right clicking on History Viewer in the All Containers section of the Application Studio, and selecting Properties. The Set History Viewer Window Attributes dialog box is displayed:

The following options are available:

- **Title Bar**: Specifies that a title bar appears at the top of the window.
- **Name in Title**: Specifies that the name of the window will appear in the title bar.
- **System Menu**: Specifies that a menu appears when you click on the icon in the top left corner of the window. This menu contains items that can be used to manipulate windows, such as move, size, close and so on.
- **Min/Max Button**: Specifies that a Minimize and Maximize button appear in the top right corner of the window. These buttons can be used to minimize or maximize the window to predetermined sizes.
- **Size Border**: Enables window borders that can be dragged to change the window size.
- **Menu Bar**: Specifies that a menu bar appears in the window.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always on Top</td>
<td>Select to display the History Viewer on top of other open applications.</td>
</tr>
<tr>
<td>Pos</td>
<td>Specifies the window X and Y position coordinates in pixels.</td>
</tr>
<tr>
<td>Size</td>
<td>Specifies the window size in pixels.</td>
</tr>
<tr>
<td>Title Bar Text</td>
<td>Specifies the text that will appear in the Title Bar.</td>
</tr>
</tbody>
</table>
Chapter 31 Reports

About this chapter:

This chapter describes how to use the User-Defined Report utility in the system, as follows:

Overview on page 31-2 is an overview of the User-Defined Report module.
Report Definition and Modification on page 31-2 describes how reports are defined.
Field Summary on page 31-23 describes how to invoke the field summary report.
Saving Reports on page 31-25 describes how to save reports.
Generating Reports on page 31-28 describes how to generate completed reports from the command line and with an Application Language command.
Overview

The User-Defined Report module can be used to define customized reports for specific plant requirements. The application generates the reports that you define with this utility as free-format documents that can contain text and calculated values (fields), based on historical data stored in system files.

After the report is defined and saved, it can be generated by typing the command at the command line, or by a command in Application Language.

A report is composed of the following components:

- **Frame**: Free text and fields. Frames are stored in ASCII files called *.rpt and field data is stored in files called *.rpd.
- **Fields**: Tag and calculated values, including report date and time

Report Definition and Modification

Defining a report consists of five steps:

- Accessing the Report Definition dialog box.
- Creating a frame that is the shell of the report that contains the text and the fields.
- Entering field codes into the frame.
- Inserting field definitions, which are the calculated values inserted in the text at specific locations.
- Saving your definitions.

After you have defined a report, you can obtain a complete list of all the defined fields in your report. The list appears in a dialog in which you can add, change and delete field definitions during runtime.
Accessing the Report Definition Dialog Box

The Report Definition dialog box is accessed from the Application Studio.

► **To access/modify the Report Definition dialog box**

1. Click the New Report button in the Application Studio toolbar.
   
   Or,

   In the All Containers section of the Application Studio, right click Reports and select New Report from the popup menu. The New Report File dialog box is displayed.

2. Enter a name for the report and activate the OK button. The Report Definition dialog box is displayed. If you are modifying a report, the dialog box will display the report definitions.
The following options are available:

- **Field Definition**  Activate to insert field
- **Summary**  Activate to receive a complete list of all the defined fields in the report.
- **Import Html**  Activate to import an HTML file as a template.

### Creating a Frame

The text and fields making up a report are called a frame. You can create a frame in one of two ways:

- Entering text directly into the Report Definition dialog box.
- Using any text editor.

A frame can also be printed.

> **To create a frame:**

In the Report Definition dialog box enter the report text.

The report editor operates like any other ASCII text editor. For text, you can type any character, except the number sign (#), which is reserved for fields. If the report screen is full, you can scroll it using the dialog box scroll bar.

You can also use your own text editor to create a frame file. However, make sure that the frame filename is saved as `[filename].rpt`.

### Printing a Frame

Frames can be printed before generating a report. You can print from the command line or from the Explorer.

> **To print from the command line:**

1. In the Report Definition dialog box click the Save button. The frame is saved in the default file location with the extension *.rpt.*
2. From the command line enter:

   ```
   COPY RPT.[name of report].DAT LPT1:
   ```
3. To enable control characters as form feed in report forms, you can use the \textasciitilde DD, where DD is the printer control code. For example, use \textasciitilde 12 to form feed (control 12).

Some common ASCII codes are:

- 12 Form feed
- 15 Compressed mode (132 characters per line)
- 18 Normal mode (80 characters per line)

You can add codes for your printer to print the report headings in a large font, in bold or underline characters, and so on. These control characters should be defined in the report frame, combined with the text and fields of the report. To use these control characters designate your printer only to one of the following ports: LPT1, LPT2, LPT3, or LPT4.

To print from the Explorer:
1. In the Report Definition dialog box click the Save button. The frame is saved in the default file location with the extension *.rpt.
2. From the Windows Explorer, right-click the file and select Print from the popup menu. The frame is sent to print.

**Entering Field Codes**

A hash mark followed by numbers represents a field code. For example, #00001. The number must be an integer. Thus, #0.012 is not a legal field.

Field codes are used to define field definitions:

- Field codes should be entered in the report frame in correct numerical order.
- Field codes consist of alphanumeric characters that represent the field number and type, preceded by a number sign (#). For example, the code #00001 represents field number 1.
- The length of the field and the field value format are specified by typing the number of the field in the format and the length required:
  For example, all the following fields refer to field number 12, in different formats:

<table>
<thead>
<tr>
<th>Field Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#00012</td>
<td></td>
</tr>
<tr>
<td>#012.000</td>
<td></td>
</tr>
<tr>
<td>#12</td>
<td></td>
</tr>
</tbody>
</table>
If a tag value represents date or time, a field can be assigned for the value. To define a date or time, type the letters D for date, T for time (tag values are measured as seconds, starting from midnight), M for minutes (tag values are measured as minutes, starting from midnight), or S for time with seconds, after the # sign. For example:

```
#D00000012
#T00012
#M0012
#S00000012
```

- #D - Date fields should have a length of eight spaces to provide enough space for hyphens or slashes.
- #T - Time fields should have a length of five spaces for the format hh:mm. For example, if a tag value is 600, the report will show this value as 00:10.
- #M - Time with Minutes fields should have a length of five spaces for the format hh:mm. For example, if a tag value is 600, the report will show this value as 10:00.
- #S - Time with Seconds fields should have a length of eight spaces for the format hh:mm:ss.
- Up to 9,999 fields can be defined per report. The report frame does not have to include all the fields that you define.
- Some fields can be used to calculate other fields. You can also define fields that will be added to the report frame for later use.

The following are examples of field contents:

- The minimum value of a tag in the last work shift.
- The total amount of time a tag exceeded a value in the past week.
- The total number of times a tag was in the ON state in the past month.
- The efficiency of a tag, based on the total amount of time it was in the ON state in the past month.

A list of fields can be viewed in the Field Summary dialog box.
Inserting Field Definitions

Field definitions can only be defined for codes that were entered in proper numerical order. For example, you cannot define a field for the code #00003, if codes #00001 and #00002 were not yet defined in the report.

To define a field:

In the Report Definition dialog box select the field code or double-click on it and activate the Field Def button.

If you do not know the next field number to be defined, or if you want the report utility to determine the next field number, enter a high field number such as #9999, then activate the Field Def button. The utility will prompt you to change the field number you entered with the next ordinal number to be defined.

Or,

Click the Field Def button without first selecting a code in the report. The utility will then enable you to define a field for the next ordinal field number in the report. The Field Definition dialog box is displayed:

The following Field Definition types are available.

**Field No.** Displays the number of the current field.

**Tag** Determines tag values and value calculations.

**Compound** Determines the calculated value of two other fields and/or constants.
**Multiple**
Determines the calculated value based on a group of other fields.

**Time**
Determines that a specific time is included in the report.

**Date**
Determines specific dates in the report.

**String Tag**
Determines predefined tag string values.

**Importing HTML Templates**

You can use any HTML file as a template for a report. The file can be located anywhere on your system and can be created using any standard HTML editor. After importing the file, you can modify it by adding report fields.

**To import an HTML file:**

1. In the Report Definition dialog box click the Import HTML button. A message appears asking if you want to discard changes.
2. Click Yes. The Import HTML File dialog box is displayed.
3. Select the HTML file that you want to use as a template and click Open. The file opens in the Report Definition dialog box.
4. Add the required report fields, and click Save to save the report and exit the Report Definition dialog box.

Note: To produce a report, use the REP.EXE report generator and allocate a file name ending with .HTML.
**Field Definition Types**

The Tag field type is used to calculate tag values according to options that you can select.

► **To activate the Tag field:**

In the Field Definition dialog box click the Tag button. The Tag Field Definition dialog box opens:

The following options are available:

- **Station** Specifies the station to which the tag belongs.
- **Tag** Specifies the tag name.
- **Days/Hours** Specifies the days and hours of the tag records required for calculations in the report.
**Range**

Determines that the dates you use are relative to the reference date (the date displayed on your computer). Since the reference date is usually the current date, 0 represents the reference date, and 1 is the day before the reference date (future dates cannot be used).

**Given at Run Time**

Specifies that the values will be determined by the Application Language REPORT command, or the REP command used to generate reports at the Windows command line.

**Function**

Specifies the function to be performed on the recorded values.

The following options are available:

- **Last value**: Returns the tag value at the end of the specified interval. This value will be the last value recorded in the interval you specified.
- **Minimum**: Returns the lowest value recorded during the specified interval.
- **Maximum**: Returns the highest value recorded during the specified interval.
- **Average**: Returns the arithmetic average of all the values recorded during the interval.
- **Sum**: Returns the sum of all the values recorded during the interval.
- **Integral**: Returns the sum of the products of each recorded value, multiplied by the time until the next recording.
- **Weighted average**: Returns the average value of the tag relative to the time the value occurred in the tag.
- **Total time for range**: Returns the total amount of time that tag values were in the range specified.
- **Count for range**: Returns the number of times that tag values were recorded for a specified range.
- **Time of logging no**: Returns the time of the nth recording, after the beginning of the interval. For example, if you want the hour at which the seventh recording occurred, enter 7.
The following table indicates whether or not the SET (initialization) value of a tag (stored in the history file) is included in report function calculations. A plus (+) means that the value will be included in the calculation, and a minus (−) means that it will not be included.

<table>
<thead>
<tr>
<th>Function</th>
<th>SET Value Included</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last value</td>
<td>+</td>
</tr>
<tr>
<td>Minimum</td>
<td>+</td>
</tr>
<tr>
<td>Maximum</td>
<td>+</td>
</tr>
<tr>
<td>Average</td>
<td>−</td>
</tr>
<tr>
<td>Sum</td>
<td>−</td>
</tr>
<tr>
<td>Integral</td>
<td>+</td>
</tr>
<tr>
<td>Weighted average</td>
<td>+</td>
</tr>
<tr>
<td>Total time for range</td>
<td>+</td>
</tr>
<tr>
<td>Count for range</td>
<td>−</td>
</tr>
<tr>
<td>Time of logging no</td>
<td>−</td>
</tr>
</tbody>
</table>

Value of logging no: Returns the value of the nth recording after the beginning of the interval (for example, if you want the value of the fourth recording, type 4 for this option).

Repetition --- of value --- (Time): Returns the time of a specific occurrence of a specific value. For example, the function can return the hour at which a value of 1.0 was recorded the 2nd time. For Repetition, type a 0 to obtain the last time the value you specified appeared for that period. For example, Repetition 0 of value 100 will return the last time the tag had the value 100.

Current value: Returns the current value of a tag. This function causes the application to force-read a tag when generating the report.
The Integral function returns the sum of a series of products. Each product is the result of multiplying a single log value, by the time elapsed until the next recording.

*Note:* That the integral unit is not necessarily meaningful.

For example, suppose the time interval is from 12:00 to 13:00, and there are three records in the historic file, as follows:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Tag Value</th>
<th>Time of Logging</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANA00</td>
<td>11</td>
<td>12:00</td>
</tr>
<tr>
<td>ANA00</td>
<td>5</td>
<td>12:10</td>
</tr>
<tr>
<td>ANA00</td>
<td>7</td>
<td>12:30</td>
</tr>
</tbody>
</table>

According to the following Integral function calculation:

\[
11 \times 600 + (5 \times 1,200) + (7 \times 1,800) = 25,200
\]

Where:

- \(11 \times 600\) multiplied by 600 ((12:10-12:00) * 60 seconds)
- \(5 \times 1200\) multiplied by 1200 ((12:30-12:10) * 60 seconds)
- \(7 \times 1800\) multiplied by 1800 ((13:00-12:30) * 60 seconds)

The result will be 25,200.
**Weighted Average**

The Weighted Average function returns the average value of the tag, relative to the time that the value occurred.

For example, suppose the time interval is from 12:00 to 13:00, and the following three records are in the historic file:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Tag Value</th>
<th>Time of Logging</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANA00</td>
<td>11</td>
<td>12:00</td>
</tr>
<tr>
<td>ANA00</td>
<td>5</td>
<td>12:10</td>
</tr>
<tr>
<td>ANA00</td>
<td>7</td>
<td>12:30</td>
</tr>
</tbody>
</table>

According to the following weighted average calculation:

\[
rac{25,200}{3,600} = 7
\]

Where:

- 25,200 is the Integral value.
- 3,600 is the total time ((13:00-12:00) * 60 seconds)

The result will be 7.

*Note:* 13:00 to 12:00 equals 1 hour, or 60 minutes

**Total Time for Range**

The Total time for range function returns the total amount of time (including seconds) that the tag received values in the specified range. For example, suppose the time interval is from 12:00 to 13:00, the range is 7 to 11, and the following three records are in the historic file:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Tag Value</th>
<th>Time of Logging</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANA00</td>
<td>11</td>
<td>12:00</td>
</tr>
<tr>
<td>ANA00</td>
<td>5</td>
<td>12:10</td>
</tr>
<tr>
<td>ANA00</td>
<td>7</td>
<td>12:30</td>
</tr>
</tbody>
</table>
According to the following calculation:
10 minutes (12:00 to 12:10) for the value 11.
30 minutes (12:30 to 13:00) for the value 7.
The result will be 00:40:00,

**Current Value**
Returns the current value of a tag. This function causes the application to force-read a tag when generating the report. For example:

- For the last value at the end of a work shift:
  - Days from 0 to 0
  - Hour from 06:00 to 14:00
  - Function Last Value

- For the amount of items produced yesterday:
  - Days from 1 to 1
  - Hour from 00:00 to 23:59
  - Function Sum

- For the minimum temperature during the last shift:
  - Days from 0 to 0
  - Hour from 22:00 to 06:00
  - Function Minimum

- For the maximum fuel consumption during the week that ended three days ago:
  - Days from 9 to 3
  - Hour from 06:00 to 23:59
  - Function Maximum
For the total time the machine operated during the weekend:

Days from 2 to 1
Hour from 00:00 to 23:59
Function Total time for range: 1 to 1

*Note: In this case, a digital tag is used to determine when the machine is active (1), and not active (0).*

For the number of times the machine stopped during the last shift:

Days from 0 to 0
Hour from 06:00 to 14:00
Function Count for range: 0 to 0

*Note: In this case, a digital tag is used to determine when the machine is active (1), and not active (0).*

For the time that a boiling temperature value was detected for the tenth time:

Days from 1 to 1
Hour from 00:00 to 23:59
Function Rep 10 of value 100

**Compound Field Type**

A compound field is a value that is calculated based on the values of two other fields and/or constants specified.

► **To activate the compound field:**

In the Field Definition dialog box click the Compound button. The Compound Field definition dialog box is displayed:
The following examples help to explain the use and functionality of the Compound field. Note that the calculation is performed from left to right.

**For the total time to produce all the items, fill in the dialog box as follows:**

Where:

Field 2 is a tag field containing the average time to produce one item.

Field 3 is a tag field containing the total amount of items produced.

**For the area of a circle, fill in the dialog box as follows:**

Where:

Field 4 is a tag field containing the radius of the circle.

Constant 3.1416 is the pie factor.

*Note: Compound fields can be nested. The code numbers of the fields included in the compound formula must be codes of fields that were defined in the report.*
Multiple Field Types

Multiple field types are value calculations based on a group of other existing fields.

To activate the compound field:

In the Field Definition dialog box click the Multiple button. The Multiple Field Definition dialog box is displayed:

The following fields are available:

- **From/To**
  Specifies the field numbers that you want to include in the calculation. Click in the field to view the available fields.

- **Increment**
  Determines the fields you want to include in the calculation. Enter 1 to receive the values of all of the fields, in the range you specified. However if, for example, you have a matrix of three columns (9 fields) and you want only fields 2, 5, and 8 to be included in the calculation, you would specify From 2, To 8, and Increment 3, which would cause field number 2 to be included, the field in the next column to the immediate right (5), and the next (8).
**Function**

Specifies the function to be performed on the recorded values. The following options are available:

- **Minimum**: Returns the lowest value in the group of fields.
- **Maximum**: Returns the highest value in the group of fields.
- **Average**: Returns the arithmetic average of the values of all the fields in the group.
- **Sum**: Returns the sum of the values of all the fields in the group.

**Examples**

Following are some examples of when and how to use a multiple field type.

To receive a calculation of total production for the whole month, enter:

**From**: 4
**To**: 124
**Increment**: 4

**Function**: Sum

This example is valid assuming that you defined a 4x30 matrix of fields in which the fourth column is the total production for each day of the month. A value of 4 for Increment means that only the values of the fields in the fourth column of the matrix will be included in the sum.

Suppose a plant includes two machines for which three work shifts are organized. In addition to obtaining information about each machine and shift, you would like to obtain totals of each. You can define Multiple fields to store the total information, as follows:

<table>
<thead>
<tr>
<th></th>
<th>Machine 1</th>
<th>Machine 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift 1</td>
<td>#00001</td>
<td>#00004</td>
<td>#00009</td>
</tr>
<tr>
<td>Shift 2</td>
<td>#00002</td>
<td>#00005</td>
<td>#00010</td>
</tr>
<tr>
<td>Shift 3</td>
<td>#00003</td>
<td>#00006</td>
<td>#00011</td>
</tr>
<tr>
<td>Total</td>
<td>#00007</td>
<td>#00008</td>
<td></td>
</tr>
</tbody>
</table>

Field Definition Types  31-19
In this table, the multiple fields are fields 7 to 11. The definition for these fields would be as follows:

- Field range # 7 is defined from 1 to 3, increment 1
- Field range # 8 is defined from 4 to 63, Increment 1
- Field range # 9 is defined from 1 to 4, Increment 3
- Field range # 10 is defined from 2 to 5, Increment 3
- Field range # 11 is defined from 3 to 6, Increment 3

**Time Field Type**

The Time field type is used to include specific times in your report. Time fields are relative to the reference time.

> **To activate the Time field:**

In the Field Definition dialog box click the Time button. The Time Field Definition dialog box is displayed:

![Time Field Definition Dialog Box](image)

Specify the time, in hours and minutes, which is to be subtracted from the reference time to get the time value which will appear in the field.

*Note: The reference time will be the time the report was generated from (current), unless otherwise specified in the command that activates the report.*
**Date Field Type**

The Date field type is used to include specific dates in your report. All dates are relative to the reference date.

► **To activate the Date field:**

In the Field Definition dialog box click the Date button. The Date Field Definition dialog box is displayed:

![Date Field Definition](image)

Specify the amount of days to be subtracted from the reference date in order to obtain the date value that is to appear in the field.

*Note: The reference time will be the time the report was generated (current), unless otherwise specified in the command that activates the report.*

**String Tag Field Type**

The String Tag field enables predefined tag string values to appear in the report.

*Note: To use this field type, the tag associated with this field must have been defined in the Tag Definition procedure as a String Tag. For further reference read the Tags chapter.*

► **To activate the String Tag field:**

In the Field Definition dialog box click the String Tag button. The String Tag Field Definition dialog box is displayed:
The following options are available:

**Station**
- Specifies the station to which the tag belongs.

**Tag**
- Specifies the name of the string tag with which the field will be associated.

**Value Event**
- Specifies the period of time from which the values of the string tag will be analyzed. The following options are available:
  - **From:** Specifies the beginning of the period
  - **To:** Specifies the end of the period.

**Indicator**
- Defines the date and time for the beginning and end of the period for which the tag values will be analyzed. Click inside the field to display the following options:
  - **Absolute:** The exact time that you specify. For example, if you specified the date 08-05-99, and the time 15:00:00, the value will be recorded at 3 PM on August 5, 1997.
**Indicator**

**Relative:** The time and date that you specify will be relative to the current time and date. For example, for time 10:00:00 and date 3, the value will be recorded at 3 days and 10 hours ago.

**Relative Date:** This means that only the date that you specify will be relative to the current date (the time will remain absolute). For example, for time 10:00:00 and date 3, the value will be recorded at 3 days ago, 10 AM.

**Last Value:** Displays the last value of the string tag from the period of time specified.

**Current Value:** Displays the current value of the string tag. This is its value at runtime irrespective of the period of time specified for the field.

---

**Field Summary**

The Field Summary is a User-Defined Report utility that enables you to obtain a complete list of all the defined fields in your report. The list of fields is displayed in a dialog box that can also be used to add, change, and delete field definitions online.

**To open the Field Summary:**

In the Report Definition dialog box click the Summary button. The Field Summary dialog box is displayed:
The following options are available:

**Field No.** Contains the current ordinal number of the field that you want to add, modify, or delete.

**Type** Displays the tag type buttons which, when activated, display the relevant tag type dialog box.

**List** Generates a list of report fields.

**Use** Report lists can be used for replacing or appending current field definitions.

**To delete a field from the list:**
Select the field you want to delete from the list and click the Delete button.

*Note: Do not delete any fields appearing in the report currently displayed in the Report Definition dialog box. If you do, you will be unable to generate the report properly.*

**To change a field definition:**
1. Select the field you want to change from the list and click the relevant field type button. The Field Type dialog box is displayed.
2. Modify the Field Definition and click the Change button.
To add a new field to the report:

1. In the Field No. field, enter a new field number and click the relevant field type button. The Tag Type dialog box is displayed.
2. Define the tag type and then click the Add button. The new field is displayed in the list.
3. Click the Save button to save your definitions and to close the dialog box.

Saving Reports

After defining frames, fields and field codes, save your definitions.

To save report definitions:

Activate the Save button in the Report Definition dialog box. The report is saved in two parts as follows:
- *.rpt which contains the report frame.
- *.rpd which contains the field data.

If you entered a field in the report frame, but did not define that field, when you activate the Save button, an error message appears and a file called REPxxxxx.MIS is generated (where xxxxx is the name of the report you are saving). This file contains the numbers of all the fields that were not defined, and can be viewed using any text editor.

You can save your definitions in a file with a name that you specify. The field definitions can then be used for other report definitions.

To name the report definitions file:

Click the Save As button. A dialog box appears in which you specify the name of the file. The field definitions that you save can then be used for other report definitions.
**Generating a List of Report Fields**

Report lists can be generated and then edited using any text editor.

► **To generate a list of report fields:**

Click the List button in the Field Summary dialog box to open the Fields List dialog box.

![Fields List dialog box](image)

In the From/To fields type in the list file name for the required target file. The default suffix .RLS will be automatically attached to the file name you specified.

The output of the list is a text file, which includes all the fields requested in the field range (each line describes a field). The format of the list lines is fixed, that is the position of each item in a line is important and should not be changed. Each line that begins with a semi-colon is treated as a comment line and will be ignored when the file is used.

**Using a List**

Report lists can be used for replacing or appending current field definitions.

► **To replace or append the current field definitions:**

1. Click the Use button in the Report Summary dialog box.

2. From the Use List File listbox select an RLS file and click the Replace button or the Append button. (Replace and Append follow the same behavior as Adding a field). The Use List dialog box is displayed:
List File Editing Recommendations

When editing the list file with a text editor remember the following:

1. The columns for each line (field definition) are static and their location should not be changed. The recommended way to use the list is to generate a list and then edit it (as opposed to creating the file fresh from the start).

2. The field numbers in the list are fixed, that means they represent real field numbers and will be entered in the listbox as such. For example, if you define in the list fields 1 followed by field 5, the fields will be entered and treated as field numbers 1 and 5. The only limitation for field numbers is that they must be in increasing order.

3. If an error exists in the .RLS file (incorrect syntax), when a file is being loaded a message specifying the line and column in which the error occurred is issued. An error is either a missing or incorrect item, which prevents a field from being defined properly.

4. If the tags you specified in the list are not defined in your application, the field is treated as a legal field and no message is issued.
**Generating Reports**

After the report is defined and saved, it can be generated in two ways:

- By a command at the command line
- By command in Application Language

**Command Line Report Generation**

After the report is defined and saved, it can be generated by typing the REP command at the command line, as follows:

```
REP repname rd rt st et of sd ed
```

Where:

- RD sets the reference date, used by Date type fields. 0 is the current day, 7 is the previous week.
- RT is the reference time, used by Time type fields. This is the number of minutes that elapsed since midnight, between 0 and 1439. Thus, 8 AM would be 480.
- ST and ET are Start Time and End Time, and are only for the time in Tag type fields for which you selected the Given at Run Time option. Specify the number of minutes that elapsed since midnight.
- OF is for Output File. Specify the filename or device to which the report will be sent.
- SD and ED stand for Start Date and End Date respectively, and are used with Tag type fields for which you selected the Given at Run Time option. These parameters are optional.
- The RD, RT, ST and ET parameters are optional. In order to leave them empty, type an X at their location in the REP command.
Application Language Report Generation

In addition to using the REP command at the command line, reports can be generated by Application Language as follows:

**Short Format:**

```plaintext
REPORT "xxxxx"
```

where `xxxxx` is a report name of up to five characters.

Tag names can be included in the REPORT command as variables. This can be useful to generate a series of reports with a single command. For example, if you want to generate ten reports, REP0 to REP9, you would define a dummy tag called repno, and write the following command sequence:

```plaintext
IF @repno > 0
  THEN@repno = @repno - 1;
REPORT "REP" @repno
```

**Full Format:**

The full format of the REPORT command, with optional report variables, is:

```plaintext
REPORT "xxxxx rd rt st et of sd ed"
```

Where the parameters are as defined above.

**Examples**

The following are examples using the REP command:

Example 1:

```plaintext
REPORT "REP4 2 360 0 360 LPT2"
```

This command would create a report in a format defined as REP4, with a reference date of two days before, a reference time of 6 AM, midnight as the default start time for tag fields, 6 AM as the default end time, and the report would be output to printer 2.
Example 2:
If you want to leave optional variables empty, type an x at their location in the REPORT command. The application will use the default value 0 for all the variables except OF (Output File), for which the default is LPT1. If you want the report to be sent to the printer, do not type anything (typing x would cause the report to be sent to a file called x).

For example, the command

\[
\text{REPORT "REP1 } x \ x \ x \ x \ \text{REP1.LST"}
\]

would generate a report in the format defined as REP1 and output that report to a file called REP1.LST.
Chapter 32 Macros

Note: Not enabled on the web.

About this chapter:

This chapter describes the use of macros in the system as follows:

Overview on page 32-2 is an overview of application macros.

Basic Concepts on page 32-3 describes basic concepts of macros.

Macro Definition on page 32-4 describes how to define action macros and special action macros, shell command macros, sequence macros, and DDE command macros.

Modifying Macros on page 32-13 describes how to edit macro definitions.
Overview

Macros are shortcuts that can be used to execute pre-defined actions, commands, or sequences, whenever designated keys or key combinations are activated. This enhances overall application functionality, and saves you the time and effort of having to execute operations in several stages.

You can define up to 3072 application macros.

Application macros are defined by the following attributes:

- Accelerator keys that invoke the macros (F1 to F12, A to Z, ALT alone, or in combination with Ctrl, Shift, and others).
- A unique name and description.
- Authorization groups.
- Confirm before Execute option.

Application macros include the following types:

- Actions
- Commands
- Sequence
- DDE Command Macros
- Trigger Macros (described in the Triggers on page 19-16 of the Image Editor).

It is important to remember that macros will only be executed:

- If an application window, including the Application Studio, or the Single Tag Input dialog box is the active window. If any other window is active the macro will not be executed.
- When the application is used locally (for example, if a trigger macros is invoked through a web browser) it will not be executed.

Note: *Macro names cannot contain the following character ‘*(single quotation mark)*
Basic Concepts

The following section describes a definition of a macro file.

Macro File

In the application, all saved macros are written to a special file called wizmacro.dat. This is an ASCII file that you can edit.

In the wizmacro.dat file, the title line in the file must always be the current version number and each macro included in the file must have the following lines:

- The first line for each macro includes the following data:
  - Macro number
  - Type (A for Action, P for , C for Command)
  - Name
  - Accelerator keys
  - Confirmation (Y for yes, N for no)
  - Authorization.

- The next line is the description of the macro.
  - The last line includes specific macro data.
  - Action macros - name and parameters;
  - Commands - the shell command
  - Sequence - the macros included in the Sequence (separated by commas).
**Macro Definition**

You can define Action, Command and Sequence macros from the Macro Definition dialog box.

► **To define macros:**

In the Control Panel of the Application Studio, double-click the Macro icon.

Or,

From the Design menu in the Application Studio, select Macros. The Macro Definition dialog box is displayed:

The following options are available:

- **Name**
  Specifies the name of the macro (255 characters maximum).

- **Description**
  Specifies a brief description of the macro (255 characters maximum). This field does not have to be filled.
<table>
<thead>
<tr>
<th>Type</th>
<th>Specifies the type of macro that can be defined in this dialog box. Activate one of the following buttons to define a specific macro:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td>Single application operations.</td>
</tr>
<tr>
<td>Command</td>
<td>Shell commands.</td>
</tr>
<tr>
<td>DDE Command</td>
<td>Execute commands in other DDE-compatible applications.</td>
</tr>
<tr>
<td>Sequence</td>
<td>Any number of macros that act as one macro.</td>
</tr>
<tr>
<td>Accelerator keys</td>
<td>This specifies the keyboard combinations used to activate the macro. For example; Alt F2. Do not use standard Windows accelerator keys such as Ctrl S, Ctrl P, or F1, and F3 since they are intended for other purposes.</td>
</tr>
</tbody>
</table>

| Group                 | Used to assign groups to macro authorization                                                                                  |
| Confirm Before Execute| Enables the application to prompt you to confirm the execution of a macro before it is executed.                             |
| Add                   | This button when clicked adds the new macro definitions to the Macro List.                                                      |
| Change                | If you have updated a macro in the list click this button and then the Add button.                                              |
| Delete                | Click this button to delete a macro from the list.                                                                               |
| Save                  | Click this button to perform a global save on all the macros in the list.                                                       |
Defining Action Macros

Defining action macros includes defining the action macro, as described below, and defining special action parameters, as described on the following page.

Defining action macros is performed from the Macro Definition dialog box.

To define an Action macro:

From the Macro Definition dialog box click the Action button. The Action dialog box is displayed:

![Action dialog box]

The following options are available:

- **Name**: Specifies the macro name of an existing macro.
- **Actions**: Specifies the action to be invoked by this macro. To view a list of predefined actions, click the arrow to the right of the field.
- **Parameters**: Specifies parameter information, as described on the following page.

To define special action parameters:

Click the Parameters button. The Action Parameters dialog box is displayed:

![Action Parameters dialog box]
The fields in this dialog box are different for each action you select. In the dialog box shown above, the LoadWindow action features the following fields:

<table>
<thead>
<tr>
<th><strong>Window</strong></th>
<th><strong>Type</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the arrow to the right of the field and select a window layout.</td>
<td>Select one of the following to specify the window type.</td>
</tr>
<tr>
<td><strong>Ann</strong>: Events Summary</td>
<td><strong>Img</strong>: Image</td>
</tr>
<tr>
<td><strong>Chr</strong>: Chart</td>
<td><strong>Anl</strong>: History Viewer</td>
</tr>
</tbody>
</table>

**Actions**

This section describes the actions available in the Actions field of the Action dialog box.

<table>
<thead>
<tr>
<th><strong>Action</strong></th>
<th><strong>Parameters</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LoadLayout</strong></td>
<td>Layout</td>
<td>Loads the specified layout. If no such layout appears on the screen or is already loaded, no operation is executed.</td>
</tr>
<tr>
<td><strong>LoadImage</strong></td>
<td>Window, Image, Zone</td>
<td>Loads the specified image and zone. If you did not specify a zone, or if no such zone is defined for that image, the image will be loaded in the zone it was in when it was last saved. If the image or window you specified does not exist, no operation will be executed.</td>
</tr>
<tr>
<td><strong>GoToZone</strong></td>
<td>Window, Zone</td>
<td>Moves the image in the specified window to the specified zone. If there is no such zone or window, no operation will be executed.</td>
</tr>
<tr>
<td><strong>LoadRecipe</strong></td>
<td>Recipe</td>
<td>Loads the specified recipe. Enter the full recipe name, prefix and extension in the Recipe field. If no such recipe exists, no operation will be executed.</td>
</tr>
<tr>
<td>Action</td>
<td>Parameters</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SaveRecipe</td>
<td>Recipe, Description</td>
<td>Updates the tag values in the recipe to the values that the application reads from the PLCs.</td>
</tr>
<tr>
<td>TagAssignment</td>
<td>Tag, Expression</td>
<td>Applies the results of the specified expression to the specified tag. The macro writes the nearest value, upper/lower, to the tag. If the calculated value is out of range, then the nearest limit is written to the tag. In the Expression field use the following formats: Operand Operator Operand or Operand. Where Operand is any constant value, @tagname, or @ for the tag you specified in the Tag field. Operator can be *, /, +, -, or % (mod). In the Tag field, select a tag from the list of existing tags by clicking on the arrow to the right of the field.</td>
</tr>
<tr>
<td>PlaySound</td>
<td></td>
<td>Enables playing a .WAV file asynchronously. Click the Parameters button to open the Action Parameters dialog box and then type in the full file name and path, or click the Browse button to locate this file. Note: The full name and path must be entered.</td>
</tr>
<tr>
<td>User Login</td>
<td></td>
<td>Allows the user to define a macro which will cause the login dialog box to open. The application opens the dialog box and applies the user's actions exactly the same way it does whenever the dialog box is opened from the Quick Access Bar. The common macro running conditions and restrictions are applied to the discussed macro. This macro does not have any parameter.</td>
</tr>
<tr>
<td>Action</td>
<td>Parameters</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SelectLanguage</td>
<td></td>
<td>Allows the user to select a language. The macro opens the same dialog box that is opened from the Studio. This macro does not have any parameter.</td>
</tr>
<tr>
<td>PrintChart</td>
<td></td>
<td>Enables the printing of predefined Chart Windows. The parameter is a Chart Window name. The chart will be printed without being displayed on the screen. Note that only historical charts can be printed if they are not displayed. An error message will be issued (error code 621) if attempting to print in-line chart using this macro and the chart is not loaded.</td>
</tr>
<tr>
<td>DirectLogin</td>
<td>User Name and Password</td>
<td>Allows the user to define a macro that will enable direct login, without opening the Login User's dialog.</td>
</tr>
<tr>
<td>ExitApplication</td>
<td></td>
<td>Allows the user to define a macro that will enable the user to exit an application easily. This macro does not have any parameters.</td>
</tr>
<tr>
<td>ZoneNavigator</td>
<td></td>
<td>Allows efficient navigation through a list of zones defined in the application's various image files.</td>
</tr>
</tbody>
</table>
Defining Command Macros

Defining command macros is performed from the Macro Definition dialog box.

To define a Shell command macro:

In the Macro Definition dialog box click the Command button. The Shell Command dialog box is displayed:

![Shell Command Dialog Box]

The following options are available:

**Name**
- Specifies the macro name specified in the Macro Definition dialog box.

**Shell Command Line**
- Specifies the shell command that is to be executed whenever this macro is invoked. The application executes this command using the standard Windows Start command. You can use any of the Start parameters. For more about the Start command, refer to the Windows Help.
Defining Sequence Macros

Sequence macros are macros that are composed of several other existing macros. You can define Sequence macros when one or more macros of any type, already exist.

To define Sequence macros:

In the Macro Definition dialog box click the Sequence button. The Sequence dialog box is displayed:

The following options are available:

Name
Specifies the macro name that you specified in the Macro Definition dialog box.

Macro List
Specifies the macro that will be included in the sequence. Click on the arrow to the right of the field to display a list of macros.

Sequence List
Specifies the list of macros that you selected to be included in the sequence.

1. To add a macro to the list, click the Add button after specifying your definitions.
2. To add a macro to the list before the currently selected macro, click the Insert button.
3. Clicking OK saves your definitions and closes this dialog box and opens the Macro Definitions dialog box.
Defining the DDE Command Macro

Using the Application DDE Support Command macro you can create a macro that enables you to execute commands from any application that supports the Command part of the DDE protocol. Usually, these applications include a predefined set of supported commands, which are listed in the applications' documentation.

To define DDE Commands:

In the Macro Definition dialog box click the DDE Command button. The DDE Command dialog box is displayed.

The following options are available:

Name  Specifies the macro name that you specified in the Macro Definition dialog box.

Application  Specifies the name of the DDE-compatible application in which you want to execute the command.

Topic  Specifies the name of the topic on the server. The server's documentation must specify what the topic should be for its supported DDE commands.

Command  Specifies the command string that you want to execute. Make sure that the application recognizes the syntax of the command. You can also include command tokens and receive their current values when you execute the commands. For example, the current value of the $time token can be 1:00pm. The command tokens are similar to the alarm tokens which are listed in the Alarms chapter.
**Modifying Macros**

You can modify Action, Command, Sequence macros from the Macro Definition dialog box.

▶ **To modify macros:**

From the Design menu in the Application Studio, select Macros. The Macro Definition dialog box is displayed with a list of the defined macros.

Select the macro you want to modify, make the changes you require and click the Change button.
Chapter 33 Network Application Update

About this chapter:

This chapter describes the Network Application Update module.

Overview on page 33-2 discusses the basic options of this module.

Remote Update Settings Dialog Box on page 33-3 discusses the various fields of this module.

Adding Stations on page 33-5 teaches you how to add a station to the Stations List.
Overview

The Network Application Update module enables an application developer to quickly and easily update far station application files remotely. To the station operator this action is invisible. However a record of the update will appear in the station's Errors Log File file.

An unlimited number of network stations using the application can be defined in the Remote Update Settings dialog box. This dialog box, by default, holds all the files within the application.

To update a station's application files, the developer after modifying an application file opens the Remote Application Update module and maps between the updated file and the station. After the Update button is clicked and OK is pressed the new file data is transferred to the selected remote station.

Note: The Zone Navigator cannot be updated in the Network Application Update module.
Remote Update Settings Dialog Box

This dialog box is used to match between application files and remote stations.

To access the Remote Update Settings dialog box do the following:

In the Application Studio double click the Remote Update Settings icon. The Remote Update Settings dialog box opens.

This dialog box has the following fields:

Select Application

Files to Update

Apply Selected Configuration to all Stations

Station List

This field holds a tree of all the files appearing in the application.

This field when checked indicates that the selected configuration will be saved to all network stations.

This field lists the stations defined by the developer.
Note: If the .vim file is not in the same folder as the .img file then the Image will be corrupted. To solve this problem move the .vim and .img files into the same directory. This module does not support the Zone Navigator module.

1. Select the updated file from the Select Application Files to Update field.

2. From the Station List select the relevant station. A tick will appear in the checkbox opposite each selected station.

3. To add the new data to all stations in the application check the Apply Selected Configuration to all Stations checkbox.

4. Click the Select All/Unselect All buttons if this applies.

5. Click Update or Update All to transfer the new data to all selected stations. An update process bar will appear under the application files tree.

6. Click OK to actually save.
Adding Stations

An unlimited number of network stations can be added to the Stations List. When a station is selected a tick appears in the checkbox opposite it.

► To add a station do the following:

1. Click the Add Station button to open the Add Station dialog box.

![Add Station dialog box]

2. Type in the name of the station.

3. Click OK. The station name is added to the Stations List.
Chapter 34 Enterprise Server Connection

About this chapter:

This chapter describes the Enterprise Server Connection module.

Enterprise Server Connection - Overview on page 34-2 discusses the basic options of this module.

Enterprise Server on page 34-2 gives a short description of this unique server.

Requirements on page 34-3 lists the equipment required to use this module.

Setup on page 34-3 discusses how to setup this module.

Connecting between Tags, Alarms & Enterprise Server Connection on page 34-4 teaches you how to use this module.
Enterprise Server Connection - Overview

The Enterprise Server Connection is a modular embedded application server that provides data acquisition, local decision-making and a web user interface for devices and systems.

The Enterprise Server Connection includes all functionality and XML processing required for two-way Firewall Friendly communication with the Enterprise Server. Connection data and alarms flow easily to the Server through the Internet without local user or IT administration.

Connection to the device can be made through the system's VPI drivers library, be developed using the OPC Toolkit, or through the Connection's APIs.

When installed on a platform that supports file changes, the Enterprise Server Connection can receive product and application updates remotely from the Server. The Enterprise Server Connection is designed to enable upgrade of product files while the system is running thereby minimizing downtime.

This module is currently available for Microsoft Windows NT, Windows NT Embedded and Windows 2000; Microsoft Windows CE for x86, SH3, SH4, ARM and MIPS processors; Linux; and NetSilicon ThreadX 3.0.

Enterprise Server

The Enterprise Server directs information to your application and your business systems, providing a secure, fault-tolerant infrastructure for communicating and managing the information exchange between remote devices and businesses.

An Enterprise Server can receive data from multiple Connections (where each Connection sits on a different application serving different devices) and save this data into one database. Additionally, the Server serves as a main manager station for multiple application stations that have the Connection installed.

Requiring minimal configuration and setup the Enterprise Server provides a fast and secured means of connection and data transfer.
Requirements

- Functional Enterprise Server (already containing a license ID).
- Enterprise Server Connection license string (which you receive together with the software).

Setup

To create a link between the Enterprise Server Connection and Enterprise Server do the following:

1. In the Application Studio double click the Enterprise Server Connection icon to open the Enterprise Server Connection Configurator dialog box.
2. Click the Server Setup button. The Server Setup dialog box opens.

![Server Setup Dialog Box]

This dialog box has the following fields:
- Enterprise Server Address
- Connection License String
- Enterprise Server Owner
- Device Model
- Device Serial Number
3. Type in the correct data in each field. Setup will only be complete if all fields are correctly filled. If the correct data is not entered in this dialog box the server will fail to connect. This can only be checked during actual connection.

4. Click OK to confirm and to return to the Enterprise Server Connection Configuration dialog box.

5. To complete setup at least one group holding Connection Tags should be created. See creating new groups on page 34-6 for further instructions.

6. Restart the application. The Enterprise Server Connection will now automatically connect you to the Enterprise Server.

**Connecting between Tags, Alarms & Enterprise Server Connection**

The Enterprise Server Connection compiles groups of application tags and sends them to an Enterprise Server as Connection Tags.

Connection Tag groups are defined in the Enterprise Server Connection Configurator dialog box. Connection Tags have no affect on application tags.

The Enterprise Server Connection is launched automatically after setup is complete.

► To access the Enterprise Server Connection module, do the following:

In the application's Quick Access bar click the Enterprise Server Connection icon.

Or,

In the Application Studio click the Enterprise Server Connection icon. The Enterprise Server Connection Configurator dialog box opens.
This dialog box has the following fields and buttons:

**Alarm Configuration**
- **Enable Alarm Connection**: When this checkbox is checked, alarms that are in Start/Ack/Ended status will be transferred.
- **Add**: Which when clicked opens the Edit Group dialog box where a new group containing application tags can be defined.
- **Modify**: This button is clicked only after a group has been selected. The Edit Groups dialog box will open where the group's definitions can be modified.
- **Delete**: This button when clicked removes a selected group from the Enterprise Server Connection Configurator List.
- **Server Setup**: When this button is clicked the Server Setup dialog box opens.
Creating new groups

1. Click the Add button to open Edit Group dialog box.

This dialog box holds the following fields:

**Group Settings**

- **Name** Which is the name of the group.
- **Update On** Which defines how the tag is sent to the Server. There are two options:
  - **Change** Indicating that each time the tag is updated it will be sent to the Server.
  - **Interval** Indicating that at a specific interval the Connector sends the tag to the Server.
- **Interval (Sec)** That is only available when Interval is selected. This defines the specific time interval that the Connection sends the Connection Tags to the Connection Enterprise Server.

**Application Tags**

Which holds a list of all the tags in the application. These tags can be selected and added to groups.

**Add Tags to Server**

This button when clicked adds selected application tags to the Connection Tags list.
In the Group field type in the group's name.

3. In the Update On field select whether changes to this tag are sent to the Enterprise Server per Change or per Interval. If per interval then in the Interval (Sec) field type in the relevant timing.

4. In the Application Tags list select the relevant tags and then click the Add Tags to Server button. The application tags will be added to the Connection Tags list.

5. To remove tags, select the relevant tag from the Connection Tag list and then click the Remove Tags from Server button.

6. Click OK to return to the Connection Configuration dialog box.

Note: After changes are made to the XML file restart this module.

Modifying a group

1. In the Enterprise Server Connection Configurator dialog box select a group and then click the Modify button. The Edit Group dialog box opens.
2. The Group Settings Name field cannot be updated when modifying a group. Follow the instructions for Creating new Groups on page 6.

3. Click OK to confirm and to return to the Enterprise Server Connection Configurator dialog box.

**Modifying a Connection Tag’s alias**

This dialog box enables you to give the Connection Tag a different name. The name of the original tag name remains the same.

1. In the Connection Tags list double click on the relevant tag to open the Edit Item dialog box.

   ![Edit Group Dialog Box]

2. The Name field cannot be changed. In the Alias field type in the new Connection Tag name and click OK to confirm and to return to the Edit Group dialog box.
Chapter 35 Axeda Systems Remote Module

About this chapter:

This chapter describes the Axeda Systems Remote module.

Overview on page 35-2 discusses the basic options of this module.

Architecture on page 35-3 is a diagram of this module and how it works.

Requirements on page 35-4 lists the H/W, S/W and system requirements necessary for the Axeda Systems Remote module.

Workflow on page 35-5 displays a diagram of how a shared session is held.

Users Station on page 35-6 discusses how the User station operator requests a session and how the connection is made between the Viewer and the User stations.

Viewers Station on page 35-9 discusses how the Viewer station receives a request for a session and how the connection is made between the User and the Viewer stations.

Server on page 35-16 is a short overview of this feature.
Overview

The Axeda Systems Remote module, an integral part of the system's package, enables shared access between this application's User (operator) computer and a Viewer (System Integrator, Technical Support) computer. A User's computer that has Axeda Remote is hidden behind a firewall and cannot be addressed directly. Since access to the User's computer is by password and shared Session IDs only, and any information sent over the Internet is encrypted, this module provides a safe solution for remote technical support and other control situations.

This module has three levels:

- **Users Station** whose operator sends a request for a shared session
- **Viewers Station** whose user (Technical Support) receives the request and then requests a session ID from the Enterprise Server through an Internet browser
- **Enterprise Server** which creates the shared session

Once the User's station is accessed, the Viewer station shares its desktop and has access to both this application and other programs on the User's computer.
Architecture

- Server
- Internet
- Firewall
- LAN Proxy Server
- Viewer Station
- Remote User Stations
- Remote User Stations
Requirements

The following are required to run this module:

Hardware
- Computer running Windows 2000, NT, or 9x operating system
- Network connection to the application's Enterprise Server. (This connection can be through a LAN, modem, ISDN etc)

Software
- Axeda Systems Remote (aremote.exe)
- Internet Explorer (version 5.5 or greater) for requesting a session ID from the Enterprise Server

System Requirements
- 300 KB disk space
- 32 MB RAM
**Workflow**

**User Station**

- For first time access, enters station’s password in the Properties dialog box. Requests a shared session.

- Receives session ID. Types session ID into Shared Session ID dialog box.

- Viewer Station operator gains access to User station.

- User station stops/ends Viewer station access.

**Viewer Station**

- Receives User’s request (and password). The password gives this station access permission to User Station.

- Opens Internet browser and requests a session ID. Sends session ID to User station operator.

- Enters same session ID to Viewer station.

- Receives notification that session has ended/been stopped.
**Users Station**

The Axeda Systems Remote module must be installed on a computer that is shared with the Axeda Systems Remote Viewers. The computer must have a connection to the Internet to use the module's Server, which is required for computer sharing. The Internet connection can be permanent or dial-up. It can also share to other computers on the LAN.

**Configuring Properties**

The User Properties dialog box defines the User station's password, type of Internet connection and amount of access to the user's desktop.

- **To access the User Properties dialog box do the following:**

  In the application's Quick Access bar click the Axeda Systems Remote icon.

  Or,

  In the Application Studio click the Axeda Systems Remote icon. The User Properties dialog box opens.
This dialog box has the following fields:

<table>
<thead>
<tr>
<th>Incoming Connections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Password</strong></td>
<td>identifies the password that the Viewer station needs to access the User station's computer. Passwords are case sensitive and do not expire. A password is required to run the shared session.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Accept Direct LAN</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connections</strong></td>
<td>when checked the module accepts a Viewer station selection directly through the network. This only works when the Viewer can address the module directly.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Axeda Enterprise Connections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host</strong></td>
<td>identifies the IP address or fully qualified domain name of the Enterprise Server.</td>
</tr>
<tr>
<td><strong>User HTTP Proxy</strong></td>
<td>if checked, the module connects to a specified HTTP proxy server, which in turn connects to the portal server. The application's server cannot be accessed directly and the proxy server name address must be entered.</td>
</tr>
<tr>
<td><strong>Proxy Host</strong></td>
<td>identifies the IP address of the HTTP proxy server.</td>
</tr>
<tr>
<td><strong>Proxy Port</strong></td>
<td>identifies the proxy server's HTTP port.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Update Handling</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Poll full Screen</strong></td>
<td>when checked the module polls only the window under the mouse cursor for changes and then posts this information</td>
</tr>
<tr>
<td><strong>Poll Foreground Window</strong></td>
<td>when checked module polls the foreground window only for changes and posts the information.</td>
</tr>
<tr>
<td><strong>Poll Window Under Curser</strong></td>
<td>when checked the module polls only the window under the mouse cursor for changes and then posts the information.</td>
</tr>
</tbody>
</table>
Axeda Systems Remote Session

After the User Properties dialog box has been configured and saved the module's icon will be displayed on your task bar.

Note: Make sure that you have the session ID from the Viewer station before starting the shared session. (Both the User and Viewer stations need to be configured with the same session ID).

To request a shared session do the following:

1. Right click the icon in the task bar and select Share Desktop. The Shared Session dialog box will open on your screen.

2. Type the shared session ID (provided by the Viewer station operator) and then click OK.

Poll Console Windows Only - when checked the module polls only open console windows for changes and posts the information.

Poll on Event Received Only - when checked the module polls the screen for changes only when it receives a mouse or keyboard event from the Viewer station and then posts the information.

Input (Applies to next Session)

This section has the following fields:

Disable Remote Keyboard and Pointer - when checked the Viewer station cannot perform any operations in the remote station. The Viewer is limited to viewing the desktop only.

Disable Local Keyboard and Pointer - when checked a local operator on the module computer cannot perform any operation on the computer. The server access is limited to viewing the desktop.
Note: The session ID is case sensitive and must be entered within one minute.

To stop a shared session do the following:

1. Right click the icon in the task bar and click Stop Sharing and then click Yes to stop the session and No to continue with it.

To exit the shared session do the following:

1. Right click the icon in the task bar to open the dropdown list.
2. Click Exit to close the exit the module.

**Viewers Station**

The Viewers station operator can access a User station remotely. This is mainly done for technical support or general application maintenance procedures. In general the Viewer station will receive a request from the User station for technical support before accessing it.

Before viewing a User (operator's) station you must have the following:

- Session ID from the Enterprise Server. (Both the User and Viewer stations need to be configured with the same Session ID)
- User (operator's) password

**Configuring the Enterprise Viewer Connection**

There are several configuration options that can be defined for shared sessions. The Viewer station can be configured before connections are made or while making a connection with a User (operator) computer.
To access the Enterprise Viewer Connection dialog box do the following:

1. Start the aviewer.exe. The Viewer Connection dialog box opens.

2. In the Server field type in the Enterprise Server address.

3. Click OK to save this information.

To define Enterprise Viewer Connection Options do the following:

1. In the Enterprise Viewer Connections dialog box click the Options button. The following dialog box opens.

   ![Enterprise Viewer Connections Dialog Box]

2. Check the relevant checkboxes and click OK to confirm.
This dialog box has the following fields:

**Display**  
This section has the following fields:

- **Restrict pixels to 8-bit (for slow networks)** If selected screen image transfers are restricted to 8 bit pixels.
- **View only (input ignored)** If selected the Viewer operator’s capabilities are limited to view only.
- **Full-screen mode** If selected the server desktop appears in full screen mode by default.
- **Scale by** If selected the Viewer shows the server’s desktop scaled proportionately to the values defined. Default is 1:1, no scaling.

**Connection Type**  
This section has the following fields:

- **Connect through Enterprise Server** If selected the User and Viewer stations connect through a shared session in the Enterprise Server. This option can be used for all connections between all the application’s User and Viewer stations. For direct network connections, deselect this option.

- **Use an HTTP Proxy Server** If selected the Viewer accesses the desktop through an HTTP proxy server in the defined IP address and port. This option can be used when the User and Viewer stations cannot make direct contact with the Enterprise Server. When this option is checked the following parameters must be defined:

  - **Proxy Host** this is the address of the proxy server.
  - **Proxy Port** this is the port of the proxy server’s port number.
To access a User Station:

1. After receiving a request and password from a User station operator open your Internet browser and type in the Enterprise Server's address. You will receive a unique session ID number.

2. Contact the User station's operator and give them the unique session ID. They will then type this number in the Server Connection dialog box. The User station's desktop will appear in the Viewer station's screen.
Other Viewer Station Options

- **Viewing a Desktop Shared through a Direct Network Connection**

The Viewer station can be connected to the User station without using the Enterprise Server. This could be for example when the User and Viewer stations are defined nodes on the same network.

1. In the Viewer Connections Options dialog box Connection Type field do not check the Connect through Enterprise Server checkbox.
2. In the Server Connections dialog box Incoming Connections field check the Accept through LAN Connections checkbox.

- **Changing the viewer window size**

Click the Viewer icon in the window's title bar and select Full Screen.

- **Refreshing the Viewer window**

Click the Viewer icon in the window's title bar and select Request Screen Refresh.

- **Files Transfer**

Files can be both uploaded and downloaded to/from the User station.

1. Click the Viewer icon in the window's title bar and select File Transfer to open the Viewer File Transfer dialog box.
2. To download files, in the Local Drive field click the arrow and select the relevant Drive. Select the files that you wish to download from the left side of the dialog box and then click the Forward arrow button. The selected files will be added to the right side list.

3. To upload files, in the Remote Drive field click the arrow and select the relevant Drive. Select the files that you wish to upload from the right side of the dialog box and then click the Back arrow button.

4. Click the Done button to save these definitions.

► Closing the User Station's Computer

Right click the Viewer icon in the window's title bar and in the displayed menu select Close. The shared session ends.

► Moving the Focus Area of the User station's Desktop

Click the Viewer icon in the window's title bar in the displayed menu select either:

- Ctrl Down which moves the focus downward enabling you to see and select objects located below the current screen area view.
- Ctrl Up which moves the focus upwards enabling you to see objects located above the current area screen.

► Scrolling the User station's desktop

Click the Viewer icon in the window's title bar and in the displayed menu select either:

- Alt Down which moves the screen down enabling you to view objects located below the current screen area displayed
- Alt Up which moves the screen up enabling you to view objects located above the current screen area displayed

► Viewing information about Sessions

1. From your browser, log into the Application Portals and open the Access Application Portal page.

2. Select view the current sessions. Information about all sessions created for this instance of the Server are displayed. The page displays all sessions and identifies the sessions that are actively connected. The module's and Viewer IP addresses for all completed connections are also displayed.
► Viewing connection information
1. Click the Viewer icon in the window's title bar and select Connection Info. The Connection Information dialog box will open.
2. Type in the Session ID and password for the new connection.

► Starting a new connection
A single module installation can connect to multiple shared computer stations.
1. Click the Viewer icon in the window's title bar and select New Connection. The Connection Details dialog box opens.
2. Type or select a different Enterprise Server or host name.
3. Identify the session ID and password for the new connection.

► Saving information for the current connection
Configuration information, password and the connection IP address can be saved and used for another shared session on the same computer.
1. Click the Viewer icon in the window's title bar and click Save Connection Info as. The Save As dialog box will open.
2. Type in the relevant location and file name.
3. Click OK to confirm. The file extension will be *.vnc. A message box will open informing you that this file may not be secure.

► Closing an Viewer station window
Click the Viewer icon in the window's title bar and select Close. A message will appear. Click Yes to close the window and No not to.
**Server**

The Enterprise Server is web-based technology that enables Viewer station operators to access and operate a User station operator's desktop.

Requiring minimal configuration and setup the Enterprise Server provides a fast and secured means of connection and data transfer.

The Viewer station operator can use their own mouse and keyboard to operate a User station's desktop.

The server also enables secure file transfer between the User and Viewer stations. The data transferred between the two stations is first encrypted and then unencrypted and read by the Server.
Chapter 36 Application DDE Support

About this chapter:

This chapter describes how to use the system as a DDE client or server, as follows:

Overview on page 36-2 is an overview of DDE clients and servers.

In the manual the names WizDDE and WizDDEC/S have been substituted by application DDE and application DDEC/S. When writing code type the name of the application and then DDE or DDEC/S. on page 36-2 describes the DDE Address, DDE transactions, and DDE Overview.

Using the Application as a DDE Client on page 36-4 describes when to use DDE as a client.

DDE Client Definition on page 36-5 describes how to define the application as a DDE client and how to specify DDE addresses for tags.

DDE Client Block on page 36-8 describes how to define and modify DDE client blocks.

DDE Command on page 36-11 describes DDE commands.

Activating the DDE Client (DDEC) on page 36-12 describes how to run the DDEC module.

DDE Server (DDES) on page 36-12 describes when to use and how to define this application as a DDE server, how to specify a DDE address in the client application and activate DDES.

Excel to the Application Data Transfer on page 36-15 describes how to send data from Excel to the system.

An Application Macro From Client on page 36-16 describes how to activate application macros from DDE client applications.
Overview

Dynamic Data Exchange (DDE) is a protocol that enables unrelated software programs to exchange data. Any software that supports the DDE protocol can talk with other programs that support the protocol, regardless of differences between the applications. When the application passes tag values to an application module, it does not use DDE, but when this application and Excel exchange information, they must use DDE (WizDDE).

When applications exchange data using DDE, one is called the client application and the other the server application, as shown in the diagram below. The basic distinction is that the client application receives data from the server. Another difference is that the client always specifies what data is to be transferred. The DDE client specifies the data items to be exchanged by using a standard syntax called a DDE Address.

DDE Address

Before two applications can exchange information, the client application must specify the data items it wants to receive by using DDE Addresses. Remember that even though the data items reside in the server application, the DDE Address is always specified in the client application. The DDE Address consists of three parts:

- **Application**, that defines the name of the application you want to communicate with.
- **Topic**, that defines the data you want to process.
- **Item name**, that defines a unit of data (it can also be a file).

A program acting as a DDE server requires a client to define DDE Addresses in a specific manner.

Note: In the manual the names WizDDE and WizDDEC/S have been substituted by application DDE and application DDEC/S. When writing code type the name of the application and then DDE or DDEC/S.
Note: Read the relevant documentation of the server application for instruction on how to define the DDE Address in the client application. Remember that the DDE Address is defined in the client application for accessing data in the server.

A common example is a client application receiving updated data from Excel. Excel documentation states that a client must define the DDE Address as follows in order to receive data updates:

<table>
<thead>
<tr>
<th>Application</th>
<th>EXCEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>FileName/Sheet [e.g. BOOK1.XLS / SHEET1]</td>
</tr>
<tr>
<td>Item name</td>
<td>Row#Column# [e.g. R1C1]</td>
</tr>
</tbody>
</table>

Excel is a good example of why you need to read the server application documentation in order to properly define DDE Addresses from client applications. The Excel Item name specified above is valid for the English language version, but differs in other language versions of Excel.

Client applications wishing to access tag values in the application, must define their DDE Addresses as follows:

<table>
<thead>
<tr>
<th>Application</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>TAG</td>
</tr>
<tr>
<td>Item name</td>
<td>TagName or StationName:TagName. For example, VIEW01:ANA01.</td>
</tr>
</tbody>
</table>

**DDE Transactions**

Two DDE-compatible applications can exchange data in four steps:

1. A DDE Address is defined in the client application.
2. The client sends the DDE Address in a request to the server for data updates.
3. The server identifies the requested data by the DDE Address sent by the client.
4. When the requested data item changes, the server updates the client.
**DDE Overview**

The application supports DDE both as a client and a server (this means that it can receive data as a DDE client and send data as a DDE server provided the partner application supports DDE). The application DDE support is provided by two programs:

- **DDEC**: (WizDDEC) Enables your application to run as a DDE client and receive information from server applications, as described on the following page. Using WIZDEC, you can:
  - Update tags with values received from a server application. The new tag values are incorporated on-line into images, charts, reports, alarms, historical databases, and PLCs.
  - From the application, execute DDE commands in server applications with parameters defined in the application.

- **DDES**: (WizDDES) Enables you to run your application as a DDE server. Using DDES, you can:
  - Transmit real-time tag values to external applications such as spreadsheets, databases, batch programs, and many others.
  - Run any application macro from a DDE client application.

*Note: Both programs can run simultaneously to transform the application into a DDE client and server at the same time. This is common in configurations in which an application receives data updates from one program and sends data updates to another.*

**Using the Application as a DDE Client**

The DDEC (WIZ DDEC) program enables your application to run as a DDE client and receive information from server applications.

When the application receives frequent data updates from another program, set your application as a DDE Client. For instance, a program may read values from a field device and have to update the application with data changes. In this case configure the application as a DDE Client with all the necessary DDE addresses in order to receive updates from the other program.

In addition to processing data received from DDE servers DDEC also supports the DDE poke (one-shot send) mechanism. If a tag value changes in the application and this tag has a DDE Address, then DDEC will poke the tag value to the DDE server. This feature
exists to maintain data consistency between the application and the DDE server application. However, the DDEC poke does not transform the application into a DDE server and is not meant for transmitting data on a large scale.

If your configuration requires the application to frequently update another program (the other program would be a DDE client) with tag values, do not define DDE addresses for these specific tags in order to use DDEC. This will abuse the poke mechanism and result in inefficient data transfer. In this case configure the application as a DDE server.

**DDE Client Definition**

This section describes the following:

- Defining an application to run as a DDE client.
- Specifying a DDE address for tags so that the application updates the tag values it received from DDE server application.

**To define the application to run as a DDE client:**

In the Control Panel of the Application Studio, double-click the Application Setup icon.

Or,

From the Design menu, select Application Setup. The Application Setup dialog box is displayed.
1. Click the Add button. The Programs Specifications dialog box is displayed.

2. Click Browse and locate the DDEc.exe file in the Application/Bin directory.

3. Select the file and click Open. The file name appears in the Programs Specification dialog box.
4. Click OK to save your definition and to close the dialog box. The Application Setup dialog box opens.

5. Click OK to save your definitions and close the dialog box.

**Specifying a DDE Address for Tags**

To enable the application to update the tag values it receives from a DDE server application, specify a DDE address for these tags.

► **To specify a DDE address:**

1. Open the Tag Definition dialog box.

2. Select the DDE Link tab and then select the Single option. The DDE Link to tag parameters are displayed.

![DDE Link Parameters](image)

*Note: Read the Chapter 9, Tags for further details.*

The following options are available:

- **Application**
  
  Specifies the name of the DDE server from which the DDE Client will receive updates. Often the name of the software serves as the Application.

- **Topic**
  
  Specifies the name of the group of data or files on the DDE Server that will be accessed.

- **Item name**
  
  Specifies the data item on which updates are requested.

- **Link**
  
  Enables you to define the DDE Link as: Always linked to the DDE server, or In Monitor. When selecting Always, every change will be passed by DDEC to WizPro, even if the tag is not In Monitor.
**DDE Client Block**

The DDE Client Block enables the application to receive many tag values from the server in one update message. This improves the communication between the application and the DDE server. The DDE Client Block is built from a matrix of rows and columns in which each cell of the matrix contains the value of one data item.

*Note: Not all programs support block message. Check the documentation of the DDE server application.*

A common use for DDE client blocks is a setup in which a DDE server simultaneously updates a block of items that make up a recipe. The application which is the client receives all the items and the tag values are changed immediately.

Define DDE client blocks only if data items in the server change simultaneously (within milliseconds). The application receives the whole block of data whenever one of the items in the block changes. Therefore, if items change one at a time, the application will receive a whole block of values, many of which have not changed.

**DDE Client Blocks Definition and Modification**

There are two steps for using DDE blocks in the application:

- Defining the DDE client blocks.
- Connecting the tags to the relevant blocks in the DDE Link tab of the Tag Definition dialog box.

A DDE block in the application is composed of an internal name, block address, and block dimension. The internal name is used to connect a tag to a block.

DDE blocks are created and modified in the DDE Client Block Definition dialog box. This dialog box is invoked from the application Application Studio.

► **To define/modify DDE Client Blocks:**

In the Control Panel of the Application Studio, double click the DDE Blocks icon.

Or,

From the Design menu of the Application Studio, select DDE Blocks. The DDE Client Block Definition dialog box is displayed:
To create a new DDE block, follow the instructions in 2, 3 and 4 below.

1. To modify a DDE block, double-click the block, or select the block and click the Change button. The Define Blocks dialog box is displayed in which you can make the necessary changes.

2. In the Block Name field, enter an internal block name.

3. In the Application field, specify the DDE server application where each block physically resides.

4. Click the Add button. The Define Blocks dialog box is displayed. Define the block and click OK to save your definitions and close the dialog box.

The following options are available:

**Name**
- Specifies the internal name of the block. For example, BLOCK1.

**Application**
- Specifies the DDE server application. For example, EXCEL.
After defining blocks, individual tags can be connected to elements in the block, as described below.

**Connecting Tags to One Item in a DDE Block**

To connect a tag to an item in a DDE block, you must specify a DDE address for the tag.

► **To specify a DDE Address:**

Access the Tag Definition dialog box, select the DDE Link tab, and the Block option. The DDE Link to Tags parameters are displayed.

Following is an example using Excel:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Specifies the name of the group of data or files on the DDE Server that will be accessed. For example, Book1.xls.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Specifies the block address. For example, DDE clients of Excel must specify the block address as follows:</td>
</tr>
<tr>
<td></td>
<td><strong>Upper Left Cell:</strong> Bottom Right Cell. The DDE block starts at the cell in Row2/Column3 and ends with the cell in Row6/Column9. Therefore, the block covers five cells vertically (rows) and seven cells horizontally (columns). Therefore, the entry will be R2C3:R6C9.</td>
</tr>
<tr>
<td>Dimension</td>
<td>The number of rows and columns in the block. This is worked out from the address.</td>
</tr>
</tbody>
</table>

After defining blocks, individual tags can be connected to elements in the block, as described below.
The following options are available:

**Block Name**  Specifies the block to which the tag will belong.

**Row**  Specifies the row number of the item in the block relative to the start position. The start position appears in the Address field of the Define Blocks dialog box.

**Column**  Specifies the column number of the item in the block relative to the start position.

**Link**  Enables you to define the DDE Link as:
- **Always** linked to the DDE server or
- **In Monitor**. When selecting Always, every change will be passed by DDEC to WizPro, even if the tag is not In Monitor.

**DDE Command**

A DDE command is a command that the DDE client sends to the DDE server and is executed in the server application.

*Note:*  *Not all the applications support DDE commands even though they may support DDE communication. You must check the documentation of each software to see if this feature is supported.*

It is very important to remember that DDE commands are sent by the client and executed in the server.

Applications that support DDE commands include a predefined set of commands that can be received from a client application. These commands should be listed in the server applications' documentation.

DDE commands that the application sends to a DDE server are defined as macros in the application. Refer to the section on **Defining the DDE Command Macro** in Chapter 32, **Macros** for more details about defining DDE commands.
Activating the DDE Client (DDEC)

In order for the DDE to establish contact with the DDE server application, the server must be loaded before DDE. For example, if your application receives data from Excel (the DDE server), you must first load Excel before loading the DDE.

To enable your application as a DDE client run the DDEC module.

▶ To run the DDEC module:
Click the Start button and point to Programs. A popup menu is displayed. Point to the application and select DDE Client from the popup menu.

Important DDE Client Notes

Things to know about DDEC:

■ Load the application program that is the server before the client is loaded.
In order for the DDE to establish contact with the DDE server application, the server must be loaded before DDE. For example, if your application receives data from Excel (the DDE server), you must first load Excel before loading DDE.

■ If the DDE server application was not loaded prior to the DDE, or was closed and then reloaded, you must do one of the following to establish communication:
  Restart DDEC.
  Or,
  If a DDE tag is displayed in a Single Tag Input dialog box or image, close the dialog box, or image and reopen it. Restart the DDE Client to restore communication and reopen the tags. If no DDE tag is visible, simply display the tag in a Single Tag Input dialog box and communication will be restored.

DDE Server (DDES)

DDES is used to run your application as a DDE server.

This section describes the following:

■ When to use the application as a DDE server.
■ Defining the application to run as a DDE server.
Specifying a DDE address in the client application.

Activating the DDE server (DDES).

**Using the Application as a DDE Server**

Your application should run on a DDE Server when it has to send tag values to another program. A common example of this configuration is the application and a spreadsheet program that receives tag values from the application and displays them in a pie-chart.

If your application sends frequent tag value changes to a client program, then it is very important that it serves as a DDE server and not as a DDE client that abuses the poke mechanism. The poke mechanism is described in detail in the previous section.

**Defining the Application to run as a DDE Server**

1. To define the application to run as a DDE server:

   In the Control Panel of the Application Studio, click the Application Setup icon. The Application Setup dialog box page 5 is displayed.

   1. Click the Add button. The Programs Specifications dialog box is displayed.
   2. Press Browse and locate the DDEs.exe file in the Application/Bin directory.
   3. Select the file and click Open. The file name appears in the Programs Specification dialog box.
   4. Click OK to save your definition and to close the dialog. The Application Setup dialog box appears.
   5. Click OK to save your definitions and close the dialog.
   6. Run Excel or any other application program to serve as the client.

*Note: The DDE Server can support only one client application. If a DDE Server communicates with a client and another application establishes contact with this application, the link between it and the first client will be terminated. If a real tag gets a communication error, then asterisks (*****) are sent to the DDE client.*
Specifying a DDE Address

The DDE address is always defined in the client application. When the application serves a DDE server, the DDE addresses must be defined in the application that will request tag value updates from it. The client must define the DDE Addresses with the three standard components:

- Application
- Topic
- Item Name.

Client applications wishing to receive tag values in the application must define their DDE Addresses as such:

<table>
<thead>
<tr>
<th>Application</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>GATE</td>
</tr>
<tr>
<td>Item Name</td>
<td>TagName or 'StationName:TagName'. For example, A1001 or 'VIEW01:ANA01'.</td>
</tr>
</tbody>
</table>

Read the relevant documentation in the client application to find the syntax for defining DDE Addresses. For example, in Excel, to make a cell a DDE client on the application tag ANA01, you must specify the following formula for the cell:

=APPLICATION|TAG!ANA01.

If ANA01 is on a remote station called STAT1, the formula would be:

=APPLICATION|TAG!'STAT1:ANA01'.

Activating the DDE Server (DDES)

To enable your application as a DDE server, run the DDES module.

- To run the DDES module:

Click the Start button on your desktop, point to Programs, and then to the application. Select DDE Server from the popup menu.
Excel to the Application Data Transfer

This section describes how to send data from Excel to the application in two steps:

- Defining the DDE link initialization.
- Defining the DDE transfer.

**Step 1: Define the DDE Link Initialization**

Excel establishes the DDE link with the application. This is performed using the Excel INITIATE() function called from a macro sheet. For example:

```excel
= SET.VALUE (B1, INITIATE ("APPLICATION", "TAG"))
= RETURN ( )
```

In this example, the INITIATE function establishes a DDE link with the application and requests the TAG topic from the application. The SET.VALUE( ) function returns the result of the INITIATE function in the B1 cell of the macro sheet.

**Step 2: Define the DDE Transfer**

After the link between the application and Excel is established, data can be transferred from Excel to the application. In order to define the data transfer, the following macro should be implemented in a macro sheet:

```excel
= SET.VALUE (B5, POKE (B1,"1N101",B2))
= RETURN ( )
```

In this macro, the POKE ( ) function is used to transfer a value from the B2 cell to the application tag called ANA01, through the channel specified in the B1 cell. The SET.VALUE( ) function returns the result of the POKE( ) function to the B5 cell in a macro sheet. TRUE is returned upon success.

*Note: The macros specified above are used for definition purposes only. In order to establish a link and transfer data, activate these macros using the Macro/Run option from the Excel Main Menu.*
Application macros can be activated from DDE client applications as long as the applications support this part of the DDE protocol. Consult the documentation of the client application to check if this support exists and how it operates.

To activate an application macro from the client application, the DDE Address for the macro must be defined with the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application</strong></td>
<td>Application</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>Gate</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td>Macro Name (the name in the application given to the macro to be executed)</td>
</tr>
</tbody>
</table>

An Application Macro From Client
Chapter 37 Application SQL Support

About this chapter:

This chapter describes application SQL support, as follows:

Overview on page 37-2 is an overview of SQL and the application SQL Connection module.
The Application’s SQL Connection Module on page 37-2 describes the application’s SQL and how it can be configured.
ODBC SQL Support on page 37-3 describes installation, configuration and activation of ODBC.
Activating Application SQL on page 37-5 describes how application SQL is activated.
The Application SQL File on page 37-7 describes how to define commands for reading and writing data from and to user-defined RDB tables.
Application SQL Commands - Overview on page 37-10 gives an overview of application SQL commands and their functions.
Adding, Updating and Deleting Data on page 37-17 describes adding to, deleting from and inserting data into RDB tables.
Retrieving Data on page 37-19 describes retrieving data with the SELECT and FETCH commands.
String Expression on page 37-20 describes a string expression.
Application Command on page 37-21 describes application supported operations.
Program Initialization on page 37-25 describes the initialize section of an ASCII file.
Program Termination on page 37-26 describes the termination section of an ASCII file.
Communication Failure Processing on page 37-26 describes how application SQL handles communication problems with the RDB.
Application SQL Messages on page 37-27 lists application SQL messages.
Overview

Structured Query Language (SQL) is a standard language used for retrieving data from and sending data to a database management system. In database management systems (DBMS), information is stored in tables where each line of the table contains a record of information.

When an application needs to retrieve data from a database, the application’s SQL language is used to make the request. The database program processes the SQL request, retrieves the requested data, and returns it to the requesting program. The application’s SQL also enables a program to update the database by adding new data, removing old data, and modifying previously stored data.

The application’s SQL Connection module enables you to:

- Update user-defined database tables.
- Retrieve information from common databases and save it in this application's recipes. This type of data transfer allows users to send production orders from their business systems directly to the plant floor.

Note: In the manual the name WizSQL has been substituted by application SQL. When writing code type the name of the application and then SQL.

The Application’s SQL Connection Module

The purpose of the application’s SQL (WIZSQL) is to allow a two-way data exchange between the application and database management systems.

Application SQL can be configured to do the following:

- Store the application data in user-defined tables in a database management system. The data can be online values of tags, historical data or data derived by applying functions to application historical data.
- Retrieves data from database management system (DBMS) tables and updates application tags or other structures.

The connection between the application and DBMS systems allows easy implementation of laboratory analysis systems, batch tracing, recipe management, and order management applications. The application’s SQL feature is a separate module that is run from the application setup.
Application SQL can also be used as an event-driven language for calculating and extracting information from history. When used in this way an SQL database is not required.

**ODBC SQL Support**

The application’s SQL Module supports the Microsoft Open Database Connectivity (ODBC) interface, allowing the application to exchange data (uploading and downloading) with a variety of databases, including Sybase, INGRES, INFORMIX, DB/2 and others, as well as file formats such as dBase and Paradox.

*Note: The application ODBC interface and the specific ODBC compliant driver to the relevant database must be obtained separately.*

This section describes the following:

- Installing the application system files and the ODBC driver for your database, as described below.
- Configuring the Wiztune.dat file, as described on the following page.

**Installation**

To use ODBC support of the application, install the following:

- The application’s system files from the standard application installation CD (hnODBC driver for the database you are using. (Provided by the database vendor.)

**ODBC Configuration**

To configure your ODBC configuration, add the following variables to the wiztune.dat file:

```
WIZSQL_ODBC_ATTRIBUTES=database connection string
```

```
WIZSQL_INTERFACE=ODBC
```

Axeda

ODBC SQL Support 37-3
Database Connection String

In the database connection string, you define the database you are using, plus other necessary attributes. It has the following format:

```
attribute=value;.....;attribute=value
```

The connection string must include the attribute: DSN=data source name.

To determine the Data Source Name:

1. Click the Start button, point to Settings and click Control Panel from the popup menu. The Control Panel window is displayed.
2. Double-click the ODBC or 32 bit ODBC icon. The Data Sources window is displayed with a list of data sources (drivers).
3. In the USER menu, select ADD, and then select the name of the driver you are using and click the Finish button.
4. The ODBC Text Setup dialog is displayed.
5. Fill in the necessary information, according to the driver you have chosen. Select the location where the sets of tables are created.

For further information, refer to the relevant documentation of the driver you are using.

The following are examples of database connection strings:

The line in Wiztune for Sybase System 10 ODBC driver will be:

```
WIZSQL_ODBC_ATTRIBUTES=DSN=Sybase System 10;
SRVR=application
```

The line in Wiztune for dBASE format ODBC driver will be:

```
WIZSQL_ODBC_ATTRIBUTES=DSN=dBASEfile
```

Note: You should not include the UID (User ID or name) and PWD (Password) attributes in the connection string. They are given in the connect command in your application SQL program.
Activating Application SQL and ODBC

If you are using an ODBC driver of a file format, (for example, dBASE, FoxPro etc.) use empty strings (" ") for the user and password in the connect command in the application SQL program. For example:

```
CONNECT " " / " " ;
```

Before writing your application SQL program, check which of the SQL commands are supported by the ODBC driver for the database you are using. You can also refer to the documentation of the specific driver you are using.

Activating Application SQL

Application SQL is activated as follows:

```
WIZSQL [/P/A/D/L/C] FileName
```

Where:

FileName - is the name of the Application SQL file. Enter the FileName without an extension. The system automatically attaches the suffix WSQ to the file.

/P - only Parse the application SQL program. Use this option to find syntax errors in the program. You do not need the database itself when you use it.

/A - Automatically run the backup file.

/D - print runtime debug messages for each command with its parameters.

/L - prints error, debug and warning messages to a log file. The log is the filename with LSQ suffix.

/C Error codes for detecting database disconnection.

In the application SQL Backup mechanism, commands are written to a backup file once the communication with the server is lost (See the application SQL Communication Failure Processing section for more details). Application SQL needs to know which database error codes indicate that it should start writing the commands to the backup file.

You can enter these error codes into application SQL in its command line with the parameter /C in one of the following ways:
/Cxxxx - where xxxx is a database error code meaning that the communication with the database has ceased.

Or,

/Call - all error codes received from the database mean that the communication with the database has stopped.

**Example 1: application SQL /C1234 /C4321 prog**

The error codes 1234 and 4321 mean a communication error with the database server.

**Example 2: application SQL /Call prog**

All error codes mean a communication error with the database server.

*Note:*

The error codes can be found in the documentation of the database server you are using. Several application SQL files can run simultaneously. Make sure that WizPro is active before running application SQL.

**Activating application SQL from the Command Prompt**

You can activate application SQL from the command prompt using the following flags:

```
WIZSQL [/P],[/A],[/D],[/L],[/C],FileName.
```

You can also run application SQL from application Language. The command is as follows:

```
SHELL "WIZSQL[/P],[/A],[/D],[/L],[/C],FileName."
```

If you run application SQL from an application command macro, use the same format.

**Activating application SQL from the Application Setup Menu Item**

Application SQL can also be run from the Application Setup menu item. From the application setup dialog click ADD and browse to locate application SQL.EXE, which should be added to the programs to run field. In the parameters field, enter the file name (without the suffix). You can also use the following flags: [/P], [/A], [/D], [/L], [/C].
Example: /L /D FileName

Note: To run application SQL properly, make sure to only checkmark (P) the Open a Window field.

**The Application SQL File**

Application SQL enables you to define commands for reading and writing data from/to user-defined RDB tables. These commands are defined in an ASCII file using a standard ASCII editor.

The format of the file is as follows:

- **Header section**: Includes one line with the version number.
- **Initialization**: Lists SQL and application commands for initializing variables and connecting to the RDB.
- **Commands**: Includes a set of commands where each command is composed of a condition and a list of SQL and application commands.
- **Termination**: Includes a list of SQL and application commands to be carried out before completing the program.
- **Remarks**: Remarks can be inserted in the application SQL file in one of two ways: // - from the slashes to the end of the line is a comment. /* */ - the comment can be closed at each end by these symbols.
**Sample Application SQL Program**

The application SQL file below performs the following functions in an application.

1. An order management system uses an RDB to process orders for production.
2. When preparing to produce the next order, application SQL retrieves information on the pending order from the RDB.
3. The retrieved information is placed in a group of dummy tags, which are saved to a recipe.
4. The database is updated with a new status for the order just retrieved.
5. When production begins, the dummy tags recipe is loaded into real tags.
6. When production is complete, the RDB is updated with the new status of the order produced.

```sql
WIZSQL
INIT
    CONNECT @USER IDENTIFIED BY @PWDS;
    @NEW_ORDER = 0;
    @START_PRODUCTION = 0;
    @END_PRODUCTION = 0;
INIT
    CONNECT @USER IDENTIFIED BY @PWDS;
    @NEW_ORDER = 0;
    @START_PRODUCTION = 0;
    @END_PRODUCTION = 0;
```
COMMANDS

DESCRIPTION "Retrieving a new order from RDB";
IF (@NEW_ORDER)
BEGIN
SELECT "SELECT Order_Id, Qty_1, Qty_2, Qty_3 FROM Orders WHERE Orders_Status='new' AND Order_Pri=@PRI";
FETCH INTO @ORDER_ID, @PRODUCT1, @PRODUCT2, @PRODUCT3;
END;
@RCP_NUM = @RCP_NUM + 1;
SAVE RECIPE "Dummy."+@RCP_NUM
"Save specs of next production order";
@ORDER_STATUS = "pending";
WHERE Order_Id = @ORDER_ID ;
EXEC SQL "UPDATE Orders SET orders_status = ' @ORDER_STATUS 'WHERE Order_Id = @ORDER_ID ";
DESCRIPTION "Starting production of new order";
IF (@START_PRODUCTION)
LOAD RECIPE "Dummy."+@RCP_NUM;
LOAD RECIPE "SQL.001";
@ORDER_STATUS = "in production";
EXEC SQL "UPDATE Orders SET Orders_Status = ' @ORDER_STATUS"
**Application SQL Commands - Overview**

The application’s SQL module allows you to define commands for reading and writing data from/to user-defined RDB tables. Each command consists of three segments, as described below:

<table>
<thead>
<tr>
<th>Command Description</th>
<th>Free text in quotation marks that explains the command purpose and comments. It is 80 characters long (maximum) and ends with a semicolon.</th>
</tr>
</thead>
</table>
Condition

Login condition for command execution. The SQL and application sections will be executed only if the condition changes from False to True.

Command List

Includes a number of mixed SQL and application commands which will be executed when the condition becomes True. Each is ended with a semicolon.

Types of Commands

SQL Command

An SQL statement that can incorporate application tag names as tokens. This type of command connects/disconnects between the application and the RDB. Three groups of commands are supported: Connect, Table Update and RDB Query.

Application Command

An application related operation. Two types of application operations are supported: Tag Assignment and Save/Load Recipe.

Block Command

A block of SQL and application commands. If a command in a block fails, the execution stops and all the SQL commands that have been executed to that point are automatically cancelled using the Rollback command. If communication with the database stops only commands existing in a block are saved and will be executed when the connection is renewed.

Backup Command

Used to run the backup file after connection with the database is renewed.

Backup Command

Used to run the backup file after connection with the database is renewed.

Termination

This command signals SQL to stop running commands in the SQL file.

If

The If command can be used anywhere in the program, as with all other standard commands.
The following example shows a typical application SQL command containing a Description, Condition, and a combination of SQL and application commands.

```
DESCRIPTION "Save batch data into Process table.";
IF (@BATCH_END)
    /* SQL INSTRUCTIONS */
    EXEC SQL "INSERT INTO process VALUES (@TEMP_P1A, @DUR_P1A, @LEV_P1A)";
    EXEC SQL "commit";
    /* application command */
    @BATCH_END = 0;
```

**Saving batch data into process table**

<table>
<thead>
<tr>
<th>Date</th>
<th>Temp</th>
<th>Duration</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>15/06/95</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12/06/95</td>
<td>92</td>
<td>9</td>
<td>222</td>
</tr>
<tr>
<td>09/06/95</td>
<td>124</td>
<td>4</td>
<td>20</td>
</tr>
<tr>
<td>08/06/95</td>
<td>112</td>
<td>8</td>
<td>0</td>
</tr>
</tbody>
</table>
**Application SQL Condition**

The Condition statement is a logical condition based on application tag values. The format of the condition expression is similar to the 'C' language format. Consequently, it is TRUE when it is different from 0.

You can use the mathematical and logical operators listed below in expressions. These symbols have the same meaning as the ones used in 'C' language.

**Mathematical Operators:**
+, -, *, /, %, |, &, ~, <, <=, >, >=, ==, !=

**Logical Operators:**
&&, ||, !, ^, AND, OR, NOT

The condition variable can be:
@TAG: The application tag name. It must be preceded by the @ character.

For every tag that appears in the condition expression, WizPro updates application SQL whenever one of the tags changes. When application SQL receives the tag update message, it checks only the conditions that contain the tag whose value has changed. This event-driven mechanism saves computer resources and allows the application to perform unaffected by communications with the DBMS.

The following are examples of condition expressions:

```
IF (@TEMP > @TEMP_SP && @DOIT == 1)
```

```
IF (@ANA01+@ANA02*@ANA03 < @ANA04/@ANA05 || @ANA06)
```

```
IF ($SQLRC == 1)
```

```
IF (@ANA01>5 AND NOT @ANA02 == 5*@ANA03)
```
Note: If at least one of the tags in the condition expression is in communication error or has been deleted, the condition will be ignored.

**SQL Command**

The application’s SQL command is a standard SQL statement that is executed when the command condition becomes TRUE.

The application’s SQL command may incorporate the application @Tag token that is translated to the tag value when it is inserted or updated in the database but the tag will receive a value only when the database is queried. Application SQL supports three groups of SQL commands explained in the following sections.

Only application SQL data manipulation commands are supported. Application SQL does not support the standard SQL data definition commands for managing the DBMS. Refer to the relevant SQL documentation for the full syntax of each SQL command.

**Connect/Disconnect**

Every application SQL program must connect to the database with the standard CONNECT command, and disconnect from the database using one of the standard ‘COMMIT/ROLLBACK RELEASE’ commands. CONNECT can appear only in the initialization section, while DISCONNECT can appear only in the termination section.

**Connect command:**

Syntax:

```
CONNECT user-name IDENTIFIED BY password [connect string];
CONNECT user-name/password [connect string];
```

The user-name, password and connect string parameters are string expressions.

**Connect String (optional)**

The Connect String enables connection to different databases from two different application programs running in parallel.

If no connection string is given, then the connection string is taken from the Wiztune global parameter WIZTUNE_ODBC_ATTRIBUTES = database connection string.
Examples:

<table>
<thead>
<tr>
<th>CONNECT &quot;Axeda Systems&quot; IDENTIFIED BY &quot;Application&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONNECT @USER/@PASSWORD;</td>
</tr>
</tbody>
</table>

Note: Application SQL cannot communicate with the RDB without the CONNECT command in the INIT section of the application SQL file.

**Disconnect command**

**Syntax:**

| COMMIT WORK RELEASE; |
| ROLLBACK WORK RELEASE; |

**If Command**

The If command can be used anywhere in the program, as with all other standard commands, in one of the following ways:

<table>
<thead>
<tr>
<th>IF (expression)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Command</td>
</tr>
<tr>
<td>IF (Expression)</td>
</tr>
<tr>
<td>BEGIN</td>
</tr>
<tr>
<td>Command 1;</td>
</tr>
<tr>
<td>Command 2;</td>
</tr>
<tr>
<td>...</td>
</tr>
<tr>
<td>Command n;</td>
</tr>
<tr>
<td>END</td>
</tr>
</tbody>
</table>
An **ELSE** part can be added to any of the two IF formats with a single command, or with a list of commands between **BEGIN** and **END**.

**Examples:**

```plaintext
DESCRIPTION "Example 1"
IF (@ANA01 > 200)
LOAD RECIPE "Recipe.001";
IF (@ANA03 > 100)
@ANA02 = 30;
DESCRIPTION "EXAMPLE 2"
IF (@ANA10 == 1)
@index = 0;
WHILE ( @INDEX < 5 )
    @INDEX = @INDEX+1;
IF ( @ANA05 == 100 )
BEGIN
    SAVE RECIPE "Name.1" "Description";
    @ANA06 = 300;
END
ELSE
    @ANA06 = 200;
END
```
Adding, Updating and Deleting Data

These commands belong to the Data Manipulation Language part of SQL and enable data to be added to, deleted from, and inserted into RDB tables. Commands such as INSERT, UPDATE, DELETE, COMMIT, and ROLLBACK can be used in application SQL. The syntax for executing one of these SQL statements is:

Syntax:

```sql
EXEC SQL string-expression;
```

Where the result of the string expression is the SQL command to be executed. The SQL command should conform to the standard SQL syntax;

The following examples cover the most common SQL commands.

**INSERT:** Adds a new row of data to a table.

**Syntax:**

```sql
INSERT INTO table-name (column-name, column-name,...) VALUES (value, value,...)
```

**Example:**

```sql
EXEC SQL "INSERT INTO Process1 (Batch, Temperature, Pressure) VALUES ('August', @TEMP, @PRES)"
```

**UPDATE:** Modifies the values of one or more columns in selected rows of a single table.

**Syntax:**

```sql
UPDATE table-name SET column-name = expression WHERE search-condition
```

**Example:**

```sql
EXEC SQL "UPDATE Process1 SET Temperature = @TEMP WHERE Batch = 'August';"
```
DELETE: Removes selected rows of data from a single table.

Syntax:

```
DELETE FROM table-name WHERE search-condition
```

Example:

```sql
EXEC SQL "DELETE FROM Process1 WHERE Batch = @BATCH_NUM";
```

Note: The syntax in the above commands is partial. For the full syntax, please refer to your SQL documentation.

COMMIT: Signals the successful end of a transaction. A transaction is a sequence of one or more SQL statements that together form a logical unit of work. The SQL statements that form the transaction are closely related and perform an interdependent action. Each statement in the transaction performs some part of the task, but all are required to complete the task. The COMMIT statement tells the DBMS that the transaction is now complete. All the statements that comprise the transaction, for example, inserts, updates, delete have been executed and the database is consistent. If you do not use the commit command, other clients cannot see the changes made, and when exiting, data is lost.

Syntax:

```
EXEC SQL "COMMIT";
```

ROLLBACK: Signals the unsuccessful end of a transaction. It tells the DBMS that the user does not want to complete the transaction. Instead the DBMS should delete any changes made to the database during the transaction. It restores the database to its state before the transaction began.

Syntax:

```
EXEC SQL "ROLLBACK";
```
## Retrieving Data

Data is retrieved by one SELECT command that finds a group of records, and one or more FETCH commands that insert values from one record in the RDB into tags. Often, the values are saved in dummy tag recipes for later use.

The syntax of the SELECT command is:

```
BEGIN SELECT "select command according to standard SQL syntax";
  select command block
END SELECT;
```

*Note: The SELECT command string can be a string expression.*

The Select Command Block is a mixture of SQL and Application commands and FETCH commands. The syntax of the FETCH command is:

```
FETCH INTO @TAG1, @TAG2, @TAG3....;
```

*Note:*

The syntax of the FETCH command in application SQL differs slightly from the standard SQL syntax.

The number of tags in the FETCH command must be the same as the number of fields selected in the SELECT command.

The tags in the FETCH command and the values assigned to them must be of the same type.

A typical Select Command Block may look as follows:

```
IF (@BATCH_BEGIN)
  BEGIN SELECT "SELECT Temp, Pressure FROM Process1 WHERE Batch = 'July'";
    FETCH INTO @SAVE_TEMP, @SAVE_PRESSURE;
    SAVE RECIPE "BatchBegin.007" "Batch begin status of month 7";
  END SELECT
```

*Axeda*
String Expression

The string expression can be:

- A String tag.
- A Quoted string.
- One or more of the above concatenated with the '+' sign.

Example:

The following example shows how a string expression that combines string tags and quoted strings is translated by application SQL.

Assume that the Application string tags have the following values:

```sql
@INSERT_COLUMNS= "( Batch, Temperature, Pressure )"
@INSERT_TAGS= "( 'August', @TEMP, @PRES )"
```

And that application SQL contains the following command:

```sql
EXEC SQL "INSERT INTO Process1" + @INSERT_COLUMNS + "VALUES" + @INSERT_TAGS;
```

Application SQL translates and executes this command as follows:

```sql
EXEC SQL "INSERT INTO Process1 (Batch, Temperature, Pressure) VALUES ('August', @TEMP, @PRES)";
```

Note: String tags used within an SQL command require single quotes. For example, assuming @Month is a string tag @Month = "August";

```sql
EXEC SQL "INSERT INTO Process1 (Batch, Temperature, Pressure) VALUES (@MONTH', @TEMP, @PRES)";
```
**Application Command**

Two types of application operations are supported:
- Tag Assignment.
- Save/Load Recipe.

**Tag Assignment**

In application tag assignment operations the value assigned to the tag can be any expression in 'C' format (as in the condition expression), or the result of a historical function on a tag. For example:

**Syntax:**

```
@tag-name = expression
@tag-name = historical expression
```

**Expression**

One of the following expression types can be assigned to a tag:
- If @tag_name is a numerical tag, it is a numerical expression as described earlier in the condition section.
- If @tag_name is a string tag, it is a string expression as described earlier in the SQL command section.
- $SQLRC: This is a variable containing the SQL completion code. It is a predefined variable that indicates the status of the last SQL command executed.

**Historical Functions**

Much like the application Report module, application SQL supports historical operations on tag values in historical files. The results of these operations can be assigned to tags. The application SQL historical functions are split into two groups.
The functions in the first group perform a calculation on values within a specified time interval:

**WMIN**  
Returns the lowest value recorded during the specified interval.

**WMAX**  
Returns the highest value recorded during the specified interval.

**WAVERAGE**  
Returns the arithmetic average of all the values recorded during the interval.

**WWAVERAGE**  
Returns the average of recorded values of the tag, relative to the time the value occurred in the tag.

**WINTEGRAL**  
Returns the sum of recorded values, multiplied by the time the value occurred in the tag, until the next recording of the same tag.

**WSUM**  
Returns the sum of all the values recorded during the interval.

The syntax for this group of commands is as follows:

**Syntax:**

`FUNCTION(@tag-name, from-time, to-time)`

**Example:**

`WMIN(@ANA01, REL(1, 10:0:0), REL(1, 0:0:0));`

The functions in the second group perform calculations based on a value range given:

**WINTIME**  
Returns the total amount of time that tag values were in the specified range.

**WINCOUNT**  
Returns the number of times that tag values were recorded for a specified value range.

The syntax for this group of commands is as follows:

**Syntax:**

`FUNCTION(@tag-name, from-time, to-time, low-value, high-value)`
Example:

```
@DURATION = WINTIME(@TEMP, REL(0, 10:0:0), REL(0, 0:0:0), 90, 100);
```

*Note: For more information on each application SQL historical command, refer to the Chapter 31, Reports.*

**From/To Parameter**

For every application SQL historical function, the From/To parameter must be specified to define the time interval for which historical values will be analyzed. A time indicator can be absolute or relative.

**Syntax:**

```
indicator(date, time)
```

The Indicator is used for indicating whether the date-time is absolute or relative. Specify one of the following:

**ABS - Absolute date & time:** A full date and time with minutes and seconds must be specified.

**REL - Relative date & time:** The number of days back and number of hours back are specified.

**RELD - Relative date & Absolute time:** The number of days back and a specific time are specified.

The full format for the date and time parameters is as follows:

**Date** day-month-year

**Time** hour:minutes:seconds

**Examples:**

```
ABS(12-10-89, 12:30:00)
```

This specifies 12:30 on October 12, 1989

```
RELD(10, 12:30:00)
```
This specifies 12:30 10 days ago.

REL(10, 1:0:0)

This specifies 10 days and 1 hour ago.

**Save/Load Recipe**

The Save and Load Recipe commands in application SQL perform the same operations that they normally do in the application.

Save and Load Recipe commands are defined as follows:

**Syntax:**

```
SAVE RECIPE "recipe-name" "description"
```

LOAD RECIPE "recipe-name"

*Note: The recipe-name and description parameters support string expressions.*

**Example:**

```
SAVE RECIPE "Batch.002" "Yoghurt production";
LOAD RECIPE "Batch.002";
```

**Block Command**

A block of SQL and application commands are used to ensure that a database will be updated with end of batch data even if that database is offline or down. If a command in a block fails, the execution stops and all the SQL commands that have been executed to that point are automatically canceled using the ROLLBACK command. If the communication with the database is stopped, only commands that exist in the block are saved and will be executed when the connection is renewed.

**Syntax:**

```
BEGIN BLOCK

END BLOCK;
```

Commands list, which is a list of application and SQL commands except for SELECT.
**Program Header**

A header must appear in the application SQL file.

The syntax of the header of a program file is:

```
application SQL VERSION version-number
```

The syntax of the header of a backup file is:

```
application SQL BACKUP VERSION version-number
```

**Program Initialization**

The initialization section of the ASCII file includes SQL and application commands for opening relational databases and initializing the application SQL related tags. This section must include at least a CONNECT command, as described earlier.

The syntax of this section is:

```
INIT
Commands list - a list of assignment, recipe, connect, and SQL commands.
```

The following shows an example of an initialization section in a application SQL file:

```
INIT
@ANA03 = 0;
CONNECT @USER IDENTIFIED BY @PWD;
```
Program Termination

The termination section of the ASCII file includes an SQL command for disconnecting from the database, and can include application commands to reset SQL-related tags. This section should include one of the two SQL disconnecting commands, otherwise, ROLLBACK is used. Application SQL is signaled to go to the Termination section of the application SQL file by using the TERMINATE command or during shut down.

The syntax of this section is:

```sql
TERM

Commands list - a list of assignment, recipe, dis-connect, and SQL commands.
```

The following is an example of the TERMINATE command and a termination section.

```sql
IF (@BATCH_END)
   TERMINATE;
TERM
   COMMIT WORK RELEASE;
@ANA03 = 9999;
```

Communication Failure Processing

When a communication problem with the RDB occurs, application SQL activates a backup mechanism to back up commands that should be executed.

The commands are back up into a backup file, consisting of the program file name and the extension BSQ.

Only commands that are in a block are backed up. If the failure occurs in the middle of a block, all the commands of the block are backed up. Commands that exist outside of a block are written to the backup file as a remark.

Assignment commands are executed regardless of the communication status with the database.

After the communication with the database is renewed, you can run the backup file in two ways:


- **Automatic:** To activate this option, application SQL should be activated with the option /A. If this option is on, application SQL automatically tries to renew the connection with the database once a minute. When it succeeds, it automatically runs the commands from the backup file.

- **Manual:** If the option /A is unavailable, you need to activate the backup manually. A special command exists for this purpose:

  **Syntax:**

  

  ```sql
  EXEC BACKUP ;
  ```

  When this command is activated, application SQL tries to re-connect to the database and run the commands from the backup file.

  *Note:* You can edit the backup file before running it to fully control the commands that will be run.

  **Example:**

  The following is an example in which backup file is executed according to the tag SQLBACKUP:

  ```sql
  IF ( @SQLBACKUP )
  
  EXEC BACKUP ;
  
  @SQLBACKUP = 0 ;
  ```

  **Application SQL Messages**

  There are two types of messages that may occur when using application SQL:

  - Application messages
  - ODBC Driver messages

  *Note:* For further information about ODBC Driver messages refer to the documentation of the ODBC Driver you are using.
Application Messages

There are three types of application SQL messages:

- Error messages
- Warning messages
- Debug messages

Note:
*Debug messages are printed to the screen when the /D parameter is active. These messages show the user the upcoming step.*

*All messages are printed to a log file when the /L option is on. The name of the log file is the same as the application SQL file with the suffix LSQ.*

The application SQL Command message is printed as line# column# and the attached message of the command file. When a message is written to a log file, then the date and time are also added.

Note: *If the message occurs on the same date as the opening date of file, only the time is indicated.*

The following is a list of the application SQL messages and the actions required to correct them. The Error message is displayed in Bold.

"Number of fields (#), differs from the number of tags (#)"

**Action:** Check that the number of tags in a Fetch command is the same as the number of Fields in the corresponding Select command.

"Type of field differs from type of tag"

**Action:** Check that the type of tag in a Fetch command is the same as the type of the corresponding field in the table.

"Type of tag tag name does not exist"

**Action:** Verify that the tag name is valid.

"Unexpected end of file"

**Action:** Your application SQL program does not end correctly. Correct it and run application SQL again.
“Tag name is too long”
Action: Tag name format can be station-name:tag-name, where station-name is optional and up to 15 characters long, and tag-name is up to 31 characters.

"String is too long"
Action: Check that the maximum amount of characters in the string is 255.

"WizPro is not active"
Action: WizSQL does not operate if WizPro is not active. Activate the application and then WizSQL.

"Failed to open input file file-name"
Action: Check that the file's file-name exists and is enabled for opening.

"Memory allocation failed"
Action: Check that the drive where the swapper file is located has enough space. If not add room for it.

"Illegal operator for the expression parameters"
Action: The operator used in an expression is illegal for the parameters. For example, using an arithmetical operator for string parameters

"Illegal parameters for the expression operator"
Action: The parameters used in an expression are illegal for the operator. For example, using arithmetical parameter for string operators.

"Illegal expression type in assignment"
Action: The expression type should be the same as the tag type to which the expression is assigned.

"A WizPro function failed, see the file errors.dat"
Action: An internal function call failed. See the errors.dat file for the cause of the failure.
"No SQL connect command, in the INIT section"
Action: An application SQL program communicating with a database must have a CONNECT command in its INIT section.

"No backup mechanism is enabled"
Action: An application SQL program communicating with a database, must have either an automatic backup mechanism activated by including the /A option, or manual mode by having the command: EXEC BACKUP in the application SQL program.

"No TERMINATE command in the program"
Action: An application SQL will only terminate when WizPro is shutdown. To enable the operator to stop application SQL, add a TERMINATE command to your program, under a termination condition.

"Illegal tag type"
Action: The type of tag is illegal for this command. For example, a string tag cannot be used in a historical function. Insert a legal tag type.

"No records found for this tag"
Action: No historical records were found while reading the history of a tag for calculating a historical function. Check the tag's recording mode

"Illegal time parameter"
Action: The format of the time parameter of a historical function is wrong. Correct the time parameter.

Syntax error "command string"
Action: A syntax error was found during parsing the file. The command string contains the erroneous part. Check the given line and column to locate error.

'command' failed, error code is 'error code'.
Action: A run time command execution failed. The command describes the failed command, the error code gives the reason for the failure. The error code can be found in wizerr.h.
## Appendix A Application Files

**About this appendix:**

This appendix describes the data and configuration files used by this application, as follows:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wizdata.mdb</td>
<td>Contains tag definitions.</td>
</tr>
<tr>
<td>Wizdata.mdb</td>
<td>Contains alarm definitions.</td>
</tr>
<tr>
<td>errors.dat</td>
<td>Contains information, warnings and error messages.</td>
</tr>
<tr>
<td>wiztune.dat</td>
<td>Stores application variables used for settings.</td>
</tr>
<tr>
<td>Wizum.mdb</td>
<td>Contains users definitions.</td>
</tr>
<tr>
<td>wizcfg.dat</td>
<td>Contains configuration information of paths and printers settings.</td>
</tr>
<tr>
<td>netcfg.dat</td>
<td>Contains information on station network settings.</td>
</tr>
<tr>
<td>wizvpi.dat</td>
<td>Contains information about communication driver definitions and Wizpro options (g+/i,a+/-...).</td>
</tr>
<tr>
<td>alarms.prt</td>
<td>Contains alarm printer configuration.</td>
</tr>
<tr>
<td>lrn.dat</td>
<td>Contains information on current active alarms. Wizpro restarts alarms in this file when it reloads.</td>
</tr>
<tr>
<td>GTddmmyy.dbfGTddmm yy.cdxGTddmmyy.fpt</td>
<td>Contain information on daily tag values, history file in FoxPro format (VFI5CB). (dd=day, mm=month, yy=year)</td>
</tr>
<tr>
<td>File Name</td>
<td>Function</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Gtddmmyy.dat Gtddmmyy.idt Gtddmmyy.str</td>
<td>Contain information on daily tag values, history file in an internal application format (VFI5FST). (dd=day, mm=month, yy=year).</td>
</tr>
<tr>
<td>Alldmmyy.dbf ALddmmyy.cdx</td>
<td>Contain information on daily alarms history file in FoxPro format. (dd=Day, mm=month, yy=year)</td>
</tr>
<tr>
<td>wizmacro.dat</td>
<td>Contains information on the default macro file.</td>
</tr>
<tr>
<td>wizmacro.err</td>
<td>Contains macros error messages.</td>
</tr>
<tr>
<td>wizmenu.dat</td>
<td>Contains menu authorizations settings.</td>
</tr>
<tr>
<td>classes.dat</td>
<td>Contains alarm user class names.</td>
</tr>
<tr>
<td>wrestart.dat</td>
<td>Stores the last state of the application. Used to restart the application in the same state after a power failure.</td>
</tr>
<tr>
<td>Set_up.dat</td>
<td>Contains the complied application language.</td>
</tr>
<tr>
<td>ecl.dat</td>
<td>Contains the application language configuration.</td>
</tr>
<tr>
<td>Command5.dat</td>
<td>Contains the application Language source.</td>
</tr>
<tr>
<td>wizddec.dat</td>
<td>Contains DDE Client block definitions.</td>
</tr>
<tr>
<td>*.IMG</td>
<td>Image picture file.</td>
</tr>
<tr>
<td>*.VIM</td>
<td>Contains image window definitions.</td>
</tr>
<tr>
<td>*.ILS</td>
<td>Image list file. Image picture in ASCII format.</td>
</tr>
<tr>
<td>*.LAY</td>
<td>Layout file.</td>
</tr>
<tr>
<td>*.ANN</td>
<td>Events Summary window definition.</td>
</tr>
<tr>
<td>*.CHR</td>
<td>Chart window definition.</td>
</tr>
<tr>
<td>*.ANL</td>
<td>History Viewer window definition.</td>
</tr>
<tr>
<td>RPD*.DAT</td>
<td>Contains the reports fields descriptions.</td>
</tr>
</tbody>
</table>

Application Files

Wizcon for Windows & Internet 8.2
<table>
<thead>
<tr>
<th>File Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPT*.DAT</td>
<td>Contains the layout of the fields in the report.</td>
</tr>
<tr>
<td>*@RC</td>
<td>Recipe model.</td>
</tr>
<tr>
<td>&quot;model name&quot;.???</td>
<td>Recipe file.</td>
</tr>
<tr>
<td>*.GLS</td>
<td>Contains tag lists in ASCII format.</td>
</tr>
<tr>
<td>*.ALS</td>
<td>Contains alarm list in ASCII format.</td>
</tr>
<tr>
<td>*.WNT</td>
<td>Trend Profile for the Trend wizlet.</td>
</tr>
<tr>
<td>*.WNA</td>
<td>Event Summary Profile for the Alarm Viewer wizlet.</td>
</tr>
<tr>
<td>*.WNP</td>
<td>Picture file for the Picture Viewer wizlet</td>
</tr>
</tbody>
</table>
Appendix B Wiztune.dat File

About this appendix:

This appendix describes Wiztune parameters, as follows:

Overview on page B-2, describes the WizeTune.dat File and how it is accessed
Wiztune.dat Parameters on page B-8, is a lists all WizeTune.dat files.
Overview

The application tuning parameters can be used to optimize performance and enhance functionality.

Each building block has its own tuning parameters which can be accessed by right clicking its container in the All Containers section in the Application Studio and selecting Properties from the displayed popup menu. For example, right clicking Alarms and selecting Properties from the popup menu, displays the Alarms Properties dialog box.

Each field in the dialog box represents an alarm tuning parameter.

When a change to a tuning parameter in the Properties dialog box of a specific building block is made, it is reflected in the wiztune.dat file located in the c:\application\proj directory. Parameters that were not displayed in the file before being modified are displayed after modification.

You can access the wiztune.dat file and change an entry back to the application default. You can also tune a parameter directly into the file.

The following is a list of all the application tuning parameters, their locations, default values and the field they represent in the containers Properties dialog box. Also defined is whether a change can be defined online or if the application should be restarted for changes to take effect.

Note: The wiztune.dat file is used to add tuning parameters to an application. Certain parameters can change the behavior of the application or its features. The wiztune.dat file is saved in the application's folder and is an integral part of the application.
Accessing the Wiztune.dat File

More than one way can be used to access this file.

To access the Wiztune.dat file, do the following:

In the Application Studio All Containers pane right click the application name and select Open Tuning Parameters File. The Wiztune.dat file will open in Notepad on your screen.

Or,

In the application folder create a Wiztune.dat file and then open it using a text editor.

WIZTUNE.DAT

The changes you make in the Tuning Parameters are recorded in the WIZTUNE.DAT file. This file contains all of the application environmental parameters and their current values.

The WIZTUNE.DAT file is an ASCII file that can be edited using any text editor.
The following is an example of the WIZTUNE.DAT file

```
; FILE: WIZTUNE.DAT
; APPLICATION ENVIRONMENT DEFINITION FILE
; All atoms can be dynamically changed and retrieved by:
; WizGetEnv() and WizSetEnv() APIs.
;********************************************************************************
;********************************************************************************
; Syntax:
; Lines that start with ";;" are comments, empty lines are
; ignored. Lines without the character '=' are also ignored.
; Spaces before/after the '=' sign are not significant.
;********************************************************************************
;********************************************************************************
; Limitations:
; 1. Total number of lines (ALL lines) in the file is
; limited to 200.
; 2. The name of an environment variable is limited to 32
; characters.
;********************************************************************************
```
=== Manager Variables ===

; Automatic recover to last state after crash (power failure, etc.)
; Default is NO.
AUTORESTART=YES

; Default user when starting APPLICATION
; Format is User.Password or "*" for last user.
; Default is "No User".
; For example:
DEFAULTUSER=hello.world

; Put APPLICATION in the system task list?
; Default is YES.
INTASKLIST=YES

Login & Logout alarm text.
; If missing, the corresponding alarm will not be generated.
; $U represents the current user name.
LOGIN_TEXT=$U logged-in.
LOGOUT_TEXT=$U logged-out.

; Determine if a message will appear after you made changes in
; a layout and then exited.
; Default is YES.
ASKSAVELAYOUT=YES

; Determine if the done-bar will appear for a large job execution.
; Default is YES.
SHOWDONEBAR=YES
Appendix B Wiztune.dat File

Wizcon for Windows & Internet 8.2

============= Image VP Variables =============
; Image update rate, in milliseconds.
; Defaults are: MinWait=10, MaxWait=2000.
IMGMINWAIT=10
IMGMAXWAIT=2000
; IMG: size of (collapsed) buffer for receiving msgs from WizPro.
; Must be in the range 5 to 500 (default is 100).
IMGWIZMSGBUF=100
; Define object blink rate parameters (fast, medium, slow).
IMG_BLINKRATES=500 1000 2000
; Determine if trigger object will be highlighted when selected.
; Default is NO.
TRG_FEEDBACK=NO
; Determine if clicking on overlapping triggers will activate
; the top or bottom object. Default is TOP.
TRG_ACTIVATE=BOTTOM

================ Event Summary VP Variables =============
; Event Summary action when double-clicking on alarm.
; Can be ASSIST or ACK. Default is ASSIST.
ANN_DOUBLE_CLICK=ASSIST

============= WizPro Variables =============
; WizPro Logger flush rate, in seconds (historic files.)
; Default is 30, maximum is 3600.
LGRFLSHTIME=30
; WizPro Logger buffer size, in lines (records) (historic files).
; Default is 124, maximum is 2048.
LGRBUFSIZE=124
; Alarm generator will not generate new alarms while condition is TRUE
; and alarm is force-ended (or auto-ended), if this variable is
; set to YES. (Default is NO).
ALGEN_REGARD_STATE=NO
; WizPro will load this recipe, at startup.
STARTUP_RECIPE=LOADME.1ST
; ALARM_PRT_CONDENSE contains the escape sequence sent to printer
; before each alarm. Consists of decimal ASCII codes separated by commas.
; For example, if the code ESC 7 (digit 7, ASCII 55) is to be sent,
; use ALARM_PRT_CONDENSE=27,55. If the variable is not defined,
; ASCII 15 (<Ctrl>O) is used. To suppress any condense character
; before alarms, use "ALARM_PRTCONDENSE=".
; ALARM_PRT_2_LINES - if YES is specified, alarm printing will be
; divided into two lines, with alarm text on the second line.
ALARM_PRT_CONDENSE=15
ALARM_PRT_2_LINES=NO
**Wiztune.dat Parameters**

The following are application parameters and the values that they can receive.

**ALERT_END_USER_ABOVE_ACK**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables the Force End operation in the User field of the Events Summary (displaying which user ended or acknowledged an Alarm)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>NO</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>NO</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Events Summaries -&gt; (right) Properties -&gt; General -&gt; Show Force End User</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### ALERT_PRT_CONDENSE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event font format print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables printer to print alarms in a smaller font</td>
</tr>
<tr>
<td>Value Type</td>
<td>Text</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>[ASCII code], [ASCII code], …</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>See Notes</td>
</tr>
<tr>
<td>Notes</td>
<td>ALERT_PRT_CONDENSE=27,55 sends the message “ESC 7”. (In ASCII code 27-&gt; ESC and 55-&gt;7).</td>
</tr>
<tr>
<td>Via Application</td>
<td>Alarms -&gt; (right) Properties -&gt; Printer -&gt; Alarm printer escape sequence</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### ALERT_TIME_FORMAT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm date event format time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Selects the day or date and time format for an alarm</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Day and Time</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>See Notes</td>
</tr>
<tr>
<td>Notes</td>
<td>Four possible values (formats): DAY + TIME, DAY + TIME + MILLISECONDS, DATE + TIME, DATE + TIME + MILLISECONDS</td>
</tr>
<tr>
<td>Via Application</td>
<td>Alarms -&gt; (right) Properties -&gt; Time Format</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### ALGEN_REGARD_STATE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Prevents generation of new alarms if an alarm condition remains true and the alarm is defined as auto-ended</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Alarms -&gt; (right) Properties -&gt; General -&gt; Avoid generating new alarms</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### ANN_AUTO_SCROLL_TO_TOP

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Causes Events Summary to scroll to top automatically to show new alarms</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Events Summaries -&gt; (right) Properties -&gt; General -&gt; Scroll alarm list</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
**ANN_DOUBLE_CLICK**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Obtains additional information (ASSIST) and/or acknowledges (ACK) an alarm upon double-clicking the alarm in the Event Summary</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Assist</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Assist</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Ack</td>
</tr>
<tr>
<td>Value 3 min</td>
<td>AckAss</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Events Summaries -&gt; (right) Properties -&gt; General -&gt; Alarm help text status</td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>

**ANN_FONT_SIZE**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event font</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets the font size for alarm titles, text and messages in the Event Summary</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>From system</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>See Notes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>See Notes</td>
</tr>
<tr>
<td>Notes</td>
<td>The size limits depends on the font type</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### ASKSAVE LAYOUT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enable system to prompt to save the Layout before exiting the application</td>
</tr>
<tr>
<td>Value Type</td>
<td>Yes</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Layouts -&gt; (right) Properties -&gt; Prompt to save layout</td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>

### ASSIST HELP BUTTON

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables displaying the Help button on the ANN window for Events Summaries</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Events Summaries -&gt; (right) New Events Summary - &gt; (highlight alarm) Operations -&gt; Assist</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## ASSIST_PRINT_BUTTON

<table>
<thead>
<tr>
<th><strong>Keywords</strong></th>
<th>Alarm event print</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Enables displaying the Print button on the ANN window for the Event Summaries</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Enumerated</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
<td>No</td>
</tr>
<tr>
<td><strong>Via Application</strong></td>
<td>Events Summaries -&gt; (right) New Events Summary -</td>
</tr>
<tr>
<td><strong>Menu</strong></td>
<td>&gt; (highlight alarm) Operations -&gt; Assist</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>

## AUDIT_TRAIL_DSN_NAME

<table>
<thead>
<tr>
<th><strong>Keywords</strong></th>
<th>Audit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Selects the name of the database file to hold the log data</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Enumerated</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>---</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>See Notes</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>Twelve possible values (file types): dBASE files, dBASE files - Word, Excel files, FoxPro files - Word, odbc_name</td>
</tr>
<tr>
<td><strong>Via Application</strong></td>
<td>Application -&gt; (right) Station Properties -&gt; Audit Trail</td>
</tr>
<tr>
<td><strong>Menu</strong></td>
<td>-&gt; Current Data Source</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>No</td>
</tr>
</tbody>
</table>
## AUDIT_TRAIL_ENABLE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Audit database tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables logging operator actions in the form of tag values to an ODBC data source.</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application</td>
<td>Application -&gt; (right) Station Properties -&gt; Audit Trail - &gt; Enable Audit Trail</td>
</tr>
<tr>
<td>Menu</td>
<td>&gt; Enable Audit Trail</td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>

## AUTORESTART

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables automatic recovery to the last stable state after a system crash</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Via Application</td>
<td>Application -&gt; (right) Station Properties -&gt; General -&gt; Auto Restart after an illegal shutdown</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>
### CHART_SCALE_EXTRA_WIDTH

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets the width of the space containing the vertical scale for charts</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>0</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>---</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CHR_MULTIMARKERS

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables a different color for each marker (up to ten markers) for the &quot;Line with marker&quot; and &quot;Marker only&quot; type charts</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Charts -&gt; (right) Properties -&gt; Multi Markers -&gt; Use chart multi markers</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### CHR_SHOW_COMPRESSION_WARNING

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Displays a warning message whenever data compression occurs for a chart</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### COMMERR_TIMEOUT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the time out (in seconds) due to a communication error</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>30</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>5</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>180</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### DEFAULTUSER

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Login start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables selection of the user name for automatic login in application startup</td>
</tr>
<tr>
<td>Value Type</td>
<td>Text</td>
</tr>
<tr>
<td>Default Value</td>
<td>---</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>User,password</td>
</tr>
<tr>
<td>Notes</td>
<td>Default requires user to supply password on login. Use * for last user.</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Application -&gt; (right) Station Properties -&gt; Default User</td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>

### DRAW_EXCLUSIVE_RECT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Draws a rectangle without a border</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Notes</td>
<td>This parameter is used for backward compatibility with OS/2.</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### DRV_TIMEOUT_FACTOR

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the driver timeout in milliseconds by adding 5000 ms to the value of this parameter.</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>25</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>200</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### FULL_SECURE_LOGOFF

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Logout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Reinstates full system security when the current user logs out of the system</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>
### HOTBACKUP_UPDATE_ALARMS

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm backup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables backup station to update online alerts from the master station</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### HOTBACKUP_UPDATE_TAGS

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Backup tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables backup station to update tags from master station</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMG_BLINKRATES

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the blinking rate in ms for dynamic objects (ie the amount of time the object is visible)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>500 1000 2000</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>100</td>
</tr>
<tr>
<td>Notes</td>
<td>Format: IMG_BLINKRATES=fast# medium# slow#</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; Dynamic -&gt; Fast or Medium or Slow</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IMG_CLUSTER_LEFT_DRAGDROP

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables drag/drop from cluster library using left mouse button</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Notes</td>
<td>This parameter maintained compatibility between Windows and OS/2.</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMG_CLUSTERS_USE_LAYER

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables cluster to be used with layer support</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IMG_EDIT_REFRESH

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables an image to be repainted automatically after editing operations</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; View -&gt; Repaint images after editing operations</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>
## IMG_FAST_ZONE_THRESHOLD

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Sets the maximum time interval (in milliseconds) to draw the background for a fast zone (i.e., drawing the background of a slow zone takes longer)</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Numeric</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>2500</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>0</td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
<td>32000</td>
</tr>
<tr>
<td><strong>Via Application</strong></td>
<td>Images -&gt; (right) Properties -&gt; Fast Zone -&gt; Fast zone threshold</td>
</tr>
<tr>
<td><strong>Menu</strong></td>
<td>Images -&gt; (right) Properties -&gt; Fast Zone -&gt; Fast zone threshold</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>

## IMG_FONT_H

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Font Image</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Controls the height of true type fonts</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Numeric</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>1000</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>14</td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
<td>1000</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>This parameter applies to the Chinese and Japanese versions.</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMG_FONT_W

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Font Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Controls the width of true type fonts</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>1000</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>14</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>1000</td>
</tr>
<tr>
<td>Notes</td>
<td>This parameter applies to the Chinese and Japanese versions.</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IMG_GRAD_STEP

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the number of steps in the color gradient for images</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>16</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>2</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>255</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; View -&gt; Number of gradient color steps</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>
### IMG_HIGHLIGHT_ON_SELECTION

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Determines if the selected object is drawn in a contrasting color</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Enumerated</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>No</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>No</td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IMG_MAX_FAST_ZONES

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Determines the limit of the number of fast zone bitmaps to be kept in a single window memory cache (least recently used bitmap is removed)</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Numeric</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>0</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>0</td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
<td>50</td>
</tr>
<tr>
<td><strong>Via Application</strong></td>
<td>Images -&gt; (right) Properties -&gt; Fast Zone -&gt; Maximum fast zones</td>
</tr>
<tr>
<td><strong>Menu</strong></td>
<td>Maximum fast zones</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMG_MONO_FONT_H

| Keywords       | Font Image                  |
|               |                             |
| Purpose       | Controls the height for monospace fonts |
| Value Type    | Numeric         |
| Default Value | 1000                      |
| Value 1/ min  | 14                        |
| Value 2/ min  | 1000                      |
| Notes         | This parameter applies to the Chinese and Japanese versions. |
| Restart required | Yes                     |

### IMG_MONO_FONT_W

| Keywords       | Font Image                  |
|               |                             |
| Purpose       | Controls the width for monospace fonts |
| Value Type    | Numeric         |
| Default Value | 1000                      |
| Value 1/ min  | 14                        |
| Value 2/ min  | 1000                      |
| Notes         | This parameter applies to the Chinese and Japanese versions. |
| Restart required | Yes                     |
### IMG_MULTI_SELECT_IF_ALL

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Selects the object within the image only if selection rectangle covers the entire object</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Notes</td>
<td>The value NO selects an object that is only partially included within the selection rectangle</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IMG_PARSEONLOAD

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image network tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables parsing names of Network tags during loading of Images (disabling shortens image load time, but does not check validity of network tags)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Images -&gt; (right) Properties -&gt; Loading -&gt; Parse each image when loading</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMG_POOLSIZE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets the amount of memory available for image objects</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>150</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>60</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>600</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Images -&gt; (right) Properties -&gt; Loading -&gt; Images memory pool size</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IMG_RESFACTOR

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets a global stretching or shrinking factor for all images (used to compensate images for resolution differences for hardware and operating systems)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>1</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0.1</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>10</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Images -&gt; (right) Properties -&gt; View -&gt; Resolution factor</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMG_SMALL.INPUT_BOX

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets the trigger button object as the small input box</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; Trigger -&gt; Trigger small input box</td>
</tr>
<tr>
<td>Menu</td>
<td>Images -&gt; (right) Properties -&gt; Trigger small input box</td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>

### IMG_STOP.UPDATE_ON_TRG

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image tag trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables the image to stop updating values of tags while momentary trigger is executed</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMG_TRG_KEYPAD

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables using keypad for triggers requiring numeric data entry</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IMG_USE_SEPARATOR

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets group symbol for digits (in thousands) for tag displays</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Notes</td>
<td>The default grouping symbol for the operating system is used</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMGMAXWAIT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets the maximum time interval (in milliseconds) to wait before updating an image</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>2000</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>---</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; Rates -&gt; Maximum</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IMGMINWAIT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets the minimum time interval (in milliseconds) to wait before updating an image</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>10</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1-</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>---</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; Rates -&gt; Minimum</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### IMGWIZMSGBUF

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm buffer image space tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the size (in messages) of the message buffer that images use to collapse tag/alarm notification messages received by WizPro</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>20</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>5</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>500</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Images -&gt; (right) Properties -&gt; Rates -&gt; Size of the internal message buffer that images use to collapse tag/alarm notification messages</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### LGRBUFSIZE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Buffer history space tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the WizPro logger buffer size (in lines/records) for history files</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>256</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>2048</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Tags -&gt; (right) Properties -&gt; Wizpro Logger -&gt; Buffer size</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
**LGRFLSHTIME**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>History Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Modifies the number of records that WizPro logs (flushes) to history files on disk (in seconds) in one operation</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>30</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>3600</td>
</tr>
<tr>
<td>Via Application</td>
<td>Tags -&gt; (right) Properties -&gt; Wizpro Logger -&gt; Flush rate</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**LOGGER_TIMEOUT**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Event history start wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the time interval (in seconds) that the logger waits during WizPro startup</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>2</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>2</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>10</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## LOGIN_TEXT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event login</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the text to appear for login alarms</td>
</tr>
<tr>
<td>Value Type</td>
<td>Text</td>
</tr>
<tr>
<td>Default Value</td>
<td>---</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Text</td>
</tr>
<tr>
<td>Via Application</td>
<td>Alarms -&gt; (right) Properties -&gt; General -&gt; Login Alarm Text</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

## LOGOUT_TEXT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event logout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the text to appear for logout alarms</td>
</tr>
<tr>
<td>Value Type</td>
<td>Text</td>
</tr>
<tr>
<td>Default Value</td>
<td>---</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Text</td>
</tr>
<tr>
<td>Via Application</td>
<td>Alarms -&gt; (right) Properties -&gt; General -&gt; Logout Alarm Text</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
<tr>
<td><strong>MLS_RELOAD_OPEN_ALARMS</strong></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Keywords</strong></td>
<td>Alarm event</td>
</tr>
<tr>
<td><strong>Purpose</strong></td>
<td>Reloads alerts upon language switching</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Enumerated</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
<td>No</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>This parameter applies to version 7.6 and later versions</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>NET_BROADCAST_TIMEOUT</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keywords</strong></td>
</tr>
<tr>
<td><strong>Purpose</strong></td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
</tr>
</tbody>
</table>
### NET_CHECKRETRY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the time interval (in seconds) to wait between receiving messages from the host before the remote station pings the host</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>3</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>1000</td>
</tr>
<tr>
<td>Notes</td>
<td>It is recommended that all stations on the network use the same value for this parameter.</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### NET_CHECKTIMEOUT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the time interval (in seconds) to wait before beginning the network communication error-checking cycle</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>5</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>2</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>600</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
**NET_COM_ERR_POPUP**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network popup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines if to show a popup window to signal a communication failure</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Network -&gt; Network Properties -&gt; Protocol -&gt; Show popup window on communication errors</td>
</tr>
<tr>
<td>Via Application</td>
<td>Application Network -&gt; Protocol -&gt; Show popup window on communication errors</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**NET_COMMCHECK**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>This parameter turns on/off the network communication checking mechanism</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### NET_HOTBACKUP_ADDR

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Backup network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Establishes the link between a master station and its backup station</td>
</tr>
<tr>
<td>Value Type</td>
<td>Address</td>
</tr>
<tr>
<td>Default Value</td>
<td>---</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>TCP/IP address</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>TCP/IP address</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Network -&gt; Network Properties -&gt; Backup -&gt; Backup Properties -&gt; TCP/IP address. Master station shows Backup</td>
</tr>
<tr>
<td>Via Application</td>
<td>Application Network -&gt; Backup -&gt; Backup Properties -&gt; TCP/IP address</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### NET_HOTBACKUP_MAXPAUSETIME

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Backup network wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the time interval (in seconds) that a backup station should wait in pause mode before automatically assuming active station status</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>60</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>10</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>3600</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### NET_HOTBACKUP_MODE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Backup network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the hotbackup switching mode</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Auto</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Auto</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Manual</td>
</tr>
<tr>
<td>Value 3</td>
<td>Disabled</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Network -&gt; Network Properties -&gt; Backup -&gt; Hot-Backup mode. The Backup station can only be manually activated by using the SetBackup mode API in an add-on.</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Application Network -&gt; Backup -&gt; Hot-Backup mode</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### NET_HOTBACKUP_UPDATE_STATION

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Backup network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines which station (Master or Backup) should be updated from the other when re-establishing communication</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Backup</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Backup</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Master</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### NET_LAN_ADPTR_NUM

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Not used for current application configuration</td>
</tr>
<tr>
<td>Restart required</td>
<td>%%%</td>
</tr>
</tbody>
</table>

### NET_MAXCHANGESDELAY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Buffer network wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the maximum number of messages that a source station accumulates before sending the data buffer to a target station</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>48</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Network -&gt; Network Properties -&gt; General -&gt; Message Control -&gt; Maximum network changes delay</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Via Application Menu Application Network -&gt; General -&gt; Message Control -&gt; Maximum network changes delay</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### NET_MAXTIMEDELAY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm network tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the maximum time interval (in milliseconds) that a station delays before updating the other stations with tag and alarm changes</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>1000</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>50</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Unlimited</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Network -&gt; Network Properties -&gt; General -&gt; Message Control -&gt; Maximum network time delay</td>
</tr>
<tr>
<td>Via Application</td>
<td>Application Network -&gt; General -&gt; Message Control - &gt; Maximum network time delay</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### NET_NOBROADCAST

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>If this parameter appears in Wiztune.dat with YES value, than NO BROADCAST mode is set. In this mode a broadcast signal is not sent to any station</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### NET_PINGCHECK

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>This parameter turns on/off checking remote stations with help of ping mechanism (ICMP packet)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### NET_PINGRETRY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>This parameter sets the count of ping retries to check a station. After this count (of retries) a communication error will be recognized</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>0</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>500</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### NET_PINGTIMEOUT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Wait</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Sets the maximum time interval (in seconds) for the station to wait for a response to a ping</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>3</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>500</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>

### NET_PROTOCOL

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Selects the network protocol for the application</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>NPITCP</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>NPITCP</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>NPINTBS</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>OR Network -&gt; Network Properties -&gt; Protocol -&gt; Protocol. The possible values: NPINTBS (Netbios); NPITCP (TCP/IP)</td>
</tr>
<tr>
<td><strong>Via Application Menu</strong></td>
<td>Application Network -&gt; Protocol -&gt; Protocol</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>
### NET_QUERY_ADD_TIMEOUT_RETRY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>This parameter defines the count of additional timeouts for an answer waiting in a remote station</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>10</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>10</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### NET_QUERY_TIMEOUT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets the network query timeout in seconds</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>6</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>60</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Network -&gt; Network Properties -&gt; General -&gt; Message Control -&gt; Maximum network answer time delay</td>
</tr>
<tr>
<td>Via Application</td>
<td>Application Network -&gt; General -&gt; Message Control - &gt; Maximum network answer time delay</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## NETWORK

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network wait</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Determines whether the application network module is activated to enable access to application stations on the network</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Enumerated</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
<td>No</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>OR Network -&gt; Network Properties -&gt; General -&gt; Activate Network</td>
</tr>
<tr>
<td><strong>Via Application Menu</strong></td>
<td>Application Network -&gt; General -&gt; Activate Network</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>

## NEW_DBF_DATE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Not used for current application configuration</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>
### OLD_NET_USER_AUTH

<table>
<thead>
<tr>
<th>Keywords</th>
<th>User management network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>If this parameter is set to YES stations with old versions have full authorization to perform operations on local stations. When set to NO - there is no authorization</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### PLUG_START_MESSAGE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines whether to show the message of the demo model if the plug is not installed</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
**PREFIX_SPACE**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format image space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines if a digital display contains space for the &quot;+&quot; / &quot;-&quot; prefix</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**PRINT_TO_RIGHT**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables report printing alignment to the left</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Notes</td>
<td>This applies to the Israeli version</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## PRINTER_FORMAT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines which printer format should be used: DOS (Printer) or WINDOWS (File)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>DOS</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>DOS</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Windows</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

## PRINTER_LINE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines alarm message line width when sent to printer (Hebrew-enabled NT only)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>---</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>---</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Compressed</td>
</tr>
<tr>
<td>Notes</td>
<td>The default width is 130 characters; the compressed width is 94 characters</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### RECIPEPERGATE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Recipe tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables the processing of values according to the tag associated with the appropriate address in the recipe block</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Via Application</td>
<td>Model Recipes -&gt; (right) Properties -&gt; General -&gt;</td>
</tr>
<tr>
<td>Menu</td>
<td>Process each value according to its tag</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### SHOWDONEBAR

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Studio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines if the Background processing dialog box can appear when large tasks are being executed</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Via Application</td>
<td>Application -&gt; (right) Station Properties -&gt; Show done bar</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## STARTUP_RECIPE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Recipe start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the name of a recipe that will be loaded during application startup</td>
</tr>
<tr>
<td>Value Type</td>
<td>File name</td>
</tr>
<tr>
<td>Default Value</td>
<td>---</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>---</td>
</tr>
<tr>
<td>Notes</td>
<td>The WizPro logger and alarm generator will be activated only after the specified recipe is loaded</td>
</tr>
</tbody>
</table>

**Via Application Menu**
Model Recipes -> (right) Properties -> General -> Startup Recipe

**Restart required**
Yes

## TRG_ACTIVATE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines which trigger-object is activated when two objects are overlapping</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>TOP</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>TOP</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Bottom</td>
</tr>
</tbody>
</table>

**Via Application Menu**
Images -> (right) Properties -> Trigger -> State

**Restart required**
Yes
### TRG_FEEDBACK

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines whether trigger objects are highlighted when the object is clicked and the mouse button held down</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; Trigger -&gt; Highlight -&gt; Trigger object</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### TRG_TEST_ON_MOVE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Image trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines whether the mouse pointer is highlighted when moved on top of an Image trigger object</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; Trigger -&gt; Highlight -&gt; Mouse pointer on triggers</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### TRIGGER_BUTTONS_TIMEOUT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Trigger wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the time interval (in milliseconds) to make a selection after accessing a trigger button dialog, and before automatically closing button dialog</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>20</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>99999</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### VFI

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Sets the format for tag history files by selecting the Virtual File Interface DLL</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>VFI5FST, VFI5CB</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>VFI5CB</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>VFI5FST</td>
</tr>
<tr>
<td>Notes</td>
<td>VFI5FST can be used only for tag history files. Both values can be used simultaneously</td>
</tr>
<tr>
<td>Via Application</td>
<td>Wiz -&gt; (right) Station Properties -&gt; VFI -&gt; Allows you to determine the format for history files by selecting Virtual File Interface</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### TRG_VISKEY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Not used for current application configuration</td>
</tr>
<tr>
<td>Restart required</td>
<td>%%%%</td>
</tr>
</tbody>
</table>

### VFI_DAYS_PER_FILE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines how many days of data will be archived into each history file</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>1</td>
</tr>
<tr>
<td>Value 1/min</td>
<td>1</td>
</tr>
<tr>
<td>Value 2/min</td>
<td>49</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### VFI5FST_IDX_SEC

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the time interval represented by a time index</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>60</td>
</tr>
<tr>
<td>Notes</td>
<td>A value of 60 represents 1 index per minute. (VFI5FST_IDX_SEC is the recommended parameter; VFI5FSTT_IDX_SEC is for backward compatibility only)</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Appendix B Wiztune.dat File  Wizcon for Windows & Internet 8.2
### VFI5FST_MODE_TIMESTAMP

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines if VFIFST supports both sorted and unsorted time stamps</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Notes</td>
<td>NO supports only sorted timestamps. (VFI5FST_MODE_TIMESTAMP is the recommended parameter)</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### VFI5FST_NO_COMM_ERR

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Disables writing communication errors to history</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Notes</td>
<td>No, writes the errors to history. (VFI5FST_NO_COMM is the recommended parameter; VFI5FSTT_NO_COMM is for backward compatibility only)</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### VFI5FST_WRITE_BACK

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines if the VFIFST make optimizations in the history files while reading them (writing back of next record pointers)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Notes</td>
<td>VFI5FST_WRITE_BACK is the recommended parameter; VFI5FSTT_WRITE_BACK is for backward compatibility only</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### VFI5FSTT_IDX_SEC

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the time interval represented by a time index</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>60</td>
</tr>
<tr>
<td>Notes</td>
<td>A value of 60 represents 1 index per minute. (VFI5FST_IDX_SEC is the recommended parameter; VFI5FSTT_IDX_SEC is for backward compatibility only)</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### VFI5FSTT_MODE_TIMESTAMP

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines if VFIFST supports both sorted and unsorted time stamps</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Notes</td>
<td>NO supports only sorted timestamps. (VFI5FST_MODE_TIMESTAMP is the recommended parameter)</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### VFI5FSTT_NO_COMM_ERR

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Disables writing communication errors to history</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Notes</td>
<td>No writes the errors to history. (VFI5FST_NO_COMM is the recommended parameter; VFI5FSTT_NO_COMM is for backward compatibility only)</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### VFI5FSTT_WRITE_BACK

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Format history</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines if the VFIFST will make optimizations in the history files while reading them (writing back of next record pointers)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Via Application</td>
<td>VFI5FST_WRITE_BACK is the recommended parameter; VFI5FSTT_WRITE_BACK is for backward</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### WIL_DISK_HIGH_LIMIT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event history space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the maximum disk space limit after which old history files are deleted</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>97</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>100</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## WIL_DISK_LOW_LIMIT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event history space start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the setpoint at which a warning message is generated concerning low free disk space</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>75</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>0</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>100</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

## WIZ_DATE_FORMAT

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Date format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the application date format</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>W</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1 See Notes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>6 See Notes</td>
</tr>
<tr>
<td>Notes</td>
<td>Six possible values: 1 - DDMMYY, 2 - MMDDYY, 3 - YYMMDD, 4 - DDMMYYYY, 5 - MMDDYYYY, 6 - YYYYMMDD</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Application -&gt; (right) Station Properties -&gt; Date Format -&gt; Date style</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### WIZ_DATE_SEPARATOR

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Date format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the separator character for the application date format</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>1</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1 See Notes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>3 See Notes</td>
</tr>
<tr>
<td>Notes</td>
<td>Three possible values: 1 - slash (/) , 2 - dot (.), 3 - dash (-)</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Application -&gt; (right) Station Properties -&gt; Date Format -&gt; Date separator</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### WIZ_SHOWMMW

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Date format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines whether to show the Quick Access bar</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>No</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### WIZDDES_TOPIC_NAME

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Database format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the topic name for the dde address format (application/Gate'A1 or Wizcon!'A1)</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Gate</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Gate</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Tag</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### WIZNET_ANN_PROF_DIRECTORY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm directory event folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the location of the Events Summary Profiles files relative to the web application root directory</td>
</tr>
<tr>
<td>Value Type</td>
<td>Folder/directory name</td>
</tr>
<tr>
<td>Default Value</td>
<td>AnnPrf</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Folder/directory name</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Web Application -&gt; (right) Properties -&gt; Events Summary Profiles -&gt; Location of Events Summary Profile file relative to the web application root directory</td>
</tr>
<tr>
<td>Via Application</td>
<td>Events Summary Profiles -&gt; (right) Properties -&gt; Location of Events Summary</td>
</tr>
<tr>
<td>Menu</td>
<td>Location of Events Summary</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## WIZNET_HIS_CACHE_DAYS

<table>
<thead>
<tr>
<th>Keywords</th>
<th>History time trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the maximum number of days of stored history files</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>10</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>365</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Web Application -&gt; (right) Properties -&gt; History -&gt; Cache Settings -&gt; Cache the last</td>
</tr>
<tr>
<td>Via Application</td>
<td>Trends Profiles -&gt; (right) Properties -&gt; History -&gt; Cache Settings -&gt; Cache the last</td>
</tr>
<tr>
<td>Menu</td>
<td>Restart required Yes</td>
</tr>
</tbody>
</table>

## WIZNET_IMAGE_DIRECTORY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Directory folder image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the location of the picture files relative to the web application root directory</td>
</tr>
<tr>
<td>Value Type</td>
<td>Folder/directory name</td>
</tr>
<tr>
<td>Default Value</td>
<td>Pictures</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Folder/directory name</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Web Application -&gt; (right) Properties -&gt; Pictures -&gt; Location of Picture files relative to the web application root directory</td>
</tr>
<tr>
<td>Via Application</td>
<td>Images -&gt; (right) Properties -&gt; Pictures -&gt; Location of Picture files relative to the web application root directory</td>
</tr>
<tr>
<td>Menu</td>
<td>Restart required No</td>
</tr>
</tbody>
</table>

Appendix B Wiztune.dat File  Wizcon for Windows & Internet 8.2
### WIZNET_MAXCHANGEDELAY

<table>
<thead>
<tr>
<th><strong>Keywords</strong></th>
<th>Network wait</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td>Defines the maximum number of messages accumulated by a source station before sending them to a client</td>
</tr>
<tr>
<td><strong>Value Type</strong></td>
<td>Numeric</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>48</td>
</tr>
<tr>
<td><strong>Value 1/ min</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Value 2/ min</strong></td>
<td>50</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>OR Network -&gt; Network Properties -&gt; Internet -&gt; Maximum number of messages delayed</td>
</tr>
<tr>
<td><strong>Via Application Menu</strong></td>
<td>Application Network -&gt; Internet -&gt; Maximum number of messages delayed</td>
</tr>
<tr>
<td><strong>Restart required</strong></td>
<td>Yes</td>
</tr>
</tbody>
</table>
### WIZNET_MAXTIMEDELAY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Network wait</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Determines the maximum time interval (in milliseconds) that a station will delay before updating the other stations with tag and alarm changes</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>1000</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>50</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>1000</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Network -&gt; Network Properties -&gt; Internet -&gt; Maximum time a message could be delayed</td>
</tr>
<tr>
<td>Via Application</td>
<td>Application Network -&gt; Internet -&gt; Maximum time a message could be delayed</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### WIZNET_MIN_FREE_DISK

<table>
<thead>
<tr>
<th>Keywords</th>
<th>History space trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the minimum amount of storage (in megabytes) reserved as free space</td>
</tr>
<tr>
<td>Value Type</td>
<td>Numeric</td>
</tr>
<tr>
<td>Default Value</td>
<td>20</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>1</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>1024</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Web Application -&gt; (right) Properties -&gt; History -&gt; Cache Settings -&gt; Keep at least</td>
</tr>
<tr>
<td>Via Application</td>
<td>Trends Profiles -&gt; (right) Properties -&gt; History -&gt; Cache Settings -&gt; Keep at least</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### WIZNET_ROOT_DIRECTORY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Directory folder network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the name of the root directory for application objects</td>
</tr>
<tr>
<td>Value Type</td>
<td>Folder/directory name</td>
</tr>
<tr>
<td>Default Value</td>
<td>Docs</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Folder/directory name</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Web Application -&gt; (right) Properties -&gt; General -&gt; Web Application root directory</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>HTML -&gt; (right) Properties -&gt; HTML files -&gt; Web Application root directory</td>
</tr>
<tr>
<td>Menu</td>
<td>Application root directory</td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>

### WIZNET_TREND_PROF_DIRECTORY

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Directory folder trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the location of the Trend profiles files relative to the web application root directory</td>
</tr>
<tr>
<td>Value Type</td>
<td>Folder/directory name</td>
</tr>
<tr>
<td>Default Value</td>
<td>TrendPrf</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Folder/directory name</td>
</tr>
<tr>
<td>Notes</td>
<td>OR Web Application -&gt; (right) Properties -&gt; Trends Profiles -&gt; Location of Trend Profile files relative to the web application root</td>
</tr>
<tr>
<td>Via Application Menu</td>
<td>Trends Profiles -&gt; (right) Properties -&gt; Trends Profiles -&gt; Location of Trend Profile files relative to the web application root directory</td>
</tr>
<tr>
<td>Restart required</td>
<td>No</td>
</tr>
</tbody>
</table>
### WIZPRO_VPI_ROUND

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Modify values from VPI to prevent roundoff errors for float tag values</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### WIZSQL_INTERFACE

<table>
<thead>
<tr>
<th>Keywords</th>
<th>SQL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the interface used to connect the data file</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Oracle</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Oracle</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>ODBC</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### WIZSQL_ODBC_ATTRIBUTES

<table>
<thead>
<tr>
<th>Keywords</th>
<th>SQL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the data source name</td>
</tr>
<tr>
<td>Value Type</td>
<td>Text</td>
</tr>
<tr>
<td>Default Value</td>
<td>---</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Name of data source</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### WIZSQL_ODBC_CODE

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keywords</td>
<td>SQL</td>
</tr>
<tr>
<td>Purpose</td>
<td>Not used for current application configuration</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### WRITE_FORMAT

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keywords</td>
<td>Alarm event format</td>
</tr>
<tr>
<td>Purpose</td>
<td>Defines the format right-to-left (RTL) or left-to-right (LTR) applying to alert message strings in Hebrew-enabled system</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>LTR</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>LTR</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>RTL</td>
</tr>
<tr>
<td>Notes</td>
<td>This parameter applies to the Israeli version</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### ALERT_PRT_2_LINES

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event format print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enables alarm information to be printed on two lines: first line - title, timestamp, etc.; second line - alarm text</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>No</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>No</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>Yes</td>
</tr>
<tr>
<td>Via Application</td>
<td>Events Summaries -&gt; (right) Properties -&gt; General -&gt; Show Force End User</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### ALERT_PRINTER_TARGET

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Alarm event print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Defines the real target for alarm output which is to the printer or file</td>
</tr>
<tr>
<td>Value Type</td>
<td>Enumerated</td>
</tr>
<tr>
<td>Default Value</td>
<td>Printer Name</td>
</tr>
<tr>
<td>Value 1/ min</td>
<td>Printer Name</td>
</tr>
<tr>
<td>Value 2/ min</td>
<td>File Name</td>
</tr>
<tr>
<td>Restart required</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Appendix C VFI5FST (VFI Fast)

About this appendix:

This appendix describes the VFI5FST feature, as follows:

Advanced User Information on page C-2 provides information about the VFI5FST feature.

VFI5FST Tuning Parameters on page C-3 describes the VFI5FST tuning parameters.
Advanced User Information

Records in the VFI5FST data file cannot be written sorted by time since the application enables timestamps in drivers and on the network. If an application does not use external timestamps (drivers receiving values with timestamps from a PLC, add-ons changing tag values with their timestamp, programs writing historical records directly to the VFI5FST using the WizVfi, APIs, hot-backup configuration), data can be written sorted by time (in a standalone configuration).

VFI5FST uses a non-dense time index file.

The index file holds a fixed number of indexes that point to record locations in the data file. The number of indexes is configurable (WIZTUNE.DAT parameter, see Appendix B Wiztune.dat File for more information). The data file is not ordered and therefore holds two indexes for each time interval:

- Index pointing to the first record with a time step larger or equal to the time index.
- Index pointing to the last record with a timestamp smaller or equal to the time of the index.

If a user has a history file for each day and requires an index in the file for each minute, the user will have a 1,440 minutes x 2 indexes/minute x 4 bytes/index = 11,520 bytes index file which is 691,200 bytes if 1 index/second.

The number of times indexes are used is determined when the file is created. When the file is used (read/write), the number of indexes is used.

VFI5FST enables more than one method for writing to history simultaneously (usually it is only one method which is the Wizpro logger).
**VFI5FST Tuning Parameters**

*Note: Always restart the application to save changes:*

**LGRBUFSIZE and LGRFLUSHTIME**

These parameters are common application parameters intended for tag history logging. For further details refer to Chapter 9, Tags.

- Buffer size indicates the buffer size used for the application logger and write operations of the VFI5FST. Advised size: 2,048.
- Flush rate influences the number of records written to the VFI in one write operation.

**VFI_DAYS_PER_FILE**

The parameters described below have no interface in the Application Studio and can be added to WIZTUNE.DAT using any text editor.

The VFI_DAYS_PER_FILE parameter defines how many days will be combined in each physical VFI5FST file in the disk. Default and recommended parameter is 1.

- **To define:**
  
  Add the following string to the WIZTUNE.DAT file:

  ```
  VFI_DAYS_PER_FILE = n
  ```

  Where n is number of days, maximum is 49 days / file for VFI5FST.

**VFI5FST_IDX_SEC, VFI5FSTT_IDX_SEC**

These parameters determine a time index for each VFI5FST_IDX_SEC second. Default is 60 (1 index / minute).

These parameters determine the size of the GTddmmyy.IDT files. (For example: a value of 60 will give an index file of 11Kb, a value of 1 will give an index file of 675Kb).

It is recommended to use VFI5FST_IDX_SEC.

VFI5FSTT_IDX_SEC is used for backward compatibility only.
To define:
Add the following string to the WIZTUNE.DAT file:

\[ \text{VFI5FST_IDX_SEC} = n \]

Where \( n \) is number of seconds between each time index.

**VFI5FST_WRITE_BACK, VFI5FSTT_WRITE_BACK**

These parameters define if the VFI5FST will optimize the history files when reading them (writing back next record pointers). Default is that optimization is performed.

To disable optimization during reading:
Add the following string to the WIZTUNE.DAT file:

\[ \text{VFI5FST_WRITE_BACK} = \text{NO} \]

To enable the optimization, remove this string from the WIZTUNE.DAT file. Disabling this option results in a faster first reading with the chart (when the chart opens), but slows down the next readings.

It is recommended to use VFI5FST_WRITE_BACK. VFI5FSTT_WRITE_BACK is used for backward compatibility only.

**VFI5FST_NO_COMM_ERR, VFI5FSTT_NO_COMM_ERR**

These parameters define if communication error values are written to history.

The default is that the communication error values are written to history. If this option is enabled, no communication error values will be written to the history files.

To define:
To disable communication error values logging to history, insert the following line in the WIZTUNE.DAT file:
To disable this option:

```
VFI5FST_NO_COMM_ERR= YES
```

To enable communication error values logging to history remove this string from WIZTUNE.DAT file. It is recommended to use VFI5FST_NO_COMM_ERR. VFI5FSTT_NO_COMM_ERR is used for backward compatibility only.

**VFI5FST_MODE_TIMESTAMP, VFI5FSTT_MODE_TIMESTAMP**

These parameters define if VFI5FST works in a mode that supports unsorted timestamps, or sorted timestamps only. The default is that this option is disabled and VFI5FST does not support non-sorted timestamps during reading. For example, by default VFI5FST, during reading, considers that data file is sorted by time.

This option must be enabled if the following timestamps are used:

- A driver that gets values with timestamps from a PLC.
- An add-on that changes tag values with their timestamp.
- A program that writes historical records directly to the VFI5FST (using the WizVfi… API's).
- Hot-backup configuration.

If you have this option disabled but work in a configuration that needs this option enabled, unusual behavior may occur in the chart during reading. For example, the graph's lines go in a backward direction, jump from point to point backwards as well as forwards.

To enable:

Enter the following line in your WIZTUNE.DAT file:

```
VFI5FST_MODE_TIMESTAMP= YES
```

This option has a big influence on history reading speed especially when the timestamps are scattered over the file (that is, totally unsorted) history reading might become very slow.
To disable unsorted timestamps:

Remove this string from the WIZTUNE.DAT file.

It is recommended to use the VFI5FST_MODE_TIMESTAMP. VFI5FSTT_MODE_TIMESTAMP is used for backward compatibility only.
Appendix D Application ASCII (ILS) File Format

About this appendix:

This appendix describes the structure and format of the application ASCII (ILS) file.  
Introduction on page D-2 discusses ASCII file format
Document Conventions on page D-3 lists the different conventions used in this format
**Introduction**

This document defines the format of the ILS file that can be created from the Image. The ILS file is an ASCII file that includes the descriptions of the image and of all its objects.

The following editing points should be noted:

Image ASCII files support #include statements. For example:

```
VERSION: 8.0
LAYERS:
"BASE"       1 2048 GROUP=0xffffffff
#include "LAYERs.ADD"
```

Comments can be inserted in one of two ways: using a semicolon (;) anywhere in the line, or by using /* to denote the beginning of a comment and */ to denote the end of the comment.

If you use a semicolon, the comment will be considered from the semicolon until the end of the line.

Comments denoted by /* and */ cannot be nested. For example, the following lines are erroneous:

```
/* This is the illustration
of the turbine engine
/* for the air blower, */
which runs on 220V */
```

Spaces and new lines are insignificant. You can insert as many spaces as you want between words and you do not have to divide the statements into lines.
This chapter uses four types of tokens:

1. Tokens that appear in the ILS file as is.
2. Composed token defined below the token.
3. Composed token definition defined below the token.
4. Simple token definition defined in the same line.

The following typographical conventions are used in this chapter:

- **Bold:** Token that appears as is
- 'italic': Composed tokens defined below
- *Italic:* A definition of a previously declared token

This chapter uses predefined operators to define correlation between other declarations and definitions. The following operators are not used in the ILS file itself:

- [] Optional expressions.
- [**] Optional expression unless mentioned in a following remark.
- [x ] The expression enclosed in the [] is optional, however another expression enclosed in [] must also appear. If the first expression does not appear then the second expression is still optional.
- [[ ]] Double square [[ ]] indicates that one [] must appear in the ILS file.
- | Logical OR.
- &| Logical AND OR.
- ##n Tokens between # and # n appear 1-n times.
- // Indicates that the following is a remark and is not part of the ILS file.
- >>> Indicates that this line and the following line appear as one line in the ILS file.
**ILS File Structure:**

- 'Header'
- 'General data on the VP'
- 'Description of the objects'

**Header:**

```plaintext
="/**********************************************************************
 * File: 'file name'
 * Date: 'date'
 * User: 'user name'
 * Source: 'image name'
 **********************************************************************/
```

**General data on the VP:**

- 'Version number'
- 'Background color'
- 'Grid data'
- 'Layers data'
- 'Fonts data'
- 'Zones data'

**Version number:**

```plaintext
VERSION 'ver num'
```

**Background color:**

```plaintext
BACKGROUND COLOR: 'rgb'
```
Rbg:

('R', 'G', 'B')

Grid data:

GRID:
DX='dx'   DY='dy' 'setup units'
ORIGIN: <'x origin', 'y origin'>
SNAP: 'on/off' SHOW: 'on/off'

Layers data:

LAYERS:
# "'layer name'"
'from scale' 'to scale' GROUP= 'group' #n

Fonts data:

FONTS:
# "'font style'" "'font name'" <'font type'> 'font
direction' 'font data'
FONTS SIZE: 'font size' #n

Zones data:

ZONES:
# "'zone name'" < 'x zone', 'y zone' > 'scale
number' #n

Description of the objects:

#' item' #n
**Object:**

'Simple object' | 'Composed object'

**Simple object:**

'Graphical object' | 'Special text object' | 'Widget object' | 'Sgf object'

**Graphical object:**

'box object' | 'circle object' | 'ellipse object' | 'circarc object' | 'poly object' | 'pipe object' | 'button object' | 'simple text'

**Box object:**

```plaintext
OBJECT BOX 'object number' {
   'General data' [ROUNDED]
   'box position'
   ['Trigger definition' ]
}
```

**Circle object:**

```plaintext
OBJECT CIRCLE 'object number' {
   'General data'
   'circle-ellipse position'
   ['Trigger definition' ]
}
```
**Ellipse object:**

```
OBJECT ELLIPSE 'object number' {
    'General data'
    'circle-ellipse position'
    ['Trigger definition']
}
```

**Circarc object:**

```
OBJECT CIRCARC 'object number' {
    'General data' [CLOSED]
    'circarc position'
    ['Trigger definition']
}
```

**Poly object:**

```
OBJECT POLY 'object number' {
    'General data'
    'poly position'
    ['Trigger definition']
}
```

**Pipe object:**

```
OBJECT PIPE 'object number' {
    'General data'
    'pipe position'
    ['Trigger definition']
}
```
Button object:

```
OBJECT BUTTON 'object number' {
   'General data'
   FONT="font style"
   FACENAME="font name" TEXT_SIZE='font size'
   T_"font direction"   T_"font data"
   'box position'
   CAPTION: "text"
   ['Trigger definition']
}
```

Simple text:

```
OBJECT TEXT 'object number' {
   'General data'
   'text information'
   ['Trigger definition']
}
```

General data:

```
LCOL='rgb' FCOL='rgb' PATTERN='pattern num' 'filled'
LAYER="layer name"
```

Box position:

```
VERTICS: <x1 pos',y1 pos'> <x2 pos',y2 pos'>
```

Poly position:

```
VERTICS: # <'x1 pos','y1 pos'>  #n // n - number of vertexes in the poly.
```
Circle-ellipse position:

CENTER: <'x1 center','y1 center'> PARAMS: <'Righted point on the circumference'> >>>
<'Leftward point on the circumference'>

Righted point on the circumference:

<'x1 pos','y1 pos'>
Leftward point on the circumference:
<'x1 pos','y1 pos'>

Pipe position:

WIDTHIN='widthin' WIDTHOUT='widthout'
VERTICS: # <'x1 pos','y1 pos'> #n // n - number of vertexes in the pipe

Circarc position:

<'x left','y left'> <'x top','y top'> <'x right','y right'>

Text information:

START: <'x1 pos','y1 pos'> FONT="'font style'"
FACENAME= "'font name'" TEXT_SIZE= 'font size' T_'font direction'
T_'font data' *]

/* STRING="'text'" */ //NOT optional when the object is a 'simple text' object.

Trigger definition:

'Data entry' | 'Action' | 'Smooth' | 'Buttons' | 'Bit trigger' | 'Momentary' | 'Fast Action'
Data entry:

```
TRIGGER DIRECT {
  GATE="'tag name'"
  POSITION=<'x1 pos','y1 pos'>
}
```

Action:

```
TRIGGER IMMEDIATE {
  [* GATE="'tag name'" *] // NOT optional incase
  FORMULA="'formula'" &| ZONE="'zone name'" &| 
  MACRO="'macro name'"
}
```

Smooth:

```
TRIGGER SMOOTH {
  GATE="'tag name'"
  POSITION=<'x1 pos','y1 pos'> MINVAL='low val'
  MAXVAL='high val'
}
```

Buttons:

```
TRIGGER BUTTONS {
  [GATE="'tag name'"]
  POSITION=<'x1 pos','y1 pos'>
  BUTTON WIDTH='x1' BUTTON HEIGHT='x2'
  'buttons order' ['extra buttons']
  TITLE="'text'"
  # LEGEND="'text' " 'operation' #n
}
```
Operation:

\[
\text{VALUE}='x1' \quad \text{AND} \quad \text{ZONE}='zone name' \quad \text{AND} \quad \text{MACRO}='macro name'
\]

Bit trigger:

```
TRIGGER BIT {
    GATE='tag name'
    POSITION='x1 pos','y1 pos'
}
```

Momentary:

```
TRIGGER MOMENTARY {
    GATE='tag name'
    DOWN_FORMULA='formula'
    UP_FORMULA='formula'
}
```

Fast Action:

```
TRIGGER FAST_ACTION {
    DLL NAME='dll name'.dll
    FASTACT_VERSION=800 FLAGS=14 TIMEOUT=0
    FUNCTION='function name for fast trigger action'
    DESCRIPTION='fast trigger description'
    FASTACT_PARAMS=''
}
```

Special text object:

```
'Digital display' | 'Date' | 'Time' | 'Sectime' | 'Text table' | 'string tag'
```
**Digital display:**

```
OBJECT DIGITAL DISPLAY 'object number' {
    GATE="tag name"  'display mode'  FORMAT='x1'
    'digital options'
    'general data'
    'text information'
    ['Trigger definition' ]
}
```

**Date:**

```
OBJECT DATE 'object number' {
    'Special text data'
    ['Trigger definition' ]
}
```

**Time:**

```
OBJECT TIME 'object number' {
    'Special text data'
    ['Trigger definition' ]
}
```

**Sectime:**

```
OBJECT SECTIME 'object number' {
    'Special text data'
    ['Trigger definition' ]
}
```
**String tag:**

```plaintext
OBJECT DIGITAL DISPLAY 'object number' {
     'Special text data'
     ['Trigger definition' ]
}
```

**Special text data:**

```plaintext
GATE="'tag name'"
'general data'
'text information'
```

**Text table:**

```plaintext
OBJECT TEXT TABLE 'object number' {
     GATE="'tag name'" FILE="' file'"
     'general data'
     'simple text position'
     ['Trigger definition' ]
}
```

**Widget object:**

```plaintext
'Widget slider' | 'widget mediaplayer'
```
**Widget slider:**

```
OBJECT WIDGET SLIDER 'object number' {
  LAYER="layer name" [[<x1 pos,'y1 pos'>,<x2 pos,'y2 pos']]]
  SLIDER SPECIFICATION:
    { 
      GATE="tag name" VALUE_ASSIGNMENT='value assignment'
      SNAP='bit'
      LIMITS: DEFAULT='bit' FROM='low val'
      TO='high val'
      PRIMARY='x1'
      TICKS_POS='ticks pos'
      BORDER='bit'
    }
}
```

**widget mediaplayer:**

```
OBJECT WIDGET MEDIAPLAYER 'object number' {
  LAYER="layer name"
  MEDIAPLAYER SPECIFICATION:
    { 
      DEVICE_NAME="file"
      HAS_TITLE='bit'
      TITLE_NAME=[],"text"
    }
}
```
**Sgf object:**

```plaintext
OBJECT SGF 'object number' {
    LAYER="layer name" [ [ '<x1 pos','y1 pos'> <'x2 pos','y2 pos'>] ] >>>
    "'file'"
    [ 'Trigger definition' ]
}
```

**Composed object:**

```plaintext
'Group object' | 'Dynamic object' | 'Cluster object' | 'Alarm object'

Group object:
OBJECT SEGMENT 'object number' {
    GROUP OBJECTS {
        # 'objects in segment' #n
    }
}
```

**Objects in segment:**

```
'Graphical object'
&| 'sfg object'
&| 'Group object'
```

**Dynamic object:**

```plaintext
OBJECT DYNAMIC 'object number' {
    'Dynamic options'
    DYNAMIC OBJECTS {
        # 'objects in dynamic'
    }
}
```
**Dynamic options:**

'simple dynamic' | 'composed dynamic'

Simple dynamic:
'move' | 'scale' | 'rotate' | 'fill' | 'show' | 'empty' | 'drum'

**Move:**

```
move style': GATE="tag name" VAL0='x1' DX='dx' DY='dy'
FROM='low val' TO='high val'
```

**Scale:**

```
SCALE: GATE="tag name" VAL0='x1' REF_POINT=('x1 pos','y1 pos')
SX='x2' SY='x3' FROM='low val' TO='high val'
```

**Rotate:**

```
ROTATE: GATE="tag name" VAL0='x1' REF_POINT=('x1 pos','y1 pos')
ANGLE='x2' FROM='low val' TO='high val'
```

**Fill:**

```
FILL: GATE="tag name" VAL0='x1' BOX0=[[('x1 pos','y1 pos'),('x2 pos','y2 pos')]]
DX='dx' DY='dy' FROM='low val' TO='high val'
```

**Show:**

```
SHOW: GATE="tag name" START='low val' END='high val'
```
Empty:

EMPTY: GATE="tag name" START='low val' END='high val'

Blink:

BLINK: GATE="tag name"
# 'blink range' #10

Blink range:

START='low val' END='high val' RATE='rate'

Drum:

DRUM: GATE="tag name" MASK="mask"

Composed dynamic:

[1 'lcol'] [2 'fcol'] [3 'pattern'] //those are optional according to the tag values while saving to ILS.
# 'simple dynamic' #n
[1 'lcol data']
[2 'fcol data']
[3 'pattern data']

lcol:

LCOL= 'rgb'

col:

FCOL= 'rgb'
**Pattern:**

```
PATTERN= 'x1'
```

**icol data:**

```
LCOL: GATE="'tag name' "
START= 'x1' END= 'x2' VAL= 'rgb'
```

**fcoll data:**

```
FCOL: GATE="'tag name' "
START='x1' END='x2' VAL='rgb'
```

**Pattern data:**

```
PATTERN: GATE="'tag name' "
START='x1' END='x2' VAL='color'
```

*Objects in dynamic:*

- 'Graphical object'
- 'Special text object'
- 'sfg object'
- 'Group object'

**Cluster object:**

```
OBJECT CLUSTER INSTANCE 'object number' {
    NAME: '"text' "
    LIBRARY: '"text'" CLUSTER: '"text' "
    PLACED SCALE: 'x1'
    INSTANCE OBJECTS {
        # 'object ' #n
    }
}
```
**Alarm object:**

```
OBJECT ALERT 'object number' {
  STATION: 'text'
  FAMILY: "'text'"
  SHOW WHEN: 'show option'
  [BLINK:'blink action time']
  [FILL COLOR:'color action time']
  [LINE COLOR: 'color action time']
  TRIGGER: 'trigger options'
  ALERT OBJECTS {
    # 'objects in alarm'  #n
  }
}
```

**Blink action time:**

```
STARTED='rate' &| ACKED='rate' &| ENDED='rate'
```

**Color action time:**

```
STARTED='color' &| ACKED='color' &| ENDED='color'
```

**Objects in alarm:**

```
'Graphical object'
&| 'Special text object'
&| 'sfg object'
&| 'Group object'
```
<table>
<thead>
<tr>
<th>File Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date:</td>
<td>String</td>
<td>Date mm/dd/yy Date when the ILS file was created.</td>
</tr>
<tr>
<td>user name:</td>
<td>String</td>
<td>Name of the user who created the ILS file.</td>
</tr>
<tr>
<td>image name:</td>
<td>String</td>
<td>The source image.</td>
</tr>
<tr>
<td>Xn:</td>
<td>Number</td>
<td>Same as written in the token previously. (Can be x1,x2...)</td>
</tr>
<tr>
<td>Text</td>
<td>String</td>
<td>The strings that the user prints in the image.</td>
</tr>
<tr>
<td>Bit:</td>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>Dx, Dy</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Ver num:</td>
<td>Number</td>
<td>Application version.</td>
</tr>
<tr>
<td>R:</td>
<td>0&lt;=Number&lt;=255</td>
<td>First value of an RGB color.</td>
</tr>
<tr>
<td>G:</td>
<td>0&lt;=Number&lt;=255</td>
<td>Second value of an RGB color.</td>
</tr>
<tr>
<td>B:</td>
<td>0&lt;=Number&lt;=255</td>
<td>Third value of an RGB color.</td>
</tr>
<tr>
<td>x step:</td>
<td>Number</td>
<td>Distance between points of the grid along the x axis.</td>
</tr>
<tr>
<td>y step:</td>
<td>Number</td>
<td>Distance between points of the grid along the y axis.</td>
</tr>
<tr>
<td>x origin:</td>
<td>Number</td>
<td>X parameter of the grid's start point.</td>
</tr>
<tr>
<td>y origin:</td>
<td>Number</td>
<td>Y parameter of the grid's start point.</td>
</tr>
<tr>
<td>setup units:</td>
<td>String</td>
<td>WORDS</td>
</tr>
<tr>
<td>on/off:</td>
<td>String</td>
<td>ON</td>
</tr>
<tr>
<td>layer name:</td>
<td>String</td>
<td>Name of the layer in uppercase.</td>
</tr>
<tr>
<td>from scale:</td>
<td>Number</td>
<td>Lowest scale included in the layer.</td>
</tr>
<tr>
<td><strong>File Name</strong></td>
<td><strong>String</strong></td>
<td><strong>ILS File Name</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>to scale:</td>
<td>Number</td>
<td>Highest scale included in the layer.</td>
</tr>
<tr>
<td>Group:</td>
<td>Hex.</td>
<td>NumberGroup authorization for that image.</td>
</tr>
<tr>
<td>font style:</td>
<td>String</td>
<td>Style of the font (that the user sets when defining a new font).</td>
</tr>
<tr>
<td>font name:</td>
<td>String</td>
<td>Font name.</td>
</tr>
<tr>
<td>Font type:</td>
<td>Character</td>
<td>B (for bitmap)</td>
</tr>
<tr>
<td>font direction:</td>
<td>String</td>
<td>LR</td>
</tr>
<tr>
<td>font data:</td>
<td>String</td>
<td>BLD</td>
</tr>
<tr>
<td>font size:</td>
<td>Number</td>
<td>Size of the font.</td>
</tr>
<tr>
<td>Zone name:</td>
<td>String</td>
<td>The name of the zone that the user wrote during definition</td>
</tr>
<tr>
<td>x zone:</td>
<td>Number</td>
<td>The x parameter of the zone's center point.</td>
</tr>
<tr>
<td>y zone:</td>
<td>Number</td>
<td>The y parameter of the zone's center point.</td>
</tr>
<tr>
<td>scale number:</td>
<td>Number</td>
<td>The scale of that zone.</td>
</tr>
<tr>
<td>Object number:</td>
<td>Index</td>
<td>(starts with 1)Index of the object.</td>
</tr>
<tr>
<td>Pattern num:</td>
<td>Number</td>
<td>Pattern of the object.</td>
</tr>
<tr>
<td>Filled:</td>
<td>String</td>
<td>EMPTY</td>
</tr>
<tr>
<td>X1 pos:</td>
<td>Number</td>
<td>X parameter of a point</td>
</tr>
<tr>
<td>Y1 pos:</td>
<td>Number</td>
<td>Y parameter of a point</td>
</tr>
<tr>
<td>X1 center:</td>
<td>Number</td>
<td>X parameter of a center point</td>
</tr>
<tr>
<td>Y1 center:</td>
<td>Number</td>
<td>Y parameter of a center point</td>
</tr>
<tr>
<td>Widthin:</td>
<td>Number</td>
<td>Width in</td>
</tr>
<tr>
<td>Widthout:</td>
<td>Number</td>
<td>Width out</td>
</tr>
<tr>
<td>File Name</td>
<td>Data Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>X left:</td>
<td>Number</td>
<td>X parameter of the left point</td>
</tr>
<tr>
<td>Y left:</td>
<td>Number</td>
<td>Y parameter of the left point</td>
</tr>
<tr>
<td>X top:</td>
<td>Number</td>
<td>X parameter of the top point</td>
</tr>
<tr>
<td>Y top:</td>
<td>Number</td>
<td>Y parameter of the top point</td>
</tr>
<tr>
<td>X right:</td>
<td>Number</td>
<td>X parameter of the right point</td>
</tr>
<tr>
<td>Y right:</td>
<td>Number</td>
<td>Y parameter of the right point</td>
</tr>
<tr>
<td>Tag name:</td>
<td>String</td>
<td>The tag that the user entered.</td>
</tr>
<tr>
<td>Formula:</td>
<td>String</td>
<td>Formula entered by the user</td>
</tr>
<tr>
<td>Macro name:</td>
<td>String</td>
<td>The name of the macro</td>
</tr>
<tr>
<td>High val:</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Low val:</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Buttons order:</td>
<td>String</td>
<td>HORIZ.</td>
</tr>
<tr>
<td>Extra buttons:</td>
<td>String</td>
<td>+CANCEL &amp;</td>
</tr>
<tr>
<td>Display mode:</td>
<td>String</td>
<td>DEC.</td>
</tr>
<tr>
<td>Digital options:</td>
<td>String</td>
<td>LEFTJUSTIFY &amp;</td>
</tr>
<tr>
<td>File:</td>
<td>String</td>
<td>Name of the file.</td>
</tr>
<tr>
<td>Value assignment:</td>
<td>String</td>
<td>DRAGTOIMG_DROPTOPLC</td>
</tr>
<tr>
<td>Ticks pos:</td>
<td>String</td>
<td>RIGHT_BOTTOM</td>
</tr>
<tr>
<td>Show option:</td>
<td>String</td>
<td>ALWAYS &amp;</td>
</tr>
<tr>
<td>Rate:</td>
<td>String</td>
<td>FAST</td>
</tr>
<tr>
<td>Color:</td>
<td>0&lt;=Number&lt;16</td>
<td>Index of the color in the color table.</td>
</tr>
</tbody>
</table>

Document Conventions

Wizcon for Windows & Internet 8.2
The following is an example of an Image ASCII file:

```
* File: EXAMPLE.ils    *
* Date: 10/27/97       *
* User: 1              *
* Source: EXAMPLE.img  *
*******************************************************************************/
VERSION: 8.0
BACKGROUND COLOR: (255,255,255)
GRID:
DX=500  DY=500  WORLD
ORIGIN: <0,0>
SNAP: OFF  SHOW: OFF
```
LAYERS: "BASE"  1 2048 GROUP=0xffffffff

FONTS:
"Default" "System" B> LR BLD REAL_SIZE: 185 x 423

ZONES:
"OVERVIEW" < 120 , 55 > 64

OBJECTS:
OBJECT CIRCLE 1 {
  LCOL=( 0, 0,128) FCOL=( 0,255, 0) PATTERN=15 FILLED
  LAYER="BASE"
  CENTER: <-3202,1000> PARAMS: <578,0> <0,578>
}

OBJECT PIPE 2 {
  LCOL=(128,128, 0) FCOL=( 0,255,255) PATTERN=15 FILLED
  LAYER="BASE"
  WIDTHIN=100 WIDTHOUT=200
  VERTICES: <-386,-3742> <1484,-1455> <2977,-3175>
}

OBJECT BOX 3 {
  LCOL=( 0,255, 0) FCOL=( 0, 0,255) PATTERN=15 FILLED
  LAYER="BASE"
  VERTICES: <5755,-4102> <10801,925>
}
Appendix E Wpack/Wunpack

About this appendix:

This document describes the Wpack/Wunpack feature, as follows:

Wpack/Wunpack Overview on page E-2 discusses Wpack, Wunpack and Program Plugs
Working in a Packed Application on page E-4 discusses how to work in a packed application during runtime
Wpack/Wunpack Overview

This chapter discusses how to pack/unpack an application after it has been developed:

- **Wpack** packs an application for runtime. After a program has been packed additional tags cannot be added. However, small changes, such as saving a file can be made if Enable Application Modification is checked in the Choose Packing Model dialog box during the packing process.

- **Wunpack** unpacks an application for further development. After an application has been unpacked and modified it can be repacked.

Program Plugs

The program has two types of plugs. Each plug type holds up to a specified number of tags.

- **Development** plugs are used to develop an application but can also be used during runtime. Wpack can be performed only with a Development plug.

- **Runtime** plugs are used for runtime only and cannot be used to develop an application

Wpack

Wpack is used to pack an application at the end of the development stages.

After an application is packed the user cannot add new tags or create new files during runtime. When the program opens in a packed application, the Quick Access Bar does not have the Show Studio icon necessary for accessing the Application Studio.

► **To pack an application:**

*Note: Before packing an application check that all view ports (module windows) are closed.*

1. Click Start/Programs/Axeda Systems/application/Wpack. The Product Information dialog box opens.
2. Click OK, the Choose Packing Model dialog box opens where the number of Runtime tags required in the application can be selected. The number of runtime tags available is according to the Development plug limitations, for example, when a Development plug containing 512 tags is used, the enabled packing options will be 512, 300 or 80 tags.

3. Check the Enable Application Modification checkbox to enable modifications (such as Save) in the application during runtime.

4. Click Pack. A Wpack message box opens. To continue the Wpack process, click Yes or click No not to.
5. Another Wpack message box opens informing you that the process is complete. Click OK. The program shuts down and the application is packed. When the application is next accessed the Quick Access Bar will not have the Show Studio icon used to access the Application Studio.

Wunpack

The Wunpack feature is used to unpack a packed application for development purposes.

► To unpack an application

*Note: An application can only be unpacked when the application is open.*

1. Click Start/Programs/Axeda Systems/application/Wunpack. The Product Information dialog box opens.

2. Click OK. A Wunpack message opens. Click Yes to continue unpacking or No not to.

3. Another Wunpack message opens informing you that the unpack was successful. Click OK to close the application. The next time the application is accessed the Quick Access Bar will have the Show Studio icon.

Working in a Packed Application

After an application is packed only features and files defined before the Wpack process are available. Changes (such as Save) can only be made if the Enable Application Modification checkbox in the Choose Packing Model dialog box is checked.

► To access an application module:

1. Click the relevant module icon in the Quick Access Bar. The Open dialog box opens.

2. Double click the relevant file. The selected file will open.

*Note: When the Save icon is clicked the Save As dialog box opens.*
Appendix F Errors Log File

About this appendix:

This appendix describes the Errors Log File.
**Errors Log File Overview**

The Errors Log File can be used to email a copy of the program's error log file to Customer Support or for viewing the Errors.Dat file.

**Accessing the log file**

In the Application Studio click the Tools menu and select View Log File. The Errors Log File dialog box opens.

This dialog box has the following options:

- **Advanced Information**: When this button is checked the errors logs is saved holding additional information regarding the error.
- **Number of lines to display**: This option enables you to define the number of error log lines that will be displayed in this dialog box.
| **Filter** | This button opens the Filter dialog box where filtering criteria for the error log can be defined. |
| **Reload** | This button reloads the Errors Log file. The number of reloaded rows will be according to the definition in the Number of Lines to Display field. Only new lines will be displayed. |
| **Clear** | This option clears the Error Log view. |
| **Export** | This option opens the Save As dialog box where you can save a copy of the displayed Error Log. |
| **Email** | This option creates an email addressed to the application's Technical Support team holding the attachment of the Errors Log. The following files are included: ERRORS.DAT, WIZTUNE.DAT AND WIZVPI.DAT. The email is sent using the default email software defined in Windows. |
Appendix G System Tags

About this appendix:

This appendix discusses system tags, how to add them to an application, their use and lists and describes all the system tags available in this software program.

System Tags - Overview on page G-2 discusses these tags and their use in the application

System Tags List on page G-3 lists all the system tags in the application.
System Tags - Overview

System Tags are predefined, built-in tags providing system status information. These tags can be added to an application only once either, when the application is activated or, anytime afterwards. Once added, System Tags will appear under the Tags icon in the All Containers pane. When this icon is double-clicked a list of all the tags in the application will open in the Control Panel.

System Tags also hold information for the WizPLC integrated application.

To define System Tags when opening the program:

If global tags have not been defined in your project then during application start-up the following message box will open on your screen.

1. Click Yes to add system tags or No not to.
2. Check the Never ask again checkbox to define this option. The System Tags icon will appear in the All Containers pane as a sub-item of Tags.
3. Double click the System Tags icon to view the List of System Tags.

To define System Tags using the Tools menu:

1. From the Tools menu select Add Systems Tags. The following warning will appear on your screen.
2. Click Yes to add System Tags. The System Tags icon will appear in the All Containers pane as a sub item of Tags.

3. Click the System Tags icon to view the List of System Tags.

**System Tags List**

<table>
<thead>
<tr>
<th>Tag Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital</td>
<td>Alarm Module.</td>
</tr>
<tr>
<td>Read and Write</td>
<td>In the Read direction: returns 1 if the alarm module, enabling the application to check whether alarm conditions are true whenever tag values changes is enabled, and 0 if this module is disabled.</td>
</tr>
<tr>
<td></td>
<td>In the Write direction: Write 1 to enable the alarm module; write 0 to disable the alarm module</td>
</tr>
<tr>
<td>Digital</td>
<td>Alarm popup state (active/passive)</td>
</tr>
<tr>
<td>Read only</td>
<td>This tag indicates if the alarm popup is active/inactive.</td>
</tr>
<tr>
<td></td>
<td>Active=1</td>
</tr>
<tr>
<td></td>
<td>Passive=0</td>
</tr>
</tbody>
</table>

System Tags List G-3
### WIZ SYS_BACKUP

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Backup mode.</td>
</tr>
<tr>
<td></td>
<td>Returns 1 if the application backup is enabled and 0 if backup is disabled</td>
</tr>
</tbody>
</table>

### WIZ SYS_COLLAPSEALARMS

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Collapse alarms.</td>
</tr>
<tr>
<td></td>
<td>In the Read direction: Returns 1 if the collapse alarm feature enabling to collapse alarms in the Events Summary is enabled, and 0 if this feature is disabled.</td>
</tr>
<tr>
<td></td>
<td>In the Write direction: Write 1 to enable the collapse alarm feature, and 0 to disable this feature</td>
</tr>
</tbody>
</table>

### WIZ SYS_COMPRESSDEFINITION

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Compress definition.</td>
</tr>
<tr>
<td></td>
<td>In the Read direction: returns 1 if the compress definition is enabled, allowing the physical removal of alarms and tags from the Application database; and 0 if this option is disabled.</td>
</tr>
<tr>
<td></td>
<td>In the Write direction: write 1 to enable the compress definition option; write 0 to disable this option</td>
</tr>
</tbody>
</table>
### WIZ SYS_DATE

<table>
<thead>
<tr>
<th>Tag type</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td>In the Read direction: returns system date.</td>
</tr>
<tr>
<td></td>
<td>In the Write direction: enables you to modify the date format.</td>
</tr>
<tr>
<td><strong>To modify the date format:</strong></td>
<td>Double click the tag name to open the Date Properties dialog box</td>
</tr>
<tr>
<td><strong>Modify the date format:</strong></td>
<td>Select the date type (short or long), date format and separator</td>
</tr>
</tbody>
</table>

### WIZ SYS_DAY

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Day of month.</td>
</tr>
<tr>
<td></td>
<td>Returns the current day of month</td>
</tr>
</tbody>
</table>

### WIZ SYS_DAYS1970

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Days since 1970.</td>
</tr>
<tr>
<td></td>
<td>Returns the number of days since January 1st 1970</td>
</tr>
</tbody>
</table>

### WIZ SYS_DAYS1980

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Days since 1980.</td>
</tr>
<tr>
<td></td>
<td>Returns the number of days since January 1st 1980</td>
</tr>
<tr>
<td>Tag</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>WIZSYS_MILLISECMIDNIGHT</td>
<td>Milliseconds since midnight. Returns milliseconds since midnight</td>
</tr>
<tr>
<td>WIZSYS_MINUTE</td>
<td>Minute. Returns the minutes of current time</td>
</tr>
<tr>
<td>WIZ SYS_MINUTEMIDNIGHT</td>
<td>Minutes since midnight. Returns the number of minutes since midnight</td>
</tr>
<tr>
<td>WIZ SYS_DISKFREE</td>
<td>Free disk space. Returns free disk space in bytes</td>
</tr>
<tr>
<td>Tag type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>WIZ SYS_DISKUSED</td>
<td>Used disk space. Returns used disk space in bytes</td>
</tr>
<tr>
<td>Analog, Float</td>
<td></td>
</tr>
<tr>
<td>Read only</td>
<td></td>
</tr>
<tr>
<td>WIZ SYS_HOUR</td>
<td>Hour. Returns the hour of current time</td>
</tr>
<tr>
<td>Analog, Unsigned-16</td>
<td></td>
</tr>
<tr>
<td>Read only</td>
<td></td>
</tr>
<tr>
<td>WIZ SYS_IMAGEX</td>
<td>Active image X coordinate. Points to the X coordinate of the active image</td>
</tr>
<tr>
<td>Signed-32</td>
<td></td>
</tr>
<tr>
<td>Read only</td>
<td></td>
</tr>
<tr>
<td>WIZ SYS_IMAGEY</td>
<td>Active image Y coordinate. Points to the Y coordinate of the active image</td>
</tr>
<tr>
<td>Signed-32</td>
<td></td>
</tr>
<tr>
<td>Read only</td>
<td></td>
</tr>
<tr>
<td>WIZ SYS_MEMFREE</td>
<td>Free memory. Returns free physical memory in kilobytes in the system</td>
</tr>
<tr>
<td>Signed-32</td>
<td></td>
</tr>
<tr>
<td>Read only</td>
<td></td>
</tr>
</tbody>
</table>
### WIZ SYS_MEMUSED

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-32</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Used memory.</td>
</tr>
<tr>
<td></td>
<td>Returns used memory in kilobytes in the system</td>
</tr>
</tbody>
</table>

### WIZ SYS_MILLISECMIDNIGHT

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-32</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Minute.</td>
</tr>
<tr>
<td></td>
<td>Returns the minutes of current time</td>
</tr>
</tbody>
</table>

### WIZ SYS_MINUTE

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-32</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Month.</td>
</tr>
<tr>
<td></td>
<td>Returns current month</td>
</tr>
</tbody>
</table>

### WIZ SYS_MINUTEMIDNIGHT

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-32</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Minutes since midnight</td>
</tr>
<tr>
<td></td>
<td>Returns the number of minutes since midnight</td>
</tr>
</tbody>
</table>

**System Tags List**

Wizcon for Windows & Internet 8.2
## WIZ SYS_NETWORKACTIVE

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Network active.</td>
</tr>
<tr>
<td></td>
<td>Returns 0 if this station is not an active network station and 1 if this station is an active network station</td>
</tr>
</tbody>
</table>

## WIZ SYS_OPERATOR

<table>
<thead>
<tr>
<th>Tag type</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Current user name.</td>
</tr>
<tr>
<td></td>
<td>Returns current user name</td>
</tr>
</tbody>
</table>

## WIZ SYS_PLUGMODEL

<table>
<thead>
<tr>
<th>Tag type</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Plug model</td>
</tr>
</tbody>
</table>

## WIZ SYS_PLUGTAGS

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-32</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Maximum number of tags allowed by the plug.</td>
</tr>
<tr>
<td></td>
<td>Returns the maximum number of tags supported by the currently connected plug</td>
</tr>
<tr>
<td>Tag type</td>
<td>Digital</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>Description</td>
<td>Enable Scheduler. Enables/disables Scheduler Enabled=1 Disabled=0</td>
</tr>
</tbody>
</table>

**WIZ SYS_SCHEDULERLASTERR**

<table>
<thead>
<tr>
<th>Tag type</th>
<th>String</th>
<th>Read only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Scheduler last error Points to the Scheduler's last error</td>
<td></td>
</tr>
</tbody>
</table>

**WIZ SYS_SCHEDULERSTART**

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
<th>Read and Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Start Scheduler Indicates whether the Scheduler is in Start/End status Start=1 End=0</td>
<td></td>
</tr>
</tbody>
</table>

**WIZ SYS_SCHEDULERSTATUS**

<table>
<thead>
<tr>
<th>Tag type</th>
<th>String</th>
<th>Read only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Scheduler status Indicates whether or not the Scheduler is running Stat=running End=not running</td>
<td></td>
</tr>
</tbody>
</table>
### WIZ SYS_SECOND

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-16</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Seconds.</td>
</tr>
<tr>
<td></td>
<td>Returns seconds of current time</td>
</tr>
</tbody>
</table>

### WIZ SYS_STATIONID

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-32</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Station ID.</td>
</tr>
<tr>
<td></td>
<td>Returns the ID number of this station</td>
</tr>
</tbody>
</table>

### WIZ SYS_STATIONNAME

<table>
<thead>
<tr>
<th>Tag type</th>
<th>String</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Station name.</td>
</tr>
<tr>
<td></td>
<td>Returns the name of this application station</td>
</tr>
</tbody>
</table>

### WIZ SYS_TAGCOUNT

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, unsigned-32</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Number of tags.</td>
</tr>
<tr>
<td></td>
<td>Returns the number of tags defined in your application</td>
</tr>
<tr>
<td>Tag Name</td>
<td>Tag Type</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| WIZ SYS_TAGSAMPLING | Digital        | Tag sampling.  
In the Read direction: returns 1 if tags are in sampling mode and 0 if sampling mode is not active.  
In the Write direction: Write 1 to enable sampling mode; or 0 to disable sampling mode |
| WIZ SYS_TIME     | String         | Time.  
In the Read direction: returns system time.  
In the Write direction: enables you to modify the time format.  
To modify the time format:  
1. Double click the tag name to open the Time Properties dialog box.  
2. Modify the time format: Select the time format, separator and the AM and FM symbols |
| WIZ SYS_WDAY     | Analog, unsigned-16 | Day of week.  
Returns the day of the week, where 0 is Sunday, 1 is Monday, 2 is Tuesday ... and 6 is Saturday |
### WIZ SYS_WILRUNNING

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read only</td>
<td></td>
</tr>
</tbody>
</table>

**Description**
- Wil running.
- Returns 0 if Application Language is not running and 1 if Application Language is running.

### WIZ SYS_WizPLCCYCLES

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, Unsigned-32</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read only</td>
<td></td>
</tr>
</tbody>
</table>

**Description**
- WizPLC cycles count.
- Returns number of cycles.

### WIZ SYS_WIZPLCCYCLETIME

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, Unsigned-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read only</td>
<td></td>
</tr>
</tbody>
</table>

**Description**
- Cycle time.
- Returns cycle time in milliseconds.

### WIZ SYS_WIZPLCDEVRUNNING

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read only</td>
<td></td>
</tr>
</tbody>
</table>

**Description**
- WIZPLC Development running.
- Returns 0 if development is not running and 1 if development is running.
### WIZ SYS_WIZPLCMAXTIME

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, Unsigned-16</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td>Description</td>
<td>WIZPLC maximal time.</td>
</tr>
<tr>
<td></td>
<td>Returns the time, in milliseconds, during which WIZPLC performs one logic cycle</td>
</tr>
</tbody>
</table>

### WIZ SYS_WIZPLCRTRUNNING

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read only</td>
</tr>
<tr>
<td>Description</td>
<td>WIZPLC Runtime running.</td>
</tr>
<tr>
<td></td>
<td>Returns 0 if WIZPLC runtime is not running and 1 if runtime is running</td>
</tr>
</tbody>
</table>

### WIZ SYS_WIZPLCSTATE

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, Unsigned-16</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read and Write</td>
</tr>
<tr>
<td>Description</td>
<td>WIZPLC state.</td>
</tr>
<tr>
<td>In the Read direction:</td>
<td>returns 0 if WIZPLC is running and 1 if WIZPLC stopped</td>
</tr>
<tr>
<td>In the Write direction:</td>
<td>write 0 to run WIZPLC; write 1 to stop WIZPLC operation</td>
</tr>
</tbody>
</table>
### WIZ SYS_WRITE2HISFILE

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Digital</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Write to history file.</td>
</tr>
<tr>
<td></td>
<td><strong>In the Read direction:</strong> returns 1 if writing to history file is enabled, and 0 if writing to history file is disabled. <strong>In the Write direction:</strong> write 1 to enable writing to history file; write 0 to disable writing to history file</td>
</tr>
</tbody>
</table>

### WIZ SYS_YEAR

<table>
<thead>
<tr>
<th>Tag type</th>
<th>Analog, Unsigned-16.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Year</td>
</tr>
<tr>
<td></td>
<td>Returns current year</td>
</tr>
</tbody>
</table>
Appendix H Glossary

Advanced Alarm Management

Advanced Alarm Management (AAM) uses a multi-service communication platform to provide alarm transmission over various communication channels including SMS, email, fax and vocal messages.

Alarm

Alarms are internal system messages that provide the operator with information concerning events generated by the system. Alarms are displayed in the Events Summary and Popup Events Summary windows.

Alarm User Class Names

Alarm classes can be used to categorize alarms to identify them more easily, and to filter them in the system Events Summary.

Alarm User Fields

These are customized fields that are defined by the user (in the Alarms Definition dialog box) according to their specific requirements. User fields enable additional alarm filtering. There are five User Fields.

Alarm Help Files

Alarm Help files are user-created ASCII files containing help messages. These messages appear on the screen when specific alarms are issued. Each file can include only one explanation for one alarm. Help files can be created using a text editor and can have any name, but must have the extension .AHP. All Help files should be placed in one directory.

Alarm Hierarchy

Alarms are displayed in a hierarchical tree in which an alarm has a parent, child and sibling relationship with other alarms. Alarms can be attached at all levels.
**Alarm Inhibition**
Alarms can be locked and unlocked for a predefined period.

**Alarms - System**
These include: Hotbackup, Network Communication Error, VPI Communication Error, User Login and WIL Diskful.

**Alarm Filters**
This module filters alarms and reports before they are printed out or written to the Events Summary. Alarm Filters are displayed in the Alarm Filters table and defined or modified in the Filter Properties dialog box. Filter properties can be updated, however the name of a filter cannot be changed.

The Alarm Filter filters the alarms sent when parameters defined in tag variants are not met.

After alarms and reports outside the defined categories have been filtered out by the Alarms Filter, the remaining alarms are sent to the Printers defined in the module.

**API**
An API (Application Programming Interface) is a function that can be called from add-on programs to perform basic application operations.

Since APIs can be called from add-ons written in the C or Visual Basic programming language, basic programming knowledge is required to use them.

**Application Language**
Application Language is a simple but powerful tool used to enhance application performance by issuing commands, handling alarms, and communicating with external applications.

Application Language is generally used to issue sophisticated commands to the PLC that are either too complex, or impossible to program directly into the PLC.
Application Studio

The Application Studio includes all relevant objects and files needed to run and manage an application. It has an Explorer-like interface from which the application developer has full control and access to all parts of the application.

All Containers

This is a list tree that represents the various elements of the application. The All Containers Tree is made of four main groups: User Management, Web Application, Files and Objects. The root of the Tree is the station or application name. When an item is selected, a list of the container's content is displayed in the right side of the Application Studio.

Control Panel

The control panel is displayed in the Application Studio when the root of the tree is selected in the All Containers section.

List Area

This is the area where a list of the container's contents is displayed. This is on the right side of the Application Studio.

Object Lists

The objects branch in the All Containers section of the Application Studio, includes a list of Tags and Alarms.

Project Tree

This is a list representing the various application elements.

Authorization

Authorization in the application refers to the ability to limit operator access to the system. This powerful feature enables the system engineer to control access to the various components and modules, such as menu items, tags, macros, and graphical objects.
**Axeda Remote**

Axeda Systems Remote Module enables shared access between a User (operator) computer and a Viewer (System Integrator, Technical Support) computer. This module provides a safe solution for remote technical support and other control situations.

Axeda Remote has three levels:

- User station whose operator sends a request for a shared session
- Viewer station whose user (Technical Support) receives the request and then requests a session ID from the server through an Internet browser
- Server which creates the shared session

Once the User's station is accessed, the Viewer station shares its desktop and has access to both this application and other programs on the User's computer.

**Basket**

A Basket is a tool that is used to make a prototype of the application before starting to actually implement it, and to trace the progress of the application development. All basket operations are also logged in a file called BASKET.LOG. The system contains only one basket, kept in an ASCII file, BASKET.DAT, that can be edited to ensure fast and simple image design.

**Chart**

Charts display historical or online tag values in graphical drawings. Each chart can include up to 16 graphs, each representing a different tag.

**Data Box**

A Data Box is a supplementary window that can be invoked in the Chart module to provide graph tags, values, and descriptions.

**Graph**

A Graph is a tag display defined for a specific chart. Each chart can include up to 16 graphs. Graphs can appear in the format of bars, lines, lines with markers, or markers only.
**Reference Graph**

A reference graph is a graph with a predefined set of values. The values are either supplied manually or taken from the history of a specific tag in a specific time period. A reference graph is attached to a standard graph and is used to graphically represent the required behavior of the standard graph. The operator can graphically compare the actual behavior of a tag with the requirements.

**Clusters**

A cluster is an object class with all its behavior, including parameters, the graphical shape and tag and alarm functions.

**Communication Driver**

*Communication Drivers* control the computer PLC communication channels. They are used to connect different PLCs, industrial instruments and remote computers to your computer. Different communication drivers are used for different PLCs. Each communication driver translates general read/write instructions into a set of detailed commands for the PLC.

**Block**

A Block is a series of addresses in a PLC. By defining blocks, you can increase communication speed between the application and the PLC.

**DDE**

The application can communicate online with other applications through the Application DDE Support (Dynamic Data Exchange) interface. DDE is a common protocol that allows OS/2 and Windows NT applications to exchange data freely, using either one-time data transfers, or ongoing transfers in which applications send updates to each other whenever new data is available.

**Enterprise Server Connection**

The *Enterprise Server Connection* is a modular embedded application server that provides data acquisition, local decision-making and a web user interface for devices and systems.
**Events Summary**

The Event Summaries is used to display online and historical alarms. Several operations (such as acknowledge) can be performed on the alarms displayed in the Events Summary.

**Popup Events Summary**

A Popup Events Summary appears on the screen immediately when a severe alarm occurs.

The Popup Events Summary can be designed to display alarms in different colors, and include different titles. In addition, the Popup Events Summary can be defined to buzz.

**Event Summary Profiles**

The Events Summary Profiles & Popups module holds the definitions that determine the way alarms are displayed on the Internet browser.

**Events Summary Viewer**

The Events Summary Viewer features real-time alarms monitoring (online mode) according to the definitions specified in the Events Summary Profile. In addition to the Online mode, the application also provides a History mode that displays a report of historical alarms.

**History Viewer**

History Viewers can be used to generate lists of historical tag values for analysis purposes. The tag list generated by the module can be filtered to include only specific tags in the list.

**Hot Backup Station**

This configuration consists of two identical application SCADA stations. Both stations are connected to the same PLCs, but one station is running in the Master mode and samples data in the field, while the second station (Backup station) remains in a Stand-By mode. When the Master station goes down, the Backup station switches to the Master mode, starts to sample PLCs and distributes real-time data to other stations across the network.
In addition to real-time redundancy, the Hot-Backup feature ensures the integrity of historical databases. After the Master station recovers, the backup station updates the Master station with the missing historical data. This mechanism ensures that the historical database on the Master stations remains complete.

**Html**

The system's applications are viewed online using application Java Applets known as Wizlets that are embedded in HTML pages displayed by the Web browser. The page also includes a parameter that specifies the input file. The system has an Html assistant to generate Html pages. Pages can be built manually. Html pages are published on a web server so that an operator can view and interact with an application in a web browser. See Chapter 26, Generating HTML Pages.

**Image**

An image is a graphical drawing of a plant or facility that can include dynamic and static objects. Application images are drawn in layers, whereby each image can consist of one or more layers that can be zoomed into, to obtain detailed views of specific plant sections. See Chapter 18, Introduction to the Image Module, Chapter 19, Image Editor and Chapter 20, Image Animation

**Dynamic Object**

Dynamic Objects are objects in images that are defined to change graphically or textually according to the value changes of tags with which the objects are associated.

**Elaborating Zoom**

The Elaborating Zoom is a technique used in images to obtain detailed views of specific plant or facility sections.

When the Elaborating Zoom mode is active, each layer in an image will be viewed according to the scale range specified in the Layer Definition procedure. When the mode not active, the layers will appear in the image, even if scale ranges were not defined for them.

The Elaborating Zoom mode can be toggled on and off by selecting Elaborate On from the Layers menu, in the image.
**Layer**

A layer is a specific level of an image in which additional information is added and can only be seen in that layer. An application can consist of many layers. Different types of plant information can be shown on different layers. It is used to provide a more detailed view of a particular section of the plant. When a problem arises in a particular part of the plant, you can display that layer to see additional information to help you solve the problem.

**Trigger Object**

A Trigger Object is an object in an image defined to execute a specific operation whenever it is selected.

**Instantiation**

Once you place a cluster in an application you create an instance. The action of creating a separate instance of the object or function is called instantiation. One cluster can have many different instances, each with the specific characteristic that you define according to your application's needs.

**Layout**

A Layout is a set of application windows in the Studio Application saved in a file. Layouts enable you to maintain continuous control of the plant. By saving a particular layout, you can ensure the specific window combination will be available whenever you need it.

**Macro**

Chapter 32, Macros are programs that execute predefined actions, commands, or programs, whenever specific keys or key combinations are pressed.

Macros simplify execution of complex operations, and enable you to perform a series of functions with one keystroke. Macros can be defined for system functions or for trigger objects.

**Fast Actions**

These triggers are predefined built-in macros that enable you to easily trigger routine operations.
**Model**
A Model is a prototype list of tags from which recipes are derived. Models must be defined before recipes, and each recipe must belong to a model.

**Momentary Trigger**
A Momentary Trigger is an object that is used to change a tag value in a single action. Usually, these operations are required for a digital tag controlling a field operation that is activated by a high value (one 1) for a short period of time, followed by a low value (zero 0). All tags can be used for the Momentary Trigger including string tags.

**Network**
A computer network consists of several computers linked together, to enable data to be transferred from one computer to another. Several application stations can be linked together in a network, so that reports, charts, tag values, recipes, and images can be transferred from one station to another.

**PLC**
A PLC (Programmable Logic Controller) is a field device used to control external machines and equipment. The application uses communication drivers to communicate (read and write values) with the PLC. The application supports the use of more than 100 PLCs from different vendors.

**PLC Tags**
A PLC tag represents data from a PLC memory. These tags are associated with external devices and mapped on the external device variables (for example, PLC register).

The application samples these tags periodically through the communication driver so that changes of value in the field device variable are automatically transferred to the associated tag. Changes in PLC tag value in the application are immediately recognized in the external device.

Each PLC tag is associated with a specific PLC register, defined as Tag address in tag definition. The format of a tag address varies from one PLC to another and depends on the PLC memory structure, internal architecture and communication protocol. When
exchanging data between application tags and PLCs, the communication driver for the specific PLC should be installed.

**Printers**

The Printers dialog box enables enhanced printing capabilities. Each printer added to a system can be set to print reports, alarms or both. In addition a definition can be made where many alarms are printed on a full page or whether only one alarm is printed on each page. Page orientation and font can also be defined. Alarm properties that are printed can also be set together with different colors, text and background.

**Printer Target**

Printer Targets are a collection of predefined filters and printers specifying the conditions under which a target printer is activated.

**Recipe**

Recipes are a list of tag values that can be saved and applied in specific control processes as a group to cause the process to enter a state.

When a recipe is applied, the tags associated with the recipe are set to the corresponding values specified during recipe definition.

In the application, each recipe belongs to a Model. Models are used to group recipes and provide the list of tags from which the recipes are derived.

**Remote Network Application Update**

The Network Application Update module enables an application developer to quickly and easily update far station application files remotely. To the station operator this action is invisible. However a record of the update will appear in the station's error.dat file.

An unlimited number of network stations using the application can be defined in the Remote Update Settings dialog box. This dialog box, by default, holds all the files within the application.
RePlay
This module is used to view a graphical display of previous history tag values in images. The application reads and displays the tag values from the application's history.

The RePlay Module is activated from the Application Studio Control Panel. An application image cluster controls the RePlay itself.

SCADA
This application is a Supervisory Control and Data Acquisition (SCADA) system.

SCADA is a common process control application that collects data from sensors on the factory floor or in remote locations and sends them to a central computer for management, monitoring and control. It is used in many diverse industries such as oil and gas, as well as water, wastewater and electrical systems.

SCADA Station
The application SCADA station is an operations station that can communicate with up to 16 networks of PLCs simultaneously. This station performs functions such as sampling PLCs, generating alarms, collecting historical data and performing control operations. The operator can view the process through the application user-interface and interact with on-going activities. The application SCADA station can receive and send data to other network stations.

SCADA View Station
The application SCADA View station is a full operational station that allows operators to view and control the process. This station automatically receives all the online and historical data from the SCADA stations, as required. The operator can transparently interact with the process using application images, charts and other standard modules. The application SCADA View station serves as a mirror of the real-time and historical data from one or more SCADA stations. The application SCADA View Station is not connected to a PLC, it is connected to SCADA Stations via a network.

Management View Station
Management View stations bring real-time and historical data from the plant floor to any desktop in the organization. Management View stations can display data collected by one or more SCADA stations. In addition to displaying the data the form of images,
graphs and reports, Management View stations provide the necessary functions for interacting with on-going activities. Each command for changing process parameters or downloading a recipe is immediately transferred to the appropriate application SCADA stations. Since the application server handles the communication, this process does not affect time-critical operations on the plant-floor. A Management View Station cannot operate without a Server station.

**Scheduler**

The **Scheduler** enables you to easily create daily or weekly task orientated schedules remotely. Accessed through an Internet browser or by clicking on an icon, the Scheduler is extremely user friendly, efficient and economical.

Being both task and time orientated the Scheduler can be used to create unlimited tasks, actions and states. Tasks can be modified, enabled/disabled and have many states such as On/Off attached to them. An unlimited number of actions, which are basic operations, can be attached to each task.

**Server**

The Server collects requests from the Management View stations and transfers them to the appropriate SCADA stations. In response to these requests, the Server continuously receives updated messages about tags and alarms and dispatches them to the Management View stations.

In addition to routing real-time data, the application server can collect data from the SCADA stations and record selected data in historical databases. These databases can reside on the application server's local disk or on the network file server and are shared among all stations across the network. Since the application stores the data in a common format, users can access this data from both application stations and other applications without format conversion.

This configuration allows users to efficiently distribute computer power among different computers and PLCs, optimizes network resource consumption, and ensures that time-critical missions will be completed without any interference.

**Tag**

**Tags** are contact points through which the application receives data from the controller and/or outputs data to it. Tags can be analog, digital, compound, string, system etc.
**Analog Tags**
Tags that have numeric values represented in various formats (signed or unsigned integer, floating point, BCD)

**Compound Tags**
Compound tags are tags for which the values are the result of a combination of two other tags. Dummy tags can also be defined.

**Digital Tags**
Logic tags that have Boolean values of TRUE (1) or FALSE (0).

**Dummy Tags**
Dummy tags represent internal variables and are used for a variety of calculations, control and other application related needs. Dummy tags are updated by user input or changed by other application modules. These tags are set to 0 on system initialization.

**Tags - System**
System Tags are predefined built-in tags that provide system status information.

**String Tags**
Tags that are defined to receive alphanumeric strings.

**Compress Tag Definition**
Every tag in the system possesses a unique ID number. When a tag is deleted its ID is reserved and cannot be assigned to another tag. Therefore, when a tag is deleted it creates a hole in the ID tag numbers. The Compress option to avoid this problem by enabling user to arrange all available tags IDs in the system in consecutive order.

**Tags Inhibition**
These are tags that are locked and unlocked at predefined periods.
Multiple Tags
The MultiAdd operation is used to automatically generate a group of tags according to a user-defined pattern format.

Single Tag
The Single Tag dialog box is used to assign an immediate value to a specific tag.

GLS File
GLS files are tag list files in ASCII format that you can edit, add to or replace with the existing tag list.

Tokens (Clusters)
Tokens are a variable or operator in an application to enable customized tag creation and identification upon Instantiation. These tokens can be used in the Tag Name, Address, and Description fields to enable customized tag attribute generation. Tokens can also be used to easily create and identify alarms. This applies for Tag name, Family, Help File and text fields in the dialog. $ASK ("text", from-to) or $ID(from-to)) '[..]' brackets specify an optional parameter.

Tag Filter
The Tag Filter Module is used to filter, view and manage a list of tags and their status (locked/unlocked) in the application. This is useful for the development and maintenance of an application.

The Tag Filters List is stored in the application's TFM.XML filter that is created in the .\docs directory (or another appropriate directory of the application).

When accessed through Java applets the Tag Filters List can be defined/modified/viewed in the Image module during runtime. Up to 10 tag filters can be selected simultaneously.

Tag Mapper
The Tag Mapper is a data file of tags and tag values that can be used to considerably reduce workload during application creation. Tag values of tags held in a Tag Mapper table are mapped by the Tag Mapper into a list of other tags.

There are two types of Tag Mapper tags:
Source: These are tags whose values are directed to target tags. More than one source tag can be pointed to the same target tag.

Target: This tag type receives the values of the source tag. All target tags must have the WIZTGM_ prefix.

TCP/IP
Transmission Control Protocol/Internet Protocol (TCP/IP) is a communications protocol that provides effective and reliable communications between computers within a network and between different networks.

Trends
Trends are used to compare device functionality and correlate actions and responses. Their data can be displayed in one of two modes:

- Online mode in which the Trends are constantly updated according to changes in field values.
- History mode in which the Trends can be configured to display tag values that occurred over a specified time period.

Trend Profile
A Trend Profile contains the definitions that determine the way graphical views of past and current activities recorded by the application are displayed over an Internet browser.

Trend Viewer
A Trend Viewer displays online past and current activities recorded by the system according to definitions specified in the Trend Profile. Trend Viewers can be modified online.

User-Defined Report
User defined Reports are customized reports that contain free text and calculated field data.
**User Management**

User Management enables management of an application's users both locally and remotely. Users can be a single user, groups or teams built from users in the same groups.

By default, User Management has a group called Administrators. Users in this group are authorized to modify user properties (including their password). However, the group name cannot be modified or deleted. Users belonging to this group cannot remove themselves from it. An authorized user can access a user/group and modify its parameters. The User Management feature provides full backwards compatibility. Groups created in previous versions can be imported. See Chapter 7, Security and User Management.

**Users Timetable**

Using the Users Timetable you can select a team and schedule it on a calendar environment. There are three different views: Weekly Schedule, Daily Schedule and Special Days Schedule.

**VFI**

VFI (Virtual File Interface) is an interface layer through which WizPro writes and reads data to and from files, in a format that databases can use.

**WizPro**

WizPro is the real-time kernel that manages the system. The WizPro kernel enables other programs to share the application resources and run parallel to it, either locally or on remote stations.

In addition to managing the application, WizPro add-on programs can be written to enhance functionality and meet specific plant requirements.

**Write History**

This option enables you to stop the logging of all tag data in the system. When the write history option is enabled tag values are logged according to tag definition. When this option is disabled, no logging occurs.
**Zone**
A Zone is a specific area in an application image marked for navigational purposes. Once defined, zones can be used in go-to and macro operations, to cause specific image sections to fill the image area of the window immediately.

**Zone Navigator**
This module enables you to quickly and efficiently navigate through a list of zones defined in the application's various image objects.
Index

A
AAM in Alarms 13-17
AAM Pager 5-20
AAM Paging Service 15-18
access the Users Timetable 17-2
Access to the Scheduler 28-2
Accessing the Application 4-2
Accessing the log file F-2
Accessing the RePlay Module 21-2
Accessing the Report Definition Dialog Box 31-3
Accessing the Scheduler 28-6
Accessing the Wiztune.dat File B-3
Action 20-42, 28-36
action buttons 20-38
Action on Alarm 13-15
Action Permission Manager 7-5
Activating Application SQL 37-5
Activating application SQL from the Application Setup Menu Item 37-6
Activating application SQL from the Command Prompt 37-6
Active Layer 18-16
Adding Pager Services 15-19
Adding Stations 33-5
Adding Temporary Date Changes 28-4, 28-33
Adding, Updating and Deleting Data 37-17
Additional Drawing Tips 19-38
Advanced Alarm Management 2-4, 5-19, 15-2, H-1
Advanced Alarm Viewer 15-37
Advanced User Information C-2
Alarm H-1
Alarm Conditions 13-8
Alarm Definition dialog box 14-7
Alarm Design 4-11
Alarm Filter 14-2
Alarm Filter Network Tab 14-14
Alarm Filters 5-18, H-2
Alarm Filters Counters Tab 14-15
Alarm Filters dialog box 14-10
Alarm Filters network station 23-11
Alarm Help Files H-1
Alarm Help files 13-15
Alarm Hierarchy H-1
Alarm Inhibition H-2
Alarm Objects in Images 13-3
Alarm Properties 13-27
Alarm Text 13-12
Alarm User Class Names H-1
Alarm User Fields H-1
Alarms 2-4, 27-36
Alarms - Network 16-23
Alarms - System H-2
Alarms and Alarm Filters 13-3
Alarms Definition 20-23
Alarms General Tab 13-4
Alarms in Events Summaries 13-2
Alarms Overview 13-2
Alarms Parameters Field Names 14-13
Align option 19-23
Align Toolbox 19-37
All Containers H-3
ALS File Format 13-24
An action 28-3
Analog Tags H-13
Analog tags 9-10
API H-2
Application Configuration 16-22
Application hardware requirements 3-2
Application Hot Backup Station 16-3
Application Language 2-10, 5-17, H-2
Application Language activation 27-3
Application Language definitions 27-5
Application Language Format 27-11
Index

Wizcon for Windows & Internet 8.2

Application Language Report Generation 31-29
Application Language Setup 27-3
Application Macro From Client 36-16
Application Messages 37-28
Application Network 5-16
application operations 37-21
Application SCADA Station 16-2
Application SERVER Station 16-3
Application Setup 5-15, 5-22
Application software requirements 3-2
Application SQL 37-2
Application SQL Condition 37-13
Application SQL File 37-7
Application Station 16-2
Application Studio H-3
Application Studio - All Containers 5-4
Application Studio - Control Panel 5-7
Application Studio - Menu Options 5-9
Application Studio - Overview 5-2
Application VIEW Stations 16-3
application’s dialog boxes 7-7
Applying a recipe 29-8
Architecture 2-11
ASCII Files 19-5
Assign Commands 27-19
Assigning Layouts to Users 5-33
Assigning Names to Alarm Classes 13-13
Assigning User Field Names 13-14
Assist 22-6
Authorization 7-2, 24-39, H-3
Authorization Groups 9-13
Autowindow 19-61
Axeda Remote 2-5, 5-20, H-4
Axeda Systems Remote 35-2
Axeda Systems Remote module 35-6
Axeda Systems Remote Session 35-8

B
Backup - Principles of Operation 16-23
Basket H-4
Bit method 20-48

Bit Testing 27-36
Bitmap 19-6, 19-13
Bitmap Transparency Dialog Box 19-13
Block H-5
Block Command 37-24
Breaking/Editing Clusters 19-53
Bring to Front/Send to Back 19-39
Building a new Task 28-32
Building HTML Pages Manually 26-9
Buttons 20-49

C
Changing Default File Paths 5-27
Channels 5-19, 15-7
Chart H-4
Chart Command 27-25
Chart data box 24-31
Chart Definition 24-6
Chart features 24-37
Chart properties 24-35
Chart time 24-7
Chart window 24-6
Chart window File 24-39
Charts 24-2
Charts Design 4-11
Closing all Open Windows 5-34
Cluster 19-44
Cluster Basket Objects 19-59
Cluster Baskets 19-57
Cluster Library 19-45
Clusters H-5
Color Toolbox 19-37
Colors 19-31
Columns Tab 22-36
COM Port Properties Dialog Box 15-11
Command Line Report Generation 31-28
Commands 27-16
Communication Driver H-5
Communication Drivers 5-13
Communication drivers 8-2
Communication Error Verification Command 27-30
Communication Errors 24-39
communication problem 37-26
Communications 29-14
Compound Field Type 31-16
compound tag 9-9
Compound Tag Source Parameters 9-2
Compound Tags H-13
Compress Tag Definition H-13
configure network stations 16-5
Configuring a Hot Backup Station 16-7
Configuring a Management View Station 16-10
Configuring AAM 15-6
Configuring an Application Server Station 16-6
Configuring SCADA and VIEW Stations 16-6
Configuring the Application for Networking 16-5
Configuring the Enterprise Viewer Connection 35-9
Connecting Tags to One Item in a DDE Block 36-10
Consistent Display Design 4-11
Control Limits 24-14
Control Panel H-3
Copy/Paste Attributes 19-11
Copy/Paste Attributes for Grouped Objects 19-12
Copying Clusters from One Library to Another 19-55
create a new Tag Mapper table 11-5
create a Tag Mapper table record 11-7
create a Trend Viewer 25-13
Create and modify recipe models 29-3
Creating a Frame 31-4
Creating a New Temporary Daily Program 28-43
Creating a State 28-21
Creating and Modifying Events Summaries 22-3
Creating New Teams 7-21
Creating Tasks 28-28
Crosshair 24-38
Current Value 31-15
Cursor Shapes 24-3
customize a time frame 17-7
customize a weekly calendar in a yearly time frame 17-8
customize the timetable font 17-4
customize timetable colors 17-5
customize timetable gridlines 17-5
Customizing the Event Log Journal Window 15-41
Customizing the Login/Logout Procedure 4-9

D
Data Box H-4
Data Box Setup 24-31
Data Box Window 24-3
Data Recovery 6-16
Database Fields 6-16
Date 20-49
Date Field Type 31-21
Date/Time display 20-21
DDE H-5
DDE Addresses 36-2
DDE client 36-4, 36-5
DDE Client (DDEC) 36-12
DDE Client Block 5-15, 36-8
DDE Client Blocks Definition and Modification 36-8
DDE command 36-11
DDE Overview 36-4
DDE server 36-12
DDE Transactions 36-3
Default Location of Trend Profile 25-20
Default User 4-7
Default Wiztune.dat File 6-5
Default Zoom 24-29
Define a tag filter 12-2
Defining Action Macros 32-6
Defining Alarms 4-15
Defining an Events Summary Profile 23-5
Index

Wizcon for Windows & Internet 8.2

Popup Events Summary Buzz 22-39
Popup Specifications 22-38
Printer Target 2-12, 14-16, H-10
Printer Targets 5-19, 14-2
Printers 2-12, 5-14, 14-2, H-10
Printers dialog box 14-3
Printers List 14-6
Printing a Frame 31-4
Printing Images 19-10
Program Header 37-25
Program Initialization 37-25
Program Plugs E-2
Program Termination 37-26
Project Tree H-3

Q
Querying the Status of a Station with Application Language 16-7
Quick Access Bar 4-3

R
rebuild the instances 19-56
Recipe H-10
Recipe Commands 27-22
Recipe Creation 29-5
Recipe Files 29-2, 29-11
recipe properties 29-8
RECIPERPRTAG Mode for Recipe Blocks 29-12
Recipes 2-13, 29-2
Record Alarms 16-14
Record Tags 16-14
Recording remote data 16-12
Reference Graph H-5
Relational Operators 13-9
Remote Network Application Update H-10
Remote Update Settings Dialog Box 33-3
Remove Pager Services 15-20
remove time rows 17-6
repaint 19-69
RePlay 5-21, H-11
RePlay Cluster 21-6
RePlay Module 2-13
RePlay module 21-2
RePlay Tags list 21-4
report 2-6
Report Command 27-27
Report lists 31-26
Retrieving Data 37-19
Rotate button 20-7
Runtime Behavior of a Reference Graph 24-21

S
Sample Application SQL Program 37-8
Sample when out of Window 20-15
save report 31-25
Save/Load Recipe 37-24
Saving and Getting Colors 19-32
Saving batch data into process table 37-12
Saving Charts as Trends 24-43
Saving Files 19-8
SCADA H-11
SCADA Station H-11
SCADA View Station H-11
Scale button 20-8
Scheduler 2-14, 5-20, 20-55, H-12
Scheduler Add Time 28-26
Scheduler Architecture 28-4
Scheduler Calculator 28-19
Scheduler Database 28-4
Scheduler Diagnostic Information 28-18
Scheduler Interface 28-12
Scheduler Requirements 28-5
Scheduler Search 28-27
Scheduler Server 28-5
Scheduler Settings 28-14
Scheduler System Info 28-17
Scheduling Teams 17-9
Scrolling 24-27
Scrolling and zooming 24-27
Security 2-13
Security on the Web 2-13
Select Filters 23-7 Select Options 19-24
Selected Task Interface 28-30
Selecting a Default User 6-10
Selecting a Language 5-30
Selecting the Schedule Time Frame 17-6
Server H-12
Set Default Paths 23-20
Setting a Format for Audit Trail 6-13
Setting a Format for History Files 6-12
Setting Control Limits 24-15
Setting General Station Parameters 6-9
Setting Image Window Attributes 18-5
Setting Reference Graph Parameters 24-17
Setting the Date Format 6-11
Setting the Image Background Color 19-31
Setup menu 24-4
SHELL Command 27-24
Short Format 31-29
Show and Empty attributes 20-9
Shutting Down 4-19
simulate tag values 20-57
Simulate Tags 19-69
Single Graph Definition 24-22
Single Tag 5-15, H-14
Smooth Variation 20-47
Smooth Variation Range 20-44
Smoothing Graphs 24-38
SMS Driver Configuration 15-21
SMS Message Format 15-34
Snap to Grid 19-77
Source tags 11-2
Special Days 28-3, 28-38
Special Tokens 19-48
Specify a tag list file 12-2
Specifying a DDE Link tab 36-14
Specifying a DDE Address for Tags 36-7
Specifying a Description for the Chart 24-16
Specifying a Login/Logout Message 13-28
Specifying Historical Trends 25-10
Specifying Line Properties 19-31
Specifying Online Trends 25-10
Specifying Remote User Login Parameters 4-7
Specifying the Orientation of the Grid Axes 25-19
SQL Command 37-14
SQL Commands 37-10
SQL Messages 37-27
start the applicatio 3-10
State 28-3
Statement Definition 27-7
Statement Groups 27-33
Station Properties 6-8
Station Properties dialog box
VFI tab 6-12
Status bar 19-35
String 20-49
string expression 37-20
String Tag Field Type 31-21
Strings 5-28, 27-18
Structured Query Language (SQL) 37-2
Styles Definition 19-71
System Definition 7-10
System Tags 9-28, G-2
System Tags List G-3
System Variables 27-12
System’s security module 7-7

Tag H-12
Tag - DDE Link tab 9-16
Tag - General tab 9-5
Tag - Record Tab 9-15
Tag Assignment 37-21
Tag Definition dialog box. 9-4
Tag Filter 2-14, H-14
Tag Filter module 10-2
Tag Filters 5-17
Tag Icons 9-3
Tag Lock 13-34
Tag Mapper 2-15, 5-21, 11-2, H-14
Tag Mapper - multi records 11-9
Tag Mapper - Online Clients 11-13
Trend Profile 25-2, H-15
Trend Profile Display 25-12
Trend Profiles 2-15
Trend Viewer 25-2, H-15
Trends 25-2, H-15
Trigger mode 19-74
Trigger Object H-8
Trigger Object Definition 20-29
Trigger objects 19-16, 20-28, 20-50
Trigger on 18-2
Types 20-11
Typical Application Requirements 4-11

U
Undo and Redo 19-11
Uninstalling the System 3-8
Updating an exiting Hot Backup application 16-10
User Fields 22-13
User Login 4-5
User Management 2-16, H-16
User Management - Overview 7-12
User Message Format 15-34
User-Defined Report H-15
Users 4-9, 26-8
User Tab 7-29
Users Timetable 17-2, H-16
Users Timetable menu bar 17-3
Users Timetable toolbar 17-4
Using the Application as a DDE Server 36-13

V
Value 24-14
VFI H-16
VFI tab 6-12
VFI_DAYS_PER_FILE C-3
VFI5FST Tuning Parameters C-3
VFI5FST_IDX_SEC, VFI5FSTT_IDX_SEC C-3
VFI5FST_MODE_TIMESTAMP, VFI5FSTT_MODE_TIMESTAMP C-5
VF15FSTT_NO_COMM_ERR C-4
VF15FSTT_WRITE_BACK C-4
View menu 19-33
Viewers station 35-9
Viewing a Popup Events Summary in a Browser 23-22
Viewing Driver Information 8-14
Vocal Server 15-23
Voice Driver Configuration 15-22
Voice Message Format 15-36
Voice Synthesis Parameters 15-25
Voice Tab 15-26

W
WAV Messages 15-25
Web Application Files Default Location 26-12
Web Application Properties 25-22, 26-13
Week Overview 28-35
Weighted Average 31-14
window 19-69
WizPLC Development and Runtime 5-17
WizPro H-16
WizPro Options 5-25
WIZRPL_CONTROL 21-4
WIZRPL_DELAY 21-5
WIZRPL_PLAYBACKTIME and WIZRPL_PLAYBACKDATE 21-5
WIZRPL_STARTDATE 21-5
WIZRPL_STARTTIME 21-5
WIZRPL_STEP 21-5
WizSQL 2-6
WIZTUNE.DAT B-3
Wiztune.dat Parameters B-8
Wpack E-2
Write Blocks 29-2
Write History H-16
Write/Save Blocks 29-12
Wunpack E-2, E-4
X
X Axis Definition 24-22
X Axis Time Format 25-11

Y
Yearly Schedule 17-8

Z
Zone H-17
Zone Command 27-31
Zone Navigator 2-16, 5-19, 19-64, H-17
Zones 19-4
Zoom Back 24-29
Zoom In 24-28
Zoom Level 19-4
Zoom Out 24-29
Zooming 24-28
Zooming In - Online Mode 24-29